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What is New in 10.06.100?
You will find the release notes for IGEL OS 10.06.100 as a text file on our download server1 and in the Knowledge 
Base under Notes for Release 10.06.100.

New Workaround Switch for Dual RTME Sessions and H.264
You can use this workaround when launching multiple desktop session with RTME and H.264 does not work; 
see Highly Secured XenServer Has Problems with LD_BIND_NOW Workaround

Configuration of the Display Setting for Notebook Lid Handling
You can configure the lid handling of a notebook so that the notebook goes into standby mode by closing the lid, 
regardless of whether the notebook is plugged in or not, see Auto Switch Monitor Configuration for Notebooks.

Configuring the Automatic Appearance of On-screen Software Keyboard
You can configure the on-screen software keyboard so that it will appear automatically when you select an input 
box (e. g. Firefox and lockscreen); see Showing and Hiding the On-Screen Software Keyboard Automatically.

Make the Search Order for UMS and ICG Configurable
You can make the device prefer the local UMS over connecting with the ICG, see the tip in Using ICG Agent Setup (see 
page 665).

Auto Switch Monitor Configuration for Laptops
This display switch can use multiple different profiles which are automatically chosen at runtime depending on the 
currently connected monitors, see auto switch monitor configuration for Laptops under Using Display Switch (see 
page 571).

Advanced Buddy Update Features
You can provision your devices with different firmware versions by dividing buddy update servers and buddy 
update clients into groups; see Configuring the Buddy Update Server, "Configuration for Different Firmware 
Versions" and Configuring the Buddy Update Client, "Configuration for Different Firmware Versions". Also, you can 
distribute the load of the buddy servers evenly using a load balancing mechanism; see Configuring the Buddy 
Update Client, "Balancing the Server Load".

https://www.igel.com/software-downloads/igel-universal-desktop-firmware/
https://www.igel.com/software-downloads/igel-universal-desktop-firmware/
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Timed Command (Cron Replacement)
You can define one or more commands which are executed at a defined time; the configuration is similar to that of 
a  cron  job. For more information, see Creating a Timed Command (Cron Replacement).

NCP VPN Client
The NCP VPN client has been added; see NCP VPN Client (see page 758).

Network Connection Symbol Visible When Screen Is Locked
The network connection symbol is visible even when the local desktop is locked; see Taskbar (see page 702).

RDS Collection
Added a field to connect to a Remote Desktop Services (RDS) collection in RDP server settings (see page 150).

Login with IGEL Smartcard When Desktop Is Not Locked
Sessions stored on an IGEL smartcard can be started even when the desktop is not locked; see Enable IGEL 
smartcard without locking desktop under IGEL Smartcard (see page 829).

IBM iAccess
The configuration of IBM iAccess Client (see page 322) via Setup has been improved.
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IGEL Universal Desktop Firmware
IGEL thin clients comprise the latest hardware and an embedded operating system. Depending on the product, this 
operating system may be based on IGEL Linux or Microsoft Windows Embedded Standard.

The firmware included with every IGEL Universal Desktop product is multifunctional and contains a wide range of 
protocols allowing access to server-based services.

Management software: Universal Management Suite

For optimum management of your IGEL thin clients, the IGEL Universal Management Suite (UMS) is available on our 
download page2.

_____

Supported Formats and Codecs (see page 6)
IGEL Devices Supported by IGEL OS 10 (see page 7)

With the IGEL Universal Management Suite, you can configure thin clients in the same way as in the devices' 
local setup.



https://www.igel.com/software-downloads/igel-universal-management-suite/
https://www.igel.com/software-downloads/igel-universal-management-suite/
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Supported Formats and Codecs
As supplied, IGEL Linux supports the following multimedia formats and codecs:

Ogg/Vorbis
Ogg/Theora
WAV
FLAC

The following codecs can be added with the optional Multimedia Codec Pack3:

Supported formats: Supported codecs:

AVI

MPEG

ASF (restricted under Linux)

WMA

WMV (restricted under Linux)

MP3

OGG

MP3

AAC

WMA stereo

WMV 7/8/9

MPEG 1/2

MPEG4

H.264

AC3 is not licensed.

IGEL zero clients in the IZ range feature the Multimedia Codec Pack as standard.

https://www.igel.com/multimedia-codec-pack/
https://www.igel.com/multimedia-codec-pack/
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IGEL Devices Supported by IGEL OS 10

Core Requirements for IGEL OS 10
CPU with 64-bit support
Memory (RAM): 2 GB
Storage: 2 GB

IGEL Devices Supported by IGEL OS 10

IGEL UD (Universal Desktop)

Product 
Line

Device 
Type

Hardware 
ID

64 Bit Memor
y
(RAM)

Storage UEFI Secure 
Boot Support

HW Video 
Acceleration

UD2 D220 40 Yes 2 GB 4 GB Yes Yes

UD3 M340C 50 Yes 2 GB 4 GB Yes Yes

UD3 M340C 51 Yes 2 GB 4 GB Yes Yes

UD5 H830C 50 Yes 2 GB 4 GB Yes (BIOS/UEFI 
update may be 
necessary)

Yes

UD6 H830C 51 Yes 2 GB 4 GB Yes (BIOS/UEFI 
update may be 
necessary)

Yes

UD7 H850C 10 Yes 4 GB 4 GB Yes Yes

UD9 TC215B 40 / 41 
(Touch)

Yes 2 GB 4 GB Yes Yes

IGEL Zero

Product 
Line

Device 
Type

Hardware 
ID

64 Bit Memory
(RAM)

Storage UEFI Secure 
Boot Support

HW Video 
Acceleration

IZ2 D220 40 Yes 2 GB 4 GB Yes Yes

IZ3 M340C 50 Yes 2 GB 4 GB Yes Yes

IZ3 M340C 51 Yes 2 GB 4 GB Yes Yes
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Partial Support

Product 
Line

Device 
Type

Hardware 
ID

64 Bit Memory
(RAM)

Storage UEFI Secure 
Boot Support

HW Video 
Acceleration

UD3 M320C 40 Yes 2 GB (after 
upgrade)

2 GB No No

UD3 M330C 41 / 42 Yes 2 GB (after 
upgrade)

2 GB No No

UD5 H820C 40 Yes 2 GB (after 
upgrade)

2 GB No Yes

UD10 TC236 10 / 10 
(Touch)

Yes 2 GB (after 
upgrade)

2 GB No No

The following devices were supplied with 1 GB RAM; a RAM upgrade is therefore necessary.
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Bluetooth Assistant
A Bluetooth Assistant starts before the actual Setup Assistant. This tests whether a USB mouse and/or a USB 
keyboard are available. If not, it searches for unconnected Bluetooth devices and helps you connect them.

The assistant starts with a window in which a timeout expires for a few seconds. During this time you can still cancel 
the wizard.

On the following setup pages you can make settings related to Bluetooth:

Bluetooth Tool:
Path: Accessories > Bluetooth Tool (see page 626)

Here you define the start options for the Bluetooth Tool session. 

USB Access Control:
Path: Devices > USB Access Control (see page 812)

If you have USB access control enabled, you should make sure that you explicitly allow the connection to your 
Bluetooth devices via a class rule or device rule.

Bluetooth
Path: Devices > Bluetooth (see page 811)

Bluetooth must be activated here so that you can work with Bluetooth devices.

If you activate Tray Icon, you can start the Bluetooth tool via an icon in the system bar.

For more information about enabling Bluetooth services, see Bluetooth (see page 811).

If you want to disable the Bluetooth Assistant in general, put the file .igel_skip_bt-autopairing

in the directory /wfs/user/
The assistant will be skipped.


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Setup Assistant
When you start an unconfigured thin client, you will be welcomed by the Setup Assistant application. This takes 
you through the most important initial configuration steps.

_____

Using the Setup Assistant Function (see page 11)
Language (see page 15)
Keyboard Layout (see page 16)
Time Zone Continent/Area (see page 17)
Time and Date (see page 18)
Mobile Broadband (see page 19)
Wireless (see page 20)
Connectivity (see page 21)
Local Logon (see page 22)
Activate Your IGEL OS (see page 23)
ICG Agent Setup (see page 25)
Finish (see page 26)

•
•

•

The Setup Assistant starts automatically after booting IGEL OS if all of the following requirements are met:
The device is not yet configured.
No IP address for the Universal Management Suite (UMS) was transferred using the DHCP 
option 224.
No UMS can be accessed under the DNS name igelrmserver .


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Using the Setup Assistant Function
Setup assistant buttons:

Next: Go to the next configuration step

Back: Go back to the previous step

Cancel: Exit the setup assistant without saving changes to the configuration. Changes to the time and date will 
however remain effective.

Language
Language: Select the language for the user interface.

Accept EULA

You must accept the EULA to continue with setting up and using your thin client.

 Click I agree to continue with the setup.

Keyboard Layout
Keyboard layout: Select the keyboard layout. The selected layout applies for all parts of the system including 
emulations, window sessions and X11 applications.

Time Zone Continent/Area
Timezone continent/area: Select the continent/area for your location.
Possible values:

General: Under Location, you can select a GMT time zone.

From IGEL Linux Version 10.03.100 the button is labeled Skip if the configuration step can be omitted; if 
you click on Skip, nothing will change during the current configuration step. If the configuration is edited, 
the button will switch to Next.



If the Activate your UD Pocket (UD Pocket Demo) or ICG Agent Setup configuration steps fail, change the 
network settings of your device:

 If you require a system-wide proxy, start the setup and configure the proxy settings under Network > 
Proxy. You will find a description in the Proxy chapter of the manual.If you require WLAN/WiFi, set up Cafe 
Wireless on your device. From IGEL Linux Version 10.03.100, WLAN setup is integrated into the Setup 
Assistant.



This step is part of the setup assistant from IGEL Linux 10.04.100 onwards.
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Africa ... Pacific: Under Location, you can select a city for the selected continent/area.

Location: Select your location or time zone.

Time and Date
Date: Select the current date.

Time: Set the current local time.

Apply: Sets the system clock according to what is entered above.

Mobile Broadband
In the basic mode (default), you can make the following settings:

Country: The country of your provider.

Provider: Provider (the possible options depend on what you choose for Country)

APN/Plan: APN/Plan (the possible options depend on what you choose for Provider)

For more configuration options, click the Expert Mode button.

In the expert mode, you can make the following settings:

Enabled: Determines if the settings made in the expert mode are used. (Default: Enabled)
APN: APN (Access Point Name) for your network connection. If you do not know the APN, ask your 
mobile communications operator for it.
Network ID: Network ID for your network connection. If you do not know the network ID, ask your 
mobile communications operator for it.
Number: Access number for your network connection. If you do not know the access number, ask 
your mobile communications operator for it.
User name: User name for your network connection. If you do not know the user name, ask your 
mobile communications operator for it.
Password: Password for your network connection. If you do not know the password, ask your 
mobile communications operator for it.
PIN: PIN for the SIM card used.

Location: Summer time adjustment is taken into account here. Example: If you select "Berlin", the device 
will switch between summer time and normal time in accordance with the German adjustment rules. Time 
zone: The GMT time zones specify by how many hours the time zone for a particular location differs from 
the Greenwich time zone. The preceding symbol is used in accordance with the POSIX format. Examples: 
For New York City, select "GMT+5" which means "5 hours west of Greenwich". For Moscow, select "GMT-3” 
which means "3 hours east of Greenwich".


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Wireless

This configuration step is available if a WLAN adapter was found when starting the device. The device will search for 
available WLAN access points as soon as the configuration step is opened. The WLAN access points found will be 
listed. You can then connect to your desired WLAN access point.

Wireless regulatory domain: In the first selection menu, select the world region (example: Europe) in which you 
are situated and in the second one the country (example: United Kingdom).

: Searches again for WLAN access points.

: Opens a dialog which allows you to enter the WLAN name (SSID) of a hidden WLAN access point.

(Name of a WLAN access point in the list): Click on your desired WLAN access point and enter your access data in the 
dialog.

Once the connection is established, the  symbol will be shown in the Connected column.

Connectivity
This page is shown if for any reason no network connectivity is available.

Follow the instructions on the screen.

Activate Your UD Pocket
When you start a UD Pocket Demo, you can obtain an evaluation license. With this evaluation license, all features of 
the UD Pocket are available for a period.

Possible proxy settings:

Use proxy server: Determines if the proxy settings are used. (Default: Disabled)
HTTP Proxy: HTTP Proxy
Port: Port of HTTP proxy
SSL Proxy: SSL proxy
Port: Port of SSL Proxy
SOCKS Host: SOCKS Host
Port: Port of SOCKS host

This step is part of the setup assistant from IGEL Linux 10.03.100 onwards.

If you carry out the WLAN configuration and exit the Setup Assistant by selecting Finish, the connection 
will be saved and WLAN will be permanently enabled. If you skip this configuration step or cancel the 
configuration, WLAN will not be permanently enabled.



If you get an error at this stage of the wizard, you may need to configure a proxy. Click Proxy 
configuration in the upper right of the wizard to get to the proxy configuration dialog.


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1.
2.

User name: User name for authentication
Password: Password for authentication
Store credentials: Determines if the credentials are stored. (Default: Disabled)

Proceed as as follows:

Make your choice as required and fill in all fields.
Activate the checkbox near I agree to the terms + conditions and privacy policy.

ICG Agent Setup
If your system administrator has given you access data for IGEL Cloud Gateway, you can connect the thin client to 
the gateway here.

You will find instructions for this under Using ICG Agent Setup.

Otherwise, do not touch this page and click on Skip or Next.

Finish
Finish: Saves all settings and closes the Setup Assistant. If you have changed the language, the X11 graphics system 
will restart; the screen will go black for a short time. If you have a UD Pocket Demo, a restart is required to finish the 
activation.

The user name and password are the credentials for all proxy types configurable here (HTTP, SSL 
and SOCKS).


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Language
Language: Select the language for the user interface.
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Keyboard Layout
Keyboard layout: Select the keyboard layout. The selected layout applies for all parts of the system including 
emulations, window sessions and X11 applications.
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Time Zone Continent/Area
Timezone continent/area: Select the continent/area for your location.
Possible values:

General: Under Location, you can select a GMT time zone.
Africa ... Pacific: Under Location, you can select a city for the selected continent/area.

Location: Select your location or time zone.

Location: Summer time adjustment is taken into account here. Example: If you select "Berlin", the device 
will switch between summer time and normal time in accordance with the German adjustment rules. Time 
zone: The GMT time zones specify by how many hours the time zone for a particular location differs from 
the Greenwich time zone. The preceding symbol is used in accordance with the POSIX format. Examples: 
For New York City, select "GMT+5" which means "5 hours west of Greenwich". For Moscow, select "GMT-3” 
which means "3 hours east of Greenwich".





Setup Assistant

IGEL OS Reference Manual   18 / 897

Time and Date
Date: Select the current date.

Time: Set the current local time.

Apply: Sets the system clock according to what is entered above.
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Mobile Broadband
In the basic mode (default), you can make the following settings:

Country: The country of your provider.

Provider: Provider (the possible options depend on what you choose for Country)

APN/Plan: APN/Plan (the possible options depend on what you choose for Provider)

For more configuration options, click the Expert Mode button.

In the expert mode, you can make the following settings:

Enabled: Determines if the settings made in the expert mode are used. (Default: Enabled)
APN: APN (Access Point Name) for your network connection. If you do not know the APN, ask your 
mobile communications operator for it.
Network ID: Network ID for your network connection. If you do not know the network ID, ask your 
mobile communications operator for it.
Number: Access number for your network connection. If you do not know the access number, ask 
your mobile communications operator for it.
User name: User name for your network connection. If you do not know the user name, ask your 
mobile communications operator for it.
Password: Password for your network connection. If you do not know the password, ask your 
mobile communications operator for it.
PIN: PIN for the SIM card used.
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Wireless
This configuration step is available if a WLAN adapter was found when starting the device. The device will search for 
available WLAN access points as soon as the configuration step is opened. The WLAN access points found will be 
listed. You can then connect to your desired WLAN access point.

Wireless regulatory domain: In the first selection menu, select the world region (example: Europe) in which you 
are situated and in the second one the country (example: United Kingdom).

: Searches again for WLAN access points.

: Opens a dialog which allows you to enter the WLAN name (SSID) of a hidden WLAN access point.

(Name of a WLAN access point in the list): Click on your desired WLAN access point and enter your access data in the 
dialog.

Once the connection is established, the   symbol will be shown in the Connected column.

If you carry out the WLAN configuration and exit the Setup Assistant by selecting Finish, the connection 
will be saved and WLAN will be permanently enabled. If you skip this configuration step or cancel the 
configuration, WLAN will not be permanently enabled.


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Connectivity
This page is shown if for any reason no network connectivity is available.

Follow the instructions on the screen.
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Local Logon
This step is optional. If you want to configure a local user password later, see Local User (see page 837). 

Login with local user password

☑ A login screen is shown upon the start of the device, and a local user password set under Password is used to 
log in.

Password: Enter the desired password. The checker shown below assesses the strength of the password.

Password (repeated): Repeat the password.
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1.
2.

1.
2.

•
•
•

3.
4.
5.

1.
2.
3.
4.
5.
6.

Activate Your IGEL OS
In this step, you select the method for licensing the device.

If the device has no license yet, the following options are available:

Install license via UMS/ICG
Manual license deployment
Register for demo license

If the device already has a license, the following options are available:

Keep using the current license: You can continue with Next.
Manual license update: The procedure is the same as that for Manual license deployment.

The options are described in detail further below.

Install License via UMS/ICG
The device will request a license from the UMS. If the device is outside the company network, the IGEL Cloud 
Gateway (ICG) will be used for connecting the device to the UMS. In this case, ICG access must be set up; see ICG 
Agent Setup (see page 25).

Manual License Deployment
You can deploy a license via HTTP download from a specific URL, via FTP, or from a USB memory stick.

To deploy a license from a URL:

Enter the complete URL of the license file in the text field, including the protocol.
Click Install.

To deploy a license via FTP:

Click FTP.
Define the access data for you FTP server:

Host/Port: URL of the FTP server on which the license file is located
User: User for accessing the FTP server
Password: Password associated with the User

Click Browse.
In the dialog, go to the license file and select it.
Click Install.

To deploy a license from a USB memory stick.

Click File.
Connect the USB flash drive that contains the license to the device.
Under Storage Device, select the USB flash drive that contains the license.
Click Browse.
In the dialog, go to the license file, select it and click Open.
Click Install.
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2.
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Register for Demo License
With this evaluation license, all features of IGEL OS 11 are available for a fixed period. This period starts when the 
device has received the demo license.

Make your choice as required and fill in all fields.
Activate the checkbox near I agree to the terms + conditions and privacy policy.
Click ACTIVATE YOUR OS 11.
Your device fetches a demo license from IGEL.

Troubleshooting: Proxy Configuration
If you get an error at this stage of the wizard, you may need to configure a proxy.

Click Proxy configuration in the upper right of the wizard to get to the proxy configuration dialog.
Edit the proxy settings as required:

Use proxy server: Activate this if a proxy is required.
HTTP Proxy: Address of the HTTP proxy
Port: Port of the HTTP proxy
SSL Proxy: Address of the SSL proxy
Port: Port of the SSL Proxy
SOCKS Host: Address of the SOCKS Host
Port: Port of the SOCKS host
User name: User name for authentication
Password: Password for authentication

For a demo license, you must accept the EULA to continue with setting up and using your device.

User name and Password are the credentials for all proxy types configurable here (HTTP, 
SSL and SOCKS).


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ICG Agent Setup
If your system administrator has given you access data for IGEL Cloud Gateway, you can connect the device to the 
gateway here.

You will find instructions for this under Using ICG Agent Setup.

Otherwise, do not touch this page and click on Skip or Next.
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Finish
Finish: Saves all settings and closes the Setup Assistant. If you have changed the language, the X11 graphics system 
will restart; the screen will go black for a short time. If you have a UD Pocket Demo, a restart is required to finish the 
activation.
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Boot Procedure
The quick installation procedure is complete.

 Restart the system in order to start the boot procedure.

Boot Menu (see page 28)
Network Integration (see page 35)
X-Server (see page 36)
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Boot Menu
During the boot procedure, a boot menu is available on request. Via this menu, you can access system parameters 
or reset the device to the factory defaults if the device is configured incorrectly or you experience problems when 
booting.

 During the boot procedure, press the [Esc] key repeatedly in rapid succession in the Secondstage Loader when 
the Loading Kernel message is shown on the screen.
A menu with four boot options as well as an option for resetting the device to the default factory settings will 
appear:

Quiet boot: Normal start (default)
Verbose boot: Start with system messages and an interactive root shell
Emergency boot (setup only): Setup only
Failsafe boot with CRC check: Start with an integrity check of the operating system
Reset to factory defaults: Reset the client to factory defaults
Custom boot command: Boot with configurable command line options
VESA only Boot: Basic graphic boot (Use if normal boot has graphic issues. This is not 
manufacurer specific) 
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Quiet Boot
Quiet boot is the default boot mode. In this mode, all kernel messages are disabled and the graphical user interface 
is started.
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1.
2.
3.
4.
5.
6.

Verbose Boot
Unlike in Quiet boot mode, the boot messages are shown in Verbose boot mode. The boot procedure also pauses 
before the graphics system and the user session start.

This gives you an opportunity to open a root shell and interactively execute debugging commands (such as 
ifconfig etc.).

Proceed as follows:

Select Verbose boot from the boot menu.
Wait until the boot messages stop at Reached target IGEL Network Online .
Open a virtual console with the key combination [Ctrl ]+ [Alt ]+ [F11 ]or [Ctrl ]+ [Alt ]+ [F12].
Log in by pressing [Return ]and enter the root password if necessary.
Go through the desired individual commands.
Now enter the following command to continue the normal boot procedure:
systemctl default  

The graphical user session will start.

Use the root shell only if you have adequate knowledge of Linux or if you are instructed to do so by the 
IGEL Helpdesk and are given appropriate guidance. Incorrect use can destroy the operating system.


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Emergency Boot
During an Emergency Boot, the thin client is started without network drivers and with a resolution of 640 x 480 - 60 
Hz. The setup is then opened directly.

This option is useful if, for example, you have selected an excessively high screen resolution or a wrong mouse type 
and these settings can no longer be changed in the normal setup.

 Close the setup window to shut down the system or restart it.
Unlike with a reset, the setup will open with the actual settings.
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Failsafe Boot - CRC Check
During a Failsafe boot, a check of the file system is carried out first. The thin client then starts in Verbose mode.

This option is helpful if you no longer have a bootable system after a firmware update. The Failsafe boot checks 
where the problem is. If need be, an old version will be booted and you will need to repeat the firmware update.
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1.
2.

1.
2.
3.

4.
5.

Reset to Factory Defaults

Do you know the password?

Confirm the warning message.
Enter the password. You have three attempts.

Do you not know the password?

Confirm the warning message.
When you are prompted to enter the password, press the Enter key three times.
Press [c].
The Terminal Key will appear.
Contact us using license@igel.com4.
Enter the Terminal Key shown, the firmware version, and your contact details.
IGEL will send you a so-called Reset to Factory Defaults Key specially for your device. To ensure 
that the process is as straightforward and yet as secure as possible, each key is valid for just one 
device.
See also Resetting a Device with Unknown Administrator Password.

If you select Reset to factory defaults, all personal settings on the thin client (including your password 
and the sessions you have configured) will be lost.



A warning message will appear on the screen before the procedure is carried out. If the device is protected 
by an administrator password, you will be prompted to enter this password.



You can also reset your device to factory defaults in the UMS Console under Devices > Other commands 
> Reset to Factory Defaults, see Devices. 



mailto:license@igel.com
mailto:license@igel.com
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1.
2.

3.

4.

Custom Boot Command
If you select Custom boot command, preconfigured options will be placed on the kernel command line. This allows 
you for example to investigate and rectify problems with specific hardware components.

To configure the options for the Custom boot command, proceed as follows:

Open a local terminal and log in as root .
Enter the following command to bring up the current options:
bootreg get /dev/igfdisk boot_cmd

Save your desired options with the following command:
bootreg set /dev/igfdisk boot_cmd "<Your Options>"

Check the options that you have entered:
bootreg get /dev/igfdisk boot_cmd

The Custom boot command is merely a temporary solution – it is not an everyday booting method. It must 
therefore be selected manually in the boot menu.



If you would like to delete options for the Custom boot command, leave an empty string of 
characters in their place: bootreg set /dev/igfdisk boot_cmd ""


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Network Integration
Once the kernel has been loaded, the network can be configured.

There are three possible ways of integrating the terminal into the network environment.

Depending on the terminal settings, choose between

DHCP,
BOOTP,
manually configured IP address.

The network interface can be stopped and restarted on the Linux Console (accessible via 
[Ctrl]+[Alt]+[F11]) with this command:  /etc/init.d/network stop   /etc/

init.d/network start


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X-Server
The final step in the boot procedure involves starting the X-Server and the local windowmanager.
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The IGEL Linux Desktop
You can operate the thin client via the taskbar and the IGEL menu.

The following items can be found in the taskbar at the bottom of the screen:

Opens the IGEL menu.

Quick Start Panel

Application Launcher: Opens a dialog window with 
start symbols for sessions.

Setup: Opens the IGEL setup.

 
Symbol for sessions: Launches a session.

Window bar

Window buttons Allows you to switch between open windows.
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•

System tray

CPU power plan: Changes the power saving 
settings.

Volume control

Allows you to remove a USB stick safely

Local network connection

Time / date

Show Desktop

The IGEL menu offers the following areas and functions:

Sessions: Allows you to launch sessions
System: Allows you to launch system programs
About: Shows all relevant system information
Search window: Allows you to find sessions and functions in the start menu

 Allows you to shut down the thin client

 Allows you to restart the thin client

Application Launcher (see page 39)
Sessions (see page 41)
System (see page 42)
License (see page 43)
About Window (see page 44)
Restart and Shutdown (see page 45)
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Application Launcher
To launch the Application Launcher, proceed as follows:

 Click on  in the Quick Start Panel or in the start menu.

The sub-areas of the Launcher provide access to:

Listing of the sessions that have been set up
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Listing of the most important tools

License declarations for the components used

The About Window with information about the system

Restart

Shut down

Search field for fast access to the components

You will find information regarding the configuration here Application Launcher.
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Sessions
All sessions created are shown in a list of applications if they are enabled for the main session page.

 To open an application, double-click on it or click on  Run. 
Alternatively, you can launch sessions via icons on the desktop, in the quick launch bar or from the Start menu and 
context menu. 
Applications can also be launched automatically and a key combination (hotkey) can be defined. 
It is also possible, to build a file structure for the sessions in the application launcher. Therefor, in the setup page 
Desktop Integration of the relevant application you have to define a folder in the application launcher.

The available options for launching a session can be defined under Desktop Integration in the session 
configuration.





The IGEL Linux Desktop

IGEL OS Reference Manual   42 / 897

•
•
•
•
•
•
•

•
•

•
•
•
•
•

System

Under System , you can execute various tools including the firmware updating tool with the pre-set update 
information.

The following tools are available:

Identify Monitors: Shows the screen's number and manufacturer details.
Screenshot Tool: Takes photos of the screen content.
Bluetooth Tool: Starts the Bluetooth tool.
Firmware Update: Carries out the update with the settings made during the setup.
Savely Remove Hardware: Removes external storage devices without a risk of losing data.
Disk Utility: Shows information regarding connected USB drives.
Network Tools: Provides detailed information on the network connection and offers a number of 
problem analysis tools such as Ping or Traceroute.
Setup: Launches the IGEL Setup.
System Information: Shows information regarding hardware, the network and connected 
devices.
System Log Viewer: Shows system log files "live" and allows you to add your own logs.
Task Manager: Manages all processes.
Touchscreen Calibration: Allows a connected touchscreen monitor to be calibrated.
UMS Registration: Logs the thin client on to a UMS server (access data for the server are required).
Webcam Information: Shows data relating to a connected webcam and allows the camera to be 
tested.
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License

Under License  you will find the following:

The licenses for the components used in the UD system
Information on the provision of source code, e.g. under GPL
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•

About Window
In the About window, accessible via the  icon, you will find the following data:

Product: Information regarding the installed firmware
Copyright
Firmware Version
Product ID
Product Name
Website

Network: Computer name, hardware address and IP address of the thin client
Local Name
Standard Gateway (only with valid network connection)
DNS Server (only with valid network connection)
Universal Management Suite

Interface [number name]:
Description
Hardware Address
IP Address

Hardware:
Boot Mode
CPU Model
Device Type
Flash Size
Graphic Chipset
Memory Size
Total Operating Time
Unid ID (equal to MAC address (UD, UDC) or serial number (UD Pocket))

Licensed Features: List with all firmware features for which a license is available

If the network status changes, the details will automatically be updated. To force an 

update, click on .


You can copy individual entries via the context menu (right mouse button).
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Restart and Shutdown

Within the Application Launcher you will find two buttons for  rebooting or  shutting down the 
device. Both actions can be disabled for the user and will then be available to the administrator only.

You can change the default action when shutting down the device using the button on the screen or the on/off 
button on the device itself in the setup under System > Power Options > Shutdown.
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Setup
With the help of the setup, you can change the system configuration and session settings.

_____

Starting the Setup (see page 47)
End the Setup (see page 48)
Setup Areas (see page 49)
Quick Setup (see page 50)
Setup Search (see page 51)

Any changes you have made in the UMS take precedence and may no longer be able to be changed. A lock 
symbol before a setting indicates that it cannot be changed.


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Starting the Setup
You can open the setup in the following ways:

Double-click  in the Application Launcher
or click on Run.

Double-click  on the desktop (if available based on the settings).

Select  Setup in the desktop context menu (if available based on the settings).

Select System >  Setup in the start menu.

Click on  in the Quick Start Panel.
Launch the setup using the keyboard command [Ctrl]+[Alt]+[s], or 
in the Appliance Mode using [Ctrl]+[Alt]+[F2].

You can configure how the setup can be launched under Accessories. The options 
described above as well as combinations thereof are available.


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End the Setup
In order to end the setup again, you have the following options:

 Click on Apply if you have finished configuring a setup area and would like to save your settings without closing 
the setup program.

 Click on Cancel if you have not made any changes and would like to abort the setup.

 Click on OK to save your changes and exit the setup.
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Setup Areas
The setup application comprises the following main areas:

Sessions: Allows you to configure application sessions such as ICA, RDP, PowerTerm, browser and 
others
Accessories: Allows you to configure various local tools - setup pages for the local shell (Terminal), 
sound mixer, screen keyboard (for touchscreen monitors), options for the Application Launcher
and the setup application itself.
User Interface: Allows you to configure display settings, entry devices, hotkey commands etc.
Network: Allows you to configure all network settings for LAN/WLAN interfaces and the dial-up 
connections
Devices: Allows you to configure various devices
Security: Allows you to set the administrator/user passwords and user authorizations etc.
System: Allows you to set various basic system parameters including the date and time, 
information regarding the firmware update, remote management etc.

 Click on one of the areas to open up the relevant sub-structure.

The tree structure allows you to switch between the setup options.

Three navigation buttons are available. The buttons allow you to move back and forth between the setup pages you 
have visited or reach the next level up within the structure.

You will find a more detailed description of the individual setup options elsewhere. This is merely a brief overview.
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1.

2.

3.

Quick Setup
As administrator, you prepare the setup for the user. If you want to give the user the option of defining their own 
settings in certain areas of the setup, you can prepare a quick setup. A quick setup is a slimmed down version of the 
setup. It only displays areas the user is allowed to change.

To create a quick setup session, proceed as follows:

Enable the password for the administrator in IGEL Setup under Security > Password.

Under Accessories > Quick Settings (see page 559), define the name and options for calling up the 
quick setup.
Under Accessories > Quick Settings > Page Authorizations, (see page 562) enable those areas to 
which the user is to have access.

If users are to be allowed to edit parts of the setup only with a password, enable the 
password for the setup user too.



You can set up a hotkey to start quick setup in appliance mode. Instructions for setting up 
the hotkey can be found under Quick Settings (see page 559).


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1.
2.
3.
4.

Setup Search
The Search function enables you to find parameter fields or parameter values within the setup.

To start a search, click on the button below the tree structure.
Enter the text to be searched for and the search details.
Select one of the hits.
Click on Show result and you will be taken to the relevant setup page. 
The parameter or value found will be highlighted as shown below.
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Sessions
Menu path: Sessions > Sessions Summary

In this area, you will find an overview of all available sessions.

Add: Adds a session from the selection of available session types.

Filter: Filters sessions shown in the list according to the string of characters entered.

Copy Session (see page 53)
Global Session Options (see page 54)
Citrix (see page 55)
RDP Global (see page 122)
RDP Session (see page 149)
Remote Desktop Web Access (see page 165)
Horizon Client Global (see page 179)
Horizon Client Session (see page 206)
Appliance Mode (see page 220)
Caradigm (see page 234)
Leostream (see page 241)
AppliDis (see page 249)
Evidian AuthMgr (see page 256)
NoMachine NX Client (see page 268)
X Sessions (see page 289)
Parallels Client Global (see page 297)
Parallels Client Session (see page 303)
PowerTerm Selection (see page 317)
PowerTerm Session (see page 318)
IBM iAccess Client (see page 322)
ThinLinc Global (see page 345)
ThinLinc Session (see page 352)
SSH Session (see page 366)
VNC Viewer Sessions (see page 374)
Browser Global (see page 384)
Browser Session (see page 411)
Chromium Browser Global (see page 436)
Chromium Sessions (see page 452)
Media Player Global (see page 459)
Media Player Session (see page 465)
Java Session (see page 473)
VoIP Client (see page 478)
Teradici PCoIP Session (see page 492)
AVD Global (see page 499)
AVD Session (see page 505)
deskMate Session (see page 520)
Unified Communications (see page 529)
Desktop Integration (see page 532)
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1.

2.
3.

Copy Session
You can copy a session in the setup. The copy of the session has all the properties of the original session and is 
located in the same folder as the original session.

To copy a session, proceed as follows:

In the setup, open the menu path Sessions > [Session Type] > [Session Type] Sessions.
Example: Sessions > RDP > RDP Sessions 
The existing sessions are shown.
Highlight the session that you want to copy.
In the [Session Type] Sessions area, click . Alternative: Open the context menu of the session 
by right-click and select Copy.
A copy of the session will be created.
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Global Session Options
Menu path: Setup > Sessions > Global Session Options

Network notification on session start: If when launching sessions no network is available, a 
notification will be shown.
☑ Network notification is enabled (default)
☐ Network notification is disabled
Notification delay: Time in seconds after which the notification is shown. (default: 15)
Possible values:

1 ... 120 seconds
Delay session start at boot time to apply new UMS settings: If new settings were made in the 
UMS, the thin client may receive them during the boot procedure.
☑ The session start will be delayed until the settings have been transferred or the time limit has 
been exceeded.
Timeout: Delay in seconds. (default: 10)
Possible values:

1 ... 120 seconds
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Citrix
Menu path: Setup > Sessions > Citrix 

Citrix Client Selection (see page 56)
Citrix Global (see page 57)
Citrix Legacy ICA Sessions (see page 92)
Citrix StoreFront (see page 102)
Citrix Self-Service (see page 116)
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Citrix Client Selection
Menu path: Setup > Sessions > Citrix > Citrix Client Selection

Select which of the installed Citrix client versions is to be used for Citrix sessions.

Citrix client version

Possible options:

"Default" (19.3.0)
"13.5.0"
"13.10.0"
"19.3.0"

•
•

After changing the Citrix client version, check the settings under:
Citrix > Citrix StoreFront > Server
Citrix > Citrix StoreFront > Logon


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Citrix Global
Menu path: Setup > Sessions > Citrix > Citrix Global

This section describes global Citrix settings which apply for all Citrix sessions. Most of these settings can be either 
carried over or overwritten in the individual sessions.

Legacy ICA Server Location (see page 58)
Legacy ICA Login (see page 59)
StoreFront Login (see page 60)
Window (see page 62)
Keyboard (see page 64)
Mapping (see page 65)
Firewall (see page 73)
Options (see page 74)
Native USB Redirection (see page 76)
Fabulatech USB Redirection (see page 79)
Fabulatech Scanner Redirection (see page 83)
HDX Multimedia (see page 84)
Codec (see page 85)
Unified Communications (see page 87)

Please note that a number of configuration options depend on the version of the Citrix Receiver selected. A 
comparison of functions can be found in the FAQs: Citrix Receiver 12/13 Feature Matrix.


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Legacy ICA Server Location
Menu path: Setup > Sessions > Citrix > Citrix Global > Legacy ICA Server Location

Here, you can specify one or more HTTP master browsers. These provide a list of all Citrix servers and all published 
applications which are accessible via the network and use the selected browsing protocol.

To manage the list of master browser, proceed as follows:

 Click  to create a new entry.

 Click  to remove the selected entry.

 Click  to edit the selected entry.

 Click  to copy the selected entry.

You can specify a separate address list for each network protocol. This can be TCP/IP, TCP/IP + HTTP or SSL/TLS + 
HTTPS.

TCP/IP: If your network configuration uses routers or gateways, or if additional network traffic 
owing to transmissions is to be avoided, you can specify special server addresses for the Citrix
servers from which the list of available servers and/or published applications is to be requested.

TCP/IP + HTTP - You can also call up information from the available Citrix servers and published 
applications via a firewall. To do this, you use the protocol TCP/IP + HTTP as the server location.

SSL/TLS + HTTPS: Secure Sockets Layer (SSL) and Transport Layer Security (TLS) offer server 
authentication and data stream encryption. They also allow you to check the integrity of 
messages.

You can add a number of addresses to the address list so that the clients can establish a 
connection and function even if one or more servers are not available.



The "TCP/IP + HTTP" server location supports the auto-locate function.

If you try to establish a non-SSL/TLS connection to an SSL/TLS server, you will not be 
connected. A Connection Failed message will be shown.


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Legacy ICA Login
Menu path: Setup > Sessions > Citrix > Citrix Global > Legacy ICA Login

In this area, you can specify settings for logging in to the ICA client.

Use Kerberos passthrough authentication for all ICA sessions (default: disabled)
☑ Single sign-on for all ICA sessions if login to the thin client with AD/Kerberos is configured.

Use local login window:
☑ The user must enter the password again when logging in.
☐ The local login window will not be used. (default)
Relaunch mode:
☑ The login module is automatically restarted after being closed.
☐ The login module will not automatically restart. (default)
Type:

Set user/domain from last login
Set user/domain from session setup

Preset login information:
☑ The login window is prepopulated with the user name and domain. (default)
Show domain:
☑ Shows the domain entry in the login window. (default)
Set client name to user name
☑ Sets the name of the client of the ICA connection as the user name. (default)

Smartcard logon
☑ Logging in with a smartcard is allowed. (default)

Domains: One or more domains which are to be available. If you enter a number of domains, these 
will be shown in the Domains drop-down area in the login module.
Click  to create a new entry.
Click  to remove the selected entry.
Click  to edit the selected entry.
Click  to copy the selected entry.

The server too must be configured for passthrough authentication. When launching ICA 
sessions, it is then no longer necessary to enter a user name and password again as the 
local login data (domain logon) are transferred for session login purposes.



This setting may help to resolve reconnection problems during load balancing.

Only specific smartcard types are supported. You will find a list of compatible types in the 
Smartcard sub-section of the setup.


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StoreFront Login
Menu path: Sessions > Citrix > Citrix StoreFront > Login

In this area, you can define session-specific login options.

Authentication type: Depending on the Citrix client version, the following types are available:

Password authentication: Suitable for on-premises connections; connections via Citrix NetScaler 
or to a cloud environment may cause problems.
Kerberos passthrough authentication: Uses local login data for listing and launching applications. 
The option enables single sign-on if login with AD/Kerberos is configured on the thin client.
Smartcard authentication (StoreFront only, not Web Interface)
Citrix authentication mechanism (instead of IGEL), Smartcard disabled
Citrix authentication mechanism (instead of IGEL), Smartcard enabled

Additional options include the following:

Use passthrough authentication

☑ Cached login data are used for listing and starting applications.

☐ No passthrough authentication (default)

Auto login

☑ Uses the login data preset on this page when connecting to the server.

☐ Do not log on automatically (default)

User name: Can only be filled in with password authentication

Password: Can only be filled in with password authentication

Domain: Can only be filled in with password authentication

Remember username and domain:

☑ Saves the user name and domain from the last login. (default)

☐ The user name and domain will not be saved.

Synchronize Citrix password with screen lock:

☑ Synchronizes the screen lock password with that of the Citrix application.

☐ No synchronization (default)

Relaunch Citrix login after logout:

☑ Automatically shows the login dialog again after logging off.

If you have set an authentication type with smartcard, select the type of card on the Smartcard (see page 842)
page.



Session passwords are stored with reversible encryption. Therefore, we strongly recommend not to store 
the session password on the endpoint device. 


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☐ Does not start the login procedure again. (default)

Start a single published application automatically: This parameter is relevant if exactly 1 published application is 
provided for the user whose login is configured here.
☑ The published application is started when the user has logged in.
☐ The published application is not started on login. (default)

Start following applications automatically after server connection is established: A list of applications to be 
started in the session.
To edit the list, proceed as follows:

Click on  to create a new entry. In the Add dialog, give the name of the application.

Click on  to remove the selected entry.
Click on  to move the entry upwards.
Click on  to move the entry downwards.

You can also enter part of the name followed by an asterisk (*).

After a successful login, the associated desktop icon for each available application will be placed on the 
thin client desktop. All applications whose name matches one of the names given in the Launch following 
applications automatically after server connection is established area will then be launched.


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Window
Menu path: Setup > Sessions > Citrix > Citrix Global > Window

Under Window, you can configure the following settings:

Only for legacy ICA sessions

Number of colors: Specifies the default color depth.
Possible values:

16
256
32 Thousand
16 million
Automatic

Approximate colors: Given the differences between the color palettes used by the ICA client and 
the thin client desktop, the screen may flash annoyingly if you switch between windows on a 
pseudo-color screen. The ICA client's color adaptation scheme prevents this flashing as it uses the 
colors from the local desktop palette in order to display the ICA window session.
☑ Flashing when switching between windows is avoided.
☐ Disabled (Default)
Default horizontal resolution: Specifies the window width in pixels. (Default: 640)
Default vertical resolution: Specifies the window height in pixels. (Default: 480)
Font smoothing: Enables font smoothing - in the event of performance problems, font smoothing 
should be switched off as it requires additional computing power.

Off
Default
ClearType

For all Citrix sessions

Multimonitor full-screen mode:
Restrict full-screen session to one monitor
Expand full-screen session to all monitors
Expand the session over a self-selected number of monitors

StoreFront start monitor: This setting is available if you selected Restrict full-screen session to 
one monitor for Multimonitor full-screen mode.
Monitor selection: This setting is available if you selected Expand the session over a self-
selected number of monitors for Multimonitor full-screen mode.  

Select this setting if you do not want to span the session across all monitors, but only across 
a certain number of monitors. Under Monitor selection, specify the relevant monitors.



Sample configuration: If you have 4 monitors and want to expand your session across monitor 2, 3 
and 4 you have to insert  2,3,4  or  2,4 .


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Embed systray icons into manager taskbar: Specifies if an application icon is shown in the local 
taskbar.

On
Off

Control bar for Citrix sessions:
☑ Shows a control bar for minimizing and closing a Citrix full-screen session.
☐ Disabled (Default)
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Keyboard
Menu path: Setup > Sessions > Citrix > Citrix Global > Keyboard

On the Keyboard page, you can define alternative key combinations for hotkeys commonly used during ICA 
sessions. In Windows for example, the key combination [Alt]+[F4] closes the current window. This key combination 
works in ICA sessions too. All key combinations with [Alt] which are not used by the X Window Manager function in 
the familiar way during an ICA session.

The following settings can be configured:

Keyboard layout
default: The local keyboard setting will be used in ICA too.
Other Countries

Input language:
default: The local keyboard setting will be used in ICA too.
Other Countries

Mapping Ctrl+Alt+End to Ctrl+Alt+Del for Citrix sessions
☑ The user can use the combination [Ctrl]+[Alt]+[End ]to change the password instead of [Ctrl]+
[Alt]+[Del ]when the corresponding prompt message appears.
☐ No mapping (default)
Keyboard mapping file: You can choose between two alternatives.

generic: Sends language-independent scancodes from the keyboard to the computer.
Linux: Sends language-specific scancodes.

The key alternatives are restricted to [Ctrl]+[Shift]+[Key] by default. However, you can change the 
settings by clicking on the Hotkey Modifier drop-down field and/or hotkey symbol for the relevant 
key combination.

Possible keys: [F1] – [F12] , [Plus], [Minus], [Tab]
Possible modifiers: [Shift], [Ctrl], [Alt], [Alt]+[Ctrl], [Alt]+[Shift], [Ctrl]+[Shift]
Toggle SpeedScreen: Key combination for switching SpeedScreen (client reacts 
immediately to keyboard inputs or mouse clicks) on and off alternately.
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Mapping
Menu path: Setup > Sessions > Citrix > Citrix Global > Mapping

Locally connected devices such as printers or USB storage devices can be made available in ICA sessions.

_________

Drive Mapping (Citrix) (see page 66)
COM Ports (see page 68)
Printer (see page 70)
Device Support (see page 71)
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Drive Mapping (Citrix)

Menu path: Setup > Sessions > Citrix > Citrix Global > Mapping > Drive Mapping

Through drive mapping, each directory mounted on the thin client (including CD-ROMs and disk drives) is made 
available to you during ICA sessions on Citrix servers.

In this area, you can specify which drives and paths are mapped during the logon. This applies for all ICA sessions.

Drive mapping:
☑ Citrix servers can access the thin client's local drives. (default)

To manage the Drive Mapping list, proceed as follows:

 Click on  to create a new entry.

 Click on  to remove the selected entry.

 Click on  to edit the selected entry.

 Click on  to copy the selected entry.

Add Drive Mapping

Enable:
☑ The drive will be made available in the session.
Drive to map: DOS-style drive letters on the Citrix Server.

Local (USB) devices which are to be used for drive mapping purposes must first be set up as storage 
devices.



•
•

•

Before you unplug a hotplug storage device from the thin client, you must safely remove it. Otherwise, 
data on the hotplug storage device can be damaged. Depending on the configuration, there is one or 
several possibilities to safely remove a hotplug storage device:

Click on  in the task bar. The taskbar is not available in a fullscreen session.
Click on in the in-session control bar. Depending on the configuration, the in-session 
control bar may be available in a fullscreen session. For further information, see In-session 
Control Bar.
Function Accessories > Safely Remove Hardware with further starting possibilities; 
amongst other things, a hotkey can be defined here.
If the following warning is displayed: Volume(s) still in use. Dont' remove the device., 
then the hotplug storage device must not be removed. First, exit the program concerned 
or close all files or directories that reside on the hotplug storage device.


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Local drive path: Unix path name of the local directory to which the mapping is to refer.

Read access
Possible options:

yes
no
ask user: The read access right is queried when each ICA session is accessed for the first 
time.

Write access
Possible options:

yes
no
ask user: The write access right is queried when each ICA session is accessed for the first 
time.

If the drive letter you have selected is no longer available on the Citrix server, the specified 
directory or local drive will be given the next free letter during the logon.



If you map a locally connected device, use the pre-defined path names available in the 
drop-down field.


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COM Ports

Menu path: Setup > Sessions > Citrix > Citrix Global > Mapping > COM Ports

COM port mapping
☑ Enables the mapping of serial devices connected to the thin client to the serial interfaces of the 
Citrix server. (Default)

To manage the list of COM port devices, proceed as follows:

 Click  to create a new entry.

 Click  to remove the selected entry.

 Click  to edit the selected entry.

 Click  to copy the selected entry.

Add

COM port device: Allows you to select from all serial and USB interfaces on the device.
Possible values:

COM 1
COM 2
COM 3
COM 4
USB COM 1
USB COM 2
USB COM 3
USB COM 4

Detect Devices...: Opens a dialog allowing you to select the device file. 3 device files are available 
for each device; the Description column shows the type of device file:

(GENERIC) [device designation]: Generic type. The name of the device file ends in a 
consecutive number which depends on the boot procedure or the order of insertion. 
Example: /dev/ttyUSB0

(BY PORT) [device designation]: According to USB port. The device file is in the /dev/

usbserial/  directory. The name of the device file ends in the number of the USB port 

that the device is plugged into. Example: /dev/usbserial/ttyUSB_P12

(BY USBID) [device designation]: According to USB ID. The device file is in the /dev/

usbserial/  directory. The name of the device file ends as follows: _V[Vendor 

ID]_P[Product ID] . Example: /dev/usbserial/ttyUSB_V067b_P2303

If you would like to use signature pads, you must enable them beforehand under User 
Interface > Input > Signature Pad (see page 714).


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• (Virtual) [device designation]: Virtual device; used for signature pads for example. Example: 
/dev/ttyVST0

If your device has an additional multiport PCI card, more than 2 connections may be 
available.


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Printer

Menu path: Setup > Sessions > Citrix > Citrix Global > Mapping > Printer

You can set up a printer for ICA sessions here.

Client printer mapping: With this function, the locally connected thin client printer is made 
available for your ICA sessions, provided that it was not disabled on the server side.
Set another default printer:
☑ Allows you to specify a default printer for the client which differs from the one defined in the 
printer setup.
☐ Do not set another default printer. (default)
Default printer: Print queues used on the thin client to specify the default printer for the session. 
lp  is the locally configured default printer.

Default printer driver: Windows driver name for the printer which is automatically set up. Enter 
one of the universal drivers or your own driver name here. 
Possible values:

Metaframe XP PS universal driver
Metaframe XP PCL5c universal driver
Metaframe XP PCL4 universal driver
Citrix PCL4 universal driver (old)
User entry

Because the thin client merely places incoming print jobs in a queue, you need to install the printer on the server.

The printers must be set up on the Devices > Printers > CUPS > Printer page and must be 
enabled there for mapping in ICA sessions, see ICA sessions.


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Device Support

Menu path: Setup > Sessions > Citrix > Citrix Global > Mapping > Device Support

In this area, you can enable virtual ICA channels for communicating with various devices connected to the thin 
client.

The devices supported are listed in the IGEL Third Party Hardware Database5.

DriveLock channel: The virtual DriveLock channel is implemented on the thin client. The channel must also be 
installed on the Citrix server.
DriveLock can read hardware data from local USB devices and transfer these data to the Citrix server with the help 
of the Virtual ICA Channel Extension. From IGEL Linux Version 10.03.500, this is also possible with SATA devices. 
When using whitelists, rules based on the hardware properties of the connected drive (e.g. manufacturer details, 
model and serial number) are taken into account.

Important information regarding DriveLock can be found in the FAQ Using DriveLock with IGEL Devices.

☑ A virtual channel for DriveLock is enabled.

☐ No virtual channel for DriveLock is enabled. (Default)

deviceTRUST channel

☑ A virtual channel for deviceTRUST is enabled.

☐ No virtual channel for deviceTRUST is enabled. (Default)

Crossmatch DigitalPersona fingerprint channel

☑ A virtual channel for Crossmatch DigitalPersona is enabled.

☐ No virtual channel for Crossmatch DigitalPersona is enabled. (Default)

Diktamen Channel for Dictation
☑ A virtual channel for Diktamen is enabled.
☐ No virtual channel for Diktamen is enabled. (Default)

Grundig MMC-Kanal for dictation with Grundig devices

☑ A virtual channel for communication with Grundig devices is enabled.

☐ No virtual channel for communication with Grundig devices is enabled. (Default)

Nuance channel for dictation: Virtual audio channel for dictation devices. Dictation microphones from Grundig, 
Philips and Olympus are supported.

☑ The Nuance audio channel is enabled.

☐ The Nuance audio channel is not enabled. (Default)

Olympus Channel for dictation

☑ A virtual channel for communication with Olympus devices is enabled.

This channel is only responsible for audio transmission. The channel for dictation device operating 
elements is manufacturer-specific and must be enabled separately.



https://www.igel.com/linux-3rd-party-hardware-database/
https://www.igel.com/linux-3rd-party-hardware-database/
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☐ No virtual channel for communication with Olympus devices is enabled. (Default)

signotec signature pad channel

☑ A virtual channel for communication with signotec signature pads is enabled.

☐ No virtual channel for communication with signotec signature pads is enabled. (Default)

StepOver signature pad channel

☑ A virtual channel for communication with StepOver signature pads is enabled.

☐ No virtual channel for communication with StepOver signature pads is enabled. (Default)

Philips speech channel for dictation

☑ A virtual channel for communication with Philips dictation devices is enabled.

☐ No virtual channel for communication with Philips dictation devices is enabled. (Default)

DPM server drive: Via this drive, the Philips PocketMemo dictation device makes the voice recordings available to 
the server. (Default: P)

SpeechAir server drive: Via this drive, the Philips SpeechAir dictation device makes the voice recordings available 
to the server. (Default: S)

Kofax SPVC signature pad channel

☑ The Kofax SPVC signature pad channel is enabled.

☐ The Kofax SPVC signature pad channel is not enabled. (Default)

Lakeside SysTrack channel

☑ The Lakeside SysTrack channel is enabled.

☐ The Lakeside SysTrack  channel is not enabled. (Default)

The dictation device is automatically assigned to the selected drive letter. Ensure that no other Hotplug 
storage device is assigned to this drive letter. Further information can be found under Hotplug storage 
device (see page 807) and Drive mapping (see page 66).



The dictation device is automatically assigned to the selected drive letter. Ensure that no other Hotplug 
storage device is assigned to this drive letter. Further information can be found under Hotplug storage 
device (see page 807) and Drive mapping (see page 66).


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Firewall
Menu path: Setup > Sessions > Citrix > Citrix Global > Firewall

In this area, you can configure the following firewall settings:

Alternative address:
☑ Allows you to use a proxy or Secure Gateway server as an alternative address for connections 
via a firewall.
☐ Do not use an alternative address (default)

SOCKS / Secure Proxy

Proxy type
None (Direct Connection)
SOCKS: A proxy that uses the SOCKS protocol
Secure (HTTPS): An HTTP proxy with TLS/SSL encryption.

Proxy server: Name or IP address of the proxy server
Proxy port: TCP port of the proxy server (default: 1080)

Secure Gateway (relay mode)

Secure gateway address: If you would like to use a Citrix Secure Gateway in relay mode, you must 
give the full DNS name – the IP address is not sufficient in this case.
Port: TCP port of the gateway (default: 443)

After enabling the alternative address, add the server to the address list under Sessions > 
Citrix > Citrix Global > Legacy ICA Server Location.


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Options
Menu path: Setup > Sessions > Citrix > Citrix Global> Options
In this area, you can set up additional options to optimize the system's general behavior and its performance.

Use server redraw

☑ The Citrix server is responsible for refreshing the screen content.

☐ Do not use server redraw (default)

Disable Windows alert sounds

☑ Switches off the Windows warning sounds.

☐ The warning sounds remain enabled. (default)

Backing store

☑ The X Server temporarily stores hidden window content.

☐ Window content is not stored. (default)

Deferred screen update mode

☑ Enables delayed updates from the local video buffer on the screen. The local video buffer is used if the seamless 
Windows mode or HDX latency reduction is used.

☐ No delayed update (default)

Cache size in kB: (default: 1024)

Minimum bitmap size in bytes: The minimum size of the bitmap files that are to be stored in the cache (default: 
1024).

Persistent cache path: The directory where the files are to be stored locally. (default: $ICAROOT/cache)

Scrolling control: Depending on the speed of your network or the response time of your server, there may be a 
delay between you letting go of the mouse button on a scroll bar and the scrolling actually stopping (e.g. when 
using Excel). Changing this value may help (default: 100)

Audio bandwidth limit in StoreFront sessions

High
Medium
Low

Auto reconnect

☑ Automatically attempt to reconnect if connection is terminated (default)

☐ Do not attempt to reconnect.

Do not make the cache too big otherwise you run the risk of the thin client having too little storage space 
for its own system and other applications. You may have no alternative but to equip your thin client with 
additional RAM.



Higher quality requires more network and computing resources.
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Maximum retries: (default: 3)

Delay in seconds before reconnecting: (default: 30)

Allow Kerberos passthrough authentication in StoreFront sessions

☑ Kerberos passthrough authentication is allowed. (default)

☐ Kerberos passthrough authentication is not allowed.

CGP address

Use server address
Text input
disabled

Multi-Stream sessions

☑ Support Multi-Stream ICA 

☐ Do not support Multi-Stream ICA (default)

HDX Adaptive Transport over EDT
Possible options:

UDP with fallback to TCP
TCP Only - UDP disabled
UDP without fallback to TCP

This point concerns Citrix XenApp in Version 6.5 and older.
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Native USB Redirection
Menu path: Sessions > Citrix > Citrix Global > Native USB Redirection

USB devices can be permitted or prohibited during a Citrix session on the basis of rules. Sub-rules for specific 
devices or device classes are also possible. The use of rules is described under USB Access Control (see page 812).

Native USB redirection

☑ Native USB redirection is enabled globally.

Default rule: This rule will apply if no special rule was configured for a class or a device.

Deny
Allow

Class Rules

Class rules apply to USB device classes and sub-classes.

To manage rules, proceed as follows:

 Click  to create a new entry.

 Click  to remove the selected entry.

 Click  to edit the selected entry.

 Click  to copy the selected entry.

Add class rule:

Rule:

Allow
Deny

Class ID: Selection list

Sub-class ID: Selection list

Name: Free text entry

Enable either native USB redirection or Fabulatech USB redirection, but not both together.

Disable USB redirection if you use DriveLock. Further information can be found under Using DriveLock 
with IGEL Devices.



Tip

To secure your endpoint, it is generally recommended to set Default rule to Deny and to configure 
Allow rules only for the required USB devices and USB device classes. 


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Device Rules

Device rules apply to specific USB devices.

Add device rule:

Rule:

Allow
Deny

Vendor ID: Hexadecimal manufacturer number

Product ID: Hexadecimal device number

Getting USB Device Information

To find out the Class ID, Subclass ID, Vendor ID and Product ID of the connected USB device, you can use 
the System Information tool. For further information, see Using “System Information” Function (see page 
634).
System Information example:

Alternatively, you can use the command lsusb  (or lsusb | grep -i [search term] ) in the 
terminal.


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Name: Free text entry

Example for lsusb :
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Fabulatech USB Redirection
Menu path: Sessions > Citrix > Citrix Global > Fabulatech USB Redirection

Redirection for USB devices can be allowed or denied during a Citrix session on the basis of rules. Sub-rules for 
specific devices or device classes are also possible. The use of rules is described under USB Access Control (see page 
812).

Fabulatech USB Redirection

☑ Fabulatech USB Redirection is enabled for all Citrix sessions.

Default rule: This rule will apply if no special rule was configured for a class or a device.

Deny
Allow

Class Rules

Class rules apply to USB device classes and sub-classes.

Managing rules:

 Create a new entry

 Remove the selected entry

 Edit the selected entry

 Copy the selected entry

Class rule properties:

Rule:

For the Fabulatech USB Redirection, a server-side component is required. We recommend the USB for 
Remote Desktop IGEL Edition; see http://www.usb-over-network.com/partners/igel/.



Enable either Native or Fabulatech USB Redirection – not both together. Disable USB redirection if you 
use DriveLock.



Ensure that no other Hotplug storage device (USB stick) is connected if a session is started with Fabulatech 
USB Redirection. Otherwise, the hotplug storage device will not be securely removed when the session 
starts, and this could lead to data loss. With IGEL Linux Version 10.02.x the Hotplug storage device is 
already insecurely removed when the Fabulatech USB Redirection is enabled.



Tip

To secure your endpoint, it is generally recommended to set Default rule to Deny and to configure 
Allow rules only for the required USB devices and USB device classes. 



http://www.usb-over-network.com/partners/igel/
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Allow: Devices that have the properties defined here are redirected by the Fabulatech USB 
Redirection.
Deny: Devices that have the properties defined here are not redirected.

Class ID: Device class

Subclass ID: Subclass relating to the specified device class

Name: Free text entry

Override serial: Serial number that will appear in the session

Override name: Device name that will appear in the session

Postpone

☑ The USB device is only removed from the system (endpoint device) when the session starts.

☐ The USB device is no longer shown immediately after the system is booted.

Takeaway

☑ The USB device may be removed from the system (endpoint device).

☐ The USB device may not be removed.

No Reset

☑ The device will not be automatically reset after the connection with the session has been terminated.

☐ The device will be reset after the connection with the session has been terminated.

Device Rules

A device rule applies to a specific device that is identified by its serial number.

Device rule settings:

Rule:

Allow
Deny

Vendor ID: Hexadecimal manufacturer number

Product ID: Hexadecimal device number

This setting is only effective if the Takeaway parameter is enabled.

Getting USB Device Information

To find out the Class ID, Subclass ID, Vendor ID and Product ID of the connected USB device, you can use 
the System Information tool. For further information, see Using “System Information” Function (see page 
634).
System Information example:


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Name: Free text entry

Override serial: Serial number that will appear in the session.

Override name: Device name that will appear in the session.

Postpone

☑ The USB device is only removed from the system (endpoint device) when the session starts.

☐ The USB device is no longer shown immediately after the system is booted.

Alternatively, you can use the command lsusb  (or lsusb | grep -i [search term] ) in the 
terminal.
Example for lsusb :
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Takeaway

☑ The USB device may be removed from the system (endpoint device).

☐ The USB device may not be removed.

No Reset

☑ The device will not be automatically reset after the connection with the session has been terminated.

☐ The device will be reset after the connection with the session has been terminated.

This setting is only effective if the Takeaway parameter is enabled.
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Fabulatech Scanner Redirection
Menu path: Sessions > Citrix > Citrix Global > Fabulatech Scanner Redirection

Redirection for a Fabulatech scanner can be allowed during a Citrix session.

Fabulatech Scanner for Remote Desktop

☑ Fabulatech Scanner for Remote Desktop is enabled.

For more information, see Citrix Fabulatech Scanner Redirection.
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HDX Multimedia
Menu path: Sessions > Citrix > Citrix Global > HDX Multimedia

HDX multimedia redirection improves the playback of audio and video content during a Citrix session.

Hardware acceleration for multimedia playback is available on specific devices.  For further information, see 
Hardware Video Acceleration on IGEL OS.

Multimedia redirection

☑ Multimedia data are sent to the device and decoded there.

☐ Multimedia data are decoded on the server. (Default)

HDX RealTime WebCam redirection

☑ Redirection is enabled.

The following webcam parameters can be adjusted (for information on how to determine the capabilities of the 
webcam, see Using Webcam Information (see page 661)): 

HDX WebCam frame rate. (Default: 5)
HDX WebCam quality. (Default: 16)
HDX WebCam width. (Default: 352)
HDX WebCam height. (Default: 288)
HDX WebCam delay time. (Default: 2000)
HDX WebCam delay type. (Default: 1)

☐ Redirection is disabled. (Default)

HDX RealTime Media Engine

☑ The HDX RealTime Media Engine is enabled and significantly improves the performance of Lync / Skype for 
Business.

☐ The HDX RealTime Media Engine is not used. (Default)

Content redirection

☑ Specific content types are opened with a local program, e.g. PDF documents with Evince.

☐ Content redirection is disabled. (Default)

Browser content redirection

☑ The browser content is redirected from the server to the device, e.g. to relieve the load on the server.

☐ Browser content redirection is disabled. (Default)
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Codec
Menu path: Setup > Sessions > Citrix > Citrix Global > Codec

Graphical codec: Decoding method for the transferred screen content

Automatic: Automatically selects the appropriate codec according to the performance of the 
hardware.
H.264 Deep Compression Codec:

High image quality is possible, with lower network load
Without available hardware acceleration it is very CPU intensive.

JPEG: 
High image quality possible, with high network load
Moderate CPU load

Additional parameters for H.264 Deep Compression Codec

These parameters are relevant if Automatic or H.264 Deep Compression Codec is selected.

Accelerated H.264 Deep Compression Codec 
☑ Enables hardware-accelerated decoding with H.264, which reduces CPU load.
☐ Uses the software implementation of H.264 and results in a greater CPU load. (default)
For more information, read the Setting up Citrix Sessions with Hardware-Accelerated H.264 Deep 
Compression Codec How-To.

Following options are available in combination with H.264 Deep Compression Codec:

Text tracking:
☑ Loss-free depiction of texts (default)
Text is displayed sharper, especially if "Visual Quality" is set to Low/Medium. Recommended for 
office applications, but requires a higher available bandwidth. With bad connection and EDT over 
UDP it can lead to missing text parts.
Small frames feature:
☑ Pixel-perfect depiction of lines etc. (default)
This feature allows efficient processing when only a small part of the screen changes over time (for 
example, when a cursor flashes on an otherwise stable background).

•
•

•

•

At the Citrix Server following policies must be set:
Use video codec for compression must be enabled.
For the entire screen: Text tracking should be enabled if bandwidth is not a 
problem to increase readability in Office applications
For actively changing regions: Citrix Receiver 13.6+ required, otherwise 
JPEG fallback will be loaded
Use video codec when preferred: If For actively changing regions is 
selected by Citrix, a Citrix receiver 13.6+ must be activated, otherwise JPEG 
fallback is loaded.


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Additional parameters for JPEG

These parameters are relevant if JPEG is selected.

JPEG direct-to-screen decoding
☑ Decodes image tiles directly without using a bitmap cache.
☐ No JPEG direct-to-screen decoding (default)
JPEG batch decoding
☑ Enables batch processing and delayed XSync. (default)
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Unified Communications
Menu path: Sessions > Citrix > Citrix Global > Unified Communications

VDI Solutions (see page 88)
Skype for Business (see page 89)
Cisco Jabber (see page 90)
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VDI Solutions

Menu path: Sessions > Citrix > Citrix Global > Unified Communications >VDI Solutions

Microsoft Teams optimization

☑ The audio and video streams for Microsoft Teams are redirected between the endpoint devices. Audio and video 
data are not processed by the server.

☐ The audio and video streams for Microsoft Teams are not redirected.

Zoom Media Plugin

☑ The audio and video streams for Zoom are redirected between the endpoint devices. Audio and video data 
are not processed by the server.

☐ The audio and video streams for Zoom are not redirected.

Server and Network Requirements

Microsoft Teams optimization requires additional configuration on the Citrix VDI Desktop image, as well as 
some additional network configurations.
For more information, please see the following article by Citrix: https://docs.citrix.com/en-us/citrix-virtual-
apps-desktops/multimedia/opt-ms-teams.html



https://docs.citrix.com/en-us/citrix-virtual-apps-desktops/multimedia/opt-ms-teams.html
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Skype for Business

Menu path: Setup > Sessions > Citrix > Citrix Global > Unified Communications > Skype for Business

The HDX Realtime Media Engine is required for using Skype for Business in a HDX/ICA session.

HDX Realtime Media Engine

☑ The HDX Realtime Media Engine is active.

☐ The HDX Realtime Media Engine is not active. (Default)
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Cisco Jabber

Menu path: Sessions > Citrix > Citrix Global > Unified Communications > Cisco Jabber

For vendor documentation, see Deployment and Installation Guide for Cisco Jabber Softphone for VDI—HP Thin Pro 
and Ubuntu Release 12.16.

Cisco JVDI Client

Codec Pack

The Cisco JVDI Client configuration is only displayed if the Multimedia Codec Pack (MMCP) is present. See 
also the list with features that require codec pack.



•
•
•

•
•
•

Feature with Limited Functionality

As of IGEL OS 10.05.100, there is a special 32 bit sandbox solution for Cisco JVDI which requires Citrix 
Receiver 13.9.1 (32 bit). When Cisco JVDI is enabled (downloaded and installed), Citrix Receiver 13.9.1 (32 
bit) is used automatically. The selection under Sessions > Citrix > Citrix Client Selection is ignored.
The following features cannot be used in a session with Citrix Receiver 13.9.1 (32 bit):

Multimedia redirection
Smartcard authentication
Native USB redirection, which implies that peripherals like signature pads, dictation 
devices etc. can not be used
FabulaTech USB redirection
RTME (Skype for Business)
HTML5 redirection



1.

2.

3.
4.
5.

Feature Must Be Enabled

The Cisco JVDI Client must be enabled explicitly. This involves an additional software download and 
installation. To enable the feature, proceed as follows:

Ensure that the settings under System > Update > Firmware Update are correct. 
The Server Path must point to the firmware version that is currently installed. This is 
required because the appropriate software package for the Cisco JVDI Client must be 
downloaded in order to deploy the feature.
Go to System > Firmware Customization > Features and activate Cisco JVDI Client 
(Limited functionality – see product documentation for details).
Confirm the warning dialog with Ok.
Click Ok in the main window.
Reboot the thin client.
On reboot, the thin client downloads and installs the software package for the Cisco JVDI 
Client .



https://www.cisco.com/c/en/us/td/docs/voice_ip_comm/jvdi/12_1/hp_ubuntu/deploy/jvdi_b_deployment-installation-jvdi-hp-unbuntu-12-1/jvdi_b_deployment-installation-jvdi-hp-unbuntu-12-1_chapter_011.html
https://www.cisco.com/c/en/us/td/docs/voice_ip_comm/jvdi/12_1/hp_ubuntu/deploy/jvdi_b_deployment-installation-jvdi-hp-unbuntu-12-1/jvdi_b_deployment-installation-jvdi-hp-unbuntu-12-1_chapter_011.html
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☑ The Cisco JVDI Client is enabled. 

☐ The Cisco JVDI Client is disabled. 

Audio

Default volume: Headphone volume control (Default: 80%)

Default microphone volume: Microphone volume control (Default: 80%)

Default ring volume: Ringtone volume control (Default 100%)

Internal sound card: Here you have the possibility to define a sound card. If you leave the field empty, the default 
sound card of the system is used.

For further information, see Sound Preferences (see page 578).

Video

You can set the Cisco JVDI Client to use the default resolutions of the camera or to use a user-defined set of 
resolutions. Separate configurations for cameras with and without hardware acceleration are possible.

Allow default resolutions (for cameras without hardware resolution)

☑ The default resolutions of the camera are used.

☐ A user-defined set of resolutions is used. You can add a resolution by clicking   in the Camera area and 
selecting the desired resolution.

Allow default resolutions (for cameras with hardware resolution)

☑ The default resolutions of the camera are used.

☐ A user-defined set of resolutions is used. You can add a resolution by clicking   in the Hardware 
Accelerated Camera area and selecting the desired resolution.
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Citrix Legacy ICA Sessions
Menu path: Setup > Sessions > Citrix > Citrix Legacy ICA Sessions

You can set up your own ICA sessions here.

The global ICA session settings can be changed in the individual sessions.

The primary source of further information relating to Citrix connections should always be the relevant Citrix
documentation. This manual merely gives general configuration tips.

_____

Server (see page 93)
Logon (see page 94)
Window (see page 95)
Firewall (see page 96)
Reconnect (see page 97)
Options (see page 98)
Desktop Integration (see page 100)
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Server
Menu path: Setup > Sessions > Citrix > Citrix Legacy ICA Sessions > [ICA Session] > Server

In this area, you can specify the following server connection details regardless of the default settings:

Browser protocol: The protocol that is to be used when searching for servers and published 
applications

Default
TCP/IP + HTTP
TCP/IP
SSL + HTTPS

Do not use default server location:
☑ Lifts the default server requirement – for each protocol separately
☐ Default server location is used (default)

HTTP server location

Several names or IP addresses of the server and application browser

Citrix server: By selecting the server, the user is connected to the entire desktop as if logging on at 
the server itself. As a result, all applications, rights and settings contained in the user's profile 
(local server profile) are available. (default: enabled)
Published application: If you select a published application, the session is opened in a window 
which contains just one application. The session is ended when you close this application. 
(default: disabled)
Server: Application name, server or IP address

Click on Browse to send a transmission signal which searches through all available servers 
and published applications.

Application: If you have entered the server manually, you can specify a published application 
here. These fields are automatically filled in if you have found one of the recognized published 
applications as a result of the search.
Work directory: Complete path of the work directory for the application on the server.

ICA sessions only function with XenApp servers of Version 6.5 or older.
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Logon
Menu path: Setup > Sessions > Citrix > Citrix Legacy ICA Sessions > [ICA Session] > Logon

Use Kerberos passthrough authentication for this session:

☑ Single sign-on will be enabled for this ICA session if Log on to the thin client with AD/Kerberos is configured. The 
server too must be configured for passthrough authentication. When launching the ICA session, there is no need to 
enter a user name and password again.

☐ Kerberos passthrough authentication will not be enabled. (default)

Use passthrough authentication for this session:

☑ Single sign-on will be enabled for this ICA session if Log on to the thin client with AD/Kerberos is configured. The 
fact that the user name and password are temporarily stored when logging on to the thin client means that there is 
no need to enter them again when launching a session.

☐ Passthrough authentication will not be enabled. (default)

User name: Specifies the user name. These details are automatically forwarded to the server and no longer need to 
be entered on the logon screen.

Password: Specifies the password

Domain: Specifies the domain

Do not show password protection window before login:

☑ The Windows splash screen is disabled. (default)

☐ The Windows splash screen is not disabled.

This option must be disabled when logging on to Windows using a smartcard.
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Window
Menu path: Setup > Sessions > Citrix > Citrix Legacy ICA Sessions > [ICA Session] > Window

Number of colors: Specifies the default color depth.
Possible values:

16
256
32 thousand
16 million
Automatic
Default: The value set in HDX/ICA Global

Use default settings for colormap
☑ Default settings are enabled. (default)
☐ The settings for this setup page are enabled.
Approximate colors
☑ The color table will be approximated for this session.
☐ The color table will remain preset on a global basis. (default)
Use Full-Screen
☑ Use full-screen mode if possible. (default)
☐ Full-screen mode will not be used.
Use Full-Screen restricted to work area:
☑ In this full-screen mode, the local taskbar can be used at the same time.
☐ The full screen covers the local taskbar (default).
Window size:

Default
640x480
800x600
1024x768
1280x1024
1600x1200

Start monitor: Starts the session window on this monitor.
No configuration
1st Monitor
2nd Monitor

Seamless window mode:
☑ The seamless mode is enabled. It can only be used with published applications or with a 
specified start program for the server connection.
☐ The seamless mode is disabled. (default)
Font smoothing: Font smoothing is preset on a global basis. You can change it for this session.

Global setting
Off
Default
ClearType
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Firewall
Menu path: Setup > Sessions > Citrix > Citrix Legacy ICA Sessions > [ICA Session] > Firewall

In this area, you can specify the following firewall details regardless of the default settings:

Use default alternate address setting
☑ Default alternate address setting is used (default)
☐ Default alternate address setting is not used
Use alternative address: Define a proxy or Secure Gateway server as an alternative address for 
connections via a firewall. Note the tool tips regarding the individual configuration parameters.
☑ Use alternate address for firewall connections
☐ Disabled (default)

SOCKS / Secure proxy

Use default proxy settings
☑ Default proxy settings are used (default)
☐ Default proxy settings are not used
Proxy Type:

None (Direct Connection)
SOCKS: A proxy that uses the SOCKS protocol
Secure (HTTPS): An HTTP proxy with TLS/SSL encryption.

Proxy Server: Name or IP address of the proxy server
Proxy Port: TCP port of the proxy server (default: 1080)

Secure Gateway (relay mode)

Use default Secure Gateway settings
☑ Default Secure Gateway settings are used (default)
☐ Default Secure Gateway settings are not used
Secure Gateway address: If you would like to use a Citrix Secure Gateway in relay mode, you must 
give the full DNS name – the IP address is not sufficient in this case.
Port: TCP port of the gateway (default: 443)

After enabling the alternative address, add the server to the address list under Setup > 
Sessions > Citrix > Legacy ICA Sessions > ICA Session > Server.


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Reconnect
Menu path: Setup > Sessions > Citrix > Citrix Legacy ICA Sessions > [ICA Session] > Reconnect

Use default auto reconnect settings
☑ The default settings are used. (default)
Auto reconnect
☑ Auto Reconnect is enabled. (default)
Maximum retries: Maximum number of repeated attempts (default: 3)
Delay in seconds before reconnecting: (default: 30)
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Options
Menu path: Setup > Sessions > Citrix > Citrix Legacy ICA Sessions > [ICA Session] > Options

Compression: Reduces the quantity of data transmitted via the ICA session. This in turn reduces 
network traffic to the detriment of CPU performance. (default: disabled)

Persistent cache: Enables caching in the cache memory (configured in the global ICA settings) for 
each session. (default: disabled)

Encryption level:
Basic
RC5 (128 bit - logon only)
RC5 (40 bit)
RC5 (56 bit)
RC5 (128 bit)

Client audio:
☑ Transfer system sounds and audio output from applications to the thin client. (default)
Audio bandwith limit:

High
Medium
Low

Speedscreen Latency Reduction

Mouse click feedback: The mouse pointer immediately turns into an hourglass symbol, thus 
providing visual feedback in response to a mouse click.

Automatic
Off
On

•
•

Enable compression if you connect your server(s) via WAN.
Disable this option if you use a relatively low-performance server and only work in 
one LAN.



Caching image data makes sense if you use a number of ICA sessions but only one or two 
sessions are critical with regards to network bandwidth or are used heavily during the day. 
In this case, you should reserve the cache memory for these sessions.



Encryption increases the security of your ICA connection. Basic encryption is enabled by 
default. You should therefore ensure that the Citrix server supports RC5 encryption before 
you select a higher degree of encryption.



The higher the level of audio quality you select, the more bandwidth is needed for 
transferring audio data.


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Local text echo: Displays the text entered more quickly.
Automatic: If you are not sure how fast the connection is.
Off: For faster connections (connection via a LAN)
On: For slower connections (connection via WAN) in order to reduce the delay between the 
user entering text and the text being displayed on the screen.
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Desktop Integration
Menu path: Setup > Sessions > Citrix > Citrix Legacy ICA Sessions > [ICA Session] > Desktop Integration

Session name: Name for the session

Starting Methods for Session

Start menu

☑ The session can be started with the start menu.

Application Launcher

☑ The session can be started with the Application Launcher.

Desktop:

☑ The session can be started with a program starter on the desktop.

Quick start panel:

☑ The session can be started with the quick start panel.

Start menu's system tab

☑ The session can be started with the start menu’s system tab.

Application Launcher's system tab

☑ The session can be started with the Application Launcher’s system tab.

Desktop context menu

☑ The session can be started with the desktop context menu.

Menu folder: If you specify a folder name or a path comprising a number of folder names separated by "/", a menu 
path will be created for the session. The menu path will be used in the start menu and in the desktop context menu.

Path in the Application Launcher: If you specify a folder name or a path comprising a number of folder names 
separated by "/", a menu path will be created for the session. The menu path will be used in the Application 
Launcher.

Desktop folder: If you specify a folder name or a path comprising a number of folder names separated by "/", a 
menu path will be created for the session. The menu path will be used for the program launcher on the desktop.

Password protection: Specifies which password will be requested when launching the session.
Possible values:

None: No password is requested when launching the session.
Administrator: The administrator password is requested when launching the session.
User: The user password is requested when launching the session.
Setup user: The setup user's password is requested when launching the session.

Hotkey:

The session name must not contain any of these characters: \ / : * ? “ < > | [ ] { } ( )
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☑ The session can be started with a hotkey. A hotkey consists of one or more modifiers and a key.

Modifiers: A modifier or a combination of several modifiers for the hotkey. You can select a set key symbol/
combination or your own key symbol/combination. A key symbol is a defined chain of characters, e.g.  Ctrl .

These are the pre-defined modifiers and the associated key symbols:

(No modifier) =  None

 =  Shift
[Ctrl] =  Ctrl

 =  Mod4

[Alt] =  Alt

Key combinations are formed as follows with  | :

Ctrl +   =  Ctrl|Super_L

Key: Key for the hotkey

Autostart: If this option is enabled, the session will be launched automatically when the thin client boots.

Restart: If this option is enabled, the session will be relaunched automatically after termination.

Autostart delay: Waiting time in seconds between the thin client booting and the session being launched 
automatically.

Autostart requires network

☑ If no network is available at system startup, the session is not started. A message is shown. As soon as the 
network is available, the session is started automatically.

☐ The session is started automatically, even when no network is available.

Do not use [AltGr] as a modifier (represented as Mod5 ). Otherwise, the key that is configured as a hotkey 
with AltGr cannot be used as a regular key anymore. Example: If you configure [AltGr] + [E] as a hotkey, it is 
impossible to enter an "e".



When this keyboard key is used as a modifier, it is represented as Mod4 ; when it is used as a key, it 

is represented as Super_L .



To enter a key that does not have a visible character, e. g. the [Tab] key, open a terminal, log on as user

and enter xev -event keyboard . Press the key to be used for the hotkey. The text in brackets that 

begins with keysym  contains the key symbol for the Key field. Example: Tab  in (keysym 0xff09, 

Tab)


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Citrix StoreFront
Menu path: Sessions > Citrix > Citrix StoreFront

Most of the settings were already configured under Citrix Global and Legacy ICA Sessions.

Server (see page 103)
Login (see page 105)
Appearance (see page 107)
Reconnect (see page 108)
Refresh (see page 110)
Logoff (see page 112)
Desktop Integration (see page 114)
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Server
Menu path: Setup > Sessions > Citrix > Citrix StoreFront > Server

Citrix server type:
Web Interface / Services Site: For Citrix XenApp Version 6.5 and older
StoreFront: For Citrix XenApp Version 6.5 and 7
StoreFront Legacy Mode: For Citrix XenApp Version 6.5 and 7 in Legacy Mode

Server location: You can set up up to 5 Citrix master browsers per domain. If the first browser is 
not available, the second will be queried and so on. Please note that multiple farms can be 
searched. You can therefore specify addresses for a number of server farms.
To manage the list, proceed as follows:

Click on  to create a new entry.
Click on  to remove the selected entry.
Click on  to edit the selected entry.
Click on  to copy the selected entry.

Add (Web Interface)

Protocol:
http://
https://

Citrix Xen App Services Site: Server name or IP address of the server
Port: Network port on which the service is available (default: 80 (http), 443 (https) )
Path to the config.xml file: (default: Citrix/PNAgent/config.xml)
Server Farm Name: Name of the Citrix farm

Add (StoreFront)

Protocol:
https://

Citrix Store Site Address: Server name or IP address of the server
Port: Network port on which the service is available (default: 443)
Path to Store: (default: Citrix/Store)
Store name: Name of the Citrix store

Add (StoreFront Legacy Mode)

Protocol:
https://

Store address: Server name or IP address of the server
Port: Network port on which the service is available (default: 443)

The selection options depend on the type of Citrix Receiver, see Citrix Client selection (see 
page 56).


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Path to Store: (default: Citrix/Store/PNAgent/config.xml)
Store name: Name of the Citrix store

Domains

To manage the list of domains, proceed as follows:
Click on  to create a new entry.
Click on  to remove the selected entry.
Click on  to edit the selected entry.
Click on  to copy the selected entry.

Handling of domain in login window:

normal
locked
hidden
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Login
Menu path: Sessions > Citrix > Citrix StoreFront > Login

In this area, you can define session-specific login options.

Authentication type: Depending on the Citrix client version, the following types are available:

Password authentication: Suitable for on-premises connections; connections via Citrix NetScaler 
or to a cloud environment may cause problems.
Kerberos passthrough authentication: Uses local login data for listing and launching applications. 
The option enables single sign-on if login with AD/Kerberos is configured on the thin client.
Smartcard authentication (StoreFront only, not Web Interface)
Citrix authentication mechanism (instead of IGEL), Smartcard disabled
Citrix authentication mechanism (instead of IGEL), Smartcard enabled

Additional options include the following:

Use passthrough authentication

☑ Cached login data are used for listing and starting applications.

☐ No passthrough authentication (default)

Auto login

☑ Uses the login data preset on this page when connecting to the server.

☐ Do not log on automatically (default)

User name: Can only be filled in with password authentication

Password: Can only be filled in with password authentication

Domain: Can only be filled in with password authentication

Remember username and domain:

☑ Saves the user name and domain from the last login. (default)

☐ The user name and domain will not be saved.

Synchronize Citrix password with screen lock:

☑ Synchronizes the screen lock password with that of the Citrix application.

☐ No synchronization (default)

Relaunch Citrix login after logout:

☑ Automatically shows the login dialog again after logging off.

If you have set an authentication type with smartcard, select the type of card on the Smartcard (see page 842)
page.



Session passwords are stored with reversible encryption. Therefore, we strongly recommend not to store 
the session password on the endpoint device. 


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☐ Does not start the login procedure again. (default)

Start a single published application automatically: This parameter is relevant if exactly 1 published application is 
provided for the user whose login is configured here.
☑ The published application is started when the user has logged in.
☐ The published application is not started on login. (default)

Start following applications automatically after server connection is established: A list of applications to be 
started in the session.
To edit the list, proceed as follows:

Click on  to create a new entry. In the Add dialog, give the name of the application.

Click on  to remove the selected entry.
Click on  to move the entry upwards.
Click on  to move the entry downwards.

You can also enter part of the name followed by an asterisk (*).

After a successful login, the associated desktop icon for each available application will be placed on the 
thin client desktop. All applications whose name matches one of the names given in the Launch following 
applications automatically after server connection is established area will then be launched.


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Appearance
Menu path: Setup > Sessions > Citrix > Citrix StoreFront > Appearance

Show applications in the start menu
☑ Applications will appear in the start menu (default)
☐ Applications will not appear in the start menu
Show in the start menu

All: All Citrix applications will be shown in the start menu.
Follow server settings

Resize icons for the start menu
☑ The size of icons for the start menu will automatically be adjusted. (default)

Apply display filter to start menu entries
☑ Only the applications selected in the display filter will be shown in the start menu.
☐ Do not use display filter (default)
Show applications in the Application Launcher
☑ Applications will be shown in the Application Launcher. (default)
Apply display filter to Application Launcher entries
☑ Only the applications selected in the display filter will be shown in the Application Launcher.
☐ Do not use display filter (default)
Show applications on desktop
☑ The applications will be shown on the desktop. (default)
Keep folder structure on desktop
☑ The Citrix sessions are shown in their directory structure on the desktop.
☐ The directory structure is not shown. (default)
Show desktop shortcuts

All: All Citrix applications will be shown in the Desktop Launcher.
Follow server settings

Apply display filter to desktop icons
☑ Desktop icons are created only for the applications selected in the display filter (see below). 
(default)
Display filter: Show only the following applications. In the Add dialog, enter the name of the 
application that is to be shown on the desktop.
To manage the list, proceed as follows:

Click on  to create a new entry.
Click on  to remove the selected entry.
Click on  to edit the selected entry.

Enable following applications in quick start panel: In the Add dialog, enter the name of the 
application that is to be shown in the quick start panel.

Automatic scaling can prolong the logon procedure.
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Reconnect
Menu path: Setup > Sessions > Citrix > Citrix StoreFront > Reconnect

Automatic reconnection at logon
☑ Connection will take place when logging on.
☐ Do not reconnect (default)
Connect to
Possible values:

Active and terminated sessions
Terminated sessions only
Ask user

Automatic reconnection from menu/desktop
☑ Reconnect
☐ Do not reconnect (default)
Connect to
Possible values

Active and terminated sessions
Terminated sessions only
Ask user

Reconnect session name: Session name (default: Reconnect)

Starting Methods for Sessions

Start menu: If this option is enabled, the session can be launched from the start menu.
Application Launcher: If this option is enabled, the session can be launched with the Application 
Launcher.
Desktop: If this option is enabled, the session can be launched with a program launcher on the 
desktop.
Quick start panel: If this option is enabled, the session can be launched with the quick start panel.
Start menu's system tab: If this option is enabled, the session can be launched with the start 
menu's system tab.
Application Launcher's system tab: If this option is enabled, the session can be launched with 
the Application Launcher's system tab.
Desktop context menu: If this option is enabled, the session can be launched with the desktop 
context menu.
Menu folder: If you specify a folder name or a path comprising a number of folder names 
separated by "/", a menu path will be created for the session. The menu path will be used in the 
start menu and in the desktop context menu.
Path in the Application Launcher: If you specify a folder name or a path comprising a number of 
folder names separated by "/", a menu path will be created for the session. The menu path will be 
used in the Application Launcher.
Desktop folder: If you specify a folder name or a path comprising a number of folder names 
separated by "/", a menu path will be created for the session. The menu path will be used for the 
program launcher on the desktop.



Sessions

IGEL OS Reference Manual   109 / 897

•

•
•
•
•

•

•

•

•

•

•

•

•
•

Password protection: Specifies which password will be requested when launching the session.
Possible values:

None: No password is requested when launching the session.
Administrator: The administrator password is requested when launching the session.
User: The user password is requested when launching the session.
Setup user: The setup user's password is requested when launching the session.

Hotkey:
☑ The session can be started with a hotkey. A hotkey consists of one or more modifiers and a 
key.
Modifiers: A modifier or a combination of several modifiers for the hotkey. You can select a set key 
symbol/combination or your own key symbol/combination. A key symbol is a defined chain of 
characters, e.g. Ctrl . Here, you will find the available modifiers and the associated key symbols:

(No modifier) = None

 = Shift
[Ctrl] = Ctrl

 = Super_L

[Alt] = Alt

Key combinations are formed as follows with | :

Ctrl +  = Ctrl|Super_L
Key: Key for the hotkey

To enter a key that does not have a visible character, e. g. the [Tab] key, open a terminal, 
log on as user  and enter xev -event keyboard . Press the key to be used for the 

hotkey. The text in brackets that begins with keysym  contains the key symbol for the 

Key field. Example: Tab  in (keysym 0xff09, Tab)


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Refresh
Menu path: Setup > Sessions > Citrix > Citrix StoreFront > Refresh

Refresh Session Name: Name for the session.

Starting Methods for Session

Start menu

☑ The session can be launched from the start menu.

Application Launcher

☑ The session can be launched with the Application Launcher.

Desktop

☑ The session can be launched with a program launcher on the desktop.

Quick start panel

☑ The session can be launched with the quick start panel.

Start menu's system tab

☑ The session can be launched with the start menu's system tab.

Application Launcher's system tab

☑ The session can be launched with the Application Launcher's system tab.

Desktop context menu

☑ The session can be launched with the desktop context menu.

Menu folder: If you specify a folder name or a path comprising a number of folder names separated by "/", a menu 
path will be created for the session. The menu path will be used in the start menu and in the desktop context menu.

Desktop folder: If you specify a folder name or a path comprising a number of folder names separated by "/", a 
menu path will be created for the session. The menu path will be used for the program launcher on the desktop.

Password protection: Specifies which password will be requested when launching the session.
Possible values:

None: No password is requested when launching the session.
Administrator: The administrator password is requested when launching the session.
User: The user password is requested when launching the session.
Setup user: The setup user's password is requested when launching the session.

Hotkey

☑ The session can be started with a hotkey. A hotkey consists of one or more modifiers and a key.

Modifiers: A modifier or a combination of several modifiers for the hotkey. You can select a set key symbol/
combination or your own key symbol/combination. A key symbol is a defined chain of characters, e.g.  Ctrl .

The session name must not contain any of these characters: \ / : * ? “ < > | [ ] { } ( )
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These are the pre-defined modifiers and the associated key symbols:

(No modifier) =  None

 =  Shift
[Ctrl] =  Ctrl

 =  Mod4

[Alt] =  Alt

Key combinations are formed as follows with  | :

Ctrl +   =  Ctrl|Super_L

Key: Key for the hotkey

Do not use [AltGr] as a modifier (represented as Mod5 ). Otherwise, the key that is configured as a hotkey 
with AltGr cannot be used as a regular key anymore. Example: If you configure [AltGr] + [E] as a hotkey, it is 
impossible to enter an "e".



When this keyboard key is used as a modifier, it is represented as Mod4 ; when it is used as a key, it 

is represented as Super_L .



To enter a key that does not have a visible character, e. g. the [Tab] key, open a terminal, log on as user

and enter xev -event keyboard . Press the key to be used for the hotkey. The text in brackets that 

begins with keysym  contains the key symbol for the Key field. Example: Tab  in (keysym 0xff09, 

Tab)


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Logoff
Menu path: Setup > Sessions > Citrix > Citrix StoreFront > Logoff

Logoff session name: Session name (default: Logoff)

Starting Methods for Session

Session name: Name for the session

Start menu:
☑ The session can be started with the start menu. (Default)
☐ The session cannot be found in the start menu.
Application Launcher:
☑ The session can be started with the Application Launcher. (Default)
☐ The session cannot be found in the Application Launcher.
Desktop:
☑ The session can be started with a program starter on the desktop. (Default)
☐ The session does not have a program starter on the desktop.
Quick start panel:
☑ The session can be started with the quick start panel.
☐ The session cannot be found in the quick start panel. (Default)
Start menu's system tab:
☑ The session can be started with the start menu’s system tab.
☐ The session cannot be found in the start menu’s system tab. (Default)
Application Launcher's system tab:
☑ The session can be started with the Application Launcher’s system tab.
☐ The session cannot be found in the Application Launcher’s system tab. (Default)
Desktop context menu:
☑ The session can be started with the desktop context menu.
☐ The session cannot be found in the desktop context menu. (Default)
Menu folder: If you specify a folder name or a path comprising a number of folder names 
separated by "/", a menu path will be created for the session. The menu path will be used in the 
start menu and in the desktop context menu.
Desktop folder: If you specify a folder name or a path comprising a number of folder names 
separated by "/", a menu path will be created for the session. The menu path will be used for the 
program launcher on the desktop.
Password protection: Specifies which password will be requested when launching the session.
Possible values:

None: No password is requested when launching the session.
Administrator: The administrator password is requested when launching the session.

The session name must not contain any of these characters: \ / : * ? “ < > | 

[ ] { } ( )


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User: The user password is requested when launching the session.
Setup user: The setup user's password is requested when launching the session.

Hotkey: A hotkey with which the session can be started is defined. It consists of modifiers and a 
key.
Modifiers: One or two modifiers for the hotkey:

None

 = Shift
[Ctrl ] = Ctrl

 = Super_L

[Alt] = Alt

Modifiers can be combined by using the pipe character |:

[Ctrl ]+  = Ctrl|Super_L
Key: Key for the hotkey

To enter a key that does not have a visible character, e. g. the [Tab] key, open a terminal, 
log on as user  and enter xev -event keyboard . Press the key to be used for the 

hotkey. The text in brackets that begins with keysym  contains the character string for 

the Key field. Example: Tab  in (keysym 0xff09, Tab)


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Desktop Integration
Menu path:  Sessions > Citrix > Citrix StoreFront> Desktop Integration

Login session name: Session name. 

Starting Methods for Session

Start menu

☑ The session can be launched from the start menu.

Application Launcher

☑ The session can be launched with the Application Launcher.

Desktop

☑ The session can be launched with a program launcher on the desktop.

Quick start panel

☑ The session can be launched with the quick start panel.

Start menu's system tab

☑ The session can be launched with the start menu's system tab.

Application Launcher's system tab

☑ The session can be launched with the Application Launcher's system tab.

Desktop context menu

☑ The session can be launched with the desktop context menu.

Menu folder: If you specify a folder name or a path comprising a number of folder names separated by "/", a menu 
path will be created for the session. The menu path will be used in the start menu and in the desktop context menu.

Application Launcher folder: If you specify a folder name or a path comprising a number of folder names 
separated by "/", a menu path will be created for the session. The menu path will be used in the Application 
Launcher.

Desktop folder: If you specify a folder name or a path comprising a number of folder names separated by "/", a 
menu path will be created for the session. The menu path will be used for the program launcher on the desktop.

Password protection: Specifies which password will be requested when launching the session.
Possible values:

None: No password is requested when launching the session.
Administrator: The administrator password is requested when launching the session.
User: The user password is requested when launching the session.
Setup user: The setup user's password is requested when launching the session.

Hotkey

The session name must not contain any of these characters: \ / : * ? “ < > | [ ] { } ( )
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☑ The session can be started with a hotkey. A hotkey consists of one or more modifiers and a key.

Modifiers: A modifier or a combination of several modifiers for the hotkey. You can select a set key symbol/
combination or your own key symbol/combination. A key symbol is a defined chain of characters, e.g.  Ctrl .

These are the pre-defined modifiers and the associated key symbols:

(No modifier) =  None

 =  Shift
[Ctrl] =  Ctrl

 =  Mod4

[Alt] =  Alt

Key combinations are formed as follows with  | :

Ctrl +   =  Ctrl|Super_L

Key: Key for the hotkey

Autostart

☑ The session will be launched automatically when the device boots.

Autostart delay: Waiting time in seconds between the complete startup of the desktop and the automatic session 
launch.

Autostart requires network

☑ If no network is available at system startup, the session is not started. A message is shown. As soon as the 
network is available, the session is started automatically.

☐ The session is started automatically, even when no network is available.

Do not use [AltGr] as a modifier (represented as Mod5 ). Otherwise, the key that is configured as a hotkey 
with AltGr cannot be used as a regular key anymore. Example: If you configure [AltGr] + [E] as a hotkey, it is 
impossible to enter an "e".



When this keyboard key is used as a modifier, it is represented as Mod4 ; when it is used as a key, it 

is represented as Super_L .



To enter a key that does not have a visible character, e. g. the [Tab] key, open a terminal, log on as user

and enter xev -event keyboard . Press the key to be used for the hotkey. The text in brackets that 

begins with keysym  contains the key symbol for the Key field. Example: Tab  in (keysym 0xff09, 

Tab)


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Citrix Self-Service
Menu path: Sessions > Citrix > Citrix Self-Service

The Citrix Self-Service interface allows access to Citrix Virtual Desktops and Apps via Self-Service UI.

Server (see page 117)
Options (see page 119)
Desktop Integration (see page 120)
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Server
Menu path: Setup > Sessions > Citrix > Citrix Self-Service > Server

Use IGEL Setup for configuring Citrix Self-Service
☑ The IGEL Setup is used for Citrix Self-Service configuration. (Default)

To manage the list, proceed as follows:

 Click on  to create a new entry.

 Click on  to remove the selected entry.

 Click on  to edit the selected entry.

 Click on  to copy the selected entry.

Server: Web Interface

Add:

Protocol:
http://
https://

Server: Name or IP address of the server
Server port: Port on which the service is available (default: 80 (http), 443 (https))
Path to config.xml file: (default: Citrix/PNAgent/config.xml)
Store name: Name for the store

Server: StoreFront

Add:

Protocol:
http://
https://

Server: Name or IP address of the server
Server port: Port on which the service is available (default: 80 (http), 443 (https))
Path to store: (default: Citrix/Store)
Store name: Name for the store

Server: StoreFront Legacy Mode

Add:

Protocol:
http://
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https://
Server: Name or IP address of the server
Server port: Port on which the service is available (default: 80 (http), 443 (https))
Path to config.xml file: (default: Citrix/Store/PNAgent/config.xml)
Store name: Name for the store
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Options
Menu path: Setup > Sessions > Citrix > Citrix Self-Service > Server > Options

Display mode: Display type for the Self-Service user interface
Possible values:

Window
Full screen

Multi user 
☑ The user data on the client will be deleted after logging off or terminating Self-Service. (default)
Reconnect after logon:
☑ The Self-Service user interface reconnects automatically to applications and desktops after 
being launched.
☐ The Self-Service user interface does not reconnect automatically.
Reconnect to apps after starting an application:
☑ The Self-Service user interface will attempt to reconnect to ongoing sessions if an application 
is launched or the store is reloaded.
☐ The Self-Service user interface will not attempt to reconnect. (default)

In full screen mode, the IGEL desktop will not be available.
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Desktop Integration
Self-Service session: Name for the Self-Service session (default: Self-Service)

Starting Methods for Session

Start menu

☑ The session can be started with the start menu.

Application Launcher

☑ The session can be started with the Application Launcher.

Desktop:

☑ The session can be started with a program starter on the desktop.

Quick start panel:

☑ The session can be started with the quick start panel.

Start menu's system tab

☑ The session can be started with the start menu’s system tab.

Application Launcher's system tab

☑ The session can be started with the Application Launcher’s system tab.

Desktop context menu

☑ The session can be started with the desktop context menu.

Menu folder: If you specify a folder name or a path comprising a number of folder names separated by "/", a menu 
path will be created for the session. The menu path will be used in the start menu and in the desktop context menu.

Path in the Application Launcher: If you specify a folder name or a path comprising a number of folder names 
separated by "/", a menu path will be created for the session. The menu path will be used in the Application 
Launcher.

Desktop folder: If you specify a folder name or a path comprising a number of folder names separated by "/", a 
menu path will be created for the session. The menu path will be used for the program launcher on the desktop.

Password protection: Specifies which password will be requested when launching the session.
Possible values:

None: No password is requested when launching the session.
Administrator: The administrator password is requested when launching the session.
User: The user password is requested when launching the session.
Setup user: The setup user's password is requested when launching the session.

Hotkey:

☑ The session can be started with a hotkey. A hotkey consists of one or more modifiers and a key.

The session name must not contain any of these characters: \ / : * ? “ < > | [ ] { } ( )
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Modifiers: A modifier or a combination of several modifiers for the hotkey. You can select a set key symbol/
combination or your own key symbol/combination. A key symbol is a defined chain of characters, e.g.  Ctrl .

These are the pre-defined modifiers and the associated key symbols:

(No modifier) =  None

 =  Shift
[Ctrl] =  Ctrl

 =  Mod4

[Alt] =  Alt

Key combinations are formed as follows with  | :

Ctrl +   =  Ctrl|Super_L

Key: Key for the hotkey

Autostart: If this option is enabled, the session will be launched automatically when the thin client boots.

Autostart delay: Waiting time in seconds between the thin client booting and the session being launched 
automatically.

Autostart requires network

☑ If no network is available at system startup, the session is not started. A message is shown. As soon as the 
network is available, the session is started automatically.

☐ The session is started automatically, even when no network is available.

Do not use [AltGr] as a modifier (represented as Mod5 ). Otherwise, the key that is configured as a hotkey 
with AltGr cannot be used as a regular key anymore. Example: If you configure [AltGr] + [E] as a hotkey, it is 
impossible to enter an "e".



When this keyboard key is used as a modifier, it is represented as Mod4 ; when it is used as a key, it 

is represented as Super_L .



To enter a key that does not have a visible character, e. g. the [Tab] key, open a terminal, log on as user

and enter xev -event keyboard . Press the key to be used for the hotkey. The text in brackets that 

begins with keysym  contains the key symbol for the Key field. Example: Tab  in (keysym 0xff09, 

Tab)


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RDP Global
Menu path: Setup > Sessions > RDP > RDP Global

This section describes the procedure for configuring the global RDP settings. This configuration applies for all RDP 
sessions.

_____

Gateway (see page 123)
Local Logon (see page 125)
Window (see page 126)
Keyboard (see page 128)
Mapping (see page 129)
Performance (see page 137)
Options (see page 141)
Native USB Redirection (see page 142)
Fabulatech USB Redirection (see page 145)
Fabulatech Scanner Redirection (see page 147)
Multimedia (see page 148)

The protocol version cannot be configured manually. The version used by the server is automatically 
recognized and used.


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Gateway
Menu path: Setup > Sessions > RDP > RDP Global > Gateway

Via Microsoft Remote Desktop Gateway, you can access remote Windows systems.

The gateway translates between the internal Remote Desktop Protocol (RDP) and the external HTTPS connection.

Access to the Remote Desktop environment is provided via the browser. The browser establishes a secure 
connection to the gateway. From here, the connection query is forwarded to the target system. In the process, pre-
defined Connection Access Policies and Resource Access Policies (CAP and RAP) for access control are evaluated.

Enable gateway support:

☑ Gateway support is enabled and you can configure the following settings:

☐ Gateway support is disabled. (default)

Gateway address

The following Windows Server editions can preferably be used as gateway servers: 
Server 2008R2 Standard (restricted to 250 RD Gateway connections) 
Server 2008R2 Enterprise 
Server 2008R2 Datacenter 
Server 2012 Standard 
Server 2012 Datacenter 
Server 2012 Essential (restricted to the RD Gateway role) 
Server 2012R2 Standard 
Server 2012R2 Essential (restricted to the RD Gateway role)

Use other logon data for RD gateway

RD gateway requires Microsoft Windows Server 2008R2 or Server 2012 with various 
restrictions for each server version.



RD Gateway is not supported in the IGEL RDP Legacy Mode.
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☑ Uses custom data that can be defined below rather than the session access data.
☐ Uses the session access data. (default)

Gateway user name: User name when logging on to the gateway
Gateway password: Password when logging on to the gateway
Gateway domain: Domain in which the gateway is located



Sessions

IGEL OS Reference Manual   125 / 897

•

•

•

•
•

•

•

•

•

•

Local Logon
Menu path: Setup > Sessions > RDP > RDP Global > Local Logon

In this area, you can prepopulate user data. As a result, you can avoid users possibly having to log in a number of 
times.

Use local login window
☑ The RDP login window is used on the terminal side to set the user name and domain when a 
connection to the terminal server is established for the first time. (default)

You can configure the following presets:

Preset login information
☑ The login window is prepopulated with the user name and domain. (default)
Type: Here, you can prepopulate the user name and domain in the logon window. 
Possible values:

Set user/domain from last login
Set user/domain from session setup

Show domain
☑ Shows the domain entry in the logon window. (default)
Set client name to user name
☑ The name of the client for the RDP connection will be set to the user name. This setting may 
help to resolve reconnection problems during load balancing. (default)
Relaunch mode
☑ The RDP login window is displayed in restart mode and cannot be closed.
☐ The RDP window will not be displayed in restart mode. (default)
Enable network authentication
☑ Enables network authentication via NTLM. Smartcards are not supported here. (default)
Domains: Allows you to add domains which are to be available. If you enter a number of domains, 
these will be shown in the Domains drop-down area in the login module.

To manage the list of domains, proceed as follows:

 Click  to create a new entry.

 Click  to remove the selected entry.

 Click  to edit the selected entry.

 Click  to copy the selected entry.

You can also use Local logon to freely select the server in the logon window of an RDP session.
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Window
Menu path: Setup > Sessions > RDP > RDP Global > Window

In this area, you can configure the window for RDP sessions.

You can change the following settings:

Number of Colors: Specifies the color depth.
Possible values:

256
Thousands
Millions

Window size: Specifies the width and height of the window.
Fullscreen: The session is shown on the full screen. The thin client's taskbar is not visible.
Work area: The session is shown on the full screen, minus the area needed by the thin 
client's taskbar.
Numeric details: The session is shown in the selected resolution or on the selected 
percentage of the screen area.

Desktop scale factor: Specifies the desktop scaling in percent. Select a value from the selection 
list or enter a percentage value manually.

Possible values:
Automatic: The resolution set under Setup > User Interface > Display > Options > Monitor-
DPI will be used for the RDP session.
Numeric details: The display will be magnified by the factor given here. Value range: 100% - 
500%

Enable Display Control
☑ The window size can be changed during the session. (Default)

Control Bar for RDP-Sessions
☑ A control bar for minimizing and closing a full-screen session will be shown.
☐ No control bar will be shown. (Default)

Desktop scaling is supported from Windows Server 2012 or higher and from Windows 8.1 
or higher.



Set the Desktop scale factor to a fixed value of 100% to allow server-side desktop scaling 
take effect. All values other than 100% overwrite the server-side setting.



If the window size is to be changed during the session, at least Windows 8.1 or Windows 
Server 2012 R2 must be running on the server.



It is not possible to change the window size during the session if Window size is set to 
fullscreen or workarea.


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Multi-monitor fullscreen mode - If more than one monitor is connected to the terminal:
Restrict fullscreen session to one monitor.
Display fullscreen session on all monitors.
Expand fullscreen session across all monitors.

If the symbol bar is enabled, a session will be shown on one monitor only, even if Multi-
monitor fullscreen mode is set to Expand full-screen session across all monitors.


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Keyboard
Menu path: Setup > Sessions > RDP > RDP Global > Keyboard

Configure how the keyboard reacts within RDP sessions. The following options are available:

Enable clipboard
☑ You can use the clipboard. (default)
Input language: Here, you can determine which language is used for auto-correction in the RDP 
session. This is independent of the keyboard layout. The "Default" setting corresponds to the 
system setting. (default: Default).
Override local window manager keyboard shortcuts
☑ All keyboard entries, including those which would otherwise be processed by the local window 
manager, will be sent straight to the Windows server.
☐ The keyboard shortcuts of the local window manager will not be overridden. (default)
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Mapping
Menu path: Sessions > RDP > RDP Global > Mapping

In this area, you can make available locally connected devices such as printers or USB storage devices in RDP 
sessions.

Drive Mapping (see page 130)
COM Ports (see page 131)
Printers (see page 133)
Device Support (see page 134)
Audio (see page 136)
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3.

4.

Drive Mapping
Menu path: Sessions > RDP > RDP Global > Mapping > Drive Mapping

Through drive mapping, connected mass storage devices can be made available in the session. Specify which 
folders or drives are mapped during the login.

Enable Drive Mapping

☑ Drive mapping is enabled. (Default)

Drive Mapping: List of mapped drives.

To set up drive mapping, proceed as follows:

Click  Add to bring up the mapping window.
Click Enabled to enable the drive connection.
Select a Drive to map from the list under which the local device or the folder is to be mapped.

Give the Local Drive Path of the local directory to which the mapping is to refer.

Local (USB) devices which are to be used for drive mapping purposes must first be set up as devices. See 
Storage Hotplug (see page 807).



•
•

•

Before you unplug a hotplug storage device from the thin client, you must safely remove it. Otherwise, 
data on the hotplug storage device can be damaged. Depending on the configuration, there is one or 
several possibilities to safely remove a hotplug storage device:

Click on  in the taskbar. The taskbar is not available in a fullscreen session.
Click on   in the in-session control bar. Depending on the configuration, the in-session 
control bar may be available in a fullscreen session. For further information, see In-
Session Control Bar (see page 695).
Function Accessories > Safely Remove Hardware with further starting possibilities; 
amongst other things, a hotkey can be defined here.
If the following warning is displayed: Volume(s) still in use. Don't remove the device, 
then the hotplug storage device must not be removed. First, exit the program concerned 
or close all files or directories that reside on the hotplug storage device.



If the drive letter you have selected is no longer available on the server, the specified 
directory or local drive will be given the next free letter during the login.



If you map a locally connected device, use the pre-defined path names available in the 
drop-down field. The directories in question are those on which the devices are mounted 
by default during the boot procedure (e.g.  /autofs/floppy  for an integrated floppy 
drive).


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COM Ports
Menu path: Setup > Sessions > RDP > RDP Global > Mapping > Serial Connections

As with locally connected mass storage devices, you can also map the thin client's local serial connections (COM 
ports) during an RDP session:

Enable COM port mapping:
☑ COM port mapping is enabled. (default)
Server COM Port starts with: Specifies the lowest device number that is used on the server for 
mapping. Possible values:

COM 1 to COM 6. (default: COM1)
COM Port Devices: List with mapped local serial devices.
Click  to add a serial device.

COM Port Device:
Possible values: 
COM 1 
COM 2 
COM 3 
COM 4 
USB COM 1 
USB COM 2 
USB COM 3 
USB COM 4

Detect Devices... : Opens a dialog allowing you to select the device file. 3 device files are available 
for each device; the Description column shows the type of device file:

(GENERIC) [device designation]: Generic type. The name of the device file ends in a 
consecutive number which depends on the boot procedure or the order of insertion. 
Example: /dev/ttyUSB0

(BY PORT) [device designation]: According to USB port. The device file is in the /dev/

usbserial/  directory. The name of the device file ends in the number of the USB port 

that the device is plugged into. Example: /dev/usbserial/ttyUSB_P12

(BY USBID) [device designation]: According to USB ID. The device file is in the /dev/

usbserial/  directory. The name of the device file ends as follows: _V[Vendor 

ID]_P[Product ID] . Example: /dev/usbserial/ttyUSB_V067b_P2303
(Virtual) [device designation]: Virtual device; used for signature pads for example. Example: 
/dev/ttyVST0

If your device has an additional multiport PCI card, more than 2 connections may be 
available.





Sessions

IGEL OS Reference Manual   132 / 897

If you would like to use signature pads, you must enable them beforehand under User 
Interface > Input > Signature Pad (see page 714).


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Printers
Menu path: Setup > Sessions > RDP > RDP Global > Mapping > Printers

In this area, you can configure printer mapping.

Enable Client Printer Mapping

☑ The locally connected thin client printer is made available for your RDP sessions, provided that it was not 
disabled on the server side. (default)

The printers must be set up on the Devices > Printer > CUPS > Printers (see page 788) page and must be 
enabled there for mapping in RDP sessions.



Because the thin client merely places incoming print jobs in a queue, you need to install the printer on the 
server.


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Device Support
Menu path: Setup > Sessions > RDP > RDP Global > Mapping > Device Support

In this area, you can enable virtual RDP channels for communicating with various devices connected to the thin 
client.

The devices supported are listed in the IGEL Third Party Hardware Database7.

Enable plugin support
☑ Communication between connected devices and the relevant server applications is enabled. 
The individual channels must also be enabled.
☐ Communication between connected devices and server applications is not enabled. (Default)

DriveLock channel: The virtual DriveLock channel is implemented on the thin client. The channel 
must also be installed on the RDP server.
DriveLock can read hardware data from local USB devices and transfer these data to the server 
with the help of the virtual RDP channel extension. From IGEL Linux Version 10.03.500 this is also 
possible with SATA devices. When using whitelists, rules based on the hardware properties of the 
connected drive (e.g. manufacturer details, model and serial number) are taken into account.
Important information regarding DriveLock can be found in the Using DriveLock with IGEL Devices
FAQ.
☑ A virtual channel for DriveLock is enabled.
☐ No virtual channel for DriveLock is enabled. (Default)
Diktamen channel for dictation
☑ A virtual channel for Diktamen is enabled.
☐ No virtual channel for Diktamen is enabled. (Default)
deviceTRUST channel
☑ A virtual channel for deviceTRUST is enabled..
☐ No virtual channel for deviceTRUST is enabled. (Default)
Grundig MMC channel for dictation with Grundig devices
☑ A virtual channel for communication with Grundig devices is enabled.
☐ No virtual channel for communication with Grundig devices is enabled. (Default)
Olympus channel for dictation
☑ A virtual channel for communication with Olympus dictation devices is enabled.
☐ No virtual channel for communication with Olympus dictation devices is enabled. (Default)

Philips speech channel for dictation
☑ A virtual channel for communication with Philips dictation devices is enabled.
☐ No virtual channel for communication with Philips dictation devices is enabled. (Default)
DPM server drive: Via this drive, the Philips PocketMemo dictation device makes the voice 
recordings available to the server. (Default: P)

When using DriveLock, ensure that the use of USB devices is not universally restricted; see 
Devices > USB Access Control.



https://www.igel.com/linux-3rd-party-hardware-database/
https://www.igel.com/linux-3rd-party-hardware-database/
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SpeechAir server drive: Via this drive, the Philips SpeechAir dictation device makes the voice 
recordings available to the server (default: S)

Lakeside SysTrack channel
☑ The Lakeside SysTrack channel is enabled.
☐ The Lakeside SysTrack  channel is not enabled. (Default)
Enable smartcard
☑ The thin client’s smartcard reader will appear within the RDP session. Applications can access 
the reader and the smartcards it contains. (Default)
☐ The thin client’s smartcard reader will not appear within the RDP session.

The dictation device is automatically assigned to the selected drive letter. Ensure that no 
other Hotplug storage device is assigned to this drive letter. Further information can be 
found under Hotplug storage device and Drive mapping.



The dictation device is automatically assigned to the selected drive letter. Ensure that no 
other Hotplug storage device is assigned to this drive letter. Further information can be 
found under Hotplug storage device and Drive mapping.


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Audio
Menu path: Setup > Sessions > RDP > RDP Global > Mapping > Audio

In this area, you can configure the settings for local audio transmission.

Enable client audio
Possible values:

On: Audio will be transmitted.
Off: No audio will be transmitted.

Audio quality mode
Possible values:

Automatic
High: High audio quality is favored.
Medium: Medium audio quality is favored.
Dynamic

Audio compression
Possible values:

Automatic
On: Compressed audio data will be accepted.
Off: Compressed audio data will not be accepted.

Audio recording
☑ The microphone will be diverted to the session.
☐ The microphone will not be diverted to the session. (Default)
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Performance
Menu path: Setup > Sessions > RDP > RDP Global > Performance

In this area, you can configure settings in order to improve the performance of the RDP session.

Enable RemoteFX

☑ Remote FX is enabled. (Default)

RemoteFX codec mode

Possible options:

Use server setting
Optimized for LAN
Optimized for WAN
Legacy mode

Hardware accelerated codecs AVC420/AVC444 (H.264)

Possible options:

Automatic: H.264 is activated automatically if supported by the thin client's hardware.

On: H.264 is activated, regardless of hardware support.

Off: H.264 is deactivated.

 You can disable graphics functions which are not absolutely necessary.

Graphics settings that you can disable in order to improve performance:

Disable wallpaper

☑ Desktop background is disabled.

☐ Desktop background is enabled. (Default)

Don't show contents of window while dragging

☑ Window content will be hidden.

☐ Window content will be shown. (default)

Disable menu and window animation

☑ Menu and window animation is disabled.

☐ Menu and window animation is enabled. (Default)

Disable themes

This parameter is present if the thin client has a Multimedia Codec Pack (MMCP) license.

For testing purposes only; this option can lead to display flaws.
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☑ Themes are disabled.

☐ Themes are enabled. (Default)

Disable cursor shadow

☑ Cursor shadow is disabled.

☐ Cursor shadow is enabled. (Default)

Disable cursor settings

☑ Cursor settings are disabled. No "unnecessary" mouse movements will be sent.

☐ Cursor settings are enabled. (Default)

Enable font smoothing

☑ Font smoothing is enabled.

☐ Font smoothing is disabled. (Default)

Compression

☑ Data is compressed.

☐ Data flow is not compressed. (Default)

In low-bandwidth environments, you should use compression in order to reduce network traffic. Please 
note that the use of compression reduces the burden on the network but does use CPU power.





Sessions

IGEL OS Reference Manual   139 / 897

RemoteFX Support
Menu path: Setup > Sessions > RDP > RDP Global > Performance > RemoteFX Support

With the Service Pack 1 for Windows Server 2008 R2, local system functions such as Windows Aero or 3D display can 
be made available in RDP sessions too.

In order to do this, the RemoteFX extension for RDP must be enabled. You can configure the relevant settings under 
RDP Global > Performance or in the corresponding session settings.

Globally enabling Remote FX is not recommended as conventional RDP sessions may also be affected by 
this. With RemoteFX, all graphics effects available under Performance are enabled. This may slow down 
the session as a result. It is better to enable the function only for individual sessions which establish a 
connection to appropriately equipped servers.


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Further information on Remote FX and the server-related requirements is available from Microsoft at https://
technet.microsoft.com/en-us/library/dd736539(ws.10).aspx8.

In the IGEL Registry, you can configure the number of frames sent by the server without confirmation 
under the key rdp.winconnect.remotefx-ack . The default value is 1. A value of 2 or 3 can lead to 
improved performance in networks with high latency.



http://technet.microsoft.com/en-us/library/dd736539(ws.10).aspx
http://technet.microsoft.com/en-us/library/dd736539(ws.10).aspx
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Options
Menu path: Setup > Sessions > RDP > RDP Global > Options

In this area, you can configure the following settings:

Inverted cursor color
Possible values:

Black
White
Dotted

Reset license
☑ The Microsoft llicense will be removed from the device. The device must then be restarted.
☐ The license will not be removed. (default)
Reset confirmed server certificates
☑ All confirmed server certificated will be deleted from the client.
☐ The certificates will not be deleted. (default)
Client name: Client name for terminal service identification. 
Possible values:

Special client name: Specify a special client name in the next field.
MAC address: Use the MAC address of the computer as the client name
Computer name: Use the name of the computer

Custom client name: If you have opted for a special client name, you can enter the name here. If 
the field remains empty, the MAC address of the client will be used automatically.
Verify server certificate
☑ The server certificate will be verified if the connection is TLS-encrypted. (default)

You can also configure your own values custom:, . The colors must be given in the 
ARGB8888 format, e.g. 0xFF000000.


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Native USB Redirection
Menu path: Sessions > RDP > RDP Global > Native USB Redirection

USB devices can be permitted or prohibited during an RDP session on the basis of default rules. Sub-rules for 
specific devices or device classes are also possible. The use of rules is described under USB Access Control (see page 
812).

Enable native USB redirection

☑ Native USB redirection is enabled and you can define default rules below.

☐ Native USB redirection is not enabled. (Default)

Default rule
Possible values:

Deny
Allow

Class Rules
Class rules apply to USB device classes and sub-classes.

To manage rules, proceed as follows:

 Click  to create a new entry.

 Click  to remove the selected entry.

 Click  to edit the selected entry.

 Click  to copy the selected entry.

Add a class rule:

Rule:

Deny
Allow

Class ID: Selection list

Enable either Native or Fabulatech USB Redirection – not both together. For details on Fabulatech USB 
Redirection, see Fabulatech USB Redirection (see page 145).



Disable USB redirection if you use DriveLock. Further information can be found under Using DriveLock 
with IGEL Devices.



Tip

To secure your endpoint, it is generally recommended to set Default rule to Deny and to configure 
Allow rules only for the required USB devices and USB device classes. 


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Subclass ID: Selection list

Name: Free text entry

Device Rules
Device rules apply to specific USB devices.

Add a device rule:

Rule:

Allow
Deny

Vendor ID: Hexadecimal manufacturer number

Product ID: Hexadecimal device number

Getting USB Device Information

To find out the Class ID, Subclass ID, Vendor ID and Product ID of the connected USB device, you can use 
the System Information tool. For further information, see Using “System Information” Function (see page 
634).
System Information example:


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Name: Free text entry

Alternatively, you can use the command lsusb  (or lsusb | grep -i [search term] ) in the 
terminal.
Example for lsusb :
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Fabulatech USB Redirection
Menu path: Setup > Sessions > RDP > RDP Global > Fabulatech USB Redirection

Redirection for USB devices can be allowed or denied during an RDP session on the basis of rules. Sub-rules for 
specific devices or device classes are also possible. The use of rules is described under USB Access Control (see page 
812).

Fabulatech USB Redirection

  Fabulatech USB redirection is enabled for all RDP sessions.

Default rule: This rule will apply if no special rule was configured for a class or a device.
Prohibit
Allow

Class rules
Class rules apply to USB device classes and sub-classes.

Managing rules:

 Create a new entry
 Remove the selected entry
 Edit the selected entry
 Copy the selected entry

Class rule properties:

Rule:
Allow: Devices that have the properties defined here are redirected by the Fabulatech USB 
redirection.
Prohibit: Devices that have the properties defined here are not redirected.

Class ID: Device class
Subclass ID: Subclass relating to the specified device class
Name: Free text entry

For the Fabulatech USB redirection, a server-side component is required. We recommend the USB for 
Remote Desktop IGEL Edition; see http://www.usb-over-network.com/partners/igel/.



Enable either native or Fabulatech USB redirection – not both together. Disable USB redirection if you use 
DriveLock.



Ensure that no other Hotplug storage device (USB stick) is connected if a session is started with Fabulatech 
USB redirection. Otherwise the Hotplug storage device will not be securely removed when the session 
starts, and this could lead to data loss. With IGEL Linux Version 10.02.x the Hotplug storage device is 
already insecurely removed when the Fabulatech USB redirection is enabled.



http://www.usb-over-network.com/partners/igel/
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Override serial: Serial number that will appear in the session
Override name: Device name that will appear in the session
Postpone

 The USB device is only removed from the system (thin client) when the session starts.
 The USB device is no longer shown immediately after the system is booted. (Default)

This setting is only effective if the Takeaway parameter is enabled.
Takeaway

 The USB device may be removed from the system (thin client).
 The device may not be removed. (Default)

No Reset
 The device will not be automatically reset after the connection with the session has been 

terminated.
 The device will be reset after the connection with the session has been terminated. (Default)

Device rules
A device rules applies to a specific devices that is identified by its serial number.

Device rule settings:

Rule:
Allow
Prohibit

Vendor ID: Hexadecimal manufacturer number
Product ID: Hexadecimal device number
Name: Free text entry
Override serial: Serial number that will appear in the session.
Overriede name: Device name that will appear in the session.
Postpone

 The USB device is only removed from the system (thin client) when the session starts. (Default)
 The USB device is no longer shown immediately after the system is booted.

This setting is only effective if the Takeaway parameter is enabled.
Takeaway

 The USB device may be removed from the system (thin client). (Default)
 The device may not be removed.

No Reset
 The device will not be automatically reset after the connection with the session has been 

terminated. (Default)
 The device will be reset after the connection with the session has been terminated.
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Fabulatech Scanner Redirection
Menu path: Sessions > RDP > RDP Global > Fabulatech Scanner Redirection

Redirection for a Fabulatech scanner can be allowed during an RDP session.

Fabulatech Scanner for Remote Desktop

☑ Fabulatech Scanner for Remote Desktop is enabled. 

For more information, see RDP Fabulatech Scanner Redirection.
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Multimedia
Menu path: Setup > Sessions > RDP > RDP Global > Multimedia

In this area, you can enable video redirection in order to allow optimized video playback in remote sessions.

Video redirection
☑ Use video redirection. The thin client renders the video data.
☐ Do not use video redirection. (default)
From IGEL Linux 5.06.100, hardware acceleration for multimedia playback is available on certain 
devices. You will find more detailed information in the FAQ Hardware Video Acceleration on IGEL 
OS.
.
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RDP Session
Menu path: Sessions > RDP > RDP Sessions

You can set up your own RDP sessions here.

The following configuration pages offer you detailed setup options for the RDP session:

Server (see page 150)
Gateway (see page 152)
Logon (see page 153)
Window (see page 154)
Keyboard (see page 156)
Mapping (see page 157)
Performance (see page 158)
Options (see page 159)
USB Redirection (see page 160)
Multimedia (see page 161)
Desktop Integration RDP (see page 162)
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Server
Menu path: Setup > Sessions > RDP > RDP Sessions > [Session Name] > Server

In this area, you can change the information regarding the server connection.

 Choose between Server and RemoteApps mode.

Server

Server: Name or IP address of the server.
RDP port: The RDP TCP/IP port which is used for the connection. (Default: 3389)
Collection: The name of the Remote Desktop Services (RDS) collection to connect to.

Application: Start application for the terminal server session.
Command line parameter for the executed program: Command line parameter with which you 
would like to call up your own application in the RemoteAPP mode.
Changeable server URL on local logon
☑ The server can be entered freely when the user logs on locally. Local logon must be enabled in 
order to do this.
☐ The terminal server’s logon window will be shown. When using local logon, the device’s logon 
window will be shown. (Default)

Enable RemoteApp mode
Like the published applications of a Citrix server, MS Windows Server 2008 offers the option of passing on 
RemoteApps to the device.

Detailed instructions regarding server configuration can also be found on the Microsoft website: TS RemoteApp 
Step-by-Step Guide9.

On the client side, only a few parameters need to be configured after enabling the RemoteApp mode.

Instead of the collection name, it is also possible to specify under Collection the token that directs 
the RDP client to a specific RDS collection. The token format is tsv://MS Terminal 

Services Plugin.1.RDS collection name . For more information, see What Is the String 
for Token-Based Load Balancing?.



If the Passthrough Authentication option is enabled, the session with the local logon 
data for the terminal user, e.g. from the domain logon, is used. However, this setting will 
be overridden by the Local Logon global parameter. You should not therefore use both 
options at the same time.



https://technet.microsoft.com/en-us/library/cc730673(v=ws.10).aspx
https://technet.microsoft.com/en-us/library/cc730673(v=ws.10).aspx


Sessions

IGEL OS Reference Manual   151 / 897

Please note that the name of the application to be launched must be preceded by two pipe characters (||), 
e.g. ||Excel .


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Gateway
Menu path: Setup > Sessions > RDP > RDP Sessions > [Session Name] > Gateway

Here, you can specify custom gateway details for your RDP session.

Enable gateway support
Global setting: The settings from RDP Global > Gateway will be carried over.
Session setting: Here, you can configure custom settings. The entry options correspond to 
those under RDP Global > Gateway (see page 123).
Off: No gateway support

Gateway address

The following Windows Server editions can preferably be used as gateway servers: 
Server 2012 Standard 
Server 2012 Datacenter 
Server 2012 Essential (restricted to the RD Gateway role) 
Server 2012R2 Standard 
Server 2012R2 Essential (restricted to the RD Gateway role)
Server 2016
Server 2019

Use other credentials for RD Gateway authentication:
☑ Uses custom data that can be defined below rather than the session access data.

Gateway user name
Gateway password
Gateway domain

RD Gateway requires Microsoft Windows Server 2008R2 or Server 2012 with various 
restrictions for each server version.



RD Gateway is not supported in the IGEL RDP Legacy Mode.
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Logon
Menu path: Sessions > RDP > RDP Sessions > [Session Name] > Logon

Here, you can specify session-specific settings for login.

Use passthrough authentication for this session

☑ This option can be used if the local device login takes place via Kerberos or Shared Workspace. The login data 
saved temporarily when logging in to the device will be used for the user name and password.

☐ The login data are not passed on. (Default)

User name: Name of the user

Password: Password of the user

Domain: Windows domain

Session passwords are stored with reversible encryption. Therefore, we strongly recommend not to store 
the session password on the endpoint device. 


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Window
Menu path: Setup > Sessions> RDP > RDP-Sessions > [Session Name] > Fenster

Here, you can specify the settings for the RDP session window.

Number of colours
Possible values:

Global setting
256
Thousands
Millions

Window size
Possible values:

Global setting
Fullscreen: The session is shown on the full screen. The thin client's taskbar is not visible.
Workarea: The session is shown on the full screen, minus the area needed by the thin 
client's taskbar.
Numeric details: The session is shown in the selected resolution or on the selected 
percentage of the screen area.

Desktop scale factor: Specifies the desktop scaling in percent. This function is available from IGEL 
Linux Version 10.02.

Possible values:
Global setting (default)
Automatic: The resolution set under Setup > User Interface > Display > Options > Monitor-
DPI will be used for the RDP session.
Numeric details: The display will be magnified by the factor given here. Value range: 100% - 
500%

Display resolution
Possible values:

Same as window size
Value selection: The session runs on the server side with the screen resolution selected here. 
The session will be shown on the thin client in the screen resolution set with the Window 
size parameter. If the screen resolution on the server side is smaller than the Window size, 
the display will be magnified accordingly and anti-aliasing may be used. Example: 
Applications that only work or work optimally with a specific screen resolution.

Start monitor: Specifies the monitor on which the session is to start.
No configuration
Selects a specific monitor

Multi-monitor fullscreen mode: This setting is relevant if more than one monitor is connected to 
the terminal:

Global setting

Desktop scaling is supported from Windows Server 2012 or higher and from Windows 8.1 
or higher.


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Restrict fullscreen session to one monitor.
Display fullscreen session on all monitors.
Expand fullscreen session across all monitors.
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Keyboard
Menu path: Setup > Sessions > RDP > RDP Sessions > [Session Name] > Keyboard

Here, you can specify session-specific keyboard settings.

Keyboard map
Possible values:

Automatic
Country name

Override local window manager keyboard shortcuts
Possible values:

Global setting
On
Off
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Mapping
Menu path: Setup > Sessions > RDP > RDP Sessions > [Session Name] > Mapping

Enable COM port mapping
Global setting:
On
Off

Enable drive mapping
Global setting from RDP Global > Mapping > Drive Mapping
On
Off

Enable printer mapping
Global setting from RDP Global > Mapping > Printers
On
Off

Enable plugin support
Global setting from RDP Global > Mapping > Drive Support
Off

Enable client audio
Global setting from RDP Global > Mapping > Audio
On
Off

Audio quality mode
Global setting from RDP Global > Mapping > Audio
Automatic
High: High audio quality is favored.
Medium: Medium audio quality is favored.
Dynamic

Audio compression
Global setting from RDP Global > Mapping > Audio
Automatic
On
Off

Audio capture
Global setting from RDP Global > Mapping > Audio
On
Off

Enable clipboard
Global setting from RDP Global > Keyboard
On
Off
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Performance
Menu path: Setup > Sessions > RDP > RDP Sessions > [Session Name] > Performance

Enable RemoteFX
Global setting from RDP Global > Performance
On
Off

Hardware accelerated codecs AVC420/AVC444 (H.264)
Global setting from RDP Global > Performance
On
Off

Disable wallpaper
Global setting from RDP Global > Performance
On
Off

Do not show contents of window while dragging
Global setting from RDP Global > Performance
On
Off

Disable menu and window animation
Global setting from RDP Global > Performance
On
Off

Disable themes
Global setting from RDP Global > Performance
On
Off

Disable cursor shadow
Global setting from RDP Global > Performance
On
Off

Disable cursor settings
Global setting from RDP Global > Performance
On
Off

Enable font smoothing
Global setting from RDP Global > Performance
On
Off

Compression
Global setting from RDP Global > Performance
On
Off
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Options
Menu path: Setup > Sessions > RDP > RDP Sessions > [Session Name] > Options

Here, you can specify the name and symbol for the RDP client.

Client name: Specifies the name that is sent to the terminal server for identification purposes.
Possible values:

Global setting: The setting from RDP Global > Options will be carried over.
Custom client name: The name given under Custom client name will be used as the client 
name.
MAC address: The MAC address of the computer will be used as the client name.
Host name: The name of the device specified under Setup > Network > LAN Interfaces > 
Terminal name  will be used as the client name. See LAN Interfaces (see page 724).

Custom client name: Custom client name; if the field is empty, the MAC address will be used.
Collection: The name of the Remote Desktop Services (RDS) collection to connect to.

Icon name: File name of the icon without file extension. (Default: rdp)

Instead of the collection name, it is also possible to specify under Collection the token that directs 
the RDP client to a specific RDS collection. The token format is tsv://MS Terminal 

Services Plugin.1.RDS collection name . For more information, see What Is the String 
for Token-Based Load Balancing?.


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USB Redirection
Menu path: Sessions > RDP > RDP Sessions > [Session Name] > USB Redirection

Native USB redirection

Global setting: The settings from RDP Global > Native USB Redirection will be carried over.
On: Native USB redirection is enabled.
Off: Native USB redirection is disabled.

Further information regarding the global settings can be found under Native USB Redirection (see page 142).
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Multimedia
Menu path: Setup > Sessions > RDP > RDP Sessions > [Session Name] > Multimedia

Enalbe video redirection
Global setting: The setting from RDP Global > Multimedia will be used.
On: Video redirection is enabled.
Off: Video redirection is disabled.

Further information regarding the global settings can be found under Multimedia (see page 148).
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Desktop Integration RDP
Menu path: Sessions > RDP > RDP Sessions > [Session Name] > Desktop Integration

Session name: Name for the session.

Starting Methods for Session
Start menu

☑ The session can be launched from the start menu.

Application Launcher

☑ The session can be launched with the Application Launcher.

Desktop

☑ The session can be launched with a program launcher on the desktop.

Quick start panel

☑ The session can be launched with the quick start panel.

Start menu's system tab

☑ The session can be launched with the start menu's system tab.

Application Launcher's system tab

☑ The session can be launched with the Application Launcher's system tab.

Menu folder: If you specify a folder name or a path comprising a number of folder names separated by "/", a menu 
path will be created for the session. The menu path will be used in the start menu and in the desktop context menu.

Application Launcher folder: If you specify a folder name or a path comprising a number of folder names 
separated by "/", a menu path will be created for the session. The menu path will be used in the Application 
Launcher.

Desktop folder: If you specify a folder name or a path comprising a number of folder names separated by "/", a 
menu path will be created for the session. The menu path will be used for the program launcher on the desktop.

Password protection: Specifies which password will be requested when launching the session.
Possible values:

None: No password is requested when launching the session.
Administrator: The administrator password is requested when launching the session.
User: The user password is requested when launching the session.
Setup user: The setup user's password is requested when launching the session.

Hotkey

☑ The session can be started with a hotkey. A hotkey consists of one or more modifiers and a key.

The session name must not contain any of these characters: \ / : * ? “ < > | [ ] { } ( )
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Modifiers: A modifier or a combination of several modifiers for the hotkey. You can select a set key symbol/
combination or your own key symbol/combination. A key symbol is a defined chain of characters, e.g.  Ctrl .

These are the pre-defined modifiers and the associated key symbols:

(No modifier) =  None

 =  Shift
[Ctrl] =  Ctrl

 =  Mod4

[Alt] =  Alt

Key combinations are formed as follows with  | :

Ctrl +   =  Ctrl|Super_L

Key: Key for the hotkey

Autostart

☑ The session will be launched automatically when the device boots.

Restart

☑ The session will be restarted automatically after the termination.

Autostart delay: Waiting time in seconds between the complete startup of the desktop and the automatic session 
launch.

Autostart requires network

☑ If no network is available at system startup, the session is not started. A message is shown. As soon as the 
network is available, the session is started automatically.

Do not use [AltGr] as a modifier (represented as Mod5 ). Otherwise, the key that is configured as a hotkey 
with AltGr cannot be used as a regular key anymore. Example: If you configure [AltGr] + [E] as a hotkey, it is 
impossible to enter an "e".



When this keyboard key is used as a modifier, it is represented as Mod4 ; when it is used as a key, it 

is represented as Super_L .



To enter a key that does not have a visible character, e. g. the [Tab] key, open a terminal, log on as user

and enter xev -event keyboard . Press the key to be used for the hotkey. The text in brackets that 

begins with keysym  contains the key symbol for the Key field. Example: Tab  in (keysym 0xff09, 

Tab)


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☐ The session is started automatically, even when no network is available.



Sessions

10 http://technet.microsoft.com/en-us/library/cc731923.aspx

IGEL OS Reference Manual   165 / 897

Remote Desktop Web Access
Menu path: Sessions > RDP > Remote Desktop Web Access

With Web Access for Remote Desktop (Web Access for RD), users can access RemoteApp and a Remote Desktop 
connection via the start menu on a computer or via a web browser.

RemoteApps and Remote Desktop connections therefore provide a modified view of RemoteApp programs and 
virtual desktops for users.

More information on Web access for Remote Desktop can be found under Microsoft Technet - Web Access for RDP10.

The settings for launching the session are described below.

Session name: Name for the session.

Starting Methods for Session
Start menu

☑ The session can be launched from the start menu.

Application Launcher

☑ The session can be launched with the Application Launcher.

Desktop

☑ The session can be launched with a program launcher on the desktop.

Quick start panel

☑ The session can be launched with the quick start panel.

Start menu's system tab

☑ The session can be launched with the start menu's system tab.

Application Launcher's system tab

☑ The session can be launched with the Application Launcher's system tab.

Desktop context menu

☑ The session can be launched with the desktop context menu.

Menu folder: If you specify a folder name or a path comprising a number of folder names separated by "/", a menu 
path will be created for the session. The menu path will be used in the start menu and in the desktop context menu.

Application Launcher folder: If you specify a folder name or a path comprising a number of folder names 
separated by "/", a menu path will be created for the session. The menu path will be used in the Application 
Launcher.

The session name must not contain any of these characters: \ / : * ? “ < > | [ ] { } ( )

http://technet.microsoft.com/en-us/library/cc731923.aspx
http://technet.microsoft.com/en-us/library/cc731923.aspx
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Desktop folder: If you specify a folder name or a path comprising a number of folder names separated by "/", a 
menu path will be created for the session. The menu path will be used for the program launcher on the desktop.

Password protection: Specifies which password will be requested when launching the session.
Possible values:

None: No password is requested when launching the session.
Administrator: The administrator password is requested when launching the session.
User: The user password is requested when launching the session.
Setup user: The setup user's password is requested when launching the session.

Hotkey

☑ The session can be started with a hotkey. A hotkey consists of one or more modifiers and a key.

Modifiers: A modifier or a combination of several modifiers for the hotkey. You can select a set key symbol/
combination or your own key symbol/combination. A key symbol is a defined chain of characters, e.g.  Ctrl .

These are the pre-defined modifiers and the associated key symbols:

(No modifier) =  None

 =  Shift
[Ctrl] =  Ctrl

 =  Mod4

[Alt] =  Alt

Key combinations are formed as follows with  | :

Ctrl +   =  Ctrl|Super_L

Key: Key for the hotkey

Do not use [AltGr] as a modifier (represented as Mod5 ). Otherwise, the key that is configured as a hotkey 
with AltGr cannot be used as a regular key anymore. Example: If you configure [AltGr] + [E] as a hotkey, it is 
impossible to enter an "e".



When this keyboard key is used as a modifier, it is represented as Mod4 ; when it is used as a key, it 

is represented as Super_L .



To enter a key that does not have a visible character, e. g. the [Tab] key, open a terminal, log on as user

and enter xev -event keyboard . Press the key to be used for the hotkey. The text in brackets that 

begins with keysym  contains the key symbol for the Key field. Example: Tab  in (keysym 0xff09, 

Tab)


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Autostart

☑ The session will be launched automatically when the device boots.

Restart

☑ The session will be restarted automatically after the termination.

Autostart delay: Waiting time in seconds between the complete startup of the desktop and the automatic session 
launch.

Autostart requires network

☑ If no network is available at system startup, the session is not started. A message is shown. As soon as the 
network is available, the session is started automatically.

☐ The session is started automatically, even when no network is available.

Server (see page 168)
Authentication (see page 172)
Appearance (see page 173)
Logoff (see page 174)
Desktop Integration (see page 176)
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Server
Menu path: Setup > Sessions > RDP > Remote Desktop Web Access > Connections

In this area, you can specify the server configuration.

The Web Access page for Windows Server 2012 and Windows Server 2012 R2 can also be used on a Linux thin client in 
the Firefox browser. See Via browser.

Server configuration
Possible values:

Predefined configuration: You can define several server connections with the same user 
access data. The user must enter their access data and the domain in the logon window. See 
Predefined configuration.
Ask user: The connection is preconfigured on the server side. The user only needs to enter 
their corporate e-mail address. See Ask user.

Server location: These settings are needed if Server configuration is set to Predefined 
configuration.

Protocol: Possible values:
http:// 
https://
RD Web Access Server: Name of the Web Access server
Path to web portal (default: /rdweb/feed/webfeed.aspx)
Enable gateway support: Possible values:
Global settings 
Session settings 
Off
Gateway address: If you would like to carry over the session settings, you must also specify 
the gateway address.

Domains: Domain of the Web Access server

_____

Predefined Configuration (see page 169)
Ask User (see page 170)
Via Browser (see page 171)
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1.
2.
3.
4.

5.

Predefined Configuration
Menu path: Setup > Sessions > RDP > Remote Desktop Web Access > Server

To predefine settings, proceed as follows:

Go to Sessions > RDP > Remote Desktop Web Access > Server.
Under Server configuration, select Predefined configuration.
Create a new session. See the Server (see page 168) section regarding the session settings.
Select a login option under Remote Desktop Web Access > Authentication.
If you have selected Predefined configuration, the Passthrough authentication mode will be 
available for logging in in addition to the normal user authentication process.
Under Desktop Integration (see page 176) and Logoff (see page 174), you can specify how you would like 
to log in and off.

The applications can be provided in the Application Launcher, in the start menu, in the quick start panel, or on the 
desktop. Under Appearance (see page 173), you can choose from the list of available applications for display on the 
desktop or in the quick start panel.

You must make a setting for the login icon because this is not preconfigured and you will 
not otherwise have access to the Web Access logon.


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Ask User
Menu path: Setup > Sessions > RDP > Remote Desktop Web Access > Server

With this logon method, the network connections connected with the user name on the server side must be 
preconfigured and it must be possible to query them via DNS.

To configure access via Ask user, proceed as follows:

 Select Ask user under RD Web Access > Server > Server configuration menu.
The user is given a login window in which they enter their e-mail address consisting of @ :



Sessions

IGEL OS Reference Manual   171 / 897

•
•

Via Browser
The Web Access page for Windows Server 2012 and Windows Server 2012 R2 can also be used on a Linux thin client in 
the Firefox browser.

The user only needs the corresponding URL which is entered in the address bar.
They then log in on the browser page using their user name and password.

If the user clicks one of the applications offered by Web Access, the thin client will open a logon mask and then a 
Remote Desktop session for the application chosen.
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1.

2.

3.

Authentication
Menu path: Setup > Sessions > RDP > Remote Desktop Web Access > Authentication

You can change login settings on the server and select applications that are launched automatically after logging in.

Authentication mode: Specifies how the user authenticates themselves on the server.
Possible values:

"Passthrough authentication": This option can be used if the local endpoint device login takes 
place via Kerberos or Shared Workspace. The login data saved temporarily when logging in to the 
device will be used for the user name and password.
"Auto logon": The login data in Username, Password, and Domain will be used to log in.
"User logon": The user enters the data in a login window.

Username: User name when logging in to the server

Password: Password when logging in to the server

Domain: Domain in which the user name and password are valid

To select an application for automatic launching, proceed as follows:

Click  in the Start following applications automatically after server connection is 
established area.
In the Add dialog, enter the name of the application. (Example: Word 2013)

Click on Ok.
After a successful login, the associated desktop icon for each available application will be placed 
on the device desktop. All applications whose name matches one of the names given in the Start 
following applications automatically after server connection is established area will then be 
launched.

The login settings on the server are only effective if Sessions > RDP > Remote Desktop Web Access > 
Server > Server configuration is set to Predefined configuration. Further information can be found 
under Server (see page 168).



You can also enter part of the name followed by an asterisk ( * ). If you enter e.g.  Word* , 
all available versions of Microsoft Word as well as Microsoft WordPad will be opened.


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Appearance
Menu path: Setup > Sessions > RDP > Remote Desktop Web Access > Appearance

In this area, you can decide where you would like to display Remote Desktop Web Access applications:

Show applications in start menu

☑ The applications are shown in the start menu. (Default)

Apply display filter to start menu entries

☑ Only the applications listed in the display filter will be shown in the start menu.

☐ All applications will be shown in the start menu. (Default)

Show applications in Application Launcher

☑ The applications are shown in Application Launcher. (Default)

Apply display filter to Application Launcher entries

☑ Only the applications listed in the display filter will be shown in the Application Launcher.

☐ All applications will be shown in the Application Launcher. (Default)

Show applications on desktop

☑ The applications will be shown on the desktop. (Default)

Apply display filter to desktop icons

☑ Only the applications listed in the display filter will be shown on the desktop.

☐ All applications will be shown on the desktop. (Default)

Application Launcher folder: If you specify a folder name or a path comprising a number of folder names 
separated by "/", a menu path will be created for the session. The menu path will be used in the Application 
Launcher.

Display filter: Show only the following applications

 Via , you can add applications to the display filter and determine display options for this selected group.

Enable following applications in Quick Start Panel

 Via , you can specify applications which will be added to the quick start panel.
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Logoff
Menu path: Setup > RDP > Remote Desktop Web Access > Logoff

Here, you can specify how you would like to log off from the application.

Session name: Name for the session.

Starting Methods for Session
Start menu

☑ The session can be launched from the start menu.

Application Launcher

☑ The session can be launched with the Application Launcher.

Desktop

☑ The session can be launched with a program launcher on the desktop.

Quick start panel

☑ The session can be launched with the quick start panel.

Start menu's system tab

☑ The session can be launched with the start menu's system tab.

Application Launcher's system tab

☑ The session can be launched with the Application Launcher's system tab.

Desktop context menu

☑ The session can be launched with the desktop context menu.

Menu folder: If you specify a folder name or a path comprising a number of folder names separated by "/", a menu 
path will be created for the session. The menu path will be used in the start menu and in the desktop context menu.

Application Launcher folder: If you specify a folder name or a path comprising a number of folder names 
separated by "/", a menu path will be created for the session. The menu path will be used in the Application 
Launcher.

Desktop folder: If you specify a folder name or a path comprising a number of folder names separated by "/", a 
menu path will be created for the session. The menu path will be used for the program launcher on the desktop.

Password protection: Specifies which password will be requested when launching the session.
Possible values:

None: No password is requested when launching the session.
Administrator: The administrator password is requested when launching the session.
User: The user password is requested when launching the session.

The session name must not contain any of these characters: \ / : * ? “ < > | [ ] { } ( )
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Setup user: The setup user's password is requested when launching the session.

Hotkey

☑ The session can be started with a hotkey. A hotkey consists of one or more modifiers and a key.

Modifiers: A modifier or a combination of several modifiers for the hotkey. You can select a set key symbol/
combination or your own key symbol/combination. A key symbol is a defined chain of characters, e.g.  Ctrl .

These are the pre-defined modifiers and the associated key symbols:

(No modifier) =  None

 =  Shift
[Ctrl] =  Ctrl

 =  Mod4

[Alt] =  Alt

Key combinations are formed as follows with  | :

Ctrl +   =  Ctrl|Super_L

Key: Key for the hotkey

Do not use [AltGr] as a modifier (represented as Mod5 ). Otherwise, the key that is configured as a hotkey 
with AltGr cannot be used as a regular key anymore. Example: If you configure [AltGr] + [E] as a hotkey, it is 
impossible to enter an "e".



When this keyboard key is used as a modifier, it is represented as Mod4 ; when it is used as a key, it 

is represented as Super_L .



To enter a key that does not have a visible character, e. g. the [Tab] key, open a terminal, log on as user

and enter xev -event keyboard . Press the key to be used for the hotkey. The text in brackets that 

begins with keysym  contains the key symbol for the Key field. Example: Tab  in (keysym 0xff09, 

Tab)


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Desktop Integration
Menu path: RDP > Remote Desktop Web Access > Desktop Integration

Session name: Name for the session.

Starting Methods for Session
Start menu

☑ The session can be launched from the start menu.

Application Launcher

☑ The session can be launched with the Application Launcher.

Desktop

☑ The session can be launched with a program launcher on the desktop.

Quick start panel

☑ The session can be launched with the quick start panel.

Start menu's system tab

☑ The session can be launched with the start menu's system tab.

Application Launcher's system tab

☑ The session can be launched with the Application Launcher's system tab.

Desktop context menu

☑ The session can be launched with the desktop context menu.

Menu folder: If you specify a folder name or a path comprising a number of folder names separated by "/", a menu 
path will be created for the session. The menu path will be used in the start menu and in the desktop context menu.

Application Launcher folder: If you specify a folder name or a path comprising a number of folder names 
separated by "/", a menu path will be created for the session. The menu path will be used in the Application 
Launcher.

Desktop folder: If you specify a folder name or a path comprising a number of folder names separated by "/", a 
menu path will be created for the session. The menu path will be used for the program launcher on the desktop.

Password protection: Specifies which password will be requested when launching the session.
Possible values:

None: No password is requested when launching the session.
Administrator: The administrator password is requested when launching the session.
User: The user password is requested when launching the session.
Setup user: The setup user's password is requested when launching the session.

The session name must not contain any of these characters: \ / : * ? “ < > | [ ] { } ( )



Sessions

IGEL OS Reference Manual   177 / 897

•

•

•

•

•

•

Hotkey

☑ The session can be started with a hotkey. A hotkey consists of one or more modifiers and a key.

Modifiers: A modifier or a combination of several modifiers for the hotkey. You can select a set key symbol/
combination or your own key symbol/combination. A key symbol is a defined chain of characters, e.g.  Ctrl .

These are the pre-defined modifiers and the associated key symbols:

(No modifier) =  None

 =  Shift
[Ctrl] =  Ctrl

 =  Mod4

[Alt] =  Alt

Key combinations are formed as follows with  | :

Ctrl +   =  Ctrl|Super_L

Key: Key for the hotkey

Autostart

☑ The session will be launched automatically when the device boots.

Restart

☑ The session will be restarted automatically after the termination.

Autostart delay: Waiting time in seconds between the complete startup of the desktop and the automatic session 
launch.

Autostart requires network

Do not use [AltGr] as a modifier (represented as Mod5 ). Otherwise, the key that is configured as a hotkey 
with AltGr cannot be used as a regular key anymore. Example: If you configure [AltGr] + [E] as a hotkey, it is 
impossible to enter an "e".



When this keyboard key is used as a modifier, it is represented as Mod4 ; when it is used as a key, it 

is represented as Super_L .



To enter a key that does not have a visible character, e. g. the [Tab] key, open a terminal, log on as user

and enter xev -event keyboard . Press the key to be used for the hotkey. The text in brackets that 

begins with keysym  contains the key symbol for the Key field. Example: Tab  in (keysym 0xff09, 

Tab)


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☑ If no network is available at system startup, the session is not started. A message is shown. As soon as the 
network is available, the session is started automatically.

☐ The session is started automatically, even when no network is available.
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Horizon Client Global
Menu path: Sessions > Horizon Client > Horizon Client Global

In this area, you can define the global settings for Horizon Client sessions.

The following settings are carried over from the global settings for RDP sessions:

Number of colors; see Window (see page 126)
Window size; see Window (see page 126)
Multi-monitor full-screen mode; see Window (see page 126)

Server Options (see page 180)
Local Logon (see page 182)
Window (see page 184)
USB Redirection (see page 185)
Fabulatech USB Redirection for IGEL OS (see page 188)
Fabulatech Scanner Redirection (see page 196)
Serial Port Redirection (see page 197)
Drive Mapping (see page 198)
Multimedia (see page 199)
Performance (see page 200)
Smartcard (see page 201)
Unified Communications (see page 202)
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Server Options
Menu path: Sessions > Horizon Client > Horizon Client Global > Server Options

In this area, you can specify the settings for the connection between the VMware Horizon Client and the server.

Preferred desktop protocol: The selected option is preferred by the client when negotiating the connection 
protocol.

Possible values:

Server setting: The client does not give the server details of a preferred connection protocol. The 
connection protocol preferred by the server is used.
RDP: The client tells the server that it prefers RDP as the connection protocol.
PCoIP: The client tells the server that it prefers PCoIP as the connection protocol.
VMware Blast: The client tells the server that it prefers VMware Blast as the connection protocol.

High Color Accuracy Mode
Enables H.264 encoding with High Color Accuracy in VMware Blast Sessions. 

☑High color accuracy is allowed.
☐High color accuracy is not allowed. (Default)

Kiosk mode

☑Horizon client sessions are held in kiosk mode.

☐Horizon client sessions are held in normal mode. (Default)

Server certificate verification mode: Specifies what will happen if server certificate verification fails.
Possible values:

If the server does not accept the connection protocol preferred by the client, the connection protocol 
preferred by the server will be used.



Hardware video acceleration can be used for VMware Blast. Information regarding hardware video 
acceleration on IGEL devices can be found under Hardware Video Acceleration on IGEL OS. For hardware 
video acceleration, the Multimedia Codec Pack must be installed on IGEL OS versions lower than 
11.01.100. If no hardware video acceleration is available, rendering will take place via software, without 
acceleration.



Fabulatech USB redirection and VMWare Blast are not compatible. If you use Fabulatech USB redirection, 
ensure that RDP or PCoIP is used as the protocol for VMware Horizon sessions.



Horizon Client uses high color accuracy only if the agent supports it. This feature might reduce battery life 
and performance.


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Reject if verification fails
Warn if verification fails
Allow unverifiable connections

Action to take in case there are running applications from previous sessions: Specifies the start behavior of an 
application-type session if applications from a previous session are still running.

Possible values:

Ask to reconnect to open applications: When the session starts, the user is asked whether they 
want to re-establish the connection. If the connection is reestablished, the applications running 
will be available. The applications will have the same status as when the connection was 
terminated.
Reconnect automatically to open applications: The connection will be re-established 
automatically. The application running will be available. The application will have the same status 
as when the connection was terminated.
Do not ask to reconnect and do not reconnect: The connection will not be re-established.

The session type is defined under Sessions > Horizon Client > Horizon Client Session > [Session Name] > 
Connection Settings > Session Type.


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Local Logon
Menu path: Setup > Sessions > Horizon Client > Horizon Client Global > Local Logon

In this area, you can prepopulate user data. As a result, you can avoid users possibly having to log in a number of 
times.

You can change the following settings:

Use local login window

☑ The local login window of the endpoint device will be used to log in to the server. If you use the local login 
window, you can prepopulate login information.

☐ The local login window will not be used. (Default)

Preset login information

☑ Login information will appear automatically in the login window. With Type, you can specify the source of the 
login information. (Default)

Type

Set user/domain from last login: The login information from the last session will appear 
automatically in the login window. (Default)
Set user/domain from session setup: Session-specific login information will appear 
automatically in the login window. The session-specific login information is described under 
Connection Settings (see page 209).
Set user/domain from appliance mode: If this option is enabled, the login information specified 
in the Appliance Mode (see page 220) for VMware Horizon will appear automatically in the login 
window.

Show domain

☑ The domain will be shown in the login window. (Default)

Relaunch mode

☑ The login window is shown in relaunch mode and cannot be closed.

☐ The login window is not shown in relaunch mode. (Default)

Exit on disconnect or when an error occurs

☑ The session will be ended completely when the connection is terminated.

☐ The connection overview will be shown when the connection is terminated. (Default)

Working with the domain list:

 Click  to add a new domain.

 Click  to remove the selected domain.

 Click  to edit the selected domain. 
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 Click  to copy the selected domain.

Further settings options can be found under Security > Active Directory / Kerberos (see page 839) and Security > 
Logon > Active Directory / Kerberos (see page 832).
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Window
Menu path: Sessions > Horizon Client > Horizon Client Global > Window

Window size: Specifies the width and height of the window.

Possible options:

"Full-screen": The session is shown on the full screen. The device's taskbar is not visible.
"Work area": The session is shown on the full screen, minus the area needed by the device's 
taskbar.
Numeric details: The session is shown in the selected resolution or on the selected percentage of 
the screen area.

Multimonitor full-screen mode - If more than one monitor is connected to the terminal:

"Restrict full-screen session to one monitor"
"Display full-screen session on all monitors"
"Expand full-screen session across all monitors": The same as "Display full-screen session on all 
monitors"
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1.
2.

USB Redirection
Menu path: Sessions > Horizon Client > Horizon Client Global > USB Redirection

In this area, you can enable and configure USB redirection for specific devices. A USB composite device can be split 
into its components (interfaces). Example: USB dictation device that is split into the components loudspeaker, 
microphone, storage device/drive and control buttons.

You can change the following settings:

USB Redirection

On
Off

Automatically connect at startup

☑ USB devices that were inserted before the start of the session are available in the session. (default)

Automatically connect when inserted

☑ USB devices that are inserted during the session are available in the session. (default)

Default rule: This rule will apply if no special rule was configured for a class or a device.

Allow
Deny

Automatic splitting of composite USB devices

☑ A USB composite device will automatically be split into its individual components (interfaces). The class rules 
will be applied to these individual devices.

☐ The device will not be split into its components.

Creating a Class Rule

To create a new rule, click  in the Class Rules area.
Choose a Rule. The rule specifies whether use of the device class defined here is allowed or 
prohibited.

Ensure that the power supplied by the USB connection is adequate for the device.

If USB redirection is enabled, drive mapping should be disabled; see Drive Mapping (see page 198). Otherwise, 
USB redirection can cause a storage device to be removed from the drive mapping. This is the case if the 
Automatically connect when inserted option is enabled.



Tip

To secure your endpoint, it is generally recommended to set Default rule to Deny and to configure 
Allow rules only for the required USB devices and USB device classes. 


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3.

4.
5.
6.

1.
2.

•
•
•

•
3.
4.

Under Family, select the class of device for which the rule should apply. Examples: Audio, Printer,
Smartcard, Storage Devices.
Under Name, give a name for the rule.
Click on Ok.
Click on Apply or Ok.
The rule is active.

Creating a Device Rule

To create a new rule, click  in the Device Rules area.
Choose a Rule. The following rules are available:

Deny: The device will not be redirected via USB redirection.
Allow: The device will be redirected via USB redirection.
Split: A USB composite device will automatically be split into its individual components 
(interfaces).
No auto-split: A USB composite device will not be split.

Give the Vendor ID of the device as a hexadecimal value.
Give the Product ID of the device as a hexadecimal value.

When a rule is defined, at least one of the properties Vendor ID or Product ID must be given.

Getting USB Device Information

To find out the Class ID, Subclass ID, Vendor ID and Product ID of the connected USB device, you 
can use the System Information tool. For further information, see Using “System Information” 
Function (see page 634).
System Information example:


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5.

6.
7.
8.

Only for USB composite devices: Under Interface Exclude List, enter a list of interfaces that are to 
be excluded from USB redirection. The individual interfaces are separated by spaces. Example: "0 
1"
Under Name, give a name for the rule.
Click on Ok.
Click on Apply or Ok.
The rule is active.

Alternatively, you can use the command lsusb  (or lsusb | grep -i [search term] ) 
in the terminal.
Example for lsusb :
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Fabulatech USB Redirection for IGEL OS
For Fabulatech USB redirection, a special Fabulatech server component (USB for Remote Desktop Igel Edition) must 
be installed on the Horizon VDI desktop. Please note that licenses must be purchased from Fabulatech to enable 
this functionality.

More detailed information about the function can be found on the Fabulatech partner site: http://www.usb-over-
network.com/partners/igel/.

Menu path: Sessions > Horizon Client > Horizon Client Global > Fabulatech USB Redirection

Fabulatech USB Redirection
☑ Fabulatech USB Redirection is used.

☐ Fabulatech USB Redirection is not used.*

Default rule
This rule will apply if no special rule was configured for a class or a device.
Possible options:

Deny*
Allow

•
•
•

•

Important Notes

Enable either native USB redirection or Fabulatech USB Redirection – not both together.
Disable USB redirection if you use DriveLock.
Ensure that no other hotplug storage device (USB memory stick) is connected before you 
enable Fabulatech USB redirection. Otherwise, the hotplug storage device is insecurely 
removed.
Generally, Fabulatech USB Redirection might not be the ideal solution for each use case. 
For details, refer to the general device redirection recommendations of your terminal 
server or VDI vendor.



Tip

To secure your endpoint, it is generally recommended to set Default rule to Deny and to configure 
Allow rules only for the required USB devices and USB device classes. 



http://www.usb-over-network.com/partners/igel/
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Class Rules
Class rules apply to USB device classes and sub-classes.

Managing rules:

 Create a new entry.

 Remove the selected entry.

 Edit the selected entry.

 Copy the selected entry.

The class rule properties are described in the following.

Rule
Possible options:

Deny: Devices that have the properties defined here are not redirected.
Allow: Devices that have the properties defined here are redirected by the Fabulatech USB 
Redirection.*

Class ID
Device class

Getting USB Device Information

To find out the Class ID, Subclass ID, Vendor ID and Product ID of the connected USB device, you can use 
the System Information tool. For further information, see Using “System Information” Function (see page 
634).
System Information example:


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Subclass ID
Subclass relating to the specified device class

Alternatively, you can use the command lsusb  (or lsusb | grep -i [search term] ) in the 
terminal.
Example for lsusb :

Getting USB Device Information

To find out the Class ID, Subclass ID, Vendor ID and Product ID of the connected USB device, you can use 
the System Information tool. For further information, see Using “System Information” Function (see page 
634).


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Name
Free text entry

Override serial
Serial number that will appear in the session

System Information example:

Alternatively, you can use the command lsusb  (or lsusb | grep -i [search term] ) in the 
terminal.
Example for lsusb :
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Override name
Device name that will appear in the session

Postpone
☑ The USB device is only removed from the system (endpoint device) when the session starts.

☐ The USB device is no longer shown immediately after the system is booted.*

Takeaway
☑ The USB device may be removed from the system (endpoint device).

☐ The USB device may not be removed.*

No Reset
☑ The device will not be automatically reset after the connection with the session has been terminated.

☐ The device will be reset after the connection with the session has been terminated.*

Device Rules
A device rule applies to a specific device that is identified by its serial number.

The device rule settings are described in the following.

Rule
Possible options:

Deny: The device will not be redirected via Fabulatech USB Redirection.
Allow: The device will be redirected via Fabulatech USB Redirection.*

Vendor ID
Hexadecimal manufacturer number

This setting is only effective if the Takeaway parameter is enabled.

Getting USB Device Information

To find out the Class ID, Subclass ID, Vendor ID and Product ID of the connected USB device, you can use 
the System Information tool. For further information, see Using “System Information” Function (see page 
634).
System Information example:


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Product ID
Hexadecimal device number

Alternatively, you can use the command lsusb  (or lsusb | grep -i [search term] ) in the 
terminal.
Example for lsusb :

Getting USB Device Information

To find out the Class ID, Subclass ID, Vendor ID and Product ID of the connected USB device, you can use 
the System Information tool. For further information, see Using “System Information” Function (see page 
634).


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Name
Free text entry

Override serial
Serial number that will appear in the session.

System Information example:

Alternatively, you can use the command lsusb  (or lsusb | grep -i [search term] ) in the 
terminal.
Example for lsusb :
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Override name
Device name that will appear in the session.

Postpone
☑ The USB device is only removed from the system (endpoint device) when the session starts.*

☐ The USB device is no longer shown immediately after the system is booted.

Takeaway
☑ The USB device may be removed from the system (endpoint device).*

☐ The USB device may not be removed.

No Reset
☑ The device will not be automatically reset after the connection with the session has been terminated.*

☐ The device will be reset after the connection with the session has been terminated.

*IGEL OS system default

This setting is only effective if the Takeaway parameter is enabled.



Sessions

IGEL OS Reference Manual   196 / 897

Fabulatech Scanner Redirection
Menu path: Sessions > Horizon Client > Horizon Client Global > Fabulatech Scanner Redirection

You can enable or disable Fabulatech scanner redirection.

Fabulatech Scanner for Remote Desktop

☑ Fabulatech scanner redirection is enabled.
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Serial Port Redirection
Serial Port Redirection

With the serial port redirection feature, youcan redirect locally connected serial (/dev/ttyS) ports, such as built-in 
RS232 ports or USB-to-Serial adapters, to their RDS-hosted desktops.

☑ Serial Port Redirection is enabled.

☐ Serial Port Redirection is disabled. (Default)
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1.
2.
3.

4.

Drive Mapping
Menüpfad: Horizon Client > Horizon Client Global > Drive Mapping

Through drive mapping, connected mass storage devices can be made available in the session. Specify which 
folders or drives are mapped during the login.

Enable Drive Mapping

☑ Drive mapping is enabled. (Default)

Drive Mapping: List of mapped drives.

To set up drive mapping, proceed as follows:

Click  Add to bring up the mapping window.
Click Enabled to enable the drive connection.
Select a Drive to map from the list under which the local device or the folder is to be mapped.

Give the Local Drive Path of the local directory to which the mapping is to refer.

Local (USB) devices which are to be used for drive mapping purposes must first be set up as devices. See 
Storage Hotplug (see page 807).



•
•

•

Before you unplug a hotplug storage device from the endpoint device, you must safely remove it. 
Otherwise, data on the hotplug storage device can be damaged. Depending on the configuration, there is 
one or several possibilities to safely remove a hotplug storage device:

Click on  in the task bar. The taskbar is not available in a fullscreen session.
Click on in the in-session control bar. Depending on the configuration, the in-session 
control bar may be available in a fullscreen session. For further information, see In-
Session Control Bar (see page 695).
Function Accessories > Safely Remove Hardware with further starting possibilities; 
amongst other things, a hotkey can be defined here.
If the following warning is displayed: Volume(s) still in use. Don't remove the device, 
then the hotplug storage device must not be removed. First, exit the program concerned 
or close all files or directories that reside on the hotplug storage device.



If the drive letter you have selected is no longer available on the server, the specified 
directory or local drive will be given the next free letter during the login.



If you map a locally connected device, use the pre-defined path names available in the 
drop-down field. The directories in question are those on which the devices are mounted 
by default during the boot procedure (e.g.  /autofs/floppy  for an integrated floppy 
drive).


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Multimedia
Menu path: Setup > Sessions > Horizon Client > Horizon Client Global > Multimedia

You can change the following multimedia settings:

Enable VMware Multimedia Redirection
Possible values:

Off: The server renders the multimedia data and sends the individual images to the client.
On: The client renders the multimedia data supplied by the server.

Real Time Audio Video (RTAV): Specifies the redirection of video data from the client USB 
webcam.
Possible values:

Off: The client does not forward the webcam data as video data.

On: The client forwards the webcam data as video data.

With USB redirection, data from the webcam can be forwarded to the server even if RTAV 
is disabled.


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Performance
Menu path: Setup > Sessions > Horizon Client > Horizon Client Global > Performance

In this area, you can optimize the performance of Horizon Client sessions.

You can change the following settings:

PCoIP client-side image cache size: Specifies the size of the cache for images. Caching parts of the display reduces 
the amount of data to be transferred.
Possible values:

50 MB
100 MB
150 MB
200 MB
250 MB
300 MB

Lakeside SysTrack channel
☑ The Lakeside SysTrack channel is enabled.

☐ The Lakeside SysTrack  channel is not enabled. (Default)

Larger cache sizes of 250 MB or more should only be used if at least 2 GB RAM or more is available.
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Smartcard
Menu path: Sessions > Horizon Client > Horizon Client Global > Smartcard

In this area, you can specify which middleware is used for logon with smartcard.

The following middlewares for logging on to VMware Horizon are available to choose from:

Horizon logon with Gemalto eToken and IDPrime smartcards und token

☑ The middleware for Gemalto/SafeNet eToken, IDPrime smartcards and tokens is used.

☐ The middleware for Gemalto/SafeNet eToken, IDPrime smartcards and tokens is not used. (Default)

Horizon logon with cryptovision sc/interface smartcards

☑ The middleware for cryptovision sc/interface smartcards is used.

☐ The middleware for cryptovision sc/interface smartcards is not used. (Default)

Horizon logon with Gemalto IDPrime smartcards

☑ The middleware for Gemalto IDPrime smartcards is used.

☐ The middleware for Gemalto IDPrime smartcards is not used. (Default)

Horizon logon with Athena IDProtect smartcards

☑ The middleware for Athena IDProtect smartcards is used.

☐ The middleware for Athena IDProtect smartcards is not used. (Default)

Horizon logon with A.E.T. SafeSign smartcards

☑ The middleware for A.E.T. SafeSign Smartcards is used.

☐ The middleware for A.E.T. SafeSign Smartcards is not used. (Default)

Horizon logon with SecMaker Net iD smartcards

☑ The middleware for SecMaker Net iD smartcards is used.

☐ The middleware for SecMaker Net iD smartcards is not used. (Default)

Horizon logon with smartcards supported by Coolkey library

☑ The Coolkey middleware is used.

☐ The Coolkey middleware is not used. (Default)

Horizon logon with smartcards supported by OpenSC

☑ The OpenSC middleware is used.

☐ The OpenSC middleware is not used. (Default)

Activate this Gemalto middleware if you want to use Gemalto common criteria devices in unlinked mode.
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Unified Communications
Menüpfad: Sessions > Horizon Client > Horizon Client Global > Unified Communications

Here, you can change settings relevant to Unified Communications.

Skype for Business (see page 203)
Cisco (see page 204)
VDI Solutions (see page 205)
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Skype for Business
Menu path: Setup > Sessions > Horizon Client > Horizon Client Global > Unified Communications > Skype for 
Business

Virtualization Pack Skype for Business: Defines whether the Virtualization Pack Skype for 
Business is active.
☑ The Virtualization Pack Skype for Business is active. (Default)
☐ The Virtualization Pack Skype for Business is not active.
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Cisco
Menu path: Sessions > Horizon Client > Horizon Client Global > Unified Communications > Cisco

Here, you can activate or deactivate the virtual desktop optimization for Cisco Webex and define settings for the 
Cisco JVDI client.

Cisco Webex Teams VDI

☑ The Cisco Webex Teams VDI solution is enabled.

☐ The Cisco Webex Teams VDI solution is disabled.

Settings for the Cisco JVDI Client

Cisco JVDI Client

☑ The Cisco JVDI Client is enabled. 

☐ The Cisco JVDI Client is disabled. 

For the vendor documentation, see Deployment and Installation Guide for Cisco Jabber Softphone for VDI Release 
12.911.

Audio

Default volume: Headphone volume control. (Default: 80%)

Default microphone volume: Microphone volume control. (Default: 80%)

Default ring volume: Ringtone volume control. (Default 100%)

Internal sound card: Here you have the possibility to define a sound card. If you leave the field empty, the default 
sound card of the system is used.

For further information, see Sound Preferences (see page 578).

Video

You can set the Cisco JVDI Client to use the default resolutions of the camera or to use a user-defined set of 
resolutions. Separate configurations for cameras with and without hardware acceleration are possible.

Allow default resolutions (for cameras without hardware resolution)

☑The default resolutions of the camera are used.

☐A user-defined set of resolutions is used. You can add a resolution by clicking in the Camera area and selecting 
the desired resolution.

Allow default resolutions (for cameras with hardware resolution)

☑The default resolutions of the camera are used.

☐A user-defined set of resolutions is used. You can add a resolution by clicking in the Hardware 
Accelerated Camera area and selecting the desired resolution.

https://www.cisco.com/c/en/us/td/docs/voice_ip_comm/jvdi/12_9/dig/jvdi_b_deploy-install-jvdi-12-9/jvdi_b_deploy-install-jvdi-12-9_chapter_01.html
https://www.cisco.com/c/en/us/td/docs/voice_ip_comm/jvdi/12_9/dig/jvdi_b_deploy-install-jvdi-12-9/jvdi_b_deploy-install-jvdi-12-9_chapter_01.html
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VDI Solutions
Menu path: Sessions > Horizon Client > Horizon Client Global > Unified Communications > VDI Solutions

Here, you can activate or deactivate various virtual desktop optimizations.

HTML5 multimedia redirection

☑ HTML5 multimedia redirection is enabled.

Microsoft Teams optimization

☑ The Microsoft Teams optimization is enabled.

Zoom VDI Media Plugin

☑ The Zoom VDI Media Plugin is enabled.
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Horizon Client Session
Menu path: Sessions > Horizon Client > Horizon Client Sessions > [Session Name]

You can configure one or more Horizon Client sessions.

The settings for launching the session are described below.

Session name: Name for the session.

Starting Methods for Session
Start menu

☑ The session can be launched from the start menu.

Application Launcher

☑ The session can be launched with the Application Launcher.

Desktop

☑ The session can be launched with a program launcher on the desktop.

Quick start panel

☑ The session can be launched with the quick start panel.

Start menu's system tab

☑ The session can be launched with the start menu's system tab.

Application Launcher's system tab

☑ The session can be launched with the Application Launcher's system tab.

Desktop context menu

☑ The session can be launched with the desktop context menu.

Menu folder: If you specify a folder name or a path comprising a number of folder names separated by "/", a menu 
path will be created for the session. The menu path will be used in the start menu and in the desktop context menu.

Application Launcher folder: If you specify a folder name or a path comprising a number of folder names 
separated by "/", a menu path will be created for the session. The menu path will be used in the Application 
Launcher.

Desktop folder: If you specify a folder name or a path comprising a number of folder names separated by "/", a 
menu path will be created for the session. The menu path will be used for the program launcher on the desktop.

Password protection: Specifies which password will be requested when launching the session.
Possible values:

None: No password is requested when launching the session.
Administrator: The administrator password is requested when launching the session.

The session name must not contain any of these characters: \ / : * ? “ < > | [ ] { } ( )
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User: The user password is requested when launching the session.
Setup user: The setup user's password is requested when launching the session.

Hotkey

☑ The session can be started with a hotkey. A hotkey consists of one or more modifiers and a key.

Modifiers: A modifier or a combination of several modifiers for the hotkey. You can select a set key symbol/
combination or your own key symbol/combination. A key symbol is a defined chain of characters, e.g.  Ctrl .

These are the pre-defined modifiers and the associated key symbols:

(No modifier) =  None

 =  Shift
[Ctrl] =  Ctrl

 =  Mod4

[Alt] =  Alt

Key combinations are formed as follows with  | :

Ctrl +   =  Ctrl|Super_L

Key: Key for the hotkey

Autostart

☑ The session will be launched automatically when the device boots.

Restart

☑ The session will be relaunched automatically after the termination.

Do not use [AltGr] as a modifier (represented as Mod5 ). Otherwise, the key that is configured as a hotkey 
with AltGr cannot be used as a regular key anymore. Example: If you configure [AltGr] + [E] as a hotkey, it is 
impossible to enter an "e".



When this keyboard key is used as a modifier, it is represented as Mod4 ; when it is used as a key, it 

is represented as Super_L .



To enter a key that does not have a visible character, e. g. the [Tab] key, open a terminal, log on as user

and enter xev -event keyboard . Press the key to be used for the hotkey. The text in brackets that 

begins with keysym  contains the key symbol for the Key field. Example: Tab  in (keysym 0xff09, 

Tab)


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Autostart delay: Waiting time in seconds between the complete startup of the desktop and the automatic session 
launch.

Autostart requires network

☑ If no network is available at system startup, the session is not started. A message is shown. As soon as the 
network is available, the session is started automatically.

☐ The session is started automatically, even when no network is available.

Connection Settings (see page 209)
Window (see page 210)
Mouse and Keyboard (see page 211)
Mapping (see page 212)
Performance (see page 213)
Options (see page 214)
Multimedia (see page 215)
Proxy (see page 216)
Desktop Integration (see page 217)
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Connection Settings
Menu path: Setup > Sessions > Horizon Client > Horizon Client Sessions > [Session Name] > Connection 
Settings

In this area, you can specify the settings for the connection between the Horizon Client and the server.

Server URL: URL of the VMware Horizon server
Use passthrough authentication for this session
☑ The user name and password are temporarily saved and used for authentication purposes in 
this session.
☐ Passthrough authentication is not used. (default)
User name: User name when logging on to the VMware Horizon server
User password: Password when logging on to the VMware Horizon server
Domain: Domain when logging on to the VMware Horizon server
Session type: Specifies whether the session contains a desktop or an individual application.
Possible values:

Desktop: The session contains a desktop.
Application: The session contains an individual application.

Desktop name: Specifies a name for the desktop. This option is available if Session Type is set to 
“Desktop”.
Application: Application that is launched during the session. This option is available if Session 
Type is set to “Application”.
Autoconnect
☑ When the session starts, the connection to the desktop or application will automatically be 
established. For this to be possible, the name of the desktop or application must be defined.
☐ When the session starts, the overview will be shown. (default)
Preferred desktop protocol: The selected option is preferred by the client when negotiating the 
connection protocol.
Possible values:

Global setting
Server setting
RDP
PCoIP
VMWare Blast

Enable kiosk mode
Global setting
On
Off

Further settings options can be found under AD/Kerberos Configuration (see page 839) and AD/
Kerberos (see page 832).
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Window
Menu path:  Sessions > Horizon Client > Horizon Client Sessions > [Session Name] > Window

In this area, you can change the way in which the session is displayed.

Window size: Specifies the width and height of the window.
Possible values:

Global setting: The window size is carried over from the global settings for RDP sessions, see 
Window (see page 126).
Fullscreen: The session is shown on the full screen.
User selection
Numeric details: The session is shown in the selected resolution or on the selected percentage of 
the screen area.

Number of colors: Specifies the color depth.

Global setting: The color depth is carried over from the global settings for RDP sessions, see 
Window (see page 126).
256
Thousands
Millions

Start monitor: Specifies the monitor on which the session is shown.
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Mouse and Keyboard
Menu path: Sessions > Horizon Client > Horizon Client Sessions > [Session Name] > Mouse and Keyboard

In this area, you can define the settings for the mouse and keyboard.

Disable Mouse Motion Events

☑ The mouse pointer will only be shown locally on the thin client. If the user moves the mouse over a session item, 
no reaction of the item will be shown.

Further settings options can be found in the user interface setup area under Language (see page 696) as well as 
Keyboard (see page 706) and Additional keyboard layouts (see page 707).
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Mapping
Menu path: Setup > Sessions > Horizon Client > Horizon Client Sessions > [Session Name] > Mapping

In this area, you can specify the data transmission between the thin client and Horizon Client session.

Enable Client Audio
Global setting
On - enhanced
On - secure
Off

Enable Clipboard
Global setting
On
Off

Enable Printer Mapping
Global setting
On
Off

Enabling COM Port Mapping
Global setting
On
Off

Enable Drive Mapping
Global setting
On
Off

Enable USB Redirection
Global setting
Off

Further settings options can be found in the RDP Global setup area under Drive Mapping, COM 
Ports, Printers (see page 133), Audio, Keyboard and in the Devices area under Printer (see page 786).

These settings only apply to RDP-based sessions.
 Check whether Sessions > Horizon Client Sessions > Horizon Client Session > Connection Settings 

> Preferred Connection Protocol selection is set to "RDP".


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Performance
Menu path: Setup > Sessions > Horizon Client > Horizon Client Sessions > [Session Name] > Performance

In this area, you can save system resources by disabling certain visual functions of the user interface.

Disable wallpaper:
On: No desktop background image is shown.

Do not show contents of window while dragging:
On: The content of a window will not be shown while the window is being moved.

Disable menu and window animation:
On: Transitions for menus and windows will not be animated.

Disable themes:
On: No optional desktop theme can be used.
Off: An optional desktop theme can be used.

Disable cursor shadow:
On: The mouse pointer will be shown without a shadow.
Off: The mouse pointer will be shown with a shadow.

Disable cursor settings
On: The mouse pointer settings cannot be changed.
Off: The mouse pointer settings can be changed.

Enable font smoothing:
Global setting: The setting under Sessions > Horizon Client > Horizon Client Global will be 
used.
On: Edges will be smoothed when text is displayed.
Off: Edges will not be smoothed when text is displayed.

Further settings options can be found in the Horizon Global setup area under Performance (see page 
200) and in the RDP Global area under Performance (see page 137).
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Options
Menu path: Setup > Sessions > Horizon Client > Horizon Client Sessions > [Session Name] > Options

In this area, you can change the following settings:

Working directory: Directory that is used after logging on
Compression:

Global setting: The setting from Setup > Sessions > Horizon Client > Horizon Client Global
will be carried over.
On: The data flow between the client and server will be compressed.
Off: The data flow will not be compressed.

Enforce TLS-encrypted connections:
Global setting: The setting from Setup > Sessions > Horizon Client > Horizon Client Global
will be carried over.
On: Encryption of the connection with TLS will be forced.
Off: Encryption will not be forced.

Network level authentication:
On: The user will authenticate themselves on the network level (network layer 
authentication) in order to establish an RDP connection.

Off: Conventional authentication
Further settings options can be found in the RDP Global setup area under Options (see page 141), 
Performance (see page 137) and in the Horizon Global area under Local Logon (see page 182).

If network level authentication is enabled, the local logon window is used. This also 
applies if the Use local logon window option under Setup > Sessions > Horizon Client > 
Horizon Client Global > Local Logon is disabled.


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Multimedia
Menu path: Setup > Sessions > Horizon Client > Horizon Client Sessions > [Session Name] > Multimedia

You can change the following multimedia setting:

Enable VMware multimedia redirection
Possible values:

Global setting: The setting under Sessions > Horizon Client > Horizon Client Global will be 
used.
off: The server renders the multimedia data and sends the individual images to the client.

Further options can be found in the Horizon Client Global setup area under Multimedia (see page 
199).
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Proxy
Menu path: Setup > Sessions > Horizon Client > Horizon Client Sessions > [Session Name] > Proxy

In this area, you can configure the use of a proxy for the connection between the client and server.

You can change the following settings:

Direct connection to the Internet:
☑ No proxy will be used.
Manual proxy configuration:
☑ A proxy will be used. The configuration must be specified in the following fields.

HTTP proxy: URL of the proxy for HTTP
Port: Port of the proxy for HTTP
SSL proxy: URL of the proxy for SSL
Port: Port of the proxy for SSL
SOCKS host: URL of the proxy for SOCKS
Port: Port of the proxy for SOCKS
SOCKS protocol version: Version of the SOCKS protocol used. Possible values:
SOCKS v4 
SOCKS v5
No proxy for: List of URLs for which no proxy is to be used (separated by commas).
System-wide proxy configuration:

☑ The proxy configured under Setup > Network > Proxy will be used.
You will find further settings options in the setup under Network > Proxy (see page 784).
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Desktop Integration
Menu path: Sessions > Horizon Client > Horizon Client Sessions > [Session name] > Desktop Integration

Session name: Name for the session.

Starting Methods for Session
Start menu

☑ The session can be launched from the start menu.

Application Launcher

☑ The session can be launched with the Application Launcher.

Desktop

☑ The session can be launched with a program launcher on the desktop.

Quick start panel

☑ The session can be launched with the quick start panel.

Start menu's system tab

☑ The session can be launched with the start menu's system tab.

Application Launcher's system tab

☑ The session can be launched with the Application Launcher's system tab.

Desktop context menu

☑ The session can be launched with the desktop context menu.

Menu folder: If you specify a folder name or a path comprising a number of folder names separated by "/", a menu 
path will be created for the session. The menu path will be used in the start menu and in the desktop context menu.

Application Launcher folder: If you specify a folder name or a path comprising a number of folder names 
separated by "/", a menu path will be created for the session. The menu path will be used in the Application 
Launcher.

Desktop folder: If you specify a folder name or a path comprising a number of folder names separated by "/", a 
menu path will be created for the session. The menu path will be used for the program launcher on the desktop.

Password protection: Specifies which password will be requested when launching the session.
Possible values:

None: No password is requested when launching the session.
Administrator: The administrator password is requested when launching the session.
User: The user password is requested when launching the session.
Setup user: The setup user's password is requested when launching the session.

The session name must not contain any of these characters: \ / : * ? “ < > | [ ] { } ( )
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Hotkey

☑ The session can be started with a hotkey. A hotkey consists of one or more modifiers and a key.

Modifiers: A modifier or a combination of several modifiers for the hotkey. You can select a set key symbol/
combination or your own key symbol/combination. A key symbol is a defined chain of characters, e.g.  Ctrl .

These are the pre-defined modifiers and the associated key symbols:

(No modifier) =  None

 =  Shift
[Ctrl] =  Ctrl

 =  Mod4

[Alt] =  Alt

Key combinations are formed as follows with  | :

Ctrl +   =  Ctrl|Super_L

Key: Key for the hotkey

Autostart

☑ The session will be launched automatically when the device boots.

Restart

☑ The session will be relaunched automatically after the termination.

Autostart delay: Waiting time in seconds between the complete startup of the desktop and the automatic session 
launch.

Autostart requires network

Do not use [AltGr] as a modifier (represented as Mod5 ). Otherwise, the key that is configured as a hotkey 
with AltGr cannot be used as a regular key anymore. Example: If you configure [AltGr] + [E] as a hotkey, it is 
impossible to enter an "e".



When this keyboard key is used as a modifier, it is represented as Mod4 ; when it is used as a key, it 

is represented as Super_L .



To enter a key that does not have a visible character, e. g. the [Tab] key, open a terminal, log on as user

and enter xev -event keyboard . Press the key to be used for the hotkey. The text in brackets that 

begins with keysym  contains the key symbol for the Key field. Example: Tab  in (keysym 0xff09, 

Tab)


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☑ If no network is available at system startup, the session is not started. A message is shown. As soon as the 
network is available, the session is started automatically.

☐ The session is started automatically, even when no network is available.
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Appliance Mode
Menu path: Setup > Sessions > Appliance Mode

In the appliance mode, only one specific session is accessible. You can activate the appliance mode for one of the 
following session types (if available on your system):

VMware Horizon (see page 222)
Browser (see page 223)
Citrix Virtual Desktops (see page 224)
Citrix Self-Service (see page 225)
RHEV/Spice (see page 226)
Imprivata (see page 227)
RDP MultiPoint Server (see page 229)
Caradigm (see page 230)
XDMCP for This Display (see page 233)

By default, access to other applications is not possible in appliance mode. However, these applications can be 
made available by activating Appliance Mode Access at the corresponding Desktop Integration page:

ICA Connection Center (see page 536)
Task Manager (see page 596)
Application Launcher (see page 574)
Firmware Update (see page 646)
Quick Settings (see page 559)
Sound Preferences (see page 578)
Disk Utility (see page 635)
Commands (see page 618)
Webcam Information (see page 658)
Touchscreen Calibration (see page 592)
Screen Lock/Saver (see page 697)
Monitor Calibration (see page 615)
Network Tools (see page 621)
Screenshot Tool (see page 603)
System Information (see page 631)
Bluetooth Tool (see page 626)
Display Switch (see page 563)
Identify Monitors (see page 654)
System Log Viewer (see page 584)
Local Terminal (see page 540)

The system hotkey [Ctrl]+[Alt]+[s] for launching the setup application does not work in the appliance 
mode. Use [Ctrl]+[Alt]+[F2] instead.



You can set up a hotkey to start quick setup in appliance mode.
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SSH Session (see page 366)
Custom Application (see page 871)
Mobile Device Access (see page 643)
Open VPN (see page 755)
OpenConnect VPN (see page 762)
genucard (see page 765)

Additionally, the in-session control bar can be used in an appliance mode session. With the in-session control bar, 
the user can eject a USB drive, start the wireless manager, start the Mobile Device Access USB tool and end the 
session. For further information, see In-Session Control Bar (see page 695).
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VMware Horizon
Menu path: Sessions > Appliance Mode > VMware Horizon

Server URL: URL of the VMware Horizon server.

User name: User name when logging on to the VMware Horizon server.

User password: Password when logging on to the VMware Horizon server.

Domain: Domain when logging on to the VMware Horizon server.

Desktop name: Desktop that is to be launched automatically.

Autoconnect

☑ The desktop given in Desktop name is launched automatically.

Network level authentication

on: The user will authenticate themselves on the network level (network layer authentication) in 
order to establish an RDP connection.
off: Conventional authentication

Enable on-screen keyboard:

☑ If a touchscreen is available, an on-screen keyboard will be shown.

x coordinate of on-screen keyboard: Specifies the X position of the on-screen keyboard. (Default: 0)

y position of on-screen keyboard: Specifies the Y position of the on-screen keyboard. (Default: -1)

Width of on-screen keyboard in pixels: It is recommended that you specify either the width or the height. (Default:
0)

Height of on-screen keyboard in pixels: It is recommended that you specify either the width or the height. 
(Default: 300)

Session passwords are stored with reversible encryption. Therefore, we strongly recommend not to store 
the session password on the endpoint device. 



If network level authentication is enabled, the local logon window is used. This also applies if the Use local 
login window option under Sessions > Horizon Client > Horizon Client Global > Local Logon is disabled.



If the on-screen keyboard is enabled, the local logon window is used. This also applies if the Use local 
login window option under Sessions > Horizon Client > Horizon Client Global > Local Logon is disabled.





Sessions

IGEL OS Reference Manual   223 / 897

Browser
Menu path: Sessions > Appliance Mode > Browser

When this appliance mode is active, the Firefox browser is started to establish a connection with a session, e.g. a 
Citrix XenDesktop session. With a Citrix session, the browser is restarted after the session has been closed.

Web URL: URL for the session

If your session requires an on-screen keyboard, you can jump to the relevant configuration page via the 
link On-screen keyboard on the right-hand side. See also On-Screen Keyboard (see page 607).


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Citrix Virtual Desktops
Menu path: Setup > Sessions > Appliance Mode > Citrix Virtual Desktops

Virtual Desktop delivery server URL: URL of the Virtual Desktop Delivery server.

Smartcard Login

☑ The user can log in with a smartcard.

On-screen keyboard

☑ If the screen is a touchscreen, an on-screen keyboard will be shown.

The following settings are active if On-screen keyboard is enabled.

X coordinate of the on-screen keyboard: Specifies the X position of the on-screen keyboard. (Default: 0)

Y coordinate of the on-screen keyboard: Specifies the Y position of the on-screen keyboard. (Default: 0)

Width of on-screen keyboard in pixels: It is recommended that you specify either the width or the height. (Default:
0)

Height of on-screen keyboard in pixels: It is recommended that you specify either the width or the height. 
(Default: 300)

When the option is enabled, the browser and the virtual desktop will be restarted.
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Citrix Self-Service
Menu path: Setup > Sessions > Appliance Mode > Citrix Self-Service

At least Citrix Receiver Version 13 is required!

Self-Service delivery server URL: Server address including the https://  prefix.

Multi User (StoreFront servers only)
☑ The user data on the client will be deleted after logging off or terminating Self-Service.
Reconnect after logon
☑ The Self-Service GUI reconnects automatically after being launched.
Reconnect to apps after starting an application
☑ The Self-Service GUI will attempt to reconnect to ongoing sessions if an application is launched 
or the store is reloaded.
Enable on-screen keyboard
☑ If the screen is a touchscreen, an on-screen keyboard will be shown.
X coordinate of the on-screen keyboard: Specifies the X position of the on-screen keyboard 
(default: 0).
Y coordinate of the on-screen keyboard: Specifies the Y position of the on-screen keyboard 
(default: 0).
Width of on-screen keyboard in pixels: It is recommended that you specify either the width or 
the height (default: 0).
Height of on-screen keyboard in pixels: It is recommended that you specify either the width or 
the height (default: 300).

In the Appliance Mode, only one server can be used for Self-Service.



Sessions

IGEL OS Reference Manual   226 / 897

RHEV/Spice
Menu path: Setup > Sessions > Appliance Mode > RHEV/Spice

Connection Broker: URL of the Connection Broker

Enable on-screen keyboard

☑ If the screen is a touchscreen, an on-screen keyboard will be shown.

X coordinate of the on-screen keyboard: Specifies the X position of the on-screen keyboard (default: -1).

Y coordinate of the on-screen keyboard: Specifies the Y position of the on-screen keyboard (default: -1).

Width of on-screen keyboard in pixels: It is recommended that you specify either the width or the height (default:
0).

Height of on-screen keyboard in pixels: It is recommended that you specify either the width or the height (default:
300).
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Imprivata
Menu path: Setup > Sessions > Appliance Mode > Imprivata

Imprivata offers digital security solutions for healthcare organizations. For more information, see imprivata.com12.

Set the URL to the Server: URL address of the single sign-on server.

Path to the Appliance: Path to the application on the single sign-on server. (Default: sso/servlet/

getembeddedloader?arch=amd64 )

Enable Component's Logging

☑ Log files will be generated. You will need them if support is required in the future.

Redirection of Smartcards

☑ A smartcard will be redirected into a session.

The following setting is active if Enable Component's Logging is enabled.

Component's Logging Verbosity: Specifies the level of detail for the log files.
Possible options:

"debug": Detailed information on the flow through the system.
"info": Runtime events (startup/shutdown). 
"warning": Events that may lead to unexpected behavior.
"error": Other errors or unexpected conditions.
"critical": Events that may break the workflow. 

Generic session: Name of the Citrix session which was configured for Citrix Fast User Switching using generic 
access data.

Path to Certificate: Absolute path to the certificate your Imprivata Appliance or Certification Authority issued. 

Enable on-screen keyboard

☑ If a touchscreen is used, the on-screen keyboard is enabled.

The following settings are active if Enable on-screen keyboard is activated.

x coordinate of on-screen keyboard: Specifies the X position of the on-screen keyboard in pixels. (Default: 2)

y coordinate of on-screen keyboard: Specifies the Y position of the on-screen keyboard in pixels. (Default: 2)

Width of on-screen keyboard in pixels: It is recommended that you specify either the width or the height. (Default: 
900)

Height of on-screen keyboard in pixels: It is recommended that you specify either the width or the 
height. (Default: 0)

IMPORTANT NOTE
If you rename the certificate or decide to store it in a different place, you have to adjust the path 
accordingly under Sessions > Appliance Mode > Imprivata > Path to Certificate.
Best practice is to change it directly through the profile which also issued the firmware update. 



https://www.imprivata.com/
https://www.imprivata.com/
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If you need to modify and adjust the sessions, see Imprivata: Session Customization.

Imprivata automatically creates data partitions, i.e. storage locations for internal data. 
If you are asked by your support to delete the data partition or you want to delete it for other reasons, 
see Imprivata: Clear the Imprivata Data Partition.


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RDP MultiPoint Server
Menu path: Sessions > Appliance Mode > RDP MultiPoint Server

Connect to server as soon as it is found: If you always have to connect to the same server, you can preset the 
connection here by giving the DNS name of your RDP MultiPoint Server.
Otherwise, the device will find one or more RDP MultiPoint Servers automatically as soon as you launch the session. 
For this to be possible, the servers must be in the same network as the device and obtain their IP address from the 
same DHCP server as the device.
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Caradigm
Menu path: Setup > Sessions > Appliance Mode > Caradigm

The Caradigm appliance is integrated from IGEL Linux Version 5.09.100.

Caradigm Vault VIP: IP address or host name of the Caradigm authentication server, also referred 
to as the Vault
Caradigm Vault Port: Port number of the Caradigm authentication server (default port: 8443)

SSL Client Private Key: Path to the private key of the thin client. Example: /wfs/ca-certs/

tc_pk.pem

SSL Client Certificate: Path to the client certificate. Example: /wfs/ca-certs/tc_ca.crt

CA certs file: Path to the file which contains the CA certificates. Example: /etc/ssl/certs/

ca-certificates.crt
Disable SSL certification validation
☑ SSL validation will be disabled for testing purposes. Normally, the certificates should always be 
validated.
Timeout: Specifies the number of seconds after which the connection is automatically terminated 
(default: 30).
Way2Care (EGP): Name of a group within which the user can log in system-wide with a card 
without having to authenticate themselves again. Example: EGPGroup

Default domain: Name of the default domain. The following options are available for specifying 
the domain:

The authentication server returns a domain.
A default domain for the Caradigm Appliance is set.
A system-wide default domain is entered. You will find it under IGEL Setup > Network > 
LAN Interfaces > Default Domain field.
The user enters the domain manually when logging on.

Session type: Selects the session type. To do this, you must have entered the server in the 
relevant session beforehand. 
Possible values:

Citrix HDX/ICA
VMware Horizon

For the certificates that follow, you have to send the certificate files to the client via the file 
transfer - to the directory wfs/ca-certs/ . Three files are needed: the thin client 
certificate, the thin client private key and the Root-CA public key. Now enter the 
certificates here in the setup. The CA certificates must not be changed because the Root-
CA is automatically available after the first reboot via the file ca-certificates.crt .



This function only affects desktop sessions.
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Microsoft RDP

Depending on the session type, you have the following setting options:

Advanced settings for Citrix HDX/ICA

Logoff behavior: The logoff behavior can be specified for Citrix HDX/ICA. The following are 
possible:
User selection 
Session termination 
Session logoff

Advanced settings for VMware Horizon

Server URL: URL of the VMware Horizon server
Desktop name: Name of the desktop that is to be launched automatically.
Autoconnect
☑ Connect automatically to the desktop if enough information is given.
Network Level Authentication 
On: Enables network level authentication (NLA) for RDP connections. Requires local logon window. 
Off: Conventional authentication

Company Logo: (Optional) Full path of an image file for a logo which is to appear in the logon 
window.
Logging
☑ Local logging is enabled.

Logging verbosity: Specifies how exact logging is to be. The level of detail decreases as you 
move down through the selection.
Possible values: 
debug 
info 
warning 
error 
critical

On-screen keyboard: If this option is enabled, an on-screen keyboard will be shown.
X position of the on-screen keyboard: Specifies the X position of the on-screen keyboard 
(default: -1).
Y position of the on-screen keyboard: Specifies the Y position of the on-screen keyboard 
(default: -1).
Width of on-screen keyboard in pixels: It is recommended that you specify either the 
width or the height (default: 0).
Height of on-screen keyboard in pixels: It is recommended that you specify either the 
width or the height (default: 300).
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1.

2.

Smartcard Logon
To log in or off using the smartcard via Caradigm, proceed as follows:

 Tap the card on the card reader to log in.

 Tap the card on the card reader once more to log off again.

Forgotten your card?

Click on the arrow at the bottom right of the logon mask.
The Enter user data mask will open.
Enter your logon data.

If you leave the terminal without logging off, you will automatically be logged off as soon as another user 
logs on.


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XDMCP for This Display
Menu path: Sessions > Appliance Mode > XDMCP for this Display

If this session type is selected, the thin client acts as an XDMCP client.

Connection type: The type of the connection.
Possible values:

Indirect via localhost: At startup, the thin client generates a list of found XDMCP hosts. The user 
can select a host.
Indirect: At startup, a list of XDMCP hosts is displayed. This list is generated by the server specified 
under Name or IP of the server. The user can select a host.
Direct: The login mask of the host specified under Name or IP of the server is displayed.
Broadcast: The thin client starts a broadcast request. The login mask of that XDMCP host is 
displayed which is the first to respond to the broadcast request.

Name or IP of server: The name or IP of the XDMCP server.

Enable hotkeys for XDMCP Display: Defines whether hotkeys are managed by the thin client or the host.

☑ Hotkeys are managed by the thin client. When the user enters a shortcut key that is defined as a hotkey on the 
thin client, it starts the appropriate action. The input is not forwarded to the server. (Default)

☐ Hotkeys are not managed by the thin client. Almost all keyboard shortcuts are forwarded to the server. The 
hotkey [Ctrl + Alt + s] for opening the IGEL setup can still be used, provided that this hotkey is activated under
Accessories > Setup.
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Caradigm
Menu path: Setup > Sessions > Caradigm

The procedure for configuring your Caradigm session is described below.

Connection (see page 235)
Options (see page 236)
Desktop Integration (see page 238)
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Connection
Menu path: Setup > Sessions > Caradigm > Connection

In this area, you can define the connection settings for your Caradigm session:

Caradigm Vault VIP: IP address or host name of the Caradigm authentication server, also referred 
to as the Vault
Caradigm Vault Port: Port number of the Caradigm authentication server (default: 8443)

SSL Client Private Key: Path to the private key of the thin client (example: /wfs/client-

certs/tc_pk.pem )

SSL Client Certificate: Path to the client certificate (example: /wfs/client-certs /

tc_ca.crt )

CA certs file: Path to the file which contains the CA certificates (example: /etc/ssl/certs/

ca-certificates.crt )
Disable SSL certification validation:
☑ SSL validation will be disabled for testing purposes. Normally, the certificates should always be 
validated.
Timeout: Specifies the number of seconds after which the connection is automatically terminated. 
(default: 30)
Way2Care (EGP): Name of a group within which the user can log on system-wide with a card 
without having to authenticate themselves again. (Example: EGPGroup)

For the following certificates, you have to send the certificate files from the UMS to the 
client via the file transfer – to the directory / wfs/client-certs/ . Three files are 
needed: the thin client certificate, the thin client private key and the Root-CA public key. 
Now enter the certificates here in the setup. The CA certificates must not be changed 
because the Root-CA is automatically available after the first reboot via the file ca-

certificates.crt .



This function only affects desktop sessions.
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Options
Menu path: Setup > Sessions > Caradigm > Options

In this area, you can configure additional Caradigm settings such as the location domain and session-type-specific 
attributes:

Default domain: Name of the default domain. The following options are available for specifying 
the domain:

The authentication server returns a domain.
A default domain for the Caradigm Appliance is set.
A system-wide default domain is entered. You will find it under Setup > Network > LAN 
Interfaces > Default Domain field.
The user enters the domain manually when logging on.

Session type: Selects the session type. To do this, you must have entered the server in the 
relevant session beforehand. Possible values:

Citrix HDX/ICA
VMware Horizon
Microsoft RDP

Depending on the session type, you have the following setting options:

Advanced settings for Citrix HDX/ICA

Logout behavior: The logoff behavior can be specified for Citrix HDX/ICA. 
Possible values:

User choice
Force disconnect
Force logoff

Advanced settings for VMware Horizon

Server URL: URL of the VMware Horizon server
Desktop name: Name of the desktop that is to be launched automatically
Autoconnect
☑ Connect automatically to the desktop if enough information is given.
Network level authentication

On: Enables network level authentication (NLA) for RDP connections. Requires local logon 
window.
Off: Conventional authentication

Company logo: (Optional) Full path of an image file for a logo which is to appear in the logon 
window.
Logging:
☑ Local logging is enabled.
Logging verbosity: Specifies how exact logging is to be. The level of detail decreases as you move 
down through the selection.
Possible values:
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debug
info
warning
error
critical
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Desktop Integration
Menu path: Setup > Sessions > Caradigm > Desktop Integration

You can configure one or more Caradigm sessions.

The settings for launching the session are described below.

Session name: Name for the session

Session start options
Start menu

☑ The session can be started with the start menu.

Application Launcher

☑ The session can be started with the Application Launcher.

Desktop:

☑ The session can be started with a program starter on the desktop.

Quick start panel:

☑ The session can be started with the quick start panel.

Start menu's system tab

☑ The session can be started with the start menu’s system tab.

Application Launcher's system tab

☑ The session can be started with the Application Launcher’s system tab.

Desktop context menu

☑ The session can be started with the desktop context menu.

Menu folder: If you specify a folder name or a path comprising a number of folder names separated by "/", a menu 
path will be created for the session. The menu path will be used in the start menu and in the desktop context menu.

Path in the Application Launcher: If you specify a folder name or a path comprising a number of folder names 
separated by "/", a menu path will be created for the session. The menu path will be used in the Application 
Launcher.

Desktop folder: If you specify a folder name or a path comprising a number of folder names separated by "/", a 
menu path will be created for the session. The menu path will be used for the program launcher on the desktop.

Password protection: Specifies which password will be requested when launching the session.
Possible values:

None: No password is requested when launching the session.
Administrator: The administrator password is requested when launching the session.
User: The user password is requested when launching the session.

The session name must not contain any of these characters: \ / : * ? “ < > | [ ] { } ( )
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Setup user: The setup user's password is requested when launching the session.

Hotkey:

☑ The session can be started with a hotkey. A hotkey consists of one or more modifiers and a key.

Modifiers: A modifier or a combination of several modifiers for the hotkey. You can select a set key symbol/
combination or your own key symbol/combination. A key symbol is a defined chain of characters, e.g.  Ctrl .

These are the pre-defined modifiers and the associated key symbols:

(No modifier) =  None

 =  Shift
[Ctrl] =  Ctrl

 =  Mod4

[Alt] =  Alt

Key combinations are formed as follows with  | :

Ctrl +   =  Ctrl|Super_L

Key: Key for the hotkey

Autostart: If this option is enabled, the session will be launched automatically when the thin client boots.

Relaunch: If this option is enabled, the session will be relaunched automatically after termination.

Autostart delay: Waiting time in seconds between the thin client booting and the session being launched 
automatically.

Autostart requires network

Do not use [AltGr] as a modifier (represented as Mod5 ). Otherwise, the key that is configured as a hotkey 
with AltGr cannot be used as a regular key anymore. Example: If you configure [AltGr] + [E] as a hotkey, it is 
impossible to enter an "e".



When this keyboard key is used as a modifier, it is represented as Mod4 ; when it is used as a key, it 

is represented as Super_L .



To enter a key that does not have a visible character, e. g. the [Tab] key, open a terminal, log on as user

and enter xev -event keyboard . Press the key to be used for the hotkey. The text in brackets that 

begins with keysym  contains the key symbol for the Key field. Example: Tab  in (keysym 0xff09, 

Tab)


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☑ If no network is available at system startup, the session is not started. A message is shown. As soon as the 
network is available, the session is started automatically.

☐ The session is started automatically, even when no network is available.
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Leostream
Menu path: Setup > Sessions > Leostream

In this area, you can configure settings for the Leostream Connection Broker. You have the following options:

Connection Details of the server and domain for logging on.

Desktop Integration Start option settings for this session.

Options Setting up the logon prompt and USB redirection.

More information on the Leostream Connection Broker is available from Leostream by visiting: http://
www.leostream.com/resources/downloads.php.

_____

Session (see page 242)
Connection (see page 244)
Desktop Integration (see page 245)
Options (see page 248)

By default, the RD Desktop client is used for the connection in UDLX – rdesktop must therefore be set as the 
Leostream API protocol with priority 1 on the server.



http://www.leostream.com/resources/downloads.php
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Session
Menu path: Setup > Sessions > Leostream > [session name]

Session name: Name for the session

Session start options

Start menu
☑ The session can be started with the start menu.
Application Launcher
☑ The session can be started with the Application Launcher.
Desktop
☑ The session can be started with a program starter on the desktop.
Autostart requires network
☑ If no network is available at system startup, the session is not started. A message is shown. As 
soon as the network is available, the session is started automatically.
☐ The session is started automatically, even when no network is available.
Hotkey
☑ The session can be started with a hotkey. A hotkey consists of one or more modifiers and a 
key.
Modifiers: A modifier or a combination of several modifiers for the hotkey. You can select a set key 
symbol/combination or your own key symbol/combination. A key symbol is a defined chain of 
characters, e.g. Ctrl . Here, you will find the available modifiers and the associated key symbols:

(No modifier) = None

 = Shift
[Ctrl] = Ctrl

 = Super_L

[Alt] = Alt

Key combinations are formed as follows with | :

Ctrl +  = Ctrl|Super_L
Key: Key for the hotkey

The session name must not contain any of these characters: \ / : * ? “ < > | 

[ ] { } ( )



To enter a key that does not have a visible character, e. g. the [Tab] key, open a terminal, 
log on as user  and enter xev -event keyboard . Press the key to be used for the 


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Autostart: If this option is enabled, the session will be launched automatically when the thin client 
boots.
Restart: If this option is enabled, the session will be relaunched automatically after termination.
Autostart delay: Waiting time in seconds between the thin client booting and the session being 
launched automatically.

hotkey. The text in brackets that begins with keysym  contains the key symbol for the 

Key field. Example: Tab  in (keysym 0xff09, Tab)
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Connection
Menu path: Setup > Sessions > Leostream > [session name] > Connection

Server: IP address or hostname of the connection broker.
User name: Login user name.
Domain: Login domain.
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Desktop Integration
Menu path: Setup > Sessions > Leostream > [session name] > Desktop Integration

Session name: Name for the session.

Starting Methods for Session
Start menu

☑ The session can be launched from the start menu.

Application Launcher

☑ The session can be launched with the Application Launcher.

Desktop

☑ The session can be launched with a program launcher on the desktop.

Quick start panel

☑ The session can be launched with the quick start panel.

Start menu's system tab

☑ The session can be launched with the start menu's system tab.

Application Launcher's system tab

☑ The session can be launched with the Application Launcher's system tab.

Desktop context menu

☑ The session can be launched with the desktop context menu.

Menu folder: If you specify a folder name or a path comprising a number of folder names separated by "/", a menu 
path will be created for the session. The menu path will be used in the start menu and in the desktop context menu.

Application Launcher folder: If you specify a folder name or a path comprising a number of folder names 
separated by "/", a menu path will be created for the session. The menu path will be used in the Application 
Launcher.

Desktop folder: If you specify a folder name or a path comprising a number of folder names separated by "/", a 
menu path will be created for the session. The menu path will be used for the program launcher on the desktop.

Password protection: Specifies which password will be requested when launching the session.
Possible values:

None: No password is requested when launching the session.
Administrator: The administrator password is requested when launching the session.
User: The user password is requested when launching the session.
Setup user: The setup user's password is requested when launching the session.

The session name must not contain any of these characters: \ / : * ? “ < > | [ ] { } ( )
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Hotkey

☑ The session can be started with a hotkey. A hotkey consists of one or more modifiers and a key.

Modifiers: A modifier or a combination of several modifiers for the hotkey. You can select a set key symbol/
combination or your own key symbol/combination. A key symbol is a defined chain of characters, e.g.  Ctrl .

These are the pre-defined modifiers and the associated key symbols:

(No modifier) =  None

 =  Shift
[Ctrl] =  Ctrl

 =  Mod4

[Alt] =  Alt

Key combinations are formed as follows with  | :

Ctrl +   =  Ctrl|Super_L

Key: Key for the hotkey

Autostart

☑ The session will be launched automatically when the device boots.

Restart

☑ The session will be relaunched automatically after the termination.

Autostart delay: Waiting time in seconds between the complete startup of the desktop and the automatic session 
launch.

Autostart requires network

Do not use [AltGr] as a modifier (represented as Mod5 ). Otherwise, the key that is configured as a hotkey 
with AltGr cannot be used as a regular key anymore. Example: If you configure [AltGr] + [E] as a hotkey, it is 
impossible to enter an "e".



When this keyboard key is used as a modifier, it is represented as Mod4 ; when it is used as a key, it 

is represented as Super_L .



To enter a key that does not have a visible character, e. g. the [Tab] key, open a terminal, log on as user

and enter xev -event keyboard . Press the key to be used for the hotkey. The text in brackets that 

begins with keysym  contains the key symbol for the Key field. Example: Tab  in (keysym 0xff09, 

Tab)


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☑ If no network is available at system startup, the session is not started. A message is shown. As soon as the 
network is available, the session is started automatically.

☐ The session is started automatically, even when no network is available.
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Options
Menu path: Setup > Sessions > Leostream > [session name] > Options

Hide the 'Advanced Login' button
☑ The Advanced Login button is hidden. (Default)
Remove the domain field from the login screen
☑ The domain field is removed.
☐ The domain field is not removed. (Default)
When using a single desktop
Possible values:

Do not attach USB devices
Prompt to select devices to attach
Automatically attach all devices

When using multiple desktops
Possible values:

Do not attach USB devices
Prompt to select devices to attach
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AppliDis
Menu path: Setup > Sessions > AppliDis

AppliDis Fusion 4 is a virtualization solution which combines the virtualization of desktops and applications in a 
single console.

If you create an AppliDis session, you can configure the following settings:

Connection (see page 250): Details of the Server URL and Connect Type for logging on. If you use 
AppliDis SLB Linux in the Connector Mode, the name of the application that uses the connector 
can be specified here.
Options (see page 251): Allows you to define the language, credentials, access path, and further 
settings for the AppliDis client.
Desktop Integration (see page 253): Start option settings for this session.
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Connection
Menu path: Setup > Sessions > AppliDis > Connection

Server URL: Address of the AppliDis server or the administration server

HTTP/HTTPS service port: Protocol for communication with the AppliDis server
Possible options:

http
https

Connection type
Possible options:

Standard TS/RDS environment
VirtualDesktop environment
VirtualDesktop environment with AppliDis dashboard registration

AppliDis SLB connector mode: Name of the application which the connector uses if AppliDis SLB Linux is to be 
used in the connector mode.
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Options
Menu path: Setup > Sessions > AppliDis > Options

Language
Possible options:

English
French

RDP mode
Possible options:

classic RDP
console mode RDP

Working directory: Complete path of the work directory for the application on the server.

User name: User name when logging on to the server

Password: Password when logging on to the server

Full path to cert: Path to the certificate with file name.

Timeout: Maximum time that the system waits for a response from the server (default: 30)

AppliDisXML access path: Path for XML communication with the AppliDis administration server. (Example: /

applidisXML/ApplidisServer.asp )

Lock connection type

☑ The connection type is locked. (default)

☐ The connection type is not locked.

Hide “Close” tab

☑ The “Close” tab is not hidden. (default)

☐ The “Close” tab is not hidden.

Close AppliDis client at end of session

☑ The client is closed when the session ends. (default)

☐ The client is not closed.

Force insecure mode

☑ Insecure mode is forced.

☐ Insecure mode is not forced. (default)

Enable debug mode

☑ Debug mode is enabled.

Session passwords are stored with reversible encryption. Therefore, we strongly recommend not to store 
the session password on the endpoint device. 


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☐ Debug mode is disabled. (default)

Activate SSL mode

☑ SSL mode is enabled.

☐ SSL mode is not enabled. (default)

Remember user

☑ AppliDis remembers the user name. (default)

☐ AppliDis does not remember the user name.

Discard credentials

☑ The credentials are not saved. (default)

☐ The credentials are saved.

Hide “Filter” tab

☑ The “Filter” tab is not shown.

☐ The “Filter” tab is shown. (default)

Hide “Service” tab

☑ The “Service” tab is not shown.

☐ The “Service” tab is shown. (default)

Hide “Server” tab

☑ The “Server” tab is not shown.

☐ The “Server” tab is shown. (default)
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Desktop Integration
Menu path: Setup > Sessions > AppliDis > Desktop Integration

Session name: Name for the session.

Starting Methods for Session
Start menu

☑ The session can be launched from the start menu.

Application Launcher

☑ The session can be launched with the Application Launcher.

Desktop

☑ The session can be launched with a program launcher on the desktop.

Quick start panel

☑ The session can be launched with the quick start panel.

Start menu's system tab

☑ The session can be launched with the start menu's system tab.

Application Launcher's system tab

☑ The session can be launched with the Application Launcher's system tab.

Menu folder: If you specify a folder name or a path comprising a number of folder names separated by "/", a menu 
path will be created for the session. The menu path will be used in the start menu and in the desktop context menu.

Application Launcher folder: If you specify a folder name or a path comprising a number of folder names 
separated by "/", a menu path will be created for the session. The menu path will be used in the Application 
Launcher.

Desktop folder: If you specify a folder name or a path comprising a number of folder names separated by "/", a 
menu path will be created for the session. The menu path will be used for the program launcher on the desktop.

Password protection: Specifies which password will be requested when launching the session.
Possible values:

None: No password is requested when launching the session.
Administrator: The administrator password is requested when launching the session.
User: The user password is requested when launching the session.
Setup user: The setup user's password is requested when launching the session.

Hotkey

☑ The session can be started with a hotkey. A hotkey consists of one or more modifiers and a key.

The session name must not contain any of these characters: \ / : * ? “ < > | [ ] { } ( )
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Modifiers: A modifier or a combination of several modifiers for the hotkey. You can select a set key symbol/
combination or your own key symbol/combination. A key symbol is a defined chain of characters, e.g.  Ctrl .

These are the pre-defined modifiers and the associated key symbols:

(No modifier) =  None

 =  Shift
[Ctrl] =  Ctrl

 =  Mod4

[Alt] =  Alt

Key combinations are formed as follows with  | :

Ctrl +   =  Ctrl|Super_L

Key: Key for the hotkey

Autostart

☑ The session will be launched automatically when the device boots.

Restart

☑ The session will be restarted automatically after the termination.

Autostart delay: Waiting time in seconds between the complete startup of the desktop and the automatic session 
launch.

Autostart requires network

☑ If no network is available at system startup, the session is not started. A message is shown. As soon as the 
network is available, the session is started automatically.

Do not use [AltGr] as a modifier (represented as Mod5 ). Otherwise, the key that is configured as a hotkey 
with AltGr cannot be used as a regular key anymore. Example: If you configure [AltGr] + [E] as a hotkey, it is 
impossible to enter an "e".



When this keyboard key is used as a modifier, it is represented as Mod4 ; when it is used as a key, it 

is represented as Super_L .



To enter a key that does not have a visible character, e. g. the [Tab] key, open a terminal, log on as user

and enter xev -event keyboard . Press the key to be used for the hotkey. The text in brackets that 

begins with keysym  contains the key symbol for the Key field. Example: Tab  in (keysym 0xff09, 

Tab)


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☐ The session is started automatically, even when no network is available.
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•

Evidian AuthMgr
Menu path: Sessions > Evidian AuthMgr

The procedure for configuring your Evidian AuthMgr session is described below.

Evidian AuthMgr Global (see page 257)
Evidian AuthMgr Session (see page 261)
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Evidian AuthMgr Global
Menu path: Setup > Sessions > Evidian AuthMgr > Evidian AuthMgr Global

Here, you can configure the global settings for Evidian AuthMgr sessions.

Restart (see page 258)
Options (see page 260)
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Restart
Menu path: Setup > Sessions > Evidian AuthMgr > Evidian AuthMgr Global > Restart

Here, you can define the desktop integration for restarting Evidian AuthMgr.

Session name: Name for the session.

Starting Methods for Session

Start menu

☑ The session can be launched from the start menu.

Application Launcher

☑ The session can be launched with the Application Launcher.

Desktop

☑ The session can be launched with a program launcher on the desktop.

Quick start panel

☑ The session can be launched with the quick start panel.

Start menu's system tab

☑ The session can be launched with the start menu's system tab.

Application Launcher's system tab

☑ The session can be launched with the Application Launcher's system tab.

Desktop context menu

☑ The session can be launched with the desktop context menu.

Menu folder: If you specify a folder name or a path comprising a number of folder names separated by "/", a menu 
path will be created for the session. The menu path will be used in the start menu and in the desktop context menu.

Application Launcher folder: If you specify a folder name or a path comprising a number of folder names 
separated by "/", a menu path will be created for the session. The menu path will be used in the Application 
Launcher.

Desktop folder: If you specify a folder name or a path comprising a number of folder names separated by "/", a 
menu path will be created for the session. The menu path will be used for the program launcher on the desktop.

Password protection: Specifies which password will be requested when launching the session.
Possible values:

None: No password is requested when launching the session.
Administrator: The administrator password is requested when launching the session.
User: The user password is requested when launching the session.

The session name must not contain any of these characters: \ / : * ? “ < > | [ ] { } ( )



Sessions

IGEL OS Reference Manual   259 / 897

•

•

•

•

•

•

•

Setup user: The setup user's password is requested when launching the session.

Hotkey

☑ The session can be started with a hotkey. A hotkey consists of one or more modifiers and a key.

Modifiers: A modifier or a combination of several modifiers for the hotkey. You can select a set key symbol/
combination or your own key symbol/combination. A key symbol is a defined chain of characters, e.g.  Ctrl .

These are the pre-defined modifiers and the associated key symbols:

(No modifier) =  None

 =  Shift
[Ctrl] =  Ctrl

 =  Mod4

[Alt] =  Alt

Key combinations are formed as follows with  | :

Ctrl +   =  Ctrl|Super_L

Key: Key for the hotkey

Do not use [AltGr] as a modifier (represented as Mod5 ). Otherwise, the key that is configured as a hotkey 
with AltGr cannot be used as a regular key anymore. Example: If you configure [AltGr] + [E] as a hotkey, it is 
impossible to enter an "e".



When this keyboard key is used as a modifier, it is represented as Mod4 ; when it is used as a key, it 

is represented as Super_L .



To enter a key that does not have a visible character, e. g. the [Tab] key, open a terminal, log on as user

and enter xev -event keyboard . Press the key to be used for the hotkey. The text in brackets that 

begins with keysym  contains the key symbol for the Key field. Example: Tab  in (keysym 0xff09, 

Tab)


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Options
Menu path: Setup > Sessions > Evidian AuthMgr > Evidian AuthMgr Global > Options

Options

Language selection: Language selection of catalog messages.
Possible values:

Global setting
English (UK)
English (US)
German
French
Custom

Custom catalog of messages: Choose here the file for the custom catalog of messages. (Default: /services/

evidian/share/locale/en/rsUserAuth.cat )

Data Partition

Evidian AuthMgr Data Partition

☑ The data partition is activated so that additional data can be stored persistently.

☐ The data partition is deactivated. (Default)

Size: Size of the Evidian AuthMgr data partition in MB. (Default: 10)
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Evidian AuthMgr Session
Menu path: Sessions > Evidian AuthMgr > Evidian AuthMgr Sessions

Here, you can set up your own Evidian AuthMgr session.

Connection (see page 262)
Options (see page 263)
Desktop Integration (see page 265)
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Connection
Menu path: Setup > Sessions > Evidian AuthMgr > Evidian AuthMgr Sessions > [Session name] > Connection

In this area, you can specify the settings for the connection between Evidian AuthMgr and the server.

Protocol: Protocol that is used for user access.
Possible values:

"HTTP"
"HTTPS"

Server: IP address or DNS name that is used for user access.

Port: Port that is used for user access. 
Possible values:

"9764 (HTTP)"
"9765 (HTTPS)"
"Custom"

Custom port: If you selected "Custom" above, you can enter a port of your own here.

Path to service: Service path that is used for user access. (Default: /soap)

CA certificate: Path to the CA certificate with file name. The certificate is needed for HTTPS connections. (Example: 
/wfs/ca-certs/ca.crt )

Roaming session secret: Password for the roaming session.

Fallback User Access Services

Click on the logo to specify up to four alternative connections. These will be used if the primary authentication 
server is not available. The alternative servers will be queried in sequence.

•
•

•

Download the Certificate for Evidain from the EAM in base64 encoded x509 CER format,
Convert it to crt by the following command: openssl x509 -inform PEM -in 
YOUR_CERT.cer -out YOUR_CRT.crt
Eventually move YOUR_CRT.crt to the endpoint


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Options
Menu path: Sessions > Evidian AuthMgr > Evidian AuthMgr Sessions > [Session name] > Options

Specify further options for your Evidian AuthMgr session.

Session type
Possible values:

Citrix ICA
RDP
VMware Horizon
Custom

If you have selected the user-defined session type, you can enter your own start and stop commands here:

Custom start command: Command that is executed when the card is inserted. (Example: /wfs/start.bash )

Custom stop command: Command that is executed when the card is removed. (Example:  /wfs/stopp.bash )

Language selection: Language selection of catalog messages.
Possible values:

Automatic
English (UK)
English (US)
German
French
Custom

Custom catalog of messages: Choose here the file for the custom catalog of messages. (Default: /services/

evidian/share/locale/en/rsUserAuth.cat )

Availability message

☑ A message is shown when the authentication tool is available.

☐ A message is not shown when the authentication tool is available. (Default)

Tapping mode

☑ The operating mode can be changed by briefly tapping the card on the reader. Each tap triggers an action.

☐ The operating mode cannot be changed by tapping the card on the reader. (Default)

Delay for dynamic tapping: Tapping delay in seconds. (Default: 3)

Allow password authentication

☑ Password is required for the authentication.

☐ Password is not required for the authentication. (Default)

Allow password forgotten

☑ Resetting the password is allowed.

☐ Resetting the password is not allowed. (Default)
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Default domain name for password authentication: Domain name used by default for password authentication.

Debug mode

☑ Debug mode is activated, and all outputs are switched to the default error output.

☐ Debug mode is deactivated. (Default)

Level for trace: Specifies the trace level. The level of detail of the log messages decreases as you move down 
through the selection list.
Possible values:

none
low
medium
high
details

Use configuration file

☑ Instead of the preconfigured session, a custom configuration file is used. All other session settings are ignored.

☐ A custom configuration file is not used. (Default)

Path: Path to the configuration file with file name. (Example: /etc/rsUserAuth/rsUserAuth.ini )
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Desktop Integration
Menu path: Sessions > Evidian AuthMgr > Evidian AuthMgr Sessions > [Session name] > Desktop Integration

Session name: Name for the session.

Starting Methods for Session

Start menu

☑ The session can be launched from the start menu.

Application Launcher

☑ The session can be launched with the Application Launcher.

Desktop

☑ The session can be launched with a program launcher on the desktop.

Quick start panel

☑ The session can be launched with the quick start panel.

Start menu's system tab

☑ The session can be launched with the start menu's system tab.

Application Launcher's system tab

☑ The session can be launched with the Application Launcher's system tab.

Desktop context menu

☑ The session can be launched with the desktop context menu.

Menu folder: If you specify a folder name or a path comprising a number of folder names separated by "/", a menu 
path will be created for the session. The menu path will be used in the start menu and in the desktop context menu.

Application Launcher folder: If you specify a folder name or a path comprising a number of folder names 
separated by "/", a menu path will be created for the session. The menu path will be used in the Application 
Launcher.

Desktop folder: If you specify a folder name or a path comprising a number of folder names separated by "/", a 
menu path will be created for the session. The menu path will be used for the program launcher on the desktop.

Password protection: Specifies which password will be requested when launching the session.
Possible values:

None: No password is requested when launching the session.
Administrator: The administrator password is requested when launching the session.
User: The user password is requested when launching the session.
Setup user: The setup user's password is requested when launching the session.

The session name must not contain any of these characters: \ / : * ? “ < > | [ ] { } ( )
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Hotkey

☑ The session can be started with a hotkey. A hotkey consists of one or more modifiers and a key.

Modifiers: A modifier or a combination of several modifiers for the hotkey. You can select a set key symbol/
combination or your own key symbol/combination. A key symbol is a defined chain of characters, e.g.  Ctrl .

These are the pre-defined modifiers and the associated key symbols:

(No modifier) =  None

 =  Shift
[Ctrl] =  Ctrl

 =  Mod4

[Alt] =  Alt

Key combinations are formed as follows with  | :

Ctrl +   =  Ctrl|Super_L

Key: Key for the hotkey

Autostart

☑ The session will be launched automatically when the device boots.

Restart

☑ The session will be relaunched automatically after the termination.

Autostart delay: Waiting time in seconds between the complete startup of the desktop and the automatic session 
launch.

Autostart requires network

Do not use [AltGr] as a modifier (represented as Mod5 ). Otherwise, the key that is configured as a hotkey 
with AltGr cannot be used as a regular key anymore. Example: If you configure [AltGr] + [E] as a hotkey, it is 
impossible to enter an "e".



When this keyboard key is used as a modifier, it is represented as Mod4 ; when it is used as a key, it 

is represented as Super_L .



To enter a key that does not have a visible character, e. g. the [Tab] key, open a terminal, log on as user

and enter xev -event keyboard . Press the key to be used for the hotkey. The text in brackets that 

begins with keysym  contains the key symbol for the Key field. Example: Tab  in (keysym 0xff09, 

Tab)


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☑ If no network is available at system startup, the session is not started. A message is shown. As soon as the 
network is available, the session is started automatically.

☐ The session is started automatically, even when no network is available.
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NoMachine NX Client
Menu path: Sessions > NoMachine NX Client > [Session Name]

You can configure one or more NoMachine NX sessions.

Further information regarding configuration can be found in the original documentation provided by NoMachine: 
http://www.nomachine.com/documents.

The settings for launching the session are described below.

Session name: Name for the session.

Starting Methods for Session
Start menu

☑ The session can be launched from the start menu.

Application Launcher

☑ The session can be launched with the Application Launcher.

Desktop

☑ The session can be launched with a program launcher on the desktop.

Quick start panel

☑ The session can be launched with the quick start panel.

Start menu's system tab

☑ The session can be launched with the start menu's system tab.

Application Launcher's system tab

☑ The session can be launched with the Application Launcher's system tab.

Desktop context menu

☑ The session can be launched with the desktop context menu.

Menu folder: If you specify a folder name or a path comprising a number of folder names separated by "/", a menu 
path will be created for the session. The menu path will be used in the start menu and in the desktop context menu.

Application Launcher folder: If you specify a folder name or a path comprising a number of folder names 
separated by "/", a menu path will be created for the session. The menu path will be used in the Application 
Launcher.

Desktop folder: If you specify a folder name or a path comprising a number of folder names separated by "/", a 
menu path will be created for the session. The menu path will be used for the program launcher on the desktop.

The session name must not contain any of these characters: \ / : * ? “ < > | [ ] { } ( )

http://www.nomachine.com/documents
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Password protection: Specifies which password will be requested when launching the session.
Possible values:

None: No password is requested when launching the session.
Administrator: The administrator password is requested when launching the session.
User: The user password is requested when launching the session.
Setup user: The setup user's password is requested when launching the session.

Hotkey

☑ The session can be started with a hotkey. A hotkey consists of one or more modifiers and a key.

Modifiers: A modifier or a combination of several modifiers for the hotkey. You can select a set key symbol/
combination or your own key symbol/combination. A key symbol is a defined chain of characters, e.g.  Ctrl .

These are the pre-defined modifiers and the associated key symbols:

(No modifier) =  None

 =  Shift
[Ctrl] =  Ctrl

 =  Mod4

[Alt] =  Alt

Key combinations are formed as follows with  | :

Ctrl +   =  Ctrl|Super_L

Key: Key for the hotkey

Autostart

☑ The session will be launched automatically when the device boots.

Do not use [AltGr] as a modifier (represented as Mod5 ). Otherwise, the key that is configured as a hotkey 
with AltGr cannot be used as a regular key anymore. Example: If you configure [AltGr] + [E] as a hotkey, it is 
impossible to enter an "e".



When this keyboard key is used as a modifier, it is represented as Mod4 ; when it is used as a key, it 

is represented as Super_L .



To enter a key that does not have a visible character, e. g. the [Tab] key, open a terminal, log on as user

and enter xev -event keyboard . Press the key to be used for the hotkey. The text in brackets that 

begins with keysym  contains the key symbol for the Key field. Example: Tab  in (keysym 0xff09, 

Tab)


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Restart

☑ The session will be restarted automatically after the termination.

Autostart delay: Waiting time in seconds between the complete startup of the desktop and the automatic session 
launch.

Autostart requires network

☑ If no network is available at system startup, the session is not started. A message is shown. As soon as the 
network is available, the session is started automatically.

☐ The session is started automatically, even when no network is available.

Server (see page 271)
Unix Desktop (see page 272)
Unix Display (see page 274)
Windows Desktop (see page 275)
Windows Display (see page 276)
VNC Desktop (see page 278)
VNC Display (see page 279)
Shadow Display (see page 280)
Logon (see page 282)
Advanced (see page 283)
Services (see page 285)
Desktop Integration (see page 286)
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Server
Menu path: Setup > Sessions > NoMachine NX Client > [Session Name] > Server

Here, you can specify the connection data for the NoMachine NX session.

Host: Host name or IP address of the NoMachine NX server.
Port: Port for connecting with the NoMachine NX server (default: 22).
Connection service: Protocol for connecting to the NoMachine NX server.
Possible values:

SSH
NX

Session: Session type
Possible values:

Unix: The session will run under Unix/Linux on the server side. X11 serves as the 
transmission protocol.
Windows: The session will run under Windows on the server side. RDP serves as the 
transmission protocol.
VNC: The session will be transmitted with VNC (Virtual Network Computing) via RFP (Remote 
Framebuffer Protocol). On the server side, the session can run on any operating system. A 
VNC server is required on the server.
Shadow: Protocol version for older VNC servers

Use following DSA key: DSA key which is to be used instead of the default key when logging on to 
the server. If no key is entered here, i.e. the field is empty, the thin client’s default key will be used. 
The default key is saved under /wfs/nxkeys/server.id_dsa.key .
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Unix Desktop
Menu path: Setup > Sessions > NoMachine NX Client > [Session Name] > Unix Desktop

Here, you can specify which window manager or display manager is to be launched on the server when the user logs 
on with the NoMachine NX client. The window manager must be available on the server.

This area is active if the parameter Setup > Sessions > NoMachine NX Client > [Session Name] > Session is set to 
"Unix".

Desktop
Possible values:

KDE: KDE will be launched.
Gnome: Gnome will be launched.
CDE: CDE will be launched.
XDM: The display manager XDM will be launched.
Custom: A custom window manager will be used.

Settings options if "Desktop" is set to "XDM":

Login: These options are available if Desktop is set to “XDM”.
Let the NX server decide: The configuration of the NoMachine NX server will be used for 
logon purposes.
Query an X desktop manager: The NoMachine NX client will connect to the X desktop 
manager of the computer defined under Host. The set Port will be used for this connection 
(default: 177).
Broadcast XDM request: The NoMachine NX client will send a request for available XDM 
servers in the subnet via the set Port (default: 177). The NoMachine NX client will use the 
first XDM server that responds to the request.
Get a list of available X desktop managers: The NoMachine NX client will send a request to 
the computer defined under Host via the set Port (default: 177). This computer will reply 
with a list of available XDM servers. This option is relevant to older versions of the 
NoMachine NX server.

Settings options if "Desktop" is set to "Custom":

Application

Run console: The terminal set by default will be launched. Example: Xfce terminal
Run default X client script on server: The script for the default desktop environment set by 
default will be launched. Example: /home/user/startxfce.sh
Run the following command: Start command for the desired application or the desired window 
manager. Example: startxfce
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Options

Floating window: The session will be shown in a separate window. This option makes particularly 
efficient use of bandwidth.
Use X agent encoding
☑ The data traffic will be decoded by the NX agent rather than in the X protocol. (default)
☐ The data traffic will remain in the X protocol and will be tunneled and compressed by the NX 
proxy.
Use taint of X replies
☑ Trivial sources of X roundtrips will be suppressed by generating the response on the side of the 
X client. This option is relevant to older versions of the NoMachine NX server. (default)
New virtual desktop: The session will take place on a new virtual desktop on the server side.
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Unix Display
Menu path: Setup > Sessions > NoMachine NX Client > [Session Name] > Unix Display

Here, you can define the properties for image transmission from the NoMachine NX server to the NoMachine NX 
client.

This area is active if the parameter Setup > Sessions > NoMachine NX Client > [Session Name] > Server > Session
is set to "Unix".

Display: Size of the display area that is used for the session.
Possible values:

"640x480"
"800x600"
"1024x768"
"Available area": The entire display area is used for the session. The taskbar is not visible.
"Fullscreen": The session will be shown in full-screen mode, i. e. stretched across the entire screen.
"Custom": The Width and Height can be freely defined.
"Multimonitor fullscreen": The session will be shown in full-screen mode on all available monitors, 
i.e. stretched across the entire screen of each monitor.

Width: Width of the display area for the session. (Default: 800)

Height: Height of the display area for the session. (Default: 600)

Use custom settings

☑ The image transmission properties can be changed on the client side.

☐ The image transmission properties are specified on the server side only. (Default)

Use both JPEG and RGB compression: JPEG compression (results in losses) as well as RGB compression (loss-free) 
will be used. The level of JPEG compression will be adjusted dynamically depending on the compressibility.

Use JPEG and RGB compression, and use custom JPEG quality: JPEG compression (results in losses) as well as 
RGB compression (loss-free) will be used. The level of JPEG compression is specified by the parameter JPEG 
quality.

Only use JPEG compression: Only JPEG compression (results in losses) will be used. The level of JPEG 
compression will be adjusted dynamically depending on the compressibility.

Use JPEG compression and custom JPEG quality: Only JPEG compression (results in losses) will be used. The 
level of JPEG compression is specified by the parameter JPEG quality.

Only use RGB compression: Only RGB compression (loss-free) will be used.

Use plain X bitmaps: The images will be transmitted as bitmaps without compression.

JPEG quality: If Use JPEG and RGB compression, and use custom JPEG quality or Use JPEG compression and 
cusom JPEG quality is enabled, the quality of images in JPEG format can be defined. (Default: 6)

The image transmission properties can also be defined on the server side. If a server-side setting competes 
with a client-side setting, the server-side setting will be effective.


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Windows Desktop
Menu path: Setup > Sessions > NoMachine NX Client > [Session Name] > Windows Desktop

Here, you can specify which Windows terminal server (or remote desktop service) is used, how the user logs on and 
whether the entire desktop or an individual application is launched.

This area is active if the parameter Setup > Sessions > NoMachine NX Client > [Session Name] > Session is set to 
"Windows".

Windows terminal server: Host name or IP address of the Windows server on which the desktop 
or the application runs
Windows terminal server domain: Domain in which the Windows terminal server is located
Use the NX user's credentials: When the session starts, the logon information under Setup > 
NoMachine NX Client Sessions > [Session Name] > Logon will be used. (default)
Use following credentials: When the session starts, the logon information under Username and 
Password will be used.

Username: User name for starting the session
Password: Password for starting the session

Start Windows login screen: When starting the session, the user must enter their logon 
information.
Run desktop: When starting the session, the Windows desktop is shown (default)
Run application: When starting the session, the Windows application given in the text field is 
launched.
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Windows Display
Menu path: Setup > Sessions > NoMachine NX Client > [Session Name] > Windows Display

This area is active if the parameter Setup > Sessions > NoMachine NX Client > [Session Name] > Session is set to 
"Windows".

Display: Size of the display area that is used for the session 
Possible values:

640x480
800x600
1024x768
Available area:
Full screen: The session will be shown in full-screen mode, i. e. stretched across the entire 
screen.
Custom: The width and height can be freely defined.
Multi-monitor full screen:

Width: Width of the display area for the session (default: 800)
Height: Height of the display area for the session (default: 600)
Colors
Possible values:

256
32K
64K
16M

Use custom settings
☑ The image transmission properties can be changed on the client side.
☐ The image transmission properties are specified on the server side only. (default)

Use JPEG and RGB compression: JPEG compression (results in losses) as well as RGB 
compression (loss-free) will be used. The level of JPEG compression will be adjusted 
dynamically depending on the compressibility.
Use JPEG and RGB compression, and define JPEG quality: JPEG compression (results in 
losses) as well as RGB compression (loss-free) will be used. The level of JPEG compression is 
specified by the parameter JPEG quality.
Only use JPEG compression: Only JPEG compression (results in losses) will be used. The 
level of JPEG compression will be adjusted dynamically depending on the compressibility.
Use JPEG compression and custom JPEG quality: Only JPEG compression (results in 
losses) will be used. The level of JPEG compression is specified by the parameter JPEG 
quality.
Only use RGB compression: Only RGB compression (loss-free) will be used.
Use plain X bitmaps: The images will be transmitted as bitmaps without compression.
JPEG quality: If Use JPEG and RGB compression and define JPEG quality or Use JPEG 
compression and define JPEG quality is enabled, the quality of images in JPEG format can 
be defined (default: 6).

Enable RDP image cache
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☑ The cache is enabled. This increases the amount of memory needed. However, the speed of the 
session may be increased. (default)
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VNC Desktop
Menu path: Setup > Sessions > NoMachine NX Client > [Session Name] > VNC Desktop

Here, you can specify the VNC server as well as the password for the VNC session.

This area is active if the parameter Setup > Sessions > NoMachine NX Client > [Session Name] > Session is set to 
"VNC".

VNC server: Name or IP address of the server
: Number of the display.
Password: Password for the VNC session

These settings are only relevant up to NoMachine NX Server Version 3.5.
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VNC Display
Menu path: Setup > Sessions > NoMachine NX Client > [Session Name] > VNC Display

This area is active if the parameter Setup > Sessions > NoMachine NX Client > [Session Name] > Session is set to 
"VNC".

Display: Size of the display area that is used for the session 
Possible values:

640x480
800x600
1024x768
Available area
Fullscreen: The session will be shown in full-screen mode, i. e. stretched across the entire 
screen.
Custom: The width and height can be freely defined.
Multimonitor Fullscreen

Width: Width of the display area for the session (default: 800)
Height: Height of the display area for the session (default: 600)
Use custom settings
☑ The image transmission properties can be changed on the client side.
☐ The image transmission properties are specified on the server side only. (default)

Use both JPEG and RGB compression: JPEG compression (results in losses) as well as RGB 
compression (loss-free) will be used. The level of JPEG compression will be adjusted 
dynamically depending on the compressibility.
Use JPEG and RGB compression, and use custom JPEG quality: JPEG compression 
(results in losses) as well as RGB compression (loss-free) will be used. The level of JPEG 
compression is specified by the parameter JPEG quality.
Only use JPEG compression: Only JPEG compression (results in losses) will be used. The 
level of JPEG compression will be adjusted dynamically depending on the compressibility.
Use JPEG compression and custom JPEG quality: Only JPEG compression (results in 
losses) will be used. The level of JPEG compression is specified by the parameter JPEG 
quality.
Only use RGB compression: Only RGB compression (loss-free) will be used.
Use plain X bitmaps: The images will be transmitted as bitmaps without compression.
JPEG quality: If Use JPEG and RGB compression and define JPEG quality or Use JPEG 
compression and define JPEG quality is enabled, the quality of images in JPEG format can 
be defined (default: 6).

These settings are only relevant up to NoMachine NX Server Version 3.5.
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Shadow Display
Menu path: Setup > Sessions > NoMachine NX Client > [Session Name] > Shadow Display

This area is active if the parameter Setup > Sessions > NoMachine NX Client > [Session Name] > Session is set to 
"Shadow".

Display: Size of the display area that is used for the session
Possible values:

640x480
800x600
1024x768
Available area:
Fullscreen: The session will be shown in fullscreen mode, i. e. stretched across the entire 
screen.
Custom: The width and height can be freely defined.
Multi-monitor full screen:

Width: Width of the display area for the session (default: 800)
Height: Height of the display area for the session (default: 600)
Enable custom settings
☑ The image transmission properties can be changed on the client side.
☐ The image transmission properties are specified on the server side only. (default)

Use both JPEG and RGB compression: JPEG compression (lossy) as well as RGB 
compression (lossless) will be used. The level of JPEG compression will be adjusted 
dynamically depending on the compressibility.
Use JPEG and RGB compression, and use custom JPEG quality: JPEG compression (lossy) 
as well as RGB compression (lossless) will be used. The level of JPEG compression is 
specified by the parameter JPEG quality.
Only use JPEG compression: Only JPEG compression (lossy) will be used. The level of JPEG 
compression will be adjusted dynamically depending on the compressibility.
Use JPEG compression and custom JPEG quality: Only JPEG compression (lossy) will be 
used. The level of JPEG compression is specified by the parameter JPEG quality.
Only use RGB compression: Only RGB compression (lossless) will be used.
Use plain X images: The images will be transmitted as bitmaps without compression.
JPEG quality: If Use JPEG and RGB compression and use custom JPEG quality or Use 
JPEG compression and custom JPEG quality is enabled, the quality of images in JPEG 
format can be defined (default: 6).

Enable render extension
☑ The "Render" or "XRender" protocol extension is enabled. This allows a transparency effect 
where windows overlap on the screen. (default)
Disable the backing store
☑ The cache is disabled. This reduces the amount of memory needed. However, the speed of the 
session may be reduced.
☐ The cache is enabled. (default)

These settings are only relevant up to NoMachine NX Version 3.5.
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Disable the composite extension
☑ The "Composite" protocol extension is disabled. Transparency effects where windows overlap 
on the screen are not possible.
☐ The "Composite" protocol extension is enabled. (default)
Disable the shared memory extension
☑ The shared memory extension is disabled.
☐ The shared memory extension is enabled. (default)
Disable emulation of shared pixmaps
☑ The emulation of shared images (shared pixmaps) is disabled.
☐ The emulation of shared images (shared pixmaps) is enabled. (default)
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Logon
Menu path: Setup > Sessions > NoMachine NX Client > [Session Name] > Logon

Here, you can specify the logon information for starting the session.

Login method
Possible values:

Password: The user logs on with a logon and password.
Private key: The logon takes place with a private key.

Login: User name when logging on to the server
Password: Password when logging on to the server

Session passwords are stored with reversible encryption. Therefore, we strongly recommend not to 
store the session password on the endpoint device. 


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Advanced
Menu path: Setup > Sessions > NoMachine NX Client > [Session Name] > Advanced

Here, you can change advanced settings.

Link speed
Possible values:

Modem
ISDN
ADSL
WAN
LAN

Disable ZLIB stream compression
Possible values:
☑ The data traffic between the client and server will not be compressed.

☐ The data traffic between the client and server will be compressed. (default)
Enable SSL encryption on all traffic
☑ Connections with NX, SSH and UDP will be encrypted. (default)
☐ Connections with NX and SSH will be encrypted, connections with UDP will remain unencrypted.
Connect through a HTTP proxy
☑ The connection between the client and server will be routed via an HTTP proxy.
☐ The connection between the client and server will be direct. (default)
Host: Host name or IP address of the HTTP proxy
Port: Port of the HTTP proxy (default: 8080)
Username: User name when logging on to the HTTP proxy

Password: Password when logging on to the HTTP proxy

Remember my password

☑ The password will be saved.
☐ The password will not be saved and must therefore be entered again for each session. (default)
Disable deferred screen updates: Delayed screen refreshing ("lazy encoding") compensates for 
bottlenecks in data transmission. If a bottleneck occurs, refresh procedures requiring large 
amounts of bandwidth are delayed in favor of interactivity. There are two levels of delayed screen 

Switching off compression can be helpful if the data traffic is compressed on another 
level, e.g. by VPN software.



This setting is only relevant up to NoMachine NX Server Version 3.5.

This setting is only relevant up to NoMachine NX Server Version 3.5.

This setting is only relevant up to NoMachine NX Server Version 3.5.
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refreshing. With Level 1, refresh actions which are not displayed directly ("offscreen") are 
dismissed. With Level 2, refresh actions which are displayed directly ("onscreen") are dismissed.

☑ Bottlenecks in data transmission are not compensated for through delayed screen refreshing.
☐ If the connection speed is set to "WAN”, Level 1 delayed screen refreshing will be used. If the 
connection speed is set to "MODEM, “ISDN” or “ADSL”, Level 2 delayed screen refreshing will be 
used. (default)
Disk cache: Size of the persistent memory for caching images (default: 64 MB)

Memory cache: Size of the volatile memory for caching images (default: 16 MB)

This setting is only relevant up to NoMachine NX Server Version 3.5.

This setting is only relevant up to NoMachine NX Server Version 3.5.

This setting is only relevant up to NoMachine NX Server Version 3.5.
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Services
Menu path: Setup > Sessions > NoMachine NX Client > [Session Name] > Services

Here, you can enable or disable services for printers and audio playback on your thin client.

Enable multimedia support
You will find further information regarding audio playback on the Nomachine NX client in the 
NoMachine Knowledge Base13.
☑ Audio output is forwarded to the media player via esound.
☐ A dedicated channel is used for audio output. (default)
Enable CUPS printing
☑ Printing via the thin client is enabled. (default)
☐ Printing via the thin client is disabled.
Port: Port via which CUPS can be configured with a browser (default: 631)
Public printer
☑ The printer connected to the thin client is shared via the network. A server-side configuration is 
required for this purpose.
☐ The printer is not shared. (default)

https://www.nomachine.com/?q=AR03D00355
https://www.nomachine.com/?q=AR03D00355
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Desktop Integration
Menu path: Sessions > NoMachine NX Client > [Session Name] > Desktop Integration

In this area, you can configure desktop integration for the NoMachine NX session.

Session name: Name for the session.

Starting Methods for Session
Start menu

☑ The session can be launched from the start menu.

Application Launcher

☑ The session can be launched with the Application Launcher.

Desktop

☑ The session can be launched with a program launcher on the desktop.

Quick start panel

☑ The session can be launched with the quick start panel.

Start menu's system tab

☑ The session can be launched with the start menu's system tab.

Application Launcher's system tab

☑ The session can be launched with the Application Launcher's system tab.

Desktop context menu

☑ The session can be launched with the desktop context menu.

Menu folder: If you specify a folder name or a path comprising a number of folder names separated by "/", a menu 
path will be created for the session. The menu path will be used in the start menu and in the desktop context menu.

Application Launcher folder: If you specify a folder name or a path comprising a number of folder names 
separated by "/", a menu path will be created for the session. The menu path will be used in the Application 
Launcher.

Desktop folder: If you specify a folder name or a path comprising a number of folder names separated by "/", a 
menu path will be created for the session. The menu path will be used for the program launcher on the desktop.

Password protection: Specifies which password will be requested when launching the session.
Possible values:

None: No password is requested when launching the session.
Administrator: The administrator password is requested when launching the session.
User: The user password is requested when launching the session.

The session name must not contain any of these characters: \ / : * ? “ < > | [ ] { } ( )
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Setup user: The setup user's password is requested when launching the session.

Hotkey

☑ The session can be started with a hotkey. A hotkey consists of one or more modifiers and a key.

Modifiers: A modifier or a combination of several modifiers for the hotkey. You can select a set key symbol/
combination or your own key symbol/combination. A key symbol is a defined chain of characters, e.g.  Ctrl .

These are the pre-defined modifiers and the associated key symbols:

(No modifier) =  None

 =  Shift
[Ctrl] =  Ctrl

 =  Mod4

[Alt] =  Alt

Key combinations are formed as follows with  | :

Ctrl +   =  Ctrl|Super_L

Key: Key for the hotkey

Autostart

☑ The session will be launched automatically when the device boots.

Restart

☑ The session will be restarted automatically after the termination.

Autostart delay: Waiting time in seconds between the complete startup of the desktop and the automatic session 
launch.

Do not use [AltGr] as a modifier (represented as Mod5 ). Otherwise, the key that is configured as a hotkey 
with AltGr cannot be used as a regular key anymore. Example: If you configure [AltGr] + [E] as a hotkey, it is 
impossible to enter an "e".



When this keyboard key is used as a modifier, it is represented as Mod4 ; when it is used as a key, it 

is represented as Super_L .



To enter a key that does not have a visible character, e. g. the [Tab] key, open a terminal, log on as user

and enter xev -event keyboard . Press the key to be used for the hotkey. The text in brackets that 

begins with keysym  contains the key symbol for the Key field. Example: Tab  in (keysym 0xff09, 

Tab)


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Autostart requires network

☑ If no network is available at system startup, the session is not started. A message is shown. As soon as the 
network is available, the session is started automatically.

☐ The session is started automatically, even when no network is available.
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X Sessions
Menu path: Sessions > X Sessions > [Session Name]

You can configure one or more X sessions.

The settings for launching the session are described below.

Session name: Name for the session.

Starting Methods for Session
Start menu

☑ The session can be launched from the start menu.

Application Launcher

☑ The session can be launched with the Application Launcher.

Desktop

☑ The session can be launched with a program launcher on the desktop.

Quick start panel

☑ The session can be launched with the quick start panel.

Start menu's system tab

☑ The session can be launched with the start menu's system tab.

Application Launcher's system tab

☑ The session can be launched with the Application Launcher's system tab.

Desktop context menu

☑ The session can be launched with the desktop context menu.

Menu folder: If you specify a folder name or a path comprising a number of folder names separated by "/", a menu 
path will be created for the session. The menu path will be used in the start menu and in the desktop context menu.

Application Launcher folder: If you specify a folder name or a path comprising a number of folder names 
separated by "/", a menu path will be created for the session. The menu path will be used in the Application 
Launcher.

Desktop folder: If you specify a folder name or a path comprising a number of folder names separated by "/", a 
menu path will be created for the session. The menu path will be used for the program launcher on the desktop.

Password protection: Specifies which password will be requested when launching the session.
Possible values:

None: No password is requested when launching the session.
Administrator: The administrator password is requested when launching the session.

The session name must not contain any of these characters: \ / : * ? “ < > | [ ] { } ( )
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User: The user password is requested when launching the session.
Setup user: The setup user's password is requested when launching the session.

Hotkey

☑ The session can be started with a hotkey. A hotkey consists of one or more modifiers and a key.

Modifiers: A modifier or a combination of several modifiers for the hotkey. You can select a set key symbol/
combination or your own key symbol/combination. A key symbol is a defined chain of characters, e.g.  Ctrl .

These are the pre-defined modifiers and the associated key symbols:

(No modifier) =  None

 =  Shift
[Ctrl] =  Ctrl

 =  Mod4

[Alt] =  Alt

Key combinations are formed as follows with  | :

Ctrl +   =  Ctrl|Super_L

Key: Key for the hotkey

Autostart

☑ The session will be launched automatically when the device boots.

Restart

☑ The session will be restarted automatically after the termination.

Do not use [AltGr] as a modifier (represented as Mod5 ). Otherwise, the key that is configured as a hotkey 
with AltGr cannot be used as a regular key anymore. Example: If you configure [AltGr] + [E] as a hotkey, it is 
impossible to enter an "e".



When this keyboard key is used as a modifier, it is represented as Mod4 ; when it is used as a key, it 

is represented as Super_L .



To enter a key that does not have a visible character, e. g. the [Tab] key, open a terminal, log on as user

and enter xev -event keyboard . Press the key to be used for the hotkey. The text in brackets that 

begins with keysym  contains the key symbol for the Key field. Example: Tab  in (keysym 0xff09, 

Tab)


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Autostart delay: Waiting time in seconds between the complete startup of the desktop and the automatic session 
launch.

Autostart requires network

☑ If no network is available at system startup, the session is not started. A message is shown. As soon as the 
network is available, the session is started automatically.

☐ The session is started automatically, even when no network is available.

Server (see page 292)
Desktop Integration (see page 294)



Sessions

IGEL OS Reference Manual   292 / 897

•

•

•
•

•

•

•

•

Server
Menu path: Setup > Sessions > X Sessions > [session name] > Server

Connection type: Connection type for the XDMCP session

Possible options:

Indirect via localhost: At startup, the thin client generates a list of found XDMCP hosts. The user 
can select a host. 
Indirect: At startup, a list of XDMCP hosts is displayed. This list is generated by the server specified 
under Name or IP of server. The user can select a host.
Direct: The login mask of the host specified under Name or IP of server is displayed
Broadcast: The thin client starts a broadcast request. The login mask of that XDMCP host is 
displayed which responds first.
Local display: The command specified under Command to be displayed is run.

Name or IP of server: Hostname or IP address of the XDMCP server

Command to be displayed: Command to be executed. The display is set in the DISPLAY environment variable.

Access control

☑ Access to this display from other computers will be controlled.

Terminate after one session

☑ The session is terminated when the user has logged out from the remote server.

Use quit hotkey

☑ The session can be terminated with a hotkey. A hotkey consists of one or more modifiers and a key.

Modifiers: A modifier or a combination of several modifiers for the hotkey. You can select a set key symbol/
combination or your own key symbol/combination. A key symbol is a defined chain of characters, e.g.  Ctrl . Here, 
you will find the available modifiers and the associated key symbols:

(No modifier) =  None

 =  Shift
[Ctrl] =  Ctrl

 =  Super_L

[Alt] =  Alt

Key combinations are formed as follows with  | :

Ctrl +   =  Ctrl|Super_L

Quit hotkey: Key for the hotkey

To enter a key that does not have a visible character, e. g. the [Tab] key, open a terminal, log on as user

and enter xev -event keyboard . Press the key to be used for the hotkey. The text in brackets that 


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Use fullscreen

☑ The XDCMP session is displayed in fullscreen mode.

Use fullscreen restricted to workarea

☑ The thin client's local taskbar is visible.

Window size: Window size for the XDMCP session. Default: 640x480

Color depth: Color depth for the XDMCP session. 

Possible options:

Same as display: The system settings for the thin client is used.
256 colors
65535 colors
True Color (24)
True Color (32)

Color allocation policy

Possible options:

Default
Mono
Gray
Color

Start monitor: Selects the monitor on which the XDMCP session ist displayed.

Possible options:

No configuration: The monitor is selected according to already existing windows and to the 
current position the mouse pointer.
1st monitor
2nd monitor
Fullscreen on all monitors

begins with keysym  contains the key symbol for the Key field. Example: Tab  in (keysym 0xff09, 

Tab)
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Desktop Integration
Menu path: Sessions > X Sessions > [Session Name] > Desktop Integration

You can configure one or more X sessions.

The settings for launching the session are described below.

Session name: Name for the session.

Starting Methods for Session
Start menu

☑ The session can be launched from the start menu.

Application Launcher

☑ The session can be launched with the Application Launcher.

Desktop

☑ The session can be launched with a program launcher on the desktop.

Quick start panel

☑ The session can be launched with the quick start panel.

Start menu's system tab

☑ The session can be launched with the start menu's system tab.

Application Launcher's system tab

☑ The session can be launched with the Application Launcher's system tab.

Desktop context menu

☑ The session can be launched with the desktop context menu.

Menu folder: If you specify a folder name or a path comprising a number of folder names separated by "/", a menu 
path will be created for the session. The menu path will be used in the start menu and in the desktop context menu.

Application Launcher folder: If you specify a folder name or a path comprising a number of folder names 
separated by "/", a menu path will be created for the session. The menu path will be used in the Application 
Launcher.

Desktop folder: If you specify a folder name or a path comprising a number of folder names separated by "/", a 
menu path will be created for the session. The menu path will be used for the program launcher on the desktop.

Password protection: Specifies which password will be requested when launching the session.
Possible values:

None: No password is requested when launching the session.
Administrator: The administrator password is requested when launching the session.

The session name must not contain any of these characters: \ / : * ? “ < > | [ ] { } ( )
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User: The user password is requested when launching the session.
Setup user: The setup user's password is requested when launching the session.

Hotkey

☑ The session can be started with a hotkey. A hotkey consists of one or more modifiers and a key.

Modifiers: A modifier or a combination of several modifiers for the hotkey. You can select a set key symbol/
combination or your own key symbol/combination. A key symbol is a defined chain of characters, e.g.  Ctrl .

These are the pre-defined modifiers and the associated key symbols:

(No modifier) =  None

 =  Shift
[Ctrl] =  Ctrl

 =  Mod4

[Alt] =  Alt

Key combinations are formed as follows with  | :

Ctrl +   =  Ctrl|Super_L

Key: Key for the hotkey

Autostart

☑ The session will be launched automatically when the device boots.

Restart

☑ The session will be restarted automatically after the termination.

Do not use [AltGr] as a modifier (represented as Mod5 ). Otherwise, the key that is configured as a hotkey 
with AltGr cannot be used as a regular key anymore. Example: If you configure [AltGr] + [E] as a hotkey, it is 
impossible to enter an "e".



When this keyboard key is used as a modifier, it is represented as Mod4 ; when it is used as a key, it 

is represented as Super_L .



To enter a key that does not have a visible character, e. g. the [Tab] key, open a terminal, log on as user

and enter xev -event keyboard . Press the key to be used for the hotkey. The text in brackets that 

begins with keysym  contains the key symbol for the Key field. Example: Tab  in (keysym 0xff09, 

Tab)


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Autostart delay: Waiting time in seconds between the complete startup of the desktop and the automatic session 
launch.

Autostart requires network

☑ If no network is available at system startup, the session is not started. A message is shown. As soon as the 
network is available, the session is started automatically.

☐ The session is started automatically, even when no network is available.
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Parallels Client Global
Menu path: Sessions > Parallels Client > Parallels Client Global

In this area, you can configure global settings for all Parallels Client sessions.

Keyboard (see page 298)
USB Redirection (see page 299)
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•

Keyboard
Menu path: Setup > Sessions > Parallels Client > Parallels Client Global > Keyboard

In this area, you can select the keyboard layout for Parallels Client sessions.

Keyboard layout
Possible values:

System presets as well as all available input schemes.
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USB Redirection
Menu path: Setup > Sessions > Parallels Client > Parallels Client Global > USB Redirection

In this area, you can configure USB Redirection for Parallels Client sessions.

USB Redirection

☑ USB redirection is enabled.

☐ USB redirection is disabled. (Default)

Automatically redirect all USB devices: Defines whether the Device Rules will be ignored and all USB devices 
redirected.

☑ All USB devices will be redirected.

☐ USB devices will be redirected according to the Device Rules. (Default)

Device Rules
In this area, you can define device rules for USB redirection.

Defining new rules:

Click  to get to the Add dialog.

In the Add dialog, you can define the following settings:

Rule
Possible values:

"Deny"
"Allow"

Vendor ID: Hexadecimal manufacturer number.

Product ID: Hexadecimal device number.

Getting USB Device Information

To find out the Class ID, Subclass ID, Vendor ID and Product ID of the connected USB device, you can use 
the System Information tool. For further information, see Using “System Information” Function (see page 
634).
System Information example:


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Name: Free text entry.

PTP/MTP redirection

☑ PTP/MTP redirection is enabled.

☐ PTP/MTP redirection is disabled. (Default)

Automatically redirect all PTP/MTP devices: Defines whether the Device Rules will be ignored and all PTP/MTP 
devices redirected.

☑ All PTP/MTP devices will be redirected.

Alternatively, you can use the command lsusb  (or lsusb | grep -i [search term] ) in the 
terminal.
Example for lsusb :
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☐ PTP/MTP devices will be redirected according to the Device Rules. (Default)

Device Rules
In this area, you can define device rules for PTP/MTP redirection.

Defining new rules:

Click  to get to the Add dialog.

In the Add dialog, you can define the following settings:

Rule
Possible values:

"Deny"
"Allow"

Vendor ID: Hexadecimal manufacturer number.

Product ID: Hexadecimal device number.

Getting USB Device Information

To find out the Class ID, Subclass ID, Vendor ID and Product ID of the connected USB device, you can use 
the System Information tool. For further information, see Using “System Information” Function (see page 
634).
System Information example:


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Name: Free text entry.

Alternatively, you can use the command lsusb  (or lsusb | grep -i [search term] ) in the 
terminal.
Example for lsusb :
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Parallels Client Session
Menu path: Setup > Sessions > Parallels Client > Parallels Client Sessions > [Session Name]

You can configure one or more Parallels Client sessions.

Session name: Name for the session.

Starting Methods for Session
Start menu

☑ The session can be launched from the start menu.

Application Launcher

☑ The session can be launched with the Application Launcher.

Desktop

☑ The session can be launched with a program launcher on the desktop.

Quick start panel

☑ The session can be launched with the quick start panel.

Start menu's system tab

☑ The session can be launched with the start menu's system tab.

Application Launcher's system tab

☑ The session can be launched with the Application Launcher's system tab.

Desktop context menu

☑ The session can be launched with the desktop context menu.

Menu folder: If you specify a folder name or a path comprising a number of folder names separated by "/", a menu 
path will be created for the session. The menu path will be used in the start menu and in the desktop context menu.

Desktop folder: If you specify a folder name or a path comprising a number of folder names separated by "/", a 
menu path will be created for the session. The menu path will be used for the program launcher on the desktop.

Password protection: Specifies which password will be requested when launching the session.
Possible values:

None: No password is requested when launching the session.
Administrator: The administrator password is requested when launching the session.
User: The user password is requested when launching the session.
Setup user: The setup user's password is requested when launching the session.

Hotkey

The session name must not contain any of these characters: \ / : * ? “ < > | [ ] { } ( )
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☑ The session can be started with a hotkey. A hotkey consists of one or more modifiers and a key.

Modifiers: A modifier or a combination of several modifiers for the hotkey. You can select a set key symbol/
combination or your own key symbol/combination. A key symbol is a defined chain of characters, e.g.  Ctrl .

These are the pre-defined modifiers and the associated key symbols:

(No modifier) =  None

 =  Shift
[Ctrl] =  Ctrl

 =  Mod4

[Alt] =  Alt

Key combinations are formed as follows with  | :

Ctrl +   =  Ctrl|Super_L

Key: Key for the hotkey

Autostart

☑ The session will be launched automatically when the device boots.

Restart

☑ The session will be relaunched automatically after the termination.

Autostart delay: Waiting time in seconds between the complete startup of the desktop and the automatic session 
launch.

Autostart requires network

Do not use [AltGr] as a modifier (represented as Mod5 ). Otherwise, the key that is configured as a hotkey 
with AltGr cannot be used as a regular key anymore. Example: If you configure [AltGr] + [E] as a hotkey, it is 
impossible to enter an "e".



When this keyboard key is used as a modifier, it is represented as Mod4 ; when it is used as a key, it 

is represented as Super_L .



To enter a key that does not have a visible character, e. g. the [Tab] key, open a terminal, log on as user

and enter xev -event keyboard . Press the key to be used for the hotkey. The text in brackets that 

begins with keysym  contains the key symbol for the Key field. Example: Tab  in (keysym 0xff09, 

Tab)


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☑ If no network is available at system startup, the session is not started. A message is shown. As soon as the 
network is available, the session is started automatically.

☐ The session is started automatically, even when no network is available.

_________

Connection (see page 306)
Display (see page 308)
Local Resources (see page 309)
Experience (see page 310)
Network (see page 312)
Advanced (see page 313)
Desktop Integration (see page 314)
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Connection
Menu path: Setup > Sessions > Parallels Client > Parallels Client Sessions > [Session Name] > Connection

In this area, you can specify the settings for the connection between the Parallels Client and the server.

Application Server
Primary Server: Name or IP address of the primary application server.

Secondary Server: Name or IP address of the secondary application server. The secondary application server is 
used if the primary application server cannot be contacted.

Connection Mode
Possible values:

"Gateway Mode": This mode is suitable if the Parallels Client does not have access to a physical 
server and no special demands as regards security apply. The Parallels Client establishes a 
connection to the Parallels SecureClientGateway via port 80. The RDP sessions runs in a tunnel 
within this connection.
"Direct Mode": This mode is suitable if the Parallels Client has direct access to a physical server. 
The Parallels Client establishes a connection to the Parallels SecureClientGateway via port 80 in 
order to negotiate connection data for the RDP session with the application server. The Parallels 
Client then terminates the connection to the gateway and establishes the session with the 
application server. This mode is the most efficient because the connection to the gateway is 
temporary and the data traffic is correspondingly low.
"Gateway SSL Mode": This mode is suitable if the Parallels Client does not have access to a 
physical server and there are high demands as regards security. The Parallels Client establishes a 
connection to the Parallels SecureClientGateway via port 443. The RDP sessions runs in a tunnel 
within this connection.
"Direct SSL Mode": This mode is suitable if the Parallels Client has direct access to a physical 
server and there are high demands as regards security. The Parallels Client establishes a 
connection to the Parallels SecureClientGateway via port 443 in order to negotiate connection 
data for the RDP session with the application server. The Parallels Client then terminates the 
connection to the gateway and establishes the session with the application server.

Port: Port for communication with the application server. (Default: 80)

Logon
Use system credentials

☑ The system-wide logon data will be used for logging on to the application server (single sign-on). This option can 
be used if the local device logon takes place via Kerberos. The logon data saved temporarily when logging on to the 
device will be used for the user name and password.

☐ The logon data given under User name, Password, and Domain will be used when logging on to the application 
server. (Default)

User: User name when logging on to the application server.
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Password: Password when logging on to the application server.

Domain: Domain when logging on to the application server.

Enable support for FIPS 140-2 compliance

☑ The support for FIPS 140-2 standard is enabled.

☐ The support for FIPS 140-2 standard is disabled. (Default)

Session passwords are stored with reversible encryption. Therefore, we strongly recommend not to store 
the session password on the endpoint device. 


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Display
Display color depth: Number of colors displayed

Possible values:

8 bit
15 bit
16 bit
24 bit
32 bit

Use all monitors for desktop session (if applicable)

☑ All monitors will be used for the desktop session.

☐ The primary monitor will be used for the desktop session. (Default)

Use only primary monitor for published applications
Published applications run on the server, the input and output data is exchanged between the client and the 
application server.

☑ Published applications will only be shown on the primary monitor.

☐ Published applications will only be shown on all available monitors. (Default)

Span desktop across all monitors

☑ The desktop will be shown across all available monitors.

☐ The desktop will only be shown on the primary monitor. (Default)

If the option RemoteFX is enabled under Setup > Parallels Client > Parallels Client Sessions > [session 
name] > Experience, the color depth will be set internally to 32 bit, regardless of the value selected.


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Local Resources
Menu path: Setup > Parallels Client > Parallels Client Sessions > [Session Name] > Local Resources

Remote computer sound
Possible values:

Bring to this computer: The device plays back the audio data supplied by the application server.
Do not play: The device does not play back the audio data supplied by the application server.
Leave at remote computer: The audio data will be played back on the application server.

Local devices
Connect local serial ports

☑ The device's serial interfaces can be used in the Parallels Client session.

☐ The serial interfaces cannot be used in the Parallels Client session. (Default)

Connect local smartcards

☑ The device's card reader can be used in the Parallels Client session.

☐ The card reader cannot be used in the Parallels Client session. (Default)

Connect local drives

☑ The drives connected to the device can be used in the Parallels Client session.

☐ The drives cannot be used in the Parallels Client session. (Default)

Connect local printers

☑ The printer connected to the device can be used in the Parallels Client session.

☐ The printer cannot be used in the Parallels Client session. (Default)

Connect clipboard

☑ The clipboard of the Parallels Client session can be used. (Default)

☐ The clipboard of the Parallels Client session cannot be used.
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Experience
Menu path: Setup > Parallels Client > Parallels Client Sessions > Parallels Client Session > Experience

You can enable or disable the features for the graphical display according to the bandwidth of the network 
connection.

Connection speed: Choice of graphical display modes
Possible options:

Modem 28 kbps: The RemoteFX and Adaptive RemoteFX (RDP 8.1) features are enabled.
Modem 56 kbps: The user interface design, RemoteFX and Adaptive RemoteFX (RDP 8.1) 
features are enabled.
Broadband: The menu and window animation, show window content when moving windows, 
user interface design, RemoteFX and Adaptive RemoteFX (RDP 8.1) features are enabled.
LAN: The desktop background, font smoothing, menu and window animation, show window 
content when moving windows, user interface design, RemoteFX and Adaptive RemoteFX 
(RDP 8.1) features are enabled.
Custom: The features can be enabled or disabled individually.

Desktop background

☑ The desktop background image for the session will be shown.

Font smoothing

☑ Edges will be smoothed when text is displayed.

Menu and window animation

☑ Transitions for menus and windows will be animated.

Show contents of window while dragging

☑ The window content will be shown when a window is moved.

Themes

☑ The design of the desktop can be modified.

RemoteFX

☑ Microsoft RemoteFX will be used.

Adaptive RemoteFX (RDP 8.1):

•

•

If this option is enabled, the following parameters will be set automatically:
The desktop background, font smoothing, menu and window animation, show 
window content when moving windows and user interface design features will be 
enabled internally, regardless of what is selected under Speed of the network 
connection.
The color depth will be set internally to 32 Bit, regardless of the value set under Setup > 
Parallels Client > Parallels Client Sessions > Parallels Client Session > Local Resources 
> Color Depth selection.





Sessions

IGEL OS Reference Manual   311 / 897

☑ RemoteFX Progressive and H.264 (RDP 8.1) Parallel 2X Options are enabled.
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Network
Menu path: Setup > Parallels Client > Parallels Client Sessions > [Session Name] > Network

Here, you can configure a proxy for communication between the Parallels Client and application server.

Use proxy server

☑ A proxy is used for communication between the Parallels Client and the application server.

☐ A direct network connection is used for communication between the Parallels Client and the application server. 
(default)

Proxy type: Type or protocol of the proxy used
Possible values:

SOCKS 4
SOCKS 4A
SOCKS 5
HTTP 1.1

Proxy host: URL of the proxy

Proxy port: Port of the proxy (default: 8080)

Use proxy credentials: If a proxy demands a logon, this option must be enabled and the logon data must be 
entered under Proxy user and Proxy password.

☑ The logon data in Proxy user and Proxy password will be sent to the proxy.

Proxy user: User name when logging on to the proxy

Proxy password: Password when logging on to the proxy. The password is relevant if either the “SOCKS 5” or 
“HTTP 1.1” protocol is selected as the proxy type.
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Advanced
Menu path: Setup > Sessions > Parallels Client > Parallels Client Sessions > [Session Name] > Advanced

Redirect URLs to client

☑ URLs will be opened on the client.

☐ URLs will be opened on the application server. (Default)

Redirect MAIL to client

☑ E-mails will be opened on the client.

☐ E-mails will be opened on the application server. (Default)

Compression

☑ The data flow between the Parallels Client and the application server will be compressed. (Default)

☐ The data flow between the Parallels Client and the application server will not be compressed.

Use pre-windows 2000 login format

☑ Legacy login format (pre-Windows 2000) can be used. (Default)

☐ Legacy login format (pre-Windows 2000) cannot be used.

Network level authentication

☑ Network level authentication (NLA) is activated for the Parallels Client session. The client has to authenticate 
before connecting to the server. (Default)
For more information about NLA, see https://technet.microsoft.com/en-us/magazine/hh750380.aspx.

☐ Network level authentication is disabled.

Override computer name: The name entered here will override the name of the application server shown at the 
top of the session window.

Compression reduces network traffic but requires more CPU power.

https://technet.microsoft.com/en-us/magazine/hh750380.aspx
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Desktop Integration
Menu path: Setup > Sessions > Parallels Client > Parallels Client Sessions > [Session Name] > Desktop 
Integration

In this area, you can configure desktop integration for the Parallels Client session.

Session name: Name for the session.

Starting Methods for Session
Start menu

☑ The session can be launched from the start menu.

Application Launcher

☑ The session can be launched with the Application Launcher.

Desktop

☑ The session can be launched with a program launcher on the desktop.

Quick start panel

☑ The session can be launched with the quick start panel.

Start menu's system tab

☑ The session can be launched with the start menu's system tab.

Application Launcher's system tab

☑ The session can be launched with the Application Launcher's system tab.

Desktop context menu

☑ The session can be launched with the desktop context menu.

Menu folder: If you specify a folder name or a path comprising a number of folder names separated by "/", a menu 
path will be created for the session. The menu path will be used in the start menu and in the desktop context menu.

Desktop folder: If you specify a folder name or a path comprising a number of folder names separated by "/", a 
menu path will be created for the session. The menu path will be used for the program launcher on the desktop.

Password protection: Specifies which password will be requested when launching the session.
Possible values:

None: No password is requested when launching the session.
Administrator: The administrator password is requested when launching the session.
User: The user password is requested when launching the session.
Setup user: The setup user's password is requested when launching the session.

Hotkey

The session name must not contain any of these characters: \ / : * ? “ < > | [ ] { } ( )
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☑ The session can be started with a hotkey. A hotkey consists of one or more modifiers and a key.

Modifiers: A modifier or a combination of several modifiers for the hotkey. You can select a set key symbol/
combination or your own key symbol/combination. A key symbol is a defined chain of characters, e.g.  Ctrl .

These are the pre-defined modifiers and the associated key symbols:

(No modifier) =  None

 =  Shift
[Ctrl] =  Ctrl

 =  Mod4

[Alt] =  Alt

Key combinations are formed as follows with  | :

Ctrl +   =  Ctrl|Super_L

Key: Key for the hotkey

Autostart

☑ The session will be launched automatically when the device boots.

Restart

☑ The session will be relaunched automatically after the termination.

Autostart delay: Waiting time in seconds between the complete startup of the desktop and the automatic session 
launch.

Autostart requires network

Do not use [AltGr] as a modifier (represented as Mod5 ). Otherwise, the key that is configured as a hotkey 
with AltGr cannot be used as a regular key anymore. Example: If you configure [AltGr] + [E] as a hotkey, it is 
impossible to enter an "e".



When this keyboard key is used as a modifier, it is represented as Mod4 ; when it is used as a key, it 

is represented as Super_L .



To enter a key that does not have a visible character, e. g. the [Tab] key, open a terminal, log on as user

and enter xev -event keyboard . Press the key to be used for the hotkey. The text in brackets that 

begins with keysym  contains the key symbol for the Key field. Example: Tab  in (keysym 0xff09, 

Tab)


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☑ If no network is available at system startup, the session is not started. A message is shown. As soon as the 
network is available, the session is started automatically.

☐ The session is started automatically, even when no network is available.
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PowerTerm Selection
Menu path: Sessions > PowerTerm Terminal Emulation > PowerTerm Selection

Here, you can choose between various versions of the PowerTerm terminal emulator in order to ensure the best 
possible compatibility with your terminal applications.

PowerTerm version

12.0.1.0.20170219.2-dev-34574

In IGEL Linux 10.x, only a single version can be selected.

Before you can use PowerTerm, you need a valid Ericom PowerTerm license, see IGEL Software License 
Overview.


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PowerTerm Session
Menu path: Setup > Sessions > PowerTerm Terminal Emulation > PowerTerm Session

You can configure one or more sessions for PowerTerm terminal emulation.

To edit the list, proceed as follows:

Click on  to create a new entry.
Click on  to remove the selected entry.
Click on  to edit the selected entry.
Click on  to copy the selected entry.

You will find detailed information on configuring the PowerTerm software in the PowerTerm Interconnect Manual 
on the Ericom website14.

The configuration dialogs were designed to look as similar as possible to the setup pages described in the 
original documentation from ERICOM Software Ltd.



http://www.ericom.com/help.asp?cat=support
http://www.ericom.com/help.asp?cat=support
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Desktop Integration
Menu path: Sessions > PowerTerm Terminal Emulation > PowerTerm Sessions > [Session Name] > Desktop 
Integration

Session name: Name for the session.

Starting Methods for Session
Start menu

☑ The session can be launched from the start menu.

Application Launcher

☑ The session can be launched with the Application Launcher.

Desktop

☑ The session can be launched with a program launcher on the desktop.

Quick start panel

☑ The session can be launched with the quick start panel.

Start menu's system tab

☑ The session can be launched with the start menu's system tab.

Application Launcher's system tab

☑ The session can be launched with the Application Launcher's system tab.

Desktop context menu

☑ The session can be launched with the desktop context menu.

Menu folder: If you specify a folder name or a path comprising a number of folder names separated by "/", a menu 
path will be created for the session. The menu path will be used in the start menu and in the desktop context menu.

Application Launcher folder: If you specify a folder name or a path comprising a number of folder names 
separated by "/", a menu path will be created for the session. The menu path will be used in the Application 
Launcher.

Desktop folder: If you specify a folder name or a path comprising a number of folder names separated by "/", a 
menu path will be created for the session. The menu path will be used for the program launcher on the desktop.

Password protection: Specifies which password will be requested when launching the session.
Possible values:

The session name must not contain any of these characters: \ / : * ? “ < > | [ ] { } ( )
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None: No password is requested when launching the session.
Administrator: The administrator password is requested when launching the session.
User: The user password is requested when launching the session.
Setup user: The setup user's password is requested when launching the session.

Hotkey

☑ The session can be started with a hotkey. A hotkey consists of one or more modifiers and a key.

Modifiers: A modifier or a combination of several modifiers for the hotkey. You can select a set key symbol/
combination or your own key symbol/combination. A key symbol is a defined chain of characters, e.g.  Ctrl .

These are the pre-defined modifiers and the associated key symbols:

(No modifier) =  None

 =  Shift
[Ctrl] =  Ctrl

 =  Mod4

[Alt] =  Alt

Key combinations are formed as follows with  | :

Ctrl +   =  Ctrl|Super_L

Key: Key for the hotkey

Autostart

☑ The session will be launched automatically when the device boots.

Restart

☑ The session will be restarted automatically after the termination.

Do not use [AltGr] as a modifier (represented as Mod5 ). Otherwise, the key that is configured as a hotkey 
with AltGr cannot be used as a regular key anymore. Example: If you configure [AltGr] + [E] as a hotkey, it is 
impossible to enter an "e".



When this keyboard key is used as a modifier, it is represented as Mod4 ; when it is used as a key, it 

is represented as Super_L .



To enter a key that does not have a visible character, e. g. the [Tab] key, open a terminal, log on as user

and enter xev -event keyboard . Press the key to be used for the hotkey. The text in brackets that 

begins with keysym  contains the key symbol for the Key field. Example: Tab  in (keysym 0xff09, 

Tab)


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Autostart delay: Waiting time in seconds between the complete startup of the desktop and the automatic session 
launch.

Autostart requires network

☑ If no network is available at system startup, the session is not started. A message is shown. As soon as the 
network is available, the session is started automatically.

☐ The session is started automatically, even when no network is available.
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IBM iAccess Client
Menu path: Sessions > IBM iAccess Client

IBM iAccess Client is an emulation of the IBM-5250 terminal in Java and supports numerous encodings.

 Add a session in order to be able to use the IBM iAccess Client.

 Under the Connection point under Destination address, give at least the DNS name or the IP address of a 
server. The client can also retrieve further logon information interactively.

 Under Help > Information Center in the IBM iAccess Client menu, you can read the help provided by the 
manufacturer in your browser.

iAccess Global (see page 323)
IBM iAccess Session (see page 326)

IBM iAccess certificates for server authentication and encryption can be distributed as files using the 
Universal Management Suite (UMS).


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iAccess Global
Menu path: Sessions > IBM iAccess Client > IBM iAccess Global

Here you can define global settings for the emulation.

Tab Setup (see page 324)
Font (see page 325)
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Tab Setup
Menu path: Sessions > IBM iAccess Client > IBM iAccess Global > Tab Setup

Open new sessions in a new tab

☑ The new session will be opended in a new tab.  (Default)

☐ A new session will be opened in a new window.

Always display the tab bar

☑ The tab bar will always be displayed.

☐ The tab bar will not be displayed. (Default)

Switch to new tab when created

☑ Switches to new tab. (Default)

☐ Remains in current tab.

Send a warning when closing multiple tabs

☑ Sends warning. (Default)

☐ Multiple tabs are closed without warning.

Do not start tabbed sessions until the tab is selected

☑ Applies.

☐ Does not apply. (Default)

New Tab Action

Disable and hide
Run the same
Run other...

Tab Placement

Top
Bottom
Left
Right
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Font
Menu path: Sessions > IBM iAccess Client > IBM iAccess Global > Font

Font File or Dirctory: Enter the path to your font file or font directory.
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IBM iAccess Session
Menu path: Sessions > IBM iAccess Client > iAccess Sessions > [Session Name]

Session name: Name for the session.

Starting Methods for Session
Start menu

☑ The session can be launched from the start menu.

Application Launcher

☑ The session can be launched with the Application Launcher.

Desktop

☑ The session can be launched with a program launcher on the desktop.

Quick start panel

☑ The session can be launched with the quick start panel.

Start menu's system tab

☑ The session can be launched with the start menu's system tab.

Application Launcher's system tab

☑ The session can be launched with the Application Launcher's system tab.

Desktop context menu

☑ The session can be launched with the desktop context menu.

Menu folder: If you specify a folder name or a path comprising a number of folder names separated by "/", a menu 
path will be created for the session. The menu path will be used in the start menu and in the desktop context menu.

Application Launcher folder: If you specify a folder name or a path comprising a number of folder names 
separated by "/", a menu path will be created for the session. The menu path will be used in the Application 
Launcher.

Desktop folder: If you specify a folder name or a path comprising a number of folder names separated by "/", a 
menu path will be created for the session. The menu path will be used for the program launcher on the desktop.

Hotkey

☑ The session can be started with a hotkey. A hotkey consists of one or more modifiers and a key.

Modifiers: A modifier or a combination of several modifiers for the hotkey. You can select a set key symbol/
combination or your own key symbol/combination. A key symbol is a defined chain of characters, e.g.  Ctrl .

The session name must not contain any of these characters: \ / : * ? “ < > | [ ] { } ( )
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These are the pre-defined modifiers and the associated key symbols:

(No modifier) =  None

 =  Shift
[Ctrl] =  Ctrl

 =  Mod4

[Alt] =  Alt

Key combinations are formed as follows with  | :

Ctrl +   =  Ctrl|Super_L

Key: Key for the hotkey

Autostart

☑ The session will be launched automatically when the device boots.

Restart

☑ The session will be restarted automatically after the termination.

Autostart delay: Waiting time in seconds between the complete startup of the desktop and the automatic session 
launch.

Autostart requires network

☑ If no network is available at system startup, the session is not started. A message is shown. As soon as the 
network is available, the session is started automatically.

☐ The session is started automatically, even when no network is available.

Do not use [AltGr] as a modifier (represented as Mod5 ). Otherwise, the key that is configured as a hotkey 
with AltGr cannot be used as a regular key anymore. Example: If you configure [AltGr] + [E] as a hotkey, it is 
impossible to enter an "e".



When this keyboard key is used as a modifier, it is represented as Mod4 ; when it is used as a key, it 

is represented as Super_L .



To enter a key that does not have a visible character, e. g. the [Tab] key, open a terminal, log on as user

and enter xev -event keyboard . Press the key to be used for the hotkey. The text in brackets that 

begins with keysym  contains the key symbol for the Key field. Example: Tab  in (keysym 0xff09, 

Tab)


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Connection (see page 329)
Screen (see page 332)
Preferences (see page 337)
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Connection
Menu path: Sessions > IBM iAccess Client > IBM iAccess Session >  [session name] > Connection

Destination Address: Name or IP of the server

Destination Port: Server port (Default value: "default")

Use TLS/SSL

☑ TLS/SSL is used.

☐ TLS/SSL is not used. (Standard)

Server Authentication: Defines if the client validates the authenticity of the server when connecting.

☑ The client requires the server to authenticate itself. (Default)

☐ The client connects to the server without server authentication.

Workstation ID: Name of the client that is presented to the server. This name must be unique. For more 
information, go to Help > Information Center in your iAccess client.

Screen Size

Possible values:

24x80
27x132

Host Code Page

Possible values:

1140 United States Euro
1141 Germany Euro
1141 Austria Euro
1142 Denmark Euro
...

Enable Unicode Data Stream

☑ Unicode Data Stream is enabled.

☐ Unicode Data Stream is disabled. (Default)

Enable DBCS in Unicode Fields

☑ DBCS is enabled in unicode fields.

If you leave Destination Address set to the string value "default" (default value) while Use TLS/SSL is 
enabled, port 229 is used. Without Use TLS/SSL enabled, port 23 is used. However, you are free to enter a 
custom port number.



To perform server authentication, the endpoint device must have the CA certificate that is associated with 
the server certificate. For instructions on how to deploy the certificate on the device, see Deploying 
Trusted Root Certificates.


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☐ DBCS is disabled in unicode fields. (Default)

Auto-Connect

☑ Automatically connect to the server on client startup. (Default)

Auto-Reconnect

☑ Automatically make a reconnect attempt if the server connection is lost. (Default)

Advanced (see page 331)
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Advanced

Menu path: Sessions > IBM iAccess Client > IBM iAccess Session >  [session name] > Connection > Advanced

Connection Timeout (seconds) (Default: 0)

Inactivity Timeout (minutes) (Default: 0)

Keep-Alive

☑ Keep-Alive is enabled.

☐ Keep-Alive is disabled. (Default)

Enable ENPTUI

☑ ENPTUI is enabled. (Default)

Password Prompting

Possible values:

Use default user name to prompt once for each system: The credentials preconfigured in the fields 
User ID and Password (optional) are used.
Prompt for user name and password every time
Use Kerberos authentication: The credentials from the Active Directory login are used; only 
available if the user has logged in to the thin client via Active Directory. For more information, see 
Active Directory/Kerberos (see page 832).

User ID: The user ID to be used when Password Prompting is set to "Use default user name to prompt once for 
each system".

Password (optional): The password to be used when Password Prompting is set to "Use default user name to 
prompt once for each system".

Bypass sign-on:

☑ The logon to the system is bypassed. (Default)

Session passwords are stored with reversible encryption. Therefore, we strongly recommend not to store 
the session password on the endpoint device. 


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Screen
Menu path: Sessions > IBM iAccess Client > IBM iAccess Session >  [session name] > Screen

Cursor Shape

Possible Values:

Underline
Block

_____

Font (see page 333)
Cursor (see page 334)
Rule Line (see page 335)
Color (see page 336)
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Font

Menu path: Sessions > IBM iAccess Client > IBM iAccess Session >  [session name] > Screen > Font

Fixed Font

☑ Use a fixed font.

☐ Use no fixed font. (Default)

Fixed Font Size

Possible values:

8
10
12
14
...
58

Font Scaling

☑ Font is scaled. (Default)

Antialiasing

☑ Antialiasing is activated.

☐ Antialiasing is diabled. (Default)

Font Name

Possible values:

IBM3270
Monospaced
Courier 10 Pitch
DejaVu Sans Mono
Liberation Mono
Lucida Sans Typewriter
Numbus Mono L
PComm Session
Ubuntu Mono

Font Style

Possible values:

Plain
Bold
Italic



Sessions

IGEL OS Reference Manual   334 / 897

•
•

•
•

•
•
•

Cursor

Menu path: Sessions > IBM iAccess Client > IBM iAccess Session >  [session name] > Screen > Cursor

Cursor Shape

Possible values:

Underline
Block

Cursor Pointer

Possible values

Default
Crosshair

Allow blinking cursor

☑ Blinking cursor is allowed.

☐ Blinking cursor is diabled. (Default)

Show blinking text with

Possible values:

Blinking Text
Host Color
Mapped color

Blink Color: Select a color in which the cursor should blink.

Blink Color Background: Select a background color.
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Rule Line

Menu path: Sessions > IBM iAccess Client > IBM iAccess Session >  [session name] > Screen > Rule Line

Rule Line

☑ Rule line is activated.

☐ Rule line is disabled. (Default)

Follow Cursor

☑ The follow cursor effect is enabled.

☐ The follow cursor effect is disabled. (Default)

Style

Possible values:

Crosshair
Vertical
Horizontal
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Color

Menu path: Sessions > IBM iAccess Client > IBM iAccess Session >  [session name] > Screen > Color

Field Color: Choose respective colors.

OIA Color: Select a suitable color for the respective indicators.

Status Indicators
Information Indicators
Attention Indicators
Error Indicators
OIA Background

Other

Screen Background: Choose a color. 

Highlight active field

☑ Active field is highlighted.

☐ Active field is not highlighted. (Default)

Active field: Choose a color 
Active Field Background: Choose a color 
Crosshair Ruler Color: Choose a color 
Column Separator: Choose a color 

This color overrides all Field Color Background colors which are set to black.
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Preferences
Menüpfad: Sessions > IBM iAccess Client > iAccess Sessions > [session name] > Preferences

Start window maximized

☑ The windows starts in maximal size.

☐ The windows does not start in maximal size. (Default)

Automatic Resize

☑ Automatic window resizing is enabled. (Default)

☐ Automatic window resizing is disabled.

Show Border

☑ The session screen is framed by a border.

☐ No additional border is added. (Default)

Graphical OIA

☑ The Graphical OIA (Graphical Operator Information Area) is displayed. (Default)

☐ The Graphical OIA (Graphical Operator Information Area) is hidden.

Textual OIA

☑ The Textual OIA (Textual Operator Information Area) is displayed.

☐ The Textual OIA (Textual Operator Information Area) is hidden. (Default)

Keypad

☑ The Keypad is displayed.

☐ The Keypad is hidden. (Default)

Toolbar

☑ The toolbar is displayed. (Default)

☐ The toolbar is hidden.

Toolbar Text

☑ Textual items are added to the toolbar icons.

☐ No textual items are added to the toolbar icons. (Default)

Status Bar

☑ The status bar is displayed. (Default)

☐ The status bar is hidden.

Macro Manager

☑ The Macro Manager toolbar is displayed.

☐ The Macro Mananger toolbar is hidden. (Default)

Right Mouse Button Popup Keypad
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☑ Right-clicking will bring up the the Popup Keypad.

☐ Right-clicking will bring up the default menu. (Default)

Scratch Pad

☑ The Scratch Pad (integrated basic text editor) is displayed.

☐ The Scratch Pad (integrated basic text editor) is hidden. (Default)

'Save' in Scratch Pad

☑ The Save button in the Scratch Pad is active.

☐ The Save button in the Scratch Pad is inactive. (Default)

Quick Connect

☑ The Quick Connect toolbar is displayed.

☐ The Quick Connect toolbar is hidden. (Default)

Search Text

☑ The Search Text area is displayed.

☐ The Search Text area is hidden. (Default)

Screen History

☑ The Screen History area is displayed.

☐ The Screen History area is hidden. (Default)

History Screen Type Simple (Text)

☑ The History Screen will be displayed black and white.

☐ The History Screen will have the default terminal (green screen) look and feel. (Default)

Menu Bar

☑ The main menu bar is displayed. (Default)

☐ The main menu bar is hidden.

_____

Window (see page 339)
Start Options (see page 340)
Language (see page 341)
Keyboard (see page 342)
Popup Keypad (see page 343)
Toolbar (see page 344)
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Window

Menu path: Sessions > IBM iAccess Client > iAccess Sessions > [session name] > Preferences > Window

Here you can define how the iAccess client application window is positioned and sized by default on start. If you 
leave the fields empty, the window will be positioned and sized automatically.

Width: Width of the window

Height: Height of the window

Horizontal offset: Horizontal offset of the window

Vertical offset: Vertical offset of the window
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Start Options

Menu path: Sessions > IBM iAccess Client > iAccess Sessions > [session name] > Preferences > Start Options

Session ID

Possible values:

Automatic
[Various alphabetic values]
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Language

Menu path: Sessions > IBM iAccess Client > iAccess Sessions > [session name] > Preferences > Language

Emulation Language

Possible values:

Default: The language of the IGEL User Interface (User Interface > Language) will be used.
[Various languages]
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Keyboard

Menu path: Sessions > IBM iAccess Client > iAccess Sessions > [session name] > Preferences > Keyboard

Keyboard Remapping File: Enter the file name (Default: IBMi.kmp)

The directory  /userhome/IBM/iAccesClient/Emulator  is used by default.
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Popup Keypad

Menu path: Sessions > IBM iAccess Client > iAccess Sessions > [session name] > Preferences > Popup Keyboard

Popup Keypad File: Enter the file name.

The directory  /userhome/IBM/iAccesClient/Emulator  is used by default.
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Toolbar

Menu path: Sessions > IBM iAccess Client > iAccess Sessions > [session name] > Preferences > Toolbar

Toolbar File: Enter the file name.

The directory  /userhome/IBM/iAccesClient/Emulator  is used by default.
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ThinLinc Global
Menu path: Sessions > ThinLinc > ThinLinc Global

In this area, you can change the global settings for ThinLinc sessions.

Server (see page 346)
Window (see page 347)
Options (see page 348)
Optimization (see page 350)
VNC Optimization (see page 351)
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Server
Menu path: Setup > Sessions > ThinLinc > ThinLinc Global > Server

You can specify the port for communication between the client and server and allow remote monitoring of the 
client through shadowing.

SSH port
Possible values:

Default SSH (22): Port 22 is used.
HTTP (80): Port 80 is used.
Custom: Under Custom port number, you can enter an alternative port number.

Custom port number: Alternative port number
Allow shadowing
☑ The session can be remote monitored by shadowing via VNC.
☐ The session cannot be remote monitored by shadowing. (default)
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Window
Menu path: Setup > Sessions > ThinLinc > ThinLinc Global > Window

In this area, you can define the window settings for ThinLinc sessions.

Screen size
Possible values:

"800x600"
"1024x768"
"1280x1024"
"1600x1200"
"Current monitor": The entire display area of the current monitor is used for the ThinLinc session.
"All monitors": The display area of all monitors is used for the ThinLinc session.
"Work area (maximized)": The display area of the current monitor minus the height of the taskbar 
is used for the ThinLinc session.
"Custom size": The display area specified with Custom screen width and Custom screen height is 
used for the ThinLinc session.

Custom screen width: Width of the display area for the session in pixels.

Custom screen height: Height of the display area for the session in pixels.

Full-screen mode

☑ The entire display area is used for the ThinLinc session. (Default)

Full-screen all monitor

☑ The entire display area of all monitors is used for the ThinLinc session. (Default)

Control bar for ThinLinc sessions

☑ If the ThinLinc session takes place in full-screen mode, an in-session control bar will be shown. You can 
minimize or close the session with the control bar. Further information can be found under In-Session Control 
Bar (see page 695).

☐ The in-session control bar will not be shown. (Default)
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Options
Menu path: Setup > Sessions > ThinLinc > ThinLinc Global > Options

You can change various settings and enable local directories.

Enable sound

☑ Audio output will be forwarded from the server to the device. The audio data can then be played back via the 
built-in loudspeaker or the headset.

☐ Audio output will not be forwarded to the device. (Default)

Redirect serial port

☑ The serial port data will be forwarded from the device to the server. The serial port can be used in the ThinLinc 
session.

☐ The serial port data will not be forwarded to the server. (Default)

Enable printer

☑ The local printer can be used in the ThinLinc session. (Default)

☐ The local printer cannot be used in the ThinLinc session.

Enable smartcard readers

☑ The server has access to the device’s local smartcard reader.

☐ The server does not have access to the local smartcard reader. (Default)

Enable drive access

☑ The server has access to local directories. These directories can be selected in the Exported Paths and 
Permissions area.

☐ The server does not have access to local directories. (Default)

Exported Paths and Permissions
To edit the list, proceed as follows:

Click on  to create a new entry.
Click on  to remove the selected entry.
Click on  to edit the selected entry.
Click on  to copy the selected entry.

To select a local directory for server-side access, proceed as follows:

Click on .
In the Path field, enter the local directory path. Example: /userhome
Select the Permission that the server is to have for the directory.

Read only: The server has read rights for the directory but no write rights.
Read/write: The server has read and write rights for the directory.
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4.

Disabled: The server has no read rights and no write rights for the directory.

Click on Ok.

If you set a directory to “Disabled”, ensure that it is not a sub-directory of a directory for 
which the server has read or write rights.





Sessions

IGEL OS Reference Manual   350 / 897

•

•

•

•

•

Optimization
Menu path: Setup > Sessions > ThinLinc > ThinLinc Global > Optimization

You can select a suitable compression procedure in order to optimize the transmission speed between the client 
and server.

Enable custom compression level
☑ You can specify how much the data transmitted between the client and server are compressed.
☐ The default value will be used for the compression level. (default)
Compression level: Allows you to select the compression level; 9 is the highest compression 
(default: 8)
Enable JPEG compression: If this option is enabled, graphical data will be compressed using the 
JPEG procedure.

☑ Graphical data will be compressed in accordance with the JPEG procedure. (default)
JPEG quality: Allows you to select the image quality. 1 means the highest compression and the 
lowest image quality, 9 means the lowest compression and the highest image quality. (default: 7)
SSH compression
☑ The data will be compressed using SSH compression.
☐ The data will not be compressed using SSH compression. (default)

A higher JPEG compression level saves bandwidth but reduces the image quality.
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VNC Optimization
Menu path: Setup > Sessions > ThinLinc > ThinLinc Global > VNC Optimization

You can change VNC protocol settings in order to optimize transmission.

VNC autoselect

☑ The preferred coding and color depth will be specified automatically. (Default)

☐ The Preferred coding and Color depth can be specified by the user.

Preferred encoding: Specifies how the data to be transmitted are to be coded. The coding is negotiated between 
the client and server.
Possible values:

"Tight": Suitable for slow networks too.
"ZRLE": Compatible with RealVNC.
"Hextile": Recommended for fast networks.
"Raw": No compression.

Color depth: Allows you to select the color resolution.
Possible values:

"Full (all colors)": The maximum value set on the server is used.
"Medium (256 colors)"
"Low (64 colors)"
"Very low (8 colors)"
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ThinLinc Session
Menu path: Sessions > ThinLinc > ThinLinc Sessions > [Session Name]

 Click on  Add to create a ThinLinc session.

In this area, you can configure desktop integration for the ThinLinc session.

Session name: Name for the session.

Starting Methods for Session
Start menu

☑ The session can be launched from the start menu.

Application Launcher

☑ The session can be launched with the Application Launcher.

Desktop

☑ The session can be launched with a program launcher on the desktop.

Quick start panel

☑ The session can be launched with the quick start panel.

Start menu's system tab

☑ The session can be launched with the start menu's system tab.

Application Launcher's system tab

☑ The session can be launched with the Application Launcher's system tab.

Desktop context menu

☑ The session can be launched with the desktop context menu.

Menu folder: If you specify a folder name or a path comprising a number of folder names separated by "/", a menu 
path will be created for the session. The menu path will be used in the start menu and in the desktop context menu.

Application Launcher folder: If you specify a folder name or a path comprising a number of folder names 
separated by "/", a menu path will be created for the session. The menu path will be used in the Application 
Launcher.

Desktop folder: If you specify a folder name or a path comprising a number of folder names separated by "/", a 
menu path will be created for the session. The menu path will be used for the program launcher on the desktop.

Password protection: Specifies which password will be requested when launching the session.
Possible values:

None: No password is requested when launching the session.

The session name must not contain any of these characters: \ / : * ? “ < > | [ ] { } ( )
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Administrator: The administrator password is requested when launching the session.
User: The user password is requested when launching the session.
Setup user: The setup user's password is requested when launching the session.

Hotkey

☑ The session can be started with a hotkey. A hotkey consists of one or more modifiers and a key.

Modifiers: A modifier or a combination of several modifiers for the hotkey. You can select a set key symbol/
combination or your own key symbol/combination. A key symbol is a defined chain of characters, e.g.  Ctrl .

These are the pre-defined modifiers and the associated key symbols:

(No modifier) =  None

 =  Shift
[Ctrl] =  Ctrl

 =  Mod4

[Alt] =  Alt

Key combinations are formed as follows with  | :

Ctrl +   =  Ctrl|Super_L

Key: Key for the hotkey

Autostart

☑ The session will be launched automatically when the device boots.

Restart

☑ The session will be relaunched automatically after the termination.

Do not use [AltGr] as a modifier (represented as Mod5 ). Otherwise, the key that is configured as a hotkey 
with AltGr cannot be used as a regular key anymore. Example: If you configure [AltGr] + [E] as a hotkey, it is 
impossible to enter an "e".



When this keyboard key is used as a modifier, it is represented as Mod4 ; when it is used as a key, it 

is represented as Super_L .



To enter a key that does not have a visible character, e. g. the [Tab] key, open a terminal, log on as user

and enter xev -event keyboard . Press the key to be used for the hotkey. The text in brackets that 

begins with keysym  contains the key symbol for the Key field. Example: Tab  in (keysym 0xff09, 

Tab)


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Autostart delay: Waiting time in seconds between the complete startup of the desktop and the automatic session 
launch.

Autostart requires network

☑ If no network is available at system startup, the session is not started. A message is shown. As soon as the 
network is available, the session is started automatically.

☐ The session is started automatically, even when no network is available.

Server (see page 355)
Login (see page 356)
Window (see page 358)
Options (see page 359)
Optimization (see page 360)
VNC Optimization (see page 361)
User Interface (see page 362)
Desktop Integration (see page 363)
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Server
Menu path: Setup > Sessions > ThinLinc > ThinLinc Sessions > [Session Name] > Server

Server: Name or IP address of the ThinLinc server
User: User name for the connection to the ThinLinc server
Password: Password for the connection to the ThinLinc server

Use global SSH port settings
☑ The port set under Setup > Sessions > ThinLinc > ThinLinc Global > Server will be used. 
(default)
☐ The port set in SSH port or Custom port number will be used.
SSH port
Possible values:

Default SSH (22): Port 22 is used.
HTTP (80): Port 80 is used.
Custom: Under Custom port number, you can enter an alternative port number.

Custom port number: Alternative port number

Session passwords are stored with reversible encryption. Therefore, we strongly recommend not to 
store the session password on the endpoint device. 


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Login
Menu path: Sessions > ThinLinc > ThinLinc Sessions > [Session Name] > Login

Method of authentication: A method used for the authentication.
Possible values:

"Password"
"Public key"
"Smartcard"
"Kerberos"

User: The user credentials are taken from Setup > Sessions > ThinLinc > ThinLinc Sessions > [Session Name] > 
Server > User.

Password: A password specified under Setup > Sessions > ThinLinc > ThinLinc Sessions > [Session Name] > 
Server > Password is used for the authentication. (Available if Password is selected as Method of authentication).

The following settings can be configured if Smartcard is used as a Method of authentication.

Smartcard only 
Use certificate subject as name for login

☑ The certificate subject will be used as login name. (Default)

☐ The user credentials from Setup > Sessions > ThinLinc > ThinLinc Sessions > [Session Name] > Server > User 
will be used as login name.

Connect the client automatically if a smartcard is found 

☑ The client will be connected automatically if a smartcard is detected (available if Use subject of smartcard as 
name for login is enabled). (Default)

☐ The client will not be connected automatically by the smartcard detection.

Disconnect the client automatically when the smartcard is removed

☑ The client will be disconnected automatically if the smartcard is removed. (Default)

☐ The client will not be disconnected at the smartcard removal.

Allow transmission of the smartcard's passphrase for logging in

☑ The transmission of the smartcard's passphrase for logging in is allowed. 

☐ The transmission of the smartcard's passphrase for logging in is not allowed. (Default)

If modified here (under Login), User and Password will automatically be changed under Setup > Sessions 
> ThinLinc > ThinLinc Sessions > [Session Name] > Server.



The transmission of the smartcard's passphrase is not recommended by Cendio.
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Smartcard filter: The smartcard filter must be specified in the format described under "SMARTCARD_FILTER_n "

in https://www.cendio.com/resources/docs/tag/clientconf.html.

https://www.cendio.com/resources/docs/tag/clientconf.html
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Window
Menu path: Setup > Sessions > ThinLinc > ThinLinc Sessions > [Session Name] > Window

In this area, you can define the window settings for the specific ThinLinc session.

Use global screen settings

☑ The settings under Setup > Sessions > ThinLinc > ThinLinc Global > Window will be used. (Default)

☐ The settings for this session are defined here.

Screen size
Possible values:

"800x600"
"1024x768"
"1280x1024"
"1600x1200"
"Current monitor": The entire display area of the current monitor is used for the ThinLinc session.
"All monitors": The display area of all monitors is used for the ThinLinc session.
"Work area (maximized)": The display area of the current monitor minus the height of the taskbar 
is used for the ThinLinc session.
"Custom size": The display area specified with Custom screen width and Custom screen height is 
used for the ThinLinc session.

Custom screen width: Width of the display area for the session in pixels.

Custom screen height: Height of the display area for the session in pixels.

Full-screen mode

☑ The entire display area is used for the ThinLinc session. (Default)

Full-screen all monitor

☑ The entire display area of all monitors is used for the ThinLinc session. (Default)

You can enable the in-session control bar for ThinLinc sessions only in the global settings, see Window (see 
page 347).


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Options
Menu path: Setup > Sessions > ThinLinc > ThinLinc Sessions > [Session Name] > Options

You can change various settings and enable local directories.

Use global shadowing settings

☑ The option Setup > Sessions > ThinLinc > ThinLinc Global > Server > Enable Shadowing will be used.

☐ The global setting Enable shadowing will not be used for this session.

Enable shadowing

☑ The session can be monitored remotely by shadowing via VNC.

☐ The session cannot be remotely monitored by shadowing. (Default)

Use global resourse settings

☑ The settings under Setup > Sessions > ThinLinc > ThinLinc Global > Options will be used. (Default)

☐ The settings for this session are defined here.

Enable sound

☑ Audio output will be forwarded from the server to the device. The audio data can then be played back via the 
built-in loudspeaker or the headset.

☐ Audio output will not be forwarded to the device. (Default)

Enable serial port

☑ The serial port data will be forwarded from the device to the server. The serial port can be used in the ThinLinc 
session.

☐ The serial port data will not be forwarded to the server. (Default)

Enable printer

☑ The local printer can be used in the ThinLinc session. (Default)

☐ The local printer cannot be used in the ThinLinc session.

Enable smartcard readers

☑ The server has access to the device’s local smartcard reader.

☐ The server does not have access to the local smartcard reader. (Default)

Enable drive access

☑ The server has access to local directories. These directories can be selected in the Exported Paths and 
Permissions area.

☐ The server does not have access to local directories. (Default)

Options popup key: Key to be used for opening the options menu during the session. (Default: F8)



Sessions

IGEL OS Reference Manual   360 / 897

•

•

•

•

•

•

•

•

Optimization
Menu path: Setup > Sessions > ThinLinc > ThinLinc Sessions > [Session Name] > Optimization

You can select a suitable compression procedure in order to optimize the transmission speed between the client 
and server.

Use global compression level
☑ The global settings under Setup > Sessions > ThinLinc > ThinLinc Global > Optimization > 
Use custom compression level option and Setup > Sessions > ThinLinc > ThinLinc Global > 
Optimization > Compression level selection will be used. (default)
☐ The specific settings for this session will be used.
Enable custom compression level
☑ You can specify how much the data transmitted between the client and server are compressed.
☐ The default value will be used for the compression level. (default)
Compression level: Allows you to select the compression level; 9 is the highest compression 
(default: 8)
Use global JPEG quality settings
☑ The global settings under Setup > Sessions > ThinLinc > ThinLinc Global > Optimization > 
Use JPEG compression option and Setup > Sessions > ThinLinc > ThinLinc Global > 
Optimization > JPEG Quality selection will be used. (default)
☐ The specific settings for this session are defined here.
Enable JPEG compression

☑ Graphical data will be compressed in accordance with the JPEG procedure. (default)
JPEG quality: Allows you to select the image quality. 1 means the highest compression and the 
lowest image quality, 9 means the lowest compression and the highest image quality. (default: 7)
Use global SSH connection settings
☑ The global settings under Setup > Sessions > ThinLinc > ThinLinc Global > Optimization > 
SSH Compression option will be used. (default)
☐ The specific setting for this session will be used.
SSH compression
☑ The data will be compressed using SSH compression.
☐ The data will not be compressed using SSH compression. (default)

A higher JPEG compression level saves bandwidth but reduces the image quality.
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VNC Optimization
Menu path: Setup > Sessions > ThinLinc > ThinLinc Sessions > [Session Name] > VNC Optimization

You can change VNC protocol settings in order to optimize transmission.

Use global VNC settings

☑ The global settings under Setup > Sessions > ThinLinc > ThinLinc Global > VNC optimization will be used. 
(Default)

☐ The specific settings for this session are defined here.

VNC auto select

☑ The Preferred encoding and Color level will be specified automatically. (Default)

☐ The Preferred encoding and Color level can be specified by the user.

Preferred encoding: Specifies how the data to be transmitted are to be coded. The coding is negotiated between 
the client and server.
Possible values:

"Tight": Suitable for slow networks too.
"ZRLE": Compatible with RealVNC.
"Hextile": Recommended for fast networks.
"Raw": No compression.

Color level: Allows you to select the color resolution.
Possible values:

"Full (all colors)": The maximum value set on the server is used.
"Medium (256 colors)"
"Low (64 colors)"
"Very low (8 colors)"
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User Interface
Menu path: Setup > Sessions > ThinLinc > ThinLinc Sessions > [Session Name] > User Interface

You can change the fields and settings options of the logon window as well as the ThinLinc Client Options dialog.

Lock server name
☑ The server name given under Setup > Sessions > ThinLinc Sessions > Server will be used and 
it will not be possible to change it in the logon window. (default)
Hide options button
☑ The Options button will not appear in the logon window. The ThinLinc Client Options dialog 
therefore cannot be opened. (default)
Advanced mode
☑ The fields that can be opened under Advanced will appear when starting the session.
☐ The fields that can be opened under Advanced will not appear when starting the session. 
(default)
Lock ThinLinc options tab
☑ The settings in the Options tab of the ThinLinc Client Options dialog cannot be changed. 
(default)
Lock Local Devices options tab
☑ The settings in the Local Devices tab of the ThinLinc Client Options dialog cannot be 
changed. (default)
Lock ThinLinc Screen tab
☑ The settings in the Screen tab of the ThinLinc Client Options dialog cannot be changed. 
(default)
Lock ThinLinc Optimization tab
☑ The settings in the Optimization tab of the ThinLinc Client Options dialog cannot be 
changed. (default)
Lock Security tab
☑ The settings in the Security tab of the ThinLinc Client Options dialog cannot be changed. 
(default)
Debug level: Specifies how detailed the debugging information is to be. 1 is the lowest level 
(default), 5 is the highest.
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Desktop Integration
Menu path: Sessions > ThinLinc > ThinLinc Sessions > [Session Name] > Desktop Integration

In this area, you can configure desktop integration for the ThinLinc session.

Session name: Name for the session.

Starting Methods for Session
Start menu

☑ The session can be launched from the start menu.

Application Launcher

☑ The session can be launched with the Application Launcher.

Desktop

☑ The session can be launched with a program launcher on the desktop.

Quick start panel

☑ The session can be launched with the quick start panel.

Start menu's system tab

☑ The session can be launched with the start menu's system tab.

Application Launcher's system tab

☑ The session can be launched with the Application Launcher's system tab.

Desktop context menu

☑ The session can be launched with the desktop context menu.

Menu folder: If you specify a folder name or a path comprising a number of folder names separated by "/", a menu 
path will be created for the session. The menu path will be used in the start menu and in the desktop context menu.

Application Launcher folder: If you specify a folder name or a path comprising a number of folder names 
separated by "/", a menu path will be created for the session. The menu path will be used in the Application 
Launcher.

Desktop folder: If you specify a folder name or a path comprising a number of folder names separated by "/", a 
menu path will be created for the session. The menu path will be used for the program launcher on the desktop.

Password protection: Specifies which password will be requested when launching the session.
Possible values:

None: No password is requested when launching the session.
Administrator: The administrator password is requested when launching the session.
User: The user password is requested when launching the session.

The session name must not contain any of these characters: \ / : * ? “ < > | [ ] { } ( )
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Setup user: The setup user's password is requested when launching the session.

Hotkey

☑ The session can be started with a hotkey. A hotkey consists of one or more modifiers and a key.

Modifiers: A modifier or a combination of several modifiers for the hotkey. You can select a set key symbol/
combination or your own key symbol/combination. A key symbol is a defined chain of characters, e.g.  Ctrl .

These are the pre-defined modifiers and the associated key symbols:

(No modifier) =  None

 =  Shift
[Ctrl] =  Ctrl

 =  Mod4

[Alt] =  Alt

Key combinations are formed as follows with  | :

Ctrl +   =  Ctrl|Super_L

Key: Key for the hotkey

Autostart

☑ The session will be launched automatically when the device boots.

Restart

☑ The session will be relaunched automatically after the termination.

Autostart delay: Waiting time in seconds between the complete startup of the desktop and the automatic session 
launch.

Do not use [AltGr] as a modifier (represented as Mod5 ). Otherwise, the key that is configured as a hotkey 
with AltGr cannot be used as a regular key anymore. Example: If you configure [AltGr] + [E] as a hotkey, it is 
impossible to enter an "e".



When this keyboard key is used as a modifier, it is represented as Mod4 ; when it is used as a key, it 

is represented as Super_L .



To enter a key that does not have a visible character, e. g. the [Tab] key, open a terminal, log on as user

and enter xev -event keyboard . Press the key to be used for the hotkey. The text in brackets that 

begins with keysym  contains the key symbol for the Key field. Example: Tab  in (keysym 0xff09, 

Tab)


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Autostart requires network

☑ If no network is available at system startup, the session is not started. A message is shown. As soon as the 
network is available, the session is started automatically.

☐ The session is started automatically, even when no network is available.
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SSH Session
Menu path: Sessions > SSH > [Session Name]

You can launch applications on a remote computer via SSH (Secure Shell). The display is usually on the terminal; 
X11 connections too can be routed via SSH.

 Click on  Add to create an SSH session.

In the following area, you can configure desktop integration for the SSH session.

Session name: Name for the session.

Starting Methods for Session
Start menu

☑ The session can be launched from the start menu.

Application Launcher

☑ The session can be launched with the Application Launcher.

Desktop

☑ The session can be launched with a program launcher on the desktop.

Quick start panel

☑ The session can be launched with the quick start panel.

Start menu's system tab

☑ The session can be launched with the start menu's system tab.

Application Launcher's system tab

☑ The session can be launched with the Application Launcher's system tab.

Desktop context menu

☑ The session can be launched with the desktop context menu.

Menu folder: If you specify a folder name or a path comprising a number of folder names separated by "/", a menu 
path will be created for the session. The menu path will be used in the start menu and in the desktop context menu.

Application Launcher folder: If you specify a folder name or a path comprising a number of folder names 
separated by "/", a menu path will be created for the session. The menu path will be used in the Application 
Launcher.

Desktop folder: If you specify a folder name or a path comprising a number of folder names separated by "/", a 
menu path will be created for the session. The menu path will be used for the program launcher on the desktop.

The session name must not contain any of these characters: \ / : * ? “ < > | [ ] { } ( )
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Password protection: Specifies which password will be requested when launching the session.
Possible values:

None: No password is requested when launching the session.
Administrator: The administrator password is requested when launching the session.
User: The user password is requested when launching the session.
Setup user: The setup user's password is requested when launching the session.

Hotkey

☑ The session can be started with a hotkey. A hotkey consists of one or more modifiers and a key.

Modifiers: A modifier or a combination of several modifiers for the hotkey. You can select a set key symbol/
combination or your own key symbol/combination. A key symbol is a defined chain of characters, e.g.  Ctrl .

These are the pre-defined modifiers and the associated key symbols:

(No modifier) =  None

 =  Shift
[Ctrl] =  Ctrl

 =  Mod4

[Alt] =  Alt

Key combinations are formed as follows with  | :

Ctrl +   =  Ctrl|Super_L

Key: Key for the hotkey

Autostart

☑ The session will be launched automatically when the device boots.

Do not use [AltGr] as a modifier (represented as Mod5 ). Otherwise, the key that is configured as a hotkey 
with AltGr cannot be used as a regular key anymore. Example: If you configure [AltGr] + [E] as a hotkey, it is 
impossible to enter an "e".



When this keyboard key is used as a modifier, it is represented as Mod4 ; when it is used as a key, it 

is represented as Super_L .



To enter a key that does not have a visible character, e. g. the [Tab] key, open a terminal, log on as user

and enter xev -event keyboard . Press the key to be used for the hotkey. The text in brackets that 

begins with keysym  contains the key symbol for the Key field. Example: Tab  in (keysym 0xff09, 

Tab)


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Restart

☑ The session will be restarted automatically after the termination.

Autostart delay: Waiting time in seconds between the complete startup of the desktop and the automatic session 
launch.

Autostart requires network

☑ If no network is available at system startup, the session is not started. A message is shown. As soon as the 
network is available, the session is started automatically.

☐ The session is started automatically, even when no network is available.

Appliance mode access: Determines whether the session can be started in appliance mode. By default, appliance 
mode implies that one session is running on the device exclusively. For further information, see Appliance Mode (see 
page 220).

☑ The session can be started in appliance mode. The following starting methods can be used in appliance mode:

Desktop (desktop icon; not in appliance mode XDMCP for this Display)
Desktop Context Menu (not in appliance mode XDMCP for this Display)
Application Launcher (includes Application Launcher's system tab; not in appliance 
mode XDMCP for this Display)
Hotkey
Autostart (not in appliance mode XDMCP for this Display)

☐ The session cannot be started in appliance mode. 

Command (see page 369)
Options (see page 370)
Desktop Integration (see page 371)
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Command
Menu path: Sessions > SSH > [Session Name] > Command

Remote user name: User name under which the application runs on the remote computer If you do not give a 
name, you will be asked when the session starts.

Remote host: Host name or IP address of the remote computer.

Command line: Command which is to be executed on the remote computer immediately after logging in.



Sessions

IGEL OS Reference Manual   370 / 897

Options
Menu path: Sessions > SSH > [Session Name] > Options

Here, you can change the setting for X11 forwarding, compression, and the protocol version used.

Enable X11 connection forwarding

☑ X11 applications on the remote computer that are launched via the SSH session will be shown on your device. 
(Default)

☐ No X11 programs can be launched on the remote computer via the SSH session.

Enable compression

☑ The data will be compressed for transmission.

Force protocol version 1

☑ The SSH client will force protocol version 1 for authentication. Protocol version 1 will be used when you connect 
to an old SSH server.

Force protocol version 2

☑ The SSH client will force protocol version 2 for authentication. 

Port: SSH port. (Default: 22)

Select one of the two protocol versions or none. If you select none, the system will decide which version it 
prefers.


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Desktop Integration
Menu path: Sessions > SSH > [Session Name] > Desktop Integration

In this area, you can configure desktop integration for the SSH session.

Session name: Name for the session.

Starting Methods for Session
Start menu

☑ The session can be launched from the start menu.

Application Launcher

☑ The session can be launched with the Application Launcher.

Desktop

☑ The session can be launched with a program launcher on the desktop.

Quick start panel

☑ The session can be launched with the quick start panel.

Start menu's system tab

☑ The session can be launched with the start menu's system tab.

Application Launcher's system tab

☑ The session can be launched with the Application Launcher's system tab.

Desktop context menu

☑ The session can be launched with the desktop context menu.

Menu folder: If you specify a folder name or a path comprising a number of folder names separated by "/", a menu 
path will be created for the session. The menu path will be used in the start menu and in the desktop context menu.

Application Launcher folder: If you specify a folder name or a path comprising a number of folder names 
separated by "/", a menu path will be created for the session. The menu path will be used in the Application 
Launcher.

Desktop folder: If you specify a folder name or a path comprising a number of folder names separated by "/", a 
menu path will be created for the session. The menu path will be used for the program launcher on the desktop.

Password protection: Specifies which password will be requested when launching the session.
Possible values:

None: No password is requested when launching the session.
Administrator: The administrator password is requested when launching the session.
User: The user password is requested when launching the session.

The session name must not contain any of these characters: \ / : * ? “ < > | [ ] { } ( )
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Setup user: The setup user's password is requested when launching the session.

Hotkey

☑ The session can be started with a hotkey. A hotkey consists of one or more modifiers and a key.

Modifiers: A modifier or a combination of several modifiers for the hotkey. You can select a set key symbol/
combination or your own key symbol/combination. A key symbol is a defined chain of characters, e.g.  Ctrl .

These are the pre-defined modifiers and the associated key symbols:

(No modifier) =  None

 =  Shift
[Ctrl] =  Ctrl

 =  Mod4

[Alt] =  Alt

Key combinations are formed as follows with  | :

Ctrl +   =  Ctrl|Super_L

Key: Key for the hotkey

Autostart

☑ The session will be launched automatically when the device boots.

Restart

☑ The session will be restarted automatically after the termination.

Autostart delay: Waiting time in seconds between the complete startup of the desktop and the automatic session 
launch.

Do not use [AltGr] as a modifier (represented as Mod5 ). Otherwise, the key that is configured as a hotkey 
with AltGr cannot be used as a regular key anymore. Example: If you configure [AltGr] + [E] as a hotkey, it is 
impossible to enter an "e".



When this keyboard key is used as a modifier, it is represented as Mod4 ; when it is used as a key, it 

is represented as Super_L .



To enter a key that does not have a visible character, e. g. the [Tab] key, open a terminal, log on as user

and enter xev -event keyboard . Press the key to be used for the hotkey. The text in brackets that 

begins with keysym  contains the key symbol for the Key field. Example: Tab  in (keysym 0xff09, 

Tab)


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Autostart requires network

☑ If no network is available at system startup, the session is not started. A message is shown. As soon as the 
network is available, the session is started automatically.

☐ The session is started automatically, even when no network is available.

Appliance mode access: Determines whether the session can be started in appliance mode. By default, appliance 
mode implies that one session is running on the device exclusively. For further information, see Appliance Mode (see 
page 220).

☑ The session can be started in appliance mode. The following starting methods can be used in appliance mode:

Desktop (desktop icon; not in appliance mode XDMCP for this Display)
Desktop Context Menu (not in appliance mode XDMCP for this Display)
Application Launcher (includes Application Launcher's system tab; not in appliance 
mode XDMCP for this Display)
Hotkey
Autostart (not in appliance mode XDMCP for this Display)

☐ The session cannot be started in appliance mode. 
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VNC Viewer Sessions
Menu path: Sessions > VNC Viewer > VNC Viewer Sessions > [Session Name]

With the VNC viewer, you can access the graphical user interface of a remote computer.

 Click on  to create a VNC viewer session.

The settings for starting the session are described below.

Session name: Name for the session.

Starting Methods for Session
Start menu

☑ The session can be launched from the start menu.

Application Launcher

☑ The session can be launched with the Application Launcher.

Desktop

☑ The session can be launched with a program launcher on the desktop.

Quick start panel

☑ The session can be launched with the quick start panel.

Start menu's system tab

☑ The session can be launched with the start menu's system tab.

Application Launcher's system tab

☑ The session can be launched with the Application Launcher's system tab.

Desktop context menu

☑ The session can be launched with the desktop context menu.

Menu folder: If you specify a folder name or a path comprising a number of folder names separated by "/", a menu 
path will be created for the session. The menu path will be used in the start menu and in the desktop context menu.

Application Launcher folder: If you specify a folder name or a path comprising a number of folder names 
separated by "/", a menu path will be created for the session. The menu path will be used in the Application 
Launcher.

Desktop folder: If you specify a folder name or a path comprising a number of folder names separated by "/", a 
menu path will be created for the session. The menu path will be used for the program launcher on the desktop.

Password protection: Specifies which password will be requested when launching the session.
Possible values:

The session name must not contain any of these characters: \ / : * ? “ < > | [ ] { } ( )
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•
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None: No password is requested when launching the session.
Administrator: The administrator password is requested when launching the session.
User: The user password is requested when launching the session.
Setup user: The setup user's password is requested when launching the session.

Hotkey

☑ The session can be started with a hotkey. A hotkey consists of one or more modifiers and a key.

Modifiers: A modifier or a combination of several modifiers for the hotkey. You can select a set key symbol/
combination or your own key symbol/combination. A key symbol is a defined chain of characters, e.g.  Ctrl .

These are the pre-defined modifiers and the associated key symbols:

(No modifier) =  None

 =  Shift
[Ctrl] =  Ctrl

 =  Mod4

[Alt] =  Alt

Key combinations are formed as follows with  | :

Ctrl +   =  Ctrl|Super_L

Key: Key for the hotkey

Autostart

☑ The session will be launched automatically when the device boots.

Restart

☑ The session will be restarted automatically after the termination.

Do not use [AltGr] as a modifier (represented as Mod5 ). Otherwise, the key that is configured as a hotkey 
with AltGr cannot be used as a regular key anymore. Example: If you configure [AltGr] + [E] as a hotkey, it is 
impossible to enter an "e".



When this keyboard key is used as a modifier, it is represented as Mod4 ; when it is used as a key, it 

is represented as Super_L .



To enter a key that does not have a visible character, e. g. the [Tab] key, open a terminal, log on as user

and enter xev -event keyboard . Press the key to be used for the hotkey. The text in brackets that 

begins with keysym  contains the key symbol for the Key field. Example: Tab  in (keysym 0xff09, 

Tab)


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Autostart delay: Waiting time in seconds between the complete startup of the desktop and the automatic session 
launch.

Autostart requires network

☑ If no network is available at system startup, the session is not started. A message is shown. As soon as the 
network is available, the session is started automatically.

☐ The session is started automatically, even when no network is available.

Connection (see page 377)
Compression (see page 378)
Input (see page 379)
Misc (see page 380)
Desktop Integration (see page 381)
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Connection
Menu path: Setup > Sessions > VNC Viewer > VNC Viewer Sessions > [Session Name] > Connection

Name or IP address of VNC server: Host name or IP address of the VNC server
Password: User password for logging on to the VNC server, if necessary

Session passwords are stored with reversible encryption. Therefore, we strongly recommend not to 
store the session password on the endpoint device. 





Sessions

IGEL OS Reference Manual   378 / 897

•

•

Compression
Menu path: Setup > Sessions > VNC Viewer > VNC Viewer Sessions > [Session Name] > Compression

Compression level (default = 2): Allows you to select the compression level; 9 is the highest 
compression (default: 2)
JPEG quality level: Allows you to select the image quality. 1 means the highest compression and 
the lowest image quality, 9 means the lowest compression and the highest image quality. (default: 
8)



Sessions

IGEL OS Reference Manual   379 / 897

•

•

•

•
•
•
•
•
•
•
•
•
•

Input
Menu path: Setup > Sessions > VNC Viewer > VNC Viewer Sessions > [Session Name] > Input

Here, you can change the settings for keyboard input for the VNC session.

View only
☑ Mouse and keyboard inputs are not forwarded to the remote computer. You can only observe 
the remote computer.
☐ Mouse and keyboard inputs are forwarded to the remote computer. You can remote control the 
remote computer. (default)
Pass system keys directly to the server (full-screen)
☑ You can use system key combinations in the VNC session, e.g. [Alt] + [Tab]. (default)
☐ System key combinations cannot be used in the VNC session.
Menu key: Key which brings up the menu.
Possible options (default: F8):

[F2] ... [F12]
[Pause]
[Print]
[Scroll lock]
[Esc]
[Ins]
[Del]
[Home]
[Page up] 
[Page down] 
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Misc
Menu path: Setup > Sessions > VNC Viewer > VNC Viewer Sessions > [Session Name] > Misc

Shared mode
☑ When starting a session, other users’ sessions with the same server are not terminated. The 
sessions run alongside each other with equal status.
☐ If another user has a VNC session with the same server, the other user’s session will be 
terminated when the session is started. (default)
Fullscreen mode
☑ The session will be shown in full-screen mode. The taskbar is not visible.
☐ The taskbar is visible. (default)
Color level: Number of possible colors
Possible values:

Default: The highest available color depth will be used.
Very low (8 colors)
Low (64 colors)
Medium (256 colors)
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Desktop Integration
Menu path: Sessions > VNC Viewer > VNC Viewer Sessions > [Session Name] > Desktop Integration

Session name: Name for the session.

Starting Methods for Session
Start menu

☑ The session can be launched from the start menu.

Application Launcher

☑ The session can be launched with the Application Launcher.

Desktop

☑ The session can be launched with a program launcher on the desktop.

Quick start panel

☑ The session can be launched with the quick start panel.

Start menu's system tab

☑ The session can be launched with the start menu's system tab.

Application Launcher's system tab

☑ The session can be launched with the Application Launcher's system tab.

Desktop context menu

☑ The session can be launched with the desktop context menu.

Menu folder: If you specify a folder name or a path comprising a number of folder names separated by "/", a menu 
path will be created for the session. The menu path will be used in the start menu and in the desktop context menu.

Application Launcher folder: If you specify a folder name or a path comprising a number of folder names 
separated by "/", a menu path will be created for the session. The menu path will be used in the Application 
Launcher.

Desktop folder: If you specify a folder name or a path comprising a number of folder names separated by "/", a 
menu path will be created for the session. The menu path will be used for the program launcher on the desktop.

Password protection: Specifies which password will be requested when launching the session.
Possible values:

None: No password is requested when launching the session.
Administrator: The administrator password is requested when launching the session.
User: The user password is requested when launching the session.
Setup user: The setup user's password is requested when launching the session.

The session name must not contain any of these characters: \ / : * ? “ < > | [ ] { } ( )
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Hotkey

☑ The session can be started with a hotkey. A hotkey consists of one or more modifiers and a key.

Modifiers: A modifier or a combination of several modifiers for the hotkey. You can select a set key symbol/
combination or your own key symbol/combination. A key symbol is a defined chain of characters, e.g.  Ctrl .

These are the pre-defined modifiers and the associated key symbols:

(No modifier) =  None

 =  Shift
[Ctrl] =  Ctrl

 =  Mod4

[Alt] =  Alt

Key combinations are formed as follows with  | :

Ctrl +   =  Ctrl|Super_L

Key: Key for the hotkey

Autostart

☑ The session will be launched automatically when the device boots.

Restart

☑ The session will be restarted automatically after the termination.

Autostart delay: Waiting time in seconds between the complete startup of the desktop and the automatic session 
launch.

Autostart requires network

Do not use [AltGr] as a modifier (represented as Mod5 ). Otherwise, the key that is configured as a hotkey 
with AltGr cannot be used as a regular key anymore. Example: If you configure [AltGr] + [E] as a hotkey, it is 
impossible to enter an "e".



When this keyboard key is used as a modifier, it is represented as Mod4 ; when it is used as a key, it 

is represented as Super_L .



To enter a key that does not have a visible character, e. g. the [Tab] key, open a terminal, log on as user

and enter xev -event keyboard . Press the key to be used for the hotkey. The text in brackets that 

begins with keysym  contains the key symbol for the Key field. Example: Tab  in (keysym 0xff09, 

Tab)


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☑ If no network is available at system startup, the session is not started. A message is shown. As soon as the 
network is available, the session is started automatically.

☐ The session is started automatically, even when no network is available.
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Browser Global
Menu path: Sessions > Browser > Browser Global

In this area, you can define the start page, display resolution and font size for the browser.

You can change the following settings:

When browser starts: Specifies what pages are shown when the browser is launched.

Start with a blank page
Show my home page (default)
Resume previous session: All tabs from the last session are reopened.

Home page: Specifies the URL of the start page. You can specify a number of start pages by separating the URLs of 
the start pages with a vertical dash "|".

Display resolution: Specifies the display resolution for the browser in DPI. Typical values are 72 for medium 
screens and 96 for large screens.
Possible values:

System setting
(Various discreet values)

Minimum font size: Specifies the minimum size of the fonts displayed on websites. The formats of the websites are 
overwritten in the process. 
Possible values:

None: The fonts can be as small as you like. (default)
(Various discreet values)

Show browser splash screen

☑ While the browser is starting, a Firefox logo will be shown in the middle of the screen. (default)

☐ No Firefox logo will be shown.

Tabs (see page 386)
Content (see page 387)
Print (see page 389)
Proxy (see page 390)
Privacy (see page 393)
Security (see page 395)
Advanced (see page 396)
Encryption (see page 399)
Certificates (see page 400)
Smartcard Middleware (see page 401)
Restart (see page 402)
Window (see page 403)
Menus & Toolbars (see page 404)
Hotkeys (see page 407)
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Context (see page 408)
Commands (see page 409)
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Tabs
Menu path: Setup > Sessions > Browser > Browser Global > Tabs

In this area, you can define settings for the browser tabs.

New pages should be opened in: Specifies how links to new pages are to be opened.
Current window: The page will open in the current window, even if the link defines a new 
window as the target.
New window: If the link does not define a target, the page will open in the current window. If 
the link defines a new window as the target, the page will open in a new window. (default)
New tab: If the link does not define a target, the page will open in the current window. If the 
link defines a new window as the target, the page will open in a new tab.

Warn me when closing multiple tabs
☑ A warning will be shown as soon as you attempt to close a browser window with a number of 
tabs.
☐ No warning will be shown if you close a number of browser windows. (default)
Warn me when opening multiple tabs might slow down the browser
☑ A warning will be shown if a very large number of tabs are loaded simultaneously. (default)
☐ No warning will be shown if a very large number of tabs are loaded simultaneously.
When a link is opened in a new tab, switch to it immediately
☑ When a new tab is opened via a link, the focus will switch to the new tab.
☐ When a new tab is opened via a link, the focus will not change. (default)
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3.
4.

1.
2.
3.
4.

5.

•
•

Content
Menu path: Sessions > Browser > Browser Global > Content

In this area, you can change settings regarding popups, JavaScript, downloads and the browser display.

Block pop-up windows

☑ The automatic opening of popup windows by websites will be blocked. With Exceptions..., you can allow 
popups to be opened automatically for specific websites.

☐ The automatic opening of popup windows will not be blocked. (default)

To add an exception for the automatic opening of popups, proceed as follows:

Click on Exceptions....
Click on .
In the Website field, give the URL of the website for which the exception is to apply.
Click on Ok.

Load images automatically

☑ Websites will be loaded fully including all images. (default)

☐ Images in websites will not be loaded; placeholders will be shown instead of the images. As a result of this, 
websites can be loaded more quickly, but the layout is impaired. With Exceptions... you can allow or prevent 
automatic loading for specific websites.

To add an exception for the automatic loading of images, proceed as follows:

Click on Exceptions....
Click on .
In the Website field, give the URL of the website for which the exception is to apply.
Using the Status drop-down menu, specify whether the automatic loading of images is to be 
allowed or prevented for the given website.
Click on Ok.

Type of download directory: Specifies the directory in which a downloaded file is saved.

User directory: The file is saved locally on the thin client desktop.
Custom path: You can specify whether the downloaded file is to be opened with an application or 
saved locally. (default)

Download path: Local directory in which the downloaded file is saved if Type of download directory is set to 
Custom path. (default: /tmp )

Enable JavaScript

☑ JavaScript code will be executed on websites. (default)

☐ JavaScript code will not be executed.

Raise or lower windows

☑ A website can place windows in the background or foreground via JavaScript. (default)

☐ Websites cannot place windows in the background or foreground via JavaScript.
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Move or resize existing windows

☑ A website can move windows or change the window size via JavaScript.

☐ Websites cannot move windows or change the window size via JavaScript. (default)

Disable or replace context menus

☑ A website can define a custom context menu via JavaScript; the browser's own context menu will be suppressed 
in the process.

☐ Websites cannot define a custom context menu.

Languages for web pages: One or more preferred languages for multilingual websites, given in the form of 
language abbreviations separated by commas. The languages should be given in the order of preference. Example: 
With de, en, fr, it , the website will be shown in German, if available, otherwise in English, etc.
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Print
Menu path: Sessions > Browser > Browser Global > Print

In this area, you can set the default paper size for the printer.

Use system settings for default paper size

☑ The globally set paper size will be used when printing websites. (Default)

☐ You can set the paper size via Default paper size.

Default paper size: Preset paper size when printing websites.
Possible values:

Letter
Legal
Executive
A5
A4
A3
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2.

Proxy
Menu path: Sessions > Browser > Browser Global > Proxy

In this area, you can change the proxy configuration.

To change the proxy configuration, proceed as follows:

In the Proxy Configuration pull-down menu, select the type of proxy configuration.
The following proxy configurations are available:

Direct connection to the Internet
Manual proxy configuration
Automatic proxy configuration
System-wide proxy configuration
Auto-detect proxy settings for this network

Enter the necessary configuration data for the selected proxy configuration.

Direct Connection to the Internet
With this proxy configuration, no proxy is used.

Manual Proxy Configuration
The configuration data must be specified in the following fields.

FTP proxy: URL of the proxy for FTP

Port: Port of the proxy for FTP

HTTP proxy: URL of the proxy for HTTP

Port: Port of the proxy for HTTP

SSL proxy: URL of the proxy for SSL

Port: Port of the proxy for SSL

SOCKS host: URL of the proxy for SOCKS

Port: Port of the proxy for SOCKS

SOCKS protocol version: Version of the SOCKS protocol used (default: SOCKS v5)

No proxy for: List of URLs for which no proxy is to be used (default: localhost, 127.0.0.1 )

Proxy realm: Area in which the browser authenticates itself for the proxy. Together with the user name and 
password, this information is necessary for authentication.

The Proxy realm field is internally pre-populated with the value moz-proxy://[HTTP Proxy]:

[Port] . If the field is empty, this value will be used when authenticating the browser. If the proxy 
expects another unknown value for the proxy realm, you can determine this as follows: Leave the User 
name and Password fields empty and launch the browser. The dialog window which appears will contain 
the correct value for the Proxy realm field:


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Use passthrough authentication: This option can be used if the local thin client logon takes place via Kerberos.

☑ The logon information saved temporarily when logging on to the thin client will be carried over when logging on 
to the proxy.

User name: User name with which the browser authenticates itself for the proxy.

Password: Password with which the browser authenticates itself for the proxy.

Do not prompt for proxy authentication if credentials are saved

☑ If logon data are already saved in the browser, the user will not be asked for a user name and password. 
(default)

Automatic Proxy Configuration
With this proxy configuration, the PAC file (Proxy Auto Config) available under URL will be used.

URL: URL of the proxy configuration file

Do not prompt for proxy authentication if credentials are saved

☑ If logon data are already saved in the browser, the user will not be asked for a user name and password. 
(default)

System-Wide Proxy Configuration
With this proxy configuration, the proxy configured under Setup > Network > Proxy will be used.

Do not prompt for proxy authentication if credentials are saved

In the example above, the value for the Proxy realm field is as follows: moz-proxy://

172.30.178.10:8080

This option should not be enabled in multiuser environments. If this option is enabled in a multiuser 
environment, a user can use the logon data of a previous user.



This option should not be enabled in multiuser environments. If this option is enabled in a multiuser 
environment, a user can use the logon data of a previous user.


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☑ If logon data are already saved in the browser, the user will not be asked for a user name and password. 
(default)

Auto-Detect Proxy Settings for This Network
With this proxy configuration, WPAD (Web Proxy Autodiscovery Protocol) will be used. The browser will determine 
the URL of the WPAD file wpad.dat  automatically with the help of DNS.

Do not prompt for proxy authentication if credentials are saved

☑ If logon data are already saved in the browser, the user will not be asked for a user name and password. 
(default)

This option should not be enabled in multiuser environments. If this option is enabled in a multiuser 
environment, a user can use the logon data of a previous user.



This option should not be enabled in multiuser environments. If this option is enabled in a multiuser 
environment, a user can use the logon data of a previous user.


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Privacy
Menu path: Sessions > Browser > Browser Global > Privacy

In this area, you can configure settings relevant to data protection.

Save browsing history (in days): Specifies how long your browsing history will be stored. If you select Do not store 
history, all browsing history data will be lost when the browser restarts. (default: 9)

Save information entered in forms and the search bar

☑ Entries in forms and search bars will be retained after the browser restarts.

☐ Entries in forms and search bars will be retained only for the duration of the session. (default)

Remember passwords

☑ Passwords entered will be retained after the browser restarts.

☐ Passwords entered will be retained only for the duration of the session. (default)

Clear private data when closing browser

☑ Data entered will be deleted when the browser is closed. What data are deleted is specified in the following 
options.

☐ Data entered will not be deleted when the browser is closed. (default)

Select the Items to Be Cleared
The options in this area are effective if Clear private data when closing browser is enabled.

Browsing & download history

☑ Addresses (URLs) of visited websites and the list of downloads will be deleted when the browser is closed. 
(default)

Form & search history

☑ Entries in the search window and in website forms will be deleted when the browser is closed. (default)

Saved passwords

☑ Passwords entered will be deleted when the browser is closed.

☐ Passwords entered will be retained after the browser restarts. (default)

Cookies

☑ Cookies will be deleted when the browser is closed. (default)

Cache

☑ The cache for temporarily saving websites will be emptied when the browser is closed. (default)

Active logins

All browsing history data stored before the period specified here will be lost.
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☑ Ongoing sessions on websites will be terminated when the browser is closed and will need to be restarted after 
the browser restarts. (default)

☐ Ongoing sessions on websites will be retained after the browser restarts.

Allow private browsing feature

☑ You can open one or more private windows in the browser. All data from private windows will be deleted after 
the browser is closed.

☐ Private windows cannot be opened. (default)

Always start in private browsing mode

☑ The browser will start in private mode. All data will be deleted after the browser is closed.

☐ The browser will start in default mode. (default)

Enable "Do Not Track" feature

☑ The browser will inform the website you are visiting that you do not wish to be tracked, i.e. you do not want your 
surfing history to be recorded. (default)

Enable built-in tracking protection

☑ The browser will block specific domains and websites that use tracking. The browser has an internal list for 
selecting the domains and websites to be blocked. (default)

Suggest visited sites in URL bar

☑ Suggestions will be shown while an address is being typed in the address bar. The suggestions will be based on 
previously visited websites which are stored in the history. (default)

Suggest only typed visited sites

☑ The suggestions will be based only on the websites that were typed directly into the address bar. Websites that 
were visited via bookmarks or links in other websites will not be used for the suggestions.

☐ Websites that were visited via bookmarks or links in other websites will also be used for the suggestions. (default)

Suggest bookmarked sites in URL bar

☑ Suggestions will be shown while an address is being typed in the address bar. The suggestions will be based on 
bookmarks. (default)

Suggest open tabs in URL bar

☑ Suggestions will be shown while an address is being typed in the address bar. The suggestions will be based on 
previously opened tabs. (default)

The browser will use the DNT  ("Do Not Track") field in the HTTP header for this purpose. Observing this 
setting is voluntary; from a technical point of view, websites can still record the surfing history even when 
DNT  is set to 1.



If tracking protection is enabled, a shield symbol will be shown at the left-hand edge of the address bar.
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Security
Menu path: Sessions > Browser > Browser Global > Security

In this area, you can define settings for preventing phishing and malware.

Safe browsing

☑ The browser will check each address entered as to whether it can be found in the black list of fraudulent 
websites which use phishing. If this is the case, you will be given a warning.

☐ The browser will not check whether an address is on the black list of fraudulent websites. (default)

Malware protection

☑ The browser will check before a file is downloaded whether the relevant website can be found in the black list of 
fraudulent websites which provide malware for downloading. If this is the case, you will be given a warning.

☐ The browser will not check whether an address is on the black list of fraudulent websites which provide malware 
for downloading. (default)
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Advanced
Menu path: Sessions > Browser > Browser Global > Advanced

In this area, you can change various settings as well as add or change custom configuration parameters.

You can change the following settings:

Use old search bar

☑ The logo of the search engine currently set will be shown in the search window.

☐ The search engine currently set will not be shown in the search window, and search suggestions will be shown in 
the drop-down menu. (default)

Caret browsing on browser start

☑ Caret browsing is enabled when the browser starts. If caret browsing is enabled, you can navigate with the 
keyboard in websites without using the mouse. With the insertion mark, you can copy text to the clipboard.

☐ Caret browsing is not enabled when the browser starts. (default)

Find as you type

☑ Search suggestions that match the characters typed will be shown while you type.

☐ No search suggestions will be shown while you type. (default)

Warn me when websites try to redirect or reload the page

☑ A message window will be shown as soon as a website tries to get the browser to load another website or reload 
the current page.

☐ No message window will be shown if a website tries to load another website or reload the current page. (default)

Check my spelling as I type
Possible options:

"Off": Your spelling will not be checked while you type.
"On for text fields": Your spelling will be checked if you are typing in text fields with multiple lines. 
(default)
"On for text fields and lines": Your spelling will be checked if you are typing in text fields with one 
line or multiple lines.

Use autoscrolling

☑ You can launch automatic page scrolling by clicking on the middle mouse button to place a scroll symbol in the 
text and then positioning the mouse pointer above or below the anchor.

☐ Autoscrolling is disabled. (default)

Use smooth scrolling

☑ You can browse through a page using the [Page Up/Down] keys smoothly as with scrolling.

You can enable or disable caret browsing at any time by pressing [F7]. To prevent caret browsing being 
disabled, you will also need to enable the Setup > Sessions > Browser > Browser Sessions > [Session 
Name] > Settings > Hotkeys > Disable Hotkeys for Starting Caret Browsing option.


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☐ When you press the [Page Up/Down] keys, the display will jump immediately. (default)

Disable GStreamer in Browser

☑ GStreamer will not be used to play back videos. This may be a good idea if you experience problems when 
playing back videos.

☐ GStreamer will be used to play back videos.

Disable OpenGL acceleration

☑ Hardware acceleration with OpenGL will not be used. This may be a good idea if you experience problems with 
OpenGL applications.

To add a custom preference, proceed as follows:

Custom Preferences
In this area, you can add custom preferences.

 Click  to get to the Add dialogue.

In the Add dialogue, you can define the following settings:

Active: Defines whether the preference is active.

☑ The preference is active. (Default)

☐ The preference is not active.

Mode: The mode of the preference.
Possible values:

"pref": You can change the value in the browser via about:config . When the browser restarts, 
this change will be lost and the value set here will be used.
"defaultPref": You can change the value in the browser via about:config . When the browser 
restarts, this change will remain.
"lockPref": You cannot change the value in the browser via about:config .

We recommend that you disable this option if there is no multimedia codec pack installed on your thin 
client and you wish to view videos on HTML5 websites.



Changes to the advanced Firefox browser settings can impair its stability, security and speed. IGEL Support 
is not responsible for problems caused by changing the browser configuration, even if the browser 
configuration was changed in the IGEL setup.



Custom preferences can also be changed in the browser via about:config . To do this, the Browser 
Sessions > [Session Name] > Window Settings > Hide Browser Configuration Page option must be 
disabled.


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"clearPref": You cannot change the value in the browser via about:config  and the value will 

not be shown via about:config.

Custom preference: The name of the custom preference. Example: ui.textSelectBackground

Type: The type of the custom preference. 
Possible values:

"String": The value is a string of characters.
"Integer": The value is a whole number.
"Boolean": The value is a Boolean value, i.e. true  or false .

Value: The value of the custom preference. The possible entries depend on the Type selected.

 Click Ok to add the custom preference.
The custom preference will take effect the next time that the browser is launched.

You will find information regarding custom preferences in Firefox in the MozillaZine Knowledge Base under Firefox 
About:config entries15.

http://kb.mozillazine.org/About:config_entries
http://kb.mozillazine.org/About:config_entries
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Encryption
Menu path: Sessions > Browser > Browser Global > Encryption

In this area, you can define the settings for encryption methods.

Minimum required encryption protocol: This protocol will be used to establish a secure connection if no higher 
protocol is available. Higher protocols are preferred.
Possible options:

SSL3
TLS 1.0
TLS 1.1
TLS 1.2

Maximum supported encryption protocol: This protocol is requested when negotiating the connection. If this 
protocol is not available, the next lowest protocol will be requested.
Possible options:

SSL3
TLS 1.0
TLS 1.1
TLS 1.2
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Certificates
Menu path: Sessions > Browser > Browser Global > Certificates

In this area, you can define the settings for certificate validation.

When a website requests a certificate: Specifies how the browser behaves if a website requests a security 
certificate.
Possible values:

Select one automatically: The browser selects a certificate automatically. (default)
Ask me every time: A dialog window requesting the certificate will be displayed.

View certificates: If you click on this button, the certificates saved in the browser's Certificate Manager will be 
displayed.

Certificate validation: Specifies the validation of certificates using OCSP (Online Certificate Status Protocol).

Do not use OCSP for certificate validation: The certificate will not be validated using OCSP.
Validate a certificate if it specifies an OCSP server: The certificate will be validated with the OCSP 
server specified in the certificate. If no OCSP server is specified, no certificate validation will take 
place. (default)
Validate all certificates with the following OCSP server: All certificates will be validated with the 
OCSP server specified under the Service URL, irrespective of which OCSP server is specified in the 
certificate.

Response signer: Signer of the response from the OCSP server

Service URL: URL of the OCSP server

When an OCSP server connection fails, treat the certificate as invalid:

☑ If, owing to a failed connection to the OCSP server, no validation can take place, the certificate will be treated as 
invalid. In this case, the browser will show the “This connection is not trusted” error message.

☐ The certificate will not be deemed invalid if no check can take place because there is no connection to the OSCP 
server. (default)
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Smartcard Middleware
Menu path: Sessions > Browser > Browser Global > Smartcard Middleware
In this area, you can activate or deactivate smartcard middleware that is to be used for encryption.
Gemalto SafeNet security device

☑ Gemalto/SafeNet eToken will be used for encryption.

☐ Gemalto/SafeNet eToken will not be used for encryption. (Default)

cryptovision sc/interface security device

☑ cryptovision sc/interface will be used for encryption.

☐ cryptovision sc/interface will not be used for encryption. (Default)

Gemalto IDPrime security device

☑ Gemalto IDPrime will be used for encryption. Enable this Gemalto middleware when you want to operate 
Gemalto Common Criteria devices in unlinked mode.

☐ Gemalto IDPrime will not be used for encryption. (Default)

Athena IDProtect security device

☑ Athena IDProtect will be used for encryption.

☐ Athena IDProtect will not be used for encryption. (Default)

A.E.T. SafeSign security device

☑ A.E.T. SafeSign will be used for encryption.

☐ A.E.T. SafeSign will not be used for encryption. (Default)

SecMaker Net iD security device

☑ SecMaker Net iD will be used for encryption.

☐ SecMaker Net iD will not be used for encryption. (Default)

Coolkey security device

☑ Coolkey will be used for encryption.

☐ Coolkey will be not used for encryption. (Default)

OpenSC security device

☑ OpenSC will be used for encryption.

☐ OpenSC will not be used for encryption. (Default)
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Restart
Menu path: Sessions > Firefox Browser > Firefox Browser Global > Restart

In this area, you can specify whether the browser automatically starts and whether it is automatically restarted 
after being closed and after what delay time.

Restart

☑ The browser automatically restarts if it was closed.

☐ The browser does not automatically restart if it was closed. (default)

Restart after idle time

☑ If no action on the part of the user has occurred after the idle time has elapsed, the browser will automatically 
be restarted.

☐ There will be no automatic restart after a specific idle time has elapsed. (default)

Idle time after which a restart occurs: Time interval after which the browser is automatically restarted if in the 
meantime no action on the part of the user has occurred. (default: 5) 
The time unit can be selected under Unit.

Unit: Time interval for the idling time
Possible options:

Minutes
Seconds
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Window
Menu path: Sessions > Firefox Browser > Firefox Browser Global > Window

In this area, you can define the window settings for a browser session.

Start in full-screen mode

☑ The browser will start in fullscreen mode.

☐ The browser will start in a standard window. (default)

Firefox translation: Language of the user interface
Possible values:

System setting: The language set under User Interface > Language > Language will be used for 
the browser. (default)
English
German
French
Dutch
Spanish
Italian

Hide configuration page of the browser

☑ The browser configuration page ( about:config ) is locked. As a result, the user cannot change the 
configuration. (default)

☐ The browser configuration page ( about:config ) can be used.
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Menus & Toolbars
Menu path: Sessions > Firefox Browser > Firefox Browser Global > Menus & Toolbars

In this area, you can change the browser’s menus and toolbars.

Hide app menu/menu bar

☑ The button for opening the browser menu will not be shown.

☐ The button for opening the browser menu will be shown. (default)

Use old menu bar

☑ The browser menu will be shown in the menu bar as in earlier browser versions.

☐ The browser menu can be opened via a button. (default)

Hide the Following Items in App Menu/Menu Bar
Hide bookmarks menu

☑ The bookmarks menu will not be shown in the menu bar.

☐ The bookmarks menu will be shown in the menu bar. (default)

Hide tools menu

☑ The “Tools” menu will not be shown.

☐ The “Tools” menu will be shown. (default)

Hide history entry

☑ The button for showing the browser history will not be shown.

☐ The button for showing the browser history will be shown. (default)

Hide tabs toolbar

☑ The tabs will not be shown in the menu bar. The user cannot switch between a number of tabs.

☐ The tabs will be shown in the menu bar. (default)

Hide bookmarks toolbar

☑ The bookmarks toolbar will not be shown. (default)

☐ The bookmarks toolbar will be shown.

Hide sidebar

☑ The sidebar will not be shown.

☐ The sidebar will be shown. The bookmarks can be shown in the sidebar. (default)

Hide navigation toolbar

☑ The navigation bar will not be shown.

☐ The navigation bar will be shown. (default)

Hide the toolbar for searching the page
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☑ The search bar will not be shown.

☐ The search bar will be shown. (default)

Toolbar Items
Hide URL input

☑ Only search terms can be entered in the entry field; URLs cannot be entered manually.

☐ Both search terms and URLs can be entered in the entry field. (default)

Hide "Print" button

☑ The button for printing websites will not be shown.

☐ The button for printing websites will be shown. (default)

Hide "Home" button

☑ The Home button will not be shown.

☐ The Home button will be shown. (default)

Hide "Search" input

☑ The search field will not be shown.

☐ The search field will be shown. (default)

Hide “Bookmarks” and “RSS Feed” button

☑ The button for displaying bookmarks and RSS feeds will not be shown.

☐ The button for displaying bookmarks and RSS feeds will be shown. (default)

Toolbarconfig
User customization of toolbars

☑ The user can customize the toolbars. (default)

☐ The user cannot customize the toolbars.

Navigation toolbar: Specifies which symbols are shown in the navigation toolbar. The symbols are given as 
follows; multiple symbols should be separated by commas “,”:

loop-button

zoom-controls

edit-controls

history-panelmenu
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privatebrowsing-button

save-page-button

find-button

open-file-button

developer-button

sidebar-button

feed-button

print-button

characterencoding-button

social-share-button

panic-button

web-apps-button

new-window-button

fullscreen-button

tabview-button

downloads-button

Application menu: Specifies which symbols are shown in the application menu. Multiple symbols should be 
separated by commas “,”.
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Hotkeys
Menu path: Sessions > Firefox Browser > Firefox Browser Global > Hotkeys

In this area, you can disable Firefox hotkeys.

Disable hotkey Quit/Close

☑ The hotkey for terminating/closing the browser is disabled.

☐ The hotkey for terminating/closing the browser is enabled. (default)

Disable hotkey for print dialog

☑ The hotkey for opening the print dialog is disabled.

☐ The hotkey for opening the print dialog is enabled. (default)

Disable hotkey for save page

☑ The hotkey for saving a website is disabled.

☐ The hotkey for saving a website is enabled. (default)

Disable hotkeys for opening new window/tab

☑ The hotkey for opening a new window or tab is disabled.

☐ The hotkey for opening a new window or tab is enabled. (default)

Disable hotkeys for opening a new webpage/location and download window

☑ The hotkey for opening a new website/location and the download window is disabled.

☐ The hotkey for opening a new website/location and the download window is enabled. (default)

Disable hotkeys to show history and page info

☑ The hotkey for showing the history and page information is disabled.

☐ The hotkey for showing the history and page information is enabled. (default)

Disable hotkeys for creating bookmarks

☑ The hotkey for creating a bookmark is disabled.

☐ The hotkey for creating a bookmark is enabled. (default)

Disable hotkeys for opening help pages

☑ The hotkey for displaying help is disabled.

☐ The hotkey for displaying help is enabled. (default)

Disable hotkeys for caret browsing

☑ The hotkey for starting caret browsing is disabled.

☐ The hotkey for starting caret browsing is enabled. (default)
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Context
Menu path: Sessions > Firefox Browser > Firefox Browser Global > Context

In this area, you can disable various items in the browser context menu.

Disable navigation elements in context menu

☑ The navigation elements will not be shown in the context menu.

☐ The navigation elements will be shown in the context menu. (default)

Disable button for save page

☑ The button for saving a page will not be shown in the context menu.

☐ The button for saving a page will be shown in the context menu. (default)

Disable button for open new window/tab

☑ The button for opening a new window/tab will not be shown in the context menu.

☐ The button for opening a new window/tab will be shown in the context menu. (default)

Disable button for show info/source

☑ The button for showing page information/page source text will not be shown in the context menu.

☐ The button for showing page information/page source text will be shown in the context menu. (default)

Disable button for creating and editing bookmarks

☑ The button for creating and editing bookmarks will not be shown in the context menu.

☐ The button for creating and editing bookmarks will be shown in the context menu. (default)

Disable button for searching the web

☑ The button for searching the web will not be shown in the context menu.

☐ The button for searching the web will be shown in the context menu. (default)

Hide the browser's context menu

☑ The context menu will not be shown.

☐ The context menu will be shown. (default)
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1.
2.

Commands
Menu path: Sessions > Browser > Browser Global > Commands

In this area, you can define start options for browser commands.

The following commands are available:

Restart Browser

To open the dialogue for defining start options, proceed as follows:

Select the command. Example: Restart Browser
Click Modify...

The following start options are available:

Start menu

☑ The session can be launched from the start menu.

Application Launcher

☑ The session can be launched with the Application Launcher.

Desktop

☑ The session can be launched with a program launcher on the desktop.

Quick start panel

☑ The session can be launched with the quick start panel.

Start menu's system tab

☑ The session can be launched with the start menu's system tab.

Application Launcher's system tab

☑ The session can be launched with the Application Launcher's system tab.

Desktop context menu

☑ The session can be launched with the desktop context menu.

Menu folder: If you specify a folder name or a path comprising a number of folder names separated by "/", a menu 
path will be created for the session. The menu path will be used in the start menu and in the desktop context menu.

Application Launcher folder: If you specify a folder name or a path comprising a number of folder names 
separated by "/", a menu path will be created for the session. The menu path will be used in the Application 
Launcher.

Desktop folder: If you specify a folder name or a path comprising a number of folder names separated by "/", a 
menu path will be created for the session. The menu path will be used for the program launcher on the desktop.

Password protection: Specifies which password will be requested when launching the session.
Possible values:
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None: No password is requested when launching the session.
Administrator: The administrator password is requested when launching the session.
User: The user password is requested when launching the session.
Setup user: The setup user's password is requested when launching the session.

Hotkey

☑ The session can be started with a hotkey. A hotkey consists of one or more modifiers and a key.

Modifiers: A modifier or a combination of several modifiers for the hotkey. You can select a set key symbol/
combination or your own key symbol/combination. A key symbol is a defined chain of characters, e.g.  Ctrl .

These are the pre-defined modifiers and the associated key symbols:

(No modifier) =  None

 =  Shift
[Ctrl] =  Ctrl

 =  Mod4

[Alt] =  Alt

Key combinations are formed as follows with  | :

Ctrl +   =  Ctrl|Super_L

Key: Key for the hotkey

Do not use [AltGr] as a modifier (represented as Mod5 ). Otherwise, the key that is configured as a hotkey 
with AltGr cannot be used as a regular key anymore. Example: If you configure [AltGr] + [E] as a hotkey, it is 
impossible to enter an "e".



When this keyboard key is used as a modifier, it is represented as Mod4 ; when it is used as a key, it 

is represented as Super_L .



To enter a key that does not have a visible character, e. g. the [Tab] key, open a terminal, log on as user

and enter xev -event keyboard . Press the key to be used for the hotkey. The text in brackets that 

begins with keysym  contains the key symbol for the Key field. Example: Tab  in (keysym 0xff09, 

Tab)


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Browser Session
Menu path: Sessions > Browser > Browser Sessions > [Session Name]

In this area, you can configure desktop integration for the browser session.

Session name: Name for the session.

Starting Methods for Session
Start menu

☑ The session can be launched from the start menu.

Application Launcher

☑ The session can be launched with the Application Launcher.

Desktop

☑ The session can be launched with a program launcher on the desktop.

Quick start panel

☑ The session can be launched with the quick start panel.

Start menu's system tab

☑ The session can be launched with the start menu's system tab.

Application Launcher's system tab

☑ The session can be launched with the Application Launcher's system tab.

Desktop context menu

☑ The session can be launched with the desktop context menu.

Menu folder: If you specify a folder name or a path comprising a number of folder names separated by "/", a menu 
path will be created for the session. The menu path will be used in the start menu and in the desktop context menu.

Desktop folder: If you specify a folder name or a path comprising a number of folder names separated by "/", a 
menu path will be created for the session. The menu path will be used for the program launcher on the desktop.

Password protection: Specifies which password will be requested when launching the session.
Possible values:

None: No password is requested when launching the session.
Administrator: The administrator password is requested when launching the session.
User: The user password is requested when launching the session.
Setup user: The setup user's password is requested when launching the session.

Hotkey

The session name must not contain any of these characters: \ / : * ? “ < > | [ ] { } ( )
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☑ The session can be started with a hotkey. A hotkey consists of one or more modifiers and a key.

Modifiers: A modifier or a combination of several modifiers for the hotkey. You can select a set key symbol/
combination or your own key symbol/combination. A key symbol is a defined chain of characters, e.g.  Ctrl .

These are the pre-defined modifiers and the associated key symbols:

(No modifier) =  None

 =  Shift
[Ctrl] =  Ctrl

 =  Mod4

[Alt] =  Alt

Key combinations are formed as follows with  | :

Ctrl +   =  Ctrl|Super_L

Key: Key for the hotkey

Autostart

☑ The session will be launched automatically when the device boots.

Restart

☑ The session will be restarted automatically after the termination.

Autostart delay: Waiting time in seconds between the complete startup of the desktop and the automatic session 
launch.

Autostart requires network

Do not use [AltGr] as a modifier (represented as Mod5 ). Otherwise, the key that is configured as a hotkey 
with AltGr cannot be used as a regular key anymore. Example: If you configure [AltGr] + [E] as a hotkey, it is 
impossible to enter an "e".



When this keyboard key is used as a modifier, it is represented as Mod4 ; when it is used as a key, it 

is represented as Super_L .



To enter a key that does not have a visible character, e. g. the [Tab] key, open a terminal, log on as user

and enter xev -event keyboard . Press the key to be used for the hotkey. The text in brackets that 

begins with keysym  contains the key symbol for the Key field. Example: Tab  in (keysym 0xff09, 

Tab)


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☑ If no network is available at system startup, the session is not started. A message is shown. As soon as the 
network is available, the session is started automatically.

☐ The session is started automatically, even when no network is available.

Settings (see page 414)
Window (see page 424)
Menus & Toolbars (see page 425)
Hotkeys (see page 428)
Context (see page 429)
Desktop Integration (see page 430)
Plugins (see page 433)
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Settings
Menu path: Browser > Browser Sessions > [Session Name] > Settings

In this area, you can define the start page, display resolution and font size for the browser.

You can change the following settings:

When browser starts: Specifies what pages are shown when the browser is launched.
Global setting
Start with a blank page
Show my home page
Resume previous session: All tabs from the last session are reopened.

Home page: Specifies the URL of the start page. You can specify a number of start pages by 
separating the URLs of the start pages with a vertical dash "|".
Display resolution: Specifies the display resolution for the browser in DPI. Typical values are 72 
for medium screens and 96 for large screens.
Possible values:

Global setting
System setting
(Various discreet values)

Minimum font size: Specifies the minimum size of the fonts displayed on websites. The formats of 
the websites are overwritten in the process.
Possible values:

Global setting
None: The fonts can be as small as you like. (default)
(Various discreet values)

Tabs (see page 415)
Content (see page 416)
Print (see page 417)
Proxy (see page 418)
Privacy (see page 419)
Security (see page 420)
Advanced (see page 421)
Encryption (see page 422)
Restart (see page 423)
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Tabs
Menu path: Setup > Sessions > Browser > Browser Sessions > [Session Name] > Settings > Tabs

In this area, you can define settings for the browser tabs.

You will find a description under the global settings, see Tabs (see page 386).



Sessions

IGEL OS Reference Manual   416 / 897

Content
Menu path: Setup > Sessions > Browser > Browser Sessions > [Session Name] > Settings > Content

In this area, you can change settings regarding popups, JavaScript, downloads and the browser display.

You will find a description under the global settings, see Content (see page 387).

Exceptions for the blocking of popups and for the automatic loading of images can only be defined in the 
global settings.


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Print
Menu path: Setup > Browser > Browser Sessions > [Session Name] > Settings > Print

In this area, you can set the default paper size for the printer.

You will find a description under the global settings, see Printing (see page 389).
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Proxy
Menu path: Setup > Sessions > Browser > Browser Sessions > [Session Name] > Settings > Proxy

In this area, you can change the proxy configuration.

You will find a description under the global settings, see Proxy (see page 390).
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Privacy
Menu path: Setup > Sessions > Browser > Browser Sessions > [Session Name] > Settings > Privacy

In this area, you can configure settings relevant to data protection.

You will find a description under the global settings, see Data Protection (see page 393).
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Security
Menu path: Setup > Sessions > Browser > Browser Sessions > [Session Name] > Settings > Security

In this area, you can define settings for phishing and malware.

You will find a description under the global settings, see Security (see page 395).
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Advanced
Menu path: Setup > Sessions > Browser > Browser Sessions > [Session Name] > Settings > Advanced

In this area, you can change various settings.

You will find a description under the global settings, see Advanced (see page 396).

Custom configuration parameters can only be added and OpenGL acceleration disabled in the global 
settings.


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Encryption
Menu path: Setup > Sessions > Browser > Browser Sessions > [Session Name] > Settings > Encryption

In this area, you can define the settings for encryption methods and certificate validation.

You will find a description under the global settings, see Encryption (see page 399).
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Restart
Menu path: Setup > Sessions > Browser > Browser Sessions > [Session Name] > Settings > Restart

In this area, you can specify whether the browser automatically starts and whether it is automatically restarted 
after being closed and after what delay time.

Autostart
☑ The browser starts automatically when the thin client starts.
☐ The browser does not start automatically when the thin client starts. (default)
Restart
☑ The browser automatically restarts if it was closed.
☐ The browser does not automatically restart if it was closed. (default)
Restart after idle time: This function is available from IGEL Linux Version 10.02.
☑ If no action on the part of the user has occurred after the idle time has elapsed, the browser will 
automatically be restarted.
☐ There will be no automatic restart after a specific idle time has elapsed. (default)
Idle time after which a restart occurs: Time interval after which the browser is automatically 
restarted if in the meantime no action on the part of the user has occurred. (default: 5) 
The time unit can be selected under Unit.
Unit: Time interval for the idling time
Possible options:

Minutes
Seconds
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Window
Menu path: Setup > Sessions > Browser > Browser Sessions > [Session Name] > Window

In this area, you can define the window settings for a browser session.

Start in fullscreen mode
☑ The browser will start in fullscreen mode.
☐ The browser will start in a standard window. (default)
Start monitor: Specifies the monitor on which the browser window is shown when the browser 
starts.
Possible options:

No configuration: The browser window will be shown on the monitor that is currently in 
focus, i.e. the one with the mouse pointer.
1st monitor
2nd monitor

Firefox translation: Language of the user interface
Possible values:

System setting: The language set under Setup > User Interface > Language > Language 
will be used for the browser. (default)
English
German
French
Dutch
Spanish
Italian

Hide local filesystem
☑ The local file system will not be shown in the dialogs for saving data. The user cannot change 
the location for saving files.
☐ The local file system will be shown in the dialogs for saving data. (default)
Hide configuration page of the browser
☑ The browser configuration page ( about:config ) is locked. As a result, the user cannot 
change the configuration. (default)
☐ The browser configuration page ( about:config ) can be used.
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Menus & Toolbars
Menu path: Setup > Sessions > Browser > Browser Sessions > [Session Name] > Menus & Toolbars

In this area, you can change the browser’s menus and toolbars.

Hide app menu/menu bar
☑ The button for opening the browser menu will not be shown.
☐ The button for opening the browser menu will be shown. (default)
Use old menu bar
☑ The browser menu will be shown in the menu bar as in earlier browser versions.
☐ The browser menu can be opened via a button. (default)

Hide the following elements in app menu/menu bar

Hide bookmarks menu
☑ The bookmarks menu will not be shown in the menu bar.
☐ The bookmarks menu will be shown in the menu bar. (default)
Hide tools menu
☑ The “Tools” menu will not be shown.
☐ The “Tools” menu will be shown. (default)
Hide history entry
☑ The button for showing the browser history will not be shown.
☐ The button for showing the browser history will be shown. (default)
Hide tabs toolbar
☑ The tabs will not be shown in the menu bar. The user cannot switch between a number of tabs.
☐ The tabs will be shown in the menu bar. (default)
Hide bookmarks toolbar
☑ The bookmarks toolbar will not be shown. (default)
☐ The bookmarks toolbar will be shown.
Hide sidebar
☑ The sidebar will not be shown.
☐ The sidebar will be shown. The bookmarks can be shown in the sidebar. (default)
Hide navigation toolbar
☑ The navigation bar will not be shown.
☐ The navigation bar will be shown. (default)
Hide the toolbar for searching the page
☑ The search bar will not be shown.
☐ The search bar will be shown. (default)

Toolbar Items

Hide URL input
☑ Only search terms can be entered in the entry field; URLs cannot be entered manually.
☐ Both search terms and URLs can be entered in the entry field. (default)
Hide "Print" button
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☑ The button for printing websites will not be shown.
☐ The button for printing websites will be shown. (default)
Hide "Home" button
☑ The Home button will not be shown.
☐ The Home button will be shown. (default)
Hide "Search" input
☑ The search field will not be shown.
☐ The search field will be shown. (default)
Hide “Bookmarks” and “RSS Feed” button
☑ The button for displaying bookmarks and RSS feeds will not be shown.
☐ The button for displaying bookmarks and RSS feeds will be shown. (default)
User customization of toolbars
☑ The user can customize the toolbars. (default)
☐ The user cannot customize the toolbars.
Navigation toolbar: Specifies which symbols are shown in the navigation toolbar and the 
application menu. The symbols are given as follows; multiple symbols should be separated by 
commas “,”:

loop-button

zoom-controls

edit-controls

history-panelmenu

privatebrowsing-button

save-page-button

find-button

open-file-button

developer-button

sidebar-button

feed-button
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print-button

characterencoding-button

social-share-button

panic-button

web-apps-button

new-window-button

fullscreen-button

tabview-button

downloads-button
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Hotkeys
Menu path: Setup > Sessions > Browser > Browser Sessions > [Session Name] > Hotkeys

In this area, you can disable Firefox hotkeys.

Disable hotkey Quit/Close
☑ The hotkey for terminating/closing the browser is disabled.
☐ The hotkey for terminating/closing the browser is enabled. (default)
Disable hotkey for print dialog
☑ The hotkey for opening the print dialog is disabled.
☐ The hotkey for opening the print dialog is enabled. (default)
Disable hotkey for save page
☑ The hotkey for saving a website is disabled.
☐ The hotkey for saving a website is enabled. (default)
Disable hotkeys for opening new window/tab
☑ The hotkey for opening a new window or tab is disabled.
☐ The hotkey for opening a new window or tab is enabled. (default)
Disable hotkeys for opening a new webpage/location and download window
☑ The hotkey for opening a new website/location and the download window is disabled.
☐ The hotkey for opening a new website/location and the download window is enabled. (default)
Disable hotkeys to show history and page info
☑ The hotkey for showing the history and page information is disabled.
☐ The hotkey for showing the history and page information is enabled. (default)
Disable hotkeys for creating bookmarks
☑ The hotkey for creating a bookmark is disabled.
☐ The hotkey for creating a bookmark is enabled. (default)
Disable hotkeys for opening help pages
☑ The hotkey for displaying help is disabled.
☐ The hotkey for displaying help is enabled. (default)
Disable hotkeys for starting caret browsing
☑ The hotkey for starting caret browsing is disabled.
☐ The hotkey for starting caret browsing is enabled. (default)
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Context
Menu path: Setup > Sessions > Browser > Browser Sessions > [Session Name] > Hotkeys

In this area, you can disable various items in the browser context menu.

Disable navigation elements in context menu
☑ The navigation elements will not be shown in the context menu.
☐ The navigation elements will be shown in the context menu. (default)
Disable button for save page
☑ The button for saving a page will not be shown in the context menu.
☐ The button for saving a page will be shown in the context menu. (default)
Disable button for open new window/tab
☑ The button for opening a new window/tab will not be shown in the context menu.
☐ The button for opening a new window/tab will be shown in the context menu. (default)
Disable button for show info/source
☑ The button for showing page information/page source text will not be shown in the context 
menu.
☐ The button for showing page information/page source text will be shown in the context menu. 
(default)
Disable button for creating and editing bookmarks
☑ The button for creating and editing bookmarks will not be shown in the context menu.
☐ The button for creating and editing bookmarks will be shown in the context menu. (default)
Disable button for searching the web
☑ The button for searching the web will not be shown in the context menu.
☐ The button for searching the web will be shown in the context menu. (default)
Hide the browser's contextmenu
☑ The context menu will not be shown.
☐ The context menu will be shown. (default)
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Desktop Integration
Menu path: Sessions > Browser > Browser Sessions > [Session Name] > Desktop Integration

In this area, you can configure desktop integration for the Firefox browser session.

Session name: Name for the session.

Starting Methods for Session
Start menu

☑ The session can be launched from the start menu.

Application Launcher

☑ The session can be launched with the Application Launcher.

Desktop

☑ The session can be launched with a program launcher on the desktop.

Quick start panel

☑ The session can be launched with the quick start panel.

Start menu's system tab

☑ The session can be launched with the start menu's system tab.

Application Launcher's system tab

☑ The session can be launched with the Application Launcher's system tab.

Desktop context menu

☑ The session can be launched with the desktop context menu.

Menu folder: If you specify a folder name or a path comprising a number of folder names separated by "/", a menu 
path will be created for the session. The menu path will be used in the start menu and in the desktop context menu.

Desktop folder: If you specify a folder name or a path comprising a number of folder names separated by "/", a 
menu path will be created for the session. The menu path will be used for the program launcher on the desktop.

Password protection: Specifies which password will be requested when launching the session.
Possible values:

None: No password is requested when launching the session.
Administrator: The administrator password is requested when launching the session.
User: The user password is requested when launching the session.
Setup user: The setup user's password is requested when launching the session.

Hotkey

The session name must not contain any of these characters: \ / : * ? “ < > | [ ] { } ( )
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☑ The session can be started with a hotkey. A hotkey consists of one or more modifiers and a key.

Modifiers: A modifier or a combination of several modifiers for the hotkey. You can select a set key symbol/
combination or your own key symbol/combination. A key symbol is a defined chain of characters, e.g.  Ctrl .

These are the pre-defined modifiers and the associated key symbols:

(No modifier) =  None

 =  Shift
[Ctrl] =  Ctrl

 =  Mod4

[Alt] =  Alt

Key combinations are formed as follows with  | :

Ctrl +   =  Ctrl|Super_L

Key: Key for the hotkey

Autostart

☑ The session will be launched automatically when the device boots.

Restart

☑ The session will be restarted automatically after the termination.

Autostart delay: Waiting time in seconds between the complete startup of the desktop and the automatic session 
launch.

Autostart requires network

Do not use [AltGr] as a modifier (represented as Mod5 ). Otherwise, the key that is configured as a hotkey 
with AltGr cannot be used as a regular key anymore. Example: If you configure [AltGr] + [E] as a hotkey, it is 
impossible to enter an "e".



When this keyboard key is used as a modifier, it is represented as Mod4 ; when it is used as a key, it 

is represented as Super_L .



To enter a key that does not have a visible character, e. g. the [Tab] key, open a terminal, log on as user

and enter xev -event keyboard . Press the key to be used for the hotkey. The text in brackets that 

begins with keysym  contains the key symbol for the Key field. Example: Tab  in (keysym 0xff09, 

Tab)


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☑ If no network is available at system startup, the session is not started. A message is shown. As soon as the 
network is available, the session is started automatically.

☐ The session is started automatically, even when no network is available.
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Plugins
Menu path: Sessions > Browser > Plugins

The following plugins are available:

Adobe Flash Player 2

The plugin may need to be licensed.

To obtain an overview of the plugins available in the browser, proceed as follows:

 Click on the About:Plugins button.
The browser will start with the about:plugins  page. The plugins available in the browser will be shown.

Flashplayer (see page 434)
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Flashplayer
Menu path: Setup > Sessions > Browser > Plugins > Flashplayer

Before you can download and install Adobe Flash Player, you need to confirm the licensing of the software. IGEL 
Linux does not include a license for using the Flash Player.

 Enable the option I will license the Flash Player myself in order to enable Setup > Sessions > Browser > 
Browser Sessions > [Session Name] > Plugins > Flash Player > Download Flash Player.

_____

Download Flashplayer (see page 435)
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2.
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3.

Download Flashplayer

Menu path: Setup > Sessions > Browser > Plugins > Flash Player > Download Flashplayer

To install Adobe Flash Player, proceed as follows:

Enable the option I want to update to the current Flash Player and care for the license by 
myself.
Configure the following settings:

Use firmware update settings for download
☑ The parameters User authentication, User name, Password and Download URL
receive the preset values and cannot be changed.
☐ The parameters User authentication, User name, Password and Download URL are set 
here. (default)
User authentication
☑ The thin client authenticates itself on the server with the access data given under User 
name and Password.
☐ No automatic user authentication. (default)
Download URL: URL of the directory in which the file for the Adobe Flash Player is located. 
(default: The official link from Adobe) Alternatively, you can specify the location in your 
company network.

Download file: Name of the file that contains the Adobe Flash Player.
Click on Apply or OK.
The Adobe Flash Player will be downloaded and installed.

You can also launch the installation with the UMS context menu. In the context menu, select Other Thin 
Client Commands > Download Flash Player.



At the time of firmware publication, the Adobe link is correct. However, it may change. If 
the download fails, change the URL accordingly.


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Chromium Browser Global

Menu path: Sessions > Chromium Browser > Chromium Browser Global

Here, you can change settings that will be valid for all Chromium sessions.

Use IGEL Setup for configuration

☑ The settings made in the IGEL Setup or the UMS configuration dialog will be effective.

☐ The settings made in the IGEL Setup or the UMS configuration dialog will not have any effect on the behavior of 
Chromium.

Default web browser: Defines which browser will be chosen by the system,  e.g. for opening Citrix Storefront.
Possible options:

"Firefox Browser"
"Chromium Browser"

Automatic browser restart on exit

☑ Chromium is restarted when the user closes it.

☐ Chromium is not restarted on exit.

Show browser splash screen

☑ The Chromium splash screen is shown on start.

☐ Chromium starts without a splash screen.

General (see page 437)
Content (see page 438)
Proxy (see page 439)
Privacy (see page 441)
Security (see page 443)
Encryption (see page 444)
Menus & Toolbars (see page 445)
Window (see page 446)
Custom Setup (see page 447)
Smartcard Middleware (see page 450)

Please note that Chromium is an experimental feature. Full support cannot be provided yet.
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General

Menu path: Sessions > Chromium Browser > Chromium Browser Global > General

In this area, you can change the following settings:

On startup: Specifies what pages are shown when Chromium is launched.
Possible options:

"Open the new tab page"
"Open a specific page or set of pages": The page or set of pages specified under Startup page are 
opened.
"Continue where you left off": All tabs from the last session are reopened.

Startup page: Specifies the URL of the start page. You can specify a set of start pages by separating the URLs of the 
start pages with a vertical dash "|". This setting is active only when "Open a specific page or set of pages" is chosen 
under On startup.

New tab page setting: Specifies the page that is shown when a new tab is opened.
Possible options:

"Open a blank page"
"Open a specific page": The page defined under New tab page location is shown. 

New tab page location: Specifies the page that is shown when the user opens a new tab. This is effective only if 
New tab page setting is set to "Open a specific page".

Font size: Specifies the font size for web content.
Possible options:

"Very small"
"Small"
"Medium (recommended)"
"Large"
"Very large"

Please note that Chromium is an experimental feature. Full support cannot be provided yet.
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Content

Menu path: Sessions > Chromium Browser > Chromium Browser Global > Content

Block pop-ups and redirects

☑ Pop-up windows and redirects are blocked.

Exceptions...: Add websites on which pop-up windows and redirects are not blocked.

Load images automatically

☑ Images from websites are loaded automatically.

Exceptions...: Add websites on which images are not loaded automatically.

Type of download directory
Possible options:

"Custom location": The user will be prompted for a location to download a file.
"userhome": Files will be downloaded to /userhome/Downloads .

Location: Defines the path files are downloaded to. Only effective when Type of download directory is set to 
"Custom location". 

JavaScript

☑ JavaScript is enabled.

Languages: One or more preferred languages for multilingual websites, given in the form of language abbreviations 
separated by commas. The languages should be given in the order of preference. Example: With "de, en, fr, it", the 
website will be shown in German, if available, otherwise in English and so on.

Integrated translation service of Chromium

☑ When a web page has a language that differs from your system language, Chromium will offer to translate the 
page. 

Autoplay

☑ Embedded audio and video content on a web page is played automatically when the page is loaded.

☐ Audio and video content is not played automatically.

Please note that Chromium is an experimental feature. Full support cannot be provided yet.
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Proxy

Menu path: Sessions > Chromium Browser > Chromium Browser Global > Proxy

In this area, you can change the proxy configuration.

To change the proxy configuration, proceed as follows:

In the Proxy Configuration menu, select the type of proxy configuration.
The following proxy configurations are available:

"Never use a proxy"
"Use fixed proxy servers"
"Use a .pac proxy script"
"Use system proxy settings"
"Auto detect proxy settings"

Enter the necessary configuration data for the selected proxy configuration.

"Never use a proxy"
With this proxy configuration, no proxy is used.

"Use fixed proxy servers"
The configuration data must be specified in the following fields.

FTP proxy: URL of the proxy for FTP
Port: Port of the proxy for FTP
HTTP proxy: URL of the proxy for HTTP
Port: Port of the proxy for HTTP
SSL proxy: URL of the proxy for SSL
Port: Port of the proxy for SSL
SOCKS host: URL of the proxy for SOCKS
Port: Port of the proxy for SOCKS
SOCKS protocol version: Version of the SOCKS protocol used (default: SOCKS v5)
No proxy for: List of URLs for which no proxy is to be used (default: localhost, 127.0.0.1 )

"Use a .pac proxy script"
With this proxy configuration, the PAC file (Proxy Auto Config) available under URL will be used.

URL: URL of the proxy configuration file

Please note that Chromium is an experimental feature. Full support cannot be provided yet.
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"Use system proxy settings"
With this proxy configuration, the proxy configured under Network > Proxy will be used.

"Auto detect proxy settings"
With this proxy configuration, WPAD (Web Proxy Autodiscovery Protocol) will be used. The browser will determine 
the URL of the WPAD file wpad.dat  automatically with the help of DNS.
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Privacy

Menu path: Sessions > Chromium Browser > Chromium Browser Global > Privacy

Autofill addresses and more

☑ Entries in forms and search bars will be retained after Chromium restarts.

☐ Entries in forms and search bars will be retained only for the duration of the session.

Autofill payments

☑ Entries in payment forms will be retained after Chromium restarts.

☐ Entries in payment forms will be retained only for the duration of the session.

Autofill passwords

☑ Passwords entered will be retained after Chromium restarts.

☐ Passwords entered will be retained only for the duration of the session.

Clear browsing data

☑ Data entered will be deleted when Chromium is closed. What data are deleted is specified in the following 
options.

☐ Data entered will not be deleted when the browser is closed.

Browsing & download history

☑ Addresses (URLs) of visited websites and the list of downloads will be deleted when Chromium is closed.  

Saved passwords

☑ Passwords entered will be deleted when Chromium is closed. 

Cookies

☑ Cookies will be deleted when Chromium is closed.

Cache

☑ The cache for temporarily saving web pages will be emptied when Chromium is closed.

Allow incognito mode: When the incognito mode is active, all data from private windows will be deleted 
after Chromium is closed.

Possible options:

"Enabled": The user can open browser windows in incognito mode.
"Disabled": The user cannot open browser windows in incognito mode.
"Forced": All browser windows started by the user are in incognito mode.

Enable "Do Not Track" feature

☑ Chromium will inform the website you are visiting that you do not wish to be tracked, i.e. you do not want your 
surfing history to be recorded.

Please note that Chromium is an experimental feature. Full support cannot be provided yet.
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Enable search suggestions

☑ Suggestions will be shown while an address is being typed in the address bar. The suggestions will be based on 
previously visited websites which are stored in the history. 

The browser will use the DNT  ("Do Not Track") field in the HTTP header for this purpose. Observing this 
setting is voluntary; from a technical point of view, websites can still record the surfing history even when 
DNT  is set to 1.


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Security

Menu path: Sessions > Chromium Browser > Chromium Browser Global > Security

On this page, you can define settings for safe browsing and for the handling of files.

Safe browsing

☑ Chromium will check all web content, including e.g. images and scripts, against a continuously updated list of 
known phishing and malware websites. If Chromium finds suspicious content, you will be given a warning. 

☐ Chromium will not check web content. 

File access

☑ Chromium can access local files on the endpoint device. Downloads and uploads are allowed. Before a file is 
downloaded, a confirmation dialog is shown.

☐ Local files cannot be accessed by Chromium. Neither downloads nor uploads are allowed. When the user tries to 
download a file, a message informs the user that downloads are blocked.

Download allowlist: The MIME types listed here are not blocked even when File access is deactivated. The storage 
location is defined under Sessions > Chromium Browser > Chromium Browser Global > Content, parameter 
Location. If the file suffix matches with one of the entries in Open file types automatically after downloading, the 
file is opened immediately after download. The list entries are separated by semicolons ";".

Open file types automatically after downloading: Any file whose suffix is listed here will be opened immediately 
after download. The list entries are separated by semicolons ";".

Please note that Chromium is an experimental feature. Full support cannot be provided yet.
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Encryption

Menu path: Sessions > Chromium Browser > Chromium Browser Global > Encryption

In this area, you can define the settings for encryption methods.

Minimum SSL/TLS version: This protocol will be used to establish a secure connection if no higher protocol is 
available. Higher protocols are preferred.
Possible options:

TLS 1.0
TLS 1.1
TLS 1.2
TLS 1.3

Maximum SSL/TLS version: This protocol is requested when negotiating the connection. If this protocol is not 
available, the next lowest protocol will be requested.
Possible options:

TLS 1.2
TLS 1.3

Please note that Chromium is an experimental feature. Full support cannot be provided yet.
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Menus & Toolbars

Menu path: Sessions > Chromium Browser > Chromium Browser Global > Menus & Toolbars

In this area, you can change the browser’s menus and toolbars.

Hide home button

☑ The home button will not be shown.

☐ The home button will be shown.

Hide bookmarks toolbar

☑ The bookmarks menu will not be shown in the menu bar.

☐ The bookmarks menu will be shown in the menu bar.

Please note that Chromium is an experimental feature. Full support cannot be provided yet.
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Window

Menu path: Sessions > Chromium Browser > Chromium Global > Window

In this area, you can define the window settings for a Chromium session.

Enable kiosk mode

☑ Chromium starts in kiosk mode.

☐ Chromium starts in normal mode.

Start maximized

☑ Chromium starts in a maximized window.

☐ Chromium starts in a window with default size.

Chromium translation: Changes the default language when Chromium offers to translate a web page.

Block Chromium settings

☑ The settings menu of Chromium can not be accessed by the user.

☐ The user can access the settings menu.

Please note that Chromium is an experimental feature. Full support cannot be provided yet.
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Custom Setup

Menu path: Sessions > Chromium Browser > Chromium Browser Global > Custom Setup

Policies (see page 448)
Custom Command-Line Options (see page 449)

Please note that Chromium is an experimental feature. Full support cannot be provided yet.
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Policies

Menu path: Sessions > Chromium Browser > Chromium Browser Global >Custom Setup > Policies

Here, you can define policies for Chromium. For further information, see https://chromium.googlesource.com/
chromium/src/+/master/docs/enterprise/add_new_policy.md.

 Click on  Add to create a policy.

Policy name: Name of the policy

Policy value: Value of the policy

Please note that Chromium is an experimental feature. Full support cannot be provided yet.

https://chromium.googlesource.com/chromium/src/+/master/docs/enterprise/add_new_policy.md
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Custom Command-Line Options
Menu path: Sessions > Chromium Browser > Chromium Browser Global > Custom Setup > Custom Command-
Line Options

Here, you can define command-line parameters that are passed to Chromium on startup. The syntax is exactly the 
same as if Chromium would be started from a terminal. 

Custom command-line parameters: One or more command-line parameters. Multiple parameters are separated 
by whitespace.

Example:

--proxy-server="socks://localhost:8080" --incognito
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Smartcard Middleware

Menu path: Sessions > Chromium Browser > Chromium Browser Global > Smartcard Middleware

In this area, you can activate or deactivate smartcard middleware that is to be used for encryption.

Gemalto SafeNet security device

☑ Gemalto/SafeNet eToken will be used for encryption.

☐ Gemalto/SafeNet eToken will not be used for encryption.

cryptovision sc/interface security device

☑ cryptovision sc/interface will be used for encryption.

☐ cryptovision sc/interface will not be used for encryption.

Gemalto IDPrime security device

☑ Gemalto IDPrime will be used for encryption. Enable this Gemalto middleware when you want to operate 
Gemalto Common Criteria devices in unlinked mode.

☐ Gemalto IDPrime will not be used for encryption.

Athena IDProtect security device

☑ Athena IDProtect will be used for encryption.

☐ Athena IDProtect will not be used for encryption.

A.E.T. SafeSign security device

☑ A.E.T. SafeSign will be used for encryption.

☐ A.E.T. SafeSign will not be used for encryption.

SecMaker Net iD security device

☑ SecMaker Net iD will be used for encryption.

☐ SecMaker Net iD will not be used for encryption.

Coolkey security device

☑ Coolkey will be used for encryption.

☐ Coolkey will be not used for encryption.

OpenSC security device

☑ OpenSC will be used for encryption.

☐ OpenSC will not be used for encryption.

90meter security device

Please note that Chromium is an experimental feature. Full support cannot be provided yet.

Licensed Feature
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☑ 90meter will be used for encryption.

☐ 90meter will not be used for encryption.

Use a custom security device

☑ The PKCS#11 module stored under the Path to the library is used.

☐ The custom security device will not be used for encryption.

Name of the security device: Name of the custom security device that uses the library specified under Path to the 
library

Path to the library: Path to the custom PKCS#11 module

This feature requires an add-on license; see Add-On Licenses. Please contact your IGEL reseller.
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Chromium Sessions

Menu path: Sessions > Chromium Browser > Chromium Sessions > [Session Name]

In this area, you can configure desktop integration for the Chromium session.

Session name: Name for the session.

Starting Methods for Session
Start menu

☑ The session can be launched from the start menu.

Application Launcher

☑ The session can be launched with the Application Launcher.

Desktop

☑ The session can be launched with a program launcher on the desktop.

Quick start panel

☑ The session can be launched with the quick start panel.

Start menu's system tab

☑ The session can be launched with the start menu's system tab.

Application Launcher's system tab

☑ The session can be launched with the Application Launcher's system tab.

Desktop context menu

☑ The session can be launched with the desktop context menu.

Menu folder: If you specify a folder name or a path comprising a number of folder names separated by "/", a menu 
path will be created for the session. The menu path will be used in the start menu and in the desktop context menu.

Application Launcher folder: If you specify a folder name or a path comprising a number of folder names 
separated by "/", a menu path will be created for the session. The menu path will be used in the Application 
Launcher.

Desktop folder: If you specify a folder name or a path comprising a number of folder names separated by "/", a 
menu path will be created for the session. The menu path will be used for the program launcher on the desktop.

Hotkey

☑ The session can be started with a hotkey. A hotkey consists of one or more modifiers and a key.

Please note that Chromium is an experimental feature. Full support cannot be provided yet.

The session name must not contain any of these characters: \ / : * ? “ < > | [ ] { } ( )
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Modifiers: A modifier or a combination of several modifiers for the hotkey. You can select a set key symbol/
combination or your own key symbol/combination. A key symbol is a defined chain of characters, e.g.  Ctrl .

These are the pre-defined modifiers and the associated key symbols:

(No modifier) =  None

 =  Shift
[Ctrl] =  Ctrl

 =  Mod4

[Alt] =  Alt

Key combinations are formed as follows with  | :

Ctrl +   =  Ctrl|Super_L

Key: Key for the hotkey

Autostart

☑ The session will be launched automatically when the device boots.

Autostart delay: Waiting time in seconds between the complete startup of the desktop and the automatic session 
launch.

Autostart notification: This parameter is available if Autostart is activated and Autostart delay is set to a value 
greater than zero.

☑ For the duration defined by Autostart delay, a dialog is shown which allows the user to start the session 
immediately or cancel the automatic session start.

☐ No dialog is shown; the session is started automatically after the timespan specified with Autostart delay.

Do not use [AltGr] as a modifier (represented as Mod5 ). Otherwise, the key that is configured as a hotkey 
with AltGr cannot be used as a regular key anymore. Example: If you configure [AltGr] + [E] as a hotkey, it is 
impossible to enter an "e".



When this keyboard key is used as a modifier, it is represented as Mod4 ; when it is used as a key, it 

is represented as Super_L .



To enter a key that does not have a visible character, e. g. the [Tab] key, open a terminal, log on as user

and enter xev -event keyboard . Press the key to be used for the hotkey. The text in brackets that 

begins with keysym  contains the key symbol for the Key field. Example: Tab  in (keysym 0xff09, 

Tab)


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Settings (see page 455)
Desktop Integration (see page 456)
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Settings

Menu path: Sessions > Chromium Browser > Chromium Sessions > [Session Name] > Settings

In this area, you can change the following settings:

On startup: Specifies what pages are shown when Chromium is launched.
Possible options:

"Global setting"
"Open the new tab page"
"Open a specific page or set of pages": The page or set of pages specified under Startup page are 
opened.
"Continue where you left off": All tabs from the last session are reopened.

Startup page: Specifies the URL of the start page. You can specify a set of start pages by separating the URLs of the 
start pages with a vertical dash "|". This setting is active only when "Show my home page" is chosen under On 
startup.

Please note that Chromium is an experimental feature. Full support cannot be provided yet.
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Desktop Integration

Menu path: Sessions > Chromium Browser > Chromium Sessions > [Session Name] > Desktop Integration

In this area, you can configure desktop integration for the Chromium session.

Session name: Name for the session.

Starting Methods for Session
Start menu

☑ The session can be launched from the start menu.

Application Launcher

☑ The session can be launched with the Application Launcher.

Desktop

☑ The session can be launched with a program launcher on the desktop.

Quick start panel

☑ The session can be launched with the quick start panel.

Start menu's system tab

☑ The session can be launched with the start menu's system tab.

Application Launcher's system tab

☑ The session can be launched with the Application Launcher's system tab.

Desktop context menu

☑ The session can be launched with the desktop context menu.

Menu folder: If you specify a folder name or a path comprising a number of folder names separated by "/", a menu 
path will be created for the session. The menu path will be used in the start menu and in the desktop context menu.

Application Launcher folder: If you specify a folder name or a path comprising a number of folder names 
separated by "/", a menu path will be created for the session. The menu path will be used in the Application 
Launcher.

Desktop folder: If you specify a folder name or a path comprising a number of folder names separated by "/", a 
menu path will be created for the session. The menu path will be used for the program launcher on the desktop.

Hotkey

☑ The session can be started with a hotkey. A hotkey consists of one or more modifiers and a key.

Please note that Chromium is an experimental feature. Full support cannot be provided yet.

The session name must not contain any of these characters: \ / : * ? “ < > | [ ] { } ( )
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Modifiers: A modifier or a combination of several modifiers for the hotkey. You can select a set key symbol/
combination or your own key symbol/combination. A key symbol is a defined chain of characters, e.g.  Ctrl .

These are the pre-defined modifiers and the associated key symbols:

(No modifier) =  None

 =  Shift
[Ctrl] =  Ctrl

 =  Mod4

[Alt] =  Alt

Key combinations are formed as follows with  | :

Ctrl +   =  Ctrl|Super_L

Key: Key for the hotkey

Autostart

☑ The session will be launched automatically when the device boots.

Autostart delay: Waiting time in seconds between the complete startup of the desktop and the automatic session 
launch.

Autostart notification: This parameter is available if Autostart is activated and Autostart delay is set to a value 
greater than zero.

☑ For the duration defined by Autostart delay, a dialog is shown which allows the user to start the session 
immediately or cancel the automatic session start.

☐ No dialog is shown; the session is started automatically after the timespan specified with Autostart delay.

Autostart requires network

Do not use [AltGr] as a modifier (represented as Mod5 ). Otherwise, the key that is configured as a hotkey 
with AltGr cannot be used as a regular key anymore. Example: If you configure [AltGr] + [E] as a hotkey, it is 
impossible to enter an "e".



When this keyboard key is used as a modifier, it is represented as Mod4 ; when it is used as a key, it 

is represented as Super_L .



To enter a key that does not have a visible character, e. g. the [Tab] key, open a terminal, log on as user

and enter xev -event keyboard . Press the key to be used for the hotkey. The text in brackets that 

begins with keysym  contains the key symbol for the Key field. Example: Tab  in (keysym 0xff09, 

Tab)


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☑ If no network is available at system startup, the session is not started. A message is shown. As soon as the 
network is available, the session is started automatically.

☐ The session is started automatically, even when no network is available.
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Media Player Global
Menu path: Setup > Sessions > Media Player > Media Player Global

Here, you can change the global settings for the thin client’s media player.

_____

Window (see page 460)
Playback (see page 461)
Video (see page 462)
Audio (see page 463)
Options (see page 464)
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Window
Menu path: Setup > Sessions > Media Player > Media Player Global > Window

Aspect ratio: Aspect ratio for video playback
Possible values:

Auto: The aspect ratio of the playback window will adapt to the video being played.
Square
4:3 (TV)
16:9 (widescreen)
2.11:1 (DVB)

Fullscreen

☑ The media player will be shown in full-screen mode.

☐ The media player will be shown in a standard window. (Default)

Automatically resize the player window when a new video is loaded

☑ The window size will adapt to the video being played.

☐ The window size will not change. (Default)

Main window should stay on top

☑ The media player window will always remain in the foreground. Other windows cannot be placed on top of the 
media player window.

☐ The media player window will behave like a standard window. Other windows can be placed on top of the media 
player window. (Default)

Show controls

☑ The media player operating components will be shown. (Default)

☐ The media player operating components will not be shown; only the playback window is visible.
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Playback
Menu path: Sessions > Media Player > Media Player Global > Playback

Repeat mode

☑ The playlist will be repeated until the user stops playback.

☐ The playlist will be played back once only. (default)

Shuffle mode

☑ The playlist will be played back in a random order.

☐ The playlist will be played back in the set order. (default)

Show visual effects when an audio file is played

☑ Visual effects will be shown when playing back audio data.

☐ No visual effects will be shown. (default)

Type of visualization: The type of visual effects when playing back audio data
Possible values:

Monoscope
Goom!

Visualization size: The size of the visual effects shown

Possible values:

Small
Normal
Large
Extra large

This parameter is effective only if gstreamer 0.10 is selected as the multimedia framework, which results in 
Totem being selected as the media player. With the default setting for IGEL OS 10.05 and higher (gstreamer 
1.x in combination with Parole) the parameter is not effective.
The multimedia framework and media player can be changed in the Registry under System > Registry > 
multimedia > gstreamer > version (registry key: multimedia.gstreamer.version ).


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Video
Menu path: Setup > Sessions > Media Player > Media Player Global > Video

Video output: Specifies the video output method.
Possible options:

Auto: The video output method will be set depending on availability. The following options 
will be queried in this order. Examples: If available, hardware acceleration will be used. If 
hardware acceleration is not available but the X video extension is, the X video extension 
will be used.
Hardware accelerated: Hardware acceleration will be used.
X video extension: The images will be written to the graphics card memory using shared 
memory. Hardware acceleration will be used.
X Window System: Video will be output via the X11 protocol. Hardware acceleration will not 
be used.



Sessions

IGEL OS Reference Manual   463 / 897

•

•

•
•
•
•
•

Audio
Menu path: Setup > Sessions > Media Player > Media Player Global > Audio

Audio output type: Specifies via which output audio is to be delivered. The setting depends on the 
hardware used.
Possible values:

Stereo: Audio is delivered via the stereo output. This option is suitable if you work with an 
IGEL thin client.
4 channel output
4.1 channel output
5.0 channel output
5.1 channel output
AC3 passthrough: Audio is delivered digitally via an S/PDIF output if available.
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•

Options
Menu path: Setup > Sessions > Media Player > Media Player Global > Options

Disable screensaver when playing audio
☑ The screensaver will not be started during audio playback. (default)
☐ The screensaver will start after the set idling time, even is audio is being played back.
Network connection speed
Possible values:

56 kBps modem/ISDN
112 kBps dual ISDN/DSL
256 kBps DSL/cache
384 kBps DSL/cache
512 kBps DSL/cache
1.5 MBps T1/Intranet/LAN
Intranet/LAN

Buffer size: The buffer compensates for fluctuations in the network speed. (default: 3)
Autoload subtitle
☑ Subtitles contained in the video will be shown automatically. (default)
☐ Subtitles contained in the video will only be shown if the user has enabled them via View > 
Subtitles.
Subtitle encoding: Character coding for the subtitles. The value is set to UTF-8.
Font name: Font that is used for the subtitles
Possible values:

Sans
Sans Bold
Serif
Serif Bold

Font size: Size of the font that is used for the subtitles (default: 20)
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Media Player Session
Menu path: Sessions > Media Player > Media Player Sessions > [session name]

In this area, you can configure desktop integration for the media player.

Session name: Name for the session.

Starting Methods for Session
Start menu

☑ The session can be launched from the start menu.

Application Launcher

☑ The session can be launched with the Application Launcher.

Desktop

☑ The session can be launched with a program launcher on the desktop.

Quick start panel

☑ The session can be launched with the quick start panel.

Start menu's system tab

☑ The session can be launched with the start menu's system tab.

Application Launcher's system tab

☑ The session can be launched with the Application Launcher's system tab.

Desktop context menu

☑ The session can be launched with the desktop context menu.

Menu folder: If you specify a folder name or a path comprising a number of folder names separated by "/", a menu 
path will be created for the session. The menu path will be used in the start menu and in the desktop context menu.

Application Launcher folder: If you specify a folder name or a path comprising a number of folder names 
separated by "/", a menu path will be created for the session. The menu path will be used in the Application 
Launcher.

Desktop folder: If you specify a folder name or a path comprising a number of folder names separated by "/", a 
menu path will be created for the session. The menu path will be used for the program launcher on the desktop.

Password protection: Specifies which password will be requested when launching the session.
Possible values:

None: No password is requested when launching the session.
Administrator: The administrator password is requested when launching the session.
User: The user password is requested when launching the session.

The session name must not contain any of these characters: \ / : * ? “ < > | [ ] { } ( )
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Setup user: The setup user's password is requested when launching the session.

Hotkey

☑ The session can be started with a hotkey. A hotkey consists of one or more modifiers and a key.

Modifiers: A modifier or a combination of several modifiers for the hotkey. You can select a set key symbol/
combination or your own key symbol/combination. A key symbol is a defined chain of characters, e.g.  Ctrl .

These are the pre-defined modifiers and the associated key symbols:

(No modifier) =  None

 =  Shift
[Ctrl] =  Ctrl

 =  Mod4

[Alt] =  Alt

Key combinations are formed as follows with  | :

Ctrl +   =  Ctrl|Super_L

Key: Key for the hotkey

Autostart

☑ The session will be launched automatically when the device boots.

Restart

☑ The session will be restarted automatically after the termination.

Autostart delay: Waiting time in seconds between the complete startup of the desktop and the automatic session 
launch.

Do not use [AltGr] as a modifier (represented as Mod5 ). Otherwise, the key that is configured as a hotkey 
with AltGr cannot be used as a regular key anymore. Example: If you configure [AltGr] + [E] as a hotkey, it is 
impossible to enter an "e".



When this keyboard key is used as a modifier, it is represented as Mod4 ; when it is used as a key, it 

is represented as Super_L .



To enter a key that does not have a visible character, e. g. the [Tab] key, open a terminal, log on as user

and enter xev -event keyboard . Press the key to be used for the hotkey. The text in brackets that 

begins with keysym  contains the key symbol for the Key field. Example: Tab  in (keysym 0xff09, 

Tab)


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Autostart requires network

☑ If no network is available at system startup, the session is not started. A message is shown. As soon as the 
network is available, the session is started automatically.

☐ The session is started automatically, even when no network is available.

                  

Playback (see page 468)
Options (see page 469)
Desktop Integration (see page 470)
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Playback
Menu path: Setup > Sessions > Media Player > Media Player Sessions > [Session Name] > Playback

In this area, you can specify which audio data or video data are played back with which window settings when the 
media player session starts.

Medium / filename: Path to the audio data or video data that are to be played back when the 
media player session starts. This can be a local path or a URL.
Use default fullscreen mode configuration
☑ The setting under Setup > Sessions > Media Player > Media Player Global > Window will be 
used. (default)
☐ The setting will be set on a session-specific basis with Play video in fullscreen.
Play video in fullscreen
☑ The media player will be shown in fullscreen mode.
☐ The media player will be shown in a standard window. (default)
Use image aspect ratio setting
☑ The setting under Setup > Sessions > Media Player > Media Player Global > Window will be 
used. (default)
☐ The setting will be set on a session-specific basis with Aspect ratio.
Aspect ratio: Aspect ratio for video playback
Possible values:

Auto: The aspect ratio of the playback window will adapt to the video being played.
Square
4:3 (TV)
16:9 (widescreen)
2.11:1 (DVB)
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Options
Menu path: Setup > Sessions > Media Player > Media Player Sessions > [Session Name] > Options

Use default controls configuration
☑ The setting under Setup > Sessions > Media Player > Media Player Global > Window will be 
used. (default)
☐ The setting will be set on a session-specific basis with Show controls.
Show controls
☑ The media player operating components will be shown. (default)
☐ The media player operating components will not be shown; only the playback window is visible.
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Desktop Integration
Menu path: Sessions > Media Player > Media Player Sessions > [Session Name] > Desktop Integration

In this area, you can configure desktop integration for the media player.

Session name: Name for the session.

Starting Methods for Session
Start menu

☑ The session can be launched from the start menu.

Application Launcher

☑ The session can be launched with the Application Launcher.

Desktop

☑ The session can be launched with a program launcher on the desktop.

Quick start panel

☑ The session can be launched with the quick start panel.

Start menu's system tab

☑ The session can be launched with the start menu's system tab.

Application Launcher's system tab

☑ The session can be launched with the Application Launcher's system tab.

Desktop context menu

☑ The session can be launched with the desktop context menu.

Menu folder: If you specify a folder name or a path comprising a number of folder names separated by "/", a menu 
path will be created for the session. The menu path will be used in the start menu and in the desktop context menu.

Application Launcher folder: If you specify a folder name or a path comprising a number of folder names 
separated by "/", a menu path will be created for the session. The menu path will be used in the Application 
Launcher.

Desktop folder: If you specify a folder name or a path comprising a number of folder names separated by "/", a 
menu path will be created for the session. The menu path will be used for the program launcher on the desktop.

Password protection: Specifies which password will be requested when launching the session.
Possible values:

None: No password is requested when launching the session.
Administrator: The administrator password is requested when launching the session.
User: The user password is requested when launching the session.

The session name must not contain any of these characters: \ / : * ? “ < > | [ ] { } ( )
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Setup user: The setup user's password is requested when launching the session.

Hotkey

☑ The session can be started with a hotkey. A hotkey consists of one or more modifiers and a key.

Modifiers: A modifier or a combination of several modifiers for the hotkey. You can select a set key symbol/
combination or your own key symbol/combination. A key symbol is a defined chain of characters, e.g.  Ctrl .

These are the pre-defined modifiers and the associated key symbols:

(No modifier) =  None

 =  Shift
[Ctrl] =  Ctrl

 =  Mod4

[Alt] =  Alt

Key combinations are formed as follows with  | :

Ctrl +   =  Ctrl|Super_L

Key: Key for the hotkey

Autostart

☑ The session will be launched automatically when the device boots.

Restart

☑ The session will be restarted automatically after the termination.

Autostart delay: Waiting time in seconds between the complete startup of the desktop and the automatic session 
launch.

Do not use [AltGr] as a modifier (represented as Mod5 ). Otherwise, the key that is configured as a hotkey 
with AltGr cannot be used as a regular key anymore. Example: If you configure [AltGr] + [E] as a hotkey, it is 
impossible to enter an "e".



When this keyboard key is used as a modifier, it is represented as Mod4 ; when it is used as a key, it 

is represented as Super_L .



To enter a key that does not have a visible character, e. g. the [Tab] key, open a terminal, log on as user

and enter xev -event keyboard . Press the key to be used for the hotkey. The text in brackets that 

begins with keysym  contains the key symbol for the Key field. Example: Tab  in (keysym 0xff09, 

Tab)


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Autostart requires network

☑ If no network is available at system startup, the session is not started. A message is shown. As soon as the 
network is available, the session is started automatically.

☐ The session is started automatically, even when no network is available.
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•
•

Java Session
Menu path: Setup > Sessions > JWS Sessions

You can set up one or more Java Web Start sessions. This can be for example an IGEL UMS console running as Java 
Web Start.

To set up a Java Web Start session, proceed as follows:

In the JWS Sessions area, click on .
A new Java Web Start session will be created.
Configure the Java Web Start session. You will find further information under Java Web Start (see 
page 474).

_____

Java Web Start (see page 474)
Desktop Integration (see page 475)
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Java Web Start
Menu path: Setup > JWS Sessions > [Session Name] > Java Web Start

In this area, give the address of the JNLP file which is needed for launching the Java Web Start session. The file is 
loaded to the cache before being executed.

JNLP file: Address of the JNLP file. Example: http://www.server.com/example.jnlp

The browser's global proxy settings are used when downloading the JNLP file. You will find a description of 
these proxy settings under Browser Proxy (see page 390). If a proxy is to be used only for the browser but not 
for the Java Web Start session, give the address of the JNLP file under Setup > Sessions > Browser > 
Browser Global > Proxy > No proxy for.


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Desktop Integration
Menu path: Setup > Sessions > JWS Sessions > [Session Name] > Desktop Integration

You can configure one or more Java Web Start sessions.

The settings for launching the session are described below.

Session name: Name for the session

Session start options
Start menu

☑ The session can be started with the start menu.

Application Launcher

☑ The session can be started with the Application Launcher.

Desktop:

☑ The session can be started with a program starter on the desktop.

Quick start panel:

☑ The session can be started with the quick start panel.

Start menu's system tab

☑ The session can be started with the start menu’s system tab.

Application Launcher's system tab

☑ The session can be started with the Application Launcher’s system tab.

Desktop context menu

☑ The session can be started with the desktop context menu.

Menu folder: If you specify a folder name or a path comprising a number of folder names separated by "/", a menu 
path will be created for the session. The menu path will be used in the start menu and in the desktop context menu.

Path in the Application Launcher: If you specify a folder name or a path comprising a number of folder names 
separated by "/", a menu path will be created for the session. The menu path will be used in the Application 
Launcher.

Desktop folder: If you specify a folder name or a path comprising a number of folder names separated by "/", a 
menu path will be created for the session. The menu path will be used for the program launcher on the desktop.

Password protection: Specifies which password will be requested when launching the session.
Possible values:

None: No password is requested when launching the session.
Administrator: The administrator password is requested when launching the session.
User: The user password is requested when launching the session.

The session name must not contain any of these characters: \ / : * ? “ < > | [ ] { } ( )
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Setup user: The setup user's password is requested when launching the session.

Hotkey:

☑ The session can be started with a hotkey. A hotkey consists of one or more modifiers and a key.

Modifiers: A modifier or a combination of several modifiers for the hotkey. You can select a set key symbol/
combination or your own key symbol/combination. A key symbol is a defined chain of characters, e.g.  Ctrl .

These are the pre-defined modifiers and the associated key symbols:

(No modifier) =  None

 =  Shift
[Ctrl] =  Ctrl

 =  Mod4

[Alt] =  Alt

Key combinations are formed as follows with  | :

Ctrl +   =  Ctrl|Super_L

Key: Key for the hotkey

Autostart: If this option is enabled, the session will be launched automatically when the thin client boots.

Autostart delay: Waiting time in seconds between the thin client booting and the session being launched 
automatically.

Autostart requires network

☑ If no network is available at system startup, the session is not started. A message is shown. As soon as the 
network is available, the session is started automatically.

Do not use [AltGr] as a modifier (represented as Mod5 ). Otherwise, the key that is configured as a hotkey 
with AltGr cannot be used as a regular key anymore. Example: If you configure [AltGr] + [E] as a hotkey, it is 
impossible to enter an "e".



When this keyboard key is used as a modifier, it is represented as Mod4 ; when it is used as a key, it 

is represented as Super_L .



To enter a key that does not have a visible character, e. g. the [Tab] key, open a terminal, log on as user

and enter xev -event keyboard . Press the key to be used for the hotkey. The text in brackets that 

begins with keysym  contains the key symbol for the Key field. Example: Tab  in (keysym 0xff09, 

Tab)


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☐ The session is started automatically, even when no network is available.
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VoIP Client
Menu path: Sessions > VoIP Client

Ekiga Voice over IP client allows you to use the SIP (Session Initiation Protocol) and H.323; see http://ekiga.org16.

You will find a detailed description of all Ekiga options under http://wiki.ekiga.org/index.php/Manual.

In this area, you can configure desktop integration for the VoIP session.

Session name: Name for the session.

Starting Methods for Session
Start menu

☑ The session can be launched from the start menu.

Application Launcher

☑ The session can be launched with the Application Launcher.

Desktop

☑ The session can be launched with a program launcher on the desktop.

Quick start panel

☑ The session can be launched with the quick start panel.

Start menu's system tab

☑ The session can be launched with the start menu's system tab.

Application Launcher's system tab

☑ The session can be launched with the Application Launcher's system tab.

Desktop context menu

☑ The session can be launched with the desktop context menu.

Menu folder: If you specify a folder name or a path comprising a number of folder names separated by "/", a menu 
path will be created for the session. The menu path will be used in the start menu and in the desktop context menu.

Application Launcher folder: If you specify a folder name or a path comprising a number of folder names 
separated by "/", a menu path will be created for the session. The menu path will be used in the Application 
Launcher.

Desktop folder: If you specify a folder name or a path comprising a number of folder names separated by "/", a 
menu path will be created for the session. The menu path will be used for the program launcher on the desktop.

The session name must not contain any of these characters: \ / : * ? “ < > | [ ] { } ( )

http://ekiga.org/
http://ekiga.org/
http://wiki.ekiga.org/index.php/Manual
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Password protection: Specifies which password will be requested when launching the session.
Possible values:

None: No password is requested when launching the session.
Administrator: The administrator password is requested when launching the session.
User: The user password is requested when launching the session.
Setup user: The setup user's password is requested when launching the session.

Hotkey

☑ The session can be started with a hotkey. A hotkey consists of one or more modifiers and a key.

Modifiers: A modifier or a combination of several modifiers for the hotkey. You can select a set key symbol/
combination or your own key symbol/combination. A key symbol is a defined chain of characters, e.g.  Ctrl .

These are the pre-defined modifiers and the associated key symbols:

(No modifier) =  None

 =  Shift
[Ctrl] =  Ctrl

 =  Mod4

[Alt] =  Alt

Key combinations are formed as follows with  | :

Ctrl +   =  Ctrl|Super_L

Key: Key for the hotkey

Autostart

☑ The session will be launched automatically when the device boots.

Do not use [AltGr] as a modifier (represented as Mod5 ). Otherwise, the key that is configured as a hotkey 
with AltGr cannot be used as a regular key anymore. Example: If you configure [AltGr] + [E] as a hotkey, it is 
impossible to enter an "e".



When this keyboard key is used as a modifier, it is represented as Mod4 ; when it is used as a key, it 

is represented as Super_L .



To enter a key that does not have a visible character, e. g. the [Tab] key, open a terminal, log on as user

and enter xev -event keyboard . Press the key to be used for the hotkey. The text in brackets that 

begins with keysym  contains the key symbol for the Key field. Example: Tab  in (keysym 0xff09, 

Tab)


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Restart

☑ The session will be restarted automatically after the termination.

Autostart delay: Waiting time in seconds between the complete startup of the desktop and the automatic session 
launch.

Autostart requires network

☑ If no network is available at system startup, the session is not started. A message is shown. As soon as the 
network is available, the session is started automatically.

☐ The session is started automatically, even when no network is available.

Account (see page 481)
Audio (see page 483)
SIP (see page 484)
H.323 (see page 485)
Call Options (see page 486)
Phone Book (see page 487)
Preferences (see page 488)
Desktop Integration (see page 489)
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Account
Menu path: Setup > Sessions > VoIP Client > User Account

You can set up or change one or more user accounts as well as specify the name displayed.

Full Name: Name of the user; this name will be shown to the other person. Example: John Doe

To set up an SIP user account, proceed as follows:

Click .
If the user account is to be active once set up, enable the Enable Account option.
Enter the following data:

Protocol: Select SIP.
Name: Name for this user account.

Registrar: URI with which the VoIP client registers. This can be a DNS name or an IP address.
User name: Numerical or alphanumerical value. The user name is part of the SIP address. 
Example: john.doe  in john.doe@example.com
Login Name: Numerical or alphanumerical value. Name with which the VoIP client registers 
on the registrar. This name can differ from the name given under user name.
Password: Password with which the VoIP client registers on the registrar
Registration Update Timeout: Timeout after which the registration should be updated 
(default: 3600)

Click Ok.
The user account has been set up.

To set up an H.323 user account, proceed as follows:

Click .
If the user account is to be active once set up, enable the Enable Account option.
Enter the following data:

Protokoll: Wählen Sie H323.
Name: Name für dieses Benutzerkonto.

Ensure that the VoIP client was terminated before you start setting up or changing a user account. 
Changes will only be saved if the client is not running.



Choose a name which allows a distinction to be made easily between a number of user 
accounts.



Ensure that the VoIP client was terminated before you start setting up or changing a user account. 
Changes will only be saved if the client is not running.


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Gatekeeper: URI with which the VoIP client registers. This can be a DNS name or an IP 
address.
User name: Numerical or alphanumerical value. Example: john.doe  in 

john.doe@example.com
Passwort: Password with which the VoIP client logs on to the registrar
Registration Update Timeout: Timeout after which the registration should be updated 
(default: 3600)

Click Ok.
The user account has been set up.

Choose a name which allows a distinction to be made easily between a number of user 
accounts.


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Audio
Menu path: Setup > Sessions > VoIP Client > Audio

You can change the audio settings of the VoIP client.

To configure the audio devices in the VoIP client, proceed as follows:

In the IGEL setup, ensure that the option Save configuration changes made in the application is 
enabled under Sessions > VoIP Client > Preferences.
Start the VoIP client.
Configure your desired settings in the VoIP client under Edit > Preferences > Audio > Devices.

To save your settings, close the VoIP client window, right-click on  in the system tray and 
select Close.

The changes will be saved in the IGEL setup once the VoIP client is terminated.
Settings in the setup:

Sound event output device: Specifies which audio device is used for the ringtone.

Audio output device: Specifies which audio device is used for playback. Example: the audio 
device that is connected to the loudspeakers of the headset.
Audio input device: Specifies which audio device is used for recording. Example: the audio device 
that is connected to the microphone of the headset.
Enable silence detection: If this option is enabled, audio transmission will be suppressed in the 
absence of voice activity. This helps to save bandwidth.

Enable echo cancelation: If this option is enabled, the VoIP client will suppress echoes of your 
own voice.
Maximum jitter buffer (in milliseconds): The jitter buffer improves voice quality by 
compensating for delay variations when transmitting voice packets. The VoIP client continuously 
measures delay variations and automatically adjusts the buffer size. The bigger the delay 
variations are, the bigger the jitter buffer will be set. (Default: 500)

Recommendation: Configure the settings Device for ringtone, Device for audio playback and Device for 
audio recording in the VoIP client. All available audio devices of the thin client are shown in the VoIP 
client.



It is recommended that you select the audio device that is connected to the thin client's 
built-in loudspeaker.



Voice activity detection can reduce the voice quality.

A bigger jitter buffer results in greater latency.
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SIP
Menu path: Setup > Sessions > VoIP Client > SIP

You can change SIP-specific settings for the proxy, forwarding and the multi-frequency dialing process (DTMF).

Outbound Proxy: URI of the SIP proxy that handles outbound calls.
Forward URI: SIP URI to which inbound calls are forwarded if forwarding is enabled. You will find 
further information on forwarding under Call Options (see page 486).
Send DTMF as: Specifies how key sequences are transmitted while a connection is in place.
Possible values:

INFO: The key sequence is transmitted as SIP INFO.
RFC 2833: The key sequence is transmitted using RTP (Real-time Transport Protocol).
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H.323
Menu path: Setup > Sessions > VoIP Client > H.323

You can change H.323-specific settings for forwarding, H.245, quick start and for the multi-frequency dialing 
process (DTMF).

Forward URI: H.323 URI to which inbound calls are forwarded if forwarding is enabled. You will 
find further information on forwarding under Call Options (see page 486).
Enable H.245 tunneling
☑ H.245 messages will be packaged in H.225 messages. In this way, no additional TCP connection 
must be established. (Default)

☐ A separate TCP connection is established for H.245.
Enable early H.245
☑ H.245 will be launched at an earlier point in the connection process. The voice connection can 
be established more quickly as a result. (Standard)
Enable Fast Start procedure
☑ The voice connection will be established in quick start mode (fast connect, part of H.323 v2). 
(Standard)
DTMF senden als: Specifies how key sequences are transmitted while a connection is in place.
Mögliche Werte:

String: The key sequence is transmitted using H.245 User Input Indication.
Tone: The key sequence is transmitted as a tone sequence in the audio data flow.
RFC 2833: The key sequence is transmitted using RTP (Real-time Transport Protocol).
Q.931: The key sequence is transmitted via the signaling channel.

For H.245 tunneling, port 1720 is required.



Sessions

IGEL OS Reference Manual   486 / 897

•

•

•

•

Call Options
Menu path: Setup > Sessions > VoIP Client > Call Options

You can change settings for inbound calls.

Always forward calls to the given address: If this option is enabled, inbound calls will 
immediately be forwarded to the address defined in Setup > Sessions > VoIP Client > SIP > 
Foward URI (see SIP (see page 484)) or Setup > Sessions > VoIP Client > H.323> Forward URI (see 
H.323 (see page 485)).
Forward calls to the given address if no answer: If this option is enabled, inbound calls will be 
forwarded to the address defined in Setup > Sessions > VoIP Client > SIP > URI for Forwarding
(see SIP (see page 484)) or Setup > Sessions > VoIP Client > H.323> URI for Forwarding (see 
H.323 (see page 485)) after the time specified under Time limit for calls not taken. If this option is 
disabled, inbound calls will be rejected after the time specified under Time limit for calls not 
taken.
Forward calls to the given address if busy: If this option is enabled, inbound calls during a call 
will be forwarded to the address defined in Setup > Sessions > VoIP Client > SIP > URI for 
Forwarding (see SIP (see page 484)) or Setup > Sessions > VoIP Client > H.323> URI for Forwarding 
(see H.323 (see page 485)).
No Answer Timeout: Time in seconds after which calls not taken are rejected or forwarded.
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3.

Phone Book
Menu path: Setup > Sessions > VoIP Client > Telephone Book

You can add one or more LDAP address books or local contacts.

To add an LDAP address book, proceed as follows:
In the List of LDAP address books area, click on .
Enter the following data:

Name: Name with which the LDAP address book will be displayed in the VoIP client
Server Name: Host name of the LDAP server
Port: Port for the connection to the LDAP server (Default: 389)
Base DN: Basis for the search in the LDAP tree
Scope: Area for the LDAP search
Possible options: 
- Single level 
- Subtree
Display name attribute: LDAP attribute that is displayed as the name of the contact in the 
VoIP client. (Default: cn)
Call Attribute: LDAP attribute that contains the telephone number (Standard: 
telephoneNumber)
Filter Template: Filter for the LDAP search (Default: (cn=$))
Bind ID: Identifier for the LDAP search. This identifier is sent to the LDAP server in a BIND 
request.
Password: Password for the user account for the LDAP search

Click Ok.

To add a contact to the local contact list, proceed as follows:
In the List of Contacts area, click on .
Enter the following data:

Name: Name of the SIP or H.323 address displayed
Address: SIP or H.323 address. Example: sip:500@example.com
Group: Optional group name in order to group contacts

Click Ok.
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Preferences
Menu path: Setup > Sessions > VoIP Client > Settings

You can change VoIP client settings.

Save configuration changes made in the application
☑ changes made in the VoIP client will be saved in the IGEL setup when the VoIP client is 
terminated. This applies to all settings available in the IGEL setup, with the exception of settings 
for the LDAP address book. (Default)
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Desktop Integration
Menu path: Sessions > VoIP Client > Desktop Integration

In this area, you can configure desktop integration for the VoIP client session.

Session name: Name for the session.

Starting Methods for Session
Start menu

☑ The session can be launched from the start menu.

Application Launcher

☑ The session can be launched with the Application Launcher.

Desktop

☑ The session can be launched with a program launcher on the desktop.

Quick start panel

☑ The session can be launched with the quick start panel.

Start menu's system tab

☑ The session can be launched with the start menu's system tab.

Application Launcher's system tab

☑ The session can be launched with the Application Launcher's system tab.

Desktop context menu

☑ The session can be launched with the desktop context menu.

Menu folder: If you specify a folder name or a path comprising a number of folder names separated by "/", a menu 
path will be created for the session. The menu path will be used in the start menu and in the desktop context menu.

Application Launcher folder: If you specify a folder name or a path comprising a number of folder names 
separated by "/", a menu path will be created for the session. The menu path will be used in the Application 
Launcher.

Desktop folder: If you specify a folder name or a path comprising a number of folder names separated by "/", a 
menu path will be created for the session. The menu path will be used for the program launcher on the desktop.

Password protection: Specifies which password will be requested when launching the session.
Possible values:

None: No password is requested when launching the session.
Administrator: The administrator password is requested when launching the session.
User: The user password is requested when launching the session.

The session name must not contain any of these characters: \ / : * ? “ < > | [ ] { } ( )
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Setup user: The setup user's password is requested when launching the session.

Hotkey

☑ The session can be started with a hotkey. A hotkey consists of one or more modifiers and a key.

Modifiers: A modifier or a combination of several modifiers for the hotkey. You can select a set key symbol/
combination or your own key symbol/combination. A key symbol is a defined chain of characters, e.g.  Ctrl .

These are the pre-defined modifiers and the associated key symbols:

(No modifier) =  None

 =  Shift
[Ctrl] =  Ctrl

 =  Mod4

[Alt] =  Alt

Key combinations are formed as follows with  | :

Ctrl +   =  Ctrl|Super_L

Key: Key for the hotkey

Autostart

☑ The session will be launched automatically when the device boots.

Restart

☑ The session will be restarted automatically after the termination.

Autostart delay: Waiting time in seconds between the complete startup of the desktop and the automatic session 
launch.

Do not use [AltGr] as a modifier (represented as Mod5 ). Otherwise, the key that is configured as a hotkey 
with AltGr cannot be used as a regular key anymore. Example: If you configure [AltGr] + [E] as a hotkey, it is 
impossible to enter an "e".



When this keyboard key is used as a modifier, it is represented as Mod4 ; when it is used as a key, it 

is represented as Super_L .



To enter a key that does not have a visible character, e. g. the [Tab] key, open a terminal, log on as user

and enter xev -event keyboard . Press the key to be used for the hotkey. The text in brackets that 

begins with keysym  contains the key symbol for the Key field. Example: Tab  in (keysym 0xff09, 

Tab)


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Autostart requires network

☑ If no network is available at system startup, the session is not started. A message is shown. As soon as the 
network is available, the session is started automatically.

☐ The session is started automatically, even when no network is available.
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Teradici PCoIP Session
Menu path: Sessions > Teradici PColP Client > PCoIP Sessions

Connection Settings (see page 493)
Login (see page 494)
Window (see page 495)
Desktop Integration (see page 496)

Licensed Feature

This feature requires an add-on license; see Add-On Licenses. Please contact your IGEL reseller.


If you are using Amazon WorkSpace, note that Linux connectivity is usually disabled by default, 
see Amazon WorkSpaces Linux Client Application17

You will have to enable this before connecting.



https://docs.aws.amazon.com/workspaces/latest/userguide/amazon-workspaces-linux-client.html
https://docs.aws.amazon.com/workspaces/latest/userguide/amazon-workspaces-linux-client.html
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Connection Settings
Menu path: Sessions > Teradici PCoIP Client > PCoIP Sessions > PCoIP Session > Connection Settings

Use IGEL Setup for configuration
☑ The connection settings are configured via IGEL Setup.
☐ IGEL Setup does not control the connection settings. (Default)

Broker type
Possible options:

'PCoIP broker'
'Direct hardhost'

Server: Host name or IP address of the PCoIP server. 

Desktop: Name of the virtual desktop. This parameter is only relevant if the user is assigned to more than one 
virtual desktop on the server, e. g. Amazon Web Services (AWS). If the user has several desktops and the field 
Desktop is empty, a selection of all available desktops is displayed after login. If the field Desktop contains the 
name of an available desktop, the session is started with this desktop.

Server certificate verification mode
Possible options:

'Not required'
'Warn but allow'
'Full verification': For secure operation, this verification mode is recommended.
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Login
Menu path: Sessions > Teradici PCoIP Client > PCoIP Sessions > PCoIP Session > Login

Authentication type
Possible options:

'Password authentication'
'Smartcard authentication'

Smartcard PIN: PIN required for smartcard authentication; only valid if Authentication type is set to Smartcard 
authentication.
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Window
Menu path: Sessions > Teradici PCoIP Client > PCoIP Sessions > PCoIP Session > Window

Window mode
Possible options:

'User defined': The user can change the window mode via the PCoIP client. The window mode that 
has been used last is stored. 
'Fullscreen one monitor'
'Fullscreen all monitors'
'Window'

User interface translation
Possible options:

'System setting'
'English'
'German'
'French'
'Spanish'
'Portuguese (EU)'
'Portuguese (Brazil)'
'Italian'
'Japanese'
'Chinese (Simplified)'
'Chinese (Traditional)'
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Desktop Integration
Menu path: Sessions > Teradici PCoIP Client > PCoIP Sessions > PCoIP Session > Desktop Integration

Session name: Name for the session.

Starting Methods for Session
Start menu

☑ The session can be launched from the start menu.

Application Launcher

☑ The session can be launched with the Application Launcher.

Desktop

☑ The session can be launched with a program launcher on the desktop.

Quick start panel

☑ The session can be launched with the quick start panel.

Start menu's system tab

☑ The session can be launched with the start menu's system tab.

Application Launcher's system tab

☑ The session can be launched with the Application Launcher's system tab.

Desktop context menu

☑ The session can be launched with the desktop context menu.

Menu folder: If you specify a folder name or a path comprising a number of folder names separated by "/", a menu 
path will be created for the session. The menu path will be used in the start menu and in the desktop context menu.

Application Launcher folder: If you specify a folder name or a path comprising a number of folder names 
separated by "/", a menu path will be created for the session. The menu path will be used in the Application 
Launcher.

Desktop folder: If you specify a folder name or a path comprising a number of folder names separated by "/", a 
menu path will be created for the session. The menu path will be used for the program launcher on the desktop.

Password protection: Specifies which password will be requested when launching the session.
Possible values:

None: No password is requested when launching the session.
Administrator: The administrator password is requested when launching the session.
User: The user password is requested when launching the session.
Setup user: The setup user's password is requested when launching the session.

The session name must not contain any of these characters: \ / : * ? “ < > | [ ] { } ( )
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Hotkey

☑ The session can be started with a hotkey. A hotkey consists of one or more modifiers and a key.

Modifiers: A modifier or a combination of several modifiers for the hotkey. You can select a set key symbol/
combination or your own key symbol/combination. A key symbol is a defined chain of characters, e.g.  Ctrl .

These are the pre-defined modifiers and the associated key symbols:

(No modifier) =  None

 =  Shift
[Ctrl] =  Ctrl

 =  Mod4

[Alt] =  Alt

Key combinations are formed as follows with  | :

Ctrl +   =  Ctrl|Super_L

Key: Key for the hotkey

Autostart

☑ The session will be launched automatically when the device boots.

Restart

☑ The session will be restarted automatically after the termination.

Autostart delay: Waiting time in seconds between the complete startup of the desktop and the automatic session 
launch.

Do not use [AltGr] as a modifier (represented as Mod5 ). Otherwise, the key that is configured as a hotkey 
with AltGr cannot be used as a regular key anymore. Example: If you configure [AltGr] + [E] as a hotkey, it is 
impossible to enter an "e".



When this keyboard key is used as a modifier, it is represented as Mod4 ; when it is used as a key, it 

is represented as Super_L .



To enter a key that does not have a visible character, e. g. the [Tab] key, open a terminal, log on as user

and enter xev -event keyboard . Press the key to be used for the hotkey. The text in brackets that 

begins with keysym  contains the key symbol for the Key field. Example: Tab  in (keysym 0xff09, 

Tab)


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Autostart notification: This parameter is available if Autostart is activated and Autostart delay is set to a value 
greater than zero.

☑ For the duration defined by Autostart delay, a dialog is shown which allows the user to start the session 
immediately or cancel the automatic session start.

☐ No dialog is shown; the session is started automatically after the timespan specified with Autostart delay.

Autostart requires network

☑ If no network is available at system startup, the session is not started. A message is shown. As soon as the 
network is available, the session is started automatically.

☐ The session is started automatically, even when no network is available.
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AVD Global
Menu path: Sessions > AVD > AVD Global

Plugins (see page 500)
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Plugins
Menu path: Sessions > AVD > AVD Global > Plugins

Fabulatech (see page 501)
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Fabulatech
Menu path: Sessions > AVD > AVD Global > Plugins > Fabulatech

The Fabulatech redirection of webcams and scanners as well as the common Fabulatech USB redirection can be 
enabled or disabled. The Fabulatech USB redirection can be controlled based on class rules and device rules.

For the Fabulatech USB redirection, a server-side component is required. We recommend the USB for Remote 
Desktop IGEL Edition; see http://www.usb-over-network.com/partners/igel/.

Fabulatech Webcam Redirection

☑ Fabulatech webcam redirection is enabled.

Fabulatech Scanner Redirection

☑ Fabulatech scanner redirection is enabled. 

Fabulatech USB Redirection

☑ Fabulatech USB redirection is enabled. 

Default rule: This rule will apply if no special rule was configured for a class or a device.

Deny
Allow

Class Rules

Class rules apply to USB device classes and sub-classes.

Managing rules:

 Create a new entry

 Remove the selected entry

Enable either native USB redirection or Fabulatech USB redirection – not both together. Disable USB 
redirection if you use DriveLock.



Ensure that no other hotplug storage device (USB stick) is connected if a session is started with Fabulatech 
USB redirection. Otherwise, the hotplug storage device will not be securely removed when the session 
starts, and this could lead to data loss.



You can enable or disable all Fabulatech redirections for each individual session; go to Sessions > AVD > 
AVD Sessions > [Session name] > Plugins and set Fabulatech Webcam/Scanner/USB 
Redirection accordingly (see Plugins (see page 516)).



Tip

To secure your endpoint, it is generally recommended to set Default rule to Deny and to configure 
Allow rules only for the required USB devices and USB device classes. 



http://www.usb-over-network.com/partners/igel/
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 Edit the selected entry

 Copy the selected entry

Class rule properties:

Rule:

Allow: Devices that have the properties defined here are redirected by the Fabulatech USB 
Redirection.
Deny: Devices that have the properties defined here are not redirected.

Class ID: Device class

Subclass ID: Subclass relating to the specified device class

Name: Free text entry

Override serial: Serial number that will appear in the session

Override name: Device name that will appear in the session

Postpone

☑ The USB device is only removed from the system (endpoint device) when the session starts.

☐ The USB device is no longer shown immediately after the system is booted.

Takeaway

☑ The USB device may be removed from the system (endpoint device).

☐ The USB device may not be removed. (Default)

No Reset

☑ The device will not be automatically reset after the connection with the session has been terminated.

☐ The device will be reset after the connection with the session has been terminated.

Device Rules

A device rule applies to a specific device that is identified by its serial number.

Device rule settings:

Rule:

Allow
Deny

Vendor ID: Hexadecimal manufacturer number

Product ID: Hexadecimal device number

This setting is only effective if the Takeaway parameter is enabled.

Getting USB Device Information
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Name: Free text entry

Override serial: Serial number that will appear in the session.

Override name: Device name that will appear in the session.

Postpone

To find out the Class ID, Subclass ID, Vendor ID and Product ID of the connected USB device, you can use 
the System Information tool. For further information, see Using “System Information” Function (see page 
634).
System Information example:

Alternatively, you can use the command lsusb  (or lsusb | grep -i [search term] ) in the 
terminal.
Example for lsusb :
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☑ The USB device is only removed from the system (endpoint device) when the session starts.

☐ The USB device is no longer shown immediately after the system is booted.

Takeaway

☑ The USB device may be removed from the system (endpoint device).

☐ The USB device may not be removed.

No Reset

☑ The device will not be automatically reset after the connection with the session has been terminated.

☐ The device will be reset after the connection with the session has been terminated.

This setting is only effective if the Takeaway parameter is enabled.
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AVD Session
Menu path: Sessions > AVD > AVD Sessions > [Session Name]

In this area, you can configure desktop integration for the AVD session.

Session name: Name for the session.

Starting Methods for Session
Start menu

☑ The session can be launched from the start menu.

Application Launcher

☑ The session can be launched with the Application Launcher.

Desktop

☑ The session can be launched with a program launcher on the desktop.

Quick start panel

☑ The session can be launched with the quick start panel.

Start menu's system tab

☑ The session can be launched with the start menu's system tab.

Application Launcher's system tab

☑ The session can be launched with the Application Launcher's system tab.

Desktop context menu

☑ The session can be launched with the desktop context menu.

Menu folder: If you specify a folder name or a path comprising a number of folder names separated by "/", a menu 
path will be created for the session. The menu path will be used in the start menu and in the desktop context menu.

Application Launcher folder: If you specify a folder name or a path comprising a number of folder names 
separated by "/", a menu path will be created for the session. The menu path will be used in the Application 
Launcher.

Desktop folder: If you specify a folder name or a path comprising a number of folder names separated by "/", a 
menu path will be created for the session. The menu path will be used for the program launcher on the desktop.

Password protection: Specifies which password will be requested when launching the session.
Possible values:

None: No password is requested when launching the session.
Administrator: The administrator password is requested when launching the session.
User: The user password is requested when launching the session.

The session name must not contain any of these characters: \ / : * ? “ < > | [ ] { } ( )
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Setup user: The setup user's password is requested when launching the session.

Hotkey

☑ The session can be started with a hotkey. A hotkey consists of one or more modifiers and a key.

Modifiers: A modifier or a combination of several modifiers for the hotkey. You can select a set key symbol/
combination or your own key symbol/combination. A key symbol is a defined chain of characters, e.g.  Ctrl .

These are the pre-defined modifiers and the associated key symbols:

(No modifier) =  None

 =  Shift
[Ctrl] =  Ctrl

 =  Mod4

[Alt] =  Alt

Key combinations are formed as follows with  | :

Ctrl +   =  Ctrl|Super_L

Key: Key for the hotkey

Autostart

☑ The session will be launched automatically when the device boots.

Restart

☑ The session will be relaunched automatically after the termination.

Autostart delay: Waiting time in seconds between the complete startup of the desktop and the automatic session 
launch.

Do not use [AltGr] as a modifier (represented as Mod5 ). Otherwise, the key that is configured as a hotkey 
with AltGr cannot be used as a regular key anymore. Example: If you configure [AltGr] + [E] as a hotkey, it is 
impossible to enter an "e".



When this keyboard key is used as a modifier, it is represented as Mod4 ; when it is used as a key, it 

is represented as Super_L .



To enter a key that does not have a visible character, e. g. the [Tab] key, open a terminal, log on as user

and enter xev -event keyboard . Press the key to be used for the hotkey. The text in brackets that 

begins with keysym  contains the key symbol for the Key field. Example: Tab  in (keysym 0xff09, 

Tab)


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Autostart notification: This parameter is available if Autostart is activated and Autostart delay is set to a value 
greater than zero.

☑ For the duration defined by Autostart delay, a dialog is shown which allows the user to start the session 
immediately or cancel the automatic session start.

☐ No dialog is shown; the session is started automatically after the timespan specified with Autostart delay.

Autostart requires network

☑ If no network is available at system startup, the session is not started. A message is shown. As soon as the 
network is available, the session is started automatically.

☐ The session is started automatically, even when no network is available.

Logon (see page 508)
Options (see page 510)
Proxy (see page 511)
Display (see page 512)
Printing (see page 513)
Plugins (see page 516)
Desktop Integration (see page 517)
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Logon
Menu path: Sessions > AVD > AVD Sessions > [Session Name] > Logon

Username@domain or @domain: A user name or a preset domain name used for the automatic connection (see 
page 508) to the AVD session. The string after "@" is taken as a preset domain name.

Example: 

avd@your.domain.com : To log in, the user does not need to enter the username and the domain name.

@your.domain.com : To log in, the user only needs to enter the username, e.g. a vd . The preset domain –

  your.domain.com  – will automatically be appended.

Password: Password used for the automatic connection (see page 508) to the AVD session.

Overwriting the Preset Domain Name

Use the following registry key to specify whether the user should be able to overwrite the preset domain, 
e.g. with username@other-domain.com :

Path System > Registry
Registry sessions.wvd%.options.allow-preset-

domain-overwrite
Value enabled / disabled 
Note If enabled: the domain entered by the user is accepted.

If disabled: the domain entered by the user is replaced 
with the preset domain.



If the Login Credentials Should Not Be Applied Automatically

You can use the following registry key to always prompt for a user name and password or only for a 
password when connecting to an AVD session:
Path System > Registry
Parameter Always prompt for username and password upon 

session host connection
Registry sessions.wvd%.options.always-prompt-

for-session-username-and-password
Value enabled / disabled
Path System > Registry
Parameter Always prompt for password upon session host 

connection


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Workspace resource to automatically start when connected: Name of the resource that is to be started 
automatically.

For an example, see How to connect IGEL OS to Azure Virtual Desktop (see page 508).

Registry sessions.wvd%.options.always-prompt-for-

session-password
Value enabled / disabled
Note On the server side, you can enable the RDP group policy 

"Always prompt for password upon connection" to achieve 
the same result.
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Options
Menu path: Sessions > AVD > AVD Sessions > [Session Name] > Options

See also the list of implemented features: Early Build: AVD (RDP3) for IGEL OS 11 (see page 510).

Clipboard redirection

☑ Text and images from the clipboard are shared between the AVD session and the local client. 

Drive redirection

☑ Redirection is bound to the /media  folder, so that locally mounted storage devices, including USB sticks, are 
forwarded to the AVD session. (Default)

Smartcard redirection

☑ Smartcards are forwarded to the AVD session.

Exit on last session closed

☑ When the last session window is closed, the entire IGEL AVD Client automatically closes. (Default)

In-session toolbar

☑ The in-session toolbar is enabled. (Default)

Audio output redirection

☑ The audio output is redirected between the AVD session and the local client. (Default)

AAC Codec

☑ The AAC (Advanced Audio Coding) codec used for support of audio output redirection is enabled. (Default)

Audio input redirection

☑ The audio input (microphone) is redirected between the local client and the AVD session. (Default)
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Proxy
Menu path: Sessions > AVD > AVD Sessions > [Session Name] > Proxy

Proxy mode: Specifies if a proxy should be used. 
Possible options: 

"Off": A proxy is disabled. The direct connection to the Internet is used.
"Global HTTP proxy setting": The HTTP proxy configured under Network > Proxy is used, see 
Proxy (4) (see page 511).
"Session specific proxy": The proxy configuration specified under Proxy host and Proxy port is 
used.

The following fields are active if Proxy mode is set to "Session specific proxy":

Proxy host: Hostname or IP address of the proxy server

Proxy port: Port on which the proxy service is available
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Display
Menu path: Sessions > AVD > AVD Sessions > [Session Name] > Display

Window size: Specifies the width and height of the window.
Possible options:

"Full-screen": The session is shown on the full screen. The device's taskbar is not visible.
"Work area": The session is shown on the full screen, minus the area needed by the device's 
taskbar.
Numeric details: The session is shown in the selected resolution or on the selected percentage of 
the screen area.

Start monitor: Specifies the monitor on which the session is displayed.
Possible options:

"No configuration": The monitor is selected according to the current position of the mouse 
pointer.
"1st monitor"
"2nd monitor"

Multimonitor full-screen mode: This setting is relevant if more than one monitor is connected to the terminal.
Possible options:

"Global setting": Currently the same as "Multiple monitors".
"Single monitor": Restricts the full-screen session to one monitor.
"Multiple monitors": Displays the full-screen session on multiple monitors.
"Expand to all monitors": Expands the full-screen session across all monitors.

Scale factor: Specifies the desktop scaling in percent. 
Possible values:

"Automatic scale": The resolution set under User Interface > Display > Options > Monitor-DPI is 
used for the session.
Numeric details: The display is magnified by the factor given here. 
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Printing
Menu path: Sessions > AVD > AVD Sessions > [Session Name] > Printing

CUPS Printer Redirection (see page 514)
ezeep by ThinPrint (see page 515)
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CUPS Printer Redirection
Menu path: Sessions > AVD > AVD Sessions > [Session Name] > Printing > CUPS Printer Redirection

CUPS Printer Redirection

☑ CUPS printers configured under Devices > Printer > CUPS > Printers are redirected to the AVD session from the 
local endpoint. To disable/enable a CUPS printer for the AVD session, go to Devices > Printer > CUPS > Printers 
> [printer name] > Mapping in sessions > Map printer in AVD sessions, see Printers (see page 788).

 Set the printer driver name under System > Registry > print.cups.printer%.wvd_printer_driver: 

The default Windows driver name is "Microsoft PS Class Driver"; it is usually installed by default 
and works generically.
In the case of a custom printer driver, make sure the driver is installed on the AVD side and enter 
the exact name of the driver.
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ezeep by ThinPrint
Menu path: Sessions > AVD > AVD Sessions > [Session Name] > Printing > ezeep by ThinPrint

Printing with ezeep

☑ ezeep cloud printing is enabled for the AVD session. To add and enable/disable ezeep printers, go to Devices > 
Printer > ThinPrint > Printer, see Printer (see page 801).

ezeep is directly related to the ThinPrint configuration. When the ThinPrint configuration under Devices > 
Printer > ThinPrint is changed, close running AVD sessions and reconnect to make ezeep work again in 
these sessions.


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Plugins
Menu path: Sessions > AVD > AVD Sessions > [Session Name] > Plugins

Fabulatech Webcam/Scanner/USB Redirection

☑ The Fabulatech plugin is active for this session. Please note that the individual redirections enabled by the 
plugin, i.e. webcam redirection, scanner redirection, and USB redirection are configured system-wide under 
Sessions > AVD > AVD Global > Plugins > Fabulatech; see Fabulatech (see page 501).

☐ The Fabulatech plugin is not active for this session.

Zoom VDI Media Plugin

☑ The audio and video streams for Zoom are redirected between the endpoint devices resp. between the endpoint 
devices and the Zoom server. Audio and video data is not processed by the AVD server.

☐ The audio and video streams for Zoom are not redirected.
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Desktop Integration
Menu path: Sessions > AVD > AVD Sessions > [Session Name] > Desktop Integration

In this area, you can configure desktop integration for the AVD session.

Session name: Name for the session.

Starting Methods for Session
Start menu

☑ The session can be launched from the start menu.

Application Launcher

☑ The session can be launched with the Application Launcher.

Desktop

☑ The session can be launched with a program launcher on the desktop.

Quick start panel

☑ The session can be launched with the quick start panel.

Start menu's system tab

☑ The session can be launched with the start menu's system tab.

Application Launcher's system tab

☑ The session can be launched with the Application Launcher's system tab.

Desktop context menu

☑ The session can be launched with the desktop context menu.

Menu folder: If you specify a folder name or a path comprising a number of folder names separated by "/", a menu 
path will be created for the session. The menu path will be used in the start menu and in the desktop context menu.

Application Launcher folder: If you specify a folder name or a path comprising a number of folder names 
separated by "/", a menu path will be created for the session. The menu path will be used in the Application 
Launcher.

Desktop folder: If you specify a folder name or a path comprising a number of folder names separated by "/", a 
menu path will be created for the session. The menu path will be used for the program launcher on the desktop.

Password protection: Specifies which password will be requested when launching the session.
Possible values:

None: No password is requested when launching the session.
Administrator: The administrator password is requested when launching the session.
User: The user password is requested when launching the session.

The session name must not contain any of these characters: \ / : * ? “ < > | [ ] { } ( )
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Setup user: The setup user's password is requested when launching the session.

Hotkey

☑ The session can be started with a hotkey. A hotkey consists of one or more modifiers and a key.

Modifiers: A modifier or a combination of several modifiers for the hotkey. You can select a set key symbol/
combination or your own key symbol/combination. A key symbol is a defined chain of characters, e.g.  Ctrl .

These are the pre-defined modifiers and the associated key symbols:

(No modifier) =  None

 =  Shift
[Ctrl] =  Ctrl

 =  Mod4

[Alt] =  Alt

Key combinations are formed as follows with  | :

Ctrl +   =  Ctrl|Super_L

Key: Key for the hotkey

Autostart

☑ The session will be launched automatically when the device boots.

Restart

☑ The session will be relaunched automatically after the termination.

Autostart delay: Waiting time in seconds between the complete startup of the desktop and the automatic session 
launch.

Do not use [AltGr] as a modifier (represented as Mod5 ). Otherwise, the key that is configured as a hotkey 
with AltGr cannot be used as a regular key anymore. Example: If you configure [AltGr] + [E] as a hotkey, it is 
impossible to enter an "e".



When this keyboard key is used as a modifier, it is represented as Mod4 ; when it is used as a key, it 

is represented as Super_L .



To enter a key that does not have a visible character, e. g. the [Tab] key, open a terminal, log on as user

and enter xev -event keyboard . Press the key to be used for the hotkey. The text in brackets that 

begins with keysym  contains the key symbol for the Key field. Example: Tab  in (keysym 0xff09, 

Tab)


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Autostart notification: This parameter is available if Autostart is activated and Autostart delay is set to a value 
greater than zero.

☑ For the duration defined by Autostart delay, a dialog is shown which allows the user to start the session 
immediately or cancel the automatic session start.

☐ No dialog is shown; the session is started automatically after the timespan specified with Autostart delay.

Autostart requires network

☑ If no network is available at system startup, the session is not started. A message is shown. As soon as the 
network is available, the session is started automatically.

☐ The session is started automatically, even when no network is available.
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deskMate Session
Menu path: Sessions > deskMate > deskMate Sessions > [Session Name]

In this area, you can configure desktop integration for the deskMate session.

Session name: Name for the session.

Starting Methods for Session
Start menu

☑ The session can be launched from the start menu.

Application Launcher

☑ The session can be launched with the Application Launcher.

Desktop

☑ The session can be launched with a program launcher on the desktop.

Quick start panel

☑ The session can be launched with the quick start panel.

Start menu's system tab

☑ The session can be launched with the start menu's system tab.

Application Launcher's system tab

☑ The session can be launched with the Application Launcher's system tab.

Desktop context menu

☑ The session can be launched with the desktop context menu.

Menu folder: If you specify a folder name or a path comprising a number of folder names separated by "/", a menu 
path will be created for the session. The menu path will be used in the start menu and in the desktop context menu.

Application Launcher folder: If you specify a folder name or a path comprising a number of folder names 
separated by "/", a menu path will be created for the session. The menu path will be used in the Application 
Launcher.

Desktop folder: If you specify a folder name or a path comprising a number of folder names separated by "/", a 
menu path will be created for the session. The menu path will be used for the program launcher on the desktop.

Password protection: Specifies which password will be requested when launching the session.
Possible values:

None: No password is requested when launching the session.
Administrator: The administrator password is requested when launching the session.
User: The user password is requested when launching the session.

The session name must not contain any of these characters: \ / : * ? “ < > | [ ] { } ( )
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Setup user: The setup user's password is requested when launching the session.

Hotkey

☑ The session can be started with a hotkey. A hotkey consists of one or more modifiers and a key.

Modifiers: A modifier or a combination of several modifiers for the hotkey. You can select a set key symbol/
combination or your own key symbol/combination. A key symbol is a defined chain of characters, e.g.  Ctrl .

These are the pre-defined modifiers and the associated key symbols:

(No modifier) =  None

 =  Shift
[Ctrl] =  Ctrl

 =  Mod4

[Alt] =  Alt

Key combinations are formed as follows with  | :

Ctrl +   =  Ctrl|Super_L

Key: Key for the hotkey

Autostart

☑ The session will be launched automatically when the device boots.

Restart

☑ The session will be relaunched automatically after the termination.

Autostart delay: Waiting time in seconds between the complete startup of the desktop and the automatic session 
launch.

Do not use [AltGr] as a modifier (represented as Mod5 ). Otherwise, the key that is configured as a hotkey 
with AltGr cannot be used as a regular key anymore. Example: If you configure [AltGr] + [E] as a hotkey, it is 
impossible to enter an "e".



When this keyboard key is used as a modifier, it is represented as Mod4 ; when it is used as a key, it 

is represented as Super_L .



To enter a key that does not have a visible character, e. g. the [Tab] key, open a terminal, log on as user

and enter xev -event keyboard . Press the key to be used for the hotkey. The text in brackets that 

begins with keysym  contains the key symbol for the Key field. Example: Tab  in (keysym 0xff09, 

Tab)


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Autostart notification: This parameter is available if Autostart is activated and Autostart delay is set to a value 
greater than zero.

☑ For the duration defined by Autostart delay, a dialog is shown which allows the user to start the session 
immediately or cancel the automatic session start.

☐ No dialog is shown; the session is started automatically after the timespan specified with Autostart delay.

Autostart requires network

☑ If no network is available at system startup, the session is not started. A message is shown. As soon as the 
network is available, the session is started automatically.

☐ The session is started automatically, even when no network is available.

Provider (see page 523)
Options (see page 524)
Network (see page 525)
Desktop Integration (see page 526)
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Provider
Menu path: Sessions > deskMate > deskMate Sessions > [Session Name] > Provider

Provider URL: URL to the deskMate portal, issued by your deskMate provider. Example: https://

example.tocario.com

Login email address: Email address used for logging in to the deskMate session.
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Options
Menu path: Sessions > deskMate > deskMate Sessions > [Session Name] > Options

Full-screen

☑ The entire display area will be used for the deskMate session.

Clipboard redirection

☑ Clipboard data can be shared between a session and the local computer. (Default)

Display scaling

☑ Local display of the deskMate session can be resized.

Adaptive resolution

☑ The remote desktop resolution will automatically be adjusted in accordance with the local resolution. (Default)

Enable logging

☑ Debug logs will be created. 

Logfile destination: Path to the debug logs generated if Enable logging is activated. (Default: /userhome/

deskmate.log )
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Network
Menu path: Sessions > deskMate > deskMate Sessions > [Session Name] > Network

Use a proxy server

☑ An HTTP proxy will be used.

Proxy host address: Hostname or IP address of the proxy server

Proxy host port: Port on which the proxy service is available
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Desktop Integration
Menu path: Sessions > deskMate > deskMate Sessions > [Session Name] > Desktop Integration

Session name: Name for the session.

Starting Methods for Session
Start menu

☑ The session can be launched from the start menu.

Application Launcher

☑ The session can be launched with the Application Launcher.

Desktop

☑ The session can be launched with a program launcher on the desktop.

Quick start panel

☑ The session can be launched with the quick start panel.

Start menu's system tab

☑ The session can be launched with the start menu's system tab.

Application Launcher's system tab

☑ The session can be launched with the Application Launcher's system tab.

Desktop context menu

☑ The session can be launched with the desktop context menu.

Menu folder: If you specify a folder name or a path comprising a number of folder names separated by "/", a menu 
path will be created for the session. The menu path will be used in the start menu and in the desktop context menu.

Application Launcher folder: If you specify a folder name or a path comprising a number of folder names 
separated by "/", a menu path will be created for the session. The menu path will be used in the Application 
Launcher.

Desktop folder: If you specify a folder name or a path comprising a number of folder names separated by "/", a 
menu path will be created for the session. The menu path will be used for the program launcher on the desktop.

Password protection: Specifies which password will be requested when launching the session.
Possible values:

None: No password is requested when launching the session.
Administrator: The administrator password is requested when launching the session.
User: The user password is requested when launching the session.
Setup user: The setup user's password is requested when launching the session.

The session name must not contain any of these characters: \ / : * ? “ < > | [ ] { } ( )
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Hotkey

☑ The session can be started with a hotkey. A hotkey consists of one or more modifiers and a key.

Modifiers: A modifier or a combination of several modifiers for the hotkey. You can select a set key symbol/
combination or your own key symbol/combination. A key symbol is a defined chain of characters, e.g.  Ctrl .

These are the pre-defined modifiers and the associated key symbols:

(No modifier) =  None

 =  Shift
[Ctrl] =  Ctrl

 =  Mod4

[Alt] =  Alt

Key combinations are formed as follows with  | :

Ctrl +   =  Ctrl|Super_L

Key: Key for the hotkey

Autostart

☑ The session will be launched automatically when the device boots.

Restart

☑ The session will be relaunched automatically after the termination.

Autostart delay: Waiting time in seconds between the complete startup of the desktop and the automatic session 
launch.

Do not use [AltGr] as a modifier (represented as Mod5 ). Otherwise, the key that is configured as a hotkey 
with AltGr cannot be used as a regular key anymore. Example: If you configure [AltGr] + [E] as a hotkey, it is 
impossible to enter an "e".



When this keyboard key is used as a modifier, it is represented as Mod4 ; when it is used as a key, it 

is represented as Super_L .



To enter a key that does not have a visible character, e. g. the [Tab] key, open a terminal, log on as user

and enter xev -event keyboard . Press the key to be used for the hotkey. The text in brackets that 

begins with keysym  contains the key symbol for the Key field. Example: Tab  in (keysym 0xff09, 

Tab)


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Autostart notification: This parameter is available if Autostart is activated and Autostart delay is set to a value 
greater than zero.

☑ For the duration defined by Autostart delay, a dialog is shown which allows the user to start the session 
immediately or cancel the automatic session start.

☐ No dialog is shown; the session is started automatically after the timespan specified with Autostart delay.

Autostart requires network

☑ If no network is available at system startup, the session is not started. A message is shown. As soon as the 
network is available, the session is started automatically.

☐ The session is started automatically, even when no network is available.
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Unified Communications
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Zoom Client Selection
Menu path: Sessions > Unified Communications > Zoom Client Selection

Zoom client version: Selects the Zoom client version to be used for the Zoom VDI Media Plugin. The Zoom client for 
the relevant sessions can be activated as follows:

Sessions > Citrix > Citrix Global > Unified Communications > VDI Solutions (see page 88), 
parameter Zoom VDI Media Plugin
Sessions > Horizon Client > Horizon Client Global > Unified Communications > VDI 
Solutions (see page 205), parameter Zoom VDI Media Plugin
Sessions > AVD > AVD Sessions > [session name] > Plugins (see page 516), parameter Zoom VDI 
Media Plugin
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Cisco WebEx Meetings VDI Selection
Menu path: Sessions > Unified Communications > Cisco WebEx Meetings VDI Selection

Cisco WebEx Meetings client version: Selects the desired client version to be used for Cisco WebEx Meetings VDI. 
The Cisco WebEx Meetings client for the relevant sessions can be activated as follows:

Sessions > Citrix > Citrix Global > Unified Communications > Cisco Jabber (see page 90), 
parameter Cisco WebEx Meetings VDI
Sessions > Horizon Client > Horizon Client Global > Unified Communications >Cisco (see page 
204), parameter Cisco WebEx Meetings VDI
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Desktop Integration
Menu path: Sessions > Amazon > WorkSpaces > Amazon WorkSpaces > [Session Name] > Desktop Integration

Session name: Name for the session.

Starting Methods for Session
Start menu

☑ The session can be launched from the start menu.

Application Launcher

☑ The session can be launched with the Application Launcher.

Desktop

☑ The session can be launched with a program launcher on the desktop.

Quick start panel

☑ The session can be launched with the quick start panel.

Start menu's system tab

☑ The session can be launched with the start menu's system tab.

Application Launcher's system tab

☑ The session can be launched with the Application Launcher's system tab.

Desktop context menu

☑ The session can be launched with the desktop context menu.

Menu folder: If you specify a folder name or a path comprising a number of folder names separated by "/", a menu 
path will be created for the session. The menu path will be used in the start menu and in the desktop context menu.

Application Launcher folder: If you specify a folder name or a path comprising a number of folder names 
separated by "/", a menu path will be created for the session. The menu path will be used in the Application 
Launcher.

Desktop folder: If you specify a folder name or a path comprising a number of folder names separated by "/", a 
menu path will be created for the session. The menu path will be used for the program launcher on the desktop.

Password protection: Specifies which password will be requested when launching the session.
Possible values:

None: No password is requested when launching the session.
Administrator: The administrator password is requested when launching the session.
User: The user password is requested when launching the session.
Setup user: The setup user's password is requested when launching the session.

The session name must not contain any of these characters: \ / : * ? “ < > | [ ] { } ( )
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•

•

•

•

•

•

Hotkey

☑ The session can be started with a hotkey. A hotkey consists of one or more modifiers and a key.

Modifiers: A modifier or a combination of several modifiers for the hotkey. You can select a set key symbol/
combination or your own key symbol/combination. A key symbol is a defined chain of characters, e.g.  Ctrl .

These are the pre-defined modifiers and the associated key symbols:

(No modifier) =  None

 =  Shift
[Ctrl] =  Ctrl

 =  Mod4

[Alt] =  Alt

Key combinations are formed as follows with  | :

Ctrl +   =  Ctrl|Super_L

Key: Key for the hotkey

Autostart

☑ The session will be launched automatically when the device boots.

Restart

☑ The session will be relaunched automatically after the termination.

Autostart delay: Waiting time in seconds between the complete startup of the desktop and the automatic session 
launch.

Do not use [AltGr] as a modifier (represented as Mod5 ). Otherwise, the key that is configured as a hotkey 
with AltGr cannot be used as a regular key anymore. Example: If you configure [AltGr] + [E] as a hotkey, it is 
impossible to enter an "e".



When this keyboard key is used as a modifier, it is represented as Mod4 ; when it is used as a key, it 

is represented as Super_L .



To enter a key that does not have a visible character, e. g. the [Tab] key, open a terminal, log on as user

and enter xev -event keyboard . Press the key to be used for the hotkey. The text in brackets that 

begins with keysym  contains the key symbol for the Key field. Example: Tab  in (keysym 0xff09, 

Tab)


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Autostart notification: This parameter is available if Autostart is activated and Autostart delay is set to a value 
greater than zero.

☑ For the duration defined by Autostart delay, a dialog is shown which allows the user to start the session 
immediately or cancel the automatic session start.

☐ No dialog is shown; the session is started automatically after the timespan specified with Autostart delay.

Autostart requires network

☑ If no network is available at system startup, the session is not started. A message is shown. As soon as the 
network is available, the session is started automatically.

☐ The session is started automatically, even when no network is available.
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•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•

Accessories
ICA Connection Center (see page 536)
Terminals (see page 540)
Change Smartcard Password (see page 544)
Change Password (see page 548)
Setup (see page 552)
Quick Settings (see page 559)
Display Switch (see page 563)
Application Launcher (see page 574)
Sound Preferences (see page 578)
System Log Viewer (see page 584)
UMS Registration (see page 589)
Touchscreen Calibration (see page 592)
Task Manager (see page 596)
Screenshot Tool (see page 603)
On-Screen Keyboard (see page 607)
Java Manager (see page 611)
Monitor Calibration (see page 615)
Commands (see page 618)
Network Tools (see page 621)
Bluetooth Tool (see page 626)
System Information (see page 631)
Disk Utility (see page 635)
Disk Removal (see page 639)
Mobile Device Access (see page 643)
Firmware Update (see page 646)
Smartcard Personalization (see page 650)
Identify Monitors (see page 654)
Webcam Information (see page 658)
ICG Agent Setup (see page 662)
Licensing (see page 666)
Connector ID Key Software (see page 669)
OS 11 Upgrade (see page 670)
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ICA Connection Center
Menu path: Accessories > ICA Connection Center

With the Citrix ICA Connection Center, you are given an overview of the existing connections to Citrix servers as well 
as information regarding connection properties. You can also terminate server connections and log off from Citrix
servers. For details of how to use the ICA Connection Center, see Using ICA Connection Center (see page 539).

The settings for starting the function are described below.

Session name: Name for the session.

Starting Methods for Session
Start menu

☑ The session can be launched from the start menu.

Application Launcher

☑ The session can be launched with the Application Launcher.

Desktop

☑ The session can be launched with a program launcher on the desktop.

Quick start panel

☑ The session can be launched with the quick start panel.

Start menu's system tab

☑ The session can be launched with the start menu's system tab.

Application Launcher's system tab

☑ The session can be launched with the Application Launcher's system tab.

Desktop context menu

☑ The session can be launched with the desktop context menu.

Menu folder: If you specify a folder name or a path comprising a number of folder names separated by "/", a menu 
path will be created for the session. The menu path will be used in the start menu and in the desktop context menu.

Application Launcher folder: If you specify a folder name or a path comprising a number of folder names 
separated by "/", a menu path will be created for the session. The menu path will be used in the Application 
Launcher.

Desktop folder: If you specify a folder name or a path comprising a number of folder names separated by "/", a 
menu path will be created for the session. The menu path will be used for the program launcher on the desktop.

Password protection: Specifies which password will be requested when launching the session.
Possible values:

The session name must not contain any of these characters: \ / : * ? “ < > | [ ] { } ( )
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•
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•

•

•

•

•

•

•

None: No password is requested when launching the session.
Administrator: The administrator password is requested when launching the session.
User: The user password is requested when launching the session.
Setup user: The setup user's password is requested when launching the session.

Hotkey

☑ The session can be started with a hotkey. A hotkey consists of one or more modifiers and a key.

Modifiers: A modifier or a combination of several modifiers for the hotkey. You can select a set key symbol/
combination or your own key symbol/combination. A key symbol is a defined chain of characters, e.g.  Ctrl .

These are the pre-defined modifiers and the associated key symbols:

(No modifier) =  None

 =  Shift
[Ctrl] =  Ctrl

 =  Mod4

[Alt] =  Alt

Key combinations are formed as follows with  | :

Ctrl +   =  Ctrl|Super_L

Key: Key for the hotkey

Autostart

☑ The session will be launched automatically when the device boots.

Restart

☑ The session will be relaunched automatically after the termination.

Do not use [AltGr] as a modifier (represented as Mod5 ). Otherwise, the key that is configured as a hotkey 
with AltGr cannot be used as a regular key anymore. Example: If you configure [AltGr] + [E] as a hotkey, it is 
impossible to enter an "e".



When this keyboard key is used as a modifier, it is represented as Mod4 ; when it is used as a key, it 

is represented as Super_L .



To enter a key that does not have a visible character, e. g. the [Tab] key, open a terminal, log on as user

and enter xev -event keyboard . Press the key to be used for the hotkey. The text in brackets that 

begins with keysym  contains the key symbol for the Key field. Example: Tab  in (keysym 0xff09, 

Tab)





Accessories

IGEL OS Reference Manual   538 / 897

•
•
•

•
•

•

Autostart delay: Waiting time in seconds between the complete startup of the desktop and the automatic session 
launch.

Appliance mode access: Determines whether the session can be started in appliance mode. By default, appliance 
mode implies that one session is running on the device exclusively. For further information, see Appliance Mode (see 
page 220).

☑ The session can be started in appliance mode. The following starting methods can be used in appliance mode:

Desktop (desktop icon; not in appliance mode XDMCP for this Display)
Desktop Context Menu (not in appliance mode XDMCP for this Display)
Application Launcher (includes Application Launcher's system tab; not in appliance 
mode XDMCP for this Display)
Hotkey
Autostart (not in appliance mode XDMCP for this Display)

☐ The session cannot be started in appliance mode. 

Using ICA Connection Center (see page 539)
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1.

2.
3.

4.

1.

2.
3.

1.

2.
3.

Using ICA Connection Center
To obtain an overview of the existing connections to Citrix servers, proceed as follows:

 Start the ICA Connection Center. The start options are described under ICA Connection Center (see page 536).
All applications are shown in a tree structure with the associated Citrix servers.

To view the properties of a connection to a Citrix server, proceed as follows:

Start the ICA Connection Center. The start options are described under ICA Connection Center (see 
page 536).
Click on the server whose connection properties you want to view.
Click on the Properties button.
The connection properties as well as constantly updated information regarding the number of 
incoming and outgoing bytes and frames will be shown.
If you would like to reset the counter for incoming and outgoing bytes to 0, click on Reset.

To terminate a server connection, proceed as follows:

Start the ICA Connection Center. The start options are described under ICA Connection Center (see 
page 536).
Click on the server whose connection you want to terminate.
Click on Terminate.
The connection to the server is terminated. The Citrix session will be interrupted. The applications 
will not be terminated on the server. As a result, the application status will be retained until the 
session is resumed.

To log off from the Citrix server, proceed as follows:

Start the ICA Connection Center. The start options are described under ICA Connection Center (see 
page 536).
Click on the server from which you want to log off.
Click on Log off.
The connection to the server is terminated. The Citrix session will end. The applications on the 
server will be terminated.

With the help of the tree structure, you can see which applications run on which servers. If a number of 
applications run on the same server, this will make the exchanging of data between these applications 
easier.


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Terminals
Menu path: Accessories > Terminals > Local Terminal

With the local terminal, you can execute local commands on your thin client. For details of how to use the local 
terminal, see Using Local Terminal (see page 543).

The settings for starting the function are described below.

Session name: Name for the session.

Starting Methods for Session
Start menu

☑ The session can be launched from the start menu.

Application Launcher

☑ The session can be launched with the Application Launcher.

Desktop

☑ The session can be launched with a program launcher on the desktop.

Quick start panel

☑ The session can be launched with the quick start panel.

Start menu's system tab

☑ The session can be launched with the start menu's system tab.

Application Launcher's system tab

☑ The session can be launched with the Application Launcher's system tab.

Desktop context menu

☑ The session can be launched with the desktop context menu.

Menu folder: If you specify a folder name or a path comprising a number of folder names separated by "/", a menu 
path will be created for the session. The menu path will be used in the start menu and in the desktop context menu.

Application Launcher folder: If you specify a folder name or a path comprising a number of folder names 
separated by "/", a menu path will be created for the session. The menu path will be used in the Application 
Launcher.

It is also possible to access a local shell without a terminal session: Alternatively, you can switch to the 
virtual terminals tty11  and tty12  by pressing [Ctrl]+[Alt]+[F11 ]or [Ctrl]+[Alt]+[F12]. Pressing [Ctrl]+
[Alt]+[F1] takes you back to the user interface.



The session name must not contain any of these characters: \ / : * ? “ < > | [ ] { } ( )
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•

•

•

•

•

Desktop folder: If you specify a folder name or a path comprising a number of folder names separated by "/", a 
menu path will be created for the session. The menu path will be used for the program launcher on the desktop.

Hotkey

☑ The session can be started with a hotkey. A hotkey consists of one or more modifiers and a key.

Modifiers: A modifier or a combination of several modifiers for the hotkey. You can select a set key symbol/
combination or your own key symbol/combination. A key symbol is a defined chain of characters, e.g.  Ctrl .

These are the pre-defined modifiers and the associated key symbols:

(No modifier) =  None

 =  Shift
[Ctrl] =  Ctrl

 =  Mod4

[Alt] =  Alt

Key combinations are formed as follows with  | :

Ctrl +   =  Ctrl|Super_L

Key: Key for the hotkey

Autostart

☑ The session will be launched automatically when the device boots.

Restart

☑ The session will be relaunched automatically after the termination.

Do not use [AltGr] as a modifier (represented as Mod5 ). Otherwise, the key that is configured as a hotkey 
with AltGr cannot be used as a regular key anymore. Example: If you configure [AltGr] + [E] as a hotkey, it is 
impossible to enter an "e".



When this keyboard key is used as a modifier, it is represented as Mod4 ; when it is used as a key, it 

is represented as Super_L .



To enter a key that does not have a visible character, e. g. the [Tab] key, open a terminal, log on as user

and enter xev -event keyboard . Press the key to be used for the hotkey. The text in brackets that 

begins with keysym  contains the key symbol for the Key field. Example: Tab  in (keysym 0xff09, 

Tab)


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•

Autostart delay: Waiting time in seconds between the complete startup of the desktop and the automatic session 
launch.

Appliance mode access: Determines whether the session can be started in appliance mode. By default, appliance 
mode implies that one session is running on the device exclusively. For further information, see Appliance Mode (see 
page 220).

☑ The session can be started in appliance mode. The following starting methods can be used in appliance mode:

Desktop (desktop icon; not in appliance mode XDMCP for this Display)
Desktop Context Menu (not in appliance mode XDMCP for this Display)
Application Launcher (includes Application Launcher's system tab; not in appliance 
mode XDMCP for this Display)
Hotkey
Autostart (not in appliance mode XDMCP for this Display)

☐ The session cannot be started in appliance mode. 

Using Local Terminal (see page 543)
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1.
2.

Using Local Terminal
To use the local terminal, proceed as follows:

Start the local terminal. The start options are described under Terminals (see page 540).
Log in as user  or root .

You can enter the shell commands supported by IGEL OS.

•

•

If under Setup > Security > Password, in the Administrator area, the option Use password is 
enabled, you will need to enter the administrator password to access a local terminal as root .

If an administrator password is set, accessing a local terminal as user  is only possible if the 
following two conditions are met:

Access to local terminals has been activated for user . This is possible with the 

registry key system.security.usershell . The default setting of the registry 

key forbids terminal access for user .
Under Setup > Security > Password, in the User area,  the option Use password is 
enabled.

For accessing a local terminal as user , the user password will have to be entered.


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Change Smartcard Password
Menu path:  Accessories > Change Smartcard Password

With this function, you can change the password for your IGEL smartcard. For details of how to use the function, see 
Using Change Smartcard Password Function (see page 547).

Further information regarding the IGEL smartcard can be found under Authentication with IGEL Smartcard.

The settings for starting the function are described below.

Session name: Name for the session.

Starting Methods for Session
Start menu

☑ The session can be launched from the start menu.

Application Launcher

☑ The session can be launched with the Application Launcher.

Desktop

☑ The session can be launched with a program launcher on the desktop.

Quick start panel

☑ The session can be launched with the quick start panel.

Start menu's system tab

☑ The session can be launched with the start menu's system tab.

Application Launcher's system tab

☑ The session can be launched with the Application Launcher's system tab.

Desktop context menu

☑ The session can be launched with the desktop context menu.

Menu folder: If you specify a folder name or a path comprising a number of folder names separated by "/", a menu 
path will be created for the session. The menu path will be used in the start menu and in the desktop context menu.

Application Launcher folder: If you specify a folder name or a path comprising a number of folder names 
separated by "/", a menu path will be created for the session. The menu path will be used in the Application 
Launcher.

Desktop folder: If you specify a folder name or a path comprising a number of folder names separated by "/", a 
menu path will be created for the session. The menu path will be used for the program launcher on the desktop.

The session name must not contain any of these characters: \ / : * ? “ < > | [ ] { } ( )
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•

•

•

Password protection: Specifies which password will be requested when launching the session.
Possible values:

None: No password is requested when launching the session.
Administrator: The administrator password is requested when launching the session.
User: The user password is requested when launching the session.
Setup user: The setup user's password is requested when launching the session.

Hotkey

☑ The session can be started with a hotkey. A hotkey consists of one or more modifiers and a key.

Modifiers: A modifier or a combination of several modifiers for the hotkey. You can select a set key symbol/
combination or your own key symbol/combination. A key symbol is a defined chain of characters, e.g.  Ctrl .

These are the pre-defined modifiers and the associated key symbols:

(No modifier) =  None

 =  Shift
[Ctrl] =  Ctrl

 =  Mod4

[Alt] =  Alt

Key combinations are formed as follows with  | :

Ctrl +   =  Ctrl|Super_L

Key: Key for the hotkey

Do not use [AltGr] as a modifier (represented as Mod5 ). Otherwise, the key that is configured as a hotkey 
with AltGr cannot be used as a regular key anymore. Example: If you configure [AltGr] + [E] as a hotkey, it is 
impossible to enter an "e".



When this keyboard key is used as a modifier, it is represented as Mod4 ; when it is used as a key, it 

is represented as Super_L .



To enter a key that does not have a visible character, e. g. the [Tab] key, open a terminal, log on as user

and enter xev -event keyboard . Press the key to be used for the hotkey. The text in brackets that 

begins with keysym  contains the key symbol for the Key field. Example: Tab  in (keysym 0xff09, 

Tab)


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• Using Change Smartcard Password Function (see page 547)
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1.

2.
•
•
•

Using Change Smartcard Password Function
With this function, you can change the password for your IGEL smartcard. In order to do this, the Logon with IGEL 
smartcard option must be enabled under Security > Logon > IGEL Smartcard.

To change the password for your IGEL smartcard, proceed as follows:

Start the Change Smartcard Password function. The start options are described under Change 
Smartcard Password (see page 544).
Enter the following data in the dialog:

Old smartcard password: Previous password
New smartcard password: Chosen password
Reenter new smartcard password: Chosen password (entered again)

The password for your IGEL smartcard will be changed.
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Change Password
Menu path: Accessories > Change Password

With this function, the user can change the password or PIN for the login method he used for his current session, 
provided one of the following login methods was used:

Active Directory with username and password
Active Directory with third-party smartcard
IGEL smartcard
Local user with screenlock password

For details of how to use the Change Password function, see Using "Change password" function (see page 551).

The settings for starting the function are described below.

Session name: Name for the session.

Starting Methods for Session
Start menu

☑ The session can be launched from the start menu.

Application Launcher

☑ The session can be launched with the Application Launcher.

Desktop

☑ The session can be launched with a program launcher on the desktop.

Quick start panel

☑ The session can be launched with the quick start panel.

Start menu's system tab

☑ The session can be launched with the start menu's system tab.

Application Launcher's system tab

☑ The session can be launched with the Application Launcher's system tab.

Desktop context menu

☑ The session can be launched with the desktop context menu.

The Change Password function starts when the user clicks the password change button in the dialog 
informing him that a change of password is required. This dialog is presented after login.



The session name must not contain any of these characters: \ / : * ? “ < > | [ ] { } ( )
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Menu folder: If you specify a folder name or a path comprising a number of folder names separated by "/", a menu 
path will be created for the session. The menu path will be used in the start menu and in the desktop context menu.

Application Launcher folder: If you specify a folder name or a path comprising a number of folder names 
separated by "/", a menu path will be created for the session. The menu path will be used in the Application 
Launcher.

Desktop folder: If you specify a folder name or a path comprising a number of folder names separated by "/", a 
menu path will be created for the session. The menu path will be used for the program launcher on the desktop.

Password protection: Specifies which password will be requested when launching the session.
Possible values:

None: No password is requested when launching the session.
Administrator: The administrator password is requested when launching the session.
User: The user password is requested when launching the session.
Setup user: The setup user's password is requested when launching the session.

Hotkey

☑ The session can be started with a hotkey. A hotkey consists of one or more modifiers and a key.

Modifiers: A modifier or a combination of several modifiers for the hotkey. You can select a set key symbol/
combination or your own key symbol/combination. A key symbol is a defined chain of characters, e.g.  Ctrl .

These are the pre-defined modifiers and the associated key symbols:

(No modifier) =  None

 =  Shift
[Ctrl] =  Ctrl

 =  Mod4

[Alt] =  Alt

Key combinations are formed as follows with  | :

Ctrl +   =  Ctrl|Super_L

Key: Key for the hotkey

Do not use [AltGr] as a modifier (represented as Mod5 ). Otherwise, the key that is configured as a hotkey 
with AltGr cannot be used as a regular key anymore. Example: If you configure [AltGr] + [E] as a hotkey, it is 
impossible to enter an "e".



When this keyboard key is used as a modifier, it is represented as Mod4 ; when it is used as a key, it 

is represented as Super_L .


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• Using Change Password Function (see page 551)

To enter a key that does not have a visible character, e. g. the [Tab] key, open a terminal, log on as user

and enter xev -event keyboard . Press the key to be used for the hotkey. The text in brackets that 

begins with keysym  contains the key symbol for the Key field. Example: Tab  in (keysym 0xff09, 

Tab)


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1.

2.

3.

Using Change Password Function
To change your password for your current login method (Active Directory with user and password, Active Directory 
with third-party smartcard, IGEL smartcard, or local user with screenlock password), proceed as follows

Start the Change password function. The start options are described under Change password (see 
page 548).
Enter the changed password or PIN in the dialog. The dialog differs according to the login method 
that is currently used.
Click OK.
The password is changed.
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Setup
Menu path: Accessories > Setup

With the IGEL Setup, you can configure your endpoint device. For details of how to allow the user access to the 
individual areas of the Setup, see Setup User Permissions - Define Access to IGEL Setup Areas (see page 554). For 
details of how to change the setup options, see Options (see page 558).

The settings for starting the function are described below.

Session name: Name for the session.

Starting Methods for Session
Start menu

☑ The session can be launched from the start menu.

Application Launcher

☑ The session can be launched with the Application Launcher.

Desktop

☑ The session can be launched with a program launcher on the desktop.

Quick start panel

☑ The session can be launched with the quick start panel.

Start menu's system tab

☑ The session can be launched with the start menu's system tab.

Application Launcher's system tab

☑ The session can be launched with the Application Launcher's system tab.

Desktop context menu

☑ The session can be launched with the desktop context menu.

Menu folder: If you specify a folder name or a path comprising a number of folder names separated by "/", a menu 
path will be created for the session. The menu path will be used in the start menu and in the desktop context menu.

Application Launcher folder: If you specify a folder name or a path comprising a number of folder names 
separated by "/", a menu path will be created for the session. The menu path will be used in the Application 
Launcher.

Desktop folder: If you specify a folder name or a path comprising a number of folder names separated by "/", a 
menu path will be created for the session. The menu path will be used for the program launcher on the desktop.

Hotkey

The session name must not contain any of these characters: \ / : * ? “ < > | [ ] { } ( )
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•

•

•

•

•
•
•

☑ The session can be started with a hotkey. A hotkey consists of one or more modifiers and a key.

Modifiers: A modifier or a combination of several modifiers for the hotkey. You can select a set key symbol/
combination or your own key symbol/combination. A key symbol is a defined chain of characters, e.g.  Ctrl .

These are the pre-defined modifiers and the associated key symbols:

(No modifier) =  None

 =  Shift
[Ctrl] =  Ctrl

 =  Mod4

[Alt] =  Alt

Key combinations are formed as follows with  | :

Ctrl +   =  Ctrl|Super_L

Key: Key for the hotkey

Setup User Permissions - Define Access to IGEL Setup Areas (see page 554)
Setup Administrator Permissions - Define Access to IGEL Setup Areas (see page 556)
Options (see page 558)

Do not use [AltGr] as a modifier (represented as Mod5 ). Otherwise, the key that is configured as a hotkey 
with AltGr cannot be used as a regular key anymore. Example: If you configure [AltGr] + [E] as a hotkey, it is 
impossible to enter an "e".



When this keyboard key is used as a modifier, it is represented as Mod4 ; when it is used as a key, it 

is represented as Super_L .



To enter a key that does not have a visible character, e. g. the [Tab] key, open a terminal, log on as user

and enter xev -event keyboard . Press the key to be used for the hotkey. The text in brackets that 

begins with keysym  contains the key symbol for the Key field. Example: Tab  in (keysym 0xff09, 

Tab)


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1.

Setup User Permissions - Define Access to IGEL Setup Areas
In the IGEL OS, you can define passwords for different authorization levels (e.g. administrator, setup administrator, 
setup user, etc.) to protect the system against unauthorized changes, see Password - Restrict Access to IGEL OS 
Components (see page 824). If a password was set up for the administrator, the IGEL Setup can only be opened with 
administrator rights, i.e. after entering the administrator password. However, it can sometimes be necessary to 
provide access to individual areas of the IGEL Setup for the user. This is usually required to allow the user to change 
settings like the system language, right/left-handed mouse, keyboard layout, timezone, etc. if they are not 
preconfigured via a profile.

The following article explains how to specify which options in the IGEL Setup should be visible and/or configurable 
for the setup user. For details on configuring permissions for the setup administrator, see Setup Administrator 
Permissions - Define Access to IGEL Setup Areas (see page 556).

Menu path: Accessories > Setup > Setup User Permissions

To enable setup pages for the user, proceed as follows:

In the Setup, go to Accessories > Setup > Setup User Permissions and enable those areas to 
which the user is to have access.
Possible settings:

Node Setup Page

not visible not visible

visible not visible

visible configurable
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2.

This is an example of possible settings:

If not already done: Under Security > Password (see page 824), enable the password for the 
administrator and the setup user.

 If you enable a setup page on the lower levels, the node points required for access will 
automatically be marked as visible (but blocked for editing purposes). 
Example: If you activate all sub-nodes under Display (see the screenshot above), the higher-

level Display node will still be marked as  , and, therefore, settings on the Display page itself 
will be invisible for the setup user. This means you have to actively mark the higher-level node as 

 if editing has to be enabled.



If users are to be allowed to edit parts of the Setup even without a password, create a 
quick setup (see page 50) session, the password for the setup user will not be enabled in this 
case.


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1.

Setup Administrator Permissions - Define Access to IGEL Setup Areas
In the IGEL OS, you can define passwords for different authorization levels (e.g. administrator, setup administrator, 
setup user, etc.) to protect the system against unauthorized changes, see Password - Restrict Access to IGEL OS 
Components (see page 824). If a password was set up for the administrator, the IGEL Setup can only be opened with 
administrator rights, i.e. after entering the administrator password. However, it can be necessary to provide access 
to individual areas of the IGEL Setup for administrators performing minor administrative tasks, so that they can 
change local settings if they are not configured by a profile. This may be required, for example, to allow modifying 
printer settings or custom commands, adding a new local session like a Chromium browser, etc. 

The following article explains how to specify which options in the IGEL Setup should be visible and/or configurable 
for the setup administrator. For details on configuring permissions for the setup user, see Setup User Permissions - 
Define Access to IGEL Setup Areas (see page 554).

Menu path: Accessories > Setup > Setup Administrator Permissions

To enable setup pages for the setup administrator, proceed as follows:

In the Setup, go to Accessories > Setup > Setup Administrator Permissions and enable those 
areas to which the setup administrator is to have access.
Possible settings:

Node Setup Page

not visible not visible

visible not visible

visible configurable
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2.

This is an example of possible settings:

If not already done: Under Security > Password (see page 824), enable the password for 
the administrator and the setup administrator.

 If you enable a setup page on the lower levels, the node points required for access will 
automatically be marked as visible (but blocked for editing purposes).
Example: If you activate all sub-nodes under Display (see the screenshot above), the higher-

level Display node will still be marked as  , and, therefore, settings on the Display page itself 
will be invisible for the setup administrator. This means you have to actively mark the higher-level 

node as   if editing has to be enabled.



If administrators are to be allowed to edit parts of the setup even without a password, create 
a quick setup (see page 50) session, the password for the setup administrator will not be enabled in 
this case.


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Options
Menu path: Accessories > Setup > Options

You can configure the display of tooltips in the setup.

Enable Tooltips

☑ When the mouse pointer is placed over a parameter, the associated tooltip will be shown after the set delay.

☐ No tooltip will be shown.

Tooltip Delay: Time interval in tenths of a second during which the mouse pointer must be placed over a parameter 
for the tooltip to be shown.
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Quick Settings
Menu path: Accessories > Quick Settings

With the IGEL Setup, you can allow the user access to individual areas of the Setup. Instructions can be found under 
Setup User Permissions - Define Access to IGEL Setup Areas (see page 554).

The settings for starting the function are described below.

Session name: Name for the session.

Starting Methods for Session
Start menu

☑ The session can be launched from the start menu.

Application Launcher

☑ The session can be launched with the Application Launcher.

Desktop

☑ The session can be launched with a program launcher on the desktop.

Quick start panel

☑ The session can be launched with the quick start panel.

Start menu's system tab

☑ The session can be launched with the start menu's system tab.

Application Launcher's system tab

☑ The session can be launched with the Application Launcher's system tab.

Desktop context menu

☑ The session can be launched with the desktop context menu.

Menu folder: If you specify a folder name or a path comprising a number of folder names separated by "/", a menu 
path will be created for the session. The menu path will be used in the start menu and in the desktop context menu.

Application Launcher folder: If you specify a folder name or a path comprising a number of folder names 
separated by "/", a menu path will be created for the session. The menu path will be used in the Application 
Launcher.

Desktop folder: If you specify a folder name or a path comprising a number of folder names separated by "/", a 
menu path will be created for the session. The menu path will be used for the program launcher on the desktop.

Hotkey

☑ The session can be started with a hotkey. A hotkey consists of one or more modifiers and a key.

The session name must not contain any of these characters: \ / : * ? “ < > | [ ] { } ( )
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•

•

•

•

•

•

•
•
•

•
•

Modifiers: A modifier or a combination of several modifiers for the hotkey. You can select a set key symbol/
combination or your own key symbol/combination. A key symbol is a defined chain of characters, e.g.  Ctrl .

These are the pre-defined modifiers and the associated key symbols:

(No modifier) =  None

 =  Shift
[Ctrl] =  Ctrl

 =  Mod4

[Alt] =  Alt

Key combinations are formed as follows with  | :

Ctrl +   =  Ctrl|Super_L

Key: Key for the hotkey

Appliance mode access: Determines whether the session can be started in appliance mode. By default, appliance 
mode implies that one session is running on the device exclusively. For further information, see Appliance Mode (see 
page 220).

☑ The session can be started in appliance mode. The following starting methods can be used in appliance mode:

Desktop (desktop icon; not in appliance mode XDMCP for this Display)
Desktop Context Menu (not in appliance mode XDMCP for this Display)
Application Launcher (includes Application Launcher's system tab; not in appliance 
mode XDMCP for this Display)
Hotkey
Autostart (not in appliance mode XDMCP for this Display)

☐ The session cannot be started in appliance mode. 

Do not use [AltGr] as a modifier (represented as Mod5 ). Otherwise, the key that is configured as a hotkey 
with AltGr cannot be used as a regular key anymore. Example: If you configure [AltGr] + [E] as a hotkey, it is 
impossible to enter an "e".



When this keyboard key is used as a modifier, it is represented as Mod4 ; when it is used as a key, it 

is represented as Super_L .



To enter a key that does not have a visible character, e. g. the [Tab] key, open a terminal, log on as user

and enter xev -event keyboard . Press the key to be used for the hotkey. The text in brackets that 

begins with keysym  contains the key symbol for the Key field. Example: Tab  in (keysym 0xff09, 

Tab)


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• Setup User Permissions (see page 562)
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Setup User Permissions
Menu path: Accessories > Quick Settings > Setup User Permissions

Define which setup pages are visible to users.

You will find instructions for this function under Setup User Permissions - Define Access to IGEL Setup Areas (see page 
554).
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Display Switch
Menu path: Setup > Accessories > Display Switch

With this function, you can configure the display on several screens. For details of how to set the function, see 
Options (see page 566). 

The settings for starting the function are described below.

Session name: Name for the session

Session start options
Start menu

☑ The session can be started with the start menu.

Application Launcher

☑ The session can be started with the Application Launcher.

Desktop:

☑ The session can be started with a program starter on the desktop.

Quick start panel:

☑ The session can be started with the quick start panel.

Start menu's system tab

☑ The session can be started with the start menu’s system tab.

Application Launcher's system tab

☑ The session can be started with the Application Launcher’s system tab.

Desktop context menu

☑ The session can be started with the desktop context menu.

Menu folder: If you specify a folder name or a path comprising a number of folder names separated by "/", a menu 
path will be created for the session. The menu path will be used in the start menu and in the desktop context menu.

Path in the Application Launcher: If you specify a folder name or a path comprising a number of folder names 
separated by "/", a menu path will be created for the session. The menu path will be used in the Application 
Launcher.

Desktop folder: If you specify a folder name or a path comprising a number of folder names separated by "/", a 
menu path will be created for the session. The menu path will be used for the program launcher on the desktop.

Password protection: Specifies which password will be requested when launching the session.
Possible values:

None: No password is requested when launching the session.
Administrator: The administrator password is requested when launching the session.

The session name must not contain any of these characters: \ / : * ? “ < > | [ ] { } ( )
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User: The user password is requested when launching the session.
Setup user: The setup user's password is requested when launching the session.

Hotkey:

☑ The session can be started with a hotkey. A hotkey consists of one or more modifiers and a key.

Modifiers: A modifier or a combination of several modifiers for the hotkey. You can select a set key symbol/
combination or your own key symbol/combination. A key symbol is a defined chain of characters, e.g.  Ctrl .

These are the pre-defined modifiers and the associated key symbols:

(No modifier) =  None

 =  Shift
[Ctrl] =  Ctrl

 =  Mod4

[Alt] =  Alt

Key combinations are formed as follows with  | :

Ctrl +   =  Ctrl|Super_L

Key: Key for the hotkey

Autostart: If this option is enabled, the session will be launched automatically when the thin client boots.

Relaunch: If this option is enabled, the session will be relaunched automatically after termination.

Autostart delay: Waiting time in seconds between the thin client booting and the session being launched 
automatically.

Do not use [AltGr] as a modifier (represented as Mod5 ). Otherwise, the key that is configured as a hotkey 
with AltGr cannot be used as a regular key anymore. Example: If you configure [AltGr] + [E] as a hotkey, it is 
impossible to enter an "e".



When this keyboard key is used as a modifier, it is represented as Mod4 ; when it is used as a key, it 

is represented as Super_L .



To enter a key that does not have a visible character, e. g. the [Tab] key, open a terminal, log on as user

and enter xev -event keyboard . Press the key to be used for the hotkey. The text in brackets that 

begins with keysym  contains the key symbol for the Key field. Example: Tab  in (keysym 0xff09, 

Tab)


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Appliance mode access: Determines whether the session can be started in appliance mode. By default, appliance 
mode implies that one session is running on the device exclusively. For further information, see Appliance Mode (see 
page 220).

☑ The session can be started in appliance mode. The following starting methods can be used in appliance mode:

Desktop (desktop icon; not in appliance mode XDMCP for this Display)
Desktop Context Menu (not in appliance mode XDMCP for this Display)
Application Launcher (includes Application Launcher's system tab; not in appliance 
mode XDMCP for this Display)
Hotkey
Autostart (not in appliance mode XDMCP for this Display)

☐ The session cannot be started in appliance mode. 

_____

Options (see page 566)
Minimal Dialog (see page 568)
Advanced Dialog (see page 570)
Using Display Switch (see page 571)
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Options
Menu path: Setup > Accessories > Display Switch > Options

You can change the way the Display Switch function behaves.

Dialog Type
Possible values:

Minimal Dialog: The Display Switch function starts with the Basic dialog.
Advanced Dialog: The Display Switch function starts with the Advanced dialog.

Smart display configuration
☑  Each monitor configuration will be saved and automatically applied when the same monitors 
are connected again.
☐ Monitor configurations will not be saved and applied when the same monitors are connected 
again. (Default)
Preserve settings over reboot
☑ The settings for the Display Switch function will be preserved over a reboot.
☐ The settings for the Display Switch function will be reset to the default settings in the event of a 
reboot. (Default)
Configure new displays when connected
☑ The Display Switch function starts as soon as new screens are connected. You can then 
configure the new screens.
☐ The Display Switch function does not start automatically when new screens are connected. 
(Default)

Options in Minimal dialog

Mirror displays
☑ The Shadow screens option  is shown in the minimal dialog. (Default)
☐ The option is not shown in the minimal dialog.
Extend to the left
☑ The Extend to the left option  is shown in the minimal dialog. (Default)
☐ The option is not shown in the minimal dialog.
Extend to the right
☑ The Extend to the right option  is shown in the minimal dialog. (Default)
☐ The option is not shown in the minimal dialog.
Rotate displays (Page orientation)
☑ The Rotate displays (Page orientation) option  is shown in the minimal dialog.
☐ The option is not shown in the minimal dialog. (Default)
Mouse options
☑ The Left-handed mouse, Pointer speed and Double click interval settings are shown in the 
minimal dialog.
☐ The mouse settings are not shown. (Default)
Advanced
☑ The Advanced button is shown. With Advanced, you can switch to the advanced dialog. 
(Default)
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•
☐ The Advanced button is not shown.
Reset
☑ The Reset button is shown. With Reset, you can restore the default settings. (Default)
☐ The Reset button is not shown.
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Minimal Dialog
Selection Function

Uses only display 1.

Shows the same content on all screens, i.e. clone mode or 
mirroring.

Extends the display area to the screen on the right.

Extends the display area to the screen on the left

Uses only display 2.

Rotates the selected display to the left or to the right.

Identify Displays: Starts the monitor detection.

Advanced: Switches to Advanced mode of display configuration.

Reset: Restores the default settings.

Close: Closes the IGEL Display Switch window.

Mouse options

Lefthand Mode
☑Lefthand mode is active.

☐ Righthand mode is active. (Default)
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Pointer speed: Value for the mouse speed in percentage between 1 (slow) and 100 (fast). (Default: 
50)
Double click: Maximum interval in milliseconds between two mouse clicks to still be recognized as 
a double-click. (Default: 300)

For more information, see Using Display Switch (see page 571) and Display Switch.
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Advanced Dialog
You can access the advanced settings by clicking Advanced in the minimal dialog.

Advanced settings (pan/scale/resolution) can be configured in a collapsible area on the right. To enlarge 
the Advanced modes window, click the arrow on the right side of the window.

The following parameters must be activated for the Display Switch function to be able to save the settings:

Display Switch > Options > Preserve settings over reboot
Display Switch > Options > Smart display configuration

In the collapsible area:

Use this display
☑ Enables the selected display.
☐ Disables the selected display.
Index: Give the selected display an order number.
Rotation: Rotation of selected display
Possible values:

None
Left
Inverted
Right

Resolution: Select the resolution of the selected display. (Default: Automatic)
Refresh rate: Depends on the resolution (Default: Automatic)
Panning: Set up a virtual screen that is larger than your physical screen. It will look like an 
enlarged screen. By moving the mouse to the edge of the screen, hidden parts become visible. 
(Default: None)
Reflection: Transforms the display as if being reflected by a mirror.
Possible values:

None
Horizontal
Vertical
Horizontal and Vertical

Scale from: A software variant of the resolution. This can be useful if you need a resolution that is 
not available on the hardware. (Default: None)

For more information, see the articles Using Display Switch (see page 571) and Display Switch.
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1.
2.
3.

Using Display Switch
 Start the Display Switch function. The start options are described under Display Switch (see page 563).

Depending on the setting under Setup > Accessories > Display Switch > Options > Dialog Type selection, the basic 
or the advanced dialog will be shown.

Identify Displays

 To start screen detection, click on Identify Displays
The names and properties of the screens will be detected. The connection, the assigned number (1 = main screen) 
and the name will be shown on each screen. Example: 1: DVI-D(II): Samsung 24"

Specify Main Screen

If necessary, switch to the advanced dialog with Advanced.
Select the screen that you wish to specify as the main screen.
Enable Main screen.

Split Display over Several Screens
You have various options for using several screens. In the dialog, the connection, the assigned number (1 = main 
screen) and the name is shown for each screen. Example: 1: DVI-D(II): Samsung 24"

The procedure with the minimal dialog is described below. To switch from the advanced to the minimal dialog, click 
on Simple.

 To show the same content on all screens (Shadow screens), click on .

 If you would like to expand the display to all screens and the other screens are to the left of the main screen, 
click on .

 If you would like to expand the display to all screens and the other screens are to the right of the main screen, 
click on .

Rotate Displays (Page Orientation)
The procedure with the minimal dialog is described below; Setup > Accessories > Display Switch > Options > 
Rotate displays (Page orientation) must be enabled. To switch from the advanced to the minimal dialog, click on 
Basic.

 To rotate the display anti-clockwise, click on .

 To rotate the display clockwise, click on .
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1.
2.
3.
4.

5.

1.
2.

Change Mouse Settings
The procedure with the minimal dialog is described below; Setup > Accessories > Display Switch > Options > 
Mouse Options must be enabled. To switch from the advanced to the minimal dialog, click on Simple.

 To adjust the mouse for left-handed users, enable the Lefthanded Mode.

 To adjust the speed of the mouse pointer, change the value under Pointer speed. The higher the value, the 
further the mouse pointer will travel when the mouse is moved.

 To change the time interval within which two consecutive mouse clicks are recognized as a double-click, 
change the number of milliseconds under Double click interval.

Zoom Display (Screen Magnifying Glass)
You can magnify the screen content. The effect is the same as with the screen magnifying glass in Microsoft 
Windows: All text and graphics are magnified by the same factor; this results in a virtual display area which is bigger 
than the monitor’s available display area. The user therefore sees a magnified section of the entire screen content; 
the section can be moved by moving the mouse to the edge of the screen.

If necessary, switch to the advanced dialog with Advanced.
Enable Zoom.
Under Virtual resolution, set the highest possible value. Example: 1920x1200
Under Resolution, set a low value. This value simulates the actual resolution of the screen. 
Example: 1280x800
Click on Apply.
The screen content will be magnified. The magnification factor results from the ratio of the virtual 
resolution and the simulated actual resolution.

Change Refresh Rate

If necessary, switch to the advanced dialog with Advanced.
Under Refresh rate, set the desired value.

Restore Default Settings

 Click on Reset to restore the default settings.

If the same content is displayed on a number of screens (Shadow screens), all screens will 
show the same section. However, you can set a different magnification level for each of 
the screens.



A refresh rate of 60 Hz is usually suitable for standard screens.
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1.
2.

Auto Switch Monitor Configuration for Laptops
This display switch can use multiple different profiles, automatically chosen at runtime depending on the currently 
connected monitors. A profile is created when the current monitor layout/resolution is configured via the Display 
Switch utility. The profile will be associated with the currently connected displays automatically (manufacturer, 
model and used connector are used for allocation) and, if applicable, the state of the laptop lid.

The setup will be restored by plugging or unplugging known displays, which means that the system will 
automatically switch to the already configured profile.

For the display switch functionality, the following parameters should be enabled:

In the Setup, go to Accessories > Display Switch > Options.
Enable Preserve settings over reboot and Smart display configuration. (Default: disabled)

You can find a workflow example under Auto Switch Monitor Configuration for Notebooks.
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Application Launcher
Menu path: Accessories > Application Launcher

With the Application Launcher, you can launch predefined sessions and device functions/tools. You are also given 
information regarding the device and the licenses used.

Further information can be found under Application Launcher (see page 39).

The settings for starting the function are described below.

Session name: Name for the session.

Starting Methods for Session
Start menu

☑ The session can be launched from the start menu.

Application Launcher

☑ The session can be launched with the Application Launcher.

Desktop

☑ The session can be launched with a program launcher on the desktop.

Quick start panel

☑ The session can be launched with the quick start panel.

Start menu's system tab

☑ The session can be launched with the start menu's system tab.

Application Launcher's system tab

☑ The session can be launched with the Application Launcher's system tab.

Desktop context menu

☑ The session can be launched with the desktop context menu.

Menu folder: If you specify a folder name or a path comprising a number of folder names separated by "/", a menu 
path will be created for the session. The menu path will be used in the start menu and in the desktop context menu.

Application Launcher folder: If you specify a folder name or a path comprising a number of folder names 
separated by "/", a menu path will be created for the session. The menu path will be used in the Application 
Launcher.

Desktop folder: If you specify a folder name or a path comprising a number of folder names separated by "/", a 
menu path will be created for the session. The menu path will be used for the program launcher on the desktop.

The session name must not contain any of these characters: \ / : * ? “ < > | [ ] { } ( )
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Password protection: Specifies which password will be requested when launching the session.
Possible values:

None: No password is requested when launching the session.
Administrator: The administrator password is requested when launching the session.
User: The user password is requested when launching the session.
Setup user: The setup user's password is requested when launching the session.

Hotkey

☑ The session can be started with a hotkey. A hotkey consists of one or more modifiers and a key.

Modifiers: A modifier or a combination of several modifiers for the hotkey. You can select a set key symbol/
combination or your own key symbol/combination. A key symbol is a defined chain of characters, e.g.  Ctrl .

These are the pre-defined modifiers and the associated key symbols:

(No modifier) =  None

 =  Shift
[Ctrl] =  Ctrl

 =  Mod4

[Alt] =  Alt

Key combinations are formed as follows with  | :

Ctrl +   =  Ctrl|Super_L

Key: Key for the hotkey

Autostart

☑ The session will be launched automatically when the device boots.

Do not use [AltGr] as a modifier (represented as Mod5 ). Otherwise, the key that is configured as a hotkey 
with AltGr cannot be used as a regular key anymore. Example: If you configure [AltGr] + [E] as a hotkey, it is 
impossible to enter an "e".



When this keyboard key is used as a modifier, it is represented as Mod4 ; when it is used as a key, it 

is represented as Super_L .



To enter a key that does not have a visible character, e. g. the [Tab] key, open a terminal, log on as user

and enter xev -event keyboard . Press the key to be used for the hotkey. The text in brackets that 

begins with keysym  contains the key symbol for the Key field. Example: Tab  in (keysym 0xff09, 

Tab)


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Restart

☑ The session will be relaunched automatically after the termination.

Autostart delay: Waiting time in seconds between the complete startup of the desktop and the automatic session 
launch.

Appliance mode access: Determines whether the session can be started in appliance mode. By default, appliance 
mode implies that one session is running on the device exclusively. For further information, see Appliance Mode (see 
page 220).

☑ The session can be started in appliance mode. The following starting methods can be used in appliance mode:

Desktop (desktop icon; not in appliance mode XDMCP for this Display)
Desktop Context Menu (not in appliance mode XDMCP for this Display)
Application Launcher (includes Application Launcher's system tab; not in appliance 
mode XDMCP for this Display)
Hotkey
Autostart (not in appliance mode XDMCP for this Display)

☐ The session cannot be started in appliance mode. 

Application Launcher Configuration (see page 577)
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Application Launcher Configuration
Menu path: Setup > Accessories > Application Launcher > Application Launcher Configuration

You can hide individual areas and elements of the Application Launcher.

Hide system page

☑ The  button for displaying the system tools (accessories) will not be shown.

☐ The  button for displaying the system tools (accessories) will be shown. (default)
Hide reboot button

☑ The  button for restarting the thin client will not be shown.

☐ The  button for restarting the thin client will be shown. (default)
Hide shut down button

☑ The  button for shutting down the thin client will not be shown.

☐ The  button for shutting down the thin client will be shown. (default)
Show current user name in about, application launcher and startmenu
☑ The current user will be shown at the top edge of the relevant window.
☐ The current user will not be shown.

Single click mode:
☑ Sessions are started with a single-click. This option was set up specially for users of 
touchscreen monitors.
☐ Sessions are started with a double-click. (default)

•
•

In order for user names to be recognized and passed on, you must configure two settings 
beforehand:

Enable Active Directory/Kerberos: Security > Active Directory/Kerberos
Enable local logon: Security > Logon > Active Directory/Kerberos


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Sound Preferences
Menu path: Accessories > Sound Preferences

With this function, you can configure your device’s audio system. For details of how to change the presets for the 
audio system, see Options (see page 581). For details of how to use the function, see Using "Audio Settings" 
Function (see page 583).

The settings for starting the function are described below.

Session name: Name for the session.

Starting Methods for Session
Start menu

☑ The session can be launched from the start menu.

Application Launcher

☑ The session can be launched with the Application Launcher.

Desktop

☑ The session can be launched with a program launcher on the desktop.

Quick start panel

☑ The session can be launched with the quick start panel.

Start menu's system tab

☑ The session can be launched with the start menu's system tab.

Application Launcher's system tab

☑ The session can be launched with the Application Launcher's system tab.

Desktop context menu

☑ The session can be launched with the desktop context menu.

Menu folder: If you specify a folder name or a path comprising a number of folder names separated by "/", a menu 
path will be created for the session. The menu path will be used in the start menu and in the desktop context menu.

Application Launcher folder: If you specify a folder name or a path comprising a number of folder names 
separated by "/", a menu path will be created for the session. The menu path will be used in the Application 
Launcher.

Desktop folder: If you specify a folder name or a path comprising a number of folder names separated by "/", a 
menu path will be created for the session. The menu path will be used for the program launcher on the desktop.

Password protection: Specifies which password will be requested when launching the session.
Possible values:

The session name must not contain any of these characters: \ / : * ? “ < > | [ ] { } ( )
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•

•

•

•

•

•

None: No password is requested when launching the session.
Administrator: The administrator password is requested when launching the session.
User: The user password is requested when launching the session.
Setup user: The setup user's password is requested when launching the session.

Hotkey

☑ The session can be started with a hotkey. A hotkey consists of one or more modifiers and a key.

Modifiers: A modifier or a combination of several modifiers for the hotkey. You can select a set key symbol/
combination or your own key symbol/combination. A key symbol is a defined chain of characters, e.g.  Ctrl .

These are the pre-defined modifiers and the associated key symbols:

(No modifier) =  None

 =  Shift
[Ctrl] =  Ctrl

 =  Mod4

[Alt] =  Alt

Key combinations are formed as follows with  | :

Ctrl +   =  Ctrl|Super_L

Key: Key for the hotkey

Autostart

☑ The session will be launched automatically when the device boots.

Restart

☑ The session will be restarted automatically after the termination.

Do not use [AltGr] as a modifier (represented as Mod5 ). Otherwise, the key that is configured as a hotkey 
with AltGr cannot be used as a regular key anymore. Example: If you configure [AltGr] + [E] as a hotkey, it is 
impossible to enter an "e".



When this keyboard key is used as a modifier, it is represented as Mod4 ; when it is used as a key, it 

is represented as Super_L .



To enter a key that does not have a visible character, e. g. the [Tab] key, open a terminal, log on as user

and enter xev -event keyboard . Press the key to be used for the hotkey. The text in brackets that 

begins with keysym  contains the key symbol for the Key field. Example: Tab  in (keysym 0xff09, 

Tab)


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•

•
•

Autostart delay: Waiting time in seconds between the complete startup of the desktop and the automatic session 
launch.

Appliance mode access: Determines whether the session can be started in appliance mode. By default, appliance 
mode implies that one session is running on the device exclusively. For further information, see Appliance Mode (see 
page 220).

☑ The session can be started in appliance mode. The following starting methods can be used in appliance mode:

Desktop (desktop icon; not in appliance mode XDMCP for this Display)
Desktop Context Menu (not in appliance mode XDMCP for this Display)
Application Launcher (includes Application Launcher's system tab; not in appliance 
mode XDMCP for this Display)
Hotkey
Autostart (not in appliance mode XDMCP for this Display)

☐ The session cannot be started in appliance mode. 

Options (see page 581)
Using Sound Preferences Function (see page 583)
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Options
Menu path: Accessories > Sound Preferences > Options

With this function, you can change presets for the audio system. The settings can be changed at any time via the 
"Sound Preferences" function; see Using “Sound Preferences” function (see page 583).

Show volume control in taskbar
☑ The  button is shown in the taskbar. When the user clicks on this button, the volume control 
will be shown. (Default)
☐ The  button will not be shown. The user must start the Audio Settings function to change the 
volume. Further information can be found under Using “Sound preferences” function (see page 578).
Remote volume settings
☑ The settings for the parameters Mute, PCM volume, Input mute, and Input volume are 
restored after each system restart.
☐ The last settings set by the user will remain after the next system start. (Default)
Mute
☑ Audio playback is off.
☐ Audio playback is on. (Default)
PCM volume: Preset volume in percent (default: 50)
Input mute
☑ The audio input is muted. Sounds from a microphone that are recorded are not transferred via 
the thin client.
☐ The audio input is switched on. Sounds from a microphone that are recorded can be transferred 
via the thin client. (Default)
Input volume: Volume in percent at which sounds at the audio input are recorded, for example 
from a microphone. (Default: 100)

Default Sound Output

Port name
Possible options:

Automatic: The audio output is automatically assigned to a device. The following order 
applies here:
1. USB devices 
2. PCI devices; this also includes the HDMI interface. 
3. Internal speaker 
Not connected ports will be ignored.
HDMI / DisplayPort
Speaker
Headset

Device name: Name of the device, as it is shown on the Output tab of the Sound Preferences
dialog. The name must be entered exactly as it is written. Examples: "Built-in Audio", "Microsoft 
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•

LifeChat LX-3000".

Default Sound Input

Port name
Possible options:

Automatic: The audio input is automatically assigned to a device. The following order 
applies here:
1. USB devices 
2. PCI devices 
Not connected ports will be ignored.
Microphone
Headset microphone

Device name: Name of the device, as it is shown on the Input tab of the Sound Preferences
dialog. The name must be entered exactly as it is written, analogous to Default Sound Output. 
Examples: "Built-in Audio", "Microsoft LifeChat LX-3000".
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1.
2.
3.

1.
2.
3.

1.
2.

Using Sound Preferences Function
 Start the Sound preferences function. The start options are described under Sound Preferences (see page 578).

To change the playback volume, proceed as follows:

 Move the playback volume slider to the right to increase the volume or to the left to reduce the volume.

To select and configure the device for playback, proceed as follows:

Click on the Output tab.
Under Sound output via, select the device which is to be used for playback.
If necessary, adjust the Balance, Crossover and Subwoofer settings.

To select and configure the device for recording, proceed as follows:

Click on the Input tab.
Under Sound input via, select the device which is to be used for recording.
Adjust the Input volume if necessary.

To change the playback volume for specific applications, proceed as follows:

Click on the Applications tab.
Adjust the volume control for the relevant application.
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System Log Viewer
Menu path: Accessories > System Log Viewer

With this function, you can view your device’s system logs. For details of how to add additional logs to the logs 
shown by default, see Options (see page 587). For details of how to use the function, see Using “System Log Viewer” 
function (see page 588).

The settings for starting the function are described below.

Session name: Name for the session.

Starting Methods for Session
Start menu

☑ The session can be launched from the start menu.

Application Launcher

☑ The session can be launched with the Application Launcher.

Desktop

☑ The session can be launched with a program launcher on the desktop.

Quick start panel

☑ The session can be launched with the quick start panel.

Start menu's system tab

☑ The session can be launched with the start menu's system tab.

Application Launcher's system tab

☑ The session can be launched with the Application Launcher's system tab.

Desktop context menu

☑ The session can be launched with the desktop context menu.

Menu folder: If you specify a folder name or a path comprising a number of folder names separated by "/", a menu 
path will be created for the session. The menu path will be used in the start menu and in the desktop context menu.

Application Launcher folder: If you specify a folder name or a path comprising a number of folder names 
separated by "/", a menu path will be created for the session. The menu path will be used in the Application 
Launcher.

Desktop folder: If you specify a folder name or a path comprising a number of folder names separated by "/", a 
menu path will be created for the session. The menu path will be used for the program launcher on the desktop.

Password protection: Specifies which password will be requested when launching the session.
Possible values:

The session name must not contain any of these characters: \ / : * ? “ < > | [ ] { } ( )
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None: No password is requested when launching the session.
Administrator: The administrator password is requested when launching the session.
User: The user password is requested when launching the session.
Setup user: The setup user's password is requested when launching the session.

Hotkey

☑ The session can be started with a hotkey. A hotkey consists of one or more modifiers and a key.

Modifiers: A modifier or a combination of several modifiers for the hotkey. You can select a set key symbol/
combination or your own key symbol/combination. A key symbol is a defined chain of characters, e.g.  Ctrl .

These are the pre-defined modifiers and the associated key symbols:

(No modifier) =  None

 =  Shift
[Ctrl] =  Ctrl

 =  Mod4

[Alt] =  Alt

Key combinations are formed as follows with  | :

Ctrl +   =  Ctrl|Super_L

Key: Key for the hotkey

Autostart

☑ The session will be launched automatically when the device boots.

Restart

☑ The session will be relaunched automatically after the termination.

Do not use [AltGr] as a modifier (represented as Mod5 ). Otherwise, the key that is configured as a hotkey 
with AltGr cannot be used as a regular key anymore. Example: If you configure [AltGr] + [E] as a hotkey, it is 
impossible to enter an "e".



When this keyboard key is used as a modifier, it is represented as Mod4 ; when it is used as a key, it 

is represented as Super_L .



To enter a key that does not have a visible character, e. g. the [Tab] key, open a terminal, log on as user

and enter xev -event keyboard . Press the key to be used for the hotkey. The text in brackets that 

begins with keysym  contains the key symbol for the Key field. Example: Tab  in (keysym 0xff09, 

Tab)


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Autostart delay: Waiting time in seconds between the complete startup of the desktop and the automatic session 
launch.

Appliance mode access: Determines whether the session can be started in appliance mode. By default, appliance 
mode implies that one session is running on the device exclusively. For further information, see Appliance Mode (see 
page 220).

☑ The session can be started in appliance mode. The following starting methods can be used in appliance mode:

Desktop (desktop icon; not in appliance mode XDMCP for this Display)
Desktop Context Menu (not in appliance mode XDMCP for this Display)
Application Launcher (includes Application Launcher's system tab; not in appliance 
mode XDMCP for this Display)
Hotkey
Autostart (not in appliance mode XDMCP for this Display)

☐ The session cannot be started in appliance mode. 

Options (see page 587)
Using System Log Viewer Function (see page 588)
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1.
2.

3.

Options
Menu path: Setup > Accessories > System Log Viewer > Options

Here, you can add additional files to the files shown by default. The System Log Viewer function shows the 
following files by default:

/config/Xserver/card0

/config/Xserver/xorg.conf-0

/config/sound/card0

/config/sound/card1

/config/sound/default_card_name

/var/log/Xorg.0.log

To add a further file to the display, proceed as follows:

Click on .
In the Add dialog, enter the path and the file name of the desired file. Example: /var/log/

igfmount.log

Click OK.
When the System Log Viewer function is started, the file that you have added will be shown.

If you want to add several files, you can also use the asterisk *. Example: /var/log/ *.log or  

/var/log/ *.txt

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1.

2.

Using System Log Viewer Function
Start the System Log Viewer function. The start options are described under System Log 
Viewer (see page 584).
In the left-hand column, select the file that you want to view.
The selected file will be shown in the right-hand column.
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UMS Registration
Menu path: Accessories > UMS Registration

With this function, you can register your endpoint device in the UMS (IGEL Universal Management Suite) locally. For 
details of how to use the function, see Using "UMS Registration” Function (see page 591).

The settings for starting the function are described below.

Session name: Name for the session.

Starting Methods for Session
Start menu

☑ The session can be launched from the start menu.

Application Launcher

☑ The session can be launched with the Application Launcher.

Desktop

☑ The session can be launched with a program launcher on the desktop.

Quick start panel

☑ The session can be launched with the quick start panel.

Start menu's system tab

☑ The session can be launched with the start menu's system tab.

Application Launcher's system tab

☑ The session can be launched with the Application Launcher's system tab.

Desktop context menu

☑ The session can be launched with the desktop context menu.

Menu folder: If you specify a folder name or a path comprising a number of folder names separated by "/", a menu 
path will be created for the session. The menu path will be used in the start menu and in the desktop context menu.

Application Launcher folder: If you specify a folder name or a path comprising a number of folder names 
separated by "/", a menu path will be created for the session. The menu path will be used in the Application 
Launcher.

Desktop folder: If you specify a folder name or a path comprising a number of folder names separated by "/", a 
menu path will be created for the session. The menu path will be used for the program launcher on the desktop.

Password protection: Specifies which password will be requested when launching the session.
Possible values:

None: No password is requested when launching the session.

The session name must not contain any of these characters: \ / : * ? “ < > | [ ] { } ( )



Accessories

IGEL OS Reference Manual   590 / 897

•
•
•

•

•

•

•

•

•

•

Administrator: The administrator password is requested when launching the session.
User: The user password is requested when launching the session.
Setup user: The setup user's password is requested when launching the session.

Hotkey

☑ The session can be started with a hotkey. A hotkey consists of one or more modifiers and a key.

Modifiers: A modifier or a combination of several modifiers for the hotkey. You can select a set key symbol/
combination or your own key symbol/combination. A key symbol is a defined chain of characters, e.g.  Ctrl .

These are the pre-defined modifiers and the associated key symbols:

(No modifier) =  None

 =  Shift
[Ctrl] =  Ctrl

 =  Mod4

[Alt] =  Alt

Key combinations are formed as follows with  | :

Ctrl +   =  Ctrl|Super_L

Key: Key for the hotkey

Using UMS Registration Function (see page 591)

Do not use [AltGr] as a modifier (represented as Mod5 ). Otherwise, the key that is configured as a hotkey 
with AltGr cannot be used as a regular key anymore. Example: If you configure [AltGr] + [E] as a hotkey, it is 
impossible to enter an "e".



When this keyboard key is used as a modifier, it is represented as Mod4 ; when it is used as a key, it 

is represented as Super_L .



To enter a key that does not have a visible character, e. g. the [Tab] key, open a terminal, log on as user

and enter xev -event keyboard . Press the key to be used for the hotkey. The text in brackets that 

begins with keysym  contains the key symbol for the Key field. Example: Tab  in (keysym 0xff09, 

Tab)


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1.

2.
•
•
•
•
•
•

3.

4.

Using UMS Registration Function
Menu path: Accessories > UMS Registration

Start the UMS Registration function. The start options are described under UMS Registration (see 
page 589).
Enter the following data:

Server Address: IP address or host name of the UMS Server.
Port Number: Port of the UMS Server.
Structure Tag: Character string for assigning the device to a specific UMS directory.
New Hostname: Name under which the device is registered in the UMS.
Login: User name for logging in to the UMS Console.
Password: Password for logging in to the UMS Console.

If you want to assign a specific UMS directory to the device, click on Click to select directory and 
then select the desired directory from the list.
Click on Register.

Any UMS user with sufficient rights can be specified under Login and Password.
Example: If a device has to be registered in a particular folder, the user must have "move" 
permission for this folder.


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•

Touchscreen Calibration
Menu path: Accessories > Touchscreen Calibration

With this function, you can calibrate the touchscreen connected to your endpoint device. For details of how to use 
the function, see Using “Touchscreen Calibration” function (see page 595).

The settings for starting the function are described below.

Session name: Name for the session.

Starting Methods for Session
Start menu

☑ The session can be launched from the start menu.

Application Launcher

☑ The session can be launched with the Application Launcher.

Desktop

☑ The session can be launched with a program launcher on the desktop.

Quick start panel

☑ The session can be launched with the quick start panel.

Start menu's system tab

☑ The session can be launched with the start menu's system tab.

Application Launcher's system tab

☑ The session can be launched with the Application Launcher's system tab.

Desktop context menu

☑ The session can be launched with the desktop context menu.

Menu folder: If you specify a folder name or a path comprising a number of folder names separated by "/", a menu 
path will be created for the session. The menu path will be used in the start menu and in the desktop context menu.

Application Launcher folder: If you specify a folder name or a path comprising a number of folder names 
separated by "/", a menu path will be created for the session. The menu path will be used in the Application 
Launcher.

Desktop folder: If you specify a folder name or a path comprising a number of folder names separated by "/", a 
menu path will be created for the session. The menu path will be used for the program launcher on the desktop.

Password protection: Specifies which password will be requested when launching the session.
Possible values:

None: No password is requested when launching the session.

The session name must not contain any of these characters: \ / : * ? “ < > | [ ] { } ( )
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Administrator: The administrator password is requested when launching the session.
User: The user password is requested when launching the session.
Setup user: The setup user's password is requested when launching the session.

Hotkey

☑ The session can be started with a hotkey. A hotkey consists of one or more modifiers and a key.

Modifiers: A modifier or a combination of several modifiers for the hotkey. You can select a set key symbol/
combination or your own key symbol/combination. A key symbol is a defined chain of characters, e.g.  Ctrl .

These are the pre-defined modifiers and the associated key symbols:

(No modifier) =  None

 =  Shift
[Ctrl] =  Ctrl

 =  Mod4

[Alt] =  Alt

Key combinations are formed as follows with  | :

Ctrl +   =  Ctrl|Super_L

Key: Key for the hotkey

Autostart

☑ The session will be launched automatically when the device boots.

Restart

☑ The session will be relaunched automatically after the termination.

Do not use [AltGr] as a modifier (represented as Mod5 ). Otherwise, the key that is configured as a hotkey 
with AltGr cannot be used as a regular key anymore. Example: If you configure [AltGr] + [E] as a hotkey, it is 
impossible to enter an "e".



When this keyboard key is used as a modifier, it is represented as Mod4 ; when it is used as a key, it 

is represented as Super_L .



To enter a key that does not have a visible character, e. g. the [Tab] key, open a terminal, log on as user

and enter xev -event keyboard . Press the key to be used for the hotkey. The text in brackets that 

begins with keysym  contains the key symbol for the Key field. Example: Tab  in (keysym 0xff09, 

Tab)





Accessories

IGEL OS Reference Manual   594 / 897

•
•
•

•
•

•

Autostart delay: Waiting time in seconds between the complete startup of the desktop and the automatic session 
launch.

Appliance mode access: Determines whether the session can be started in appliance mode. By default, appliance 
mode implies that one session is running on the device exclusively. For further information, see Appliance Mode (see 
page 220).

☑ The session can be started in appliance mode. The following starting methods can be used in appliance mode:

Desktop (desktop icon; not in appliance mode XDMCP for this Display)
Desktop Context Menu (not in appliance mode XDMCP for this Display)
Application Launcher (includes Application Launcher's system tab; not in appliance 
mode XDMCP for this Display)
Hotkey
Autostart (not in appliance mode XDMCP for this Display)

☐ The session cannot be started in appliance mode. 

Using Touchscreen Calibration (see page 595)
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Using Touchscreen Calibration
 Ensure that Enable touchscreen is enabled under User Interface > Input > Touchscreen.

You will find a description of the touchscreen calibration procedure in the Touchscreen Calibration how-to.
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Task Manager
Menu path: Accessories > Task Manager

This function provides an overview of the applications and other processes running on the device. You can also 
pause or end processes and change the priority of processes. For details of how to use the Task Manager, see Using 
Task Manager (see page 599).

The settings for starting the function are described below.

Session name: Name for the session.

Starting Methods for Session
Start menu

☑ The session can be launched from the start menu.

Application Launcher

☑ The session can be launched with the Application Launcher.

Desktop

☑ The session can be launched with a program launcher on the desktop.

Quick start panel

☑ The session can be launched with the quick start panel.

Start menu's system tab

☑ The session can be launched with the start menu's system tab.

Application Launcher's system tab

☑ The session can be launched with the Application Launcher's system tab.

Desktop context menu

☑ The session can be launched with the desktop context menu.

Menu folder: If you specify a folder name or a path comprising a number of folder names separated by "/", a menu 
path will be created for the session. The menu path will be used in the start menu and in the desktop context menu.

Application Launcher folder: If you specify a folder name or a path comprising a number of folder names 
separated by "/", a menu path will be created for the session. The menu path will be used in the Application 
Launcher.

Desktop folder: If you specify a folder name or a path comprising a number of folder names separated by "/", a 
menu path will be created for the session. The menu path will be used for the program launcher on the desktop.

Password protection: Specifies which password will be requested when launching the session.
Possible values:

The session name must not contain any of these characters: \ / : * ? “ < > | [ ] { } ( )
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None: No password is requested when launching the session.
Administrator: The administrator password is requested when launching the session.
User: The user password is requested when launching the session.
Setup user: The setup user's password is requested when launching the session.

Hotkey

☑ The session can be started with a hotkey. A hotkey consists of one or more modifiers and a key.

Modifiers: A modifier or a combination of several modifiers for the hotkey. You can select a set key symbol/
combination or your own key symbol/combination. A key symbol is a defined chain of characters, e.g.  Ctrl .

These are the pre-defined modifiers and the associated key symbols:

(No modifier) =  None

 =  Shift
[Ctrl] =  Ctrl

 =  Mod4

[Alt] =  Alt

Key combinations are formed as follows with  | :

Ctrl +   =  Ctrl|Super_L

Key: Key for the hotkey

Autostart

☑ The session will be launched automatically when the device boots.

Restart

☑ The session will be relaunched automatically after the termination.

Do not use [AltGr] as a modifier (represented as Mod5 ). Otherwise, the key that is configured as a hotkey 
with AltGr cannot be used as a regular key anymore. Example: If you configure [AltGr] + [E] as a hotkey, it is 
impossible to enter an "e".



When this keyboard key is used as a modifier, it is represented as Mod4 ; when it is used as a key, it 

is represented as Super_L .



To enter a key that does not have a visible character, e. g. the [Tab] key, open a terminal, log on as user

and enter xev -event keyboard . Press the key to be used for the hotkey. The text in brackets that 

begins with keysym  contains the key symbol for the Key field. Example: Tab  in (keysym 0xff09, 

Tab)


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Autostart delay: Waiting time in seconds between the complete startup of the desktop and the automatic session 
launch.

Appliance mode access: Determines whether the session can be started in appliance mode. By default, appliance 
mode implies that one session is running on the device exclusively. For further information, see Appliance Mode (see 
page 220).

☑ The session can be started in appliance mode. The following starting methods can be used in appliance mode:

Desktop (desktop icon; not in appliance mode XDMCP for this Display)
Desktop Context Menu (not in appliance mode XDMCP for this Display)
Application Launcher (includes Application Launcher's system tab; not in appliance 
mode XDMCP for this Display)
Hotkey
Autostart (not in appliance mode XDMCP for this Display)

☐ The session cannot be started in appliance mode. 

Using Task Manager (see page 599)
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1.

2.

Using Task Manager
With the Task Manager, you can observe and influence applications and processes in the following ways:

Determining thin client processor usage
Determining thin client memory usage
Determining processor usage by a specific application
Determining memory usage by a specific application
Pausing and continuing an application
Closing an application
Force closing an application
Changing the priority of an application

 Launch the Task Manager function. The launch options are described under Task Manager (see page 596).

To determine the thin client's total processor usage, proceed as follows:

 Read the percentage value under CPU:.

To determine the thin client's total memory usage, proceed as follows:

 Read the percentage value under RAM:.

 To calculate the value in bytes, click on  and enable the option Show memory usage in bytes.

To determine the extent to which a specific application contributes to processor usage, proceed as follows:

In the search window, enter the name of the application or part of the name.
The Task Manager will now show only the relevant applications and processes.
Read the percentage value for the relevant application in the CPU column.
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To determine the extent to which a specific application contributes to memory usage, proceed as follows:

Click next to  on  and ensure that Virtual Bytes and Private Bytes are enabled.
In the search window, enter the name of the application or part of the name.
The Task Manager will now show only the relevant applications and processes.
Read the values in the VSZ and RSS columns. 
The VSZ column shows how much memory is available for the application. The RSS column shows 
how much memory the application is currently using.
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To pause an application, proceed as follows:

Highlight the application.
Open the application’s context menu by right-clicking on it and select Pause.
The application will be paused (Signal SIGSTOP). You can then continue the application.

To continue an application, proceed as follows:

Highlight the application.
Open the application’s context menu by right-clicking on it and select Continue.
The application will continue (Signal SIGCONT).

To close an application, proceed as follows:

Highlight the application.
Open the application’s context menu by right-clicking on it and select Close.
The application will close (Signal SIGTERM).
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To force an application to close, proceed as follows:

Highlight the application.
Open the application’s context menu by right-clicking on it and select Kill.
The application will be forced to close (Signal SIGKILL).

To change the priority of an application, proceed as follows:

Highlight the application.
Open the application’s context menu by right-clicking on it and select Priority.
Select one of the following values for the priority:

Very low (nice value: 15)
Low (nice value: 5)
Normal (nice value: 0)
High (nice value: -5). This value can only be set by the administrator.
Very high (nice value: -15) This value can only be set by the administrator.

In this case, the application is instructed to close by the operating system. If the 
application does not react to this instruction, you can force it to close with the Kill
command.



As a normal user, you can only change the priority from a higher value to a lower value. 
Example: If you have changed the priority from "Normal" to "Low", you can only then 
change it to “Very low” – you can no longer change it back to “Normal”. The administrator 
can increase the priority.



The priority corresponds to the nice value. High values result in a low priority, while low 
values result in a high priority.


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Screenshot Tool
Menu path: Accessories > Screenshot Tool

With this function, you can take a screenshot. For details of how to use the function, see Using “Screenshot 
Tool” (see page 606).

The settings for starting the function are described below.

Session name: Name for the session.

Starting Methods for Session
Start menu

☑ The session can be launched from the start menu.

Application Launcher

☑ The session can be launched with the Application Launcher.

Desktop

☑ The session can be launched with a program launcher on the desktop.

Quick start panel

☑ The session can be launched with the quick start panel.

Start menu's system tab

☑ The session can be launched with the start menu's system tab.

Application Launcher's system tab

☑ The session can be launched with the Application Launcher's system tab.

Desktop context menu

☑ The session can be launched with the desktop context menu.

Menu folder: If you specify a folder name or a path comprising a number of folder names separated by "/", a menu 
path will be created for the session. The menu path will be used in the start menu and in the desktop context menu.

Application Launcher folder: If you specify a folder name or a path comprising a number of folder names 
separated by "/", a menu path will be created for the session. The menu path will be used in the Application 
Launcher.

Desktop folder: If you specify a folder name or a path comprising a number of folder names separated by "/", a 
menu path will be created for the session. The menu path will be used for the program launcher on the desktop.

Password protection: Specifies which password will be requested when launching the session.
Possible values:

None: No password is requested when launching the session.

The session name must not contain any of these characters: \ / : * ? “ < > | [ ] { } ( )
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Administrator: The administrator password is requested when launching the session.
User: The user password is requested when launching the session.
Setup user: The setup user's password is requested when launching the session.

Hotkey

☑ The session can be started with a hotkey. A hotkey consists of one or more modifiers and a key.

Modifiers: A modifier or a combination of several modifiers for the hotkey. You can select a set key symbol/
combination or your own key symbol/combination. A key symbol is a defined chain of characters, e.g.  Ctrl .

These are the pre-defined modifiers and the associated key symbols:

(No modifier) =  None

 =  Shift
[Ctrl] =  Ctrl

 =  Mod4

[Alt] =  Alt

Key combinations are formed as follows with  | :

Ctrl +   =  Ctrl|Super_L

Key: Key for the hotkey

Autostart

☑ The session will be launched automatically when the device boots.

Restart

☑ The session will be relaunched automatically after the termination.

Do not use [AltGr] as a modifier (represented as Mod5 ). Otherwise, the key that is configured as a hotkey 
with AltGr cannot be used as a regular key anymore. Example: If you configure [AltGr] + [E] as a hotkey, it is 
impossible to enter an "e".



When this keyboard key is used as a modifier, it is represented as Mod4 ; when it is used as a key, it 

is represented as Super_L .



To enter a key that does not have a visible character, e. g. the [Tab] key, open a terminal, log on as user

and enter xev -event keyboard . Press the key to be used for the hotkey. The text in brackets that 

begins with keysym  contains the key symbol for the Key field. Example: Tab  in (keysym 0xff09, 

Tab)


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Autostart delay: Waiting time in seconds between the complete startup of the desktop and the automatic session 
launch.

Appliance mode access: Determines whether the session can be started in appliance mode. By default, appliance 
mode implies that one session is running on the device exclusively. For further information, see Appliance Mode (see 
page 220).

☑ The session can be started in appliance mode. The following starting methods can be used in appliance mode:

Desktop (desktop icon; not in appliance mode XDMCP for this Display)
Desktop Context Menu (not in appliance mode XDMCP for this Display)
Application Launcher (includes Application Launcher's system tab; not in appliance 
mode XDMCP for this Display)
Hotkey
Autostart (not in appliance mode XDMCP for this Display)

☐ The session cannot be started in appliance mode. 

Special Hotkeys
With the hotkeys defined under User Interface > Hotkeys > Commands, you can use the function as follows:

Screenshot of the active window: This hotkey takes a screenshot of the window currently active.
Screenshot of the entire screen: This hotkey takes a screenshot of the entire screen.

Using Screenshot Tool (see page 606)
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Using Screenshot Tool
Launch the Screenshot Tool function. The launch options are described under Screenshot 
Tool (see page 603).
Select the area you would like to photograph. You have the following options:

Entire screen
☑ The entire screen content will be photographed.
Active window
☑ The window that is currently active will be photographed.
Select a region
☑ You can select a section of the screen using the mouse.
Capture mouse pointer
☑ The mouse pointer is visible on the screenshot.

Specify the Delay before capturing in seconds. The minimum value is 1.
Click on OK.
If you have enabled Entire screen or Active window, the screenshot will be taken after the Delay 
before capturing has elapsed. 
If you have enabled Select a region, you can select the desired part of the screen using the mouse. 
To do this, press and hold the left mouse button while dragging the mouse across the screen.
Specify how the screenshot is to be used. You have the following options:

Save: If this option is enabled, the screenshot will be saved in PNG format via your thin 
client. You can save the screenshot locally, on a network drive or on a USB mass storage 
device.
Copy to the clipboard: If this option is enabled, the screenshot will be available in the thin 
client's local cache. You can access the local cache from an RDP session and open the image 
in an RDP session application.
Open with: If this option is enabled, the screenshot will be opened in your thin client's 
image viewer as soon as it is taken.

If you start the function via User Interface > Hotkeys > Commands > Screenshot of 
active window or User Interface > Hotkeys > Commands > Screenshot of entire 
screen, no options will be shown.


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On-Screen Keyboard
Menu path: Accessories > On-Screen Keyboard

This function shows an on-screen keyboard on the desktop.

The settings for starting the function are described below.

Session name: Name for the session.

Starting Methods for Session
Start menu

☑ The session can be launched from the start menu.

Application Launcher

☑ The session can be launched with the Application Launcher.

Desktop

☑ The session can be launched with a program launcher on the desktop.

Quick start panel

☑ The session can be launched with the quick start panel.

Start menu's system tab

☑ The session can be launched with the start menu's system tab.

Application Launcher's system tab

☑ The session can be launched with the Application Launcher's system tab.

Desktop context menu

☑ The session can be launched with the desktop context menu.

Menu folder: If you specify a folder name or a path comprising a number of folder names separated by "/", a menu 
path will be created for the session. The menu path will be used in the start menu and in the desktop context menu.

Application Launcher folder: If you specify a folder name or a path comprising a number of folder names 
separated by "/", a menu path will be created for the session. The menu path will be used in the Application 
Launcher.

Desktop folder: If you specify a folder name or a path comprising a number of folder names separated by "/", a 
menu path will be created for the session. The menu path will be used for the program launcher on the desktop.

Password protection: Specifies which password will be requested when launching the session.
Possible values:

None: No password is requested when launching the session.
Administrator: The administrator password is requested when launching the session.

The session name must not contain any of these characters: \ / : * ? “ < > | [ ] { } ( )
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User: The user password is requested when launching the session.
Setup user: The setup user's password is requested when launching the session.

Autostart

☑ The session will be launched automatically when the device boots.

Restart

☑ The session will be restarted automatically after the termination.

Autostart delay: Waiting time in seconds between the complete startup of the desktop and the automatic session 
launch.

Appliance mode access: Determines whether the session can be started in appliance mode. By default, appliance 
mode implies that one session is running on the device exclusively. For further information, see Appliance Mode (see 
page 220).

☑ The session can be started in appliance mode. The following starting methods can be used in appliance mode:

Desktop (desktop icon; not in appliance mode XDMCP for this Display)
Desktop Context Menu (not in appliance mode XDMCP for this Display)
Application Launcher (includes Application Launcher's system tab; not in appliance 
mode XDMCP for this Display)
Hotkey
Autostart (not in appliance mode XDMCP for this Display)

☐ The session cannot be started in appliance mode. 

Appearance (see page 609)
Application Integration (see page 610)
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Appearance
Menu path: Accessories > On-Screen Keyboard > Appearance

Show Function Keys
☑ The on-screen keyboard features the function keys [F1] ... [F12]. (default)
Show Navigation Keys
☑ The on-screen keyboard features the arrow keys for navigating on the screen. (default)
Show Numpad
☑ The on-screen keyboard features the number block.
☐ The on-screen keyboard does not feature the number block. (default)
Enable switching to alternative layout

☑ The on-screen keyboard has an additional key by which the user can toggle between the 
normal layout and a reduced layout. The reduced layout resembles the numpad, with the 
following differences:
- Additional backspace key [←] 
- Additional tab key [↹] 
- Additional space key [ ] 
- Additional escape key [Esc] 
- Return key [⏎] instead of [Enter] key
☐ Switching to the reduced layout is not possible. (default)

This option is available from IGEL Linux version 10.04.100 onwards.
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Application Integration
Menu path: Accessories > On-screen keyboard > Application Integration

Taskbar settings for the login dialog
These settings are relevant if a login is necessary in order to use the device. This applies to all logon methods that 
are possible with the device.

Show on-screen keyboard button

☑ A button for launching the on-screen keyboard will be shown during the login dialog.

☐ The on-screen keyboard cannot be launched during the login dialog. (Default)

Start on-screen keyboard automatically

☑ The on-screen keyboard is shown during the login dialog. The on-screen keyboard can be used for input in the 
logon dialog.

☐ The on-screen keyboard is not shown during the login dialog. However, it can be launched via a button if Show 
on-screen keyboard button is enabled. (Default)

Taskbar settings when the screenlock is active
Show on-screen keyboard button

☑ If the screen is locked, a button for launching the on-screen keyboard will be shown.

☐ If the screen is locked, the on-screen keyboard cannot be launched. (Default)

Start on-screen keyboard automatically

☑ If the screen is locked, the on-screen keyboard will be shown.

☐ If the screen is locked, the on-screen keyboard will not be shown. However, it can be launched via a button if 
Show on-screen keyboard button is enabled. (Default)

On-Screen Keyboard Toggle Button
Show button

☑ A button for switching the on-screen keyboard on and off will be shown on the desktop.

☐ The button will not be shown. (Default)

Touch and hold delay: Time in milliseconds, after which the button reacts to movement. (Default: 1000 ms)

Button size: A size between 40 and 80 pixels can be chosen. (Default: 60px)

For further information, see Configuring the Automatic Appearance of on-screen software keyboard.
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Java Manager
Menu path: Setup > Accessories > Java Manager

With this function, you can configure the execution of Java on your thin client. For details of how to use this 
function, see Using Java Manager (see page 614).

The settings for starting the function are described below.

Session name: Name for the session

Session start options
Start menu

☑ The session can be started with the start menu.

Application Launcher

☑ The session can be started with the Application Launcher.

Desktop:

☑ The session can be started with a program starter on the desktop.

Quick start panel:

☑ The session can be started with the quick start panel.

Start menu's system tab

☑ The session can be started with the start menu’s system tab.

Application Launcher's system tab

☑ The session can be started with the Application Launcher’s system tab.

Desktop context menu

☑ The session can be started with the desktop context menu.

Menu folder: If you specify a folder name or a path comprising a number of folder names separated by "/", a menu 
path will be created for the session. The menu path will be used in the start menu and in the desktop context menu.

Path in the Application Launcher: If you specify a folder name or a path comprising a number of folder names 
separated by "/", a menu path will be created for the session. The menu path will be used in the Application 
Launcher.

Desktop folder: If you specify a folder name or a path comprising a number of folder names separated by "/", a 
menu path will be created for the session. The menu path will be used for the program launcher on the desktop.

Password protection: Specifies which password will be requested when launching the session.
Possible values:

None: No password is requested when launching the session.
Administrator: The administrator password is requested when launching the session.

The session name must not contain any of these characters: \ / : * ? “ < > | [ ] { } ( )
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User: The user password is requested when launching the session.
Setup user: The setup user's password is requested when launching the session.

Hotkey:

☑ The session can be started with a hotkey. A hotkey consists of one or more modifiers and a key.

Modifiers: A modifier or a combination of several modifiers for the hotkey. You can select a set key symbol/
combination or your own key symbol/combination. A key symbol is a defined chain of characters, e.g.  Ctrl .

These are the pre-defined modifiers and the associated key symbols:

(No modifier) =  None

 =  Shift
[Ctrl] =  Ctrl

 =  Mod4

[Alt] =  Alt

Key combinations are formed as follows with  | :

Ctrl +   =  Ctrl|Super_L

Key: Key for the hotkey

Autostart: If this option is enabled, the session will be launched automatically when the thin client boots.

Autostart delay: Waiting time in seconds between the thin client booting and the session being launched 
automatically.

_____

Do not use [AltGr] as a modifier (represented as Mod5 ). Otherwise, the key that is configured as a hotkey 
with AltGr cannot be used as a regular key anymore. Example: If you configure [AltGr] + [E] as a hotkey, it is 
impossible to enter an "e".



When this keyboard key is used as a modifier, it is represented as Mod4 ; when it is used as a key, it 

is represented as Super_L .



To enter a key that does not have a visible character, e. g. the [Tab] key, open a terminal, log on as user

and enter xev -event keyboard . Press the key to be used for the hotkey. The text in brackets that 

begins with keysym  contains the key symbol for the Key field. Example: Tab  in (keysym 0xff09, 

Tab)


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Using Java Manager
With the Java Control Panel, you can check and change the properties of Java sessions. Changes will remain in force 
until the next thin client restart. The procedure for changing the security settings and importing certificates with the 
Java Control Panel is described below.

The procedure for rectifying an error when connecting to the UMS via Java Web Start is described in the FAQ Error 
when connecting to UMS via Java Web Start: "received fatal alert: handshake_failure".

Further information regarding the Java Control Panel can be found at http://java.sun.com/j2se/1.5.0/docs/guide/
deployment/deployment-guide/jcp.html.

To change the security settings for Java sessions, proceed as follows:

Launch the Java Manager. The start options are described under Java Manager (see page 611).
Click on the Security tab.
If you want to use Java applications (applets) in the browser, enable Enable Java content in the 
browser.
Select a security level for applications that are not on the Exception Site list:

Very high: The Java application will only be executed if it has a valid certificate which has 
not been withdrawn.
High: The Java application will only be executed if it has a valid certificate. No check will be 
made as to whether the certificate was withdrawn.

If you would like to add an exception, click on Edit Site List... > Add and enter the URL of the 
website for which the security rule is not to apply. When you have added all your exceptions, click 
on OK.
Click on OK or Apply.
The changed settings will remain valid until the next thin client restart.

To import a certificate from a file, proceed as follows:

Launch the Java Control Panel. The start options are described under Java Manager (see page 611).
Click on the Security tab.
Click on Manage Certificates....
Select the certificate type.
Select the certificate file on your thin client and click on Open.
Click on Import.

•
•

Alternatively, you can configure the settings in the registry; the changes are then 
permanent:

System > Registry > java > deployment > security_level
System > Registry > java > deployment > exception_site%



Certificates should always be imported using the UMS. You should therefore use the Java Control Panel 
only if you want to import a certificate whose type is not supported by the UMS. The UMS only supports 
"Signer CA” certificates, i.e. certificates from a certification authority (CA) for protected certificates.



http://java.sun.com/j2se/1.5.0/docs/guide/deployment/deployment-guide/jcp.html
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Monitor Calibration
Menu path: Accessories > Monitor Calibration

With this function, you can calibrate the monitor connected to your endpoint device.

A test image which you can modify using the arrow keys will appear. Using this test image, you can automatically or 
manually recalibrate your screen. This applies to old, analog monitors in particular. New monitors calibrate 
themselves.

The settings for starting the function are described below.

Session name: Name for the session.

Starting Methods for Session
Start menu

☑ The session can be launched from the start menu.

Application Launcher

☑ The session can be launched with the Application Launcher.

Desktop

☑ The session can be launched with a program launcher on the desktop.

Quick start panel

☑ The session can be launched with the quick start panel.

Start menu's system tab

☑ The session can be launched with the start menu's system tab.

Application Launcher's system tab

☑ The session can be launched with the Application Launcher's system tab.

Desktop context menu

☑ The session can be launched with the desktop context menu.

Menu folder: If you specify a folder name or a path comprising a number of folder names separated by "/", a menu 
path will be created for the session. The menu path will be used in the start menu and in the desktop context menu.

Application Launcher folder: If you specify a folder name or a path comprising a number of folder names 
separated by "/", a menu path will be created for the session. The menu path will be used in the Application 
Launcher.

Desktop folder: If you specify a folder name or a path comprising a number of folder names separated by "/", a 
menu path will be created for the session. The menu path will be used for the program launcher on the desktop.

The session name must not contain any of these characters: \ / : * ? “ < > | [ ] { } ( )
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Password protection: Specifies which password will be requested when launching the session.
Possible values:

None: No password is requested when launching the session.
Administrator: The administrator password is requested when launching the session.
User: The user password is requested when launching the session.
Setup user: The setup user's password is requested when launching the session.

Hotkey

☑ The session can be started with a hotkey. A hotkey consists of one or more modifiers and a key.

Modifiers: A modifier or a combination of several modifiers for the hotkey. You can select a set key symbol/
combination or your own key symbol/combination. A key symbol is a defined chain of characters, e.g.  Ctrl .

These are the pre-defined modifiers and the associated key symbols:

(No modifier) =  None

 =  Shift
[Ctrl] =  Ctrl

 =  Mod4

[Alt] =  Alt

Key combinations are formed as follows with  | :

Ctrl +   =  Ctrl|Super_L

Key: Key for the hotkey

Autostart

☑ The session will be launched automatically when the device boots.

Do not use [AltGr] as a modifier (represented as Mod5 ). Otherwise, the key that is configured as a hotkey 
with AltGr cannot be used as a regular key anymore. Example: If you configure [AltGr] + [E] as a hotkey, it is 
impossible to enter an "e".



When this keyboard key is used as a modifier, it is represented as Mod4 ; when it is used as a key, it 

is represented as Super_L .



To enter a key that does not have a visible character, e. g. the [Tab] key, open a terminal, log on as user

and enter xev -event keyboard . Press the key to be used for the hotkey. The text in brackets that 

begins with keysym  contains the key symbol for the Key field. Example: Tab  in (keysym 0xff09, 

Tab)


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Restart

☑ The session will be relaunched automatically after the termination.

Autostart delay: Waiting time in seconds between the complete startup of the desktop and the automatic session 
launch.

Appliance mode access: Determines whether the session can be started in appliance mode. By default, appliance 
mode implies that one session is running on the device exclusively. For further information, see Appliance Mode (see 
page 220).

☑ The session can be started in appliance mode. The following starting methods can be used in appliance mode:

Desktop (desktop icon; not in appliance mode XDMCP for this Display)
Desktop Context Menu (not in appliance mode XDMCP for this Display)
Application Launcher (includes Application Launcher's system tab; not in appliance 
mode XDMCP for this Display)
Hotkey
Autostart (not in appliance mode XDMCP for this Display)

☐ The session cannot be started in appliance mode. 
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Commands
Menu path: Accessories > Commands

The following system commands can be made accessible to the user:

Logoff: Logs the user off from the device.
Reboot Terminal: Restarts the device.
Restart windowmanager: Restarts the device's user interface.
Shutdown terminal: Shuts down the device.
Sort icons: Sorts the symbols on the desktop so that they form a block.

 To edit a user command, double click the relevant entry in the list.

If you have made changes to the hotkey, you can check these by clicking the relevant entry in the Key column.

You can change the following starting methods:

Start menu

☑ The session can be launched from the start menu.

Application Launcher

☑ The session can be launched with the Application Launcher.

Desktop

☑ The session can be launched with a program launcher on the desktop.

Quick start panel

☑ The session can be launched with the quick start panel.

Start menu's system tab

☑ The session can be launched with the start menu's system tab.

Application Launcher's system tab

☑ The session can be launched with the Application Launcher's system tab.

Desktop context menu

☑ The session can be launched with the desktop context menu.

Menu folder: If you specify a folder name or a path comprising a number of folder names separated by "/", a menu 
path will be created for the session. The menu path will be used in the start menu and in the desktop context menu.

Desktop folder: If you specify a folder name or a path comprising a number of folder names separated by "/", a 
menu path will be created for the session. The menu path will be used for the program launcher on the desktop.

Password protection: Specifies which password will be requested when launching the session.
Possible values:

None: No password is requested when launching the session.
Administrator: The administrator password is requested when launching the session.
User: The user password is requested when launching the session.
Setup user: The setup user's password is requested when launching the session.
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Hotkey

☑ The session can be started with a hotkey. A hotkey consists of one or more modifiers and a key.

Modifiers: A modifier or a combination of several modifiers for the hotkey. You can select a set key symbol/
combination or your own key symbol/combination. A key symbol is a defined chain of characters, e.g.  Ctrl .

These are the pre-defined modifiers and the associated key symbols:

(No modifier) =  None

 =  Shift
[Ctrl] =  Ctrl

 =  Mod4

[Alt] =  Alt

Key combinations are formed as follows with  | :

Ctrl +   =  Ctrl|Super_L

Key: Key for the hotkey

Appliance mode access: Determines whether the session can be started in appliance mode. By default, appliance 
mode implies that one session is running on the device exclusively. For further information, see Appliance Mode (see 
page 220).

☑ The session can be started in appliance mode. The following starting methods can be used in appliance mode:

Desktop (desktop icon; not in appliance mode XDMCP for this Display)
Desktop Context Menu (not in appliance mode XDMCP for this Display)
Application Launcher (includes Application Launcher's system tab; not in appliance 
mode XDMCP for this Display)
Hotkey

Do not use [AltGr] as a modifier (represented as Mod5 ). Otherwise, the key that is configured as a hotkey 
with AltGr cannot be used as a regular key anymore. Example: If you configure [AltGr] + [E] as a hotkey, it is 
impossible to enter an "e".



When this keyboard key is used as a modifier, it is represented as Mod4 ; when it is used as a key, it 

is represented as Super_L .



To enter a key that does not have a visible character, e. g. the [Tab] key, open a terminal, log on as user

and enter xev -event keyboard . Press the key to be used for the hotkey. The text in brackets that 

begins with keysym  contains the key symbol for the Key field. Example: Tab  in (keysym 0xff09, 

Tab)


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• Autostart (not in appliance mode XDMCP for this Display)

☐ The session cannot be started in appliance mode. 



Accessories

IGEL OS Reference Manual   621 / 897

•
•
•
•
•

Network Tools
Menu path: Accessories > Network Tools

This function provides the following tools for network analysis:

Devices
Ping
Netstat
Traceroute
Lookup

For how to use the network tools, see Using Network Tools Function (see page 624).

The settings for starting the function are described below.

Session name: Name for the session.

Starting Methods for Session
Start menu

☑ The session can be launched from the start menu.

Application Launcher

☑ The session can be launched with the Application Launcher.

Desktop

☑ The session can be launched with a program launcher on the desktop.

Quick start panel

☑ The session can be launched with the quick start panel.

Start menu's system tab

☑ The session can be launched with the start menu's system tab.

Application Launcher's system tab

☑ The session can be launched with the Application Launcher's system tab.

Desktop context menu

☑ The session can be launched with the desktop context menu.

Menu folder: If you specify a folder name or a path comprising a number of folder names separated by "/", a menu 
path will be created for the session. The menu path will be used in the start menu and in the desktop context menu.

The session name must not contain any of these characters: \ / : * ? “ < > | [ ] { } ( )
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Application Launcher folder: If you specify a folder name or a path comprising a number of folder names 
separated by "/", a menu path will be created for the session. The menu path will be used in the Application 
Launcher.

Desktop folder: If you specify a folder name or a path comprising a number of folder names separated by "/", a 
menu path will be created for the session. The menu path will be used for the program launcher on the desktop.

Password protection: Specifies which password will be requested when launching the session.
Possible values:

None: No password is requested when launching the session.
Administrator: The administrator password is requested when launching the session.
User: The user password is requested when launching the session.
Setup user: The setup user's password is requested when launching the session.

Hotkey

☑ The session can be started with a hotkey. A hotkey consists of one or more modifiers and a key.

Modifiers: A modifier or a combination of several modifiers for the hotkey. You can select a set key symbol/
combination or your own key symbol/combination. A key symbol is a defined chain of characters, e.g.  Ctrl .

These are the pre-defined modifiers and the associated key symbols:

(No modifier) =  None

 =  Shift
[Ctrl] =  Ctrl

 =  Mod4

[Alt] =  Alt

Key combinations are formed as follows with  | :

Ctrl +   =  Ctrl|Super_L

Key: Key for the hotkey

Do not use [AltGr] as a modifier (represented as Mod5 ). Otherwise, the key that is configured as a hotkey 
with AltGr cannot be used as a regular key anymore. Example: If you configure [AltGr] + [E] as a hotkey, it is 
impossible to enter an "e".



When this keyboard key is used as a modifier, it is represented as Mod4 ; when it is used as a key, it 

is represented as Super_L .



To enter a key that does not have a visible character, e. g. the [Tab] key, open a terminal, log on as user

and enter xev -event keyboard . Press the key to be used for the hotkey. The text in brackets that 


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Autostart

☑ The session will be launched automatically when the device boots.

Restart

☑ The session will be relaunched automatically after the termination.

Autostart delay: Waiting time in seconds between the complete startup of the desktop and the automatic session 
launch.

Appliance mode access: Determines whether the session can be started in appliance mode. By default, appliance 
mode implies that one session is running on the device exclusively. For further information, see Appliance Mode (see 
page 220).

☑ The session can be started in appliance mode. The following starting methods can be used in appliance mode:

Desktop (desktop icon; not in appliance mode XDMCP for this Display)
Desktop Context Menu (not in appliance mode XDMCP for this Display)
Application Launcher (includes Application Launcher's system tab; not in appliance 
mode XDMCP for this Display)
Hotkey
Autostart (not in appliance mode XDMCP for this Display)

☐ The session cannot be started in appliance mode. 

Using Network Tools Function (see page 624)

begins with keysym  contains the key symbol for the Key field. Example: Tab  in (keysym 0xff09, 

Tab)
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Using Network Tools Function
 Start the Network Tools function. The start options are described under Network Tools (see page 621).

To obtain information regarding a network device available on your thin client, proceed as follows:

Click on the Devices tab.
Under Network device, select the network device for which you would like to obtain information. 
The information regarding the selected network device will be shown.

To send a ping query to a device in your network, proceed as follows:

Click on the Ping tab.
Under Network address, enter the IP address or the host name of the device to which you would 
like to send a ping query.
If necessary, add the number of ping queries under Send.
Click on the Ping button.
The set number of ping queries will be sent. The results will then be shown.

To obtain information regarding the network status of your thin client, proceed as follows:

Click on the Netstat tab.
Select the desired information under Display:

Routing Table Information
Active Network Services
Multicast Information

Click on the Netstat button.
The desired information will be shown.

To identify the router via which an IP data packet from your thin client reaches a specific target computer, proceed 
as follows:

Click on the Traceroute tab.
Under Network address, give the IP address of the target computer.
Click on the Trace button.
The thin client will send IP packets to the target computer at short intervals, each with a TTL (Time 
To Live, i.e. maximum number of hops) increased by 1. 
When the packet reaches the target computer, "reached” will be shown in the last line and no 
further packet will be sent. 
If no computer replies, "no reply" will be shown.

With the Lookup function, you can request DNS information regarding any address on the Internet from your thin 
client.

Further information regarding the DNS (Domain Name System) can be found on Wikipedia under Domain Name 
System18.

Detailed descriptions of the Domain Name concept can be found in RFC 103419 and in related RFCs.

To obtain DNS information regarding an address on the Internet, proceed as follows:

https://en.wikipedia.org/wiki/Domain_Name_System
https://tools.ietf.org/html/rfc1034
https://en.wikipedia.org/wiki/Domain_Name_System
https://tools.ietf.org/html/rfc1034
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Click on the Lookup tab.
Under Network address, give the IP address or the host name.
Under Information type, select which information is to be shown. The following information types 
are available:

Default information
Internet address
Canonical name
Processor type/operating system
Mailbox exchange
Mailbox information
Name server
Computer name for address
Text information
Generally known services
Any / all information

Click on Lookup.
The desired information will be shown.
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Bluetooth Tool
Menu path: Accessories > Bluetooth Tool

With the Bluetooth Tool, you can connect Bluetooth devices, e.g. a keyboard, a mouse, or a headset, to your thin 
client. For details of how to use the function, see Using Bluetooth Tool (see page 629).

The settings for starting the function are described below.

Session name: Name for the session.

Starting Methods for Session
Start menu

☑ The session can be launched from the start menu.

Application Launcher

☑ The session can be launched with the Application Launcher.

Desktop

☑ The session can be launched with a program launcher on the desktop.

Quick start panel

☑ The session can be launched with the quick start panel.

Start menu's system tab

☑ The session can be launched with the start menu's system tab.

Application Launcher's system tab

☑ The session can be launched with the Application Launcher's system tab.

Desktop context menu

☑ The session can be launched with the desktop context menu.

Menu folder: If you specify a folder name or a path comprising a number of folder names separated by "/", a menu 
path will be created for the session. The menu path will be used in the start menu and in the desktop context menu.

Application Launcher folder: If you specify a folder name or a path comprising a number of folder names 
separated by "/", a menu path will be created for the session. The menu path will be used in the Application 
Launcher.

Desktop folder: If you specify a folder name or a path comprising a number of folder names separated by "/", a 
menu path will be created for the session. The menu path will be used for the program launcher on the desktop.

In order to be able to use Bluetooth, it must be enabled under Devices > Bluetooth.

The session name must not contain any of these characters: \ / : * ? “ < > | [ ] { } ( )
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Password protection: Specifies which password will be requested when launching the session.
Possible values:

None: No password is requested when launching the session.
Administrator: The administrator password is requested when launching the session.
User: The user password is requested when launching the session.
Setup user: The setup user's password is requested when launching the session.

Hotkey

☑ The session can be started with a hotkey. A hotkey consists of one or more modifiers and a key.

Modifiers: A modifier or a combination of several modifiers for the hotkey. You can select a set key symbol/
combination or your own key symbol/combination. A key symbol is a defined chain of characters, e.g.  Ctrl .

These are the pre-defined modifiers and the associated key symbols:

(No modifier) =  None

 =  Shift
[Ctrl] =  Ctrl

 =  Mod4

[Alt] =  Alt

Key combinations are formed as follows with  | :

Ctrl +   =  Ctrl|Super_L

Key: Key for the hotkey

Autostart

☑ The session will be launched automatically when the device boots.

Do not use [AltGr] as a modifier (represented as Mod5 ). Otherwise, the key that is configured as a hotkey 
with AltGr cannot be used as a regular key anymore. Example: If you configure [AltGr] + [E] as a hotkey, it is 
impossible to enter an "e".



When this keyboard key is used as a modifier, it is represented as Mod4 ; when it is used as a key, it 

is represented as Super_L .



To enter a key that does not have a visible character, e. g. the [Tab] key, open a terminal, log on as user

and enter xev -event keyboard . Press the key to be used for the hotkey. The text in brackets that 

begins with keysym  contains the key symbol for the Key field. Example: Tab  in (keysym 0xff09, 

Tab)


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Restart

☑ The session will be relaunched automatically after the termination.

Autostart delay: Waiting time in seconds between the complete startup of the desktop and the automatic session 
launch.

Appliance mode access: Determines whether the session can be started in appliance mode. By default, appliance 
mode implies that one session is running on the device exclusively. For further information, see Appliance Mode (see 
page 220).

☑ The session can be started in appliance mode. The following starting methods can be used in appliance mode:

Desktop (desktop icon; not in appliance mode XDMCP for this Display)
Desktop Context Menu (not in appliance mode XDMCP for this Display)
Application Launcher (includes Application Launcher's system tab; not in appliance 
mode XDMCP for this Display)
Hotkey
Autostart (not in appliance mode XDMCP for this Display)

☐ The session cannot be started in appliance mode. 

Using Bluetooth Tool (see page 629)
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Using Bluetooth Tool
With the Bluetooth Tool, you can connect Bluetooth devices, e.g. a keyboard, a mouse or a headset, to your thin 
client.

The Bluetooth Tool supports the following coupling methods, i.e. the mutual authentication of the Bluetooth 
device and thin client:

Coupling with PIN entry (for most keyboards)
Coupling with fixed PIN (for most headsets, mice or GPS devices)
Coupling with automatic PIN allocation

In order to use Bluetooth devices, a Bluetooth USB adapter must be connected to the thin client.

To connect a Bluetooth device with PIN entry, proceed as follows:

Ensure that the coupling mode is enabled on the Bluetooth device.
Start the Bluetooth Tool. The start options are described under Bluetooth Tool.
The Device Search dialog page will be shown. After a few seconds, the Bluetooth devices found by 
the thin client will be displayed.
Highlight the desired Bluetooth device and click on Forward.
A PIN will be shown on the Device setup dialog page.
Enter the PIN shown into your Bluetooth device.
On the Setup summary dialog page, the status of the connection will be shown.
Click on Close.

To connect a Bluetooth device with a fixed PIN, proceed as follows:

Start the Bluetooth Tool. The start options are described under Bluetooth Tool (see page 626).
The Device Search dialog page will be shown. After a few seconds, the Bluetooth devices found by 
the thin client will be displayed.
Highlight the desired Bluetooth device.
Click on PIN options.
Select one of the specified PINs or enable Custom PIN and enter the PIN for the Bluetooth device. 
You will find this PIN in the documentation for your Bluetooth device. 
On the Setup summary dialog page, the status of the connection will be shown.
Click on Close.

To connect a Bluetooth device with automatic PIN allocation, proceed as follows:

Ensure that the coupling mode is enabled on the Bluetooth device.
Start the Bluetooth Tool. The start options are described under Bluetooth Tool (see page 626).
The Search for devices dialog page will be shown. After a few seconds, the Bluetooth devices 
found by the thin client will be displayed.
Highlight the desired Bluetooth device and click on Forward.
A PIN will be shown on the Device configuration dialog page and on your Bluetooth device.
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If the PINs on the Device configuration dialog page and on your Bluetooth device are identical, 
click on Yes.
On the Set-up summary dialog page, the status of the connection will be shown.
Click on Close.

To cancel coupling to a Bluetooth device, proceed as follows:

Start the Bluetooth Tool. The start options are described under Bluetooth Tool (see page 626).
The connected Bluetooth device will be shown on the Device Search dialog page.
Highlight the connected Bluetooth device and click on Forward.
On the Setup summary dialog page, the status of the connection will be shown.
Click on Close.
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System Information
Menu path: Setup > Accessories > System Information

With this function, you can obtain information regarding the operating system of your thin client and the installed 
system components, internal and connected hardware and the network. You can also measure the performance of 
your thin client using various benchmarks.

The information shown can be copied to the clipboard in order to send it to the IGEL Support department for 
example.

For details of how to use the function, see Using “System Information” Function (see page 634).

The settings for starting the function are described below.

Session name: Name for the session.

Starting Methods for Session
Start menu

☑ The session can be launched from the start menu.

Application Launcher

☑ The session can be launched with the Application Launcher.

Desktop

☑ The session can be launched with a program launcher on the desktop.

Quick start panel

☑ The session can be launched with the quick start panel.

Start menu's system tab

☑ The session can be launched with the start menu's system tab.

Application Launcher's system tab

☑ The session can be launched with the Application Launcher's system tab.

Desktop context menu

☑ The session can be launched with the desktop context menu.

Menu folder: If you specify a folder name or a path comprising a number of folder names separated by "/", a menu 
path will be created for the session. The menu path will be used in the start menu and in the desktop context menu.

Application Launcher folder: If you specify a folder name or a path comprising a number of folder names 
separated by "/", a menu path will be created for the session. The menu path will be used in the Application 
Launcher.

The session name must not contain any of these characters: \ / : * ? “ < > | [ ] { } ( )
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Desktop folder: If you specify a folder name or a path comprising a number of folder names separated by "/", a 
menu path will be created for the session. The menu path will be used for the program launcher on the desktop.

Password protection: Specifies which password will be requested when launching the session.
Possible values:

None: No password is requested when launching the session.
Administrator: The administrator password is requested when launching the session.
User: The user password is requested when launching the session.
Setup user: The setup user's password is requested when launching the session.

Hotkey

☑ The session can be started with a hotkey. A hotkey consists of one or more modifiers and a key.

Modifiers: A modifier or a combination of several modifiers for the hotkey. You can select a set key symbol/
combination or your own key symbol/combination. A key symbol is a defined chain of characters, e.g.  Ctrl .

These are the pre-defined modifiers and the associated key symbols:

(No modifier) =  None

 =  Shift
[Ctrl] =  Ctrl

 =  Mod4

[Alt] =  Alt

Key combinations are formed as follows with  | :

Ctrl +   =  Ctrl|Super_L

Key: Key for the hotkey

Do not use [AltGr] as a modifier (represented as Mod5 ). Otherwise, the key that is configured as a hotkey 
with AltGr cannot be used as a regular key anymore. Example: If you configure [AltGr] + [E] as a hotkey, it is 
impossible to enter an "e".



When this keyboard key is used as a modifier, it is represented as Mod4 ; when it is used as a key, it 

is represented as Super_L .



To enter a key that does not have a visible character, e. g. the [Tab] key, open a terminal, log on as user

and enter xev -event keyboard . Press the key to be used for the hotkey. The text in brackets that 

begins with keysym  contains the key symbol for the Key field. Example: Tab  in (keysym 0xff09, 

Tab)


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Autostart

☑ The session will be launched automatically when the device boots.

Restart

☑ The session will be restarted automatically after the termination.

Autostart delay: Waiting time in seconds between the complete startup of the desktop and the automatic session 
launch.

Appliance mode access: Determines whether the session can be started in appliance mode. By default, appliance 
mode implies that one session is running on the device exclusively. For further information, see Appliance Mode (see 
page 220).

☑ The session can be started in appliance mode. The following starting methods can be used in appliance mode:

Desktop (desktop icon; not in appliance mode XDMCP for this Display)
Desktop Context Menu (not in appliance mode XDMCP for this Display)
Application Launcher (includes Application Launcher's system tab; not in appliance 
mode XDMCP for this Display)
Hotkey
Autostart (not in appliance mode XDMCP for this Display)

☐ The session cannot be started in appliance mode. 

________

Using System Information Function (see page 634)
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Using System Information Function
Menu path: Accessories > System Information

To obtain system information regarding a specific component of your device, proceed as follows:

Start the System Information function. The start options are described under System 
Information (see page 631).
Click on the desired area, e.g. Computer > Operating System.
The information regarding the desired area will be shown.
To send the information shown, e.g. to the IGEL Support department, click on the Copy to 
Clipboard button.
The information is on your clipboard. With Paste or [Ctrl] + [V], you can paste the information into 
an e-mail or a web form.

You can use the System Information function to find out the Vendor ID and Product ID of your connected 
hardware. They are required, for example, if you want to configure Device Rules, see e.g. USB Access 
Control (see page 812) or Native USB Redirection (see page 142).

See also Issues with USB IDs in USB Devices Rules.


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Disk Utility
Menu path: Accessories > Disk Utility

With this function, you can obtain information regarding the hotplug storage devices connected to your thin client. 
You can also remove hotplug storage devices safely, i.e. without the risk of losing data.

For details of how to use the function, see Using “Disk Utility” (see page 638).

The settings for starting the function are described below.

Session name: Name for the session.

Starting Methods for Session
Start menu

☑ The session can be launched from the start menu.

Application Launcher

☑ The session can be launched with the Application Launcher.

Desktop

☑ The session can be launched with a program launcher on the desktop.

Quick start panel

☑ The session can be launched with the quick start panel.

Start menu's system tab

☑ The session can be launched with the start menu's system tab.

Application Launcher's system tab

☑ The session can be launched with the Application Launcher's system tab.

Desktop context menu

☑ The session can be launched with the desktop context menu.

Menu folder: If you specify a folder name or a path comprising a number of folder names separated by "/", a menu 
path will be created for the session. The menu path will be used in the start menu and in the desktop context menu.

The Disk Utility function can only be started if the automatic mounting of hotplug storage devices is 
enabled. The automatic mounting of hotplug storage devices is enabled if the option "Dynamic" is 
selected under Setup > Devices > Storage Devices > Storage Hotplug > Client drive mapping or the 
number in Setup > Devices > Storage Devices > Storage Hotplug > Number of drives is greater than "0".



The session name must not contain any of these characters: \ / : * ? “ < > | [ ] { } ( )
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Application Launcher folder: If you specify a folder name or a path comprising a number of folder names 
separated by "/", a menu path will be created for the session. The menu path will be used in the Application 
Launcher.

Desktop folder: If you specify a folder name or a path comprising a number of folder names separated by "/", a 
menu path will be created for the session. The menu path will be used for the program launcher on the desktop.

Password protection: Specifies which password will be requested when launching the session.
Possible values:

None: No password is requested when launching the session.
Administrator: The administrator password is requested when launching the session.
User: The user password is requested when launching the session.
Setup user: The setup user's password is requested when launching the session.

Hotkey

☑ The session can be started with a hotkey. A hotkey consists of one or more modifiers and a key.

Modifiers: A modifier or a combination of several modifiers for the hotkey. You can select a set key symbol/
combination or your own key symbol/combination. A key symbol is a defined chain of characters, e.g.  Ctrl .

These are the pre-defined modifiers and the associated key symbols:

(No modifier) =  None

 =  Shift
[Ctrl] =  Ctrl

 =  Mod4

[Alt] =  Alt

Key combinations are formed as follows with  | :

Ctrl +   =  Ctrl|Super_L

Key: Key for the hotkey

Do not use [AltGr] as a modifier (represented as Mod5 ). Otherwise, the key that is configured as a hotkey 
with AltGr cannot be used as a regular key anymore. Example: If you configure [AltGr] + [E] as a hotkey, it is 
impossible to enter an "e".



When this keyboard key is used as a modifier, it is represented as Mod4 ; when it is used as a key, it 

is represented as Super_L .



To enter a key that does not have a visible character, e. g. the [Tab] key, open a terminal, log on as user

and enter xev -event keyboard . Press the key to be used for the hotkey. The text in brackets that 


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Autostart

☑ The session will be launched automatically when the device boots.

Restart

☑ The session will be relaunched automatically after the termination.

Autostart delay: Waiting time in seconds between the complete startup of the desktop and the automatic session 
launch.

Appliance mode access: Determines whether the session can be started in appliance mode. By default, appliance 
mode implies that one session is running on the device exclusively. For further information, see Appliance Mode (see 
page 220).

☑ The session can be started in appliance mode. The following starting methods can be used in appliance mode:

Desktop (desktop icon; not in appliance mode XDMCP for this Display)
Desktop Context Menu (not in appliance mode XDMCP for this Display)
Application Launcher (includes Application Launcher's system tab; not in appliance 
mode XDMCP for this Display)
Hotkey
Autostart (not in appliance mode XDMCP for this Display)

☐ The session cannot be started in appliance mode. 

Using Disk Utility (see page 638)

begins with keysym  contains the key symbol for the Key field. Example: Tab  in (keysym 0xff09, 

Tab)
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Using Disk Utility
To obtain information regarding a hotplug storage device connected to your thin client, proceed as follows:

Start the Disk Utility function. The start options are described under Disk Utility (see page 635).
Click on the desired hotplug storage device in the left-hand column.
The information regarding the hotplug storage device is shown in the right-hand column.

To remove a hotplug storage device safely, proceed as follows:

Start the Disk Utility function. The start options are described under Disk Utility (see page 635).
Click on the Safely Remove Hardware button in the right-hand column.
The hotplug storage device is disconnected from the thin client. Once it has been disconnected, 
the storage device can be removed from the thin client.

If Setup > Devices > Storage Devices > Storage Hotplug > Hotplug beep is enabled, a 
signal tone will signal that the device has been disconnected successfully. If Setup > 
Devices > Storage Devices > Storage Hotplug > Hotplug message is enabled, a message 
window will signal that the device has been disconnected successfully. Further 
information can be found under Storage Hotplug (see page 807).


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Disk Removal
Menu path: Accessories > Disk Removal

With this function, you can remove a hotplug storage device connected to your thin client safely without the risk of 
losing data. 

The settings for starting the function are described below:

Session name: Name for the session.

Starting Methods for Session
Start menu

☑ The session can be launched from the start menu.

Application Launcher

☑ The session can be launched with the Application Launcher.

Desktop

☑ The session can be launched with a program launcher on the desktop.

Quick start panel

☑ The session can be launched with the quick start panel.

Start menu's system tab

☑ The session can be launched with the start menu's system tab.

Application Launcher's system tab

☑ The session can be launched with the Application Launcher's system tab.

Desktop context menu

☑ The session can be launched with the desktop context menu.

Menu folder: If you specify a folder name or a path comprising a number of folder names separated by "/", a menu 
path will be created for the session. The menu path will be used in the start menu and in the desktop context menu.

Application Launcher folder: If you specify a folder name or a path comprising a number of folder names 
separated by "/", a menu path will be created for the session. The menu path will be used in the Application 
Launcher.

Desktop folder: If you specify a folder name or a path comprising a number of folder names separated by "/", a 
menu path will be created for the session. The menu path will be used for the program launcher on the desktop.

Hotkey

☑ The session can be started with a hotkey. A hotkey consists of one or more modifiers and a key.

The session name must not contain any of these characters: \ / : * ? “ < > | [ ] { } ( )
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Modifiers: A modifier or a combination of several modifiers for the hotkey. You can select a set key symbol/
combination or your own key symbol/combination. A key symbol is a defined chain of characters, e.g.  Ctrl .

These are the pre-defined modifiers and the associated key symbols:

(No modifier) =  None

 =  Shift
[Ctrl] =  Ctrl

 =  Mod4

[Alt] =  Alt

Key combinations are formed as follows with  | :

Ctrl +   =  Ctrl|Super_L

Key: Key for the hotkey

Appliance mode access: Determines whether the session can be started in appliance mode. By default, appliance 
mode implies that one session is running on the device exclusively. For further information, see Appliance Mode (see 
page 220).

☑ The session can be started in appliance mode. The following starting methods can be used in appliance mode:

Desktop (desktop icon; not in appliance mode XDMCP for this Display)
Desktop Context Menu (not in appliance mode XDMCP for this Display)
Application Launcher (includes Application Launcher's system tab; not in appliance 
mode XDMCP for this Display)
Hotkey
Autostart (not in appliance mode XDMCP for this Display)

☐ The session cannot be started in appliance mode. 

Do not use [AltGr] as a modifier (represented as Mod5 ). Otherwise, the key that is configured as a hotkey 
with AltGr cannot be used as a regular key anymore. Example: If you configure [AltGr] + [E] as a hotkey, it is 
impossible to enter an "e".



When this keyboard key is used as a modifier, it is represented as Mod4 ; when it is used as a key, it 

is represented as Super_L .



To enter a key that does not have a visible character, e. g. the [Tab] key, open a terminal, log on as user

and enter xev -event keyboard . Press the key to be used for the hotkey. The text in brackets that 

begins with keysym  contains the key symbol for the Key field. Example: Tab  in (keysym 0xff09, 

Tab)


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Disk utility in eject menu:

☑ Allows to start the disk utility from the eject menu.

See also Using “Disk Utility” (see page 638).
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1.
2.

Using Safely Remove Hardware Function
To remove a hotplug storage device safely, proceed as follows:

Start the Safely Remove Hardware function. The start options are described under Disk Removal.
In the context menu, click on the hotplug storage device that you want to remove.
The hotplug storage device is disconnected from the thin client. Once it has been disconnected, 
the storage device can be removed from the thin client.

If Setup > Devices > Storage Devices > Storage Hotplug > Use storage hotplug beep is 
enabled, a signal tone will signal that the device has been disconnected successfully. If 
Setup > Devices > Storage Devices > Storage Hotplug > Show storage hotplug 
messages is enabled, a message window will signal that the device has been 
disconnected successfully.


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Mobile Device Access
Menu path: Accessories > Mobile Device Access

With this function, you can access the directories and files of a mobile device. Mobile device access is available from 
IGEL OS 10.04.100 onwards.

The following device types can be used:

Smartphones with Android (via MTP / PTP) or iOS
Tablets with Android via MTP / PTP) or iOS
Digital cameras

To use the mobile device access feature, you must first activate the function. For information about the activation 
and use, see Using Mobile Device Access.

The settings for starting the function are described below.

Session name: Name for the session.

Starting Methods for Session
Start menu

☑ The session can be launched from the start menu.

Application Launcher

☑ The session can be launched with the Application Launcher.

Desktop

☑ The session can be launched with a program launcher on the desktop.

Quick start panel

☑ The session can be launched with the quick start panel.

Start menu's system tab

Feature Not Available on IZ Devices

This feature is not available on IGEL IZ devices (IGEL Zero HDX, IGEL Zero RFX, or IGEL Zero Horizon).


Feature with limited support! The mobile device access feature comes with limited support and without 
any warranty. Any support for this feature is provided on a non-binding, “best effort” basis.



The functionality may differ according to the specific device and operating system version.

The session name must not contain any of these characters: \ / : * ? “ < > | [ ] { } ( )
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☑ The session can be launched with the start menu's system tab.

Application Launcher's system tab

☑ The session can be launched with the Application Launcher's system tab.

Desktop context menu

☑ The session can be launched with the desktop context menu.

Menu folder: If you specify a folder name or a path comprising a number of folder names separated by "/", a menu 
path will be created for the session. The menu path will be used in the start menu and in the desktop context menu.

Application Launcher folder: If you specify a folder name or a path comprising a number of folder names 
separated by "/", a menu path will be created for the session. The menu path will be used in the Application 
Launcher.

Desktop folder: If you specify a folder name or a path comprising a number of folder names separated by "/", a 
menu path will be created for the session. The menu path will be used for the program launcher on the desktop.

Password protection: Specifies which password will be requested when launching the session.
Possible values:

None: No password is requested when launching the session.
Administrator: The administrator password is requested when launching the session.
User: The user password is requested when launching the session.
Setup user: The setup user's password is requested when launching the session.

Hotkey

☑ The session can be started with a hotkey. A hotkey consists of one or more modifiers and a key.

Modifiers: A modifier or a combination of several modifiers for the hotkey. You can select a set key symbol/
combination or your own key symbol/combination. A key symbol is a defined chain of characters, e.g.  Ctrl .

These are the pre-defined modifiers and the associated key symbols:

(No modifier) =  None

 =  Shift
[Ctrl] =  Ctrl

 =  Mod4

[Alt] =  Alt

Do not use [AltGr] as a modifier (represented as Mod5 ). Otherwise, the key that is configured as a hotkey 
with AltGr cannot be used as a regular key anymore. Example: If you configure [AltGr] + [E] as a hotkey, it is 
impossible to enter an "e".



When this keyboard key is used as a modifier, it is represented as Mod4 ; when it is used as a key, it 

is represented as Super_L .


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Key combinations are formed as follows with  | :

Ctrl +   =  Ctrl|Super_L

Key: Key for the hotkey

Autostart

☑ The session will be launched automatically when the device boots.

Restart

☑ The session will be restarted automatically after the termination.

Autostart delay: Waiting time in seconds between the complete startup of the desktop and the automatic session 
launch.

Appliance mode access: Determines whether the session can be started in appliance mode. By default, appliance 
mode implies that one session is running on the device exclusively. For further information, see Appliance Mode (see 
page 220).

☑ The session can be started in appliance mode. The following starting methods can be used in appliance mode:

Desktop (desktop icon; not in appliance mode XDMCP for this Display)
Desktop Context Menu (not in appliance mode XDMCP for this Display)
Application Launcher (includes Application Launcher's system tab; not in appliance 
mode XDMCP for this Display)
Hotkey
Autostart (not in appliance mode XDMCP for this Display)

☐ The session cannot be started in appliance mode. 

To enter a key that does not have a visible character, e. g. the [Tab] key, open a terminal, log on as user

and enter xev -event keyboard . Press the key to be used for the hotkey. The text in brackets that 

begins with keysym  contains the key symbol for the Key field. Example: Tab  in (keysym 0xff09, 

Tab)


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Firmware Update
Menu path: Accessories > Firmware Update

With this function, you can update your endpoint device’s firmware. For details of how to use the function, see 
Using “Firmware Update” (see page 649).

The settings for starting the function are described below.

Session name: Name for the session.

Starting Methods for Session
Start menu

☑ The session can be launched from the start menu.

Application Launcher

☑ The session can be launched with the Application Launcher.

Desktop

☑ The session can be launched with a program launcher on the desktop.

Quick start panel

☑ The session can be launched with the quick start panel.

Start menu's system tab

☑ The session can be launched with the start menu's system tab.

Application Launcher's system tab

☑ The session can be launched with the Application Launcher's system tab.

Desktop context menu

☑ The session can be launched with the desktop context menu.

Menu folder: If you specify a folder name or a path comprising a number of folder names separated by "/", a menu 
path will be created for the session. The menu path will be used in the start menu and in the desktop context menu.

Application Launcher folder: If you specify a folder name or a path comprising a number of folder names 
separated by "/", a menu path will be created for the session. The menu path will be used in the Application 
Launcher.

Desktop folder: If you specify a folder name or a path comprising a number of folder names separated by "/", a 
menu path will be created for the session. The menu path will be used for the program launcher on the desktop.

Password protection: Specifies which password will be requested when launching the session.
Possible values:

None: No password is requested when launching the session.

The session name must not contain any of these characters: \ / : * ? “ < > | [ ] { } ( )
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Administrator: The administrator password is requested when launching the session.
User: The user password is requested when launching the session.
Setup user: The setup user's password is requested when launching the session.

Hotkey

☑ The session can be started with a hotkey. A hotkey consists of one or more modifiers and a key.

Modifiers: A modifier or a combination of several modifiers for the hotkey. You can select a set key symbol/
combination or your own key symbol/combination. A key symbol is a defined chain of characters, e.g.  Ctrl .

These are the pre-defined modifiers and the associated key symbols:

(No modifier) =  None

 =  Shift
[Ctrl] =  Ctrl

 =  Mod4

[Alt] =  Alt

Key combinations are formed as follows with  | :

Ctrl +   =  Ctrl|Super_L

Key: Key for the hotkey

Autostart

☑ The session will be launched automatically when the device boots.

Restart

☑ The session will be relaunched automatically after the termination.

Do not use [AltGr] as a modifier (represented as Mod5 ). Otherwise, the key that is configured as a hotkey 
with AltGr cannot be used as a regular key anymore. Example: If you configure [AltGr] + [E] as a hotkey, it is 
impossible to enter an "e".



When this keyboard key is used as a modifier, it is represented as Mod4 ; when it is used as a key, it 

is represented as Super_L .



To enter a key that does not have a visible character, e. g. the [Tab] key, open a terminal, log on as user

and enter xev -event keyboard . Press the key to be used for the hotkey. The text in brackets that 

begins with keysym  contains the key symbol for the Key field. Example: Tab  in (keysym 0xff09, 

Tab)


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Autostart delay: Waiting time in seconds between the complete startup of the desktop and the automatic session 
launch.

Appliance mode access: Determines whether the session can be started in appliance mode. By default, appliance 
mode implies that one session is running on the device exclusively. For further information, see Appliance Mode (see 
page 220).

☑ The session can be started in appliance mode. The following starting methods can be used in appliance mode:

Desktop (desktop icon; not in appliance mode XDMCP for this Display)
Desktop Context Menu (not in appliance mode XDMCP for this Display)
Application Launcher (includes Application Launcher's system tab; not in appliance 
mode XDMCP for this Display)
Hotkey
Autostart (not in appliance mode XDMCP for this Display)

☐ The session cannot be started in appliance mode. 

Using Firmware Update Function (see page 649)
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1.

2.

3.

Using Firmware Update Function
To launch the firmware update for your endpoint device, proceed as follows:

Ensure that the settings under System > Update > Firmware Update are correct. Further 
information can be found under Firmware Update (see page 849).
Start the Firmware Update function. The start options are described under Firmware Update (see 
page 646).
Confirm this by clicking Yes.
The latest firmware will be loaded onto your endpoint device. The device will restart in the 
process.
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Smartcard Personalization
Menu path: Accessories > Smartcard Personalization

With this function, you can change the password for your IGEL smartcard. For details of how to use the function, see 
Using “Smartcard Personalization” function (see page 653).

Further information regarding the IGEL smartcard can be found in the Authentication with IGEL Smartcard how-to.

The settings for starting the function are described below.

Session name: Name for the session.

Starting Methods for Session
Start menu

☑ The session can be launched from the start menu.

Application Launcher

☑ The session can be launched with the Application Launcher.

Desktop

☑ The session can be launched with a program launcher on the desktop.

Quick start panel

☑ The session can be launched with the quick start panel.

Start menu's system tab

☑ The session can be launched with the start menu's system tab.

Application Launcher's system tab

☑ The session can be launched with the Application Launcher's system tab.

Desktop context menu

☑ The session can be launched with the desktop context menu.

Menu folder: If you specify a folder name or a path comprising a number of folder names separated by "/", a menu 
path will be created for the session. The menu path will be used in the start menu and in the desktop context menu.

Application Launcher folder: If you specify a folder name or a path comprising a number of folder names 
separated by "/", a menu path will be created for the session. The menu path will be used in the Application 
Launcher.

Desktop folder: If you specify a folder name or a path comprising a number of folder names separated by "/", a 
menu path will be created for the session. The menu path will be used for the program launcher on the desktop.

The session name must not contain any of these characters: \ / : * ? “ < > | [ ] { } ( )
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Password protection: Specifies which password will be requested when launching the session.
Possible values:

None: No password is requested when launching the session.
Administrator: The administrator password is requested when launching the session.
User: The user password is requested when launching the session.
Setup user: The setup user's password is requested when launching the session.

Hotkey

☑ The session can be started with a hotkey. A hotkey consists of one or more modifiers and a key.

Modifiers: A modifier or a combination of several modifiers for the hotkey. You can select a set key symbol/
combination or your own key symbol/combination. A key symbol is a defined chain of characters, e.g.  Ctrl .

These are the pre-defined modifiers and the associated key symbols:

(No modifier) =  None

 =  Shift
[Ctrl] =  Ctrl

 =  Mod4

[Alt] =  Alt

Key combinations are formed as follows with  | :

Ctrl +   =  Ctrl|Super_L

Key: Key for the hotkey

Autostart

☑ The session will be launched automatically when the device boots.

Do not use [AltGr] as a modifier (represented as Mod5 ). Otherwise, the key that is configured as a hotkey 
with AltGr cannot be used as a regular key anymore. Example: If you configure [AltGr] + [E] as a hotkey, it is 
impossible to enter an "e".



When this keyboard key is used as a modifier, it is represented as Mod4 ; when it is used as a key, it 

is represented as Super_L .



To enter a key that does not have a visible character, e. g. the [Tab] key, open a terminal, log on as user

and enter xev -event keyboard . Press the key to be used for the hotkey. The text in brackets that 

begins with keysym  contains the key symbol for the Key field. Example: Tab  in (keysym 0xff09, 

Tab)


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•

Restart

☑ The session will be relaunched automatically after the termination.

Autostart delay: Waiting time in seconds between the complete startup of the desktop and the automatic session 
launch.

Using Smartcard Personalization Function (see page 653)
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1.

2.
•
•
•

•
3.
4.

•

•

5.

Using Smartcard Personalization Function
With this function, you can change your user name, the associated password and sessions on your IGEL smartcard.

To personalize an IGEL smartcard, proceed as follows:

Start the Smartcard Personalization function. The start options are described under Smartcard 
Personalization (see page 650).
Specify the access data on your IGEL smartcard:

First name: First name of the user
Last name: Surname of the user
Require password
☑ A password must be entered when logging on with this IGEL smartcard.
☐ No password must be entered when logging on.
Password: Password for logging on with this IGEL smartcard.

Select the sessions and functions that are to be available on this IGEL smartcard.
Specify the start behavior for the sessions and functions on this IGEL smartcard:

Autostart
☑ The session/function will automatically start after you log on. The application launchers 
configured in the desktop integration are available.
☐ The session will not automatically start. The application launchers configured in the 
desktop integration are available.
Restart
☑ The session/function will automatically restart after being closed.
☐ The session/function will not automatically restart.

Click on Write smartcard.

A confirmation dialog will appear when the writing operation is complete. 
You can now remove the IGEL smartcard.

Do not remove the IGEL smartcard before the writing operation is complete.
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Identify Monitors
Menu path: Accessories > Identify Monitors

With this function, you can identify the monitors connected to your thin client. For details of how to use the 
function, see Using “Identify Monitors” function (see page 657).

The settings for starting the function are described below.

Session name: Name for the session.

Starting Methods for Session
Start menu

☑ The session can be launched from the start menu.

Application Launcher

☑ The session can be launched with the Application Launcher.

Desktop

☑ The session can be launched with a program launcher on the desktop.

Quick start panel

☑ The session can be launched with the quick start panel.

Start menu's system tab

☑ The session can be launched with the start menu's system tab.

Application Launcher's system tab

☑ The session can be launched with the Application Launcher's system tab.

Desktop context menu

☑ The session can be launched with the desktop context menu.

Menu folder: If you specify a folder name or a path comprising a number of folder names separated by "/", a menu 
path will be created for the session. The menu path will be used in the start menu and in the desktop context menu.

Application Launcher folder: If you specify a folder name or a path comprising a number of folder names 
separated by "/", a menu path will be created for the session. The menu path will be used in the Application 
Launcher.

Desktop folder: If you specify a folder name or a path comprising a number of folder names separated by "/", a 
menu path will be created for the session. The menu path will be used for the program launcher on the desktop.

Password protection: Specifies which password will be requested when launching the session.
Possible values:

None: No password is requested when launching the session.

The session name must not contain any of these characters: \ / : * ? “ < > | [ ] { } ( )
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Administrator: The administrator password is requested when launching the session.
User: The user password is requested when launching the session.
Setup user: The setup user's password is requested when launching the session.

Hotkey

☑ The session can be started with a hotkey. A hotkey consists of one or more modifiers and a key.

Modifiers: A modifier or a combination of several modifiers for the hotkey. You can select a set key symbol/
combination or your own key symbol/combination. A key symbol is a defined chain of characters, e.g.  Ctrl .

These are the pre-defined modifiers and the associated key symbols:

(No modifier) =  None

 =  Shift
[Ctrl] =  Ctrl

 =  Mod4

[Alt] =  Alt

Key combinations are formed as follows with  | :

Ctrl +   =  Ctrl|Super_L

Key: Key for the hotkey

Autostart

☑ The session will be launched automatically when the device boots.

Restart

☑ The session will be relaunched automatically after the termination.

Do not use [AltGr] as a modifier (represented as Mod5 ). Otherwise, the key that is configured as a hotkey 
with AltGr cannot be used as a regular key anymore. Example: If you configure [AltGr] + [E] as a hotkey, it is 
impossible to enter an "e".



When this keyboard key is used as a modifier, it is represented as Mod4 ; when it is used as a key, it 

is represented as Super_L .



To enter a key that does not have a visible character, e. g. the [Tab] key, open a terminal, log on as user

and enter xev -event keyboard . Press the key to be used for the hotkey. The text in brackets that 

begins with keysym  contains the key symbol for the Key field. Example: Tab  in (keysym 0xff09, 

Tab)


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Autostart delay: Waiting time in seconds between the complete startup of the desktop and the automatic session 
launch.

Appliance mode access: Determines whether the session can be started in appliance mode. By default, appliance 
mode implies that one session is running on the device exclusively. For further information, see Appliance Mode (see 
page 220).

☑ The session can be started in appliance mode. The following starting methods can be used in appliance mode:

Desktop (desktop icon; not in appliance mode XDMCP for this Display)
Desktop Context Menu (not in appliance mode XDMCP for this Display)
Application Launcher (includes Application Launcher's system tab; not in appliance 
mode XDMCP for this Display)
Hotkey
Autostart (not in appliance mode XDMCP for this Display)

☐ The session cannot be started in appliance mode. 

Using Identify Monitors Function (see page 657)
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Using Identify Monitors Function
To identify the monitors connected to your thin client, proceed as follows:

 Start the Identify Monitors function. The start options are described under Identify Monitors (see page 654).
The following data are shown for each monitor:

Socket to which the monitor is connected
Type of monitor
Resolution currently used
Maximum resolution of the monitor if the resolution currently used is a different one
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Webcam Information
Menu path: Accessories > Webcam Information

With this function, you can change and check the settings for a connected webcam. For details of how to use the 
Webcam Information function, see Using Webcam Information (see page 661).

The settings for starting the function are described below.

Session name: Name for the session.

Starting Methods for Session
Start menu

☑ The session can be launched from the start menu.

Application Launcher

☑ The session can be launched with the Application Launcher.

Desktop

☑ The session can be launched with a program launcher on the desktop.

Quick start panel

☑ The session can be launched with the quick start panel.

Start menu's system tab

☑ The session can be launched with the start menu's system tab.

Application Launcher's system tab

☑ The session can be launched with the Application Launcher's system tab.

Desktop context menu

☑ The session can be launched with the desktop context menu.

Menu folder: If you specify a folder name or a path comprising a number of folder names separated by "/", a menu 
path will be created for the session. The menu path will be used in the start menu and in the desktop context menu.

Application Launcher folder: If you specify a folder name or a path comprising a number of folder names 
separated by "/", a menu path will be created for the session. The menu path will be used in the Application 
Launcher.

Desktop folder: If you specify a folder name or a path comprising a number of folder names separated by "/", a 
menu path will be created for the session. The menu path will be used for the program launcher on the desktop.

Password protection: Specifies which password will be requested when launching the session.
Possible values:

None: No password is requested when launching the session.

The session name must not contain any of these characters: \ / : * ? “ < > | [ ] { } ( )
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Administrator: The administrator password is requested when launching the session.
User: The user password is requested when launching the session.
Setup user: The setup user's password is requested when launching the session.

Hotkey

☑ The session can be started with a hotkey. A hotkey consists of one or more modifiers and a key.

Modifiers: A modifier or a combination of several modifiers for the hotkey. You can select a set key symbol/
combination or your own key symbol/combination. A key symbol is a defined chain of characters, e.g.  Ctrl .

These are the pre-defined modifiers and the associated key symbols:

(No modifier) =  None

 =  Shift
[Ctrl] =  Ctrl

 =  Mod4

[Alt] =  Alt

Key combinations are formed as follows with  | :

Ctrl +   =  Ctrl|Super_L

Key: Key for the hotkey

Autostart

☑ The session will be launched automatically when the device boots.

Restart

☑ The session will be relaunched automatically after the termination.

Do not use [AltGr] as a modifier (represented as Mod5 ). Otherwise, the key that is configured as a hotkey 
with AltGr cannot be used as a regular key anymore. Example: If you configure [AltGr] + [E] as a hotkey, it is 
impossible to enter an "e".



When this keyboard key is used as a modifier, it is represented as Mod4 ; when it is used as a key, it 

is represented as Super_L .



To enter a key that does not have a visible character, e. g. the [Tab] key, open a terminal, log on as user

and enter xev -event keyboard . Press the key to be used for the hotkey. The text in brackets that 

begins with keysym  contains the key symbol for the Key field. Example: Tab  in (keysym 0xff09, 

Tab)


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Autostart delay: Waiting time in seconds between the complete startup of the desktop and the automatic session 
launch.

Appliance mode access: Determines whether the session can be started in appliance mode. By default, appliance 
mode implies that one session is running on the device exclusively. For further information, see Appliance Mode (see 
page 220).

☑ The session can be started in appliance mode. The following starting methods can be used in appliance mode:

Desktop (desktop icon; not in appliance mode XDMCP for this Display)
Desktop Context Menu (not in appliance mode XDMCP for this Display)
Application Launcher (includes Application Launcher's system tab; not in appliance 
mode XDMCP for this Display)
Hotkey
Autostart (not in appliance mode XDMCP for this Display)

☐ The session cannot be started in appliance mode. 

Using Webcam Information (see page 661)
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1.

•
•
•

2.
3.

Using Webcam Information
You can determine and change the width, height and frame rate for the webcam connected.

To determine and change the values for width, height and frame rate, proceed as follows:

Start the Webcam Information function.
The following values will be shown:

Width: Width of the image in pixels
Height: Height of the image in pixels
Rate: Frame rate in fps (frames per second: individual images per second). Example: 1/30
means 30 individual images per second.

Click on one of the fields to change the value. The supported values will be shown in the process.
Click on Test.
The video image generated by the webcam with the current settings will be shown.
In order to check whether the webcam is functioning in a session (e.g. redirected via Citrix HDX 
Webcam Redirection), open https://www.onlinemictest.com/webcam-test/ in your browser within 
the session.

Alternatively, you can determine the values supported by the webcam in the local terminal with the 
command webcam-info -l .



https://www.onlinemictest.com/webcam-test/
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ICG Agent Setup
Menu path: Accessories > ICG Agent Setup

This tool helps you configure the connection to IGEL Cloud Gateway (ICG). To learn how to use it, please refer 
to Using ICG Agent Setup (see page 665).

Session name: Name for the session.

Starting Methods for Session
Start menu

☑ The session can be launched from the start menu.

Application Launcher

☑ The session can be launched with the Application Launcher.

Desktop

☑ The session can be launched with a program launcher on the desktop.

Quick start panel

☑ The session can be launched with the quick start panel.

Start menu's system tab

☑ The session can be launched with the start menu's system tab.

Application Launcher's system tab

☑ The session can be launched with the Application Launcher's system tab.

Desktop context menu

☑ The session can be launched with the desktop context menu.

Menu folder: If you specify a folder name or a path comprising a number of folder names separated by "/", a menu 
path will be created for the session. The menu path will be used in the start menu and in the desktop context menu.

Application Launcher folder: If you specify a folder name or a path comprising a number of folder names 
separated by "/", a menu path will be created for the session. The menu path will be used in the Application 
Launcher.

Desktop folder: If you specify a folder name or a path comprising a number of folder names separated by "/", a 
menu path will be created for the session. The menu path will be used for the program launcher on the desktop.

Password protection: Specifies which password will be requested when launching the session.
Possible values:

None: No password is requested when launching the session.
Administrator: The administrator password is requested when launching the session.

The session name must not contain any of these characters: \ / : * ? “ < > | [ ] { } ( )
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User: The user password is requested when launching the session.
Setup user: The setup user's password is requested when launching the session.

Hotkey

☑ The session can be started with a hotkey. A hotkey consists of one or more modifiers and a key.

Modifiers: A modifier or a combination of several modifiers for the hotkey. You can select a set key symbol/
combination or your own key symbol/combination. A key symbol is a defined chain of characters, e.g.  Ctrl .

These are the pre-defined modifiers and the associated key symbols:

(No modifier) =  None

 =  Shift
[Ctrl] =  Ctrl

 =  Mod4

[Alt] =  Alt

Key combinations are formed as follows with  | :

Ctrl +   =  Ctrl|Super_L

Key: Key for the hotkey

Autostart

☑ The session will be launched automatically when the device boots.

Restart

☑ The session will be relaunched automatically after the termination.

Do not use [AltGr] as a modifier (represented as Mod5 ). Otherwise, the key that is configured as a hotkey 
with AltGr cannot be used as a regular key anymore. Example: If you configure [AltGr] + [E] as a hotkey, it is 
impossible to enter an "e".



When this keyboard key is used as a modifier, it is represented as Mod4 ; when it is used as a key, it 

is represented as Super_L .



To enter a key that does not have a visible character, e. g. the [Tab] key, open a terminal, log on as user

and enter xev -event keyboard . Press the key to be used for the hotkey. The text in brackets that 

begins with keysym  contains the key symbol for the Key field. Example: Tab  in (keysym 0xff09, 

Tab)


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Autostart delay: Waiting time in seconds between the complete startup of the desktop and the automatic session 
launch.

Using ICG Agent Setup (see page 665)
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•

Using ICG Agent Setup
This assistant helps you configure the connection to IGEL Cloud Gateway (ICG):

 Start ICG Agent Setup. Start options are described in ICG Agent Setup (see page 662).

Address: IP address or DNS name of the server running ICG. You can specify a TCP port by 
appending a colon and the port number.

 After entering the server address, click Connect.

If you are using an ICG certificate signed by an unknown CA:
Root certificate fingerprint: Fingerprint identifying the root certificate - three of four fields are 
prefilled. 
Supply the missing fingerprint field from the credentials you received from your system 
administrator.
ICG One-Time Password: The one-time-password you received from your system administrator.

 Click this icon in order to make the one-time password readable.

 Click this icon in order to change the keyboard layout for entering the 
password.

Login: Click this button to connect the thin client to ICG.
Finish: Click this button for instant connection to ICG. Otherwise, it will be started automatically 
on the next boot.

This cloud icon in the system tray indicates that the thin client is connected to ICG.


a.

b.
c.

If you are switching between home office and company office often, it may be feasible to configure 
your IGEL OS so that it prefers the local UMS over the ICG. This prevents your device from 
connecting to the ICG instead of the local UMS although the device is located in the company 
network.
To make the device prefer the local UMS, make the following settings:

Go to IGEL Setup > System > Registry > system > remotemanager > 
icg_try_ums_connect (Search parameter:
system.remotemanager.icg_try_ums_connect).
Enable Prefer UMS over ICG.
Confirm your setting with Ok.


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Licensing
Menu path: Accessories > Licensing

With this function, you can acquire a license from IGEL. An internet connection is required. The following license 
types are supported:

Enterprise Management Pack (EMP)
Software Maintenance

For information on how to use the license browser, see Activate Your IGEL OS - Manual License Deployment (see page 
23).

The settings for starting the function are described below.

Session name: Name for the session.

Start menu

☑ The session can be launched from the start menu.

Application Launcher

☑ The session can be launched with the Application Launcher.

Desktop

☑ The session can be launched with a program launcher on the desktop.

Quick start panel

☑ The session can be launched with the quick start panel.

Start menu's system tab

☑ The session can be launched with the start menu's system tab.

Application Launcher's system tab

☑ The session can be launched with the Application Launcher's system tab.

Desktop context menu

☑ The session can be launched with the desktop context menu.

Menu folder: If you specify a folder name or a path comprising a number of folder names separated by "/", a menu 
path will be created for the session. The menu path will be used in the start menu and in the desktop context menu.

Application Launcher folder: If you specify a folder name or a path comprising a number of folder names 
separated by "/", a menu path will be created for the session. The menu path will be used in the Application 
Launcher.

Desktop folder: If you specify a folder name or a path comprising a number of folder names separated by "/", a 
menu path will be created for the session. The menu path will be used for the program launcher on the desktop.

The session name must not contain any of these characters: \ / : * ? “ < > | [ ] { } ( )
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Password protection: Specifies which password will be requested when launching the session.
Possible values:

None: No password is requested when launching the session.
Administrator: The administrator password is requested when launching the session.
User: The user password is requested when launching the session.
Setup user: The setup user's password is requested when launching the session.

Hotkey

☑ The session can be started with a hotkey. A hotkey consists of one or more modifiers and a key.

Modifiers: A modifier or a combination of several modifiers for the hotkey. You can select a set key symbol/
combination or your own key symbol/combination. A key symbol is a defined chain of characters, e.g.  Ctrl .

These are the pre-defined modifiers and the associated key symbols:

(No modifier) =  None

 =  Shift
[Ctrl] =  Ctrl

 =  Mod4

[Alt] =  Alt

Key combinations are formed as follows with  | :

Ctrl +   =  Ctrl|Super_L

Key: Key for the hotkey

Autostart

☑ The session will be launched automatically when the device boots.

Do not use [AltGr] as a modifier (represented as Mod5 ). Otherwise, the key that is configured as a hotkey 
with AltGr cannot be used as a regular key anymore. Example: If you configure [AltGr] + [E] as a hotkey, it is 
impossible to enter an "e".



When this keyboard key is used as a modifier, it is represented as Mod4 ; when it is used as a key, it 

is represented as Super_L .



To enter a key that does not have a visible character, e. g. the [Tab] key, open a terminal, log on as user

and enter xev -event keyboard . Press the key to be used for the hotkey. The text in brackets that 

begins with keysym  contains the key symbol for the Key field. Example: Tab  in (keysym 0xff09, 

Tab)


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Restart

☑ The session will be restarted automatically after the termination.

Autostart delay: Waiting time in seconds between the complete startup of the desktop and the automatic session 
launch.

Autostart notification: This parameter is available if Autostart is activated and Autostart delay is set to a value 
greater than zero.

☑ For the duration defined by Autostart delay, a dialog is shown which allows the user to start the session 
immediately or cancel the automatic session start.

☐ No dialog is shown; the session is started automatically after the timespan specified with Autostart delay.

Appliance mode access: Determines whether the session can be started in appliance mode. By default, appliance 
mode implies that one session is running on the device exclusively. For further information, see Appliance Mode (see 
page 220).

☑ The session can be started in appliance mode. The following starting methods can be used in appliance mode:

Desktop (desktop icon; not in appliance mode XDMCP for this Display)
Desktop Context Menu (not in appliance mode XDMCP for this Display)
Application Launcher (includes Application Launcher's system tab; not in appliance 
mode XDMCP for this Display)
Hotkey
Autostart (not in appliance mode XDMCP for this Display)

☐ The session cannot be started in appliance mode. 
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Connector ID Key Software
Menu path:  Accessories > Connector ID Key Software

Stratusphere UX is used to assess or inventory the current environment as the basis for designing the target 
environment.

The Stratusphere IGEL agent will detect RDP/RFX, ICA/HDX, PCoIP and Blast protocols to precisely measure the user 
experience and validate that the new desktops meet performance and security demands.

Enable Stratusphere UX CID Key

☑Stratusphere UX CID Key is enabled.

Stratusphere hub: The hub (IP-address or DNS) of the Stratusphere. 

Stratusphere machine group: Machine group of the Stratusphere.

Stratusphere user group: User group of the Stratusphere.
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OS 11 Upgrade
Menu path: Accessories > OS 11 Upgrade

With this tool, you can upgrade a device from IGEL OS 10 to IGEL OS 11. For more information about this tool, see 
Testing the Upgrade; for instructions on how to upgrade, see Upgrading IGEL Devices from IGEL OS 10 to IGEL OS 
11.

The settings for starting the function are described below.

Session name: Name for the session.

Start menu

☑ The session can be launched from the start menu.

Application Launcher

☑ The session can be launched with the Application Launcher.

Desktop

☑ The session can be launched with a program launcher on the desktop.

Quick start panel

☑ The session can be launched with the quick start panel.

Start menu's system tab

☑ The session can be launched with the start menu's system tab.

Application Launcher's system tab

☑ The session can be launched with the Application Launcher's system tab.

Desktop context menu

☑ The session can be launched with the desktop context menu.

Menu folder: If you specify a folder name or a path comprising a number of folder names separated by "/", a menu 
path will be created for the session. The menu path will be used in the start menu and in the desktop context menu.

Application Launcher folder: If you specify a folder name or a path comprising a number of folder names 
separated by "/", a menu path will be created for the session. The menu path will be used in the Application 
Launcher.

Desktop folder: If you specify a folder name or a path comprising a number of folder names separated by "/", a 
menu path will be created for the session. The menu path will be used for the program launcher on the desktop.

Password protection: Specifies which password will be requested when launching the session.
Possible values:

None: No password is requested when launching the session.
Administrator: The administrator password is requested when launching the session.
User: The user password is requested when launching the session.

The session name must not contain any of these characters: \ / : * ? “ < > | [ ] { } ( )
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Setup user: The setup user's password is requested when launching the session.

Hotkey

☑ The session can be started with a hotkey. A hotkey consists of one or more modifiers and a key.

Modifiers: A modifier or a combination of several modifiers for the hotkey. You can select a set key symbol/
combination or your own key symbol/combination. A key symbol is a defined chain of characters, e.g.  Ctrl .

These are the pre-defined modifiers and the associated key symbols:

(No modifier) =  None

 =  Shift
[Ctrl] =  Ctrl

 =  Mod4

[Alt] =  Alt

Key combinations are formed as follows with  | :

Ctrl +   =  Ctrl|Super_L

Key: Key for the hotkey

Autostart

☑ The session will be launched automatically when the device boots.

Restart

☑ The session will be restarted automatically after the termination.

Autostart delay: Waiting time in seconds between the complete startup of the desktop and the automatic session 
launch.

Do not use [AltGr] as a modifier (represented as Mod5 ). Otherwise, the key that is configured as a hotkey 
with AltGr cannot be used as a regular key anymore. Example: If you configure [AltGr] + [E] as a hotkey, it is 
impossible to enter an "e".



When this keyboard key is used as a modifier, it is represented as Mod4 ; when it is used as a key, it 

is represented as Super_L .



To enter a key that does not have a visible character, e. g. the [Tab] key, open a terminal, log on as user

and enter xev -event keyboard . Press the key to be used for the hotkey. The text in brackets that 

begins with keysym  contains the key symbol for the Key field. Example: Tab  in (keysym 0xff09, 

Tab)


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Appliance mode access: Determines whether the session can be started in appliance mode. By default, appliance 
mode implies that one session is running on the device exclusively. For further information, see Appliance Mode (see 
page 220).

☑ The session can be started in appliance mode. The following starting methods can be used in appliance mode:

Desktop (desktop icon; not in appliance mode XDMCP for this Display)
Desktop Context Menu (not in appliance mode XDMCP for this Display)
Application Launcher (includes Application Launcher's system tab; not in appliance 
mode XDMCP for this Display)
Hotkey
Autostart (not in appliance mode XDMCP for this Display)

☐ The session cannot be started in appliance mode. 
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User Interface
Display (see page 674)
Desktop (see page 680)
Language Settings for IGEL OS 11 (see page 696)
Screenlock / Screensaver (see page 697)
Input (see page 705)
Hotkeys (see page 715)
Font Services (see page 720)
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Display
Menu path: User Interface > Display

Every screen connected to the IGEL UD device can be configured independently. The position of the individual 
screens can be determined in relation to Screen 1.

 Click on  to show the screen identifier on each device.

If you work in an environment with a number of monitors, see the how-to Multimonitor.

If you use the Shared Workplace (SWP) feature with user-specific display resolutions, see the how-to Display 
Configuration for Shared Workplace (SWP).

Screen Configuration
Number of screens: Select how many monitors you would like to use.

Identifies each screen connected and specifies the connection and display resolution 
for each screen.

Arranges the screens in a single row.

Arranges the screens in two rows.

Rotates the selected screen anti-clockwise.

Rotates the selected screen clockwise.

Removes the screen which was last added.

Adds a screen.

The selected screen is highlighted with a blue frame. The black bar at the bottom edge of the screen represents the 
physical orientation of the monitor.

Selected screen: Selects a screen using this selection box to configure the following settings.

Screen resolution: Move the slider to the resolution which the selected screen is to have. The resolution is shown in 
the right-hand box.

For details of the display resolution supported by your IGEL device, please see the relevant datasheet.
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Advanced
Detect refresh rate automatically
☑ A refresh rate for the monitor is identified automatically. (Dafault)
☐ A refresh rate for the monitor is to be set manually.

Refresh rate: Number of individual images per second.
Possible values:

30 ... 100. (Default: 60)

Graphic card: Graphics card assigned to the selected screen. A graphics card can have more outputs than are 
actually used. In order to ensure transparency, you may need to assign the graphics cards manually.

Monitor: Assigns the screen selected under Selected screen to a monitor connection. Example: HDMI(II). (Default: 
Automatic)

Power Options (see page 676)
Access Control (see page 677)
Gamma Correction (see page 678)
Options (see page 679)

•

•

From IGEL Linux Version 10.03.100, you have the option of defining your own resolutions via the registry 
( x.xserver0.custom_resolution ). In order for the values set there to take effect, the resolution 
must be set to "Automatic" (slider at the far left). The following parameters apply to the entry in the 
registry:

WxH  : W = width, H = height (example: 1920x1080)

WxH@R : W = width, H = height, R = refresh rate (example: 1920x1080@60 or 
1920x1200@59.8)



If Automatic is set for the Monitor and no configurable monitor is found for the selected graphics card, the 
next available monitor will be used by another graphics card.


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Power Options
Menu path: Setup > User Interface > Screen > Power Options

In this area, you can handle display power management.

Please note: Your screen must support Display power management signaling (DPMS).

Handle Display Power Management
☑ The DPMS energy saving functions are enabled.

 Specify separately for battery and mains operation the number of minutes before the screen switches to a 
specific energy-saving mode:
Three different modes are offered:

Standby Time (standby mode)
Suspend Time (sleep mode)
Off Time (Off)

If a device is switched on but not used for some time, energy can also be saved by Brightness Reduction.

 Specify by how many percent the brightness of the screen is to be reduced and how long the period of inactivity 
before brightness reduction should be. Values between 10 seconds and two minutes are available to choose from.

Naturally, all stages are gone through only if the X-Server does not receive any new entries during this 
period.


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1.

2.

1.
2.
3.

Access Control
Menu path: Setup > User Interface > Screen > Access Control

In this area, you can control access to the screen. Thin client access control is enabled by default.

Disable console switching

☑ Access to your terminal screen is possible from any UNIX host. You can no longer access the console using [Ctrl] 
+ [Alt] + [F11] or [Ctrl] + [Alt] + [F12].

☐ You can access the console using [Ctrl] + [Alt] + [F11] or [Ctrl] + [Alt] + [F12]. (default)

Access Control

☑ Access to this display from other computers will be controlled. This access control is enabled by default. 
(default)

Disable TCP connections

☐ All TCP connections to the display are prohibited. Only local applications are displayed. The xhost mechanism no 
longer functions.
This parameter is ignored if XDMCP is configured.

Fixed X-Key

☑ You can grant specific users permanent remote access to the thin client:

Click on Calculate.
A 32-digit key will appear in the X-Key field.
Enter this key in the Xauthority file on the user’s computer.

List of trusted X hosts

Here, you can approve specific computers for console access:

Click on the Add button to open the entry mask.
Give the name of the remote host (not the IP address) you would like to add.
Confirm this by clicking OK.
The computer will be entered in the list.
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Gamma Correction
Menu path: Setup > User Interface > Screen > Gamma Correction

In this area, you can increase or decrease the various brightness ranges in order to adjust the display on your screen 
to your preferences.

Selected screen: Select the screen whose brightness you would like to adjust (default: First 
Screen).

You can then change the gamma values for red, green and blue. The scale ranges from 0.10 (dark) to 10 (light) and is 
set to 1.00 by default.

Gamma value Red: Changes the brightness curve for the red color portion.
Gamma value Green: Changes the brightness curve for the green color portion.
Gamma value Blue: Changes the brightness curve for the blue color portion.
Link Sliders
☑ All sliders are moved equally in order to change the brightness harmoniously. (default)
☐ Each slider can be moved individually. This way, you can also change the color ratio.



User Interface

IGEL OS Reference Manual   679 / 897

•

•
•

•
•

Options
Menu path: Setup > User Interface > Screen > Options

Configure the options for the display here:

Monitor probing (DDC)
☑ You can share information between the system and the screen via the Display Data Channel. 
DDC is enabled by default and the native resolution supported by the screen is determined 
automatically. (default)
☐ Screen properties are not automatically detected.
Monitor DPI: Enter the DPI resolution (dots per inch) for your monitor (default: 96).
Color depth: Selects the desktop color depth
The following options are available:

True Color (24)
True Color (32)

Make sure that all screens connected to the thin client support the color setting.
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Desktop
Menu path: Setup > User Interface > Desktop

On this page, you can configure general settings for the appearance of the desktop:

Local window manager for this display: Here, you can disable the window manager if you only 
work in full-screen sessions and do not require this service.
User interface theme: The colors of windows such as the Application Launcher, the start menu, 
the local terminal, the taskbar and messages can be varied. You can either select one of our 
predefined color schemes or define a color scheme of your own.

IGEL Dark: The frame color is dark gray, IGEL logos are yellow.
IGEL Light: The frame color is light gray, IGEL logos are dark gray.
Custom Colors: Define your own color combinations below.

Desktop icon size: Specify the size in which you would like the icons to be displayed on the 
desktop (default 64).
Monitor for desktop icons: If you use several monitors, select the one which is to display desktop 
icons.

All monitors
As taskbar
1st monitor
2nd monitor
(other monitors if connected)

Single click mode:
☑ Open programs with a single click. This option was set up specially for users of touchscreen 
monitors.

Desktop fonts
Default font: Choose between serif and sans-serif text and between standard and bold. The 
following are available to choose from:

Sans
Sans bold
Serif
Serif Bold

Default font size: Specify your desired font size in pt (points) here (default: 10).
Desktop icon font size: Specify your desired font size for desktop icons in pt (points) here (default: 
11).
Titlebarfont: Choose between serif and sans-serif text and between standard and bold. The 
following are available to choose from:

Sans
Sans bold
Serif
Serif Bold

Titlebar font size: Specify your desired font size in pt (points) here (default: 11).
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_____

Background (see page 682)
Taskbar (see page 685)
Taskbar Background (see page 687)
Taskbar Items (see page 688)
Pager - Virtual Workspaces for Organizing the IGEL OS Desktop (see page 689)
Start Menu (see page 694)
In-Session Control Bar (see page 695)
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Background
Menu path: Setup > User Interface > Desktop > Background

In this area, you can configure the desktop background with pre-defined IGEL backgrounds, a fill color or a color 
gradient.

You can also use a background image of your own.

Wallpaper: Provides a selection of pre-defined IGEL backgrounds:
neutral
disabled
black (4x3)
blue (4x3)
gray (4x3)
orange (4x3)
green
black (16x9)
blue (16x9)
gray (16x9)
orange (16x9)

Wallpaper Style: Provides various design versions:
Automatic
Centered
Tiled
Spread
Scaled
Zoomed

Color Style: Sets a fill color or a color gradient.
Solid color
Horizontal gradient
Vertical gradient

Desktop Color: Select a background color if you have not selected an image.
2nd Desktop Color: Select a second background color if you have not selected an image.
Custom Wallpaper Download:
☑ You can provide a user-specific background image on a download server.
Custom Wallpaper File: Give a name for the background image file.
Specify the download server under Desktop > Background > Custom Wallpaper Server.

You can set up a separate background image for each monitor that is connected to the thin client.

If you have already defined a server for the system update files, you can use the same 
server setting for downloading the background image.


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The user-specific background image will be downloaded from the specified server if the function was enabled and if 
requested manually (Update Background Image). The download can also be launched from the IGEL Universal 
Management Suite via Update desktop changes.

A user-specific boot image can be provided on a download server. The file types BMP, JPG, GIF, TIF, PNG 
and SVG are supported for an own background image and bootsplash. A total storage area of 25 MB is 
available for all user-specific images.


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Custom Wallpaper Server
Menu path: Setup > User Interface > Desktop > Background > Custom Wallpaper Server

In this area, you can configure the download server for your own background images.

Use firmware update server location
☑ The same server and path configuration is used as for the firmware update.
☐ An own server location is used. (default)
Protocol: Determines the protocol that is to be used. The following are available to choose from:

HTTP
HTTPS
FTP
SecureFTP
FTPS
File

Server Name: Name or IP address of the server used.
Server Path: Directory in which you saved the background image.
Port: Port used (default: 80)
User name: Name of the user account on the server
Password: Password for this account
Wallpaper update: Refreshes the background image.
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•
•

Taskbar
Menu path: Setup > User Interface > Desktop > Taskbar

In this area, you can enable and configure the taskbar.

You can change the following settings:

Use Taskbar:
☑ The taskbar is displayed and the following taskbar settings options are available.
Taskbar Position: Specifies the position in which the taskbar is displayed.
Possible values:

Bottom
Top
Left
Right

Vertical Taskbar Mode: Specifies how items are shown in the taskbar. This parameter is available 
if Taskbar Position is set to Left or Right.
Possible values:

Vertical: The session texts are rotated by 90°.
Deskbar: The session texts are not shown.

Taskbar Height/Width: Specifies the height of the taskbar in pixels (default 40).

Number of rows/columns in taskbar: Specifies the number of rows for the Quick Start Panel. The 
following taskbar items can be broken down into a number of rows and columns: Icons in the 
Quick Start Panel, window buttons. Possible values:

Automatic: The number of rows for the Quick Start Panel depends on the height and width 
of the taskbar.
Numeric value: The chosen value specifies the number of rows for the Quick Start Panel.

Multi Monitor Taskbar Size: Specifies whether the taskbar is expanded across a number of 
monitors or restricted to one monitor. Possible values:

Restrict taskbar to one monitor
Extend taskbar to all monitors

•
•
•
•
•
•

If Maximum number of rows/columns in window button list is set to Automatic, the 
window buttons as well as the icons in the Quick Start Panel will be shown in a number of 
rows depending on the height of the taskbar. The number of rows increases in increments 
of 55 pixels:

1 - 55 pixels: One row
56 - 110 pixels: Two rows
111 - 165 pixels: Three rows
166 - 220 pixels: Four rows
221 - 275 pixels: Five rows
276 or more pixels: Six rows
The Maximum number of rows/columns in window button list parameter is 
described under Taskbar Items.


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•

Monitor: Specifies the screen on which the taskbar is shown. This parameter is available if 
Taskbar size in Multi Monitor is set to Restrict taskbar to one monitor (default: 1st monitor).
Taskbar on top of all windows:
☑ The taskbar is accessible on all screens, even in sessions with a full-screen window.
Taskbar Auto Hide:
☑ The taskbar is hidden and will only be shown if the mouse pointer is moved to the position of 
the taskbar at the edge of the screen.
Auto Hide Behavior: Specifies when the taskbar is automatically hidden.
Possible values:

Intelligent: The taskbar is shown as standard. The taskbar will be hidden if the space is 
needed by a window, e. g. a window in full-screen mode.
Continuous: The taskbar is hidden as standard. The taskbar will be shown if the mouse 
pointer is moved to the edge of the screen.

Taskbar Show Delay: Time interval in milliseconds before the taskbar is shown. The mouse 
pointer must be at the edge of the screen constantly during this time interval. This setting is only 
effective if Taskbar Auto Hide is enabled (default: 600).

Taskbar Hide Delay: Time interval in milliseconds before the taskbar is hidden. This setting is only 
effective if Automatically hide taskbar is enabled (default: 400).
Further settings options can be found under Screensaver and Screenlock.

With the show delay, you can prevent the taskbar for a full-screen session being covered 
by the thin client's taskbar. A show delay is necessary if the taskbar for the full-screen 
session is set to be shown automatically and both taskbars are positioned at the same 
screen edge. If no show delay is set and the user brings up the taskbar for the full-screen 
session, this will immediately be covered by the thin client's taskbar. During the show 
delay time interval, the user has time to move the mouse pointer away from the edge of 
the screen.


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Taskbar Background
Menu path: Setup > User Interface > Desktop > Taskbar Background

You can specify the background style for the taskbar here.

Background Style:
Possible values:

System preset
Solid color
Color gradient
Background image

Depending of the above selection you can define following features:

Taskbar Color: Choose the color for the taskbar.
2nd Taskbar Color: Choose the 2nd color for the taskbar if you want to create gradient colors.
Reverse Gradient
☑ The color gradient is reverse.
☐ The color gradient is normal. (default)
Background Image Path: Path of your background image
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Taskbar Items
Menu path: Setup > User Interface > Desktop > Taskbar Items

Taskbar clock:
☑ A clock is shown in the taskbar.
Sorting order in window button bar: Specifies the criteria according to which the window 
buttons are sorted.
Possible values:

Time stamp: The window buttons are sorted in the chronological order in which the 
windows were opened.
Group and time stamp: The window buttons are grouped according to the type of 
application. If for example a number of setup applications are open, all associated window 
buttons will be arranged next to each other. Within the group, the window buttons are 
sorted chronologically.
Window title: The window buttons are sorted alphabetically.
Group and window title: The window buttons are grouped according to type. If for example 
a number of setup applications are open, all associated window buttons will be arranged 
next to each other. Within the group, the window buttons are sorted alphabetically.
Drag and drop: You can order the buttons as you wish using drag and drop. You must drag a 
button over at least half of the button to be skipped.

Maximum number of rows/columns in window button bar: Specifies the maximum number of 
rows available for window buttons.
Possible values:

Automatic: The number of rows depends on the Taskbar height/width and Number of 
rows/columns in taskbar parameters, see Taskbar.
Numeric values: This value specifies the maximum number of rows.

Show labels in window button bar:
☑ The names of the ongoing sessions are displayed in the associated window buttons. (default)
☐ Only the icons are displayed.
Taskbar system tray:
☑ The system tray is shown in the taskbar. (default)
Size of icons in system tray: Specifies the size of system tray icons (volume, network connection 
etc.).
You can choose a pre-defined value or enter a numeric value between 1 and 64. 
Predefined values:

Automatic: The size is adjusted to the height and width of the taskbar.
Small: 20 pixels
Medium: 40 pixels
Large: 60 pixels

Further settings options can be found under On-screen Keyboard, Keyboard and Additional 
Keyboard Layouts and Screensaver and Screenlock.



User Interface

IGEL OS Reference Manual   689 / 897

Pager - Virtual Workspaces for Organizing the IGEL OS Desktop
In IGEL OS, you can use the Pager tool to enable the use of multiple virtual desktops. The Pager allows you to divide 
one desktop into several virtual workspaces and, thus, to better organize your desktop: for example, you can open a 
certain type of applications in one workspace and another type of applications in the second workspace. 

The Pager makes switching between multiple open applications easier – you can switch between full-screen 
applications at the click of a mouse. Instead of minimizing / maximizing sessions or switching between them using 
key combinations, you simply click on the desired workspace using the mouse. When you switch back, the virtual 
desktop is displayed exactly as before (unless you restarted the system or changed the language in the IGEL Setup). 

Menu path: User Interface > Desktop > Pager

Use Pager
☑ The Pager is enabled. You can configure up to 25 virtual desktops. The Pager will be displayed on the right of the 
taskbar:

Make sure you have enabled User Interface > Desktop > Taskbar (see page 685) > Taskbar on top of all 
windows.



The Pager can be used only in non-appliance mode.
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1.

For details on how to use the pager, see the below section "Example for how to Use the Pager (see page 690)".

☐ The Pager is disabled.*

Number of Screens - Horizontal
Specifies how many workspaces will be shown next to each other. (Default: 2)

Number of Screens - Vertical
Specifies how many workspaces will be shown above each other. (Default: 1)

Names of the workspaces
Specify names for the individual desktops.

Paging Resistance
Specifies how many pixels the cursor needs to be moved over the edge of the screen before it triggers a switch of 
the desktop. (Default: 10)

You only need to make this setting if you enable at least one of the following options – Wrap workspaces while 
dragging a window or Wrap workspaces with pointer.

Wrap workspaces while dragging a window
☑ The desktop is switched as soon as a window is dragged out of view.

☐ The desktop is not switched when a window is dragged out of view.*

Wrap workspaces with pointer
☑ The desktop is switched as soon as the mouse reaches the edge of the screen.

☐ The desktop is not switched when the mouse reaches the edge of the screen.*

Example for how to Use the Pager

Start your endpoint device and launch the desired sessions / applications, e.g. Firefox and 
Chromium browsers. 
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2. In the Pager panel in the taskbar, navigate to another workspace, e.g. Workspace 2, and click it.

You will see the "empty" desktop, i.e. without opened sessions / applications.
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3. Start the required sessions / applications, e.g. an RDP session. 
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4. When you need to switch back to the Firefox and Chromium browsers, simply select the 
corresponding workspace (in this example, Workspace 1) in the Pager panel in the taskbar.
Your desktop will be displayed exactly as before the switch to Workspace 2. Thus, you switch 
between your browser sessions and an RDP session without minimizing the latter.

*IGEL OS system default

Tip
You can use drag & drop to rearrange the sessions / applications between the workspaces: in the 
respective virtual desktop, click on the required application / session symbol on the left of the taskbar and 
drag it to the desired workspace.


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Start Menu
Menu path: Setup > User Interface > Desktop > Start Menu

In this area, you can configure the desktop start menu:

Start menu types
Classic - Default setting which is similar to that from Windows 95 - a list of available sessions 
and options
Advanced - An expanded start menu featuring a search function and a more attractive 
design. It requires more resources, which is particularly noticeable on slow devices.
Automatic - Automatically selects the classic or advanced start menu depending on the 
processor.

Select which options are to be shown in the start menu:

Lock screen
Log off
System restart
Shut down
System tab
Information

Show active user name in About, Application Launcher and Start Menu
☑ The current user will be shown at the top edge of the relevant window.
☐ The current user will not be shown.

•
•

In order for user names to be recognized and passed on, you must configure two settings 
beforehand:

Enable Active Directory/Kerberos: Security > Active Directory/Kerberos
Enable local logon: Security > Logon > Active Directory/Kerberos


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In-Session Control Bar
Menu path: Setup > User Interface > Desktop > In-Session Control Bar

In a full-screen session, the in-session control bar allows you

to eject a USB drive,
to start the wireless manager (only available in Appliance Mode),
to start the Mobile Device Access USB tool (only available if the Mobile Device Access USB feature 
is enabled),
to minimize the session view (not available in Appliance Mode),
to end the session.

Use in-session control bar in all supported sessions

☑ The in-session control bar is shown. Depending on the configuration, the in-session control bar will be 
permanently visible or will be shown as soon as you move the cursor to the top edge of the screen.

☐ In-session control bar is not used. (default)

The in-session control bar is available for the following session types:

RDP - see RDP Global (see page 122)
Citrix - see Citrix StoreFront (see page 102)
ThinLinc - see ThinLinc (see page 345)
NX - see NX (see page 268)
Parallel 2X Client - see Parallel 2X Client (see page 297)

To use the in-session control bar, proceed as follows:

 To eject a USB device, click .

 To start the wireless manager, click  (only available in Appliance Mode).

 To start the Mobile Device Access USB tool, click   (only available if the Mobile Device Access USB feature is 
enabled).

 To minimize the session view, click .

 To end the session, click .

 To make the in-session control bar permanently visible, click .
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Language Settings for IGEL OS 11
In this area, you can configure the country-specific language settings.

Menu path: Setup > User Interface > Language

Language
The language of the user interface.

Keyboard layout
When the language is changed for the first time, the keyboard layout is automatically set to the same language.

Show indicator in taskbar
☑ Shows a country abbreviation for the keyboard layout in the taskbar.

☐ No indicator is shown. (System default)

Input language
The keyboard layout is used by default.

Standards and formats
Specifies how country-specific formats for the time and currency are displayed, for example. The default setting is 
geared to the input language selected.
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Screenlock / Screensaver
Menu path: User Interface > Desktop > Screen Lock/Saver

You can set up the screen saver so that it is activated automatically after a time limit expires, via a button or in 
response to a key combination (hotkey). You can also select a password option. The look of the taskbar can be 
configured separately for the logon dialog and the locked screen.

The screen can be locked via icons in the Quick Start Panel and on the desktop or via the hotkey [Ctrl-Shift-L].

Session name: Name for the session.

Starting Methods for Session
Start menu

☑ The session can be launched from the start menu.

Application Launcher

☑ The session can be launched with the Application Launcher.

Desktop

☑ The session can be launched with a program launcher on the desktop.

Quick start panel

☑ The session can be launched with the quick start panel.

Start menu's system tab

☑ The session can be launched with the start menu's system tab.

Application Launcher's system tab

☑ The session can be launched with the Application Launcher's system tab.

Desktop context menu

☑ The session can be launched with the desktop context menu.

Menu folder: If you specify a folder name or a path comprising a number of folder names separated by "/", a menu 
path will be created for the session. The menu path will be used in the start menu and in the desktop context menu.

Application Launcher folder: If you specify a folder name or a path comprising a number of folder names 
separated by "/", a menu path will be created for the session. The menu path will be used in the Application 
Launcher.

Desktop folder: If you specify a folder name or a path comprising a number of folder names separated by "/", a 
menu path will be created for the session. The menu path will be used for the program launcher on the desktop.

Password protection: Specifies which password will be requested when launching the session.
Possible values:

The session name must not contain any of these characters: \ / : * ? “ < > | [ ] { } ( )
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•

•

None: No password is requested when launching the session.
Administrator: The administrator password is requested when launching the session.
User: The user password is requested when launching the session.
Setup user: The setup user's password is requested when launching the session.

Hotkey

☑ The session can be started with a hotkey. A hotkey consists of one or more modifiers and a key.

Modifiers: A modifier or a combination of several modifiers for the hotkey. You can select a set key symbol/
combination or your own key symbol/combination. A key symbol is a defined chain of characters, e.g.  Ctrl .

These are the pre-defined modifiers and the associated key symbols:

(No modifier) =  None

 =  Shift
[Ctrl] =  Ctrl

 =  Mod4

[Alt] =  Alt

Key combinations are formed as follows with  | :

Ctrl +   =  Ctrl|Super_L

Key: Key for the hotkey

Autostart

☑ The session will be launched automatically when the device boots.

Autostart delay: Waiting time in seconds between the complete startup of the desktop and the automatic session 
launch.

Do not use [AltGr] as a modifier (represented as Mod5 ). Otherwise, the key that is configured as a hotkey 
with AltGr cannot be used as a regular key anymore. Example: If you configure [AltGr] + [E] as a hotkey, it is 
impossible to enter an "e".



When this keyboard key is used as a modifier, it is represented as Mod4 ; when it is used as a key, it 

is represented as Super_L .



To enter a key that does not have a visible character, e. g. the [Tab] key, open a terminal, log on as user

and enter xev -event keyboard . Press the key to be used for the hotkey. The text in brackets that 

begins with keysym  contains the key symbol for the Key field. Example: Tab  in (keysym 0xff09, 

Tab)


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Appliance mode access: Determines whether the session can be started in appliance mode. By default, appliance 
mode implies that one session is running on the device exclusively. For further information, see Appliance Mode (see 
page 220).

☑ The session can be started in appliance mode. The following starting methods can be used in appliance mode:

Desktop (desktop icon; not in appliance mode XDMCP for this Display)
Desktop Context Menu (not in appliance mode XDMCP for this Display)
Application Launcher (includes Application Launcher's system tab; not in appliance 
mode XDMCP for this Display)
Hotkey
Autostart (not in appliance mode XDMCP for this Display)

☐ The session cannot be started in appliance mode. 

Options (see page 700)
Taskbar (see page 702)
Screensaver (see page 703)
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Options
Menu path: Setup > User Interface > Screenlock / Screensaver > Options

Start automatically

☑ The screenlock or screensaver starts automatically if there is no activity on the endpoint device within this time 
limit. The screenlock can be overridden by the user or administrator with the relevant password (see: Password - 
Restrict Access to IGEL OS Components (see page 824)). (Default)

Timeout: Period of time in minutes before the screenlock or the screensaver starts. (Default: 5)

Screenlock Password

None: No password is set. A screenlock cannot be set up.
User password: A user password is deployed to unlock the screen. If Active Directory (AD) login is 
enabled, an AD user password is deployed instead of the user password.
Screenlock password: A separate password specified under Set is deployed to unlock the screen. 
If Active Directory (AD) login is enabled, the AD user password is deployed instead of the 
screenlock password.

Different screenlock timeout

☑ You can specify a time limit of your own for the screenlock. (Default)

☐ The same time limit will be used for the screenlock as for the screensaver. This means that after the set time the 
screen will be locked and then the screensaver will appear.

Screenlock timeout: Period of time in minutes before the screenlock starts. (Default: 5)

Allow administrator password

☑ Access is allowed for the user and the administrator. (Default)

☐ Access is allowed for the user only.

Countdown duration in seconds: Countdown time with which the screenlock is initiated. If the value is 0, the 
screen is locked without a countdown. (Default: 0)

Countdown visual effect: While the countdown is running, a current screenshot is displayed in the background. 
This parameter determines the visual effect that the screenshot will be displayed with.
Possible options:

•
•
•
•
•
•

The appearance of the digits for the countdown is specified together with the settings for the clock display 
under Setup > User Interface > Screenlock / Screensaver > Screensaver; see Screensaver (see page 703). 
The following parameters are relevant for the countdown:

Clock display monitor
Show seconds
Horizontal clock position
Vertical clock position
Clock background color
Clock foreground color


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•
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Dark screenshot
Gray screenshot

Countdown background image: Path and file name of an image file, which is displayed in the background while 
the countdown is running. This background image is displayed instead of the screenshot, if the path and file name 
are valid; if the field is empty, the screenshot is displayed. Supported file formats: JPEG, PNG, GIF. Example: /

images/image.jpg
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Taskbar
Menu path: Setup > User Interface > Desktop > Screenlock / Screensaver > Taskbar

Taskbar Settings for the Login Dialog
☑ Show taskbar in login screen. (Default)

☑ Show clock. (Default)

☑ Show keyboard layout switcher. (Default)

☑ Show on-screen keyboard button.

☑ Start on-screen keyboard automatically.

☑ Show reboot button.

☑ Show shutdown button. (Default)

Taskbar Settings when the Screenlock Is Active
☑ Show taskbar in screenlock. (Default)

☑ Show clock. (Default)

☑ Show keyboard layout switcher. (Default)

☑ Show on-screen keyboard button.

☑ Start on-screen keyboard automatically.

☑ Show reboot button.

☑ Show shutdown button.

☑ Show logoff button.

There is no separate option for enabling/disabling network connection icons in the login dialog and/or on 
the locked screen. With Show taskbar in login screen and Show taskbar in screenlock enabled, they 
appear automatically if the option Enable tray icon is activated under Setup > Network > LAN Interfaces 
> Interface 1 (or Interface 2, Wireless) and/or under Setup > Network > Mobile Broadband (and/or 
VPN).



The network connection icons in the login dialog and on the locked screen serve for information purposes 
only and thus are inactive on clicking.


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Screensaver
Menu path: Setup > User Interface > Desktop > Screen Lock/Saver > Screensaver

Screen background color: Color palette for determining the background color of the screen.
Enable image display
☑ An image will be shown as the screensaver. (default)
File for screen saver logo: Complete path for an individual image file or directory that contains an 
unlimited number of images. If no path is given, the IGEL logo will be used.

One image per monitor
☑ If a number of monitors are used, a different image will be shown on each one. (default)
☐ Images will be distributed over the monitors.
Image duration: Time in seconds until the image is changed. (default: 10)
Image display mode: Type of display. The following are available to choose from:

Small-sized hopping - Small images are shown in changing positions.
Medium-sized hopping - Larger images are shown in changing positions.
Full-screen center cut-out - The images are shown in full-screen size. However, they may be 
clipped.
Full-screen letterbox - The images are shown as large as possible in relation to the screen 
size.

Clock display monitor: Selects the monitor on which the clock is to be shown. The following are 
available to choose from:

None
All
A specific monitor

Show seconds: Shows the seconds too in digital format.
Clock display size: The following sizes are available to choose from:

Tiny
Small
Medium
Large
Huge

Horizontal clock position
Left
Center
Right

Vertical clock position
Top
Center
Bottom

Clock background color: Color palette for determining the background color of the clock.
Clock background opacity percentage: 75% is preset.

If you enter a folder instead of a single image file as the source, all images in the folder will 
be displayed as a slide show, the display time for the images can be configured.


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• Clock foreground color: Color palette for determining the foreground color of the clock.
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•

Input
Menu path: Setup > User Interface > Input

These setup pages allow you to set the keyboard layout and other input options.

The following input devices can be set up:

Keyboard (see page 706)
Additional Keyboard Layouts (see page 707)
Mouse (see page 708)
Touchpad (see page 709)
Touchscreen (see page 712)
Signature Pad (see page 714)
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Keyboard
Menu path: Setup > User Interface > Input > Keyboard

In this area, you can configure the keyboard.

Keyboard layout: Specify the keyboard layout. The selected layout applies to all parts of the system including 
emulations, window sessions and X applications.

Enable dead keys

☑ Dead keys can be used to enter special characters.

Keyboard type: Specifies the keyboard type.
Possible values:

Default: Automatically selects the keyboard type according to the computer type (Macbook, 
Chromebook or PC105 for all others).
Standard PC keyboard (105 keys)
IBM keyboard (122 keys)
Trimodal keyboard
Sun Type 6 keyboard
Chromebook
Macbook
Macbook international

Show indicator in taskbar

☑ Shows the language code for the keyboard in the taskbar.

Character Repeat
Repeat delay: Determines the delay (in milliseconds) before automatic repetition begins.

Key repeat rate: Determines the number of times a character repeats per second.

Start with NumLock on:

☑ NumLock will be enabled automatically during the boot process.
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Additional Keyboard Layouts
Menu path: Setup > User Interface > Input > Additional Keyboard Layouts

In this area, you can define additional keyboard layouts which can be selected by the user.

Enable this layout
☑ Keyboard layout is enabled and can be defined.
Keyboard layout: Selects the language for the keyboard layout.
Enable dead keys: Enable this function if the keyboard used supports dead keys for special 
characters.
Hotkey
☑ A hotkey allowing you to switch to this keyboard can be defined.
Key: Select a key for the key combination.
Modifier: If necessary, select an additional modifier.

Hotkey for default keyboard layout

Enable hotkey to switch to the default keyboard layout
☑ A hotkey which takes you back to the default keyboard layout can be defined. This is useful 
when a number of keyboard layouts are configured.

Hotkey for next keyboard layout

Enable hotkey to switch between a number of keyboard layouts
☑ A hotkey which switches to the next keyboard layout can be defined. This is useful when a 
number of keyboard layouts are configured.
Further settings can be configured under On-screen Keyboard.
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Mouse
Menu path: Setup > User Interface > Input > Mouse

In this area, you can configure the mouse.

Lefthand mode
☑ The mouse is switched to left-handed mode.
Emulation 3 Button Mouse: Enables/disables emulation of the third (middle) mouse button for 
mice with only two physical buttons. This third button is emulated by pressing both buttons at the 
same time. If 3-button emulation was enabled, the emulation time limit determines how long (in 
milliseconds) the driver waits before deciding whether two buttons were pressed at the same 
time.
Hide Cursor: The mouse pointer will be hidden after the defined time limit.
Pointer Speed: Determines the mouse resolution in counts per inch.
Double Click Interval: Changes the maximum interval in milliseconds between two consecutive 
mouse clicks which are to be recognized as a double-click.
Double Click Distance: Changes the maximum distance in pixels between two clicks which are to 
be recognized as a double-click. The object under the second click is double-clicked.
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Touchpad
Menu path: Setup > User Interface > Input > Touchpad

Here, you can configure touchpad settings.

Custom configuration
☑ Using the following options, adapt the touchpad to your needs.
☐ No custom configuration. (default)
Operating mode: Allows various touchpad modes. Possible values:

Enable touchpad
Switch off touchpad
Turn off tapping and scrolling only

Min speed: Minimum speed of the pointer in seconds (default: 1.00)
Max speed: Maximum speed of the pointer in seconds (default: 1.75)
Acceleration: Acceleration from the minimum to the maximum speed in seconds (default: 0.01)

With a number of touchpads, you can assign functions to the four corners. Specify which mouse button is clicked by 
tapping in the relevant corner:

No action
Left mouse button
Middle mouse button
Right mouse button

The following settings apply by default:

Action top left: No action
Action bottom left: No action
Action top right: Middle mouse button
Action bottom right: Right mouse button

The actual settings options depend on the hardware supported by the particular touchpad.
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Touchpad Scrolling
Define the properties for vertical and horizontal scrolling here.

Vertical

Vertical scrolling
☑ The right edge of the touchpad will be used as a vertical scrollbar. The vertical scroll speed can 
be set.
☐ The right edge is not enabled as a scrollbar. (default)
Vertical scroll speed: Specifies from what distance scrolling is recognized when moving in a 
vertical direction. (default: 25.00)
Scroll vertically with two fingers:
☑ Two-finger scrolling is enabled for vertical scrolling.
☐ Two-finger scrolling is disabled.

Horizontal

Horizontal scrolling:
☑ The bottom edge of the touchpad will be used as a horizontal scrollbar. The horizontal scroll 
speed can be set.
☐ The bottom edge is not enabled as a scrollbar. (default)
Horizontal scroll speed: Specifies from what distance scrolling is recognized when moving in a 
horizontal direction. (default: 25.00)
Scroll horizontally with two fingers:
☑ Two-finger scrolling is enabled for horizontal scrolling.
☐ Two-finger scrolling is disabled.
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Touchpad Advanced
Further settings are possible here:

Corner coasting
☑ You can continue scrolling if your finger reaches the corner when scrolling vertically or 
horizontally along the touchpad edges.
Circular scrolling
☑ You can scroll in a circle. In the selection menu, specify where circular scrolling is to begin.

Circular scrolling enabled at 
All Edges 
Top Edge 
Top Right Corner 
Right Edge 
Bottom Right Corner 
Bottom Edge 
Bottom Left Corner 
Left Edge 
Top Left Corner

Tap and drag gesture
☑ You can move items by tapping and dragging them.
Locked drags
☑ The tap and drag gesture ends only after an additional tap; it will otherwise end when you let 
go.
Palm detect
☑ Avoids triggering a function accidentally with the palm of your hand. The function must be 
supported by the device.
ClickPad
☑ ClickPads are permitted. These are touchpads with so-called integrated soft buttons on which 
physical clicks are possible.
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Touchscreen
Menu path: Setup > User Interface > Input > Touchscreen

Here, you can configure a touchscreen. To ensure that you can open the setup and navigate within it, the initial 
configuration should take place with a mouse and keyboard connected.

You will find an up-to-date list of the touchscreens supported by IGEL in the IGEL Third Party Hardware Database20.

Enable touchscreen

☑ The touchscreen is enabled.

☐ The touchscreen is disabled. (Default)

Touchscreen type: Selects the touchscreen driver which is to be used.
Possible options:

"EvTouch (USB)"
"eGalax"
"Elo Multitouch (USB)"
"Elo Singletouch (USB)"
"TSharc"

You will find the complete list of supported devices in the IGEL Hardware Database21.

Touchscreen already calibrated
If you enable the touchscreen function, the touchscreen must be calibrated first.

☑ Calibration starts automatically after each system boot. (Default)

☐ Calibration does not start automatically after each system boot.

Swap X and Y values

☑ X values are interpreted as Y values and Y values as X values. Enable this option if the mouse pointer moves 
vertically when you move your finger in a horizontal direction.

☐ X and Y values are not swapped. (Default)

Minimal X/Y value: These values are determined by the calibration tool. However, you can also change them 
manually. (Default: 0)

Maximal X/Y value: These values are determined by the calibration tool. However, you can also change them 
manually. (Default: 4000)

Untouch delay: The maximum permitted time (in milliseconds) between two instances of contact which are still 
registered as a single touch. When moving windows by drag & drop, for example, your contact with the screen may 
inadvertently be interrupted. Increasing this value prevents the thin client from recognizing two individual contacts 
if you let go in this way. (Default: 3)

Report delay: Determines how long (in milliseconds) the screen needs to be touched in order for the contact to be 
recognized. (Default: 2)

Emulate right button

https://www.igel.com/linux-3rd-party-hardware-database/
https://www.igel.com/linux-3rd-party-hardware-database/
https://www.igel.com/linux-3rd-party-hardware-database/
https://www.igel.com/linux-3rd-party-hardware-database/
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☑ A right-click is generated by touching the screen for a long time.

☐ Touching the screen for a long time does not generate a right-click. (Default)

Right button timeout: Time (in milliseconds) after which a right-click is generated. (Default: 1000)

Set driver-specific defaults: Loads the preset for the driver currently selected under Touchscreen type. Click on 
this button once after changing the touchscreen type or to restore the default settings.

Multimonitor
Graphic card: Graphics card assigned to the selected touchscreen. A graphics card can have more outputs than are 
actually used. In order to ensure transparency, you may need to assign the graphics cards manually.

Touchscreen monitor: Assigns a monitor connection to the touchscreen. Example: HDMI(II) (Default: Automatic)

To set up a touchscreen and on-screen keyboard, proceed as follows:

 Enable the on-screen keyboard for the touchscreen use under IGEL Setup > Accessories > On-Screen 
Keyboard; see On-Screen Keyboard (see page 607).

 Calibrate the touchscreen for optimum contact recognition. The touchscreen calibration application can be 
found under Application Launcher > System.
In the calibration program, you will see a pattern with calibration points which must be touched one after another.

If “Automatic” is set for the Touchscreen monitor and no configurable monitor is found for the selected 
graphics card, the next available monitor will be used by another graphics card.



The layout for the normal keyboard will also be used for the on-screen keyboard.
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Signature Pad
Menu path: Setup > User Interface > Input > Signature Pad

You can connect signature pads from the following manufacturers here:

StepOver;
signotec.

StepOver

Enable StepOver TCP Client
☑ The StepOver TCP Client is enabled and you can use USB signature pads from this 
manufacturer in sessions.
☐ The StepOver TCP Client is not enabled. (Default)
Listening TCP port: If necessary, you can change the TCP port. (Default: 8888)

signotec

Enable signotec VCOM daemon
☑ The signotec VCOM daemon is enabled and you can use USB signature pads from this 
manufacturer in sessions.
☐ The signotec VCOM daemon is not enabled. (Default)

See also the tip & trick Connecting Signature Pads.
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Hotkeys
Menu path: Setup > User Interface > Hotkeys > Commands

In order to make it easier to use your thin client, hotkeys are available for frequent operating routines. A hotkey is a 
combination of one or more modifiers and an alphanumeric key.

You can enable or disable hotkeys and change the keys used. For more information, see Commands (see page 716).

_____

Commands (see page 716)
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Commands
Menu path: Setup > User Interface > Hotkeys > Commands

You can activate, deactivate and change the hotkeys that are available to the user.

Settings in the Dialog
Hotkey

☑ The session can be started with a hotkey. A hotkey consists of one or more modifiers and a key.

Modifiers: A modifier or a combination of several modifiers for the hotkey. You can select a set key symbol/
combination or your own key symbol/combination. A key symbol is a defined chain of characters, e.g.  Ctrl .

These are the pre-defined modifiers and the associated key symbols:

(No modifier) =  None

 =  Shift
[Ctrl] =  Ctrl

 =  Mod4

[Alt] =  Alt

Key combinations are formed as follows with  | :

Ctrl +   =  Ctrl|Super_L

Key: Key for the hotkey

Do not use [AltGr] as a modifier (represented as Mod5 ). Otherwise, the key that is configured as a hotkey 
with AltGr cannot be used as a regular key anymore. Example: If you configure [AltGr] + [E] as a hotkey, it is 
impossible to enter an "e".



When this keyboard key is used as a modifier, it is represented as Mod4 ; when it is used as a key, it 

is represented as Super_L .



To enter a key that does not have a visible character, e. g. the [Tab] key, open a terminal, log on as user

and enter xev -event keyboard . Press the key to be used for the hotkey. The text in brackets that 

begins with keysym  contains the key symbol for the Key field. Example: Tab  in (keysym 0xff09, 

Tab)


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Available Hotkeys and their Default Settings
Hide all windows and show desktop
Default: 

activated
Modifiers:  Ctrl|Mod4

Key:  d
Appliance Mode Access: deactivated

Mapping Ctrl+Alt+End to Ctrl+Alt+Del for Citrix sessions
Default: 

deactivated
Modifiers:  Ctrl|Alt + End

Key:  End

Appliance Mode Access: deactivated

Open start menu
Default:

deactivated
Modifiers:  Shift + Super

Key:  Super_L

Appliance Mode Access: deactivated

Open start menu (alternative): 
Default:

deactivated
Modifiers:  Shift + Super

Key:  Super_L

Appliance Mode Access: deactivated

Screenshot of active window
Default:

deactivated
Modifiers:  Ctrl|Alt

Key:  Print

Appliance Mode Access: deactivated

Screenshot of entire screen
Default:

deactivated
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Modifiers:  Ctrl|Shift

Key:  Print

Switch between active windows using Task Switcher
Default:

activated
Modifiers:  Ctrl|Alt
Key: Tab
Appliance Mode Access: deactivated

Switch between active windows using Task Switcher (backwards)
Default:

activated
Modifiers:  Ctrl|Alt|Shift
Key: Tab
Appliance Mode Access: deactivated

Switch focus to next window
Default:

activated
Modifiers:  Ctrl

Key:  Escape

Appliance Mode Access: deactivated

Switch focus to next window (alternative)
Default:

activated
Modifiers:  Ctrl|Alt

Key:  Up

Appliance Mode Access: deactivated

Switch focus to next window (reverse order)
Default:

activated
Modifiers:  Ctrl|Alt

Key:  Down

Appliance Mode Access: deactivated

Volume down (multimedia key)
Default:

activated
Modifiers: (none)
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Key:  XF86AudioLowerVolume

Volume mute (multimedia key)
Default:

activated
Modifiers: (none)
Key:   XF86AudioMute

Appliance Mode Access: deactivated

Volume up (multimedia key)
Default:

activated
Modifiers: (none)
Key:  XF86AudioRaiseVolume

Appliance Mode Access: deactivated



User Interface

IGEL OS Reference Manual   720 / 897

•
•

Font Services
Menu path: Setup > User Interface > Font Services

You can import further fonts in addition to the ones provided by IGEL:

XC Font Service (see page 721)
NFS Font Service (see page 722)
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XC Font Service
Menüpfad: Setup > User Interface > Font Services > XC Font Service

In this area, you can configure the XC Font Service.

Enable XC Font Service
☑ The XC Font Service is enabled.
☐ Der XC Font Service is not enabled. (Default)

Once you have enabled the XC Font Service, you can define the following settings:

XC Font Server: The server on which the XC Font Service is running.
Port Number: The port number on which the XC Font Service is available. (Default: 7100)
Prefer Local Fonts
☑ Local fonts are used before a request is sent to the font server.
☐ Local fonts are not preferred. (Default)
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2.
3.

NFS Font Service
Menu path: Setup > User Interface > Font Services > NFS Font Service

Using the NFS font service is another way to import additional fonts. The NFS font service also offers the advantage 
that the mount point for the fonts can be configured. This is necessary for a number of remote applications that 
search for your fonts in a specific directory.

To define and enable an NFS font path entry in order to use the NFS font service, proceed as follows.
Click on Add  to open the dialog window:

Local Path: Defines the local directory for the mount point
NFS Server: Name or IP address of the server that makes available the font directories via 
NFS.
Remote Path: Path on the server under which the fonts are available.
Prefer Local Fonts
☑ Local fonts are used before a request is sent to the font server.

Click on OK to enable the entry.
Export the font directory on the server via NFS read-only for the thin client.
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Network
In this area, you can configure network connections of the endpoint device.

LAN Interfaces (see page 724)
Mobile Broadband (see page 741)
DHCP Client (see page 743)
VPN (see page 746)
SCEP Client (NDES) (see page 773)
Routing (see page 777)
Hosts (see page 778)
Network Drives (see page 779)
Proxy (see page 784)
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LAN Interfaces
Menu path: Setup > Network > LAN Interfaces

Here, you can configure the LAN interfaces.

Activate default interface (Ethernet)

☑ The default interface is enabled. (Default)

☐ The Ethernet interface is not enabled.

Get IP from the DHCP server: The IP address of the client will be obtained automatically using DHCP. (Default)

DHCP options can be specified under DHCP Client (see page 743).

Specify an IP address: The IP address and the network mask are entered manually.

IP address: IP address of the device.

Network mask: Network mask of the device.

Default gateway: IP address of the default gateway.

Enable

☑ Routing via the default gateway is enabled.

☐ Routing via the default gateway is not enabled. (Default)

Terminal name: Local name of the device. If the field is empty, the default name combined of ' ITC ' with a MAC 
address will be generated.

Enable DNS

☑ The manual DNS configuration will be used.

☐ The DNS configuration will be carried out by DHCP or BOOTP. (Default)

Default domain: Usually the name of the local network.

Name server: IP address of the name server to be used.

Name server: IP address of an alternative name server.

Manually overwrite DHCP settings

☑ The default route, the domain name, and the DNS server will be overwritten by manual entries.

☐ Manual entries will not overwrite DHCP settings. (Default)

Dynamic DNS registration:

☑ The terminal name will be registered dynamically via the DNS or DHCP server.

☐ The terminal name will not be registered dynamically. (Default)

Dynamic DNS registration method

If a number of Ethernet interfaces are available, the device designated as /dev/eth0  by Linux will be 
used as the default interface.


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DHCP: Updates the terminal name through DHCP option 81.
DNS: Sends updates to the DNS server in accordance with RFC 2136.

TSIG key file for additional DNS authentication: Path to the private key if TSIG-based DDNS registration is used.

Individual Interface (see page 726)
Wireless (see page 731)
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Individual Interface
Menu path: Setup > Network > LAN Interfaces > [Interface]

Activate default interface (Ethernet)

☑ The default interface will be enabled. (Default)

☐ The Ethernet interface will not be enabled.

Get IP from DHCP server

☑ The IP address of the client will be obtained automatically using DHCP. (Default)

DHCP options can be specified under DHCP Client (see page 743).

Specify an IP address: The IP address and the network mask are entered manually.

IP address: IP address of the device.

Network mask: Network mask of the device.

IPv6 Configuration

Compatibility mode: Behavior of earlier firmware versions.
Disabled: IPv6 completely disabled.
Automatic: IPv6 auto configuration based on router advertisements (can include DHCPv6).
For further information, see RFC 4861.22

DHCPv6: IPv6 configuration using DHCPv6 if router advertisements are not available.
This is mentioned in RFC 4862 Section 5.5.2.23

Network link type

Auto sense
1000 Mb/s full duplex
100 Mb/s full duplex
100 Mb/s half duplex
10 Mb/s full duplex
10 Mb/s half duplex

Force auto-negotiation

☑ With this option, problems with half/full duplex for specific switches that expect the auto-negotiation flag for 
fixed bandwidths can be addressed.

☐ Automatic negotiation will not be forced. (Default)

Enable tray icon

☑ A tray icon for the network interface will be shown. (Default)

If a number of Ethernet interfaces are available, the device designated as /dev/eth0  by Linux will be 
used as the default interface.



https://tools.ietf.org/html/rfc4861
https://tools.ietf.org/html/rfc4862#section-5.5.2
https://tools.ietf.org/html/rfc4861
https://tools.ietf.org/html/rfc4862#section-5.5.2
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Enable context menu

☑ A context menu will be shown when you click on the tray icon. (Default)

Enable network info dialog

☑ A dialog window with information regarding the network connection will be shown when you click on the 
context menu. (Default)

Authentication (see page 728)
Wake-on-LAN (see page 730)
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Authentication
Menu path: Setup > Network > LAN Interfaces > [Interface] > Authentication

Here, you can enable and configure network port authentication.

Enable IEEE-802.1x authentication

☑ Network port authentication is enabled.

☐ Network port authentication is not enabled. (Default)

If you enable authentication, further options are available:

EAP type: Here, you can select the authentication procedure:

PEAP
TLS
TTLS

Auth method: The following authentication methods are available:

MSCHAPV2
TLS
GTC
MD5
PAP

Validate server certificate

☑ The server’s certificate is checked cryptographically. (Default)

CA Root certificate: The path to the CA root certificate file. This can be in PEM or DER format.

Identity: User name for RADIUS

Password: Password for network access

The following settings are relevant if you have selected "TLS" as EAP type:

Manage certificates with SCEP (NDES)

☑ Client certificates will automatically be managed with SCEP (see page 773).

☐ Client certificates will not be managed with SCEP (see page 773). (Default)

Client certificate: Path to the file with the certificate for client authentication in the PEM (base64) or DER format.

If you leave the Identity and Password fields empty, an entry mask for authentication purposes will be 
shown. However, this does not apply to the methods with a client certificate (TLS and PEAP-TLS) where 
these details are mandatory.



If a private key in the PKCS#12 format is used, leave this field empty.
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Private key: Path to the file with the private key for the client certificate. The file can be in the PEM (base64), DER, 
or PFX format. The Private key password may be required for access.

Identity: User name for network access

Private key password: Password for the Private key for the client certificate
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Wake-on-LAN
Menu path: Setup > Network > LAN Interfaces > [Interface] > Wake-On-LAN

Select the packets or messages with which the endpoint device can be started via the network.

For further information on the Wake-on-LAN functionality of the UMS, see Wake-on-LAN.

Wake on magic packet

☑ The device can be started with a Wake-on-LAN magic packet. (Default)

Wake on ARP packet

☑ The device can be started with a Wake on ARP packet.

☐ The device cannot be started with a Wake on ARP packet. (Default)

Wake on broadcast message

☑ The device can be started with a Wake on broadcast message.

☐ The device cannot be started with a Wake on broadcast message. (Default)

Wake on multicast message

☑ The device can be started with a Wake on multicast message.

☐ The device cannot be started with a Wake on multicast message. (Default)

Wake on physical activity

☑ The device can be started with a physical activity.

☐ The device cannot be started with a physical activity. (Default)

Wake on unicast message

☑ The device can be started with a Wake on unicast message.

☐ The device cannot be started with a Wake on unicast message. (Default)
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Wireless
Menu path: Setup > Network > LAN Interfaces > Wireless

In this area, you can configure everything relating to your wireless connections.

You will find details of compatible wireless hardware in the IGEL Linux 3rd Party Hardware Database24.

Activate wireless interface

☑ The default interface is enabled.

☐ The wireless interface is not enabled. (Default)

Get IP from DHCP server: The IP address of the client will be obtained automatically using DHCP. (Default)

DHCP options can be specified under DHCP Client (see page 743).

Specify IP address: The IP address and the network mask are entered manually

IP address: IP address of the thin client

Network mask: Network mask of the thin client

IPv6 configuration:

Compatibility mode: Behavior of earlier firmware versions
Disabled: IPv6 is completely disabled.
Automatic: IPv6 auto configuration is based on router advertisements (can include DHCPv6).

You will find further information in RFC 486125.

DHCPv6: IPv6 configuration using DHCPv6 if router advertisements are not available.

You will find further information in RFC 4862 Section 5.5.226.

Enable tray icon

☑ A tray icon for the wireless interface will be shown. (Default)

Enable context menu

☑ A context menu will be shown when you click on the tray icon. (Default)

Enable network info dialog

☑ A dialog window with information regarding the network connection will be shown when you click on the 
context menu. (Default)

Configure the wireless frequency range (see page 740) to ensure that your device meets the local regulations 
for wireless equipment.



Note that only the first wireless interface ( wlan0 ) is supported. All other wireless interfaces will be 
ignored.



https://www.igel.com/linux-3rd-party-hardware-database/
https://tools.ietf.org/html/rfc4861
https://tools.ietf.org/html/rfc4862#section-5.5.2
https://www.igel.com/linux-3rd-party-hardware-database/
https://tools.ietf.org/html/rfc4861
https://tools.ietf.org/html/rfc4862#section-5.5.2
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Enable Wireless Manager

☑ The Wireless Manager (see page 733) is enabled. This tool allows the user to establish a connection to a wireless 
network quickly. (Default)

☐ The Wireless Manager is disabled.

__________

Wireless Manager (see page 733)
Switch for the Wi-Fi Connection (see page 735)
Default Wi-Fi Network (see page 736)
Additional Wi-Fi Networks (see page 739)
Wireless Regulatory Domain (see page 740)

If you use wireless regularly, it is recommended that you enable the following options: Tray icon, Enable 
context menu, Enable Wireless Manager. Via the Wireless Manager, you can use IGEL Café Wireless.


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1.
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3.

Wireless Manager
The Wireless Manager tool allows the user to connect quickly to available wireless networks.

You can bring up the Wireless Manager from the tray icon for wireless:

See also How to Launch the Wireless Manager within IGEL OS when the Taskbar Is Hidden.

Click on the tray icon for wireless and select Manage wireless networks from the context menu.

Search for available networks.
The list of active networks is sorted according to the quality of their signal strength.
Previously configured connections are flagged with a tick in the Configured column.
The connection currently active is likewise flagged with a symbol under Connected.

Double-click on a network in the list in order to open the entry mask.
You can either permanently save the logon information or enter it each time you establish a 
connection to this network.

The Wireless Manager can be enabled under Network > LAN Interfaces > Wireless.
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4.

5.

Click on the Connect network button in order to establish the previously configured connection:
The tray icon will change to show the connection quality. 
Hidden networks appear in the Wireless Manager with the network name empty or can be defined 
using the Search for network button. 
In order to connect to a previously unknown hidden network, you must first enter the SSID before 
the access data are retrieved:

In the context menu for the tray icon, all available networks are listed and can be brought up from 
here.
The IGEL Setup shows all connections configured by the local user under Network > LAN 
Interfaces > Wireless > Additonal Wi-Fi Networks.

See also Café Wireless (Wi-Fi).

Click on the key symbol in order to display the key phrase while you are typing.

If you have configured the available connections, you will no longer need the Wireless 
Manager in order to establish a connection.


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Switch for the Wi-Fi Connection
You can turn Wi-Fi off or on.

To use the switch for the Wi-Fi connection, Enable Wi-Fi switch under Setup > System > Registry > Parameter > 
network > applet > wireless > enable_wifi_switch must be activated. (Default)

Turning Wi-Fi Off or On

If You Are Logged In

 Select Turn Wi-Fi off / Turn Wi-Fi on from the context menu of the Wi-Fi tray icon.

If the Login Dialog Is Displayed or the Screen Is Locked

 To turn Wi-Fi off, click the tray icon  and select OK in the Turn Wi-Fi off dialog. If the Wireless 

Manager (see page 733) is activated, you can also use there the button .

 To turn Wi-Fi on, click  and select OK in the Turn Wi-Fi on dialog.
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Default Wi-Fi Network
Menu path: Setup > Network > LAN Interfaces > Wireless > Default Wi-Fi network

Here, you can configure wireless network connections.

Disable Encryption: No encryption will be used. (Default)

Enable WEP Encryption: WEP encryption will be used.

Enable WPA Encryption: WPA encryption will be used.

Wireless Network Name (SSID): Name of the wireless network (SSID)

For WEP Encryption

Transmit key ID: Choose from a maximum of four configurable keys. (Default: 1)

Key Format:

ASCII
Hexadecimal

Key [1-4]: Enter the key here.

For WPA/WPA2 Personal Encryption

Network authentication

WPA Personal: Wi-Fi Protected Access Pre-Shared Key (WPA / IEEE 802.11i/D3.0)
WPA Enterprise: Wi-Fi Protected Access with 802.1X authentication (WPA / IEEE 802.11i/D3.0)
WPA2 Personal: Wi-Fi Protected Access Pre-Shared Key (WPA2 / IEEE 802.11i/RSN)
WPA2 Enterprise: Wi-Fi Protected Access with 802.1X authentication (WPA2/IEEE 802.11i/RSN)

Network key: WPA network key/passphrase as set at the dial-in point. This is either an ASCII character string with a 
length of 8...63 or exactly 64 hexadecimal digits.

Data encryption:

Default: The default value depends on which network authentication method is selected - TKIP for 
WPA, AES (CCMP) for WPA2.
TKIP: Temporal Key Integrity Protocol (IEEE 802.11i/D7.0)
AES (CCMP): AES in Counter mode with CBC-MAC (RFC 3610, IEEE 802.11i/D7.0)
AES (CCMP) + TKIP: One of two encryption methods is selected by the access point.
Automatic: The access point can choose the encryption method freely – nothing is stipulated.

You will need to give further information depending on the encryption method chosen.

•
•

Characters to be entered for WEP keys:
For 64-bit encryption, 5 characters (ASCII) or 10 hex digits (hexadecimal)
For 128-bit encryption, 13 characters (ASCII) or 26 hex digits (hexadecimal)


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AP Scan mode: Scan mode for access points

Default
Broadcast: Alternative for access points which allow the SSID broadcast
No broadcast: Alternative for access points which refuse the SSID broadcast (hidden access points)

For WPA/WPA2 Enterprise Encryption

Network authentication:

WPA Enterprise: Wi-Fi Protected Access with 802.1X authentication (WPA / IEEE 802.11i/D3.0)
WPA2 Enterprise: Wi-Fi Protected Access with 802.1X authentication (WPA2/IEEE 802.11i/RSN)

Data encryption:

Default: The default value depends on which network authentication method is selected - TKIP for 
WPA, AES (CCMP) for WPA2.
TKIP: Temporal Key Integrity Protocol (IEEE 802.11i/D7.0)
AES (CCMP): AES in Counter mode with CBC-MAC (RFC 3610, IEEE 802.11i/D7.0)
AES (CCMP) + TKIP: One of two encryption methods is selected by the access point.
Automatic: The access point can choose the encryption method freely – nothing is stipulated.

AP Scan mode: Scan mode for access points

Default
Broadcast: Alternative for access points which allow the SSID broadcast
No broadcast: Alternative for access points which refuse the SSID broadcast (hidden access points)

EAP Type

PEAP
TLS: Transport Layer Security with client certificate
TTLS: Tunneled Transport Layer Security (from IGEL Linux 10.04.100 onwards)

Auth Method: Method for authentification that is available for the selected EAP type
Possible options for PEAP:

MSCHAPv2: Microsoft Challenge Handshake Authentication Protocol
TLS: Transport Layer Security with client certificate
GTC: Generic Token Card
MD5: MD5-Challenge

Possible options for TTLS:

MSCHAPv2: Microsoft Challenge Handshake Authentication Protocol
PAP: Password Authentication Protocol

Validate Server Certificate

☑ The thin client validates the authenticity of the authentification server against the certificate file. This certificate 
file is stored under the path defined by CA Root Certificate.

☐ The authenticity of the authentification server is not validated.
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CA Root Certificate: Path and file name of the file that contains the certificates with which the authentification 
server authenticates itself.

Identity: User name that is stored at the authentification server

Password: Password relevant to the user name

Learn more from the how-to Using WPA Enterprise / WPA2 Enterprise with TLS Client Certificates.



Network

IGEL OS Reference Manual   739 / 897

Additional Wi-Fi Networks
Menu path: Setup > Network > LAN Interfaces > Wireless > Additional Wi-Fi Networks

You can add other wireless networks here. The settings options per wireless network correspond to those for the 
Default Wi-Fi Network (see page 736).

To edit the wireless network list, proceed as follows:

 Click  to create a new entry.

 Click  to remove the selected entry.

 Click  to edit the selected entry.

 Click  to copy the selected entry.
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Wireless Regulatory Domain
Menu path: Setup > Network > LAN Interfaces > Wireless > Wireless Regulatory Domain

This page allows you to set the wireless device in accordance with local regulations.

Wireless regulatory domains: Select the area in which the device is located.

Not configured
Africa
Arctic
Asia
Australia
Europe
North America
South America
World

Location: Select the country in which the device is located.

Not configured
Albania
Armenia
[...]
Cyprus
Austria

The list below sets out the technical requirements for the selected location for your information.
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Mobile Broadband
Menu path: Setup > Network > Mobile Broadband Network

Here, you can change the settings for a modem or a surf stick. This function is available from IGEL Linux Version 
10.03.100.

If the device is already inserted and has been configured, the network connection will be established after the thin 
client boots. It can take between a few seconds and around 1 minute to establish a connection. The network 
connection will remain in place until the surf stick is removed or the thin client is put on standby or shut down.

The status of the network connection is shown in the system tray:

 The network connection is established; the thin client is online This symbol is only shown if 
“Modem” is selected as the device type. If "Router” is selected as the device type, the symbol for a 

LAN connection  will be shown.
 The network connection was interrupted; the thin client is offline This symbol is only shown if 

“Modem” is selected as the device type. If "Router” is selected as the device type, the 
corresponding symbol for a LAN connection will be shown.

You can change the following settings:

Enable mobile broadband
☑ The mobile broadband network can be used if a supported modem is connected.
☐ The mobile broadband network cannot be used. (default)
Device type
Possible options:

Modem: The device will be operated as a modem. The access data can be changed with the 
parameters number, user name, password, APN, network ID and PIN.
Router: The device will be operated as a router. The device must be configured in advance in 
such a way that it is ready for use when it is inserted.

Number: Access number for your network connection. If you do not know the access number, ask 
your mobile communications operator for it.
User name: User name for your network connection. If you do not know the user name, ask your 
mobile communications operator for it.
Password: Password for your network connection. If you do not know the password, ask your 
mobile communications operator for it.
APN: APN (Access Point Name) for your network connection. If you do not know the APN, ask your 
mobile communications operator for it.

•
•

Ensure that data traffic is adequately secured. You can do this in the following ways:
Use a private APN.
Use OpenVPN and block traffic that would circumvent VPN with firewall rules.



Select the "Router” device type if you use a device from Huawei in the HiLink mode; 
example: Huawei E3372.


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Network ID: Network ID for your network connection. If you do not know the network ID, ask your 
mobile communications operator for it.
PIN: PIN for the SIM card used.
Enable tray icon
☑ The current status of the network connection is shown with the symbol  or .
☐ The current status of the network connection is not shown with a symbol.
Enable context menu
☑ If you click on  or , a context menu can be opened.
☐ No context menu can be opened.
Enable network info dialog
☑ Via the context menu, you can bring up detailed information regarding the network 
connection.
☐ No detailed information regarding the network connection can be brought up.
Enable mobile broadband configuration dialog
☑ Via the context menu, you can open a configuration dialog in order to change the access data.
☐ The configuration dialog cannot be opened.



Network

IGEL OS Reference Manual   743 / 897

•
•

DHCP Client
Menu path: Setup > Network > DHCP Client

Here, you can change the advanced settings for the firmware’s built-in DCHP client.

_____

Default Options (see page 744)
User-Defined Options (see page 745)
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Default Options
Menu path: Setup > Network > DHCP Client > Default Options

User Class: A freely definable character string which can serve as a criterion for allocating specific 
settings for the DHCP server.
List of standard options: Options with which the client can request information from the DHCP 
server.
You will find information regarding the various DHCP options in RFC 2132 DHCP Options and 
BOOTP Vendor Extensions27.

To edit the list, proceed as follows:
Click on  to create a new entry.
Click on  to remove the selected entry.
Click on  to edit the selected entry.
Click on  to copy the selected entry.

https://tools.ietf.org/html/rfc2132
https://tools.ietf.org/html/rfc2132
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User-Defined Options
Menu path: Setup > Network > DHCP Client > User-Defined Options

 To create a new entry, click on  in the List of custom options area.

Enabled
☑ The option is enabled. (default)
☐ The action is not enabled.
Option Name: Add a prefix of your own in order to prevent a conflict with the default DHCP 
options. Example of the syntax: [ YourPrefix]-[OptionName] . English letters, numbers and 
the special character “-” are allowed.
Code: A number that is used by the DHCP server and DHCP client to reference an option. A number 
between 80 and 254 can be chosen. (default: 80)
Data Type: Type of option. Possible values:
boolean 
integer 8 
integer 16 
integer 32 
signed integer 8 
signed integer 16 
signed integer 32 
unsigned integer 8 
unsigned integer 16 
unsigned integer 32 
ip address 
text 
string

For more information regarding these options, see the manual for your DHCP server or your network 
components.


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VPN
Menu path: Setup > Network > VPN

Remote users securely access company networks via virtual private network protocols (VPN).

Enable tray icon
☑ A tray icon for the network interface will be shown. (default)
Enable context menu
☑ A context menu will be shown when you click on the tray icon. (default)
Enable network info dialog
☑ A dialog window with information regarding the network connection will be shown when you 
click on the context menu. (default)

_____

OpenVPN (see page 747)
NCP VPN Client (see page 758)
OpenConnect VPN (see page 760)
genucard (see page 765)
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OpenVPN
Menu path: Setup > Network > VPN > OpenVPN

The OpenVPN client puts in place a virtual private network using TLS encryption and requires OpenVPN 2.x as a VPN 
server.

Enable Autostart During Boot
☑ Shows the Auto column in the list of OpenVPN sessions. Highlight the desired session and click 
on Set Auto to enable this connection to be established during the boot procedure.
☐ Autostart is disabled. (default)
Restart connection when disconnected:

To manage the list of OpenVPN session, proceed as follows:

 Click  to create a new entry.

 Click  to remove the selected entry.

 Click  to edit the selected entry.

 Click  to copy the selected entry.

_____

Session (see page 748)
Options (see page 750)
TLS Options (see page 751)
Proxy (see page 752)
IPv4 (see page 753)
Route (see page 754)
Desktop Integration (see page 755)

IGEL Linux 10.01.100 does not support the use of OpenVPN with smartcards and eTokens.

If problems with OpenVPN occur, read the /tmp/journal.log  log file with the System Log Viewer (see 

page 588) accessory.

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Session
Menu path: Setup > Network > VPN > OpenVPN > [OpenVPN Connection] > Session

OpenVPN Server(s): Name or public IP address of the OpenVPN server
Authentication type

TLS certificates: Authentication with user certificate and private key
Name/password: Authentication with user name and password
Name/password with TLS-certificates: Combines name/password with user certificate.
Static key: Authentication with a private key. No PKI infrastructure is needed for this.

TLS Certificates Authentication Type

Client certificate file: File with the client certificate. Enter a path relative to /wfs/OpenVPN  or 
select using the file selection.
CA certificate file: File with the CA certificate. Enter a path relative to /wfs/OpenVPN  or select 
using the file selection.
Private key file: File with the private key. Enter a path relative to /wfs/OpenVPN  or select 
using the file selection.
Private key password: Password in case one is set for the private key

For details of how to distribute certificates and keys securely to thin clients, see the Securely 
Distributing Keys and Certificates (see page 748) How-To.

Name/Password Authentication Type

Username: User name - if you leave this field empty, the user will be asked for it when establishing 
a connection.
Password required
☑ The user must enter a password. (default)
Password: Password - if you leave this field empty, the user will be asked for it when establishing a 
connection.
CA certificate file: File with the CA certificate. Enter a path relative to /wfs/OpenVPN  or select 
using the file selection.

Persistent storage of files is possible in the folder /wfs  resp. subfolders of /wfs  only. 
Files stored under other paths will be lost when the thin client is rebooted.



If you have a PKCS#12 file which contains the client certificate, CA certificate and private 
key, always enter its name in the three file fields. The advantage lies in the fact that only a 
single file needs to be distributed.


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Name/Password with TLS-Certificates Authentication Type

Username: User name - if you leave this field empty, the user will be asked for it when establishing 
a connection.
Password required
☑ The user must enter a password. (default)
Password: Password - if you leave this field empty, the user will be asked for it when establishing a 
connection.
CA certificate file: File with the CA certificate. Enter a path relative to /wfs/OpenVPN  or select 
using the file selection.
Clientcertificate file: File with the user certificate. Enter a path relative to /wfs/OpenVPN  or 
select using the file selection.
CA certificate file: File with the CA certificate. Enter a path relative to /wfs/OpenVPN  or select 
using the file selection.
Private key file: File with the private key. Enter a path relative to /wfs/OpenVPN  or select 
using the file selection.
Private key password: Password in case one is set for the private key

For details of how to distribute certificates and keys securely to thin clients, see the Securely 
Distributing Keys and Certificates (see page 748) how-to.

Static Key Authentication Type

Private key file: File with the static key. Enter a path relative to /wfs/OpenVPN  or select using 
the file selection.
Key direction:

None: No key direction
0: If the default option is not used, one side of the connection should use Direction 0 and the 
other Direction 1.
1: If the default option is not used, one side of the connection should use Direction 0 and the 
other Direction 1.

Remote IP address: The VPN IP address of the server
Local IP address: The VPN IP address of the client

If you have a PKCS#12 file which contains the user certificate, CA certificate and private 
key, always enter its name in the three file fields. The advantage lies in the fact that only a 
single file needs to be distributed.


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Options
Menu path: Setup > Network > VPN > OpenVPN > [OpenVPN Connection] > Options

Here, you can configure the options for the OpenVPN client in order to ensure interaction with the server.

Further information regarding the options can be found in the OpenVPN documentation28 which is maintained by 
the OpenVPN project.

Gateway port: Local gateway port (default: 1194)
Custom renegotiation interval: Renegotiate data channel key after given number of seconds 
(default: 0)
Use LZO data compression
☑ The client will use LZO compression. Necessary if the server uses compression.
☐ The client will not use LZO compression. (default)
Protocol used for communication to the host

udp: UDP will be used.
tcp-client: TCP will be used.

Virtual network type
tun: Routing will be used
tap: Bridging will be used.

Use custom tunnel maximum transmission unit (MTU): The MTU of the TUN device will be used 
as a given value. The MTU of the interface will be derived from it.
UDP fragment size: Allow internal data fragmenting up to this size in bytes. Leave this field empty 
to keep the default value.
Restrict tunnel TCP maximum segment size (MSS)
☑ The TCP segment size (MSS) of the tunnel will be restricted.
☐ The TCP segment size (MSS) will not be restricted. (default)
Randomize remote hosts
☑ The remote gateways will be ordered randomly as a simple type of load balancing.
☐ The remote computers will not be ordered randomly. (default)
Cipher: Encryption algorithm for data packets. (default: BF-CBC - Blowfish in the Cipher Block 
Chaining mode)
HMAC authentication: Hashing algorithm for packet authentication (default: SHA1)

If you use a proxy, select tcp-client.

https://openvpn.net/index.php/open-source/documentation.html
https://openvpn.net/index.php/open-source/documentation.html
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TLS Options
Menu path: Setup > Network > VPN > OpenVPN > [OpenVPN Connection] > TLS Options

Subject match: The computer will only accept connections from a computer whose X.509 name or name matches 
the one entered. If you leave this field empty, no check will take place.

Remote peer certificate TLS type

Do not verify
Check for server certificate
Check for client certificate

Key file for additional TLS authentication: As the path, enter relative to /wfs/OpenVPN  or select using the file 
selection. This adds an additional HMAC legitimization level above the TLS control channel in order to prevent 
DDOS attacks.

Key direction

None: No key direction
0: If the default option is not used, one side of the connection should use Direction 0 and the other 
Direction 1.
1: If the default option is not used, one side of the connection should use Direction 0 and the other 
Direction 1.
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Proxy
Menu path: Setup > Network > VPN > OpenVPN > [OpenVPN Connection] > Proxy

Here, you can set up an optional proxy server for the VPN connection.

Proxy type
None: Direct connection to the Internet.
HTTP: HTTP proxy will be used.
SOCKS: SOCKS proxy will be used.

Details for HTTP proxy

Proxy address: Name or IP address of the proxy server
Proxy port: Port on which the proxy service is available
Retry indefinitely when errors occur
☑ In the event of errors, repeated attempts to establish a connection via proxy will be made.
☐ No further attempts to establish a connection will be made (default).

Ceredentials for HTTP

Proxy username: User name for the proxy server
Proxy password: Password for the proxy server

If you use a proxy, select the value tcp-client under Options > Communication protocol to the host.
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IPv4
Menu path: Setup > Network > VPN > OpenVPN > [OpenVPN Connection] > IPv4

By default, OpenVPN uses the server’s DNS and routing settings. Here, you can change these settings.

Automatic DNS:
☑ The name server(s) will be carried over by the OpenVPN server. (default)
☐ Extra name servers (see below) will be used.
Extra name server(s): One or more name servers, IP addresses separated by commas.
Extra search domain(s): One or more search domains, separated by commas.
Automatic routes
☑ The routing table will be carried over by the OpenVPN server. (default)
☐ Extra routes will be configured.
VPN is the default route
☑ The default route leads to the VPN. (default)
☐ Extra routes will be configured.
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Route
Menu path: Setup > Network > VPN > OpenVPN > [OpenVPN Connection] > Route [0,1,2]

Here, you can configure extra routes.

Enable
☑ This route is enabled.
☐ This route is not enabled. (default)
Network route / host route: Type of route

Network route: The routing relates to a (sub) network
Host route: The routing relates to the address of a computer

Network / host IP: The address of the network (for a network route) or the IP address or the name 
of the host (for a host route)
Network mask: Mask for the desired IP range, e.g. 255.255.255.0
Gateway: Gateway that routes the packets to the target network
Metric: Here, you can enter a numerical quality assessment for routing decisions, 0 is the best 
value.
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Desktop Integration
Menu path: Setup > Network > VPN > OpenVPN > [OpenVPN Connection] > Desktop Integration

Session name: Name for the session.

Starting Methods for Session

Start menu

☑ The session can be launched from the start menu.

Application Launcher

☑ The session can be launched with the Application Launcher.

Desktop

☑ The session can be launched with a program launcher on the desktop.

Quick start panel

☑ The session can be launched with the quick start panel.

Start menu's system tab

☑ The session can be launched with the start menu's system tab.

Application Launcher's system tab

☑ The session can be launched with the Application Launcher's system tab.

Desktop context menu

☑ The session can be launched with the desktop context menu.

Menu folder: If you specify a folder name or a path comprising a number of folder names separated by "/", a menu 
path will be created for the session. The menu path will be used in the start menu and in the desktop context menu.

Application Launcher folder: If you specify a folder name or a path comprising a number of folder names 
separated by "/", a menu path will be created for the session. The menu path will be used in the Application 
Launcher.

Desktop folder: If you specify a folder name or a path comprising a number of folder names separated by "/", a 
menu path will be created for the session. The menu path will be used for the program launcher on the desktop.

Password protection: Specifies which password will be requested when launching the session.
Possible values:

None: No password is requested when launching the session.
Administrator: The administrator password is requested when launching the session.
User: The user password is requested when launching the session.
Setup user: The setup user's password is requested when launching the session.

The session name must not contain any of these characters: \ / : * ? “ < > | [ ] { } ( )
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Hotkey

☑ The session can be started with a hotkey. A hotkey consists of one or more modifiers and a key.

Modifiers: A modifier or a combination of several modifiers for the hotkey. You can select a set key symbol/
combination or your own key symbol/combination. A key symbol is a defined chain of characters, e.g.  Ctrl .

These are the pre-defined modifiers and the associated key symbols:

(No modifier) =  None

 =  Shift
[Ctrl] =  Ctrl

 =  Mod4

[Alt] =  Alt

Key combinations are formed as follows with  | :

Ctrl +   =  Ctrl|Super_L

Key: Key for the hotkey

Appliance mode access: Determines whether the session can be started in appliance mode. By default, appliance 
mode implies that one session is running on the device exclusively. For further information, see Appliance Mode (see 
page 220).

☑ The session can be started in appliance mode. The following starting methods can be used in appliance mode:

Desktop (desktop icon; not in appliance mode XDMCP for this Display)
Desktop Context Menu (not in appliance mode XDMCP for this Display)
Application Launcher (includes Application Launcher's system tab; not in appliance 
mode XDMCP for this Display)
Hotkey

Do not use [AltGr] as a modifier (represented as Mod5 ). Otherwise, the key that is configured as a hotkey 
with AltGr cannot be used as a regular key anymore. Example: If you configure [AltGr] + [E] as a hotkey, it is 
impossible to enter an "e".



When this keyboard key is used as a modifier, it is represented as Mod4 ; when it is used as a key, it 

is represented as Super_L .



To enter a key that does not have a visible character, e. g. the [Tab] key, open a terminal, log on as user

and enter xev -event keyboard . Press the key to be used for the hotkey. The text in brackets that 

begins with keysym  contains the key symbol for the Key field. Example: Tab  in (keysym 0xff09, 

Tab)


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• Autostart (not in appliance mode XDMCP for this Display)

☐ The session cannot be started in appliance mode. 
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NCP VPN Client
Menu path: Network > VPN > NCP VPN Client

The configuration parameters for the NCP Client are configured exclusively via the client program interface itself.

You will find the documentation regarding the NCP Secure Enterprise Client at https://www.ncp-e.com/en/service-
resources/library/.

 Click   to add an NCP VPN client session and configure the start methods.

Session name: Name for the session.

Starting Methods for Session
Start menu

☑ The session can be launched from the start menu.

Application Launcher

☑ The session can be launched with the Application Launcher.

Desktop

☑ The session can be launched with a program launcher on the desktop.

Desktop context menu

☑ The session can be launched with the desktop context menu.

Hotkey

☑ The session can be started with a hotkey. A hotkey consists of one or more modifiers and a key.

Modifiers: A modifier or a combination of several modifiers for the hotkey. You can select a set key symbol/
combination or your own key symbol/combination. A key symbol is a defined chain of characters, e.g.  Ctrl .

These are the pre-defined modifiers and the associated key symbols:

NCP offers a 30-days trial period for IGEL customers.

The session name must not contain any of these characters: \ / : * ? “ < > | [ ] { } ( )

Do not use [AltGr] as a modifier (represented as Mod5 ). Otherwise, the key that is configured as a hotkey 
with AltGr cannot be used as a regular key anymore. Example: If you configure [AltGr] + [E] as a hotkey, it is 
impossible to enter an "e".



https://www.ncp-e.com/en/service-resources/library/
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(No modifier) =  None

 =  Shift
[Ctrl] =  Ctrl

 =  Mod4

[Alt] =  Alt

Key combinations are formed as follows with  | :

Ctrl +   =  Ctrl|Super_L

Key: Key for the hotkey

Autostart

☑ The session will be launched automatically when the device boots.

Restart

☑ The session will be restarted automatically after the termination.

When this keyboard key is used as a modifier, it is represented as Mod4 ; when it is used as a key, it 

is represented as Super_L .



To enter a key that does not have a visible character, e. g. the [Tab] key, open a terminal, log on as user

and enter xev -event keyboard . Press the key to be used for the hotkey. The text in brackets that 

begins with keysym  contains the key symbol for the Key field. Example: Tab  in (keysym 0xff09, 

Tab)


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OpenConnect VPN
Menu Path: Setup > Network > VPN > OpenConnect VPN

The OpenConnect VPN Client puts in place a virtual private network using TLS encryption. This feature is available 
from IGEL Linux 10.04.100 onwards.

Enable autostart during boot
☑ Autostart is enabled.
☐ Autostart is disabled. (Default)
Restart connection when disconnected
☑ Reconnect automatically when a disconnect occurs.
☐ Do not reconnect automatically when a disconnect occurs. (Default)

To manage the list of OpenConnect VPN sessions, proceed as follows:

 Click  to create a new entry.

 Click  to remove the selected entry.

 Click  to edit the selected entry.

 Click  to copy the selected entry.

_____

Session (see page 761)
Desktop Integration (see page 762)
Enabling the OpenConnect VPN Client (see page 764)

Feature Not Available on IZ Devices

This feature is not available on IGEL IZ devices (IGEL Zero HDX, IGEL Zero RFX, or IGEL Zero Horizon).


Feature with limited support The OpenConnect VPN Client feature comes with limited support and 
without any warranty. Any support for this feature is provided on a non-binding, “best effort” basis.



The OpenConnect VPN Client feature needs to be enabled manually before you can use it, see Enabling the 
OpenConnect VPN Client (see page 764).


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Session
Menu path: Setup > Network > VPN > OpenConnect VPN > [session name] > Session

Gateway: IP address, hostname or Fully Qualified Domain Name (FQDN) of the VPN gateway
Connect to Juniper Networks VPN
☑ The protocol of Juniper Networks VPN is used.
☐ The protocol of Juniper Networks VPN is not used. (Default)
Name/Password Authentication
☑ User name and password are used for authentication.
☐ User name and password are not used for authentication. (Default)
User name: User name used for authentication
Password: Password used for authentication
CA Certificate: Path to the CA certificate
User Certificate: Path to the user certificate 

Private Key: Path to the private key
Private Key password: Password of the private key

The certificates should be stored in the directory /wfs/OpenVPN/  if possible, then they will 
certainly be found after a reboot.


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Desktop Integration
Menüpfad: Setup > Network > VPN > OpenConnect VPN > [session name] > Desktop Integration

Session Name: Name for the session

Starting Methods for Session

Start Menu

☑ The session can be started from the start menu. (Default)

Application Launcher

☑ The session can be started with the application launcher. (Default)

Desktop:

☑ The session icon will appear on the desktop. (Default)

Quick Start Panel

☑ The session can be started from the quick start panel.

☐ The session cannot be started from the quick start panel. (Default)

Desktop Context Menu

☑ The session can be started form the desktop context menu.

☐ The session cannot be started from the desktop context menu. (Default)

Application Launcher folder: Path to the application launcher folder

Password Protection: Specifies which password will be requested when launching the session.
Possible values:

None: No password is requested when launching the session.
Administrator: The administrator password is requested when launching the session.
User: The user password is requested when launching the session.
Setup User: The setup user's password is requested when launching the session.

Hotkey:

☑ The session can be started with a hotkey. A hotkey consists of one or more modifiers and a key.

Modifiers: A modifier or a combination of several modifiers for the hotkey. You can select a set key symbol/
combination or your own key symbol/combination. A key symbol is a defined chain of characters, e.g.  Ctrl .

The session name must not contain any of these characters: \ / : * ? “ < > | [ ] { } ( )

Do not use [AltGr] as a modifier (represented as Mod5 ). Otherwise, the key that is configured as a hotkey 
with AltGr cannot be used as a regular key anymore. Example: If you configure [AltGr] + [E] as a hotkey, it is 
impossible to enter an "e".


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These are the pre-defined modifiers and the associated key symbols:

(No modifier) =  None

 =  Shift
[Ctrl] =  Ctrl

 =  Mod4

[Alt] =  Alt

Key combinations are formed as follows with  | :

Ctrl +   =  Ctrl|Super_L

Key: Key for the hotkey

Appliance mode access: Determines whether the session can be started in appliance mode. By default, appliance 
mode implies that one session is running on the device exclusively. For further information, see Appliance Mode (see 
page 220).

☑ The session can be started in appliance mode. The following starting methods can be used in appliance mode:

Desktop (desktop icon; not in appliance mode XDMCP for this Display)
Desktop Context Menu (not in appliance mode XDMCP for this Display)
Application Launcher (includes Application Launcher's system tab; not in appliance 
mode XDMCP for this Display)
Hotkey
Autostart (not in appliance mode XDMCP for this Display)

☐ The session cannot be started in appliance mode. 

When this keyboard key is used as a modifier, it is represented as Mod4 ; when it is used as a key, it 

is represented as Super_L .



To enter a key that does not have a visible character, e. g. the [Tab] key, open a terminal, log on as user

and enter xev -event keyboard . Press the key to be used for the hotkey. The text in brackets that 

begins with keysym  contains the key symbol for the Key field. Example: Tab  in (keysym 0xff09, 

Tab)


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1.

2.

3.
4.
5.

Enabling the OpenConnect VPN Client
To enable the OpenConnect VPN Client, proceed as follows:

Ensure that the settings under System > Update > Firmware Update are correct. The Server Path
must point to the firmware version that is currently installed. This is required because the software 
package for the OpenConnect VPN client must be downloaded in order to deploy the feature.
Go to System > Firmware Customization > Features and activate VPN OpenConnect (Limited 
support - functionality "as is", see product documentation for details).
Confirm the warning dialog with Ok.
Click Ok in the main window.
Reboot the thin client.
On reboot, the client downloads and installs the software package for the OpenConnect VPN Client 
feature.
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genucard
Menu path: Network > VPN > genucard

The genucard VPN hardware offers a choice of preconfigured Internet and VPN connections.

The settings for launching the session are described below.

Session name: Name for the session.

Starting Methods for Session
Start menu

☑ The session can be launched from the start menu.

Application Launcher

☑ The session can be launched with the Application Launcher.

Desktop

☑ The session can be launched with a program launcher on the desktop.

Quick start panel

☑ The session can be launched with the quick start panel.

Start menu's system tab

☑ The session can be launched with the start menu's system tab.

Application Launcher's system tab

☑ The session can be launched with the Application Launcher's system tab.

Desktop context menu

☑ The session can be launched with the desktop context menu.

Menu folder: If you specify a folder name or a path comprising a number of folder names separated by "/", a menu 
path will be created for the session. The menu path will be used in the start menu and in the desktop context menu.

Application Launcher folder: If you specify a folder name or a path comprising a number of folder names 
separated by "/", a menu path will be created for the session. The menu path will be used in the Application 
Launcher.

Desktop folder: If you specify a folder name or a path comprising a number of folder names separated by "/", a 
menu path will be created for the session. The menu path will be used for the program launcher on the desktop.

Password protection: Specifies which password will be requested when launching the session.
Possible values:

None: No password is requested when launching the session.
Administrator: The administrator password is requested when launching the session.

The session name must not contain any of these characters: \ / : * ? “ < > | [ ] { } ( )
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User: The user password is requested when launching the session.
Setup user: The setup user's password is requested when launching the session.

Hotkey

☑ The session can be started with a hotkey. A hotkey consists of one or more modifiers and a key.

Modifiers: A modifier or a combination of several modifiers for the hotkey. You can select a set key symbol/
combination or your own key symbol/combination. A key symbol is a defined chain of characters, e.g.  Ctrl .

These are the pre-defined modifiers and the associated key symbols:

(No modifier) =  None

 =  Shift
[Ctrl] =  Ctrl

 =  Mod4

[Alt] =  Alt

Key combinations are formed as follows with  | :

Ctrl +   =  Ctrl|Super_L

Key: Key for the hotkey

Appliance mode access: Determines whether the session can be started in appliance mode. By default, appliance 
mode implies that one session is running on the device exclusively. For further information, see Appliance Mode (see 
page 220).

☑ The session can be started in appliance mode. The following starting methods can be used in appliance mode:

Desktop (desktop icon; not in appliance mode XDMCP for this Display)
Desktop Context Menu (not in appliance mode XDMCP for this Display)

Do not use [AltGr] as a modifier (represented as Mod5 ). Otherwise, the key that is configured as a hotkey 
with AltGr cannot be used as a regular key anymore. Example: If you configure [AltGr] + [E] as a hotkey, it is 
impossible to enter an "e".



When this keyboard key is used as a modifier, it is represented as Mod4 ; when it is used as a key, it 

is represented as Super_L .



To enter a key that does not have a visible character, e. g. the [Tab] key, open a terminal, log on as user

and enter xev -event keyboard . Press the key to be used for the hotkey. The text in brackets that 

begins with keysym  contains the key symbol for the Key field. Example: Tab  in (keysym 0xff09, 

Tab)


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Application Launcher (includes Application Launcher's system tab; not in appliance 
mode XDMCP for this Display)
Hotkey
Autostart (not in appliance mode XDMCP for this Display)

☐ The session cannot be started in appliance mode. 

“Connections” Window (see page 768)
Options (see page 769)
Desktop Integration (see page 770)
Administrator Session (see page 772)
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“Connections” Window
The Connections window opens as soon as the genucard session is launched. You will find the following menu 
points there:

File
Change PIN: Enter your previous PIN as well as your chosen new PIN twice.
Rekeying: Enter your PIN to generate a new key.

Wifi: Opens the Wifi dialog which allows you to configure wireless access for the genucard.
Select a wireless network from the list. Scan updates the list (this can take up to a minute).
Password: The password for the selected wireless network. Show shows the entry in plain 
text.
Save: Saves the connection data entered along with the password on the genucard.
Saved connections: Select one of the previously saved connections.
Delete: Deletes the selected connection.
Edit: Changes the password for the selected connection.

Log: Allows you to view the log
Network connection: Select one of the network connections preconfigured on the genucard, for 
example LAN or WiFi.

 To start the selected network connection, click Connect.

VPN connection: Select one of the VPN connections preconfigured on the genucard.

 To start the selected VPN connection, click Connect.

The network connections listed here have been configured using a genucard
administration session or the genucenter. Connections configured with the genucenter are 
marked with "(GCE)".



The VPN connections listed here have been configured using a genucard administration 
session or the genucenter. Connections configured with the genucenter are marked with 
"(GCE)".


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Options
Menu path: Setup > Network > VPN > genucard > Options

Here, you can prepopulate connection and user data for the genucard.

Autostart during boot
☑ The genucard application is launched during booting. This option increases the waiting time 
until the network is available.

☐ The genucard application is not launched during booting. (default)
Autostart after USB directory (requires restart)
☑ The genucard application is automatically launched as soon as the genucard is connected to 
the thin client. (default)

Default Internet connection: Name of an Internet connection configured on the genucard.
Default VPN connection: Name of an Internet connection configured on the genucard.
User name: User name for the genucard application
Password: Password for the genucard application
Internet connection timeout: Permitted waiting time in seconds (default: 120)
VPN connection timeout: Permitted waiting time in seconds (default: 120)
File path for private keys for machine connection: File path for the key file.

If the user name, password, default Internet connection and the default VPN connection 
are set in the setup, automatic launching allows firmware updates via VPN too.



Launching the genucard can take up to 60 seconds.
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Desktop Integration
Menu path: Setup > VPN > genucard > Desktop Integration

Session name: Name for the session

Start menu:
☑ The session can be started with the start menu. (Default)
☐ The session cannot be found in the start menu.
Application Launcher:
☑ The session can be started with the Application Launcher. (Default)
☐ The session cannot be found in the Application Launcher.
Desktop:
☑ The session can be started with a program starter on the desktop. (Default)
☐ The session does not have a program starter on the desktop.
Quick start panel:
☑ The session can be started with the quick start panel.
☐ The session cannot be found in the quick start panel. (Default)
Start menu's system tab:
☑ The session can be started with the start menu’s system tab.
☐ The session cannot be found in the start menu’s system tab. (Default)
Application Launcher's system tab:
☑ The session can be started with the Application Launcher’s system tab.
☐ The session cannot be found in the Application Launcher’s system tab. (Default)
Desktop context menu:
☑ The session can be started with the desktop context menu.
☐ The session cannot be found in the desktop context menu. (Default)
Menu folder: If you specify a folder name or a path comprising a number of folder names 
separated by "/", a menu path will be created for the session. The menu path will be used in the 
start menu and in the desktop context menu.
Desktop folder: If you specify a folder name or a path comprising a number of folder names 
separated by "/", a menu path will be created for the session. The menu path will be used for the 
program launcher on the desktop.
Password protection: Specifies which password will be requested when launching the session.
Possible values:

None: No password is requested when launching the session.
Administrator: The administrator password is requested when launching the session.
User: The user password is requested when launching the session.
Setup user: The setup user's password is requested when launching the session.

Hotkey: A hotkey with which the session can be started is defined. It consists of modifiers and a 
key.
Modifiers: One or two modifiers for the hotkey:

The session name must not contain any of these characters: \ / : * ? “ < > | 

[ ] { } ( )


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None

 = Shift
[Ctrl ] = Ctrl

 = Super_L

[Alt] = Alt

Modifiers can be combined by using the pipe character |:

[Ctrl ]+  = Ctrl|Super_L
Key: Key for the hotkey

To enter a key that does not have a visible character, e. g. the [Tab] key, open a terminal, 
log on as user  and enter xev -event keyboard . Press the key to be used for the 

hotkey. The text in brackets that begins with keysym  contains the character string for 

the Key field. Example: Tab  in (keysym 0xff09, Tab)


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1.

2.

3.
4.

5.

Administrator Session
The genucard is configured and administered centrally via the genucenter management interface. While VPN 
profiles can only be configured via genucenter or other remote interfaces, Internet connection profiles can also be 
configured via a local administration session.

Further information is available from www.genua.de29.

Optionally, an administrator session allowing the genucard Internet connection to be configured can be set up:

To configure an Internet connection profile via a local administration session, proceed as follows:
Click on Add instance under System > Registry > Sessions > genucard%.
The genucard icon will appear on the desktop.
Click on the genucard icon.
The genucard logon window will open.
Enter a user name and password.
Click on Logon.
The Internet/VPN page will open.
In the Internet area, configure the connection with the help of the  (Create),  (Edit) and 
(Delete) buttons.

https://www.genua.de/en.html
https://www.genua.de/en.html
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SCEP Client (NDES)
Menu path: Setup > Network > SCEP Client (NDES)

SCEP allows the automatic provision of client certificates via an SCEP server and a certification authority. This type 
of certificate is automatically renewed before it expires and can be used for purposes such as network 
authentication (e.g. IEEE 802.1x).

A Microsoft Windows Server (MSCEP, NDES) for example can serve as a queried counterpart (SCEP server and 
certification body). More information can be found at Microsoft, e.g. in the following Technet article: Network 
Device Enrollment Service (NDES) in Active Directory Certificate Services (AD CS)30

Manage certificates with SCEP

☑ Certificate management via SCEP Client (NDES) is enabled. Now carry out the necessary configuration.

☐ Certificate management via SCEP Client (NDES) is not enabled. (Default)

__________

Certificate (see page 774)
Certification Authority (see page 775)
SCEP (see page 776)

http://social.technet.microsoft.com/wiki/contents/articles/9063.network-device-enrollment-service-ndes-in-active-directory-certificate-services-ad-cs.aspx
http://social.technet.microsoft.com/wiki/contents/articles/9063.network-device-enrollment-service-ndes-in-active-directory-certificate-services-ad-cs.aspx
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Certificate
Menu path: Setup > Network > SCEP Client (NDES) > Certificate

Here, you can specify the basic data for the certificate to be issued by the certification body.

Type of CommonName/SubjectAltName: The characteristic for linking the certificate to the device.

IP address: The IP address of the device.
DNS name: The DNS name of the device.
IP address (auto): The IP address of the device (inserted automatically).
DNS name (auto): The DNS name of the device (inserted automatically).
Email address: An email address.
DNS name as UPN (auto)

CommonName/SubjectAltName: Give a designation which matches the Type of CommonName/SubjectAltName. 
For certain types, this occurs automatically. No entry is then required.

Organizational unit: Stipulated by the certification authority.

Organization: A freely definable designation for the organization to which the client belongs.

Locality: Details regarding the device’s locality. Example: "Augsburg".

State: Details regarding the device’s locality. Example: "Bayern".

Country: Two-digit ISO 3166-1 country code. Example: "DE".

RSA key length (bits): Select a key length (one suited to the certification authority) for the certificate that is to be 
issued. 
Possible values:

"1024"
"2048"
"4096"

If the client automatically obtains its network name, DNS Name (auto) is a good type for the client 
certificate.


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Certification Authority
Menu path: Setup > Network > SCEP Client (NDES) > Certification Authority

The details for the following fields can be obtained from the certification authority:

CA identifier

CA certificate fingerprint (MD5)
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SCEP
Menu path: Setup > Network > SCEP Client (NDES) > SCEP

Here, you can give information regarding the SCEP server used.

SCEP server URL: Address of the SCEP server. Examples: http://myserver.mydomain.com/certsrv/mscep/
mscep.dll (Windows Server 2019); http://myserver.mydomain.com/certsrv/mscep (before Windows Server 2019)

Proxy server for SCEP requests: Proxy server in the format host:port . If this field is empty, no proxy will be 
used.

Challenge password: Password for queries.

Certificate renewal period (days): Time interval before certificate expiry after which the certificate renewal 
procedure is started. (Default: 30)

Certificate expiry check interval (days): Specifies how often the certificate is checked against its expiry date. 
(Default: 1)

For more information, see the how-to Providing the SCEP Server Data. See also Configuration of the SCEP Client.

Because of the need to enter a fingerprint (CA root certificate) and the Challenge password (SCEP server), 
the configuration process is somewhat complicated. Ideally, it should be set up in the UMS as a profile and 
distributed to the devices. At the same time, the certificate cannot yet be used for communication 
purposes.



As an example, a certificate is valid until 31.12. of a year. If the period for renewal is set to 10 days, a new 
certificate will be requested for the first time on 21.12. of the same year.


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Routing
Menu path: Setup > Network > Routing

Here, you can enter additional routes if necessary.

Enable: (default: disabled)

☑ Routing is enabled.

Default gateway: Gateway that routes the packets to the target network

Interface: The network interface via which the route is to run, e.g. eth0

Routing [1-5]
Enable: (default: disabled)

☑ This route is enabled.

Network route / host route: Type of route

Network route: The routing relates to a (sub) network
Host route: The routing relates to the address of a computer

Network / host IP or name: The address of the network (for a network route) or the IP address or the name of the 
host (for a host route)

Network mask: Mask for the desired IP range, e.g. 255.255.255.0

Gateway: Gateway that routes the packets to the target network

Interface: The network interface via which the route is to run, e.g. eth0
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Hosts
Menu path: Setup > Network > Hosts

If no DNS (Domain Name Service) is used, you can specify a list with computers in order to allow translation 
between the fully qualified host name, the short host name and the IP address.

To manage the list of computers, proceed as follows:
Click  to create a new entry.
Click  to remove the selected entry.
Click  to edit the selected entry.
Click  to copy the selected entry.

Add
IP address: IP address of the host you would like to add
Fully qualified host name: Host name along with the domain, e.g. mail.example.com

Short host name: E.g. mail
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Network Drives
Menu path: Setup > Network > Network Drives

Here, you can configure both the drives that are to be connected during booting and the associated login data.

_____

NFS (see page 780)
Windows Drive (see page 782)
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NFS
Menu path: Setup > Network > Network Drives > NFS

In this area, you can integrate network drives using the Network File System (NFS).

You can find a sample configuration at the end of this page.

To manage the network drives, proceed as follows:
Click  to create a new entry.
Click  to remove the selected entry.
Click  to edit the selected entry.

Click  to copy the selected entry.

Add

Enabled: Here, you can enable and disable configured entries.
☑ The network drive will be integrated. (default)
Local Mount Point: The local directory under which the server directory is to be visible (default: /

nfsmount )
Server: NFS server that exports the directory

Directory name: Path under which the NFS server exports the directory

Sample configuration entry
The picture belows shows a sample configuration entry.

For Server, you can provide an IP address, a hostname or a Fully-Qualified Domain Name 
(FQDN).



In both the Local Mount Point and Directory Name only /  (Linux/Unix-style forward slash) is permitted 
as a path separator.


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Windows Drive
Menu path: Setup > Network > Network Drives > Windows Drive

In this area, you can integrate network drives shared by Windows as well as those from Linux/Unix servers via the 
SMB protocol (Samba).

You can find a sample configuration at the end of this page.

To manage the drive list, proceed as follows:
Click  to create a new entry.
Click  to remove the selected entry.
Click  to edit the selected entry.

Click  to copy the selected entry.

Clicking  will bring up the Add dialogue, where you can define the following settings:

Enabled: Defines whether the configuration entry will be applied.
☑ The network drive will be integrated.
Local Mount Point: The local directory under which the server directory is to be visible 
(default:  /smbmount )
Server: The IP address, Fully-Qualified Domain Name (FQDN) or NetBIOS name of the server.
Share Name: Path name as exported by the Windows or Unix Samba host.
User name: User name for your user account on the Windows or Unix Samba host.
Password: Password for your user account on the Windows or Unix Samba host.
User writable
☑ The user can not only read but also write directory contents. Otherwise, only the local root user 
is able to do this.
☐ The user can only read directory contents. (default)

Sample configuration entry
The following picture shows a sample configuration entry.

If a NetBios name is provided for Server, make sure it is not preceded by slashes, e.g. \\myComputer

(wrong) vs. myComputer  (correct).



For Local Mount Point, only /  (Linux/Unix-style forward slash) can be used as a path separator. Note 

that if you enter, for example, \smbmount  as a moint point, a directory called \smbmount  will be 

created, because \  is a legal character in Linux directory names. For Share Name, however, /  (Linux/

Unix-style forward slash) or \  (Windows-style backward slash) can be used as a path separator.


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Proxy
Menu path: Setup > Network > Proxy

Here, you can select the communication protocols for which a system-wide proxy server is to be used.

Direct connection to the Internet: The endpoint device is directly connected to the Internet. No proxy is used.

Manual proxy configuration: One or more proxies are used.

FTP proxy / port: FTP proxy server and port

HTTP proxy / port: HTTP proxy server and port

SSL proxy / port: SSL proxy server and port

SOCKS host / port: Socks proxy server and port

SOCKS protocol version: Selects the SOCKS protocol version. (Default: SOCKS v5)

No proxy for: List of computers to which the endpoint device is to connect directly, separated by commas (Default: 
localhost, 127.0.0.1)

Proxy realm for browser: Area in which the browser authenticates itself for the proxy. Together with the user name 
and password, this information is necessary for authentication. See also Browser Global Proxy (see page 390)

Use passthrough authentication

☑ The temporarily saved login information (user name and password) will be used to log in to the proxy server.

☐ The login information entered under User name and Password will be used to log in to the proxy server. 
(Default)

User name: User name for the proxy login

Password: Password for the proxy login
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Devices
Menu path: Devices > Hardware Info

 Click on Hardware Info to view the system information for your IGEL device.

In this area, you can make settings for the following options:

Printer (see page 786)
Storage Devices (see page 806)
Bluetooth (see page 811)
USB Access Control (see page 812)
Unified Communications (see page 815)
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Printer
Menu path: Devices > Printers

You can set up a printer for the thin client here.

The printers must be set up under Devices > Printer > CUPS > Printers and must be enabled there for mapping in 
sessions.

CUPS (see page 787)
LPD (see page 793)
TCP/IP (see page 794)
ThinPrint (see page 800)
PrinterLogic (see page 804)

Because the thin client merely places incoming print jobs in a queue, you need to install the printer on the 
server. Please note that you will need to be logged in as administrator to the terminal to which the printer 
is connected.


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CUPS
Menu path: Setup > Devices > Printers > CUPS

The Common UNIX Printing SystemTM (or CUPS) is the software that allows you to print from within applications, 
e.g. from this web browser.

CUPS converts the page descriptions produced by the application, e.g. "Insert Paragraph", "Draw Line" etc., into 
data that can be read by the printer, and then sends this information to the printer.

With the appropriate configuration, CUPS can use printing devices via the following connections:

Parallel (LPT 1, LPT 2)
Serial (COM1, COM2, USB COM1, USB COM2 – with a USB-to-serial adapter)
USB (1st and 2nd USB printer)
Network (TCP/IP, LPD, IPP, SMB)

Default Paper Size: Specify a default paper size for print jobs.

Possible values:

Letter
Legal
Executive
A5
A4
A3
Autodetect

Additional information on CUPS printers can be found under CUPS: Mapping Local Printer to Citrix or RDP Sessions
and Installing a Custom CUPS Driver. 

Printers (see page 788)
IPP Printer Sharing (see page 792)
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Printers
Menu path: Setup > Devices > Printer > CUPS > Printers

Printers can be created and edited here.

 Click on  to open the Add dialog.

 In the edit dialog, specify a Printer name which begins with a letter.

General

Printer port: Interface type for locally connected printers or the network protocol for network printers.

Possible values:

"Parallel port printer" (default)
"Serial port printer"
"USB printer"
"LPD network printer"
"TCP network printer"
"IPP network printer"
"SMB network printer"

Manufacturer: List of possible printer manufacturers. When you select a manufacturer here, the relevant selection 
of models will be provided under Printer names. (Example: Generic)

Printer names: List of possible printer models. (Example: PostScript Printer)

Default paper size: Set the printer-specific paper size that you would like to use as a default. 
Possible values:

"Letter"
"Legal"
"Executive"
"A5"
"A4"
"A3"
"System setting"

Share printer

☑ You can access the printer via the network if you have enabled the print server under IPP Printer Sharing; see 
IPP Printer Sharing (see page 792). (Default)

Mapping in sessions

Map printer in NX sessions

☑ The printer is available in NX sessions.

Depending on the chosen Printer port type, different parameters have to be configured, see Settings to Be 
Configured for Each Printer Port Type (see page 790).


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☐ The printer is not available in NX sessions. (Default)

Map printer in Parallels Client sessions

☑ The printer is available in Parallels Client sessions.

☐ The printer is not available in Parallels Client sessions. (Default)

Map printer in ICA sessions

☑ The printer is available in ICA sessions. (Default)

Map printer in RDP sessions

☑ The printer is available in RDP sessions. (Default)

Use Windows driver name from list

☑ A driver name from the following list will be used. (Default)

Manufacturer: List of possible printer manufacturers. (Example: Generic)

Model: List of possible models. (Example: Generic PostScript)

Use custom Windows driver name

☑ Enter the name of your driver here if it is not mentioned in the list above.

Printer driver: Windows driver name for the printer.

When printing in ICA and RDP sessions, the print data are normally prepared for the printer model by the Windows 
printer driver and are passed unchanged from the device to the printer. An exception is made when using the 
Windows driver in ICA sessions, Manufacturer is set to "Generic" and Model is set to "Generic PostScript." In this 
case, the print data are prepared on the device with the help of the printer driver defined above under Printer for 
the printer model. This requires device resources.

The name must not contain “;” or “:”.
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Settings to Be Configured for Each Printer Port Type

Menu path: Setup > Devices > Printer > CUPS > Printers

Here, you can find the parameters available for configuration for each Printer Port (Setup > Devices > Printer > 
CUPS > Printers > Add > General > Printer port).

Printer Port: "Parallel port printer"

Parallel device:

"LPT1"
"LPT2"

Detect devices...: Opens a dialog for selecting the available devices.

Printer Port: "Serial port printer"

Serial device:

"COM1"
"COM2"
"USB COM1"
"USB COM2"

Detect devices...: Opens a dislog for selecting the available devices.

Baud rate:

"9600"
"19200"
"38400"
"57600"
"115200"

Character size:

"5"
"6"
"7"
"8"

Parity:

"None"
"Even"
"Odd"

Flow control:

"None"
"XON/XOFF"
"RTS/CTS"
"DTR/DSR"
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Printer Port: "USB printer"

USB device:

"1st USB printer"
"2nd USB printer"

Detect devices...: Opens a dialog for selecting the available devices.

Printer Port: "LPD network printer"

LPD print server: Host name or IP address of the remote LPD printer.

LPD queue name: Name of the LPD printer queue.

Printer Port: "TCP network printer"

TCP print server: Host name or IP address of the remote TCP/JetDirect/Socket printer.

TCP port: TCP port number. (Default: 9100)

Printer Port: "IPP network printer"

IPP URI: URI of the IPP print server. Example: ipp://myprinter.example.com/printers/printer1

Printer Port: "SMB network printer"

SMB server: NetBIOS host name of the SMB server.

SMB workgroup: Workgroup or domain name. (Optional)

SMB printer: Share name of the printer.

SMB port: SMB port number. (Default: 0, which stands for standard ports 139 and 445)

Use Kerberos authentication

☑ Kerberos credentials are used for authentication on condition that Active Directory/Kerberos Logon has been 
configured. See Active Directory/Kerberos (see page 832).

☐ Kerberos credentials are not used for authentication. (Dafault)

Use passthrough authentication

☑ Single sign-on authentication is used on condition that Active Directory/Kerberos Logon or IGEL Shared 
Workplace have been configured. See Active Directory/Kerberos (see page 832) and Shared Workplace (see page 835).

☐ Single sign-on authentication is not used. (Default)

SMB user name: User name used for authentication. (Optional)

SMB password: Password used for authentication. (Optional)
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IPP Printer Sharing
Menu path: Devices > Printer > CUPS > IPP Printer Sharing

The IPP (Internet Printing Protocol) offers the following configuration options:

Network or host for sharing local printers: Access to the printer is possible from this network or host. 

Possible options:

"None"
"Local network": Allows printing on the local device from the local network.

"Global": Allows printing on the local device from the global network.

This can also be given in the form 192.0.2.*  or 192.0.2.0/24  or 

*.domain.com  or 192.0.2.1  or host.domain.com .





Devices

IGEL OS Reference Manual   793 / 897

•

•
•

•
•

•
•
•
•

•

LPD
Menu path: Setup > Devices > Printers > LPD

LPD printers are used by the BSD printing system and are also supported by Windows servers.

Enable LPD Print Server
☑ Local printers are provided in the network as LPD printers. The thin client is made the LPD print 
server. The CUPS printers defined under Printers (see page 788) can be addressed under their printer 
name as a queue name via the LPD protocol. (default)
Print Filter:

Automatic: Attempts to automatically recognize whether or not the print data need to be 
prepared by the local printer driver.
None: The print data are always forwarded unchanged to the printer.

Max. Consurrent Connections: Limits the number of print jobs that can be accepted at the same 
time.

Unlimited
1
2
3

Restrict LPD Access - Specifies the sub-networks or hosts from which print jobs can be accepted.

 Click on  to add an LPD network or a host to the list.
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TCP/IP
Menu path: Setup > Devices > Printers > TCP/IP

You can assign printers connected to your device to a TCP/IP port.

_____

COM 1 / 2 (see page 795)
Additional Serial Ports (see page 796)
LPT 1 (see page 798)
USBLP 1 (see page 799)



Devices

IGEL OS Reference Manual   795 / 897

•

•
•

•
•

•
•
•

•
•
•

•
•

•
•
•
•

•

•

•

COM 1 / 2
Menu path: Setup > Devices > Printers > TCP/IP > COM 1

Activate TCP/IP printers on this port
☑ Maps the interface defined below in a TCP/IP port.
☐ Disabled (default)
TCP/IP port number: Port on which the interface is to be mapped (default: 3004).
Poll criterion: Criterion according to which the interfaces are mapped.

Always: Maps constantly without polling.
Online: Maps only if the printer is switched on.

Poll frequency: Amount of time between polls (default: 1 sec)
Speed: Input and output speed (default: 9600)
Parity: Parity bits that are to be used. Possible values:

None
Even
Odd

Stop bits: Use up to two stop bits. (default: 1)
Word width: Sets the number of bits used per byte.

5
6
7
8

Use RTS/CTS flow control
☑ Hardware flow control will be used.
☐ Not used (default)
Use XON/XOFF flow control
☑ Software flow control by sending start/stop signs will be used.
☐ Not used (default)
Use DSR flow control
☑ Hardware flow control with DSR for output will be used.
☐ Not used (default)
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Additional Serial Ports
Menu path: Setup > Devices > Printers > TCP/IP > Additional Serial Ports

TCP/IP printers on additional serial ports

 Click on to add TCP/IP printers to the list.
A mask with the following settings options will open:

Activate TCP/IP printer on this interface
☑ Maps the interface defined below in a TCP/IP port.
☐ Disabled (default)
Device name: The printer can be connected to one of the following connections, provided that 
they are available on the device:

USB COM1
USB COM2
Perle COM1
Perle COM2

Search for devices...: Opens a dialog allowing you to select the device file. 3 device files are 
available for each device; the Designation column shows the type of device file:

(GENERIC) [device designation]: Generic type. The name of the device file ends in a 
consecutive number which depends on the boot procedure or the order of insertion. 
Example: /dev/ttyUSB0

(BY PORT) [device designation]: According to USB port. The device file is in the /dev/

usbserial/  directory. The name of the device file ends in the number of the USB port 

that the device is plugged into. Example: /dev/usbserial/ttyUSB_P12

(BY USBID) [device designation]: According to USB ID. The device file is in the /dev/

usbserial/  directory. The name of the device file ends as follows: _V[Vendor 

ID]_P[Product ID] . Example: /dev/usbserial/ttyUSB_V067b_P2303
TCP/IP port number: Port on which the interface is to be mapped (default: 9100).
Poll criterion: Criterion according to which the interfaces are mapped.

Always: Maps constantly without polling.
DSR (M1): Maps only if the relevant line is set by the serial device.
DCD (M5): Maps only if the relevant line is set by the serial device.

Poll frequency: Amount of time between polls (default: 1 sec)
Speed: Input and output speed (default 9600 baud).
Parity: Parity bits that are to be used. Possible values:

None
Even
Odd

Stop bits: Use up to two stop bits. (default: 1)

Data are forwarded bidirectionally at serial interfaces. This means that other serial devices 
such as barcode scanners or scales can be operated too.


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Word width: Sets the number of bits used per byte.
5
6
7
8

Use RTS/CTS flow control
☑ Hardware flow control will be used.
☐ Not used (default)
Use XON/XOFF flow control
☑ Software flow control by sending start/stop signs will be used.
☐ Not used (default)
Use DSR flow control
☑ Hardware flow control with DSR for output will be used.
☐ Not used (default)
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LPT 1
Menu path: Setup > Devices > Printers > TCP/IP > COM 1

Activate TCP/IP printers on this interface
☑ Maps the interface defined below in a TCP/IP port.
☐ Disabled (default)

TCP/IP port number: Port on which the interface is to be mapped (default: 3004).
Poll criterion: Criterion according to which the interfaces are mapped.
Always: Maps constantly without polling. 
Online: Maps only if the printer is switched on.
Poll frequency: Amount of time between polls (default: 1 sec)
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USBLP 1
Menu path: Setup > Devices > Printers > TCP/IP > USBLP 1

Activate TCP/IP Printers on this Port:
☑ Maps the interface defined below in a TCP/IP port.
☐ Disabled (default)

TCP/IP Port Number: Port on which the interface is to be mapped (default: 3004).
Poll Criterion: Criterion according to which the interfaces are mapped.
Always: Maps constantly without querying. 
Online: Maps only if the printer is switched on.
Poll Frequency: Amount of time between status queries (default: 1 sec)
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ThinPrint
Menu path: Devices > Printer > ThinPrint

ThinPrint allows the bandwidth provided for the transfer of print jobs to be reduced depending on the resources 
available. The ThinPrint client prints either on printers connected to a local interface (serial, parallel or USB), on an 
LPD network printer or on a CUPS printer defined on the thin client.

In this area, you will find the following parameters:

Port Number: Port number via which the ThinPrint daemon will communicate (default: 4000).

Bandwidth: A bandwidth value (in bits per second) which is lower than or equal to the value specified on the 
ThinPrint server. A higher value, the disabling of client control or no entry at all means that the ThinPrint server 
values will be used (default: 0).

Open Printer Interval: Maximum waiting time in seconds if a printer is unavailable (default: 165).

Open Printer Tries: Number of attempts to contact a printer in order to start a print job (default: 100).

Printer (see page 801)
Connection Service (see page 802)
Encryption (see page 803)

Make sure that the port number on the ThinPrint client and the ThinPrint server is the same 
(communication will otherwise not be possible).





Devices

IGEL OS Reference Manual   801 / 897

Printer
Menu path: Devices > Printer > ThinPrint > Printer

In this area, the List of ThinPrint Printers is shown.

The page provides an overview of pre-configured ThinPrint printers.

 Click on  to add a printer to the list.
A mask with the following settings options will open:

Active: Indicates whether or not the printer is visible.

Printer Name: Name under which the printer can be addressed.

Printer Class Name: Name of the printer class - optional, max. 7 characters without spaces

Device: A device file or the printer name, e.g. /dev/ttyS1 (COM2).

Detect Devices...: Opens a mask for selecting the available devices.

Print Retries: Number of attempts to contact a printer in order to start a print job (default: 10).

Default: Defines the selected device as the default printer.



Devices

IGEL OS Reference Manual   802 / 897

•
•

•

•
•
•
•
•
•

Connection Service
Menu path: Setup > Devices > Printers > ThinPrint > Connection Service

By default, the .print client waits for incoming connections from the print server. If the thin client is unavailable via 
the network from the print server, the connection can also be established from the thin client .

Connection Service ModeMode:
Listen Mode: Receive print jobs without Connection Service. The .print client heeds 
incoming connections.
Static Mode: Use connection to receive print jobs. The .print client establishes a connection 
to the .print Connected Gateway.
Both: Use both modes.

Connection Server Address: IP address of the computer on which the connection service runs.
Connection Service Port number: The client port of the .print Connected Gateway (default: 4001)
Client D: The ID of the client must be unique.
Connection Service Authentication key: A value that is defined on the connection server.
Connection Service Retry Interval: Waiting time in seconds until another connection attempt is 
made if the .print Connection Service is unavailable (default: 300)
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Encryption
Menu path: Setup > Devices > Printers > ThinPrint > Encryption

In this area, you can enable encryption for print jobs.

Enable SSL Encryption:
☑ The client can receive print jobs via an encrypted connection.
☐ Disabled (default)
SSL Root Certificate: Path name of the file that receives the root certificate in the .pem format.
SSL Client Certificate: Path name of the file that receives the client certificate in the .pem format.
SSL Client Certificate Password
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PrinterLogic
Menu path: Setup > Devices > Printer > PrinterLogic

If you are using PrinterLogic to provision printers, you are replacing the previous direct printer management from 
the Setup.

Instead, the administrator creates a website (on printercloud.com31) with the respective printers of the location(s). 
The setup user/administrator can then select the desired printers via the browser.

 

Manage printers by Printer Installer client:

☑ The printers will be managed by the Printer Installer client and not by the IGEL CUPS functionality (IGEL Setup > 
Devices > Printers > CUPS).

☐ No Printer Installer client is activated. The printers will be managed by the IGEL CUPS functionality. (default)

HomeURL protocol

Possible options:

https://
http://

HomeURL hostname: The host name of the web server running the printer cloud. Default: printercloud.com

Authorization code: Authorization code for the printer cloud; generated by the administrator.

Mapping in sessions
ICA sessions

☑ Include printers managed by PrinterLogic in ICA sessions. (default)

RDP sessions

☑ Include printers managed by PrinterLogic in RDP sessions. (default)

NX sessions

☑ Include printers managed by PrinterLogic in NX sessions. 

☐ Don't printers managed by PrinterLogic in NX sessions. (default)

Parallels client sessions

☑ Include printers managed by PrinterLogic in Parallels client sessions.

☐ Don't include in Parallels client sessions. (default)

Show CUPS printers: Displays a list of installed printers that can be deleted.

If you have successfully set up the printer cloud, this tray icon  appears in the system tray.


http://printercloud.com
http://printercloud.com
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The PrinterLogic menu

Right-click the icon   to get the following options:

Add Printers...: Opens the PrinterCloud in the browser. The installed printers are listed and can be 
installed via double-click.
Pull Printing...: The print job is held and released by the user at each print device that supports 
this function.

Print Job Management...: Manages your print jobs.
Secure Print Settings...: Opens settings for secure printing. 

Refresh Configurations
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Storage Devices
Menu path: Setup > Devices > Storage Devices

Configure your hotplug storage devices here.

Show attached storage devices: Shows a list with registered storage devices.

_____

Storage Hotplug (see page 807)
Options (see page 809)
DriveLock (see page 810)



Devices

IGEL OS Reference Manual   807 / 897

•
•

Storage Hotplug
Menu path: Setup > Devices > Storage Devices > Storage Hotplug

In this area you can set up the connection of hotplug storage devices to the thin client. These can be USB mass 
storage devices or MMC card readers for example.

Following file systems are officially supported: 

ext2, ext3, ext4 Standard Linux file systems

squashfs a packed read-only file system

vfat supports all FAT variants (except extFAT)

udf CDROM/DVD file systems

ntfs supported with ntfs-3g (Fuse)

You can change the following settings:

Storage Hotplug

☑ Hotplug storage devices will be be mounted and unmounted automatically. When mounted, a hotplug storage 
device can be used in sessions like ICA, RDP, VMware Horizon, or in local applications like browser / PDF viewer or 
media player.

☐ Hotplug storage devices will be be mounted and unmounted automatically. (Default)

Default permission: Default access rights for hotplug storage devices.
Possible values:

Read only
Read/Write

Client Drive Mapping: Defines the creation of drives in ICA sessions, RDP sessions or Horizon sessions. The 
mounting of hotplug storage devices to the local file system is not influenced by this parameter. 
Possible values:

•
•

•

Before you unplug a hotplug storage device from the thin client, you must safely remove it. Otherwise, 
data on the hotplug storage device can be damaged. Depending on the configuration, there is one or 
several possibilities to safely remove a hotplug storage device:

Click on  in the task bar. The taskbar is not available in a fullscreen session.
Click on  in the in-session control bar. Depending on the configuration, the in-session 
control bar may be available in a fullscreen session. For further information, see In-session 
Control Bar (see page 695).
Function Accessories > Disk Removal with further starting possibilities; amongst other 
things, a hotkey can be defined here.
If the following warning is displayed: Volume(s) still in use. Dont' remove the device., 
then the hotplug storage device must not be removed. First, exit the program concerned 
or close all files or directories that reside on the hotplug storage device.


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Dynamic: Drives are created automatically in a session when a hotplug storage device is connected 
to the thin client. When the device is removed, the corresponding drive is removed automatically.
Static: The drives in a session are predefined by the parameters described under  Static Client 
Drive Mapping (see page 808).

Static Client Drive Mapping
Private drive letter for each storage drive

☑ A drive letter is assigned to each hotplug storage device.

☐ A single drive letter will be generated for all hotplug storage devices and each hotplug storage device will be 
assigned a sub-directory. (default)

Number of drives: The maximum number of hotplug storage devices that can be used simultaneously in the 
session.

Start storage drives with this drive letter: Letter that is assigned to the first hotplug storage device if automatic 
drive mapping is enabled (default: A). Further hotplug storage devices are assigned the next letter alphabetically.

ICA read access for storage hotplug devices: Specifies whether read access to hotplug storage devices is allowed 
in an ICA session.

Possible values:

Yes: Read access is allowed.
No: Read access is not allowed.
Ask user: Read access can be allowed on request.

ICA write access for storage hotplug devices: Specifies whether write access to hotplug storage devices is allowed 
in an ICA session.

Possible values:

Yes: Write access is allowed.
No: Write access is not allowed.
Ask user: Write access can be allowed on request.

Notification
Hotplug beep

☑ A signal tone will be heard when connecting and disconnecting hotplug storage devices. (Default)

Hotplug message

☑ Hotplug messages will be shown when connecting and disconnecting hotplug storage devices. (Default)

Timeout: Period of time in seconds after which the window with the hotplug messages is hidden. If the parameter is 
set to No timeout, the window will be shown until it is closed manually. (Default: 15)

You will find further settings options in the HDX / ICA Global setup area under Drive mapping (see page 66), in the RDP 
Global setup area under Drive mapping (see page 130), in the Devices area under USB access control (see page 812).

When this number is reached, no additional hotplug storage devices will be assigned.
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Options
Menu path: Setup > Devices > Storage Devices > Options

In this area, you can specify a directory in which external storage devices are accessible to the user. The devices are 
always mounted in the /media  directory.

User browse directory

☑ The directory defined under Browse directory is linked to the /media  directory. (Default)

Browse directory:/: Local directory in which the devices can be found. (Default: userhome/media )

Support for built-in floppy drives

☑ Built-in disk drives are active.

☐ Built-in disk drives are disabled (default)

This option is only valid for drives which are not connected via USB.
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DriveLock
Menu path: Devices > Storage Devices > DriveLock

DriveLock allows the control of your USB devices and helps to prevent BadUSB attacks. For details, see https://
www.drivelock.com/.

Enable DriveLock agent

☑ DriveLock agent is activated.

DES server URL: URL of the DriveLock Enterprise Service server used for the distribution of policies

Tenant: Name of the DES user group to which the policy should apply. (Default: root)

https://www.drivelock.com/
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Bluetooth
Menu path: Devices > Bluetooth

In this area, you can set up a Bluetooth service.

Bluetooth

☑ The Bluetooth service is active. The Bluetooth Tool can be used.

☐ The Bluetooth service is inactive. The Bluetooth Tool cannot be used. (Default)

Tray Icon

☑ A Bluetooth icon will be shown in the system tray. You can launch the Bluetooth Tool by double-clicking on the 
Bluetooth icon. Right-clicking on the Bluetooth icon will bring up an overview as to which Bluetooth devices are 
connected to the thin client and you can enable or disable Bluetooth.

☐ A Bluetooth icon will not be shown in the system tray. (Default)

Details of the settings options for Bluetooth can be found under Accessories > Bluetooth Tool (see page 626).

Here you can find information on the Bluetooth Wizard (see page 9).
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USB Access Control
Menu path: Devices > USB Access Control

You can allow or prohibit the use of USB devices on your endpoint. Specific rules for individual devices or device 
classes are possible. For an example, see How to Configure USB Access Control.

Enable

☑ USB access control is enabled and the following settings can be configured.

☐ USB access control is inactive. (Default)

Default rule: Specifies whether the use of USB devices is allowed or prohibited.

Allow
Deny

Default permission: Default access rights for USB devices.

Read Only
Read/Write

Class Rules
Class rules apply to USB device classes.

 Click on  to create a new rule.
An input mask with the following options will open:

Rule: Specifies whether the use of the device class defined here is allowed or prohibited.

Class ID: Device class for which the rule should apply. (Examples: Audio, Printers, Mass Storage).

Name: Name of the rule

Device Rules
Device rules apply to specific USB devices.

 Click on  to create a new rule.
An input mask with the following options will open:

Rule: Specifies whether the use of the device defined here is allowed or prohibited.

The activation of USB Access Control and setting the Default rule to Deny will block the use of USB 
devices locally and in the session and, thus, might disable devices needed for the users. Therefore, activate 
the USB access control only if your security policy requires that. In this case, set Default rule to Deny and 
configure Allow rules for the required USB devices and USB device classes. 
It is recommended to make settings for USB Access Control as the last step in the device configuration. 
Before activating the USB access control, check that all your other settings for printers, Unified 
Communication, USB redirections, mapping settings for USB devices are working as expected.
Note that the feature does not disable a USB port physically, i.e. power delivery will still work.


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Vendor ID: Hexadecimal ID of the device manufacturer

Product ID: Hexadecimal ID of the device

Getting USB Device Information

To find out the Class ID, Subclass ID, Vendor ID and Product ID of the connected USB device, you can use 
the System Information tool. For further information, see Using “System Information” Function (see page 
634).
System Information example:

Alternatively, you can use the command lsusb  (or lsusb | grep -i [search term] ) in the 
terminal.
Example for lsusb :


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Device uuid: Universal Unique Identifier of the device

Permission: Authorizations for access to the device
Possible values: 

Global setting: The default setting for hotplug storage devices is used; see the Default permission
parameter under Devices > Storage Devices > Storage Hotplug.
Read only
Read/Write

Name: Name of the rule

Further setting options can be found under Storage Hotplug (see page 807).
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Unified Communications
Jabra (see page 816)
EPOS Audio (see page 819)
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Jabra
Jabra Xpress (see page 817)
Options (see page 818)
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Jabra Xpress
Menu path: Devices > Unified Communications > Jabra > Jabra Xpress

Jabra Xpress is a solution for the remote mass-deployment of Jabra USB headsets that enables creating and 
deploying packages containing a configuration of settings, firmware updates, etc. for Jabra devices. For more 
information, see https://www.jabra.com/supportpages/jabra-xpress#/. 

Device Dashboard URL: URL of the dashboard server of the Jabra device.

Package: File name of the Jabra Xpress package. Example:  xpress_package_20190109_144111.zip .

Source URL: URL to the directory containing the Xpress package. Example:  https://172.30.92.1:8443/

ums_filetransfer/  

Check SSL certificate: Determines if the SSL certificate is checked. (Default: Enabled)

User name: User name for accessing the Xpress package that resides under the Source URL.

Password: Password for accessing the Xpress package that resides under the Source URL.

For detailed information on how to deploy a Jabra Xpress package, see How to Deploy a Jabra Xpress 
Package.



As a Source URL, you can specify any server, e.g. FTP(S) or HTTP(S), where you have placed the Xpress 
package downloaded from the Jabra Xpress portal. 
If you want to use the UMS as a source location, your Jabra ZIP archive has to be registered as a file object 
in the UMS, see Registering a File on the UMS Server. See also UMS and Devices: File Transfer.



Disable SSL certificate checking if you are using a self-signed certificate.

If you want to use the UMS as a source location for your Xpress packages, Check SSL certificate has to be 
deactivated. 



•

•

•

For the optimal performance of Jabra headsets (esp. relevant if Skype for Business is used), activate:
in Citrix sessions: HDX Realtime Media Engine under Sessions > Citrix > Citrix Global > 
Unified Communications > Skype for Business;
in VMware Horizon sessions: Virtualization Pack Skype for Business under Sessions > 
Horizon Client > Horizon Client Global > Unified Communications > Skype for 
Business;
in RDP sessions: Compression under Sessions > RDP > RDP Global > Performance.



https://www.jabra.com/supportpages/jabra-xpress#/
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Options
Menu path: Devices > Unified Communications > Jabra > Options

☑ Suspend on idle: Determines if the wireless Jabra USB audio device is set to the offline state after 5 seconds of 
idle time. (Default)
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EPOS Audio
EPOS Connect (see page 820)
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EPOS Connect
Menu path: Devices > Unified Communications > EPOS Audio > EPOS Connect

Here you can set up EPOS Connect, a client application that connects with EPOS Manager and sends device 
information to it. EPOS Manager performs the following tasks for the EPOS devices that are connected to the 
endpoint:

Firmware updates
Remote asset management
Remote configuration

Enable EPOS Connect

☑ The EPOS Connect client is enabled.

Tenant ID: The customer-specific system ID for your EPOS Manager installation.

Backend Endpoint: URL of EPOS Manager

Proxy: URL of the proxy that connects to EPOS Manager, if applicable. The proxy URL must be provided in the 
format [ADDRESS]:[PORT] .
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Security
Menu path: Setup > Security

In order to prevent unauthorized access to the thin client setup, it is important to set up an administrator password 
after the initial configuration. With an additional user password, you can allow the user to make limited changes to 
the configuration.

Further information can be found under Password - Restrict Access to IGEL OS Components (see page 824).

_____

Device Encryption (see page 822)
Password - Restrict Access to IGEL OS Components (see page 824)
Logon (see page 828)
Active Directory/Kerberos (see page 839)
Smartcard (see page 842)
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Device Encryption
Menu path: Security > Device Encryption

Device encryption mode
Possible options:

"Keep": If the device is encrypted, it stays encrypted. If it is not encrypted, it will not get encrypted.
"Activate": The device will be encrypted when the user enters the password for the first time. The 
re-encryption may take about 10 to 60 seconds; the duration depends on the hardware 
performance and the size of the Custom Partition.
"Deactivate": The device will be re-encrypted back to the default device encryption on the next 
boot. The re-encryption may take about 10 to 60 seconds.

Change password: Only applicable if device encryption is enabled. The user can change the password for device 
encryption.

Authentication type
Possible options:

"PW": Password authentication. In this version of IGEL OS, this is the only available authentication 
type.

Security level
Possible options:

"Auto, constant-time": The password aggregation function that fits best with the defined Target 
time delay (ms) is selected.
"Auto, at least level": The security level will be at least as high as the value selected by Password 
aggregation function; if the Target time delay (ms) allows for a higher security level, the higher 
security level will be used.
"Manual": The Password aggregation function can be set manually, irrespective of the delay time 
specified by Target time delay (ms).

Target time delay (ms): Maximum time that should be consumed by the password aggregation function. This delay 
is effective when the user enters the device encryption password on boot or changes the device encryption 
password.

Password aggregation function: Security level of the encryption. 
Possible options:

"I: Argon2id, 8M/7 ops"
"II: Argon2id, 128M/3 ops"
"III: Argon2id, 256M/3 ops"
"IV: Argon2id, 512M/3 ops"
"V: Argon2id, 1024M/4 ops"
"VI: Argon2id, 128M/4 ops"

Minimum password length: Minimum number of characters the password must be composed of

Unwanted strings in password (comma separated): Comma-separated list of strings that must not be contained 
in the password
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The password must contain: Defines whether all of the subsequent minimum requirements (minimum amount of 
lower case letters etc.) must be fulfilled, or 2, or 3 of them.

all
2 of
3 of

Minimum amount of lower case letters

Minimum amount of upper case letters

Minimum amount of numbers

Minimum amount of special characters

Special characters allowed: List of all non-alphanumerical characters that are allowed in the password, without 
separators
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Password - Restrict Access to IGEL OS Components
The following article provides details on different authorization levels in IGEL OS, which you can configure 
to protect your endpoint devices against unwanted changes. You will learn the difference between the access for 
administrator and setup administrator, for user and setup user.

For a general overview on securing your devices, see Securing IGEL OS Endpoints. 

Menu path: Security > Password

You can assign four different authorization levels:

Administrator: The administrator has full access to the IGEL Setup.

Setup Administrator: A user to whom rights are assigned for minor administrative tasks. You specify which pages 
the setup administrator can edit under Accessories > Setup > Setup Administrator Permissions (see page 556).

Setup User: A user who can make some unlocked user settings in the IGEL Setup. You specify which pages the setup 
user can edit under Accessories > Setup > Setup User Permissions (see page 554).

•
•
•

The assignment of the administrator password is a prerequisite for all other rights assignments. Even if the 
administrator wants to leave the administration of the IGEL Setup to the setup administrator, the 
administrator password must be set.
An administrator password protects the following critical actions/areas from unauthorized access:

the reset to factory defaults (see page 33) in the boot menu
the local terminal (see page 543)
the virtual console access (see page 677).





Security

IGEL OS Reference Manual   825 / 897

•
•
•

•
•

User: This user has no access to the IGEL Setup. A user password is required in the following cases:

when logging on to the terminal session (see page 543)
when logging on to sessions (see Desktop Integration)
for unlocking the screenlock (see page 697)

If you have defined passwords for different authorization levels, a login window appears at the start of the IGEL 
Setup in which you can select an authorization level:

Administrator

Use password

☑ A password is needed to log in as administrator ( root ). 

A password is also needed for the user, the setup user, and the setup administrator.
The password is set by clicking Change Password.

☐ No password is needed to log in as an administrator. Also, no password is needed for the user ( user ), the setup 
user, and the setup administrator.*

Change Password

Sets a new password for the administrator ( root ).

When entering a password, ensure that the correct keyboard layout (see page 706) is enabled.

•

•

Effects on local terminal access

Setting an administrator password has the following effects on the access to local terminals:

For logging in as root , the administrator password must be entered.

Logging in as user  is no longer possible.


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Setup Administrator

Setup Administrator Access
This option is relevant if an administrator password is set.

☑ The setup administrator can access the areas of the IGEL Setup for which he has authorization. Further 
information can be found under Setup Administrator Permissions - Define Access to IGEL Setup Areas (see page 556).

A password is needed to log in as setup administrator.
The password is set by clicking Change Password.

☐ The setup administrator cannot access the IGEL Setup.*

Change Password
Sets a new password for the setup administrator.

Setup User

Setup User Access
This option is relevant if an administrator password is set.

☑ The setup user can access the areas of the IGEL Setup for which he has authorization. Further information can 
be found under Setup User Permissions - Define Access to IGEL Setup Areas (see page 554).

A password is needed to log in as a setup user.
The password is set by clicking Change Password.

☐ The user cannot access the IGEL Setup.*

Change Password
Sets a new password for the setup user.

•
•

However, you can allow access for user  by making the following settings:

Enable the registry key system.security.usershell  (Default: Disabled).
Set a user password.

For logging in as user , the user password will have to be entered. (See the "User" section of this page).
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User

Use Password
This option is relevant if an administrator password is set.

☑ The user ( user ) needs a password in order to log in to the device via the local terminal. The password is set by 
clicking Change Password.

☐ If an administrator password is set, the user ( user ) cannot log in to the device via the local terminal. If no 

administrator password is set, the user ( user ) can log in to the device via the local terminal without a password.*

Change Password

Sets a new password for the user ( user ).

User Account for Remote Access

Enable Login

☑ The remote user ( ruser ) can log in to the device via SSH. Further information can be found under SSH 
Access (see page 855).*

☐ Logging in via SSH is not possible.

Use Password
☑ A password is needed to log in via SSH.

☐ No password is needed to log in via SSH.*

Change Password

Sets a new password for the remote user ( ruser ).

*IGEL OS system default
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Logon
Menu path: Setup > Security > Logon

_____

IGEL Smartcard (see page 829)
Taskbar (see page 830)
Active Directory/Kerberos (see page 832)
Shared Workplace (see page 835)
Local User (see page 837)
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IGEL Smartcard
Menu path: Setup > Security > Logon > IGEL Smartcard

Login with IGEL smartcard

☑ You can log in to the device using a smartcard. Depending on the configuration, a password may also be needed. 
Sessions stored on the smartcard become available.

☐ The desktop can be used without an IGEL smartcard. (Default)

Enable IGEL smartcard without locking desktop
☑ Enables sessions stored on the smartcard after entering an optional password. The device is not locked – even 
without a smartcard.
☐ The device will be locked after the removal of the smartcard. (Default)

On smartcard removal, terminate 
This parameter is available if Enable IGEL smartcard without locking desktop is activated.
Possible options:

"All sessions": When the card is removed, all sessions are ended.
"Sessions originating from smartcard": When the card is removed, all sessions stored on the card 
are ended. Other sessions are not affected.

Company key:  A shared code for a smartcard and a device. The code entered must match the code stored on the 
IGEL smartcard. If two codes do not match, the IGEL smartcard cannot be used on this terminal.

Start application to write IGEL smartcards:

Smartcard personalization: Opens a window where you can set a login password and add sessions to the card.

For further information about the smartcard personalization function, see Using “Smartcard Personalization” 
function (see page 653).

For information on how to create IGEL smartcards via the UMS, see Authentication with IGEL Smartcard.

See also Smartcard Readers Supported by IGEL Smartcards.

Save the settings before starting to personalize the card.

Session configurations are stored on the card's integrated circuit, and the session can be used on any IGEL 
device that reads the card.



Smartcard personalization is possible via the local Setup only. The option is not available via the UMS.
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Taskbar
Menu path: Setup > Security > Logon > Taskbar

Taskbar settings for the login dialog

Show taskbar in login screen
☑ The taskbar will be shown during the login dialog. (default)
☐ The taskbar will not be shown during the login dialog.
Show clock
☑ The clock will be shown during the login dialog. (default)
☐ The clock will not be shown during the login dialog.
Show keyboard layout switcher
☑ The switch for the keyboard layout will be shown during the login dialog. (default)
☐ The switch for the keyboard layout will not be shown during the login dialog.
Show on-screen keyboard button
☑ The button for opening the on-screen keyboard is shown during the login dialog.
☐ The button for opening the on-screen keyboard is not shown during the login dialog. (default)
Start on-screen keyboard automatically
☑ The on-screen keyboard is open during the login dialog.
☐ The on-screen keyboard is not open during the login dialog. (default)
Show reboot button
☑ The button for rebooting the thin client is shown during the login dialog.
☐ The button for rebooting the thin client is not shown during the login dialog. (default)
Show shutdown button
☑ The button for shutting down the thin client is shown during the login dialog. (default)
☐ The button for shutting down the thin client is not shown during the login dialog.

Taskbar settings when the screenlock is active

Show taskbar in screenlock
☑ The taskbar is shown while the screen is locked. (default)
☐ The taskbar is not shown while the screen is locked.
Show clock
☑ The clock is shown while the screen is locked. (default)
☐ The clock is not shown while the screen is locked.
Show keyboard layout switcher
☑ The switch for the keyboard layout is shown while the screen is locked. (default)
☐ The switch for the keyboard layout is not shown while the screen is locked.
Show on-screen keyboard button
☑ The button for opening the on-screen keyboard will be shown while the screen is locked.
☐ The button for opening the on-screen keyboard will not be shown while the screen is locked. 
(default)
Start on-screen keyboard automatically
☑ The on-screen keyboard will remain open while the screen is locked.
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☐ The on-screen keyboard is not open while the screen is locked. (default)
Show reboot button
☑ The button for rebooting the thin client is shown while the screen is locked.
☐ The button for rebooting the thin client is not shown while the screen is locked. (default)
Show shutdown button
☑ The button for shutting down the thin client is shown while the screen is locked.
☐ The button for shutting down the thin client is not shown while the screen is locked. (default)
Show logoff button
☑ The button for logging off is shown while the screen is locked.
☐ The button for logging off is not shown while the screen is locked. (default)

There is no separate option for enabling/disabling network connection icons in the login dialog and/or on 
the locked screen. With Show taskbar in login screen and Show taskbar in screenlock enabled, they 
appear automatically if the option Enable tray icon is activated under Setup > Network > LAN Interfaces 
> Interface 1 (or Interface 2, Wireless) and/or under Setup > Network > Mobile Broadband (and/or 
VPN).



The network connection icons in the login dialog and on the locked screen serve for information purposes 
only and thus are inactive on clicking.


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Active Directory/Kerberos
Menu path: Setup > Security > Logon > Active Directory / Kerberos

In this area, you can enable local login to the thin client via the Kerberos protocol. Active Directory/Kerberos must 
be configured, see Active Directory/Kerberos (see page 839).

Login to Active Directory domain
☑ You can log in to the thin client via Active Directory.
☐ You cannot log in to the thin client via Active Directory. (Default)

Login Methods

Explicit:
☑ You can log in with a user name and password. (Default)
☐ You cannot log in with a user name and password. If logging in with a smartcard is set up, you 
can log in with a smartcard.
Remember last user name
☑ The login dialog will be prepopulated with the last user name that logged on. Explicit must be 
enabled for this.
☐ The login dialog will not be prepopulated. (Default)
Smartcard
☑ You can log in using a smartcard.
☐ You cannot log in using a smartcard. (Default)

Smartcard removal action: Specifies what action is performed when the smartcard via which the 
user is logged in is removed.
Possible actions:

Log off: The user is logged off from the thin client.
Lock thin client: The screen is locked.

Logout Shortcut Locations
The start options for the logoff function are specified here.

Start menu

☑ The session can be launched from the start menu.

Application Launcher

☑ The session can be launched with the Application Launcher.

The login can be used for single sign-on in a number of session types (ICA, RDP).

Select the smartcard type under Security > Smartcard > Middleware.
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Desktop

☑ The session can be launched with a program launcher on the desktop.

Quick start panel

☑ The session can be launched with the quick start panel.

Start menu's system tab

☑ The session can be launched with the start menu's system tab.

Application Launcher's system tab

☑ The session can be launched with the Application Launcher's system tab.

Desktop context menu

☑ The session can be launched with the desktop context menu.

Menu folder: If you specify a folder name or a path comprising a number of folder names separated by "/", a menu 
path will be created for the session. The menu path will be used in the start menu and in the desktop context menu.

Application Launcher folder: If you specify a folder name or a path comprising a number of folder names 
separated by "/", a menu path will be created for the session. The menu path will be used in the Application 
Launcher.

Desktop folder: If you specify a folder name or a path comprising a number of folder names separated by "/", a 
menu path will be created for the session. The menu path will be used for the program launcher on the desktop.

Password protection: Specifies which password will be requested when launching the session.
Possible values:

None: No password is requested when launching the session.
Administrator: The administrator password is requested when launching the session.
User: The user password is requested when launching the session.
Setup user: The setup user's password is requested when launching the session.

Hotkey

☑ The session can be started with a hotkey. A hotkey consists of one or more modifiers and a key.

Modifiers: A modifier or a combination of several modifiers for the hotkey. You can select a set key symbol/
combination or your own key symbol/combination. A key symbol is a defined chain of characters, e.g.  Ctrl .

These are the pre-defined modifiers and the associated key symbols:

(No modifier) =  None

 =  Shift
[Ctrl] =  Ctrl

Do not use [AltGr] as a modifier (represented as Mod5 ). Otherwise, the key that is configured as a hotkey 
with AltGr cannot be used as a regular key anymore. Example: If you configure [AltGr] + [E] as a hotkey, it is 
impossible to enter an "e".


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 =  Mod4

[Alt] =  Alt

Key combinations are formed as follows with  | :

Ctrl +   =  Ctrl|Super_L

Key: Key for the hotkey

When this keyboard key is used as a modifier, it is represented as Mod4 ; when it is used as a key, it 

is represented as Super_L .



To enter a key that does not have a visible character, e. g. the [Tab] key, open a terminal, log on as user

and enter xev -event keyboard . Press the key to be used for the hotkey. The text in brackets that 

begins with keysym  contains the key symbol for the Key field. Example: Tab  in (keysym 0xff09, 

Tab)


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Shared Workplace
Menu path: Setup > Security > Logon > Shared Workplace

Activate IGEL Shared Workplace
☑ You can log in to the thin client via IGEL Shared Workplace.
☐ You cannot log in to the thin client via IGEL Shared Workplace. (Default)
Skip lGEL Shared Workplace login if UMS server is unavailable
☑ If the UMS server is not available, the user can log in via Active Directory/Kerberos. In order to 
do this, logging in via Active Directory/Kerberos must be configured; further information can be 
found under Active Directory/Kerberos (see page 832).
☐ Logging in is only possible if the UMS server is available. (Default)
Remember last user name
☑ The login dialog will be prepopulated with the last user name that logged on.
☐ The login dialog will not be prepopulated. (Default)

Logout Shortcut Locations
The start options for the logoff function are specified here.

Start menu: If this option is enabled, the session can be launched from the start menu.
Application Launcher: If this option is enabled, the session can be launched with the Application 
Launcher.
Desktop: If this option is enabled, the session can be launched with a program launcher on the 
desktop.
Quick start panel: If this option is enabled, the session can be launched with the quick start panel.
Start menu's system tab: If this option is enabled, the session can be launched with the start 
menu's system tab.
Application Launcher's system tab: If this option is enabled, the session can be launched with 
the Application Launcher's system tab.
Desktop context menu: If this option is enabled, the session can be launched with the desktop 
context menu.
Menu folder: If you specify a folder name or a path comprising a number of folder names 
separated by "/", a menu path will be created for the session. The menu path will be used in the 
start menu and in the desktop context menu.
Path in the Application Launcher: If you specify a folder name or a path comprising a number of 
folder names separated by "/", a menu path will be created for the session. The menu path will be 
used in the Application Launcher.
Desktop folder: If you specify a folder name or a path comprising a number of folder names 
separated by "/", a menu path will be created for the session. The menu path will be used for the 
program launcher on the desktop.
Password protection: Specifies which password will be requested when launching the session.
Possible values:

None: No password is requested when launching the session.
Administrator: The administrator password is requested when launching the session.
User: The user password is requested when launching the session.
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Setup user: The setup user's password is requested when launching the session.
Hotkey:
☑ The session can be started with a hotkey. A hotkey consists of one or more modifiers and a 
key.
Modifiers: A modifier or a combination of several modifiers for the hotkey. You can select a set key 
symbol/combination or your own key symbol/combination. A key symbol is a defined chain of 
characters, e.g. Ctrl . Here, you will find the available modifiers and the associated key symbols:

(No modifier) = None

 = Shift
[Ctrl] = Ctrl

 = Super_L

[Alt] = Alt

Key combinations are formed as follows with | :

Ctrl +  = Ctrl|Super_L
Key: Key for the hotkey

To enter a key that does not have a visible character, e. g. the [Tab] key, open a terminal, 
log on as user  and enter xev -event keyboard . Press the key to be used for the 

hotkey. The text in brackets that begins with keysym  contains the key symbol for the 

Key field. Example: Tab  in (keysym 0xff09, Tab)


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Local User
Menu path: Setup > Security > Logon > Local User

Login with local user password

☑ Upon the start of the device, a login screen is shown and authentication with a local user password is enabled. A 
password specified under Set password is deployed to log in. This password will also be used for User Interface > 
Screenlock / Screensaver > Options > Local user password (previously called Screenlock password), 
see Options (see page 700).
If both Active Directory (AD) login (see page 832) and login with local user password are enabled, you can choose on 
the login screen which login method you want to use.

☐ Authentication with a local user password upon device startup is disabled. 

Logout Shortcut Locations
Start menu

☑ The session can be launched from the start menu.

Application Launcher

☑ The session can be launched with the Application Launcher.

Desktop

☑ The session can be launched with a program launcher on the desktop.

Quick start panel

☑ The session can be launched with the quick start panel.

Start menu's system tab

☑ The session can be launched with the start menu's system tab.

Application Launcher's system tab

☑ The session can be launched with the Application Launcher's system tab.

Desktop context menu

☑ The session can be launched with the desktop context menu.

Menu folder: If you specify a folder name or a path comprising a number of folder names separated by "/", a menu 
path will be created for the session. The menu path will be used in the start menu and in the desktop context menu.

Application Launcher folder: If you specify a folder name or a path comprising a number of folder names 
separated by "/", a menu path will be created for the session. The menu path will be used in the Application 
Launcher.

Desktop folder: If you specify a folder name or a path comprising a number of folder names separated by "/", a 
menu path will be created for the session. The menu path will be used for the program launcher on the desktop.

Password protection: Specifies which password will be requested when launching the session.
Possible values:

None: No password is requested when launching the session.
Administrator: The administrator password is requested when launching the session.
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User: The user password is requested when launching the session.
Setup user: The setup user's password is requested when launching the session.

Hotkey

☑ The session can be started with a hotkey. A hotkey consists of one or more modifiers and a key.

Modifiers: A modifier or a combination of several modifiers for the hotkey. You can select a set key symbol/
combination or your own key symbol/combination. A key symbol is a defined chain of characters, e.g.  Ctrl .

These are the pre-defined modifiers and the associated key symbols:

(No modifier) =  None

 =  Shift
[Ctrl] =  Ctrl

 =  Mod4

[Alt] =  Alt

Key combinations are formed as follows with  | :

Ctrl +   =  Ctrl|Super_L

Key: Key for the hotkey

Do not use [AltGr] as a modifier (represented as Mod5 ). Otherwise, the key that is configured as a hotkey 
with AltGr cannot be used as a regular key anymore. Example: If you configure [AltGr] + [E] as a hotkey, it is 
impossible to enter an "e".



When this keyboard key is used as a modifier, it is represented as Mod4 ; when it is used as a key, it 

is represented as Super_L .



To enter a key that does not have a visible character, e. g. the [Tab] key, open a terminal, log on as user

and enter xev -event keyboard . Press the key to be used for the hotkey. The text in brackets that 

begins with keysym  contains the key symbol for the Key field. Example: Tab  in (keysym 0xff09, 

Tab)


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Active Directory/Kerberos
Menu path: Setup > Security > Active Directory / Kerberos

Enable
☑ The Kerberos basic configuration will be carried out.
☐ The Kerberos basic configuration will not be carried out. (default)
Default domain (Fully Qualified Domain Name): This value must match the Windows domain on 
which the logon is to take place, e.g. EXAMPLE.COM .

DNS lookup for domain controller
☑ In order to find the key distribution centers (KDCs, domain controllers) and other servers for a 
realm, DNS SRV records are used if they are not explicitly indicated. (default)
☐ The key distribution centers entered under Setup > Security > Active Directory/Kerberos > 
Domain 1 ... Domain 4 will be used.
DNS lookup for domain
☑ In order to determine the Kerberos realm of a host, DNS TXT records are used. (default)
☐ The details under Setup > Security > Active Directory / Kerberos > Domain Realm Mapping 
are used.
Obtain addressless tickets
☑ The first Kerberos ticket is addressless. This may be necessary if the client is located behind an 
NAT device (Network Address Translation). (default)

_____

Domain 1 ... Domain 4 (see page 840)
Domain Realm Mapping (see page 841)

The value must be entered in upper case letters.
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4.

Domain 1 ... Domain 4
Menu path: Setup > Security > Active Directory/Kerberos > Domain 1 ... Domain 4

Up to 4 domains where a login is possible can be configured here.

To configure a domain, proceed as follows:
Under Domain name, give the name of the domain (Kerberos realm).
Click  to create a new entry.
Under Domain controller, give the name or IP address of the domain controller (Kerberos key 
distribution center). A port number can be added to the host name; the port name must be 
preceded by a colon.
Click on Continue.
The domain controller will be added to the Domain controller list.
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4.

Domain Realm Mapping
Menu path: Setup > Security > Active Directory / Kerberos > Domain Realm Mapping

With domain realm assignment, a host name is translated into the corresponding Kerberos realm name.

Use default DNS domain - Active Directory domain mapping
☑ The DNS name and Active Directory domain name match. (default)
☐ DNS name and Active Directory domain name assignments must be set up.

To set up a DNS name to Active Directory domain name assignment proceed as follows:
Click  to create a new entry.
Under DNS host or domain name, enter the host name that is to be assigned to an Active 
Directory domain name.
Under Active Directory domain name, enter the Active Directory domain name that is to be 
assigned to the host name.
Click on Continue.
The data entered will be added to the Domain realm mapping list.
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Smartcard
Menu path: Setup > Security > Smartcard

Here, you can define settings for logging on using a smartcard.

_____

Services (see page 843)
Middleware (see page 845)
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Services
Menu path: Setup > Security > Smartcard > Services

The PC/SC service enables the smartcard reader to connect to the device, so that the smartcard is available to an 
application. This can be a server-side application where the data are forwarded via an RDP or ICA connection or a 
local application, e.g. the browser.

Enable PC/SC daemon

☑ The PC/SC service is enabled. The card reader is available for applications. (Default)

☐ The PC/SC service is disabled. The card reader is not available.

Currently active PC/SC devices: List of smartcard readers currently connected to the device. Internal smartcard 
readers and a variety of USB smartcard readers are supported.
You will find a list of supported smartcard readers in the IGEL Hardware Database32.
See also Smartcard Readers Supported by IGEL Smartcards.

Cherry USB2LAN proxy

☑ The Cherry USB2LAN proxy is active and makes Cherry electronic health card devices available in the network 
via SICCT and HTTPS.

☐ The Cherry USB2LAN proxy is disabled. (Default)

Bind interface: Network interface used for the proxy. 
This parameter is available if Cherry USB2LAN proxy is enabled.
Possible options:

"auto": The first network interface with IPv4 address will be used if Bind IP (see below) is set to 
"auto".
"eth0": The Ethernet interface will be used.
"wlan0": The WLAN interface will be used.
Free text entry: The manually entered network interface will be used. Example: " eth1 " if the 
second Ethernet interface (Network > LAN Interfaces > Interface 2) has to be used.

Bind IP: The IP address used for the proxy.
Possible options:

"auto": The first network interface with an IPv4 address will be used if Bind interface is set to 
"auto".
Free text entry: The manually entered IP address will be used instead of the network interface 
specified under Bind interface.

HTTPS server port: The TCP port for the HTTPS server. (Default: 443)

SICCT announce IP: The IP address to send the SICCT announce messages to.
Possible options:

The Ethernet and WLAN interfaces can be configured under Network > LAN Interfaces. See LAN 
Interfaces (see page 724).



https://www.igel.com/linux-3rd-party-hardware-database/
https://www.igel.com/linux-3rd-party-hardware-database/
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"broadcast": SICCT announce messages are sent in a broadcast procedure, i.e. to all devices on the 
network.
Free text entry: SICCT announce messages are sent to the manually entered IP address.

SICCT announce port: UDP port for SICCT announce messages. (Default: 4742)

SICCT announce interval: Time interval in seconds for sending out SICCT announce messages. 
Value range: 5 to 1800 (Default: 30)

USB fast mode

☑ Faster connection to a Cherry eGK device is enabled.

☐ Faster connection to a Cherry eGK device is disabled. (Default)

Alternative initialization method for G87-1505

☑ Alternative initialization method for Cherry eGK keyboard G87-1505 is enabled.

☐ Alternative initialization method for Cherry eGK keyboard G87-1505 is disabled. (Default)

In order for the changes of this setting to be applied, the device must be unplugged and connected again.
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Middleware
Menu path: Security > Smartcard > Middleware

Here, select the middleware (PKCS#11 module) which matches your card or your token. The middleware selected 
here will be used for the following logins:

Login to Citrix HDX / ICA sessions; see Citrix Global (see page 57)
Login to Citrix StoreFront/Web Interface sessions; see Citrix StoreFront (see page 102)
Login to thin client via Active Directory; see Active Directory/Kerberos (see page 839)

The following options are available:

Gemalto SafeNet: The middleware for Gemalto/SafeNet eToken, IDPrime smartcards and Token is used.

cryptovision sc/interface: The middleware for cryptovision smartcards is used.

Gemalto IDPrime: The middleware for Gemalto IDPrime smartcards is used.

Athena IDProtect: The middleware for Athena IDProtect smartcards is used.

A.E.T. SafeSign: The middleware for SafeSign smartcards is used.

Secmaker Net iD: The middleware for Net iD smartcards is used.

Coolkey: The middleware Coolkey is used.

OpenSC: The middleware OpenSC is used.

Custom PKCS#11 module: The PKCS#11 module stored under the Path to the library is used. See also Using a 
Custom PKCS#11 Library.

Path to the library: Path to the custom PKCS#11 module

Enable this Gemalto middleware when you want to operate Gemalto Common Criteria devices in unlinked 
mode.


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System
Menu path: Setup > System

You can configure basic system settings here.

_____

Time and Date (see page 847)
Update (see page 848)
Remote Management (see page 851)
Remote Access (see page 854)
Remote Syslog (see page 860)
Power Options (see page 861)
Firmware Customization (see page 866)
Registry (see page 896)
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Time and Date
Menu path: Setup > System > Time and Date

Timezone Continent/Area: Continent/Area for your location
Possible values:

General: Under Location, you can select a time zone.
Africa... Pacific: Under Location, you can select a city for the selected continent/area.

Location: Select your location or time zone.

Use NTP Time Server
☑ The system clock is set via NTP.
☐ The system clock is not set via NTP. (default)
Use NTP Time Server: IP or name of an NTP time server. If you would like to enter a list of NTP 
time servers for redundancy purposes, separate the servers with spaces.
Set time and date: Carries over the time and date and sets the hardware clock.
You will find further information regarding the updating of time zone information (e.g. summer 
time adjustments) in the Updating Timezone Information (Daylight Saving Time, DST) FAQ.

Please note that the GMT time zones under Linux are usually in POSIX format. This means 
that you need to invert the actual time difference (e.g. for New York you select the zone 
"GMT+5" for "5 hours west of Greenwich” although the time in New York is actually 5 hours 
behind GMT). Defining the time zone by selecting a Continent and Location is therefore 
preferable.


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Update
Menu path: Setup > System > Update

Here, you can configure settings for the system update.

_____

Firmware Update (see page 849)
Buddy Update (see page 850)
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Firmware Update
Menu path: Setup > System > Update > Firmware Update

Here, you can specify how the device obtains updates for its own firmware.

Protocol: Select the method for accessing the updates.
HTTP: Download from a web server.
HTTPS: Download from a TLS/SSL-secured web server.
FTP: Download from an FTP server. (FTP passive mode is used)
Secure FTP: Download via SSH-secured FTP.
FTPS: Download from a TLS/SSL-secured FTP server.
FILE: The update lies in the device file system, possibly as a shared NFS or Windows update. 
You can choose the location by selecting a file below.

Server name: Name or IP address of the server.
Port: Port of the server on which the service is provided.
Server path: The path to the directory with the update files on the server.
User name: User name on the server.
Password: Password for the user account on the server.
Automatic update check on boot
☑ The device will automatically search for and install an updated firmware version each time that 
it boots.
☐ The device will not automatically search for an updated firmware version. (Default)
Automatic update check on shutdown
☑ The device will automatically search for and install an updated firmware version each time that 
it shuts down or it reboots.
☐ The device will not automatically search for an updated firmware version when it shuts down. 
(Default)
Automatic buddy detection
☑ The device will automatically search for further devices in the local network that offer firmware 
updates as Buddy Servers.
☐ The device will not automatically search for Buddy Servers. (Default)
Update firmware: Launches the update process. If you have made changes on this setup page 
earlier on, click on Apply first.
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Buddy Update
Menu path: Setup > System > Update > Buddy Update

Under Buddy Update, you can specify your thin client as an update server for other IGEL thin clients. If you use a 
thin client as an update server, only the FTP protocol can be used to update the firmware. A number of thin clients 
can be set up as buddy update servers within the network.

Thin clients without a specified update server search for available servers during the update. The first update server 
contacted then provides the update.

Enable Update Server
☑ This thin client serves as an FTP firmware update server for other thin clients.
☐ This thin client does not serve as an FTP firmware update server for other thin clients. (default)
User Name: User name for FTP access (default: anonymous)
Password: Password for FTP access. The asterisk * allows any password.
Max. Concurrent Logins: Maximum number of simultaneous logons on the FTP server. (default: 
10)
For further information, read the Buddy Update how-to.
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Remote Management
Menu path: Setup > System > Remote Management

Here, you can configure settings relating to the remote administration of the device using the Universal 
Management Suite (UMS).

Enable remote management

☑ The endpoint device can be managed via the UMS. (default)

☐ Remote management is not allowed.

Universal Management Suite: If the device is registered on a UMS Server, its IP address or hostname will be shown 
in the list.

To add another UMS instance, click on :

UMS Server: Name or IP of the UMS Server
Port Number: Port number of the UMS Server (default: 30001)

Display “Apply changes” dialog on boot: If new settings were made in the UMS, the device may receive them 
during the boot procedure. Here you can decide whether the user can influence the application of the new settings.

☑ During the boot procedure, the Apply changes dialog will be shown if new settings are available. The user can 
decide whether the new settings are applied immediately. If the user does not allow them to be applied 
immediately, they will automatically be applied when the system is next restarted.

☐ The dialog will not be shown. The new settings will be automatically applied or ignored depending on the setting 
under Default action on boot.

Timeout: Number of seconds for which the Apply changes dialog is shown.
Possible values:

No time limit: The dialog is shown until the user clicks on a button.
1 ... 120 seconds

Default action on boot: Configure the action that is to be performed if the dialog exceeds the time limit or if it is 
disabled.
Possible values:

Apply changed configuration immediately: New settings will become active immediately and 
programs that are running may be restarted.
Ignore changed configuration: New settings will not be applied. The new configuration will be 
saved on the device.

Prompt user on UMS actions

☑ The user will be informed via a message window if the device receives new settings from the UMS or is shut 
down. (default)

The list can contain more than one UMS instance. If the device cannot contact a UMS Server under the 
hostname igelrmserver , and the DHCP option 244 is not set, the device will go through the entries in 
the list until it can contact a UMS Server successfully.


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☐ The user will not be informed if the device receives new settings from the UMS or is shut down.

Timeout: Number of seconds for which the notification window is shown (default: 20)
Possible values:

No time limit: The dialog is shown until the user clicks on a button.
1 ... 120 seconds

Structure tag: You can define a structure tag in order to sort the device into a directory in accordance with the UMS 
directory rules.

UMS Registration: This button opens the UMS Registration (see page 589) program from the accessories.

Further information regarding the use of structure tags can be found in the how-to Using Structure Tags.

Options (see page 853)
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Options
Menu path: Setup > System > Remote Management > Options

Log login and logoff events

☑ If a user logs on or off via Citrix or Kerberos, details of this event will be sent to the UMS and can 
be used there, e.g. to process support queries.
Logoffs from the Shared Workplace will also be logged (logons take place via the UMS anyway). 
(default)
☐ Logon and logoff events will not be relayed. (default)

Delay session start at boot time in order to apply new UMS settings: If new settings were made 
in the UMS, the thin client may receive them during the boot procedure.
☑ The session start will be delayed until the settings have been transferred or the time limit has 
been exceeded.
Timeout: Delay in seconds (default: 10)
Possible values:

No time limit: The dialog is shown until the user clicks on a button.
1 ... 120 seconds

Please note: For this option to work, in the UMS Console under UMS Administration > 
Globale Configuration > Logging the option Log Events must be enabled.



The event logs can be found under the system information for the thin clients in the UMS.
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Remote Access
Menu path: Setup > System > Remote Access

In order to allow central administration, the thin client can be configured in such a way that it can be accessed via 
the WAN.

_____

SSH Access (see page 855)
Shadow (see page 857)
Secure Terminal (see page 859)



System

IGEL OS Reference Manual   855 / 897

•
•
•

SSH Access
Menu path: Setup > System > Remote Access > SSH Access

Remote access to the local system via SSH is permitted by default. However, you can restrict remote access to a 
specific user from a specific host.

Enable

☑ The SSH service is enabled. (default)

Permit empty passwords

☑ Logging on without a password is allowed.

☐ Logging on without a password is not allowed. (default)

Permit administrator logon:

☑ Logging on as an administrator is allowed.

☐ Logging on as an administrator is not allowed (default)

Port number: Port number for SSH (default: 22)

User access
User name: Permitted user
Possible values:

root
user
ruser

Hostname: Name of the host from which SSH access takes place (example: xterm.igel.de )

Deny

☑ Access is denied.

☐ Access is allowed. (default)

Permit X11 forwarding:
☑  X11 forwarding is enabled.

☐  X11 forwarding is disabled. (default)

Enable applications access for remote user “ruser”
Command line: Command that is allowed or prohibited for the remote user

Enable application

For the user name "ruser" a password has to be assigned under Security > Password. The names "root" 
and "user" work also without passwords.


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☑ The application given under command line may be executed by the remote user. (default)

☐ The application given under command line may not be executed by the remote user.
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Shadow
Menu path: System > Remote Access > Shadow

For helpdesk purposes, you can observe the endpoint device via shadowing. This is possible via IGEL VNC Viewer in 
the Universal Management Suite (UMS) or another VNC client (e.g. TightVNC). For detailed information on 
shadowing, see Shadowing (VNC).

Allow remote shadowing

☑ Desktop content can be viewed from remote computers with VNC software.

☐ VNC shadowing is not allowed. (Default)

If Allow remote shadowing is activated, you can change the following settings:

Secure mode

☑ Communication will be secured via SSL/TLS and shadowing will only be possible for UMS administrators.

☐ Communication will not be secured via SSL/TLS. (Default)

Further information regarding secure shadowing can be found under Secure Shadowing (VNC with TLS/SSL).

Use password

☑ The remote user must enter a password before shadowing can begin.

☐ The remote user does not require a password for shadowing. (Default)

Password: Password for the VNC connection

Prompt user to allow remote session

☑ The local user will be asked for permission before shadowing. (Default)

Allow user to disconnect remote shadowing

☑ A button with which the user can terminate the connection is shown. (Default)

Allow input from remote

☑ The remote user can make entries using the keyboard and mouse as if they were the local user. (Default)

For Remote Working, Use Secure Shadowing

If the endpoint device is in a mobile or work-from-home environment, it is highly recommended to use 
secure shadowing only. Regular shadowing without encryption poses a security risk.



The user can terminate the VNC connection at any time by clicking on the Disconnect button.

In a number of countries, for example, Germany, unannounced shadowing is prohibited by law. Do not 
disable this option if you are in one of these countries!


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Scale frame buffer

☑ The screen content of the shadowed device is reduced or enlarged by the scaling factor before being 
transferred.

☐ The screen content is transferred in the original size. (Default)

Scale factor: Factor by which the screen content of the shadowed device is enlarged or reduced. (Default: 1.0)

Further parameters for the VNC server on the device are accessible under Setup > System > Registry > 
network.vncserver.


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Secure Terminal
Menu path: Setup > System > Remote Access > Secure Terminal

You can establish a secure terminal connection to a thin client.

The thin client must meet the following requirements:

The firmware of the thin clients is IGEL Linux Version 5.11.100 or higher or IGEL Linux Version 
10.01.100 or higher.

For IGEL Linux Version 5.11.100 and 10.03.100:

In the thin client setup, go to System > Remote Access > Secure Terminal
Enable Secure Terminal

For IGEL Linux Version 10.01.100 or newer:

Enable the following options in the thin client registry:
network > telnetd > enabled > allow telnet access
network > telnetd > secure_mode > secure telnet

You can allow access via the secure terminal for all registered thin clients. To do this, 
enable the UMS Administration > Global Configuration > Remote Access > Enable 
Global Secure Terminal option.


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Remote Syslog
Log files can be sent to a remote server. This can be especially helpful for support purposes.

Remote mode

Possible options:

Server
Client
Off
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Power Options
Menu path: Setup > System > Power Options

In this area, you will find the settings for energy management.

_____

System (see page 862)
Rechargeable Battery (see page 863)
Screen (see page 864)
Shutdown (see page 865)
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System
Menu path: Setup > System > Power Options > System

Here you can configure the settings for standby and for the CPU power plan.

System suspend/shutdown on inactivity: Specify how long the user can be inactive before the system switches to 
standby mode or shuts down, dependent on the option selected under System action on inactivity.
Possible values:

Never
After 1 minute
...
After 24 hours

System action on inactivity
Possible options:

Suspend: The system is set to standby mode after the timeout defined with System suspend/
shutdown on inactivity has expired.
Shutdown: The system is shut down after the timeout defined with System suspend/shutdown 
on inactivity has expired. 

Without dialog

☑ The user is not asked if the system is to be set to the standby mode.

☐ The dialog will be shown. (Default).

Dialog timeout: Time in seconds, for which the dialog is to be displayed. (Default: 10 seconds)

CPU Power Plan: Specify here which CPU power plan (CPU Governor) the device is to use in battery mode and in AC 
mode.

On Battery:
High Performance: full performance with maximum processor speed 
Balanced (Smooth): slower regulation of performance in a balanced manner according to the 
demands of programs. Suitable for users who are bothered by the fan frequently running at high 
speed. 
Balanced (Recommended) : rapid regulation of performance according to the demands of 
programs. 
Power Saver: lowest processor speed
Plugged in:
High Performance
Balanced (Smooth) 
Balanced (Recommended) 
Power Saver

Tray Icon

☑ A CPU icon will be shown in the system tray. This makes it easy to switch between power plans.

☐ No CPU icon will be shown. (Default)
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Rechargeable Battery
Menu path: Setup > System > Power Options > Battery

In this area, you can define the rechargeable battery messages.

Battery Notification

Critical battery level (percentage): Percentage of remaining battery charge deemed critical 
(default: 5)
Critical battery action: Action to be taken in the event of a critical battery level
Possible options:

Do nothing
Show warning
Run command
Run command in terminal

Critical command: Command that is executed when a critical charge level is reached (example: 
Shutdown)
Low battery level (percentage): Percentage of remaining battery charge deemed low (default: 
10)
Low battery action: Here you can specify what action is to be taken in the event of a low battery 
level.
Possible options:

Do nothing
Show warning
Run command
Run command in terminal

Low command: Command that is executed when a low charge level is reached (example: 
Shutdown)

Battery Tray Icon

Display percentage:
☑ The percentage of remaining energy is shown in the taskbar. (default)
Display time
☑ The estimated remaining battery life is shown in the taskbar.
☐ The estimated remaining battery life is not shown. (default)
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Screen
Menu path: Setup > System > Power Options > Display

In this area, you can configure screen settings which can help to reduce energy consumption.

Display Power Management Settings

Handle Display Power Management:
☑ You can configure energy saving settings separately for battery or AC operation. (default)
☐ You cannot configure energy saving settings.
Standby Time: Number of minutes after which the screen switches to standby mode if the user is 
inactive. (default: 6 minutes)
Suspend time: Number of minutes after which the screen switches to suspend mode if the user is 
inactive. (default: 8 minutes)
Off Time: Number of minutes after which the screen switches off if the user is inactive. (default: 10 
minutes)

Brightness Reduction

On inactivity reduce to: Specify to how many percent the screen brightness should be reduced if 
you are not using the device for battery and AC operation. (default for battery: 20%, default for AC 
operation: 80%)
Reduce after: Specify a time between 10 and 120 seconds after which the screen brightness will be 
reduced for battery and AC operation. (default: Never)

The brightness reduction controls have been added specifically for use of laptops. They have no effect on 
other devices connected to the power supply.


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Shutdown
Menu path: Setup > System > Power Options > Shutdown

Here, you can change the behavior when the device shuts down manually or automatically.

Allow system shutdown

☑ The device can be shut down by the user. (Default)

☐ The device cannot be shut down by the user.

Allow system suspend

☑ The device can be suspended by the user. (Default)

☐ The device cannot be suspended by the user.

Allow canceling of shutdown process

☑ The user can cancel the procedure via a button. (Default)

☐ The user cannot cancel the procedure.

Default action: Action that is carried out when the time is set under Dialog timeout.
Possible options:

Shutdown
Suspend
Cancel: No action will be carried out after the time set under Dialog timeout expires, see Allow 
canceling of shutdown process parameter.
Nothing: No action will be carried out after the time set under Dialog timeout expires.

Without dialog

☑ The dialog will not be shown. The action selected under Default action will be carried out.

☐ The dialog will be shown. (Default)

Dialog timeout: After the time (in seconds) set here expires, the dialog will close and the action specified under 
Default action will be carried out. If the value is set to 0, the dialog will be shown until the user selects one of the 
possible actions. (Default: 10)
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Firmware Customization
Menu path: Setup > System > Firmware Customization

You can configure the firmware according to your needs.

Custom Partition (see page 867)
Custom Application (see page 871)
Custom Commands (see page 878)
Corporate Design (see page 884)
Environment Variables (see page 892)
Features (see page 895)
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Custom Partition
Menu path: Setup > System > Firmware Customization > Custom Partition

In IGEL Linux, a custom data partition is available for use as required. A download/update function which loads data 
from a server and, where appropriate, updates them can be set up for this custom storage area.

_____

Partition (see page 868)
Download (see page 869)

The IGEL Support Team offers support for the deployment of Custom Partitions. However, it is not possible 
to offer support for any third-party software that is installed on a Custom Partition.



If the thin client is reset to the default settings (factory reset), the custom partition and all data stored on it 
will be deleted.


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Partition
Menu path: Setup > System > Firmware Configuration > Custom Partition > Partition

Here, you can create a partition of your own.

Enable partition
☑ The customer partition is enabled in the IGEL Setup of the thin client or with the IGEL Universal 
Management Suite via the setup path.
☐ The customer partition is not enabled. (default)
Size: Size of the partition. A number must be followed by a multiplicative ending, without a space 
in between. Example: "100K" stands for 100 Kibibytes, that is, 100 * 1024 bytes.
The following multiplicative endings are possible (capital letters required):
K for kibibytes (number * 1024)
M for mebibytes (number * 1024 * 1024)
G for gibibytes (number * 1024 * 1024 * 1024)

Mount point: Path on which the partition is to be mounted. (default: /custom )
Partitions parameters: From IGEL OS Version 10.03.100, you can enter name value pairs which are 
passed on to the custom partition for further processing.
To manage the list, proceed as follows:

Click  to create a new parameter.
Click  to remove the selected parameter.
Click  to edit the selected parameter.
Click  to copy the selected parameter.

Add

Name: Name of the parameter
Value: Value of the parameter

Sensible values are for example "100K" (for 100 KiB = 100 * 1024 bytes) or "100M" (for 100 
MiB = 100 * 1024 * 1024 bytes). The size of the partition should be set to at least 100 KiB. 
However, no more than 300 MiB should be reserved for the customer-specific partition 
(based on the 1 GB standard CF used in IGEL Linux thin clients). This is because 
subsequent firmware updates may require more storage space than the current version.


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Download
Menu path: Setup > System > Firmware Configuration > Custom Partition > Download

Sources for partition data

In order to load data onto the custom partition, at least one source for partition data must be set up here.

To manage the list, proceed as follows:

Click  to create a new source.
Click  to remove the selected source.
Click  to edit the selected source.
Click  to copy the selected source.

Add

Automatic update
☑ The contents from this source will be updated automatically.
☐ The contents from this source will not be updated automatically. (default)
URL: URL of the web server
User name: User name for access to the web server
Password: Password for access to the web server
Initialization action: Action which is performed after mounting the partition (program or script 
with absolute path). For example, a program downloaded to the partition can be launched.
Finalizing action: Action which is performed before mounting the partition (program or script 
with absolute path). For example, a program downloaded to the partition can be ended.

The transfer protocols are the same as the ones for updating the firmware, e.g. HTTP and HTTPS. An INF  file 
which in turn references a tar archive zipped using bzip2 must be referenced as the target.

The structure of the INF file is as follows:

[INFO], [PART] Header information

file="test.tar.bz2" File name of the compressed tar archive

version="1" Version number - a higher version results in 
an update if Update automatically is 
enabled.

The files to be transferred must therefore be zipped in a tar archive which is then compressed using bzip2. This file 
is referenced in the INF file which is the target of the URL.

The tar archive can be created under Windows, e.g. with the open source program 7-Zip (www.7-zip.de33). This 
program also allows bzip2  compression. Under Linux, tar and bz2 files can be created using onboard resources.

http://www.7-zip.de
http://www.7-zip.de
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The procedure makes it possible to replace the file(s) on the server with a new version which the thin client loads 
the next time it is booted. The Version  parameter in the INF  file must be increased for this purpose.
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Custom Application
Menu path: System > Firmware Customization > Custom Application

Applications that were loaded onto a customer partition for example can be launched via the Application Launcher 
or an icon on the desktop once they have been defined as custom applications. In order for this to be possible, a 
command to call up the application must be entered under Settings (see page 874).

 Click on  to define a custom application.

 Specify the launch options:

Session name: Name for the session.

Starting Methods for Session
Start menu

☑ The session can be launched from the start menu.

Application Launcher

☑ The session can be launched with the Application Launcher.

Desktop

☑ The session can be launched with a program launcher on the desktop.

Quick start panel

☑ The session can be launched with the quick start panel.

Start menu's system tab

☑ The session can be launched with the start menu's system tab.

Application Launcher's system tab

☑ The session can be launched with the Application Launcher's system tab.

Desktop context menu

☑ The session can be launched with the desktop context menu.

Menu folder: If you specify a folder name or a path comprising a number of folder names separated by "/", a menu 
path will be created for the session. The menu path will be used in the start menu and in the desktop context menu.

Application Launcher folder: If you specify a folder name or a path comprising a number of folder names 
separated by "/", a menu path will be created for the session. The menu path will be used in the Application 
Launcher.

Desktop folder: If you specify a folder name or a path comprising a number of folder names separated by "/", a 
menu path will be created for the session. The menu path will be used for the program launcher on the desktop.

The session name must not contain any of these characters: \ / : * ? “ < > | [ ] { } ( )
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Password protection: Specifies which password will be requested when launching the session.
Possible values:

None: No password is requested when launching the session.
Administrator: The administrator password is requested when launching the session.
User: The user password is requested when launching the session.
Setup user: The setup user's password is requested when launching the session.

Hotkey

☑ The session can be started with a hotkey. A hotkey consists of one or more modifiers and a key.

Modifiers: A modifier or a combination of several modifiers for the hotkey. You can select a set key symbol/
combination or your own key symbol/combination. A key symbol is a defined chain of characters, e.g.  Ctrl .

These are the pre-defined modifiers and the associated key symbols:

(No modifier) =  None

 =  Shift
[Ctrl] =  Ctrl

 =  Mod4

[Alt] =  Alt

Key combinations are formed as follows with  | :

Ctrl +   =  Ctrl|Super_L

Key: Key for the hotkey

Autostart

☑ The session will be launched automatically when the device boots.

Do not use [AltGr] as a modifier (represented as Mod5 ). Otherwise, the key that is configured as a hotkey 
with AltGr cannot be used as a regular key anymore. Example: If you configure [AltGr] + [E] as a hotkey, it is 
impossible to enter an "e".



When this keyboard key is used as a modifier, it is represented as Mod4 ; when it is used as a key, it 

is represented as Super_L .



To enter a key that does not have a visible character, e. g. the [Tab] key, open a terminal, log on as user

and enter xev -event keyboard . Press the key to be used for the hotkey. The text in brackets that 

begins with keysym  contains the key symbol for the Key field. Example: Tab  in (keysym 0xff09, 

Tab)


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Restart

☑ The session will be relaunched automatically after the termination.

Autostart delay: Waiting time in seconds between the complete startup of the desktop and the automatic session 
launch.

Autostart requires network

☑ If no network is available at system startup, the session is not started. A message is shown. As soon as the 
network is available, the session is started automatically.

☐ The session is started automatically, even when no network is available.

Appliance mode access: Determines whether the session can be started in appliance mode. By default, appliance 
mode implies that one session is running on the device exclusively. For further information, see Appliance Mode (see 
page 220).

☑ The session can be started in appliance mode. The following starting methods can be used in appliance mode:

Desktop (desktop icon; not in appliance mode XDMCP for this Display)
Desktop Context Menu (not in appliance mode XDMCP for this Display)
Application Launcher (includes Application Launcher's system tab; not in appliance 
mode XDMCP for this Display)
Hotkey
Autostart (not in appliance mode XDMCP for this Display)

☐ The session cannot be started in appliance mode. 

Settings (see page 874)
Desktop Integration (see page 875)
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Settings
Menu path: System > Firmware Customization> Custom Application > [Session Name] > Settings

Enter the command for calling up an application here:

Icon name: Select an icon provided. (default: applications-other).

Command: Give the name and path of the application. (Example: /usr/bin/gpicview ).

Only the desktop icon of a session is customizable. The taskbar icon of a session cannot be customized 
and will remain the default icon. Complete customization is not possible.


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Desktop Integration
Menu path: System > Firmware Customization > Custom Application > [Session Name] > Desktop Integration

Session name: Name for the session.

Starting Methods for Session

Start menu

☑ The session can be launched from the start menu.

Application Launcher

☑ The session can be launched with the Application Launcher.

Desktop

☑ The session can be launched with a program launcher on the desktop.

Quick start panel

☑ The session can be launched with the quick start panel.

Start menu's system tab

☑ The session can be launched with the start menu's system tab.

Application Launcher's system tab

☑ The session can be launched with the Application Launcher's system tab.

Desktop context menu

☑ The session can be launched with the desktop context menu.

Menu folder: If you specify a folder name or a path comprising a number of folder names separated by "/", a menu 
path will be created for the session. The menu path will be used in the start menu and in the desktop context menu.

Application Launcher folder: If you specify a folder name or a path comprising a number of folder names 
separated by "/", a menu path will be created for the session. The menu path will be used in the Application 
Launcher.

Desktop folder: If you specify a folder name or a path comprising a number of folder names separated by "/", a 
menu path will be created for the session. The menu path will be used for the program launcher on the desktop.

Password protection: Specifies which password will be requested when launching the session.
Possible values:

None: No password is requested when launching the session.
Administrator: The administrator password is requested when launching the session.
User: The user password is requested when launching the session.
Setup user: The setup user's password is requested when launching the session.

The session name must not contain any of these characters: \ / : * ? “ < > | [ ] { } ( )
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Hotkey

☑ The session can be started with a hotkey. A hotkey consists of one or more modifiers and a key.

Modifiers: A modifier or a combination of several modifiers for the hotkey. You can select a set key symbol/
combination or your own key symbol/combination. A key symbol is a defined chain of characters, e.g.  Ctrl .

These are the pre-defined modifiers and the associated key symbols:

(No modifier) =  None

 =  Shift
[Ctrl] =  Ctrl

 =  Mod4

[Alt] =  Alt

Key combinations are formed as follows with  | :

Ctrl +   =  Ctrl|Super_L

Key: Key for the hotkey

Autostart

☑ The session will be launched automatically when the device boots.

Restart

☑ The session will be relaunched automatically after the termination.

Autostart delay: Waiting time in seconds between the complete startup of the desktop and the automatic session 
launch.

Autostart requires network

Do not use [AltGr] as a modifier (represented as Mod5 ). Otherwise, the key that is configured as a hotkey 
with AltGr cannot be used as a regular key anymore. Example: If you configure [AltGr] + [E] as a hotkey, it is 
impossible to enter an "e".



When this keyboard key is used as a modifier, it is represented as Mod4 ; when it is used as a key, it 

is represented as Super_L .



To enter a key that does not have a visible character, e. g. the [Tab] key, open a terminal, log on as user

and enter xev -event keyboard . Press the key to be used for the hotkey. The text in brackets that 

begins with keysym  contains the key symbol for the Key field. Example: Tab  in (keysym 0xff09, 

Tab)


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☑ If no network is available at system startup, the session is not started. A message is shown. As soon as the 
network is available, the session is started automatically.

☐ The session is started automatically, even when no network is available.

Appliance mode access: Determines whether the session can be started in appliance mode. By default, appliance 
mode implies that one session is running on the device exclusively. For further information, see Appliance Mode (see 
page 220).

☑ The session can be started in appliance mode. The following starting methods can be used in appliance mode:

Desktop (desktop icon; not in appliance mode XDMCP for this Display)
Desktop Context Menu (not in appliance mode XDMCP for this Display)
Application Launcher (includes Application Launcher's system tab; not in appliance 
mode XDMCP for this Display)
Hotkey
Autostart (not in appliance mode XDMCP for this Display)

☐ The session cannot be started in appliance mode. 
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Custom Commands
Menu path: Setup > System > Firmware Customization > Custom Commands

You can define custom commands for specific points in time when the system is starting. You can use configured 
environment variables (see page 892) in the commands.

_____

Post Session (see page 879)
Base (see page 880)
Network (see page 881)
Desktop (see page 882)
Reconfiguration (see page 883)
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Post Session
Menu path: Setup > System > Firmware Customization > Custom Commands > Post Session

For a specific session type, you can define an action that is performed when the last session of this type is ended.

Session type: Session type for which the action is performed.
Possible values:

No post-session command
Citrix
Citrix via Browser
RDP
VMware Horizon
Browser
Java-based (Leostream Connect)
NoMachine NX
Parallels Client
PowerTerm terminal emulation
ThinLinc
X session
IBM iAccess
Media player
VNC viewer

Post session command: Action that is carried out after the end of the session selected above.
Possible options:

Logoff: The user is automatically logged off; a login method must be defined for this purpose. 
Further information can be found under IGEL Smartcard (see page 829), Active Directory / 
Kerberos (see page 832) and Smartcard (see page 842).

Shutdown/suspend (system default action): The device will be shut down or placed in a standby 
mode depending on the setting under System > Power Options > Shutdown > Default action
selection. A dialog allowing the user to cancel the procedure will be shown in the process. Further 
information can be found under Shutdown (see page 865).
Shutdown/suspend (system default action without dialog): The device will be shut down or placed 
in a standby mode depending on the setting under System > Power Options > Shutdown > 
Default action selection. The user cannot cancel the procedure.
Reboot (with dialog timeout): The device will reboot. A dialog allowing the user to cancel the 
procedure will be shown in the process.
Reboot (without dialog): The device will reboot. The user cannot cancel the procedure.
Enter custom command here: Command to be executed.

The “Logoff” option cannot be used if the Appliance Mode is in use. Further information 
can be found under Appliance Mode (see page 220).


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Base
Menu path: Setup > System > Firmware Customization > Custom Commands > Base

The commands defined here are executed on a one-off basis during the boot procedure. You can define commands 
for the execution times described below:

Initialization
Not all drivers loaded, not all devices available
Network scripts not launched, network not available
Partitions available except firefox profile, scim data, ncp data, custom partition

Before session configuration
Not all drivers loaded, not all devices available
Network scripts launched, network not available
Partitions available except firefox profile, scim data, ncp data, custom partition
Sessions not configured

After session configuration
All drivers loaded, all devices available
Network available
Partitions available except custom partition
System daemons not launched (CUPS, ThinPrint etc.)
Sessions configured
UMS settings retrieved but not yet effective

Final initialization command
All partitions available
All system daemons launched
UMS settings effective
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Network
Menu path: Setup > System > Firmware Customization > Custom Commands > Network

The commands defined here are executed each time that the relevant network interface (default:  eth0 ) starts. 

The network interface can be selected with the  $INTERFACE  environment variables ( eth0 ,  eth1 ,  wlan0 ). 
You can define commands for the execution times described below:

Network initialization

The commands defined here are executed at the beginning of the network configuration.
No further network settings used

After network DNS

Runs after each change in the IP address or host name
IP address / name server settings used (e.g. via DHCP)

Before network services

IP address / name server settings used
VPN connected (if VPN autostart was enabled in the setup)
No network / host routing settings used

Final network command

Network / host routing settings used
NFS and SMB drives available
System time synchronized with time server
UMS settings retrieved but not effective yet
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Desktop
Menu path: Setup > System > Firmware Customization > Custom Commands > Desktop

The commands defined here are executed when the X server is launched. You can define commands for the 
execution times described below:

Desktop initialization
Runs once during the boot procedure
Desktop environment configured but not launched
User not logged on (Kerberos, smartcard etc.)

Before desktop start
Runs once during the boot procedure
Desktop environment launched
Message service launched
Session D-Bus launched
User not logged on (Kerberos, smartcard etc.)

Final desktop command
Runs after each user logon and desktop restart
User logged on (Kerberos, smartcard etc.)
User desktop launched
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Reconfiguration
Menu path: Setup > System > Firmware Customization > Custom Commands > Reconfiguration

The commands defined here are executed after settings relating to the local setup or the UMS have been changed. 
You can define commands for the execution time described below.

After reconfiguration: Runs after an effective change in the endpoint device settings (local setup, 
UMS)
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Corporate Design
Menu path: Setup > System > Firmware Customization > Corporate Design

In this area, settings allowing you to adapt the user interface to your company layout are grouped together.

You can place your own logo in the following places:

Custom Bootsplash (see page 885)
Background (1st Monitor) (see page 887)
Company Logos (see page 890)

See also the how-to Customizing IGEL OS Desktop.
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Custom Bootsplash
Menu path: Setup > System > Firmware Configuration > Corporate Design > Custom Bootsplash

With a bootsplash, you can show your company logo or a specific image during the booting procedure. The 
bootsplash will be shown instead of the console messages.

Please note: You need to provide an image file for your custom bootsplash on a download server.

Custom Bootsplash

Enable custom bootsplash

☑ You can make the following settings in order to configure a custom bootsplash.

☐ No custom bootsplash is configured. (Default)

Custom Bootsplash - Server Location

Use firmware update server location

☑ The server configuration will be carried over from the firmware update (see page 849).

☐ You can carry out a custom configuration below. (Default)

Protocol: Access method for the image
Possible options:

HTTP: Download from a web server
HTTPS: Download from a TLS/SSL-secured web server
FTP: Download from an FTP server
Secure FTP: Download via SSH-secured FTP
FTPS: Download from a TLS/SSL-secured FTP server
FILE: The image file lies in the file system of the device, possibly as a shared NFS or Windows 
update. You can choose the location simply by selecting a file below.

Server name: Name or IP address of the server

Port: Port of the server on which the service is provided (Default: 21)

Server path: Path to the directory with the image file on the server

User name: User name on the server

Password: Password for the user account on the server

Custom Bootsplash - Settings

Custom bootsplash file: File name of the custom image
As regards positioning, the following applies: 0 = left-justified, 50 = centered, 100 = right-justified

The file types BMP, JPG, GIF, TIF, PNG, and SVG are supported for a bootsplash. A total storage area of 25 
MB is available for all user-specific images. The image is 800 x 600 pixels in size (aspect ratio remains 
unchanged). It can be positioned vertically and horizontally.


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Custom bootsplash style:

Original
Stretched
Scaled
Zoomed

Background color: Use the color picker to choose.

Horizontal position of the bootsplash image (Default: 50)

Vertical position of the bootsplash image (Default: 50)

Size of progress indicator (Default 72)

Horizontal position of the progress indicator (Default: 90)

Vertical position of the progress indicator (Default: 90)

Bootsplash update: The user-specific bootsplash will be downloaded from the given server.

If you change the image file or even just one of the settings for an existing bootsplash, be sure to click on 
Bootsplash update in order to regenerate the system files used and then on Apply or OK.


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Background (1st Monitor)
Menu path: Setup > System > Firmware Customization > Corporate Design > Background (1st Monitor)

Decorate the desktop background with predefined IGEL backgrounds, a fill color or a color gradient or define a 
custom background image. You can set up a separate background image for each monitor that is connected to the 
thin client.

Prerequisite: You have provided a custom background image on a server; see Background Image Server (see page 889).

Wallpaper: Select one of the predefined background images from the following list:
neutral
disabled
black (4x3)
blue (4x3)
gray (4x3)
orange (4x3)
green
black (16x9)
blue (16x9)
gray (16x9)
orange (16x9)

Wallpaper Style: If you have set a custom background image, you can display it in a number of 
ways.
Possible options:

Automatic
Centered
Tiled

The file types BMP, JPG, GIF, TIF, PNG and SVG are supported for a background image. A total storage area 
of 25 MB is available for firmware customization images.



•

•
•
•

From IGEL Linux Version 10.03.500 both background images and background image server can be defined 
user-customized via Shared Workplace. Please note the following for this:

All user-customized background images will be saved on the thin client and therefore 
require a part of the available 25 MB storage space. Ensure that this storage limit is not 
exceeded. (When the storage limit is reached, all images except the one currently used will 
be deleted; with a new logon via Shared Workplace, the previously deleted images will be 
downloaded again until the storage limit is reached.)
You will find further information on Shared Workplace and background images here:
IGEL Linux user manual: Shared Workplace (see page 835)
IGEL UMS user manual: Shared Workplace
How-To: Creating your own Wallpaper in the How-To Customizing the IGEL Linux Desktop





System

IGEL OS Reference Manual   888 / 897

•
•
•

•

•
•
•

•

•
•

•

Spread
Scaled
Zoomed

Color Style: If you have chosen two different colors as the desktop background color, you can 
define color gradients here. Possible values:
Possible options:

Solid color
Horizontal gradient
Vertical gradient

Desktop Color: Click on Choose color to specify a custom background color for your desktop if 
you have not chosen a background image.
2nd Desktop Color: Click on Choose color to specify a second background color for your desktop.
Custom wallpaper downlad
☑ You can set up a custom background image.
☐ No custom background image will be used. (Default)
Custom Wallpaper file: Name of the background image file

If you would like to use a custom background image, you need to specify the download 
server under System > Firmware Customization > Corporate Design > Background (1st 
Monitor) > Custom Wallpaper Server (see page 889). If you have already defined a server for 
the system update files, you can use the same server settings for downloading the 
background image.


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Background Image Server

Menu path: Setup > System > Firmware Customization > Corporate Design > Background (1st Monitor) > 
Custom Wallpaper Server

Custom Wallpaper - Server Configuration

Use firmware update server location
☑ The server configuration will be carried over from the firmware update.
☐ You can carry out a custom configuration below. (default)
Protocol: Select the method for accessing the image.

HTTP: Download from a web server.
HTTPS: Download from a TLS/SSL-secured web server.
FTP: Download from an FTP server.
Secure FTP: Download via SSH-secured FTP.
FTPS: Download from a TLS/SSL-secured FTP server.
FILE: The image lies in the thin client file system, possibly as a shared NFS or Windows file. 
You can choose the location simply by selecting a file below.

Server name: Name or IP address of the server.
Port: Port of the server on which the service is provided.
Server path: The path to the directory with the image file on the server
User name: User name on the server
Password: Password for the user account on the server
Wallpaper update: The user-specific background image will be downloaded from the given server.
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Company Logos
Menu path: Setup > System > Firmware Customization > Corporate Design > Company Logos

You can show your company logo in the screensaver and in the start menu.

Screensaver

Enable image display
☑ The image defined below will be shown as the screensaver. (default)
File for screen saver logo: Complete path for an image file or a directory that contains a number 
of image files.

One image per monitor
☑ The image will be shown on each individual monitor rather than one image across all monitors. 
(default)
Image duration: Time in seconds until the image changes (default: 10)
Image display mode

Small-sized hopping: small image that jumps across the screen
Medium-sized hopping: larger image that jumps across the screen
Full screen center cut out: Image is displayed across whole screen, edges can be cut off.
Full screen letterbox: Complete image is shown. A black edge may be visible depending on 
the format.

Start menu

Start button icon: File name with full path to select your logo as the icon for the start menu in the 
taskbar. Size: 32x32 pixels
Company logo in start menu: File name with full path to show your company logo in the start 
menu window. Size: 64x64 pixels

If you enter a folder instead of a single image file as the source, all images in the folder will 
be displayed as a slide show. The image display time for the images can be configured. If 
you do not specify a file of your own, the IGEL logo will be used.



In order to see the company logo in the start menu window, you must set the start menu 
type to Advanced. To do this, click on User Interface > Desktop > Start Menu.


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Environment Variables
Menu path: System > Firmware Customization > Environment Variables

Environment variables allow you to use dynamic parameter values for a number of session types, e.g. so as not to 
have to enter ICA or RDP servers for every session.

Predefined variables can also be allocated and distributed via the IGEL UMS. Additionally, defined variables can 
only be used locally on the thin client and may be overwritten by a UMS configuration.

Enable variable substitution in session: (default: disabled)

☑ The use of variables in sessions such as ICA and RDP is enabled. If specific parameters contain a $ , shell 
substitution will be carried out.

☐ The use of variables in sessions is not enabled. (default)

The environment variables are available in the setup under Custom Commands (see page 878).

In addition, the following session parameters can be updated through variables:

Legacy ICA sessions: Citrix Server or published application
Legacy ICA sessions: User
RDP session: Server
RDP session: User

_____

Predefined (see page 893)
Additional (see page 894)
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Predefined
Menu path: System > Firmware Customization > Environment Variables > Predefined

Variable name: Name for the variable
Value: Value for the variable

To use environment variables in sessions, proceed as follows:
Enable environment variables under System > Firmware Customization > Environment 
Variables > Enable variable substitution in session.
Define the variable name and content, e.g.

Variable name: SERVERNAME

Value: testServer
Enter the variable name in the parameter field of the session with the $ symbol before it. Example: 
$SERVERNAME

In the case of RDP and ICA sessions, the value is entered in the session file after saving. 
With XenApp, the setting is not implemented until a session starts and is running.


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Additional
Menu path: System > Firmware Customization > Environment Variables > Additional

You can define other variables in addition to the 10 predefined ones.

Variable name: Name for the variable
Value: Value for the variable
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Features
Menu path: System > Firmware Customization > Features

Using this list of available services, you can quickly enable or disable firmware components such as Powerterm, 
Media Player, Extra Font Services, etc. in order to reduce the amount of storage space required.

If a service was disabled, the associated session type will no longer be available when the system is restarted. 
Existing sessions will no longer be shown but will not be deleted either.

You will find further information in Disabling Features to Reduce Firmware Size.

A disabled session type will not be updated during a firmware update. You should, therefore, disable 
unused services in order to speed up update processes.



Features with Limited Support
A number of products feature functions with “limited support”. These functions are offered 'as is' without 
any warranty. Any support for these functions is provided on a non-binding, “best effort” basis.
These features are not available on IGEL IZ devices (IGEL Zero HDX, IGEL Zero RFX, or IGEL Zero Horizon).


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Registry
Menu path: System > Registry

In the registry, you can change virtually any firmware parameter. You will find information on the individual items in 
the tooltips.

Search parameter...: Search for setup parameters in the registry.

Search criterion: Criterion for searching. 
The following can be selected:

Parameter name
Parameter name: Any search term.
Logical search restriction:

Contains
Exact match
Use regular expressions

Ignore case
Find previous: Go back if there are a number of hits.
Find next: Go forwards if there are a number of hits.
Example: If you would like to find the FTP settings for updating the Linux firmware, you can search 
for the parameter name ftp . The parameter found in the registry structure is highlighted. Click 
on Find next until you find your desired parameter:

Changes to the registry should only be made by experienced administrators. Incorrect parameter settings 
can easily destroy the configuration and cause the system to crash. In cases like these, the only way to 
restore the functionality is to reset the device to the factory defaults!


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Add instance: Adds instances. This is possible with parameters which have a percent sign as their last character, 
e.g. nfymount% . The new instances are numbered consecutively: nfymount1 , nfymount2  etc.

Delete instance: Deletes a previously added instance.
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